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Transact Manager Administration Guide (Manager v5.0)

This document provides a guide for system administrators managing a Transact Manager system. Before following any part of the document, ensure you
have correctly installed the Transact Manager (TM) Instance. For installation instructions, please see the Transaction Manager Installation Guide.

Search this Document

Overview

Transaction Manager is the sophisticated Enterprise Forms Management System that acts as the cornerstone of Avoka Transact.

Over the years, many organizations have discovered the benefits of transforming their traditional paper-based forms into streamlined, web-based electronic
forms. Though transforming a paper-based form into an electronic form is a great first step, to truly realize the benefits of modern web-based forms,
organizations must provide several other features to their form.

The following list documents several common features that an organization would need to implement to realize the true benefits of web-based electronic
forms.

Provide user manageable profiles that are able to pre-populate forms
Create and build an automated receipt generation system

Create a submission tracking system

Produce a submission management system

Transact Manager combined with Adobe LiveCycle ES, provides organizations with all these features and so much more. As a configurable web-based
solution, Transact Manager manages the complete life cycle of forms created in Transact Composer and Transact Maestro.

The Form Life Cycle

There are three phases that make up the life cycle of a form in the Transact Manager solution. These three phases are identified and documented below.

Phase 1 - Form Definition & Publishing

The first phase of the form's life cycle is all about defining the form and publishing it to the organization's website. Links to Transaction Manager forms are
typically embedded within an organization's website. When the organization's users click these links, they are redirected to the Transaction Manager server.
the server retrieves the appropriate form definition, pre-populates it with fields and data, and then renders/presents the form to the user.

Phase 2 - Form Submission

The second phase of the life cycle concerns the submission process of the form. Once a user has completed the form (ie entered all mandatory fields and
clicked the submit button), it is submitted (sent) back to the Transact Manager server. It is at this stage that the completed form (submission) is processed.

Transaction Manager supports several post-submission services that can be applied to be activated at this stage of the form's life cycle. Listed below are
several of the post-submission services that can be applied at this stage.

® Attachments
® Payments
® Signature services

Once a submission has been processed, TM generates a receipt that can be emailed or downloaded by the user.

Registered users of the Transaction Manager Example Self Service Space may view any previous submissions and download receipts at their convenience.
The Transact Manager Example Self Service Space is where registered TM users can manage their submissions.

Phase 3 - Submission Delivery

The third and final phase of the form life cycle is the delivery of the completed form, the delivery of the XML Data associated with the completed form, and
the delivery of any relevant attachments that the form user may have attached to their submission to the intended recipient of the form.

Transact Manager provides several delivery options, including email, web services delivery mechanisms and custom LiveCycle ES processes. Along with

these options, Transact Manager also provides an option for organizations to implement their own stand-alone organization-based delivery manager to
handle the delivery of forms created for their organization.

Core Capabilities

Transact Manager has several core capabilities. These core capabilities are identified and documented below.

® Form Hosting - Multiple forms can be hosted centrally and be made accessible to your users. You can do this by embedding links to the forms into
your web pages or by using form search engines. Transact Manager provides the tools required to manage forms and process submissions made
by users.

® Data Pre-Population - Users can rapidly complete forms that are pre-populated with information. This information can come from one or more
Transact Manager profiles or organization provided data retrieved via a web service.



® Receipting - Users are provided with an electronic receipt that includes the submitted form, payment and submission information. Receipts can be
viewed online, emailed, or downloaded and printed.

® Payment - If a submission needs to be accompanied by a payment, Transact Manager can be configured to read the correct payment amount from
the form and process the payment using a secure credit card payment process.

® Supporting Documentation - Submissions can be supported by additional documents that may be uploaded electronically or submitted in paper
form. Business logic in the forms can be applied to supporting documents (ie plans must be submitted for building work over $10000).

® Submission Delivery - Completed submissions can be delivered by email to one or more addresses. These addresses can be assigned by web
services or by using a custom LiveCycle process. The delivery process can be configured separately for each form.

® Form Configuration and Version Control - Forms provide fine-grained control over behavior, including form properties, form metadata, and
custom LiveCycle rendering orchestrations. Forms also support version control enabling parallel development and multiple versions of the same
form. Transact Manager also provides a sophisticated facility for promoting forms from development, to test, and finally production on separate
servers.

® Task Assignment - To facilitate more flexible workflows, forms along with their prefilled data can be assigned to a user or a group of users. This
task is then presented to the user on their to-do list.

® Customized User Experience - Transact Manager provides an Example Self Service Space where users can manage their submissions. Custom-
branded user spaces based on the Example Spaces are easy to create and deploy.

® Submission Tracking - All submissions can be tracked from form download to submission delivery. Customer support can view forms and
attachments to provide user assistance during the submission process.

® Reporting - Transaction Manager provides multiple charts and standard reports for reporting on submissions. Additional reports can be configured
using advanced reporting modules. Reports can be displayed on a screen or can be automatically sent out via email.

Transact Modules

The image below illustrates the major modules of the Transact solution.
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Transact System Modules
The major Transact system components are identified and documented below.

® Web Plugin — provides a form space for customer facing sales and service transactions. This form space is linked to from your (organization)
website, but can also be embedded on your website if the form is fairly small. Web Plugin supports unauthenticated and authenticated users.

® Work Space — provides a work space for business staff working on tasks, jobs, completing ad-hoc forms, and providing help desk support. The
work space is generally used by authenticated users but also supports unauthenticated transactions as well.

® TransactField App — provides a mobile app and PC application which enables business field staff to complete forms offline. Once online, the
application allows them to sync their work with the Transact Manager server, and receive new work tasks to complete. The TransactField App
supports authenticated users only.

® Transact Manager— provides an Enterprise Forms Management System enabling a sophisticated customer interaction and system integration hub
between form transactions and back-end business processes.

® Business Reports — provides a Business Intelligence Reporting Tool (BIRT) for scheduled and ad-hoc reporting.

Transaction Manager supports a flexible deployment of its components to multiple application server instances to support scalability. In addition, one or more
LiveCycle instances may be used for rendering, with real-time health monitoring and automated load balancing.



Security (Manager v5.0)

This chapter deals with the security model implemented in the Transact Manager platform.

Search

Concepts

A user account in Transact Manager (TM) is an account of a user who is able to successfully log on to TM. A user account may be authorized to log on
to the management console and/or one or more spaces in Transact Manager. This authorization is controlled by assigning the user account to one or
more spaces (one of these spaces may be the management console).

In addition, each user account can belong to one or more Transact Manager roles. Roles are collections of user accounts with similar access rights.
Similarly, user accounts can belong to one or more groups in Transact Manager. A group is a collection of users who are gathered based on something
other than permissions (eg a common goal).

An administrator in Transact Manager is a user account that is associated with/has authorization to access the Transact Manager management console
space.

A space user is a user account that is associated with at least one user space. Note that these categories are not mutually exclusive: An administrator
can also be associated with many user spaces, and can also have global access or be restricted to data associated with one or more specific
organizations.

Transact Manager controls access to certain content or actions using permissions. When requesting restricted content, Transact Manager will only allow
this this content to be accessed if the required permissions are present. Permissions can be granted to one or more roles, and a role is characterized by
the permissions it contains. If a user account belongs to several roles, they will have all permissions that are set for at least one of their roles.

As users make changes to Transact Manager, these changes are tracked and written to the audit log. This makes it possible to view an object's history
and review a specific user's changes.

To provide flexibility around the security configuration, Transact Manager supports one or multiple security managers. A security manager contains such
settings as how users are authenticated (against TM-managed users and/or Lightweight Directory access Protocol (LDAP)), lockout and password
settings, session timeout, SSO configuration and user self-registration settings.Each security manager contains one or more authentication managers
responsible for authenticating a user during login (by default, there is an authentication manager for authentication against an LDAP directory and
another authentication manager for authentication against the TM user database).

Each space in TM can be associated with its own security manager or use the default security manager defined in the system.

Permissions

Each permission in Transact Manager represents the right to access restricted content, for example editing a form or viewing an error log.

Permissions are specific to a space; the Transact Manager management console defines a fixed set of permissions, and each user space can define its
own permissions and implement security rules.

A full list of the available permissions in Transact Manager can be found in the Permissions (Manager v5.0)page.

Roles

Transaction Manager comes with a super administrator role with all permissions related to the Transaction Manager management console. As a
Transact Manager Administrator, you are able to create new roles and modify existing roles to suit your needs.

Standard Roles

When Transaction Manager starts up for the first time (or whenever there are no roles defined in the Transaction Manager database), it will automatically
create the following set of default roles.

A root administrator role with all permissions
A form developer role

An operations monitoring role,

An organization user manager role

® A system support role

As an administrator, you have permissions to customize these roles to suit your specific needs, or set up new roles.

Root Administrator

This is the most powerful role in Transact Manager. Root administrators have all permissions related to the Transact Manager management console
assigned to them and can access all restricted content. Critical operations such as deleting organizations and editing deployment properties should be
accessible to these users only.



Developer / System Manager

These two roles have identical permissions. Developer/System Manager users have a wide range of permissions available to them to manage TM
configurations. Users in these roles are able to edit organizations, forms and all related entities. Developers and System Managers are also able to view
requests, view submissions as well as view a wide range of system configuration settings. These roles are very powerful but cannot access submission
data, user accounts and are not able to modify roles.

Operations

Organization operation administrators can view submissions (included submitted XML data) and reports as well as various logs. Organization operation
administrators are given these permission to allow them to handle support requests submitted by space users.
However, they cannot access forms and associated configurations, nor can they access the details for user accounts stored in Transact Manager.

Organization User Manager

Organization user administrators can create and configure users for their organization. This is a role that might be used in addition to other roles to give
existing administrators access to user accounts, though it can also be used as a stand-alone role.

System Support

The system support role can be used by Avoka staff for debugging purposes. By default, this role has extensive read-only permissions to aid in
debugging. However, XML data submitted by users cannot be viewed.

Transaction Data Access

This role provides access to transaction data entered by users and allows administrators to edit this data and make submission status changes. As this
allows access to very sensitive information, this role should be assigned very carefully.

Browsing the List of Roles

Transact Manager allows administrators to view the list of available TM roles. To view this list of roles, go to "Security > Roles". You can filter this list by
using the search box and entering the name of the role and a description of the role, and exporting the search results to Excel by clicking the "Export
Data" link below the search text box. The screenshot below illustrates the search roles functionality.

Roles

Home Dashboard » Roles

[¥ Active Only Clear

New Import Export

Role Name Role Description Active Org. Assignable Action
Administrator Root System Administrator v e
Form Developer For users who can develop and test forms v v AU
Operations For users who can montor and manage form transactions v v AU
Organization User Manager For users who can manage user accounts for their organization U
System Support Read only access to assist in debugging TH issues. v e jiE!
Export Data

Using the role page (documented in the above screenshot), you can add, modify, assign permissions to and manage the members of a role by using the
=3 —_—

edit icon ( £ ). To delete a role, use the delete icon ( #.)). It is also at this page that as an administrator, you are able to import and export roles.

Adding a Role

The screenshot below documents the process of a new role being created (see below for an example with the fields filled in).
Edit Role

Home Dashboard » Reles » Role

Role |

Name*  Submission Viewer

Description = User who can view submissions and associated data
Active W @
Organisation Assignable | @

Save LIS

Creating arole



Follow the steps below to create a new role.

. Navigate to the Roles page (Security > Roles)

. Click the "New"button. Clicking this button will redirect you to the "Edit Role"page.

. Provide a name for your new role.

. Provide a description of your role (This step is optional).

. Select the "Active"checkbox. If you fail to select this checkbox your new role will be considered "Inactive". Inactive roles cannot be assigned to
users.

. Select the "Organization Assignable" checkbox if you want to allow organization administrators the permission to assign this new role to other
administrators within the same organization. If you do not select this checkbox, even organization administrators with permissions to assign
roles will be unable to see or assign this new role.

7. Click save
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Once you have saved the role, it is time to assign permissions to the role.

Setting Up Permissions for a Role

Form Developer
Home Dashboard » Roles » Role

Role | Permissions | Members

Spaces & Modules ~ Transaction Manager j
Available Assigned
Audit View A Admin Directory 1=

Collaboration Job Edit
Collaboration Job Remove
Collaboration Job View
Core Service Edit

Delivery Details Edit
Delivery Details Remove
Delivery Details View
Document Type Edit

Db Version Update View

Document Type Remove

Deployment Property Edit Document Type View

Deployment Property View Ermor Log View

Email Delivery Acknowledge Export Form

Email Queue Edit Export Form Version

Email Queue View Export Metadata

Event Log View > Export Organization

Export Groups Export Services |
Permissions  Export Portal = Finder Edit

Bxport Roles — Finder Remove

Export Security Managers - Finder View

Form Data Retention , Form Edit

Group Assign Form Remove

Group Edit Form Service Edit

Group Remave Form Test

Group View Form View

Import Action Remove Groovy Console

Import Action View Groovy Log View

Import Groups Import Action Edit

Import Portal Import Composer Form

Import Roles Import Form

Import Security Manager Import Metadata

Licensing Edit Ll Import Organization LI

Verify Your Password

Your Password *

CIDSE

Assigning permissions to arole
Follow the steps below to assign permissions to a role.

1. Navigate to the "Roles" page (Security > Roles)

2. Select the role you want to assign permissions to and click Edit

3. Select a space from the "Spaces and Modules" drop down. Selecting a space will update the "Permissions” list to include only those
permissions belonging to the selected space

4. Select the "Permissions"tab. Selecting this tab will display all of the available permissions and the permissions that are currently assigned to
that space (the above screenshot documents the "Permissions" list page for the "Transaction Manager' space).

5. Select a permission from the 'available permissions' list that you want to assign to the selected space and use the ">" button to assign the
selected permission to the space (to select multiple permissions, use the Shift and Ctrl keys, on Windows).

6. Enter your administration password

7. Click save

Note: Using the ">>" button will assign all available permissions to the selected role.

All permissions assigned to a role are loaded when the user logs in. In other words, any changes will be visible to users as soon as they log out and then
log back in to the space.

Removing permissions from a role

Follow the steps below to remove permissions from a role.



. Navigate to the "Roles" page (Security > Roles)

. Select the role you want to remove permissions from and click Edit

. Select a space from the "Spaces and Modules" drop down. Selecting a space will update the "Permissions" list to include only those

permissions belonging to the selected space

4. Select the "Permissions"tab. Selecting this tab will display all of the available permissions and the permissions that are currently assigned to
that space (the above screenshot documents the "Permissions” list page for the "Transaction Manager' space).

5. Select a permission from the 'assigned permissions' list that you want to remove from the selected space and use the "<" button to remove the
selected permission from the space (to select multiple permissions, use the Shift and Ctrl keys, on Windows).

6. Enter your administration password

7. Click save
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Note: Using the "<<" button will remove all assigned permissions from the selected role.

All permissions assigned to a role are loaded when the user logs in. In other words, any changes will be visible to users as soon as they log out and then
log back in to the space.

Managing Role Members

As an administrator, you are able to view and modify the list of users who are currently assigned particular roles (role members).
Edit Role

Home > Reles > Role

Role | Permissions I Members
User Accounts Role Members
administrator LI Ipammer LI
medgar
>
Role Members <
>
<«
= [
Save (@GRS

Managing role membership
Follow the steps below to enter the managing role membership page.

. Navigate to the Roles page (Security > Roles)
. Selectarole

=n

. Click the 'Edit Role' icon ( L)
. Switch to the '"Members' tab
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Select one or more user accounts (on Windows, use the Shift and Ctrl keys to select multiple user accounts) and use the ">" and "<" buttons to assign
and revoke the role from all selected users.

You can also assign the role to all users by using the ">>" button; likewise, the "<<" button will remove the role from all users.
Once you have finished modifying the list of members, enter your administrator password (if required) and save the role.

Deactivating a Role

You can deactivate a role to ensure its permissions are no longer applied without deleting the role (e.g. so it can later be reactivated if needed). To do
so, edit the role, untick the "Active" checkbox and save. Inactive roles are not available for assignment to users and do not confer any permissions until
they are reactivated.

The "Security > Roles" page also hides inactive roles by default. You can include them in searches by unticking the "Active Only" checkbox.

Deleting a Role

=i |
You can delete a role by going to "Security > Roles" and clicking the "Delete" icon ( #-') next to the role. You will be asked to confirm this action before
the role is deleted. This action cannot be undone.

Importing / Exporting Roles

You can export roles and permissions assigned to them, to be imported to a different Transaction Manager instance or for backup purposes.
To learn about how to export and import roles, please refer to Multi-Environment Support (Manager v5.0)#_sec_MigratingRoles.

Groups

Groups can be used to define sets of users who have something in common other than a shared permission set as provided by roles. Transaction
Manager provides a set of pre-defined groups which users can be assigned to in order to receive email notifications about certain events.
You can also create form work groups to control access to a set of forms.


https://servicedesk.temenos.com/kb/pages/viewpage.action?pageId=76189584#Multi-EnvironmentSupport(Managerv5.0)-_sec_MigratingRoles

Form Work Groups

Groups that control access to forms are called form work groups. All users within a form work group share the forms assigned to the group to a certain
extent; the exact nature of what is being shared is controlled on the group level.

There are three aspects of form sharing that can be configured for a form work group. Users can simply share access to a set of forms that all of them
can open and submit, but that are not accessible to non-members. Secondly, users can share tasks and incomplete (e.g. saved) submissions for the
forms in the group, meaning that each group member can see drafts submitted by other members and complete these draft forms even if they were not
the initial submitters. Finally, the form work group can be configured to allow users to see all completed submissions of group forms by other group
members and, if configured, access the receipt for these submissions.

Each of these three settings can be turned on independently, allowing for flexible form work group configuration. Each group applies only to forms
assigned to the group, and confers its privileges only to user accounts who are members of the group.

Browsing the List of Groups

To view the list of groups, go to "Security > Groups". You can filter the list using a substring of the group name and description, and export the search
results to Excel by clicking the "Export Data" link below the table.

Groups

Home Dashboard » Groups
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Receive Delivery Escalation Alert Rec_erve submission defivery escalation alert l'_f’ i
Aarts emails
Receive Outstanding Payment frm Flec&ue_paymem alerts for unpaid 4
Alerts suUbmissions
Receive Promotion Alerts Alert Recaive form promotion alert emails E i
Receive Submission Updetes At ::‘c;ﬁ:e submission status update notification @ |3
Receive System Alerts Alert Receive system alert emais E } i
Receive System Alerts - Delivery  Alert  Receive system delivery error alert emails @ &
Receive System Alerts - Receipts  Alert Receive system receipt error alert emails E " i
Receive User Account Creation Alert Recgree user account creation notification @ &
Alarts emails

Export Data

Browsing the list of groups

As you see, there is already a set of alert groups defined. These groups have the read-only flag set and cannot be renamed or deleted.
=3

Using this page, you can add, modify ( £ ) or delete ( #.') groups.

Adding a Group
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To add a new group, click the "New" button. You will be directed to the "Edit Group" page (see below for an example of a form work group).
Edit Group

Home Dashboard » Groups ¢ Group

Group

Name*  Human Resources 9
Type® Fom j @

Description = Users who have access to HR forms

Group User Access Control
Share with Work Group 2 @
New Forms [v @
Saved / Assigned Forms [ @
Completed Forms [ @

Reassign Task [~ @

Creating a custom group

Fill in a unique group name and an optional description.

Choose the group type (you cannot currently define custom alerts, so you should select "Form" to create a form work group).

When creating form work groups, you can define the access rules described in _sec_formworkgroups. Tick "New Forms" to allow users to actively start
filling in forms belonging to the group (otherwise they cannot access the forms at all, except when tasks are assigned to the group and the group is
configured to share tasks and incomplete submissions). Tick "Saved / Assigned Forms" to allow sharing of tasks assigned to the group as well as
incomplete submissions for these forms. Tick "Completed Forms" to allow sharing of the list of completed submissions and access to receipts.Tick
"Reassign Task" to allow members to reassign task submissions.

Save the group. Now you can start assigning forms and users to the form work group.

Managing the List of Group Members

You can view and modify the list of group members by going to "Security > Groups", clicking the "Edit Group" icon (
“1) and switching to the "Members" tab.

Job Reviewers
Home Dashboard » Groups » Group

Group | Forms | Members

User Accounts Group Members

administrator LI Jjsmith :]
Ipammer userl
Ipammer-0502
Ipammer-0509
Ipammer-1001
Ipammer-das
Ipammerntgov
Ipammer-old
Ipammer0107
Ipammer1608
Ipammer1911
Ipammer2304
Ipammer2703 ?
Ipammer2910
Group Members  |pammer3010
Ipammer3110
Ipammer@avoka. com
test@avoka.com
user2
userd
usemame

v
bvd

Verify Your Password

Your Password™*

Save Close

Managing group membership

The list of all current group members is displayed in "Group Members".

Select one or more user accounts (on Windows, use the Shift and Ctrl keys to select multiple user accounts) and use the ">" and "<" buttons to add and
remove the selected members.

You can also add all users to the group by using the ">>" button; likewise, the "<<" button will remove all users from the group.

When you have finished modifying the list of members, enter your administrator password (if required) and save the group.
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Viewing Forms Assigned to a Form Group

Form groups control access to one or more forms. To see which forms are currently associated with a form group,
edit the group and switch to the "Forms" tab.
Edit Group

Home > Groups > Group

Group | Forms | Members

Form Name Form Code Action

TCF12 tcf12d-ntgov G

Test Import Form  tif-tic |

Viewing the list of forms associated with a form group

You can remove forms from the group by clicking the "Remove Form From Group" icon ( #_-) next to the form. To add a form to the group, please follow
the instructions in  chapter "Form Configuration”, section "Form Group Access" .

Deleting a Group

You can delete a group by going to "Security > Groups" and clicking the "Delete" icon ( ) next to the group. You will be asked to confirm this action
before the group is deleted. This action cannot be undone.

Pre-Defined Groups

Transaction Manager comes with several pre-defined alert groups:

1. Receive Delivery Escalation Alerts
Members of this group will be notified when submissions with secure email delivery have not been acknowledged after a certain period (for the
exact rules, see chapter "Delivery Configuration”, section "Secure Email Delivery" ).

2. Receive Outstanding Payment Alerts
Members of this group will be notified when there are submissions with outstanding payments for their organization. This group is relevant only
if administrators wish to monitor submissions for those that are abandoned at the payment stage (e.g. to contact the applicant and offer
assistance).

3. Receive Promotion Alerts
Members of this group will be notified when a form belonging to their organization is promoted (for the exact rules, see Form Configuration
(Manager v5.0)#_sec_promotingaformversion).

4. Receive Submission Updates
Members of this group will be notified when the processing status for a submission they have made has been updated. This group is relevant
only to space users, not administrators.

5. Receive System Alerts
Members of this group will be notified when the System Monitoring job (see Scheduled Jobs (Manager v5.0)#_sec_systemmonitoringjob) finds
that important system jobs are impacted.

6. Receive System Alerts - Delivery
Members of this group will be notified when submission delivery fails.

7. Receive System Alerts - Receipts
Members of this group will be notified when submission receipt generation fails.

8. Receive User Account Creation Alerts
Members of this group will be notified when a user has applied for an account on a user space (this will be discussed in _sec_customizingusere
nrolment).

Dynamically Loaded Groups

When TM users are managed externally (LDAP or SSO authentication), TM can load the user's group associations at login time. If groups with identical
names are set up in TM, these dynamically loaded group associations can be used to control form work group access.

For LDAP users, groups are usually defined as a distinguished name (e.g. "CN=mygroup,OU=Distribution Groups,OU=MyBusiness,DC=mycompany").
Since these names are somewhat unwieldy, TM parses out the group name (to be exact, it takes the string before the first comma ("CN=mygroup") and
parses out the string following the first equals sign, resulting in a group name of "mygroup”.

For SSO users, the group names can be passed in when creating the SSO token. As Groovy scripts are used to customize SSO behavior, you can tailor
the scripts to parse out the group names in any way you need. Please refer to the Groovy services guide ("System > Groovy Services Guide") for more
information on the Groovy scripts involved in SSO authentication.

User Accounts

A user account is a login to a Transaction Manager space. A user account is characterized by some personal data, their credentials, user type ("Local",
"LDAP" or "SSQ"), one or more user profiles, the spaces they can log on to, the organizations they can access and the roles and groups they belong to.
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Browsing the List of User Accounts

To view the list of user accounts set up in Transaction Manager, go to "Security > User Accounts". You can filter the list by organization, a substring of
the user's login name and full name, user type and account status ("Active”, "Inactive”, "Locked", "Pending", "Rejected"). In addition, you can choose to
show only user accounts associated with a specific space.

You can export the search results to Excel by clicking the "Export Data" link below the table.

User Accounts
Home Dashboard » User Accounts

Status j Portal j User Type j Clear

New Bulk Import

Login Hame Full Name Email Created Last Access Time Type Admin eSignatures Status Action
aa Gg Vg Fif@aa.com 24 Apr 2015 Local Active [ &
aaa Jjvb Kk@df com 19 May 2015 Local Active [ &
adminavoka admin avoka talert@avoka.com 18Dec2013 18 May 2015 14:58:24 Local ¢ active @ &1
administrator Root Administrator 10 Apr 2013 18 Apr2013 0T:45:41 Local v’ Inactive 2 E
amehmood@avoka.com Asad Mehmood mehm avoks.com 24 Dec2013 12 Jul201500:16:03 Local Active [ &)
aokamoto Angie Okamoto aokamoto@@avoka. com 24 Apr2013 10 Jul2015 07:32:56 Local v < Active '2 Q
ackamoto2 Angie Okamoto angie.ckamoto@gmail.com 11 Dec 2013 Local Active [P &
applicant! An Applicant applic@me. com 31 Mar 2014 09 Apr2014 17:06:21 Local Active [P &
applicant2 another Applicant mrichards@avoka.com 01 Apr 2014 04 Apr2014 10:24:29 Local Active 2 E
ASSESS an assessor mrichardsg@avoka.com 28 Mar 2014 Local active [P
b 110 0f 243 Export Data

Browsing the list of user accounts

From this page, you can add, edit (= , also allows you to assign spaces, roles and groups to the user) and delete ( E) user accounts. You can also
import a list of user accounts.

Adding a User Account

To add a user account, click the "New" button. You will be taken to the "Edit User Account" page (an example with all fields filled in is shown below).
Edit User Account

Home Dashboard » User Accounts » User Account

User | I | I

User Details

Login Name* msue
User Type* Local j
Password sssssssssss
Confirm Password essssssssss
Change Password After Login v
Given Name(s)* Mary
Famity Name*  Sue
Email* msue@mydomain.com
Mobile
Phone

Spaces™ Transaction Manager j
Verify Your Password

Your Password”® eessssse

Save Close

Creating a user account

Choose the appropriate user type from the "User Type" dropdown. For users managed by Transaction Manager, use "Local" (selected by default). If you
would like to manually set up an LDAP user, choose "LDAP" (note that you will get a restricted field set as the user is managed in the LDAP directory in
this scenario - see _sec_authenticationproviders for more on user authentication); similarly, choose "SSO" for an SSO user account (only applicable if
you are using an SSO security manager).

Fill in the personal details (given and family names, email address and phone numbers).

Enter a unique login name and the initial password. By default, the password must be at least twelve, but at most 20 characters long and contain at least
one special character and mixed case letters (the exact requirements depend on the security manager configuration for the chosen space).
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If "Change Password After Login" is ticked, the new user will be forced to change his initial password when logging on, and will be unable to access any
restricted content until this has been done.

Choose a space from the "Spaces" dropdown. This will be the space (either the management console or one of the user spaces) that the user will be
associated with initially. More spaces can be added later as described in _sec_changespacesforuseraccount".

For security reasons, you must enter your own password to create the user.
Once you have filled in all the data, save the new user account.

Note that the user will not have access permissions until they have been assigned a role. When creating a new user, Transaction Manager will
automatically open the "Roles" tab for you so you can assign roles as needed.

The following sections describe how to assign one or more roles and spaces to a user account and set up organization access. These steps are
essential for setting up functional administrator users.

Changing the Roles Assigned to a User Account

There are several scenarios where you might want to change the roles assigned to a user account: A new user account needs to be set up with its initial
set of roles, and existing user accounts may need further access rights. If you suspect that a user account may have been compromised, you can
remove all their roles and spaces and make the user account inactive as well, making it unable to log on or perform any restricted actions.

¥y
To change the roles assigned to a user account, go to "Security > User Accounts", click the "Edit" icon ( =) next to the user account and switch to the
"Roles" tab.

Edit User Account

Home Dashboard » User Accounts » User Account

The User Account has been successfully saved. Please assign roles as needed.

User Organizations | Portals | Roles l Groups. l User Profies

User Roles
Available Roles Assigned Roles

Adminisirator ﬂ Fomn Deweloper d

Dashboard Organization User Manager

Maestro Admin

Maestro Developer

Maguire Staff

Operations

System Support
Roles | Tast Role <

Verify Your Password

Your Password® ssssssssssssss

Changing the roles of assigned to a user account

Please note that there are precautions built into the Transaction Manager management console that prevent organization administrators from assigning
themselves inappropriate roles. If an organization administrator edits the role assignments for a user account, they will see only roles for which
"Organization Assignable" is ticked. All other roles will be hidden. Global administrators, on the other hand, can see and assign all roles to other user
accounts (if their own roles contain the permissions around role assignment).

To change the roles assigned to a user account, select roles (on Windows, use the Shift and Ctrl keys to select multiple roles) and use the ">" and "<"
button to assign and remove them.

You can also add all available roles to a user account by using the ">>" button; likewise, the "<<" button will remove all roles, leaving the user account
without any privileges.

For security reasons, you may have to enter your own password to save changes to the roles.
Once all roles have been assigned appropriately, save the user account.

The roles assigned to a user account are loaded when the user logs in, so changes will be visible to the user after logging out of the space and logging
in again.

Managing Role Expiry

Sometimes it makes sense to assign a role to a user for a limited amount of time (e.g. to allow Avoka support to help debug a problem). TM allows you
to configure an expiry time for user roles so you don't have to remember to remove the roles yourself. To manage role expiry times for a user, edit the
user and switch to the "Role Expiry" tab.
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Edit User Account - joe

Home Dashboard » User Accounis » User Account

User | Organizations | Spaces | Roles | Role Expiry Groups Group Expiry User Profiles Login History

Configure optienal User Account Role expiry times. When the user roles expiry time has been reached the role will be removed from the user's account.

Role Name Role Expiry

Developer D
System Manager | 01Feb 2016 0:00 D

System Support

Save Close

Configuring role expiry for a user account
You can enter an expiry time for each role or remove expiry times if needed.

Save your changes. When the expiry time arrives, the background job "Security Policy Manager" (see Scheduled Jobs (Manager v5.0)
#_sec_scheduledjob_securitypolicymanager) will remove the role from the user account.

Changing the Organizations Accessible to a User Account

Users associated with the TM management console can be given global access or restricted to one or more organizations. Organization administrators
have restricted access privileges; in particular, whenever there is data associated with organizations, they will see only the subset relevant to their own
organization(s) (e.g. on the "Forms" page, they will see only their own forms). Organization administrators can also assign only organization assignable
roles to other administrators (effectively preventing them from promoting themselves or others to global administratgrs).

=

To change the organizations a user account can access, go to "Security > User Accounts”, click the "Edit" icon ( L4 ) next to the user account and
switch to the "Organizations" tab.

Edit User Account - msue
Home Dashboard » User Accounts » User Account

The User Account has been successfuly saved. Please assign organizations as needed

User Organizations | Portals ] Roles J Groups I User Profiles

Available Organizations Assigned Organizations

Admiriistrative Services ;I Morthem Tenitory Gowemment ;I
Depariment of Health
FinanceComp
Lena Test Chent (4.0)
Quick Start Client .
Test Delete Client -
- Test Import Cliert
Organizations £

Enable Global Access [ @
Verify Your Password

Your Password® eessssssssssss

Close

Configuring organization access for a user account

The "Enable Global Access" checkbox controls whether a user is a global administrator or an organization administrator. If ticked, the user automatically
has access to all organizations. Otherwise individual organizations must be assigned to the user.

To change the organizations a user account can access, select organizations (on Windows, use the Shift and Ctrl keys to select multiple organizations)
and use the ">" and "<" button to assign and remove them.

For security reasons, you have to enter your own password to save changes to the organizations.

Once all organizations have been assigned appropriately, save the user account.

Changing the Spaces Assigned to a User Account
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Before a user can log in to the management console or a user space, they need to be associated with the corresponding space record. An existing user
can register for a space account if the user space supports this; the management console does not support self-registration.
=%

To change the spaces assigned to a user account, go to "Security > User Accounts”, click the "Edit" icon ( 4 ) next to the user account and switch to
the "Spaces" tab.

Edit User Account - msue
Home Dashboard » User Accounts » User Account

User | Organizations. | Spaces | Roles | Groups | User Profiles. Login History

Available Assigned

Business Reporis LI Maguire ;J
Classic Gov Assist Transaction Manager
Finance Comoration
Gov Assist
My Com
Prototype >
Transact Maestro

Spaces & Modules | TransactField App <
Web Plug+n

v
v

”
~

Save Close

Changing the spaces assigned to a user account

To change the spaces assigned to a user account, select spaces (on Windows, use the Shift and Ctrl keys to select multiple spaces) and use the ">"
and "<" button to assign and remove them.

You can also add all available spaces to a user account by using the ">>" button; likewise, the "<<" button will remove all spaces.

Once all spaces have been assigned appropriately, save the user account.

Note: Only global administrators can always assign all spaces to user accounts. Administrators restricted to one or several organizations can assign only
the spaces they themselves have been assigned.

Changing a User's Group Associations

=%
To change the groups a user belongs to go to "Security > User Accounts”, click the "Edit" icon ( [ ) next to the user account and switch to the "Groups"
tab.
Edit User Account - msue

Home > User Accounts > User Account

User Portals Roles Groups | User Profiles ‘

Available Groups Assigned Groups
AVO Officers _:_I Receive Submission Updates ;l
Avokalsers Review Group
Ben Org
BensGroup
Field Worker Group

Receive Outstanding Payment Alerts
Receive Promation Alerts

Groups | Receive Submission Alerts

Receive User Account Creation Alerts 5>
Review Group 2
Test Import Group

Save Close

Assigning a user to groups

To change the groups assigned to a user account, select groups (on Windows, use the Shift and Ctrl keys to select multiple groups) and use the ">" and
"<" buttons to assign and remove them.

You can also add the user to all available groups by using the ">>" button; likewise, the "<<" button will remove the user from all groups.

Once all groups have been assigned appropriately, save the user account.

Managing Group Expiry

Sometimes it makes sense to assign a user to a group for a limited amount of time. TM allows you to configure an expiry time for user groups so you
don't have to remember to remove the user from the groups yourself. To manage group expiry times for a user, edit the user and switch to the "Group
Expiry" tab.
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Edit User Account - joe

Home Dashboard » User Accounis » User Account

User | Organizations | Spaces | Roles | Role Expiry Groups Group Expiry User Profiles Legin History

Configure optienal User Account Group expiry times. When the user group expiry time has been reached the group will be removed from the user's account.

Group Hame Group Expiry
Job Reviewers 05 Feb 2016 17:00 D
Receive Submission Updates =

Save Close

Configuring group expiry for a user account
You can enter an expiry time for each group or remove expiry times if needed.

Save your changes. When the expiry time arrives, the background job "Security Policy Manager" (see Scheduled Jobs (Manager v5.0)
#_sec_scheduledjob_securitypolicymanager) will remove the user account from the group.

Removing a User Account

If you wish to disable a user account, you have two options: You can deactivate the account, which will make them unable to log on but preserve the
user record in Transaction Manager, or you can delete the user account, which irrevocably removes all data associated with the user account.

Note that submissions made by a user will be preserved even after their user account is deleted; however, these submissions will not be associated with
a user any more.

Deactivating a User Account

=
To deactivate a user account, go to "Security > User Account" and click the "Edit" icon ( s ) for the user in question. You will be taken to the "Edit User
Account” page.

Edit User Account - msue
Home Dashboard » User Accounts » User Account

User | Organizations | Spaces | Roles | Groups User Profiles Login History
User Details

Login Name* msue

User Type = Local j

Password

Cenfirm Password

Change Password After Login
Given Name(s)*

Famity Name *

Email*

Mobile

Phone

Email Verification Required
Account Status *
Temporary Lockout Ends
Failed Login Attempts
Created At

Last Accessed

~

First Name

Last Name
example @mail.com

0412123123

r

Active j

Locked
Locked Temporarily
Pending
Rejected

User Key

C‘Dse

70ed9fc07ba6980197432608e521b625

Deactivating a user account

Choose "Inactive" from the "Account Status" dropdown and save. The user account record still exists, but the user can no longer log on or access
restricted content.

To reactivate the user, simply edit the user account and choose "Active" from the "Account Status" dropdown, then save.

Deleting a User Account
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To delete a user account, go to "Security > User Account”, locate the user account and click the "Delete" icon ( #.-1). Since this operation will
permanently remove the user record, you will be asked to confirm your decision.

Note that you cannot delete the user you are currently logged on as, nor can the system-generated account "Root Administrator" be deleted.

Even after a user account has been deleted, the changes the user made to the system are still visible in the audit log (see _sec_trackchanges below).

User Account Bulk Import

To make it easier to create a set of users, Transaction Manager allows you to bulk import user accounts defined in an Excel spreadsheet.For security
reasons, there are some limitiations: Only local users can be created; users can be associated with spaces used to host forms, but users cannot be
associated with other spaces such as the management console. Existing user accounts (with the same login name) are left untouched by the import.
To access user bulk import, go to "Security > User Account" and click "Bulk Import" to access the "Bulk User Account Import" page.

Bulk User Account Import

Home Dashboard » User Accounts » Bulk User Account Import

User File (XLS)*  Browse. |tm-user-bulk-import s

Example User Import Spr

Uploading a set of users defined in a spreadsheet

The XLS file you upload must follow a certain format (specifically the header column names need to be correct and are expected to be in a certain
order). You can download an example spreadsheet by clicking on the example file link.

Once you have a suitable XLS file containing the user accounts you want to import, upload the file via the "User File XLS" field and click "Import".
The import file will be processed, and the import results will be displayed (see below for an example). In the detail table, users that were imported
successfully are displayed at the top, followed by users for which an error occurred (e.g. mandatory column not set). Finally, user accounts that were
skipped because they already exist are displayed at the bottom.

Bulk User Account Import

Home Dashboard » User Accounts » Bulk User Account Import

Import completed successfully - new users: 2, skipped existing users: 1, falled imports: 3

Login Hame Import Result

user2 Success

user3 Success

invaliduser Failure: Column "email not set

invaliduser2  Failure: Password unacceptable for portal 'Classic Gov Assist”: Password must not contain the common password value ‘password
random Failure: Mobile FieldWorker Portal Security Manager uses Delegated Authentication, user accounts cannot be created

userl Skipped

User File (XLS)* Browse | No file selected

Example User Import Spreadsheet

User bulk import results

User Profile Configuration

Users can set up one or more profiles that can be used to pre-populate forms if the user space supports this. Each profile has the same fields, and each
field corresponds to a user property (for more on properties and how to set them up, see Organization Configuration (Manager v5.0)#_sec_propertytypes
). When you create a user via the management console, a default profile is created automatically.

Examples for user profile fields are first name, last name and phone number. Transaction Manager allows you to define whichever fields you need and
map them to locations in a form data configuration so they can be pre-populated into the form.

Viewing the User Profile Properties
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To view all the user profile fields, go to "Forms > Property Types" and choose "User" from the "Scope" dropdown (you should see a list similar to the one

in the screenshot below).

You can filter this list using a substring of the property name and the data type (see Organization Configuration (Manager v5.0)

#_sec_datatypesforaproperty for the list of possible data types), and export the search results to Excel by clicking the "Export Data" link below the table.
Property Types

Home > Property Types

|::a-; Scope |L|sar :I Clear

New
Property Name Org. Scope DataType Description Action
Address User String E z
Email User  String Email address. @ &
Family Name User String Surname or family name @ ﬁ
Given Name User  String First or given name @ &
Postcode User Number @ ﬁ
State User  String (]
Town User String @ ﬁ

Export Data

Viewing user property types

This page allows you to add user properties, edit existing user properties ( ‘)») and delete user properties ( E). For more information on how to do
this, see Organization Configuration (Manager v5.0)#_sec_propertytypes.

Viewing a User's Profile Data

To view a user's profiles, go to "Security > User Accounts" and click the "Edit" icon ( ';-.) next to the user. You will be directed to the "Edit User Account"
page. Switch to the "User Profiles" tab to see all profiles that the user has set up.

Edit User Account - msue

Home > User Accounts > User Account

User | Portals | Roles | Groups User Profiles

Profile N\ame Profile Description Current Profile Action

My Profile My default user profile v E‘\ =

Second Profile AR0E

2 -

The list of profiles set up for a user
This page allows you to create a new profile and edit ( ') or delete ( #-') existing user profiles. You can also promote a profile to the default (current)
profile (L&).

Adding a Profile to a User

To add a profile to a user, view the user's profiles as described above and click "New". The screenshot below shows an example where the fields have
been filled in.

Edit User Profile

Home > User Accounts » User Account > User Profile

User Profile |

User doe@mydomain.com

Profile Name * |Te=t

Profile Description |To be used for test submissions

Current Flag r

Save Close

Creating a user profile
Enter a profile name and a description.

The "Current Flag" indicates whether the profile will be used as the default when rendering forms.
Save the profile. The "User Properties" tab should now be enabled allowing you to configure the new user profile.
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Modifying a User's Profile Data

To modify a user's profile data, view the user's profiles as described in section 2.6.2. Click the "Edit" icon ( h’") next to
the profile you want to modify. You will be directed to the "Edit User Profile" page. Switch to the "User Properties”
tab. You will see all user properties and their current values for this user.

Edit User Profile

Home > User Accounts > User Account = User Profile

User Profile | User Properties

ID Property Type Profile Value

»
2
g
-]

1290 Address Test 1 Ash Street A &
1291 Email Test jdoe@mydomain.com [ &7
1292 Family Name Test Doe @A &
1293 Given Name Test Jane @A O
1294 Postcode Test 2095 A &
1285 State Test NSW E E
1296 Town Test Manly & &

o -

Modifying a user profile

=3
To modify the value of a profile property, click the "Edit" icon ( =) next to it. You will be directed to the "Edit User Property" page, where you can enter
the new value and save.

Edit User Property

Home > User Accounts = User Account = User Profile = User Property

Profie Test
Type | Address LI
1 Ash Street

Value

Save [LER

Editing a user property

Generally, you should avoid deleting user properties as this will cause the user profile to be inconsistent with the other profile (since it will be missing the
property). If you want to unset a property, simply leave the value field blank.

Deleting a User Profile

Be very careful when deleting user profiles so you do not accidentally remove data from a non-test user.

To delete a user profile, view the list of profiles as described in section 2.6.2. Find the profile you want to delete, and then click the "Delete" icon ( #.-).
You will be asked to confirm this action before the user profile is irrevocably deleted.

Default Role and Administrator

When Transaction Manager starts up, it will check to see if any roles or user accounts exist. If not, it will create an "administrator" role with all available
permissions and an administrator that belongs to that role. The credentials for the administrator are "administrator" with an initial password of
"password". You will be asked to change the password to a different value when you first log on.

To avoid the possibility of accidentally locking up the system, neither the auto-generated role nor the administrator can be deleted.

Tracking Changes

When a user makes changes to important Transaction Manager entities (e.g. creates a form, changes an organization property, deletes delivery details),
these changes are recorded and the logs made available for viewing via the Transaction Manager audit log. This allows you to find out which user was
responsible for each change, as well as to view the change history for a particular entity.

Data Logged for an Audit Log Entry
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Each audit log entry contains the same fields; depending on the nature of the change logged, the fields have to be interpreted in different contexts,
though.
The fields contained in an audit log entry are as follows:

1. Entity
The type of object affected by the change, for example "Form" or "UserDetails".

2. Entity ID
The ID of the entity that was affected by the change. This ID is unique within the entity type (e.g. two different forms always have different IDs,
but a form may have the same ID as an organization).

3. User
This field identifies the actor who made the change. The actor can be an administrator (most common case), but also a space user or even a
Transaction Manager job. In any case, the actor's login name (for administrators and space users) or name (for jobs) is logged.

4. Time
The date and time when the change was made.

5. Message
A string describing what was changed. For a "create” or "edit" operation, this string will contain all attributes that have changed and their old
and new values; for a "delete" operation, the message will only say which object has been deleted.

Browsing the Audit Log

To view the audit log, go to "Security > Audit Log".

Audit Log

Home > Audit Log
User I Message Entity Name [ Entity ID | Start Date ID‘I Mar 2012 D0-00 j End Date I j @ Clear
(1] User Time Entity Type Entity ID Change Meszsage Action
29871 lpammer 27 Mar 2012 10:16:48 Template 10724 Create Created Template 10724 [sfm-widgets-test2 Template], Active Flag is true’, Shared Flag is 'false...

29970 lpammer 27 Mar 2012 10:16:48 SchemaSeed 364 Create  Created SchemaSeed 364, File Name is “formsead xml, Name is "SFM Widgets Test - HTML [with PDF r.

25065 lpammer 27 Mar 2012 10:168:48 Form 10706 Create Created Form 10706 [Australian Taxation Office:SFM Widgets Test - HTML [with PDF receipt]], Activ...
20062 system 26 Mar 2012 16:55:51 Report 51 Create  Created Report 51, Active Flag is True’, Client Assignable Flag is 'false’, Description is. "Prov.
20967 system 26 Mar 2012 16:55:50 Report 50 Create Created Report S0, Active Flag is true’, Client Assignable Flag is “false’, Description is. "Prov...

28966 unknown 23 Mar 2012 14:38:25 UserAccount 2 Update  Updated Userd.ccount 28 [lpammer], Failed Login Attempis changed from 1" to '0"

unknown 23 Mar 2012 14:38:18 UserAccount 29 Update  Updated UserAccount 29 [lpammer], Failed Login Attempts. changed from 07 to 1"

system 23 Mar 2012 14:38:53 Report 43 Create Created Report 49, Active Flag is true’, Client Assignable Flag is “false’, Description is ‘Prov..
20963 unknown 22 Mar 2012 16:20:38 UserAccount 2 Update  Updated UserAccount 28 [lpammer], Failed Logn Atiempis changed from 1" io ‘0"
28962 unknown 22 Mar 2012 16:20:30 UserAccount 29 Update  Updated UserAccount 29 [lpammer], Failed Login Attempts changed from 70" 1o *1°

4 b 61-TOof925 Export Data

The audit log

You can filter the list using a substring of the "User" and "Message" attributes, the entity name, the entity ID and the date and time at which the change
was made. For an explanation of these fields see the previous section.

Examples:

To view all the changes made to the form property with ID 1000, enter "1000" into the "Entity ID" field and click "Search". This gives you all changes
made to objects with an ID of 1000. Should there be several objects, you can narrow the list down by entering "FormProperty" into the "Entity Name"
field.

To view all changes made by the administrator with the login name "jsmith", enter "jsmith" into the "User" field and search. You will get up to 1000
changes, with the most recent changes shown first by default. If you want to filter the results, you could enter a start and end date to see only changes
made within that date range.

You can also export the search results to Excel by clicking the "Export Data" link below the table.

Security Managers

A security manager contains configuration around user authentication, self-registration and session management. Each space is associated with a
security manager (though security managers can be shared between spaces).

On a new installation, the default security manager supports user authentication against the TM user base. In addition, TM provides templates for other
security manager for LDAP, ADFS and SSO authentication. You can create new security managers based on a template and configure existing security
managers to match your needs. You can also export security managers and import them to other Transaction Manager instances.

Each security manager contains one or more authentication providers, which perform the actual authentication of a user. Multiple authentication
providers can be chained (e.g. authentication first against the TM database, then several external LDAP directories). If an authentication provider can
authenticate a user successfully, the user is deemed to have logged on successfully, and subsequent authentication providers are not processed.

Viewing the Set of Security Managers
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To view the set of security managers defined in your TM instance, go to "Security > Security Managers" (the screenshot below shows the set of security
managers on a new system).

Security Managers

Home Dashboard » Security Managers

¥ Active Only Clear

Import Export New

Name Description Active Default Last Modified Action

LDAP Security Manager Provides a LDAP user account security manager v 10 Apr 2013 by system (2] &) N

Local Security Manager Provides a local database user account security manager v v 10 Apr 2013 by system 2
Export Data

The list of security managers

You can create new security managers, edit and delete existing security managers, export a single or all security managers and import a security
manager archive.

Note: There always has to be a default security manager. Therefore, you cannot delete the default security manager.
You can also see when a security manager was last modified and by whom in the "Last Modified" column.

Creating a Security Manager

To create a security manager, go to "Security > Security Managers" and click the "New" button. You will be directed to the "New Security Manager" page.

New Security Manager
Home Dashboard » Security Managers » New Security Manager

Security Manager Template®  LDAP Security Manager x| &

New Security Manager Name* My LDAP Security Manager @

CEV’ICE‘

Creating a security manager

Select a template to base your security manager on, and enter a unique name for the security manager.

Save your changes. The security manager will be created with its initial settings based on the selected template. The following section explains the
configuration options that are available.

Configuring a Security Manager

=

To edit a security manager, go to "System > Security Managers" and click the "Edit" icon ( )’) next to the security manager. You will be directed to the
"Edit Security Manager" page.

Local Security Manager
Home Dashboard » Security Managers » Security Manager

Security Manager I Spaces | Authentication Providers User Enroliment Passwords |

Name™” Local Security Manager @

Provides a local database user account security manager
Description

Default Security Manager [ @
Disable User Profile Editng [ @
Active [v @

Last Modified 27 Apr 2015 - 17:28 by kkremarova

User Authentication
2 Factor Authentication j @
Max Login Attempts = 3 j 9
Lockout Duration 1 minute j a9

Session Timeout 30 minutes j @

LS

Editing a security manager
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Basic Security Manager Settings

The "Security Manager" tab contains some basic settings:

The "Name" field contains the unique name that identifies the security manager.

The "Description" field is optional and is used for display purposes only.

The "Default Security Manager" checkbox should be ticked for the default security manager for your TM system. It is used whenever a space does not
explicitly specify a security manager. Make sure that there is always a default security manager.

The "Active" checkbox can be used to deactivate (rather than delete) a security manager. It is then hidden from the default view, but can later be
reactivated. Note that deactivating a security manager also reconfigures any spaces that were explicitly set to use this security manager to instead use
the system default security manager instead.

The "Disable User Profile Editing" checkbox can be ticked if you would like to prevent users from editing their profile data. This setting applies to all
spaces using the security manager.

The "User Authentication" section provides settings related to user authentication and lockout.

The "2 Factor Authentication" dropdown allows you to specify a service that will be used by this security manager for two-factor authentication. See the
Transact Integration Guide, chapter "Access Control" for details on two-factor authentication. Do not change this setting unless you have read the
section in the Transact Integration Guide as you could lock administrators (including yourself) or users out of the system.

The "Max Login Attempts" field holds the number of successive failed login attempts a user is granted before their user account is locked. Every time a
user logs in successfully, the failed login attempts counter is reset to zero.

The "Lockout Duration" field defines what happens when the user exceeds the maximum number of failed login attempts. You can choose to lock the
user account for a limited duration (after which the account reactivates automatically and the number of failed login attempts is reset) or forever (account
can only be reactivated by an administrator). While an account is locked, login attempts are ignored and do not increment the failed login attempt
counter.

The "Session Timeout" field holds the time after which idle sessions shall be discarded and the user will be forced to reauthenticate.

Spaces Associated with the Security Manager

The "Spaces" tab shows the set of spaces that are explicitly configured to use this security manager.
Local Security Manager

Home Dashboard » Security Managers » Security Manager

Security Manager | Spaces | Authentication Providers User Enroliment Passwords

Available Assigned
ANZ = Gov Assist LI
Avoka Forms Transact Maestro
Avoka 550 ADFS UWS ORS

Avoka SSO Portal ADFS
Bank of Melboume
Bank of South Australia >
Bendigo

Spaces & Modules | BT Portal g
Business Reports
CAAPortal
Classic Finance Comporation
Classic Gov Assist
CTMaguire
Department of the Interor
EPA TransactField App
Finance Corporation LI LI

Save Close

Assigning spaces to a security manager

Note: The default security manager is associated with all spaces that do not explicitly define the security manager. This is not reflected in the "Spaces"
tab, which shows only explicit associations between spaces and security managers.

Authentication Providers

The "Authentication Providers" tab allows you to define the authentication providers that the security manager will use to attempt to authenticate a user
(the screenshot below shows an example). You can add one or more authentication providers; if multiple authentication providers are defined, they are
called in order until one of them can successfully authenticate the user (login success) or all of them fail to authenticate the user (login failure).

Edit Security Manager

Home Dashboard » Security Managers » Security Manager

Security Manager | Portals | Authentication Providers S50 Auth Fitter User Enrolement | Passwords

Hame Description Action
Local Authenticator Provides a local database user account authentication provider. @ z
Company LDAP Authenticator Provides a LDAP user account authentication provider. P& @

Close

The authentication providers configured for a security manager



In case of login failure, the login failure attempts counter is incremented and user account locked if required.

If login succeeds, the login failure attempts counter is reset to zero and a user session is created with the set of roles associated with the user (if any).
You can add and delete authentication providers. Please ensure there is always at least one authentication provider as the security manager cannot
function otherwise.

You can reorder the authentication providers by using the "Move Up" icon (‘m’) next to the authentication provider.
To add an authentication provider, click the "New" button. Fill in the details for the new authentication provider on the "New Authentication Provider"
page.

New Authentication Provider

Home Dashboard » Security Managers » Security Manager » New Authentication Provider

Authentication Provider Template* = LDAP Authentication Provider ﬂ 7]

Authentication Provider Name*  Company LDAP Authenticator 2]

Save Cancel

Creating an authentication provider

Choose one of the available templates from the "Authentication Provider Template" dropdown. The template defines the initial settings for your
authentication provider. Note that the templates are built into TM and do not correspond to the set of authentication providers defined on your system.
Enter the name of the new authentication provider into the "Authentication Provider Name" field and save your changes. A new authentication provider
based on the template will be created and added as the last authentication provider for the current security manager.

Now you can configure the new authentication provider. Click on the "Edit" icon ( ’ﬁ) next to it to get to the "<Authentication provider name>

Authentication Provider" page.
Company LDAP Authenticator Authentication Provider

Home Dashboard » Security Managers » Security Manager » Authentication Provider

Authentication Provider | Parameters | LDAPTest |

Mame* Company LDAP Authenticator 2]

Description = Provides a LDAP user account authentication provider. @

Classname*® com.avoka fc.core securty.Ldap UserDetailsAuthenticationProvider Q9
Authentication Order 1 @

Save Close

Editing an authentication provider

You can change the name and description on the "Authentication Provider" tab. Do not change the "Classname" field, and use the arrows on the
"Authentication Providers" tab of the parent page to change the ordering instead of changing the "Authentication Order" field.

The "Parameters" tab allows you to configure the settings exposed by the authentication provider. The set of parameters is specific to the authentication
provider template. Generally, you should not add or delete parameters (except possibly for Groovy-based authentication parameters) but instead adjust
the values of existing parameters.

Company LDAP Authenticator Authentication Provider

Home Dashboard » Securily Managers » Securiy Manager » Authenfication Provider

Authentication Provider s | LDAPTest |

Name Type Value Description Action

Idap Distinguishedh String i izhed LDAP attribute that contains the user's distinguished name A &
IdapattributeEmail String mail LDAP attribute that contains the user's email address A "_]
ldapAttributeFrstName String givenhame LDAP attribute that contains the user's first name e l=a)
ldapattributeGroups String memberOf LOAP attribute that contains the user's groups A m
ldapAttributeLastName String =n LDAP attribute that contains the users last name A8
IdapaAttributeMobde String mobile LOAP attribute that contains the user's mobile number A ;‘|
ldapattributesProfileMapping String givenName=Given Name; sn=Family Name; mail=Email, LOAP attributes to User Profiie mapping ’Z‘| ;j

m..
ldapattributeUserName String sAMAccountiame LDAP attribute that contains the user login user name A a
ldapSearchBase String QU=Users, OU=NyBusiness,DC=mycorp,DC=local The LDAP search base to use during user authentication @8
ldapSearchFilter String ({sAMAccountMame={0}) The LDAP search fiter to use during user authentication ’2 ﬁ
ldapSearchSubTree Boolean frue LDAP search sub tree flag, or perform single level search if false. 2 ﬁ
ldapSen, The password for the user defined in 'dapServerUser’ A a
IdapServerUrl String dap://127.0.0.1:389 The URL of the LDAP server @ g
ldapServerUser String The user DN that will be used when contacting the LDAP server A8
ldaplserDnTemplate String {0y The LDAP User Distinguished Name (DN) Template for user A8
authentication
Close
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The parameters for an LDAP authentication provider

Finally, you can test LDAP based authentication providers using the "LDAP Test" panel.

Testing authentication for an LDAP authentication provider

Choose a space associated with the current security manager.

For testing authentication, enter a user name and password and click "Authenticate User".The authentication provider will attempt to authenticate the
user using the current parameter values. The results will be displayed in the "LDAP Results" field.

To do a lookup in the LDAP directory, choose a space, enter a user name and optionally tick "All Attributes” to return the full set of LDAP attributes. Click
"Lookup User".The authentication provider will attempt to look up the user in LDAP and retrieve the relevant attributes. The results will be displayed in
the "LDAP Results" field.

To add a user to a space, choose a space, enter the user name and click "Add User To Portal". The user must not yet exist in TM.The authentication
provider will attempt to load the user details from LDAP and create a new LDAP-based user account for the user, associated with the selected space.
The results will be displayed in the "LDAP Results" field.

Adding a Single Sign-On Filter
The "SSO Auth Filter" tab allows you to add a filter to enable Single Sign-On (SSO) authentication.

Edit Security Manager

Home Dashboard » Security Managers » Security Manager

| Securiy Manager [ Portals I Authentication Providers S50 Auth Filter | User Enroliment ] Passwaords ]

Enable SSO Fiter [~ @

Get S50 Auth Token Script

return null

@

Groovy Script Getting Started Guide Awvoka TM Javadoc AP

Auth OK Response Script

return true

@
Groovy Script Getting Started Guide  Avoka T Javadoc AP

Configuring SSO for a security manager

To enable the SSO filter, tick the "Enable SSO Filter" checkbox.

Customize the filter behavior by modifying the two Groovy scripts:

The "Get SSO Auth Token Script” field should be modified to retrieve the SSO token from the request. The "Auth OK Response Script" field can be
modified to customize the behavior on successful authentication. Please refer to the TM Groovy services guide ("System > Groovy Services Guide" for
more information on these scripts.

Save your changes. The effects will be applied immediately — be sure to test any changes thoroughly.

Customizing User Enrollment

User accounts are generally created in one of two ways: An administrator creates the user account via the management console, or the user can apply
for an account on a space. User self-registration is a convenient feature but it might not be supported for all spaces (for example, the management
console does not offer self-registration for security reasons).

Users who are self-registering can be asked to pass email verification (by clicking on a link in an email sent to their nominated email address). In
addition, it is possible to enable pending user enroliment, which means that new accounts must be approved by an administrator.

The general steps for a user to register an account using pending user enroliment are as follows (many of the steps are customizable as discussed later
in this section):

1. User registers an account with a Transaction Manager space
If pending user enrollment is enabled, the user will not be logged on right away. Instead, they are shown a page notifying them that their
account will need to be approved.

2. Transaction Manager sends an email to all members of the group "Receive User Account Creation Alerts", alerting them of the account creation
request.
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3. An administrator logs on to the management console and reviews the new user account. They can then choose to either activate or reject the
user.

4. Once the user account has been updated, Transaction Manager sends an appropriate email to the user. If the user was approved, they can
now log on to the space they registered the account on.

The "User Enrollment” tab allows you to customize user self-registration (enrollment) procedures.
Edit Security Manager

Home Dashboard » Security g » Security Manager

Security Manager | Portals ] Authentication Providers S50 Auth Fiter | User Enroll | Passwords

Enable User Creation V¥ @

Enable User Registration [V &

reCAPTCHA Account Creation Protection
UsereCAPTCHA [~ @

reCAPTCHA Private Key  6Li-BISAAAAAG Fwtdds-By2TREE2PxgMNBzk Tgu @

reCAPTCHA Public Key  6Li-BISAAAAAGe0093UCNZguETBH G50c @

User Email Address Verification

Enabie Emai Verification [~ &

Max Days to Verify 1 ;I @

Email Verification Subject  Transaction Manager: Email Address Verfication o
Dear ${userkeecount fullName},6 <br/><br/>
You have requested & user account on ${portalName}. Please confirm your email address here:

> >

S{verificationUrl}">S{verificationUrl}</a> <br/><br/>

Email Verification Message

@

Administrator Account Approval
Account Approval [~ @

Email Approved Subject @

Customizing user enrollment

The "Enable User Creation" checkbox controls whether new users can be created at all for spaces using the current security manager (whether by self-
registration or creation by an administrator).

The "Enable User Registration" checkbox controls whether users can self-register new accounts (note: depending on further configuration, users may be
asked to pass email verification and/or require administrator approval prior to being able to use their account).

The "reCAPTCHA Account Creation Protection" section allows you to configure a reCAPTCHA challenge (http://www.google.com/recaptcha) that users
will need to pass during self-registration.

If you would like to enable reCAPTCHA, tick the "Use reCAPTCHA" checkbox. If you have your own account with reCAPTCHA, enter the public and
private reCAPTCHA keys into the corresponding fields.

The "User Email Address Verification" section allows you to configure email verification.

You can use the "Enable Email Verification" checkbox to turn email verification on or off.

The "Max Days to Verify" dropdown lets you specify the time in days that users have to complete email verification. If a user does not verify their email
address in time, their account may be purged automatically (this avoids abandoned accounts polluting the system).

You can also customize the email sent to the user during email verification by editing the "Email Verification Subject" and "Email Verification Message".
Note: Ensure the email always contains the URL the user needs to access to complete email verification (the placeholder is "${verificationUrl}").

The "Administrator Account Approval" section allows you to configure pending user enroliment as described at the start of this section. To turn it on, tick
the "Account Approval" checkbox.

If you would like TM to send email to administrators belonging to the "Receive User Account Creation Alerts" when a user self-registers during pending
user enroliment, tick the "Notify Administrators on Change" checkbox and enter an email subject and message into the "Email Pending Subject" and
"Email Pending Message" fields.

If you would like TM to send email to users who have registered an account during pending user enrollment and whose account has been either
approved or rejected by an administrator, tick the "Notify User on Change" checkbox and enter email subjects and messages into the "Email Approved
Subject"”, "Email Approved Message", "Email Rejected Subject" and "Email Rejected Message" fields.

Once you save your changes, they will take effect immediately but will not affect user enroliment that is already in progress.

Password Security
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The security manager allows you to configure the criteria you would like to apply to passwords chosen by your users on the "Passwords" tab.
Local Security Manager

Home Dashboard » Security Managers » Security Manager

Security Manager I Portals I Authentication Providers S50 Auth Fitter ] User Enroliment Passwords

2

@

Minimum Password Length

Require Letters and Digits

Require a Special Character

OO0®

Require Mixed Case Letters @
ooa0oa, "
111111,
112233,
121212,
123123,
123456,
2000,
232323,
4444,
654321,

llegal Password Values E6€EEE,
6363969,
77777,
abecl23,
ashley,
avokal23,
avoka!Z3,
babygirl,
daniel,
dragen, v
iloveyou,

Save Close

Configuring password strength

Tick the "Require Letters and Digits" checkbox to require passwords to require at least one letter and one digit character.

Tick the "Require a Special Character" checkbox to require at least one non-alphanumeric character (e.g. !@#$%) in the password.
Tick the "Require Mixed Case Letters" checkbox to require at least one upper case and one lower case character in the password.
Set the "Minimum Password Length" field to the minimum number of characters you want to allow for passwords.

Add any passwords you want to specifically forbid to the "lllegal Password Values" field (comma-separated).

Once you save your changes, they will apply to new passwords. Passwords currently existing in the system will not be affected.



Permissions (Manager v5.0)

The following is the list of permissions in the TM management console. As a general note, permissions ending in "View." give read-only access to entities,
permissions ending in "Edit" allow modification of an entity and permissions ending in "Remove" allow deletion of entities. These permissions are separate in
the sense that "Edit" and "Remove" do not include or permit "View" access, but rather "View" is needed in order for "Edit" or "Remove" permissions to apply.
So for example, if you would like a role to include edit access to document types, you would add the permissions "Document Type View" as well as
"Document Type Edit" to the account.

The list below identifies and describes all of the permissions used in the TM management console.
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Admin Directory - This is a special permission that is required to access the management console. If a user does not have this permission, they will
not be able to use the management console.

Audit View - This permission provides access to the system audit log and user login history.

Collaboration Job View - This permission provides read-only access to collaboration job information, including viewing details about a collaboration
job and its steps, actions and events.

Collaboration Job Edit - This permission allows users to manipulate collaboration jobs (e.g. pausing/triggering job processing, editing job properties
and action details).

Collaboration Job Remove - This permission allows users to delete collaboration jobs. Note that only canceled jobs can be deleted.

Core Service Edit - This permission is needed to edit advanced service settings and some job-related services.

Data Retention View - This permission allows users to view global data retention settings.

Data Retention Edit - This permission allows users to modify and apply global data retention settings.

Db Version Update View - This permission allows users to view the database version history (listing automatic changes made to the database

schema during upgrades).

Delivery Details View - This permission allows users to view the set of delivery channels (part of the organization configuration) and manually trigger
delivery actions for submissions.

Delivery Details Edit - This permission allows users to create and edit delivery channels (part of the organization configuration). It is also needed to
delete delivery channels.

Delivery Details Remove - This permission is currently unused. This will be addressed in a future TM version. For now, please use "Delivery Details
Edit".

Deployment Property View - This permission allows users to view the list of system deployment properties and their values ("System > Deployment
Properties").

Deployment Property Edit - This permission allows users to edit deployment property values and access and modify email settings ("System > Email
Settings").

Document Type View - This permission allows users to view the list of document types and details about them ("Forms > Document Types").
Document Type Edit - This permission allows users to create and edit document types ("Forms > Document Types").

Document Type Remove - This permission allows users to delete document types ("Forms > Document Types").

Email Delivery Acknowledge - This permission is related to delivery of type "Email Secure”, where administrators receive an email notifying them of
new submissions, asking them to acknowledge delivery by accessing a page on TM and confirming. This permission controls access to the page in

guestion and should, therefore, be assigned to any administrators involved in processing secure email delivery.

Email Queue View - This permission allows users to access the system email queue ("System > Email Queue"). It does not include viewing details
about each email entry ("Email Queue Edit" is required for this).

Email Queue Edit - This permission allows users to create, modify and access details about email queue items ("System > Email Queue").

Error Log View - This permission provides access to the system error log ("System > Error Log") and error details. It also enables links to error log
entries on other pages.

Event Log View - This permission provides access to the system event log ("System > Event Log") and event details. It also enables links to event
log entries on other pages.

Export Application Package - This permission allows users to export application packages (bundles of forms and services) for organizations they
have access to.

Export Form - This permission allows users to export a form and all its versions ("Forms > Forms").

Export Form Version - This permission allows users to export a single form version.

Export Groups - This permission allows users to export one or more groups ("Security > Groups").

Export Metadata - This permission allows users to export the set of global metadata tags ("Forms > Metadata Tag Definitions").
Export Organization - This permission allows users to export an organization ("Forms > Organizations").

Export Portal - This permission allows users to export a form space ("Forms > Form Spaces").

Export Roles - This permission allows users to export one or more roles ("Security > Roles").

Export Services - This permission allows users to export one or more service definitions ("System > Service Definitions", "System > Job Services").
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Export Security Manager - This permission allows users to export one or more security managers ("Security > Security Managers").

Finder View - This permission allows users to view the list of finder categories ("Forms > Finder Categories").

Finder Edit - This permission allows users to create, modify and view details of finder categories ("Forms > Finder Categories").

Finder Remove - This permission allows users to delete finder categories ("Forms > Finder Categories").

Form View - This permission allows access to the list of forms ("Forms > Forms") and a read-only view of the majority of form configuration. It also
enables links to forms on other pages. Note that if you need to view form version or form data configuration details, you need the "Form Edit"

permission as the "Form View" permission does not include this.

Form Edit - This permission allows users to view all details about a form ("Forms > Forms") as well as create and edit forms. It includes editing form
versions and form data configuration.

Form Service Edit - This permission is a less powerful version of "Service Edit", which allows administrators to manage service definitions related to
form development.

Form Test - This permission exposes links to access forms on a space for testing. It also allows users to access the PDF receipt test harness (link in
the "Form URLs" section of the form edit page).

Form Data Retention - This permission allows users to edit form specific data retention settings (section headed "Transaction Form Data Retention"
on the "Details" tab of the form edit page).

Form Remove - This permission allows users to delete forms, form versions, form promotion entries and form data extract mappings.
Groovy Console - This permission allows access to the Groovy console ("System > Groovy Script Console").
Groovy Log View - This permission allows access to the Groovy log ("System > Groovy Service Log").

Group View - This permission allows users to view the list of groups ("Security > Groups") though it does not allow access to detail information (use
"Group Edit" if needed).

Group Edit - This permission allows users to create, edit and view details about groups ("Security > Groups").
Group Remove - This permission allows users to delete groups ("Security > Groups").
Group Assign - This permission allows users to assign users to a group. It is also necessary to access the "Forms" panel on the group edit page.

Import Action View - This permission allows access to the import log ("System > Import Log"). It does not include read only access to import action
details.

Import Action Edit - This permission allows users to edit and view details about import actions ("System > Import Log"). It is also currently necessary
to import form and space archives exported from another TM server, along with the "Import ..." permission corresponding to the entity to be imported.

Import Action Remove - This permission allows users to delete import actions ("System > Import Log"). Only completed import actions are eligible
for deletion.

Import Application Package - This permission allows users to import application packages (bundles of forms and services) for organizations they
have access to.

Import Composer Form - This permission allows users to import forms published by Transact Composer and view details about past imports
("Forms > Composer Package Imports").

Import Form - This permission allows users to import form version archives created by exporting a form version from another TM server. Note that to
import form version archives successfully, users also currently need the "Import Action Edit" permission.

Import Groups - This permission allows users to import group archives created by exporting one or more groups from another TM server.

Import Metadata - This permission allows users to import metadata tag archives created by exporting one or more metadata tags from another TM
server. In addition, this permission is needed to upload files with values for metadata tags of types "List" and "List Hierarchy".

Import Organization - This permission allows users to import an organization archive (containing organization configuration but no forms) exported
from another TM server. Note that only administrators with access to more than one organization will be able to see the import button

Import Portal - This permission allows users to import a space archive (containing space configuration but not the backing WAR file) exported from
another TM server as well as space WAR files. Note that to import space archives successfully, users also currently need the "Import Action Edit"
permission.

Import Roles - This permission allows users to import role archives (containing roles and associated permissions) exported from another TM server.

Import Security Manager - This permission allows users to import security manager archives exported from another TM server.

Import Services - This permission allows users to import service archives (containing service definitions and their service connections) exported
from another TM server.

Licensing Edit - This permission allows users to edit system licensing information and configure how licensing report data will be published to Avoka.
Metadata Tag View - This permission allows users to view metadata tags and their configuration details ("Forms > Metadata Tag Definitions").
Metadata Tag Edit - This permission allows users to create and edit metadata tags ("Forms > Metadata Tag Definitions").

Metadata Tag Remove - This permission allows users to delete metadata tags ("Forms > Metadata Tag Definitions").

Metadata Value View - This permission allows users to view values configured for metadata tags (on the organization or form version level).
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Metadata Value Edit - This permission allows users to create and edit values configured for metadata tags (on the organization or form version
level).

Metadata Value Remove - This permission allows users to delete values configured for metadata tags (on the organization or form version level).
Notification View - This permission allows users to view the list of notifications set up to appear on TM spaces ("System > Notification Messages").
Notification Edit - This permission allows users to create and edit notifications set up to appear on TM spaces ("System > Notification Messages").
Notification Remove - This permission allows users to delete notifications set up to appear on TM spaces ("System > Notification Messages").

Offline Sync Log View - This permission allows users to view the T.Field related offline sync and client logs ("System > T.Field Device Log",
"System > T.Field Sync Log").

Operation Chart View - This permission allows users to view a number of charts set up in TM (e.g. "Operations > Forms Activity", "System > Error
Log Trend" and the entries in "Analytics" except "History Analytics").

Operation Export Report View - This permission is currently unused.
Operation Form Events View - This permission is currently unused.

Organization View - This permission allows users to view information about an organization ("Forms > Organizations") and part of its configuration.
It also enables links to organizations on other pages.

Organization Edit - This permission allows users to create and edit organizations ("Forms > Organizations") and associated configuration
(categories, application packages.

Organization Remove - This permission allows users to delete organizations ("Forms > Organizations"). Because deleting organizations will also
delete all associated forms and submissions, this is a permission that should be assigned sparingly.

Organization Copy - This permission allows users to create a copy of an existing organization ("Forms > Organizations").
Organization Portal Assign - This permission allows users to assign spaces to an organization for form hosting purposes ("Forms > Organizations").

Organization Payment Edit - This permission allows users to view and modify an organization's payment configuration, including merchant account
information for the configured payment gateway.

Organization Property View - This permission allows users to view the set of organization property values (tab on the organization edit page).
Organization Property Edit - This permission allows users to edit and delete organization property values (tab on the organization edit page).

Organization Property Remove - This permission is currently not used (the edit permission also confers deletion privileges). This may be addressed
in future versions.

Organization Storage Edit - This permission allows users to edit organization data storage and retention settings (tab on the organization edit page).
Organization Transaction Audit Log View - This permission allows users to view organization transaction reports ("Reports > Org. Transaction Log").
Payment Log View - This permission allows users to view details of payments made by users ("Operations > Payment Transactions").

Portal View - This permission allows users to view details of spaces ("Forms > Form Spaces", "System > Modules").

Portal Edit - This permission allows users to edit spaces and all associated configuration ("Forms > Form Spaces", "System > Modules").

Portal Content Edit - This permission allows users to edit space content (all portal pages and resources).

Portal Style Edit - This permission allows users to edit some space content related to styling (the index page, childportal.css and all resources of
type .jpg).

Portal Remove - This permission allows users to delete spaces ("Forms > Form Spaces", "System > Modules").

Promotion View - This permission allows users to view the promotion log ("Forms > Form Version Promotions" and a tab on the form edit page).
Promotion 1 Development, Promotion 2 Ready For Test, Promotion 3 Test Failed, Promotion 4 Test Passed, Promotion 5 Ready For Production,
Promotion 6 Not Ready For Production, Promotion 7 Production - These permissions allow users to promote form versions to the promotion level
indicated in the permission ("Forms > Form Version Promotions" and a tab on the form edit page).

Property Type View - This permission allows users to view property types and their configuration ("Forms > Property Types").

Property Type Edit - This permission allows users to create and edit property types ("Forms > Property Types").

Property Type Remove - This permission allows users to delete property types ("Forms > Property Types").

Report View - This permission allows users to view reports ("Reports > Report Configurations"). It does not give read-only access to report
configuration details (use "Report Edit" if needed).

Report Edit - This permission allows users to create and edit reports ("Reports > Report Configurations").
Report Remove - This permission allows users to delete reports ("Reports > Report Configurations").

Report Render - This permission allows users to render reports on-screen ("Reports > Report Configurations". "Reports > System Report
Schedules", report schedules tab on the client edit page).

Report Schedule View - This permission allows users to view report schedules on the organization level (report schedules tab on the client edit
page).
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Report Schedule Edit - This permission allows users to create and edit report schedules on the organization level (report schedules tab on the client
edit page).

Report Schedule Remove - This permission allows users to delete report schedules on the organization level (report schedules tab on the client edit
page).

Report Schedule Trigger - This permission allows users to trigger report schedules on the organization level, causing an email to be sent out for the
most recent reporting period.

Request Log View - This permission allows users to view the request log and detailed information about each request ("Operations > Form
Requests"). It also provides access to the form rendering metrics ("Operations > Form Rendering Metrics").

Rest Delivery Service API - This permission allows users to invoke the REST Delivery API provided in TM.

Rest Delivery Service Invoke - This permission allows users to invoke REST submission delivery by accessing the REST delivery service.
Rest Service Definitions API - This permission allows users to invoke the REST Service Definitions API provided in TM.

Rest Transactions API - This permission allows users to invoke the REST Transactions API provided in TM.

Role View - This permission allows users to view the set of roles ("Security > Roles"). It does not give read-only access to role configuration details
(use "Role Edit" if needed).

Role Edit - This permission allows users to create, edit and view all details for roles ("Security > Roles").
Role Remove - This permission allows users to delete roles ("Security > Roles").

Role Assign - This permission allows users to assign user accounts to a role ("Security > Roles", "Security > User Accounts"). The set of roles that a
user can assign is further restricted based on whether the user is a global administrator.

Security Manager View - This permission allows users to view the set of security managers ("Security > Security Managers"). It does not confer
read-only access to security manager details (use "Security Manager Edit" if needed).

Security Manager Edit - This permission allows users to create, edit and view all details of security managers ("Security > Security Managers"),
including managing authentication providers.Note: "Service Edit" currently controls access to some content (such as creating security managers and
authentication providers and parameters). This may be addressed in a future release.

Security Manager Remove - This permission allows users to delete security managers ("Security > Security Managers").

Service View - This permission allows users to view the full set of service definitions ("System > Service Definitions"), service connections ("System
> Service Connections"), collaboration job service definitions ("System > Job Services"), server nodes ("System > Server Nodes") and scheduled
jobs ("System > Scheduled Jobs"). It does not give read-only access to the configuration details (use "Service Edit" if needed).

Service Edit - This permission allows users to create, edit and view configuration details of service definitions ("System > Service Definitions"),
service connections ("System > Service Connections"), collaboration job service definitions ("System > Job Services"), server nodes ("System >
Server Nodes"), scheduled jobs ("System > Scheduled Jobs") and system data retention settings ("System > Data Retention Management"). If you
would like a form developer to be able to modify their own form-related services without giving them access to all service types, you can use "Form
Service Edit" instead.

Service Remove - This permission allows users to delete service definitions, service connections, collaboration job service definitions, server nodes
and scheduled jobs.

Submission View - This permission allows users to view details for submissions in TM ("Operations > Form Transactions", "Operations >
Transactions History", "Operations > Transaction Delivery", "Operations > Saved Submissions", "Operations > Abandoned Submissions"). It also
enables links to submissions on other pages.Note that access to the actual content submitted by users is not granted by this permission. If needed,
use "Submission Data View" and "Submission XML Data View".

Submission Edit - This permission allows users to modify submission statuses and retry delivery.
Submission Data View - This permission allows users to view non-XML submission content (receipt and attachment content but not the submitted
XML) submitted by the user. It also provides access to the set of submission data extract values, including the form submission data page

("Operations > Form Submission Data").As this permission allows access to user-entered data, it may need to be handled carefully.

Submission XML Data View - This permission allows users to view XML submission content, i.e. the data entered into the form by the user.As this
permission allows access to user-entered data, it may need to be handled carefully.

Submission XML Data Edit - This permission allows users to edit XML submission content and delete submission data extract values.As this
permission allows write access to user-entered data, it may need to be handled very carefully.

Submission Save Edit - This permission allows administrators to open and fill in saved submissions ("Operations > Form Transactions", "Operations
> Saved Transactions"). This is useful in support cases where a user asks for help in completing a submission.As this permission allows access to
user-entered data, it may need to be handled carefully.

System Info View - This permission allows users to access some pages that provide information on the TM system and its performance ("System >
System Info", "Operations > TM Server Performance”, "Operations > LiveCycle Performance").

System Report Schedule View - This permission allows users to view report schedules for global reports ("Reports > System Report Schedules").

System Report Schedule Edit - This permission allows users to create and edit report schedules for global reports ("Reports > System Report
Schedules").

System Report Schedule Remove - This permission allows users to delete report schedules for global reports ("Reports > System Report
Schedules").Note: Currently TM also requires "Report Schedule Edit" for this to work. This will be addressed in future releases.

System Report Schedule Trigger - This permission allows users to trigger report schedules for global reports, causing an email to be sent out for the
most recent reporting period.
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Task View - This permission allows users to view the list of task submissions ("Operations > Assigned Tasks").
Task Edit - This permission allows users to create task submissions and edit task-related data ("Operations > Assigned Tasks").
Transaction Audit Log View - This permission allows users to view system transaction reports ("Reports > Transaction Log").

User View - This permission allows administrators to view the list of user accounts ("Security > User Accounts"). It does not include a read-only view
of user details (use "User Edit" if needed).

User Edit - This permission allows administrators to create, edit and view details of user accounts ("Security > User Accounts").
User Remove - This permission allows administrators to delete user accounts ("Security > User Accounts").
User Bulk Import - This permission allows administrators to bulk import user accounts defined in an Excel spreadsheet ("Security > User Accounts").

User Profile Edit - This permission allows administrators to create and edit profiles for a user account. It also allows administrators to mark a profile
as the default for a user.

User Profile Remove - This permission allows administrators to delete user profiles.
User Property View - This permission is currently unused.

User Property Edit - This permission is currently unused.

User Property Remove - This permission is currently unused.

Web Service Invoke - This permission allows users to invoke TM web services.



User Accounts (Manager v5.0)

A user account is a login to a Transact Manager space. A user account is characterized by personal data, their credentials, user type ("Local", "LDAP" or
"SSO"), one or more user profiles, the spaces they can log on to, the organizations they can access and the roles and groups they belong to.

Browsing the List of User Accounts

Creating a New User Account

Assigning Roles to User Account

Assigning Organizations to User Account
Changing the Spaces Assigned to a User Account
Changing a User's Group Associations

User Profiles

Login History

Removing a User Account

Browsing the List of User Accounts

To view the list of user accounts that are currently set up in your instance of Transact Manager, follow the steps below.

1. Select the Security menu.
Select Security will display the security drop down menu.

2. Click User Accounts from the menu.
Selecting User Accounts will display a list of user accounts currently created in your instance of Transact Manager.

The screenshot below displays a list of User Accounts created in an instance of Transact Manager.

User Accounts
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You can use the search box to find a specific user account based on the login name. You can also filter the list by status ("Active", "Inactive", "Locked",
"Pending", "Rejected"), and user type. In addition, you can choose to show only user accounts associated with a specific space.

You can export the search results to Excel by clicking the "Export Data" link below the table.

From this page, you can add, edit ( E)l , also allows you to assign spaces, roles and groups to the user) and delete ( E ) user accounts.

Creating a New User Account
New user accounts can be created as needed. Follow the steps below to create a new user account.
1. Navigate to the User Accounts screen (Security > User Accounts).

2. Click the New button.
Clicking New will display a blank form and direct you to the User tab. The screenshot below displays this blank form.
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. Provide a Login Name for the new user

Login Name is what the user will enter when logging into a Transact product (Maestro, Manager, Composer). Please be aware that the Login Name
must be the same as the Login Name used for the Maestro cloud instance. If the Login Name is not the same users will not be able to update TM
form versions built in Maestro.

. Select the User Type

For users managed by Transaction Manager, use "Local" (selected by default). If you would like to manually set up an LDAP user, choose "LDAP"
(note that you will get a restricted field set as the user is managed in the LDAP directory in this scenario - see section "Authentication Providers" for
more on user authentication); similarly, choose "SSQO" for an SSO user account (only applicable if you are using an SSO security manager).

. Enter a password for the user account

Password and Confirm Password must be the same value. By default, the password must be at least twelve, but at most 20 characters long and
contain at least one special character and mixed case letters (the exact requirements depend on the security manager configuration for the chosen
space).

If "Change Password After Login" is ticked, the new user will be forced to change their initial password when logging on, and will be unable to
access any restricted content until this has been done.

. Fillin the personal details (given and family names, email address and phone numbers).

. Choose a space from the "Spaces" dropdown.

This will be the space (either the management console or one of the user spaces) that the user will be associated with initially. More spaces can be
added later from the Spaces tab.

. For security reasons, you must enter your own password to create the user.

. Once you have filled in all the data, save the new user account.

Once the user account has been saved you will be directed to the Roles tab. Note that the user will not have access permissions until they have
been assigned a role. When creating a new user, Transact Manager will automatically open the "Roles" tab for you so you can assign roles as
needed.

The following sections describe how to assign one or more roles and spaces to a user account and set up organization access. These steps are
essential for setting up functional administrator users.

Assigning Roles to User Account

There are several scenarios where you might want to change the roles assigned to a user account:

® A new user account needs to be set up with its initial set of roles, and
® existing user accounts may need further access rights.

If you suspect that a user account may have been compromised, you can remove all their roles and spaces and make the user account inactive as well,
making it unable to log on or perform any restricted actions.

Follow the steps below to assign roles to the user account. Remember, if you are creating a new user account you will be automatically directed to the Roles
tab once you save the details on the User tab.
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1. Navigate to the User Account details if needed (Security > User Accounts)

2. Click the "Edit" icon ( E}l ) next to the user account and switch to the "Roles" tab

The screenshot below displays the Roles tab of the selected user account.
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Please note that there are precautions built into the Transact Manager management console that prevent organization administrators from assigning
themselves inappropriate roles. If an organization administrator edits the role assignments for a user account, they will see only roles for which
"Organization Assignable" is ticked. All other roles will be hidden. Global administrators, on the other hand, can see and assign all roles to other
user accounts (if their own roles contain the permissions around role assignment).

3. To change the roles assigned to a user account, select roles (on Windows, use the Shift and Ctrl keys to select multiple roles) and use the ">" and
"<" button to assign and remove them.
You can also add all available roles to a user account by using the ">>" button; likewise, the "<<" button will remove all roles, leaving the user
account without any privileges.

4. For security reasons, you may have to enter your own password to save changes to the roles.

5. Once all roles have been assigned appropriately, save the user account.
The roles assigned to a user account are loaded when the user logs in, so changes will be visible to the user after logging out of the space and
logging in again.

Managing Role Expiry

Sometimes it makes sense to assign a role to a user for a limited amount of time (e.g. to allow Avoka support to help debug a problem). TM allows you to
configure an expiry time for user roles so you don't have to remember to remove the roles yourself.

Follow the steps below to manage role expiry times for a user.

1. Navigate to the User Account details if needed (Security > User Accounts)

2. Click the "Edit" icon ( El ) next to the user account and switch to the "Roles Expiry" tab.
Each role assigned to the user will display on the Role Expiry tab. You can enter an expiry time for each role or remove expiry times if needed

User | Organzations | Spaces | Roles | Rote Expiry | Groups | Group Expiy | UserFrofies | Login History
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3. Select the Calendar icon next to the role.
This will display a calendar pop up.
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4. Select a date and time for role expiry.
You should select the time first as the pop up will close on selection of a date.

5. Save your changes.

When the expiry time arrives, the background job "Security Policy Manager" (see chapter "Scheduled Jobs", section "The Security Policy Manager
Job") will remove the role from the user account.

Assigning Organizations to User Account

Users associated with the TM management console can be given global access or restricted to one or more organizations. Organization administrators have
restricted access privileges; in particular, whenever there is data associated with organizations, they will see only the subset relevant to their own organization
(s) (e.g. on the "Forms" page, they will see only their own forms). Organization administrators can also assign only organization assignable roles to other
administrators (effectively preventing them from promoting themselves or others to global administrators).

To change the organizations a user account can access, following the steps below.
1. Navigate to the User Account details if needed (Security > User Accounts)

2. Click the "Edit" icon ( E}l) next to the user account and switch to the "Organizations"” tab.
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£ o
|

3. Assign the user to the necessary Organization(s).
To change the Organizations assigned to a user account, select Organizations (on Windows, use the Shift and Ctrl keys to select multiple spaces)
and use the ">" and "<" button to assign and remove them.
You can also add all available Organizations to a user account by using the ">>" button; likewise, the "<<" button will remove all Organizations

4. For security reasons, you have to enter your own password to save changes to the organizations.

5. Once all Organizations have been assigned appropriately, save the user account.

Note: Only global administrators can assign all Organizations to user accounts. Administrators restricted to one or several organizations can assign
only the spaces they themselves have been assigned.

Enable Global Access

The "Enable Global Access" checkbox controls whether a user is a global administrator or an organization administrator. If ticked, the user automatically has
access to all organizations. Otherwise individual organizations must be assigned to the user.

The screenshot below displays the “Enable Global Access” checkbox.
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Changing the Spaces Assigned to a User Account

Before a user can log in to the management console or a user space, they need to be associated with the corresponding space record. An existing user can
register for a space account if the user space supports this; the management console does not support self-registration.

To change the Spaces a user account can access, following the steps below.

1. Navigate to the User Account details if needed (Security > User Accounts)

2. Click the "Edit" icon ( E,l ) next to the user account and switch to the "Spaces" tab.
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3. Assign the user to the necessary Space(s).
Users requiring access to Maestro will need to be given the Transact Maestro and Transact Maestro 5.0 spaces. Users requiring access to Transact
Manager will need to be given the Transact Manager space.
To change the spaces assigned to a user account, select spaces (on Windows, use the Shift and Ctrl keys to select multiple spaces) and use the
">" and "<" button to assign and remove them.
You can also add all available spaces to a user account by using the ">>" button; likewise, the "<<" button will remove all spaces.

4. Once all spaces have been assigned appropriately, save the user account.

G) Note: Only global administrators can always assign all spaces to user accounts. Administrators restricted to one or several organizations can
assign only the spaces they themselves have been assigned.

Changing a User's Group Associations

To change the Groups a user account can access, following the steps below.

1. Navigate to the User Account details if needed (Security > User Accounts)
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2. Click the "Edit" icon ( E’l ) next to the user account and switch to the "Groups" tab.

User | Organzations | Spaces | Rokes | RoleExpiy | Groups | GroupExpiy | UserProfies | Login History

Available Groups Assigned Groups

Job Applcants = Receive Submission Updates =
Job Applcants AKH
Job Applcants JCD
Job Applcants JXH
Job Managers
Job Managers AKH =
Job Managers JCD
Groups  Job Managers JXH <
Job Reviewers
Job Reviewers AKH
Job Reviewers JCD =
Job Reviewers JXH
My stuff only
Receive Delivery Escalation Alerts
Receive Outstanding Payment Alerts
Receive Promotion Alerts = -

Ea -

>

3. Assign the user to the necessary Group(s).
To change the groups assigned to a user account, select groups (on Windows, use the Shift and Ctrl keys to select multiple groups) and use the ">"
and "<" buttons to assign and remove them.
You can also add the user to all available groups by using the ">>" button; likewise, the "<<" button will remove the user from all groups.

4. Once all groups have been assigned appropriately, save the user account.

Managing Group Expiry

Sometimes it makes sense to assign a user to a group for a limited amount of time. TM allows you to configure an expiry time for user groups so you don't
have to remember to remove the user from the groups yourself.

To manage group expiry times for a user, follow the steps below.

1. Navigate to the User Account details if needed (Security > User Accounts)

2. Click the "Edit" icon ( El ) next to the user account and switch to the "Group Expiry" tab.
Each role assigned to the user will display on the Role Expiry tab. You can enter an expiry time for each role or remove expiry times if needed.
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3. Use the calendar icon to set the group expiry details.
You should select the time first as the pop up will close on selection of a date.

4. Save your changes.

Save your changes. When the expiry time arrives, the background job "Security Policy Manager" (see chapter "Scheduled Jobs", section "The

Security Policy Manager Job") will remove the user account from the group.
User Profiles
Users can set up one or more profiles that can be used to pre-populate forms if the user space supports this. Each profile has the same fields, and each field
corresponds to a user property (for more on properties and how to set them up, see chapter "Organization Configuration”, section "Property Types"). When
you create a user via the management console, a default profile is created automatically.
Examples for user profile fields are first name, last name and phone number. Transact Manager allows you to define whichever fields you need and map
them to locations in a form data configuration so they can be pre-populated into the form.
Login History
The Login History tab displays a list of login attempts for the user. To view the login history for a user account follow the steps below.

1. Navigate to the User Account details if needed (Security > User Accounts)
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2. Click the "Edit" icon ( E’l ) next to the user account and switch to the "Login History" tab.
The Login History tab gives you information on the event type, date and time as well as what space (portal) was accessed.

| Uner ldlp.l:m J Spacen l Py | P Eviry |_ i g J hrong Enpiry :I.Pl-ﬁn-'x | Login Hintory |
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Removing a User Account

If you wish to disable a user account, you have two options:

1. You can deactivate the account, which will make them unable to log on but preserve the user record in Transaction Manager, or
2. You can delete the user account, which irrevocably removes all data associated with the user account.

Note that submissions made by a user will be preserved even after their user account is deleted; however, these submissions will not be associated with a
user any more.

Deactivating a User Account
To deactivate a user account, follow the steps below.

1. Navigate to the User Account details if needed (Security > User Accounts)

2. Click the "Edit" icon ( El ) next to the user account.
3. Choose "Inactive" from the "Account Status" dropdown

4. Save your changes.
The user account record still exists, but the user can no longer log on or access restricted content.
To reactivate the user, simply edit the user account and choose "Active" from the "Account Status" dropdown, then save.

User | Organcations | Spaces | Roles | Rok Expiy | Groups | GroupExpiy | UserProfies | Logi History |

User Details
Login Mame " kerrylearer
User Type  Local v
Password
Confiem Password
Change Password After Login
Given Name(s)"  Kerry
Famiy Name* Learner
Emai”  kleamer@email.com
Mobile
Phone
Emal Verfication Required

2 Factor Authentication Required

I Account Status*  Inactive v I

Temporary Lockout Ends
Failed Login Attempts 0
Created Al 8:50 AM on 24 May 2017
Last Accessed  10:51 AM on 24 May 2017

UserKey 0b81558e5000081162f8072¢02a78a05

- [

Deleting a User Account
To delete a user account, follow the steps below.

1. Navigate to the User Account details if needed (Security > User Accounts)

2. Click the "Delete" icon ( E ) next to the user account.
Since this operation will permanently remove the user record, you will be asked to confirm your decision.

_ X
elearning.avoka.com says:

Are you sure you want to remove this User Account?

Note that you cannot delete the user you are currently logged on as, nor can the system-generated account "Root Administrator" be deleted.

Even after a user account has been deleted, the changes the user made to the system are still visible in the audit log (see section "Tracking
Changes").
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Organization Configuration (Manager v5.0)

Transaction Manager is designed to accommodate anything from a single organization with a single form to hosting multiple organizations with a number
of forms, and multiple form versions.

Search

Concepts

The following are the core concepts relevant to this chapter:

User: Users are people who are using Transaction Manager. There are two categories of users: Administrators use the Transaction Manager
management console, whereas space users use a user space to fill in forms.

Organization: An organization is an entity that owns forms. Separate Transaction Manager organizations are usually set up for different organizations,
different regional branches of an organization, or different products (with different brands). Each organization has properties which will change the way
forms appear and operate. Properties can be used to control things like colors, logos, addresses, signatures, form options, or almost any part of form
behavior.

Form: Forms are requested, completed and submitted by space users. A form is owned by an organization, and can be configured in many ways. Forms
are rendered as either HTML or PDF to the user.

Form version:

Each form can have multiple versions. A form version contains the set of versioned information for a form. To allow flexible switching between versions,
almost all data related to a form is versioned. Form versions contain the actual form template file (e.g. XDP or PDF), the form data configuration,
property and metadata values, attachments and other information.

Form data configuration: A form data configuration defines how prefill data are mapped into the form's XML schema and identifies special sections in
the form. Form data configurations are crucial for pre-populating forms with property values such as a logo, attachments and contact details.

Property: Properties are the attributes of organizations, users and forms that are used to define how a form appears and functions. Each property
consists of a property type describing the attribute and a set of property values (which are the concrete attribute values assigned to the entities that have
this attribute).

Metadata: Metadata values are the attributes of organizations and forms that are used to define externally visible information about the form. Other
applications can use web services to query the metadata set up in Transaction Manager.

XML prefill: An XML prefill definition can be used to allow the client organization to pass in an XML file at form render time. The data contained in the
XML file can then be used to pre-populate the form.

Property Types

Properties are crucial for pre-population of data into the form and are also used by TM directly. Using properties, you can configure all sorts of attributes
for your organizations and forms that will be passed into the form when the user requests it, for example branding, links to related resources, contact
details and help text.

Properties are always based on a property type defined for all entities of a certain scope (organization, form or user) which can then be assigned a value
for each entity.

This section tells you how to manage property types and how to assign property values to your entities.

Browsing the List of Property Types

To see the list of properties that have been set up in Transaction Manager, go to "Forms > Property Types".

Property Types

Home = Property Types

feard Scope | =] Clear

Property Name Org. Scope Data Type Description Action
Additional Services Form String Form landing page additional services message E' 'E
Address User String A&
Attachments Single Submit Method Form String If true, all atachments must be either electronic or manual but not both |:_' ’,a
AutoSubmit Form  Bookean )]
BPAY Biller Code Client  Number @&
BPAY Reference Number Client  Number A8
Credit Card Accepted Ciient  Boolean @&
Display Receipt Number Form Boolean Controls whether the receipt number will be displayed on the submission confirmation page. [~) x'_]
Eligibility Form String E E
Email User  String Email address [

b 110043 Export Data

Browsing the list of property types
You can filter the list using a substring of the property name, by scope ("Organization”, "Form" or "User") and data type (see the following section), and
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export the search results to Excel by clicking the "Export Data" link below the table.

This page allows you to create new property types and to edit ( E)l) and delete ( E) existing ones.

Adding a Property Type
To add a new property type, go to "Forms > Property Types" and click "New". You will be directed to the "Edit Property Type" page.
Edit Property Type

Home Dashboard » Property Types » Property Type

Name* Support Email Address
Description
Organization =l
Scope* Client ;I
Data Type™ Sting ;l
Read Only [T

Save Close

Creating a property type

Adding the Basic Data

Fill in a uniqgue name and (optionally) a description for the property type.

If you want the property to belong to a specific organization, select it from the "Organization" dropdown. This means that organization administrators for
other organizations will not see this property.

Set the "Scope" field to either "Organization”, "Form" or "User" depending on what entity the property is associated with.

Finally, the "Data Type" field can be used to define the domain of expected property values (see the following section).

The "Sequence" field allows you to introduce a custom order for your property values. On pages that display property values (i.e. "Edit Organization",
"Edit Form", "Edit User"), properties will be sorted by their sequence number. If no sequence is defined, properties are sorted by property name.

If the "Read Only" flag is ticked, the property cannot be modified. This is generally only the case for properties created by Transaction Manager on
startup (e.g. the user property "Email").

Save the data to create the property type. You can now assign values to it, but until you map the property to a location in a form data configuration,
these values will not be used (see Form Version Configuration (Manager v5.0)#_sec_setuppropertyprefillmappings).

Possible Data Types for a Property

To help restrict property values that a user can set up, properties can have one of several different data types.
The property data types that Transaction Manager offers are:

BooleanAccepts only the values "true" and "false".Example: Signature Required

NumberAccepts only numeric characters (0-9, +, -, .).Example: ABN

StringAccepts an arbitrary string.Example: Country

ListList property values are used to populate lists in the form. This means that list properties can have several property values assigned to
them, all of which will be passed into the form.Example: Agency Contact Name

ImageAccepts images of type PNG, GIF and JPG. Images can be uploaded to the server when assigning a value to the property.Example: Logo
Long TextAccepts a text file with HTML-style formatting, with no length restrictions. Long text files can be uploaded to the server when
assigning a value to the property.Example: Terms and Conditions

If you choose a more restrictive data type, administrators will be prevented from entering unacceptable values. This helps avoid errors caused by invalid
data being passed to a form.

Assigning a Value to a Property

To assign a value to an organization property, please follow the instructions in _sec_addorganizationproperties. Please note that when TM resolves
property values, it always uses the values stored for the form version. When a new form is created, the current organization property values are copied
to the form version to make up the initial set of property values for that form version.Changing organization property values will not have any effect on
the set of property values maintained by existing form versions. This is intentional and preserves existing versioned information.

To change the value for a versioned property value, please follow the instructions in Form Version Configuration (Manager v5.0)
#_sec_addingformversionproperties.

Deleting a Property Type

To delete a property type, go to "Forms > Property Types", locate the property type and click the "Delete" icon ( E). You will be asked to confirm this
action before the property type and any organization and user property values associated with it are irrevocably deleted.

Note: Property values maintained on the form version level are not deleted along with the property type. These property values store the key attributes
associated with the property type, and so can exist without being associated with a property type.

Metadata Configuration

Metadata in Transaction Manager is data describing the forms for classification and searchability purposes. Rather than being used internally to render
the forms like properties are, metadata is exposed to external systems via a web service interface that Transaction Manager provides.

This allows you to offer your users various ways of searching for and filtering forms while maintaining the metadata along with your form definition in
Transaction Manager. If you need a new search criterion, you can simply add a metadata tag to Transaction Manager and then define appropriate
metadata values for your forms.

42


https://servicedesk.temenos.com/kb/pages/viewpage.action?pageId=76189416#FormVersionConfiguration(Managerv5.0)-_sec_setuppropertyprefillmappings
https://servicedesk.temenos.com/kb/pages/viewpage.action?pageId=76189416#FormVersionConfiguration(Managerv5.0)-_sec_addingformversionproperties
https://servicedesk.temenos.com/kb/pages/viewpage.action?pageId=76189416#FormVersionConfiguration(Managerv5.0)-_sec_addingformversionproperties

Concepts

Metadata is organized into metadata tag definitions, which define a particular attribute you wish to expose (e.g. form type, creator or target audience)
and metadata tag values, which are concrete values for a metadata tag and a specific form.

To make it as easy as possible to set up metadata for all forms, metadata tags can have different scopes: either "Client" or "Form". Client metadata tags
are configured once per organization and new forms for a particular organization automatically inherit that organization's metadata tag values.

Metadata Tag Types

Transaction Manager allows you to declare types for your metadata tags. This can be useful if you wish to constrain metadata values to a certain domain.
The following metadata types can be used:

StringA generic type accepting any string.

DateA type accepting only date values. When assigning values to a date metadata tag, a date picker will be used.

ListA type defining a list of string values. When assigning values to a list metadata tag, a dropdown with all list values will be used.

List HierarchyA type defining a hierarchical set of lists (with a maximum depth of three). When assigning values to a list hierarchy metadata tag,
a series of three dropdowns will be used, with the selected item on one level affecting the choices shown in the next dropdown.

Browsing Metadata Tags

To view a list of all metadata tags set up in Transaction Manager, go to "Forms > Metadata Tag Definitions". You can filter the list by organization, using
a substring of the tag name or scheme, or by scope, and export the search results to Excel by clicking the "Export Data" link below the table.

Metadata Tag Definitions

Home = Metadata Tag Defintions

| = Scope [ :I Clear
New Export mport

Tag Hame Org. Scheme Required Scope Type Description Action
Agency Name Client  Text A8
AGLS Alternative Name Form  Text Alizmative name of the resource ™
AGLS Audience agls-audience Form  List The targeted audience of the form A8
AGLS Date Created 15085601 Form  Date The creation date of the SmartForm raf~a
AGLS Deseription Form  Text :;:rfi description of the SmariForm, mainky including what the form is about and who should [ &)
AGLS Form Name Form  Teod The name given to the SmartForm usually by its owner agency j :
AGLS Function AGIFT Client ::‘rarmy The business function of the agency who owns the SmartForm j &J
AGLS Jursdiction AGLSTERMS AglsAgent Clent  List The jurisdiction of the agency primarity responsible for the content of the SmartForm @ &
AGLS Language RFC3066 Form  List The language of the SmartForm content @ &
ﬁ?nlf Organization AGLSTERMS AglsAgent Client  Teod The organization name of the agency primarily responsible for the content of the SmartForm @ "=I

P 1-100f26 Export Data

Browsing the list of metadata tags
You can also create, edit and delete metadata tag definitions from this page, as well as export or import the set of metadata tag definitions. Metadata tag
values, however, are maintained elsewhere (see _sec_settingmetadatatagvalue for details).

Adding a Metadata Tag Definition

If you need to expose another attribute of your forms to external systems, you will need to add a new metadata tag definition.
Go to "Forms > Metadata Tag Definitions" and click "New". You will be directed to the "Edit Metadata Tag Definition" page where you fill in the
specification for the new tag (see below for an example with all fields filled in).

Edit Metadata Tag Definition

Home Dashboard » Metadata Tag Definitions » Metadata Tag Definkion

Metadata Tag I

Organization

Name*

Keywords
Form ;I

Tea

Scope*
Type*
Scheme

Required [

& comma-separated list of keywords describing the form.

Description

Creating a metadata tag

If the metadata tag is specific to an organization, choose it from the "Organization" dropdown. On the other hand, if the tag should be available to all
organizations, leave the dropdown blank.

Give your metadata tag a unique name and, optionally, a description.

Choose the most appropriate scope, i.e. "Client" or "Form". Generally, if you can use "Client" because all forms of that organization will have the same
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metadata value, do so instead of using "Form" as the scope. If you cannot determine a metadata value that is constant for each organization, you will
need to use "Form".

Choose the metadata type from the "Type" dropdown. If you are creating a list or list hierarchy tag, you will need to add list values to the metadata tag
after saving it.

Optionally, enter the tag's scheme name into the "Scheme" field.

The "Required" checkbox can be ticked if a value for this metadata tag must be assigned. If a default service definition of type "Form Meta Data" is set
up in TM, a form can be promoted only if it defines values for all mandatory metadata tags (see Form Configuration (Manager v5.0)#_sec_formpromotion
for more on form promotion).

Once you have saved the new tag, it will appear in the list.

Adding or Modifying List Values for Metadata Tags

For metadata tags of type "List" or "List Hierarchy", you need to define a set of list values that can be assigned to these tags. To view or edit list values
for a metadata tag, go to "Forms > Metadata Tag Definitions" and edit the tag.

Editing Values for a List Metadata Tag

If the tag is of type "List", switch to the "List Values" tab. You will see a list of the currently defined values as shown below.
Edit Metadata Tag Definition

Heme = Metadata Tag Definitions = Metadata Tag Definition

Metadata Tag | List Values |

Values | Apkhazian (ab) - Add
Afrikaans (af)

Albanian (sq) Edit
Arabic (ar)

Amenian (ry) Do
Azerbaijani (az) Upload
Bulgarian (bg)

Burmese (my)

Cambodian fkm)

Catalan (ca)

Chinese (zh)

Corsican (co) Ll

Save Close

Values for a list metadata tag

You can either modify individual values by using the "Add", "Edit" and "Delete" buttons, or upload a new set of values.

If you are modifying values individually, note that all metadata list values have a value as well as a sequence. This sequence is used to sort values when
the list is presented during metadata value assignment. If you wish to use sequences, please make sure sequence numbers are consistent and unique.
If you want to upload a new set of values, click the "Upload" button. You will then be directed to the "Metadata List Upload" page.

Metadata List Upload

Home > Metadata Tag Definitions > Metadata Tag Definition > Metadata List Upload

Import File* IC \Avoka TestCases\metadata\language csv Browse_. |

Upload I Cancel

Uploading a file containing list values
Browse to a CSV file containing the set of list values (one per line, no separators apart from line breaks) and click "Upload". When you upload new
values, all old values will be deleted. The CSV file will be parsed, and the values contained in it will be added to the list in the same order.

Editing Values for a List Hierarchy Metadata Tag

If the tag is of type "List Hierarchy", switch to the "List Hierarchy" tag. You will be able to create a hierarchical list of up to three levels, with values on the
top two levels containing an arbitrary number of children.

Edit Metadata Tag Definition

Home > Metadata Tag Definitions = Metadata Tag Definition

Metadata Tag | | List Hierarchy

Values &3 Education aad

- £3 Primary Education =
] Parents
(L] Students Delete
] Teachers
53 Heath
tg Aging

Upload...

(] General
(7] Mental Health
=+ =3 Recreation
(7] Eishing
"wJ Hiking
[+ Sports
) Cricket
(] Rugby

Values for alist hierarchy metadata tag

You can either modify individual entries by using the "Add", "Edit" and "Delete" buttons, or upload a new set of values.

If you are modifying values individually, please note that all metadata list values have a value as well as a sequence. This sequence is used to sort
values when the list is presented during metadata value assignment. If you wish to use sequences, please make sure sequence numbers are consistent
and unique. Sequences are used to sort list values on the same hierarchy level with the same parent, so you can re-use the same sequence numbers
for groups of values on different hierarchy levels or with different parents.
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If you want to upload a new set of values, click the "Upload" button. You will then be directed to the "Metadata Hierarchy Upload" page.
Metadata Hierarchy Upload

Home = Metadata Tag Definitions = Metadata Tag Definition > Metadata Hierarchy Uplead

Import File* IC \Avoka TestCases'\metadata'category.csv Browse_

Upload | Cancel

Uploading a file containing list hierarchy values
Browse to a CSV file containing the set of list values as follows: Each line contains three values separated by commas. These values define the values
at the three hierarchy levels. You can leave the last or last two values blank.An example for a valid hierarchy file is shown below.
Education,,
Education,Primary Education,
Education,Primary Education,Parents
Education,Primary Education,Students
Education,Primary Education,Teachers
Health,,
Health, Aginag,
Health,General,
9 Health,Mental Health,
10 Recreation,,
11 Recreation,Fishing,
12 Recreation,Hiking,
13 Recreation,Sports,
14 Recreation,Sports,Cricket
15 Recreation,Sports,Rugby

LR I R

An example CSV file containing list hierarchy values
Click "Upload" to load the metadata list values from the file. When you upload new values, all old values will be deleted. The CSV file will be parsed, and
the values in it will be added to the list hierarchy in the same order.

Setting a Metadata Tag Value

To assign a value to an organization metadata tag, please follow the instructions in _sec_setuporganizationmetadata. Please note that when TM
resolves metadata values, it always uses the values stored for the form version. When a new form is created, the current organization metadata values
are copied to the form version to make up the initial set of metadata values for that form version. Changing organization metadata values will not have
any effect on the set of metadata values maintained by existing form versions. This is intentional and preserves existing versioned information.

To modify a versioned metadata value and view the set of metadata values for a form version, please follow the instructions in Form Version
Configuration (Manager v5.0)#_sec_setupformmetadata.

Deleting a Metadata Tag Definition
If you want to permanently remove a metadata tag, you can delete it. Please note that this operation cannot be undone and will also remove
organization metadata values defined for the tag, so use it with caution.

To delete a metadata tag, go to "Forms > Metadata Tag Definitions", find the metadata tag you want to remove, and click the "Delete" icon ( E). You
will be asked to confirm this action; once you do so, the tag and all organization metadata values will be irrevocably removed.

Note: Metadata values maintained on the form version level are not deleted along with the metadata tag. These metadata values store the key attributes
associated with the metadata tag, and so can exist without being associated with a metadata tag.

Importing or Exporting Metadata Tag Definitions

Please refer to Multi-Environment Support (Manager v5.0)#_sec_migratingmetadatatags on how to export and import metadata between servers.

Organization Configuration

In Transaction Manager, forms are owned by an organization, and organizations have properties and metadata values that are used by the forms.

You will need at least one organization configured in Transaction Manager. Setting up multiple organizations allows you to customize branding and other
organization related configuration, as well as allowing you to set up administrators with access rights to only data associated with a single organization.
Each organization has a set of attributes associated with it. Some of these attributes are required (e.g. name, description), while others are optional. The
set of optional attributes can be extended by using properties to match the requirements of your forms (see _sec_propertytypes).

Browsing the List of Organizations

To view the list of organizations set up in Transaction Manager, go to "Forms > Organizations". See the screenshot below for an example of what you
should be seeing.
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Organizations

Home Dashboard » Organizations

[¥ Active Only Clear

New Copy Import

Organization Name Client Code Active Last Modified Action

. A0
Administrative Services DAS v 31 Mar 2014 by lpammer@avoka.com <] i | | 4
Department of Health DOHA v 27 Jun 2012 by administrator @1
FinanceCorp fincorp v 28 Mar 2013 by administrator @ & ?
Northern Territory Government ntgov v 26 Mar 2014 by Ipammer 2 ﬁ ?
Quick Start Client quick v 31 Oct 2012 by administrator 2 E ?
Test Delete Client tdel v 13 Mar 2014 by Ipammer@avoka.com @4
Test Import Client tic v 10 Jul 2013 by Ipammer@avoka.com 2 ﬁ ?

Export Data

Browsing the list of organizations
You can filter this list using a substring of the organization name, as well as the client code and client key, and filter out organizations that do not have
the "Active" flag by ticking the "Active Only" checkbox. You can also export the search results to Excel by clicking the "Export Data" link below the table.

This page allows you to create new organizations, create a copy of an organization and edit ( @) or delete ( ﬁ) existing organizations. These
operations are described in more detail in the following sections.

You can also export ( i /) or import organizations. This is described in detail in Multi-Environment Support (Manager v5.0)#_sec_migratingorganization.

Creating an Organization

Select "Forms > Organizations" to get to the "Organizations" page. Click "New" to create a new organization. You will see a blank form as shown below.
New Organization

Home Dashboard » Organizatiens » Organization

Organization | I I [

Name* | Example Company @
Chent Code* | exaco @
Description
Credential Alias o
Active W @

Creating an organization

Setting Up the Organization's Essentials

First, complete the mandatory properties shown in the "Organization” tab.

Set the "Name" field to the name of the organization / department / product etc. that the organization represents. If the name is very long, use an
abbreviation or shortened version.

The "Client Code" will be used internally to uniquely identify the organization when requesting forms. It should be set to an alphabetic string, for example
"exaco" for an organization called "Example Company".

Set the "Description"” field to the organization's full name and / or a descriptive text to help identify the organization.

The "Credential Alias" can be used to specify the name of a custom credential set up in Adobe LiveCycle to be used during receipt rendering.

The "Active" flag indicates that the organization is active. Inactive organizations will often not be included in reports, and the Self Service Space does not
show forms for inactive organizations.

Click "Save" to create a new organization record. All the other tabs should become active at this point, allowing you to further configure the organization.
A read-only client key will also be automatically generated for the organization.

To complete setting up the new organization, please follow the instructions in the sections below.

Configuring Space Access

Once you save your new organization, you will automatically be directed to the "Spaces" tab. You will need to decide which user spaces the organization
shall be able to host forms on.

Note: If you do not assign any spaces to the organization, no forms can be created for the organization as there are no spaces available to host these
forms. Therefore, be sure to assign at least one space to the organization.
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Edit Organization

Home Dashboard » Organizations » Organization

i' The Organization has been successfully saved. Please assign portals as needed.

Organization Delivery Channels Spaces Payment Gat Properti Form Categori Form Tags I Applicati Report Data Management

Specify the Spaces that this organization's forms can be hosted on.
Select at least one Space that will be available to this organization.

Available Spaces Assigned Spaces

ANZ -t L]
Avoka Forms
Avoka S5O ADFS
Avoka S5O Portal ADFS
Bank of Melboumne
Bank of South Australia >
Bendigo
Spaces BT Portal g
CAAPortal
Classic Fnance Comoration
Classic Gov Assist <c
CTMaguire:
Department of the Interior
EPA TransactReld App
Finance Comoration

‘G.CW Azsist ;I ;I

Assigning spaces to a new organization
Select the set of spaces for the organization and click ">" to assign them. The "<" button can be used to unassign selected spaces.
When you are done, click "Save".

Configuring Delivery Channels

Delivery channels are discussed in detail in chapter "Delivery Configuration”. Please refer to Delivery Configuration (Manager v5.0)
#_sec_createdeliverychannel in particular on how to set up a delivery channel for an organization.

Configuring Payment Gateway Details

The "Payment Gateway" tab contains settings related to the payment gateway configuration used by the organization to enable credit card payments by
users. Please refer to Online Payment (Manager v5.0) for more information about online payment in Transaction Manager.

Configuring Data Retention and Storage Settings

The "Storage Settings" tab contains settings related to data storage security and data retention. Please see Operations (Manager v5.0)
#_sec_dataretention for general information, and its Operations (Manager v5.0)#_sec_dataretentionorganizationlevel for settings available on the
organization level.

Configuring Security Settings
The "Security" tab allows you to customize some settings related to form rendering.

Test organization

Home Dashboard » Organization

Organization | Delivery Channels | Spaces Payment Gateway Properties Form Categories Form Tags Applications Report Schedul Data M t Security |_

Forms Secure Browser Support Policy
Override System Defautts [~ @
Enable Internet Explorer 10 |_ .éi

Enable Internet Explorer |_ @

Enable Internet Explorer 8 |_ .éi

Forms Content Securith Policy (CSP)
Override System Defauts [~ @

CSP Security Header  script-src 'self; object-src 'none’ @

Content Security Policy Level 2 specification

Save el

Editing organization security settings
You can override browser support by modifying the settings in the "Forms Secure Browser Support Policy" section.
In addition, you can specify a Content Security Policy header that will be used by all forms in the "Forms Content Security Policy (CSP)". .

In both cases, the system settings are defined in the default "Form Submission Access Controller" service. See Services (Manager v5.0) for more on
service definitions.
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Adding Organization Properties

Before you add forms to the organization, you can define the organization further by creating organization property types as required and assigning
values to them. Organization properties can be used to pre-populate your forms or modify their behavior (see _sec_propertytypes for more on property
types and how to create them).

To edit organization properties, open your new organization by clicking the "Edit" icon ( @) on the Organizations page and go to the "Properties" tab.
You can either create a new property value by clicking "New" or change an existing property by clicking the "Edit" icon next to it. Either way, you will see
the "Edit Property" screen.

Edit Property

Home Dashboard » Organizations » Organization » Property

Property Type®  Credit Card Accepted =l

Value™ ;I

falss W

Editing an organization property

Enter the new value for the property (depending on the property type, values may have to follow a specific format; see _sec_propertytypes) and save.
Verify that the new value for the property is displayed on the "Properties” tab.

Please note: Property values are versioned on a form version level. Adding or modifying an organization property value will not affect existing form
versions (so as to preserve versioned data). However, new forms will receive a copy of all current organization property values. In addition, you can edit
a form version and synchronize organization property values.

Setting Up Form Categories

Forms can be organized into categories. Space users can then filter by category when searching for forms, if the space supports this. This can help
users locate forms, especially if a large number of forms are hosted on a space.

Form categories are set up on the organization level. Forms can be assigned one or more categories and will show up under all these categories.
To define the set of available form categories for an organization, edit the organization and switch to the "Form Categories" tab.

Northern Territory Government

Home Dashboard » Organizations » Organization

Organization [ Delivery Channels 1 Spaces 1 Payment Gateway | Properties [ Form Categories I Form Tags [ Applications 1 Report Schedub 1 Data
Hame Description Action
ACCOUNT SERVICE @ &
My Category This category s used for testing. j m
Other Category @
New Close

The list of form categories for an organization
You can add, edit and delete categories.
To add a category, click "New". The "Edit Category" page will be displayed.

Edit Category

Home Dashboard ¢ Organizations » Organization » Category

Name * | Health o

Forms related to health topics.

Description

Save Close

Creating a form category
Enter a unique category name and an optional description and save the category. Now you can assign forms to the new category as described in Form
Version Configuration (Manager v5.0)#_sec_configureformcategories.

Setting Up Organization Metadata

Metadata can be used to run queries on the set of forms defined in Transaction Manager using a Web Service API (see _sec_metadataconfiguration on
more details about metadata, including how to create metadata tags).

If you want to define metadata for an organization, you can set values for these metadata tags on the "Edit Organization" page. All forms will inherit
organization metadata when they are created.

To add a metadata value, edit the organization and go to the "Form Tags" tab. Click "New" to bring up the "Edit Organization Form Tag" page (the
screenshot below shows the page with all values filled in).
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Edit Organization Form Tag

Home Dashboard » Organizations » Organization » Organization Form Tag

Organization Example Company
Tag Name Agencyname;l @

Example Company Ltd.
Tag Value ™

Save Close

Adding an organization-based metadata value
Choose the metadata tag to assign a value to from the "Tag Name" dropdown (only metadata tags with a scope of "Client" will be displayed).

Set "Tag Value" to the metadata value for this organization and save. You will see that the metadata value has been added to the "Form Tags" tab. All
forms that are set up for this organization will inherit this metadata value.

Setting Up Application Packages

Application packages can be used to group organization specific services (see Services (Manager v5.0)) and forms so that they can be migrated
between TM servers more easily.

To manage application packages, edit the organization and switch to the "Applications” tab (see below).

Department of Health

Home Dashboard » Organizations » Organization

Organization | Delivery Channels | Spaces | Payment Gateway Properties Form Categories Form Tags Applications Report Schedules Data Management

Application Package Description Action

Test Application B E ! {i

Import Close

Managing application packages
You can edit and delete application packages, or create new ones by clicking the "New" button (the screenshot below shows the "New Application
Package" page).

New Application Package

Home Dashboard » Application Package

Application Package | |

Application Mame ™  Groovy Package
Description

Active 7

Save Close

Creating an application package
Enter a name and an optional description for the application package.

Leave the "Active" checkbox ticked if you would like the application package to be available for use.
Click "Save". You will be asked to assign services to the application package.

Edit Application Package

Home Dashboard » Application Package

i) The Application Package has been successfully saved. Please assign services as needed

Application Package Forms. Services ‘
Available Services Assigned Services
AWS Delivery Service DOHA - v1 [Delivery Process] =1 =]
ES
Services <
E
<

Assigning services to an application package
You will be offered all service definitions belonging to the organization (global services will not be offered).
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Select one or more services and add them to the application package by using the ">" button. Remove services from the application package by using
the "<" button.
Save your changes when you have assigned the appropriate services.

You can also assign forms to the application package. To do so, switch to the "Forms" tab.

Groovy Package

Home Dashboard » Application Package

Application Package | Forms Services.
Available Forms Assigned Forms
H Data Extract Form |
Medical Screening Assessment Form
>
Forms <
>>
<<
= =
RN Close

Assigning forms to an application package
You will be offered all form belonging to the organization.

Select one or more forms and add them to the application package by using the ">" button. Remove forms from the application package by using the "<"
button.

Save your changes when you have assigned the appropriate forms

You can export and import application packages as a single unit. Please see Multi-Environment Support (Manager v5.0)
# sec_Migrating_an_Application_Package for more information.

Setting Up Forms for the Organization

Transaction Manager allows you to quickly create a completely new form and associated entities by using the "New Form" wizard (see Form
Configuration (Manager v5.0)#_sec_newformwizard).

Deleting an Organization

You can delete an organization and all its dependent entities (e.g. forms, submissions) from Transaction Manager. Do consider this carefully as this
cannot be undone and will irrevocably remove all forms, submissions and users for the organization. If possible, organizations should be made inactive
instead of deleting them, especially if there have been submissions for any of their forms.

To inactivate an organization, go to "Forms > Organizations" and edit the organization. On the "Organization" tab, untick the "Active" checkbox and save.

To delete an organization, go to "Forms > Organizations" and click the "Delete" icon ( ) next to it. You will be asked to confirm this action before the
organization and all entities associated with it are irrevocably removed.

Copying an Organization

Transaction Manager allows you to quickly make a copy of an organization. This can be useful for testing purposes (setting up multiple copies of the
same organization) or setting up new organizations from a common "template".

The new organization will receive the same configuration as the parent organization (with a few exceptions). You can also choose to include forms and
their configuration in the copy operation.

To create a copy of an existing organization, go to "Forms > Organizations" and click the "Copy" button. You will be directed to the "Copy Organization”
page.

Copy Organization

Home Dashboard » Organizations » Copy Organization

Copy Organization = Example Company ;I
New Name* New Bxample Company

New Client Code™ nexaco

Copy Forms [V
Cancel

Creating a copy of an organization

Choose the organization you want to copy from the "From Client" dropdown.

Enter the name and client code for the new client into the "Target Client Name" and "Target Client Code" fields. If an organization with the same name or
code already exists, Transaction Manager will not allow you to create the copy - you need to choose unique values for both values.

If you want to copy forms and related configuration, tick the "Copy Forms" checkbox; otherwise, leave it blank.

Click the "Copy" button and wait for the operation to complete. Transaction Manager will create copies of all organization-specific entities and add
references to global entities where necessary. Once the copy operation has completed, you can start using and modifying the new organization.

Note that while most aspects of organization and form configuration are copied, some entities are specifically excluded and will not be copied to the new
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organization. These entities are: Payment configuration, report schedules, delivery details and form manager references. Also, the newly created
organization always has the "Active" flag set initially.
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Form Configuration (Manager v5.0)

Forms are the central entity in Transaction Manager. Forms can be configured to a great extent, and most settings are versioned. The configuration
includes form properties (for example contact details), attachments, metadata values and delivery details. Some information such as property values can
be inherited from the organization.

Search

Concepts

Forms are exposed to users by being hosted on a user space. Each form has at least one form version, an entity that wraps the set of form-related data
to be versioned. If multiple form versions exist, one of them is distinguished as the current form version, and is used when rendering the form. There is
some data shared by all form versions, but most settings are maintained separately for each form version.

Transaction Manager recognizes forms of different form types, such as dynamic PDF forms or Composer SmartForms. Each form version has a form
type and the artifacts needed to render the form. The form template file is used to render the form and possibly the form receipt. The receipt template file
can be used to render the receipt instead. The form data configuration file defines the data structure underlying the form, and is vital for dynamic
SmartForms hosted on Transaction Manager.

Other versioned information includes property values, metadata values and attachments (supporting documentation that will be requested after form
submission).

Form Types

There are four different form types supported by Transaction Manager: Dynamic PDF forms, Composer SmartForms, static PDF forms and other
documents.

Dynamic PDF forms are XDP or PDF forms that are filled in and then submitted electronically to Transaction Manager. The organization may still require
the form to be printed and sent in, but a record of form submission and the submitted data is also created on Transaction Manager.

Composer SmartForms are based on an XDP form but rendered as HTML in the user's browser (as opposed to being rendered as PDF in the user's
PDF viewer plugin). These forms can also be rendered to devices (e.g. tablets or smartphones) where no PDF viewer plugin is available. Transact
Composer offers extensive capabilities to create HTML forms that render on a variety of devices and screen resolutions.

Static PDF forms are simple forms that will be used for "fill and print", i.e. they will not be submitted to Transaction Manager after being filled in.

Other documents can be defined in Transaction Manager using the "Other Document" form type. The file extension of the uploaded document is used to
determine the MIME type, and the document itself is streamed back to the user's browser.

When creating a form, you will have to specify which form type you will be using, and provide a file in the appropriate format (which will be described in
the sections below).

Browsing Forms

To browse the list of all forms, go to "Forms > Forms". You will see a list of all forms that have been defined. You can filter the list by organization, a
substring of the form name, the form code, the form template file name and / or by the user space on which the form is exposed. Additionally, the "Filter
By" dropdown allows you to show filter by form active status and test flag.

Forms
Home Dashboard » Forms

Space jFlherBy Active jsmﬂv Form MName j Clear

New Import Form Version
Current . . . "

Form Name Org. Form Code Version Active Test Delivery Channel Last Modified Action
2nd level nav dmoors0RG  2nd-levelnav 1.0 v 15 Apr2015 by dmoore () &1 @ |4
| Dk A Y i
401 Test - HTML DAS 401-test 1.0 v Customer Emal Dedvery 23Feb 2015 by medgar 2] 1 & L1

Process
T54 Thiald test case - Dafaul Receipt DAS TE4-tfimid-test-case 20 o Default : REST Servica 04 Nov 2014 by jclagnan r_" E Q i
» s
AAA QA - IC Showease Form fincorp showcase-forms 20 ] Default : Trash Can Defvery 26 ay 2015 by lcouter () &) @ 1
AAA 04 Showcase Form - Default Receipt fincorp showcase-formd 20 v Default : Trash Can Defvery 29 Apr 2015 by rmandryk (7] ] @ 4
R & Ch: NOI w21 - PDF [with PDF = -
?::E EgREThaeNOlal BT ndh i maguire region-6-change-nok- 1.0 v Default : Trash Can Delvery 11 Sep 2014 by Ib By
Abandon Form Test - HTML DAS abandon-form-test 1.0 'l Dwefault : REST Service 15 Aug 2014 by diiu r_" E Q i
Abandonment - Page Change fincorp aband-page 1.0 o4 @  Default; Trash Can Delvery 03 Jun 2015 by e T 0 3
kkremarova
'- Scor c : Poei
Abandonment - Score Change fincorp abandonment—Score 1.0 v @  Default: Trash Can Delvery 16 Jan 2014 by jciagnan L i
Abandonment Background fincorp Abandon 1.0 o @  Default: Trash Can Delvery 16 Jan 2014 by jclagnan |_{ !._: 0 i
» 110 of 820 Export Data

Browsing the list of forms
This page also allows you to invoke the "New Form" wizard and import form archives exported from another Transaction Manager instance.

You can also edit existing forms ( EI), delete forms ( ﬁ) and export ( 'l-) forms. Please see Multi-Environment Support (Manager v5.0)
#_sec_migratingform for exporting and importing form archives.
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Creating a Form Using the "New Form" Wizard

The "New Form" wizard is a tool that allows you to create new forms with a minimum of effort. The wizard asks for some basic information and then
creates a new form, with a form version and form data configuration.

To use the "New Form" wizard, you need to have the organization owning the form set up first (see Organization Configuration (Manager v5.0)
#_sec_createorganization on how to do this). Next, go to "Forms > New Form Wizard" (or click the "New" button on the "Forms" page) to open the
wizard.

New Form Wizard

Home Dashboard » Organizations » Organization ¢ Mew Form Wizard

Use the New Form Wizard to quickly create a new form.
Simply complete the required details, upload your form template and press Finish

Form | Resources | Portal | PDF Options |

Organization* Example Company j @
Form Name* Change of Address 2]
Form Code™ coa-exaco @
FormType* Composer SmatFom v | @

This form can be used to notify us of an address change.

Description

TestMode [~ @

< Back Cancel

The "New Form" wizard

Choose the organization for which the form will be set up from the "Organization" dropdown.

Enter the form name into the "Form Name" field. Assign the form a unique form code, which can be any string (e.g. "cofa-examc") containing letters,
numbers, dashes, underscores and spaces.

Choose the form type (described in _sec_formtypes) from the "Type of Form" dropdown.

Enter an optional form description, which will be displayed to space users.

By default, forms start out in production mode (making them visible on the example spaces and T.Field). If you would like to set your form into test mode,
tick the "Test Mode" button.

Next, switch to the "Resources" tab.

New Form Wizard

Home = Forms = New Form Wizard

Use the New Form Wizard te guickly create a new form.
Simply complete the required details, upload your form template and press Save.

Form Resources | Portal | PDF Options

Form Template *

Upload Form or FAR File | Browse_ | @
2

LiveCycle Repository Path I/Aup\icalions/Furrnsf 1.0/changeofaddress xdp

Receipt Template

Upload Receipt File IC:'\AVukaTestCases\lemplates\UwangeofAddressﬂeceiut.pdf Browse_ | &
LiveCycle Repository Path I @

Form XML Data

Form XML Data File |C:\AvokaTestCases‘deleates\TCF1t03‘\TCLseedm\ Browse_ | @

< Back Cancel

Defining the resources for a form
You need to specify a template file, which contains the actual form as a PDF or XDP template. Please refer to the table below for the file formats
supported by the various form types.

Form type Expected file type
Dynamic PDF form XDP or PDF

Composer SmartForm | Transact Composer FAR file
Static PDF form PDF

Other document Common document formats such as Word documents

Instead of uploading a form, you can also enter the URL to the form in the Adobe LiveCycle repository into the "LiveCycle Repository Path".
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If you would like the receipt to be based on a different form template, you can upload a file or enter a path in the Adobe LiveCycle repository into the
"Receipt Template" section. If a receipt template is defined, Transaction Manager will use it to render the receipt, passing in the submitted form XML.
If you would like to use prefill for the form, you also need to upload an XML seed file in the "Form XML Data" section.

Transaction Manager will automatically create a form version and form data configuration based on these files.

Next, switch to the "Space" tab (shown below) and choose the user space(s) that will be used to host your form. The form will be available on all
selected spaces. Note: Only spaces available to the selected organization will be shown. For information on how to view or modify the spaces for an
organization, please refer to Organization Configuration (Manager v5.0)#_sec_organizationspaceaccess.

New Form Wizard

Home Dashboard » Forms » New Form Wizard

Use the New Form Wizard to quickly create a new form.
Simply complete the required details, upload your form template and press Finish

Form | Resources | Spaces | PDF Options ‘

Available Spaces Assigned Spaces
ANZ & Maguire =l
Avoka Forms TransactField App
Avoka SSO ADFS >

Avoka SSO Portal ADFS
Space™  Bank of Melboume
Bank of South Australia

Bendigo

BT Portal <

CAAPortal

Classic Finance Corporation :] LJ
< Back Next > Cancel

Assigning a new form to user spaces
The "PDF Options" tab allows you to specify some options on how the form will be displayed in Adobe Reader, such as which tool bars will be shown
and how the form will be fitted to the available space (see also Form Version Configuration (Manager v5.0)#_sec_versionpdfoptions).

New Form Wizard

Home > Forms > New Form Wizard

Use the New Form Wizard to quickly create a new form.
Simply complete the required details, upload your form template and press Save.

Form l Resources | Portal I PDF Options

Reader Extend Form v @

Allow Muttiple Submissions e

Form Supports Offiine Submission [~ @

Page View 'ﬁ @
Tool Bar I_E (2]
Navigation Pane I_z @

Scroll Bar I_E @

< Back Cancel

Setting PDF render options for a new form

By default, the "Reader Extend Form" checkbox is ticked, causing the form to be reader-extended at render time. For this to work, you will need to set up
an Adobe Reader Extensions certificate on LiveCycle as well (see the Transaction Manager Installation Guide for detailed instructions).

If your form needs to support multiple submissions based on the same form request, tick the "Allow Multiple Submissions" checkbox. This will allow a
user to save a form and submit it multiple times.

Save the form wizard to create your new form. The form wizard will assume default values for some fields, but will basically generate a renderable form
in test mode. The form is ready to be customized (e.g. form properties, attachments, delivery details) but can also be tested right away.

After saving the form, you will be taken to the form detail page. The following sections describe the page in detail.

Editing a Form

To edit a form, go to "Forms > Forms", find your form and click the "Edit" icon next to it ( E)I). You will see the form dashboard, which shows an
overview of the form configuration as well as the latest transactions for the form.

The data shown depends on the permissions assigned to the administrator. The screenshot below shows an example of the form dashboard viewed by
a user who has all applicable permissions.

Note that all configuration that can be done via the dashboard can also be accessed via other paths; the purpose of the dashboard is to provide an
overview and convenient shortcuts for administrators.
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Payment Form

Home Dashboard » Forms » Form

Dashboard | Defais | Fiow Config | Emai Verification | FormVersions | Abandonment | Page Tracking | Spaces | Groupaccess | Form Promotion | Deployment Schedule

Form Details Form Versions

Form Display Name . Payment Form Version Current Version Last Modified

Form Code : pi-id1 1.0 s 30Sep2014  Properties Attachments Services DataConfly @) i

Organization : Lena Test Chent (4.1)
Delivery Channet: Email Mew Form Viersion  Export Form Versions
Created : 30 Sap 2014 - 12:00 by Ipammer

Last Medified | 19 Jan 2015 - 16:31 by lpammer

Latest Transactions View All Transactions
Form URLs 1] Receipt Number Time Transaction Status Receipt
e Friendly Landing Form Direct GR Code E411E  phitd1-14 19 May 15 11:32 Form Submitted, Payment Required =
S e < @ @ @ E : 7 : B Submission Rate: 7%  Avg. Submit Time : 18 min
Gov Assist 2D @ @ @ E
Maguire 7 @ @ Q E

PDF Receipt Test

The form dashboard

The form dashboard consists of four sections:

The "Form Details" section shows key information about the form, such as the form name, organization, test mode and last modified date. Some items
contain links to other entities (e.g. organization), which you can use to edit these entities directly. However, keep in mind that these entities may be used
by many other forms, so be careful when making changes.

The "Form Versions" section shows the list of versions set up for the form. You can jump directly into various configuration pages (e.g. form version
properties) for a version by using the links next to each version.

The "Form URLs" section shows what spaces the form is currently hosted on, and provides the relevant links to the space pages where the form can be
accessed.The "Landing Page" link points to the form's landing page, where users can review a form description and log in, if applicable.The "Friendly
URL" link points to the form's landing page, but uses a "user-friendly" URL format.The "Form Page" link points to the space's form page, which will
render the form.The "Direct Render" link points directly to the space's form render servlet.

Finally, the "Latest Transactions" section shows the most recent submissions made for the form along with their status. In addition, some statistics about
the set of completed form submissions are displayed. It may take a few minutes for the statistics to update.

Form Details



The "Details" tab contains basic form attributes. Note that these settings are not versioned.
Payment Form

Home Dashboard » Forms » Form

Dashboard | Details I Flow Config Email Verification Form Versions | Abandonment

Form Digplay Name* | Payment Form @
Form Code™ | pf4td1 7]
Ref Form ID @
Form Manager j g
Transaction Value 9@

Active ¥ @

TestMode [T @
Form Version Selector j @

Submission Expiry Date j @

Submission Expiry Days @

Tracking Code
Use Receipt No. for Tracking Code [~ @

Tracking Number Service |8

Receipt Number

Receipt Number Service ~|@
Receipt Number Pattern*  $formCode}-${nextSequence) @
Next Sequence Number* | 15 9

Delivery Channels

Production Delivery | Email 7@ ew
Test Mode Delivery _'] 7]

Validation Failure Delivery | LC Deliver To Directory j @

Tr: ion Form Data R ion (max age)
Finished Transaction Form Data = Use defaults (7 days) j @
Saved Transaction Form Data =~ Use defaults (180 days) j a9

Delete Form Data Extracts [ @

Validate Form Close

Editing form details

The "Form Display Name" contains the form name, which needs to be unique within the organization. The form name is displayed to space users and
identifies the form.

The "Form Code" uniquely identifies the form across all organizations. It is an alphanumeric short string. The form code is not generally displayed to
space users.

If there is a form identifier that is used internally, you can enter it into the "Ref Form ID" field. Transaction Manager will pass this value into web service
calls to external systems (e.g. to obtain prefill data or create receipt numbers), if these calls are set up.

You can also set a dedicated form manager by choosing an existing administrator user from the "Form Manager" dropdown. This user will be notified via
email whenever the form's promotion status changes (see _sec_formpromotion for more on form promotion).

The "Active" checkbox should be ticked initially to indicate the form is in use. If it is unticked, the form is treated as soft-deleted and will not be rendered
by Transaction Manager. Untick the checkbox to retire a form without deleting it.

The "Test Mode" flag indicates whether the form is in test mode. If it is unticked, the form is in production mode and submissions for the form will be
marked as live submissions. Note that the Example Self-Service Space and T.Field do not display test forms in the list of forms.

The "Production Delivery" and "Test Mode Delivery" fields control the way form submissions are delivered to the organization. There are multiple
supported delivery methods, including web service delivery, delivery to an Adobe LiveCycle process and email delivery. Please refer to Delivery
Configuration (Manager v5.0)#_sec_deliverymethods for more information. Note that if the form is in test mode, the "Test Mode Delivery" setting will be
used; otherwise the "Production Delivery" setting will be used to deliver submissions.

The "Validation Failure Delivery" setting will be used to deliver submissions for which a service of type "Submission Data Validator" was defined and
found validation errors when the user submitted the form (see Services (Manager v5.0)#_sec_submissiondatavalidatorservice).

There are two fields that control form expiry. You can have a form expire n days after the user first opened it by setting "Submission Expiry Days" to a
positive integer n. This prevents a user from saving a form and then submitting it much later, potentially even after a form version change.
Alternatively, you can set a fixed expiry date by entering it into "Submission Expiry Date". This can be useful if your form has to be submitted before a
fixed deadline.

The "Form Version Selector" dropdown allows you to configure a specific form version selector service for this form; otherwise the system default service
will be used. Please refer to Services (Manager v5.0)#_sec_formversionselectorservice and the Groovy Services Guide in the management console for
more about form version selector services.

The fields in the "Transaction Form Data Retention (max age)" section concern form specific data retention policies and will be discussed in Operations
(Manager v5.0)#_sec_dataretentionformlevel.
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The fields in the "Tracking Code" and "Receipt Number" sections concern the generation of tracking and receipt numbers for each submission of the
form and will be discussed in detail in the following section.
Once you are done editing the form, click "Save".

Tracking Code and Receipt Number

Transaction Manager provides multiple ways to generate unique tracking numbers for form submissions: A unique alphanumeric tracking code is
generated by default when a submission is created, and a customizable receipt number is assigned when the user saves or submits. By default, the
tracking code is used throughout (though you can configure a form to use the receipt number in its place), and the receipt number is merely written into
the receipt where it can be displayed.

Configuring the Tracking Code

To configure the tracking code for a form, edit the form and switch to the "Details" tab. The "Tracking Code" section contains the relevant settings ( _img_
formdetails).

Ensure that "Use Receipt No. for Tracking Code" is not ticked (otherwise the receipt number will be used throughout).

The "Tracking Number Service" dropdown can be set to explicitly specify the service that will generated the tracking number. If left blank, the system
default service for service type "Tracking Number" will be used.

Configuring Receipt Numbers

To configure the receipt number for a form, edit the form and switch to the "Details" tab. The "Receipt Number" section contains the relevant settings.
Note that by default, the receipt number is not displayed to the user (though the form can elect to display it on the receipt).

If you would like to use the receipt number in place of the tracking code, tick the "Use Receipt No. for Tracking Code" checkbox.

You can configure multiple ways to generate the receipt number for a submission. The following sections list the various options built into TM.

Using a Pattern to Generate Receipt Numbers

To use a pattern as the basis of receipt number generation, go to "Forms > Forms", edit the form and switch to the "Details" tab. The "Receipt Number"
section contains fields relevant to receipt number generation (_img_formdetails).

Select "Sequence Pattern Receipt Number" from the "Receipt Number Service" dropdown to use the default pattern receipt number generation service.
If you leave the value blank, the system default service will be used.

The "Receipt Number Pattern" field contains the current receipt pattern. This pattern defines the string template that Transaction Manager will base the
receipt numbers on. You can use arbitrary strings, interspersed with the following placeholders (omit the quotes when using them):

"${formCode}"This placeholder will be replaced with the client form code.

"${submissionld}"This placeholder will be replaced with the globally unique numeric submission OID.

"${submitKey}"This placeholder will be replaced with the alphanumeric UUID created for the submission.

"${submissionTime}"This placeholder will be replaced with the date/time when the form was first submitted or saved to Transaction Manager.
The date/time can be further formatted by using "${submissionTime.format(<patternString>)}", where <patternString> is a Java
SimpleDateFormat pattern string (for further information, see http://docs.oracle.com/javase/6/docs/api/java/text/SimpleDateFormat.html).

* "${nextSequence}"This placeholder will be replaced with the sequence number that is maintained for the current form.

® ${format.decimal(...)}This notation allows you to format numbers to a fixed number of digits using leading zeroes. The format object is of type
org.apache.click.util. Format.Example: ${format.decimal($submissionld, "00000000")}

To ensure your receipt numbers are globally unique, make sure the pattern contains either the submission ID or the submit key, which are globally
unique, or both the client form code and the sequence number.

The "Next Sequence Number" field contains the sequence number that the next submission will be assigned (replacing "${nextSequence}"). If needed,
this field can be increased; however, to avoid creating non-unique values, you will not be able to change this field to a value already assigned to a
submission. We recommend leaving the "Next Sequence Number" field unchanged.

Pattern Examples:

® Sequence with date: "${formCode}${nextSequence}-${submissionTime.format("dd/MM/yy")}"
This will generate receipt numbers such as "coal7-05/07/2012". Uniqueness is assured because the client form code as well as the sequence
number are used.

® PIN: "${submissionld}-${submitKey.substring(0,4)}"
This will generate receipt numbers such as "423-f94e". These short receipt numbers are useful for forms that can be saved to Transaction
Manager anonymously, as the user must provide the receipt number (and possible pass additional challenges) before to reaccess their saved
form. While you could also use the submission OID by itself, this is not as secure since submission OIDs are generally simply ascending
numbers and so could easily be guessed. Combining the OID with part of the randomly generated submit key ensures both uniqueness and
obscurity.

® Padded receipt number: ${formCode}-$format.decimal($nextSequence, "00000000")
This will generate receipt numbers such as "coa-00017530" (assuming nextSequence is 17530).

Using a Web Service to Provide Receipt Numbers

If you wish to use a web service to provide receipt numbers, please refer to the Transaction Manager Web Service APl document for details about the
web service API.

Once you have provided the web service, you will need to edit the "Web Service Receipt Number" service definition and adjust the "webServiceAddress"
service parameter to point to the endpoint of the web service. Please refer to Services (Manager v5.0)#_sec_managingservicedefinitions for more on
service definitions and parameters.

Now you can configure your forms to use the receipt number web service. To do this, go to "Forms > Forms", edit the form and ensure you are on the
"Form" tab.

Select "Web Service Receipt Number" from the "Receipt Number Service" dropdown.

Leave the other fields unchanged and save.

From that point onwards, Transaction Manager will call the web service whenever a form is submitted to obtain the receipt number.

Using a Groovy Script to Create Receipt Numbers
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Transaction Manager allows you to specify a Groovy script that calculates the receipt number for a submission. Given the form, submission and
submitted XML, you can implement your own logic to provide a unique receipt number. The Groovy script simply needs to return the receipt number.

To edit the Groovy script, you will need to edit the "Groovy Receipt Number" service definition and adjust the "groovyScript" parameter. Please refer to S
ervices (Manager v5.0)#_sec_managingservicedefinitions for more on service definitions and parameters, and contact your Avoka contact assistance
with the Groovy script, if desired.

Once you are done, you can configure your forms to use the Groovy receipt number service. To do this, go to "Forms > Forms", edit the form and ensure
you are on the "Form" tab.

Select "Groovy Receipt Number" from the "Receipt Number Service" dropdown.

Leave the other fields unchanged and save.

Flow Configuration

Depending on a form's configuration, the steps required of and options available to an applicant filling in the form can vary to a significant degree. For
example, a simple form may launch from a landing page and show a confirmation page after submission. More complex forms may add additional steps
and options, both prior to fill-in (e.g. terms & conditions page, allowing the user to authenticate) as well as after (e.g. saving and returning to form drafts,
payment, attachments, signatures, availability of a receipt).

Transaction Manager allows you to customize this "form flow" by customizing the steps an application for a specific form will go through. The form flow is
configured on a form level and is therefore not versioned.

To view or modify the form flow, edit the form and switch to the "Flow Config" tab (see below for an example).

Card Payment Form
Home Dashboard » Forms » Form

Dashboard I Details ] Flow Config Email Verification Formersions | Abandonment | Page Tracking Portal Access Group Access l Form Promotion | Deployment Schedule

Configure the User Flow options for the form,

Show Landing Page [¥ @
User Authentication | Authenticated Only j o
Save Online | Authenticated Only j w

Show Terms & Conditions [~ @

Form Display Mode | Direct Render j o
Form Signature Required j o
Confirmation Options
Send Confirmation Emall to User | Nane j o

Show Confrmation Page V¥ &
Show POF Receipts [V @

Custom Page Flow Options

Saved Page URL a
Confirmation Page URAL =
Cancelled Page URL o

Form Page Close

Editing the flow configuration of a form

The options on this page are listed in chronological order from a user's perspective when going through the application process.

Note: If a custom user space is being used to host this form, not all form flow options may be supported. This section assumes that a fully features user
space is deployed.

You can choose to show or hide the form landing page. This page generally contains content describing the form, and allows users to log in or continue
to the form anonymously.

The "User Authentication" dropdown can be used to restrict access to the form. If left blank, anyone can access the form; if set to "Authenticated”, only
users logged on as an TM space user can access the form; and if set to "Anonymous", anyone can access the form, but the submission is always
treated as anonymous (i.e. no user is recorded against the submission even when the user is logged in). Additionally, if "Authenticated" is selected,
users are also prompted to re-authenticate at form submission time if necessary (e.g. browser session timeout, offline submission), and submissions will
always be associated with a TM user account.The options available to the user on the landing page will reflect the choice you make.

The "Save Online" dropdown controls whether the form can be saved as a draft to TM, and by whom. The options are "Disabled", "Authenticated"
(authenticated users only) and "Anonymous" (both anonymous and authenticated users). Note: If a form was saved anonymously, it can still be
accessed by authenticated users if they can pass the save challenge(s). This is useful when users share submissions or ask an administrator for help in
completing their submission.

The "Show Terms & Conditions" checkbox controls whether a page is shown in between the landing page and the actual form. The content of this page
is typically a list of terms and conditions the user must accept and can be customized via the "Form Terms And Conditions" form property (it can also be
defined as a space property for an entire user space, though the form property takes precedence).If you do not need to show a separate terms and
conditions page to your users, leave the checkbox unticked.

The "Form Display Mode" dropdown allows you to control how the form is rendered. It can be rendered directly, or embedded in a wrapping page either
inside a div or an iFrame. Do not change this setting unless you specifically need to as your form may not render as intended if the wrong setting is
chosen.

The "Form Signature Required" dropdown controls whether TM will ask the users to sign their submission once other work has been completed. You can
enable two types of signatures: "Wet" for physical wet ink signatures and eSignatures using a digital certificate. Please refer to Signatures (Manager v5.
0) for detailed information.

Confirmation Options

The "Confirmation Options" section allows you to customize what happens when the user completes a submission for this form.

The "Send Confirmation Email To User" dropdown allows you to configure automatic emails to the user submitting the form when they complete the
submission (including all user steps such as payment and attachments). Choose "None" to disable automatic confirmation emails (the example space
allows the user to send an email if they so choose), "Confirmation" to send just a notification email without attachments and "Confirmation and PDF
Receipt" to send an email that includes the PDF receipt.

You can customize the email subject and message templates by defining values for the "Email Form Receipt Subject" and "Email Form Receipt
Message" on the form version, organization and/or space.
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The "Show Confirmation Page" checkbox controls whether a summary page shall be shown to the user after they have successfully completed a
submission. The confirmation page can be used to display a submission message to the user, display the receipt number, allow the user to access a
receipt and provide further actions to the user (e.g. review their submission history, fill in another form etc.).If unchecked, the receipt for the submission
will be displayed to the user instead.

Finally, the "Show PDF Receipts" checkbox controls whether space users should be offered a receipt when they submit this form. If unticked, they will
not have access to a receipt (whether from the confirmation page or their submission history).Note that if "Show Confirmation Page" is unticked, the
receipt will still be shown to the user on submission completion.

Custom Page Flow

Normally, TM takes care of the form flow, including all post submission steps such as showing a confirmation page. If you would like to provide custom
pages instead, you can configure custom URLSs to redirect to when a submission for this form is saved, completed or cancelled.
These URLs can be entered in the "Custom Page Flow Options" section. You can use the following Velocity variables in the URLs:

® 3$submissionThe submission object. For example, ${submission.submitkey} would be substituted with the submit key (a GUID).

* $formDataMapThe map of submission data extract values. For example, ${formDataMap.firstName} would be substituted by the value in the
map for the key "firstName".

® $requestThe HTTP servlet request.

Save your changes. If you have entered custom page URLs, TM will use them instead of redirecting to the corresponding space page.

Submission Email Verification Settings

Transaction Manager supports two forms of user email verification: At account registration time, users can be asked to verify their email address by
clicking on a link in an email sent to them. Additionally, you can ask users who have just submitted a form to verify their email address (= submission
email verification). This allows you to ensure that user-entered email addresses are valid and belong to the user even for anonymous users. This section
describes how to configure submission email verification (for email verification during user enroliment, see Security (Manager v5.0)
#_sec_customizinguserenrolment).

Note: For submission email verification to work, a contact email address must have been stored for the submission. This can be achieved by configuring
the "Contact Email XPath" configuration mapping in the form data configuration set up for the current form version and ensuring in the form that the
email address cannot be blank at submission time (note that this works the same way even for authenticated users — the email address stored against
their user account is not used for submission email verification). Please refer to Form Version Configuration (Manager v5.0)#_sec_configurationmappings
to learn about configuration mappings.

To view the current submission email verification settings for a form, edit the form and switch to the "Email Verification" tab.

Product Enquiry Form

Home Dashboard » Forms » Form

Dashboard | Details ] Flow Config Email Verification Form Versions Page Tracking Portal Access ] Group Access Form Promotion ] Deployment Schedule ]

Configure the form submission user Email Verification settings.
Verify Emails For  Anonymous Submissions ;I @
Verification Timeout (Days)* 3 ﬂ @
Delver After Timeout [~ @
Email Settings
Number of Emails* 2 x| &
Reminder Interval (Hours)® 24 LJ 2

Email Subject”  Please Verfy Your Emai @

<head> <title>Please Verify Your Email</title> </head>

<body style="background:#ececec; ">

<table style

<th style="o

Please Verify Your Email

</th>

>
<td style="color:black; background:white; text-align:left; padding:lem;">

. <p> You submitted a ${form.formName} at $format.date(5{submission.timeSubmissicn}, "h:mm
Emai Message 2, dd Mo y: -

ress by clicking on the link below: </p»
»${verificationUzrl}</a> </p>

r email for your ${form formMame]} to be proceased. </p»
te ($timecutDatetime, ~ dd MMMM©) . </p>

tyle="color:#d9£f£ffd; background:#556c90; text-align:left; padding:lem;">

Save Close

Configuring submission email verification for a form

To turn on email verification, set the "Verify Emails For" dropdown to "Anonymous Submissions" or "All Submissions".

The "Verification Timeout (Days)" field allows you to specify how much time you want to give the user to complete email verification. Note that if this time
passes without user response, the submission is then either considered abandoned or delivered anyway (see below).
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Tick "Deliver after Timeout" if you consider submission email verification to be non-mandatory, and the submission should be delivered even if the user
does not complete email verification. Also note that this means that delivery for such submissions will occur only after email verification has timed out;
therefore, it is important to set the verification timeout in such a way that timed out submissions are delivered within an acceptable timeframe.

As to the verification email itself, you can customize the content, number of times it will be sent if the user has not completed email verification and the
interval between emails. The first email will be sent when the user submits the form.

Choose the maximum number of verification emails that shall be sent to the user from the "Number of Emails" dropdown (TM stops sending emails if the
user completes email verification, or if the verification timeout is reached).

Choose the interval between emails from the "Reminder Interval (Hours)" dropdown.

Customize the subject and message sent to the user by adjusting the "Email Subject" and "Email Message" fields. Note: Ensure the email always
contains the URL the user needs to access to complete submission email verification (the placeholder is "${verificationUrl}").

Once you save your changes, they will apply to all subsequent submissions for the form in question.

Abandonment Settings

You can customize when and how submissions for a form will be automatically marked as abandoned, and what will happen to abandoned submissions.
To do so, edit the form and switch to the "Abandonment" tab.

Abandonment Form

Home Dashboard » Forms » Form

Dashboard I Details I Fiow Config ] Email Verification I Form Versions | Abandonment Page Tracking Portal Access Group Access Form Promotion ] Deployment Schedule

Configure the Form Abandonment settings.

Opened Transactions Max Age  Bhours =] @

Abandoned Transaction Delivery

Abandoned Dedvery Channel  LC Process =| @
Minimum Transaction Score | 60 9

Mo User Activity in Form Max Time*  1Zhours =] &
Saved Transactions Max Time*  7days |=| @

Submitted Transactions Max Time * 14 days ;l =]

m Close

Abandonment settings

The "Opened Transactions Max Age" setting determines how soon a submission in form status "Opened" (= opened by the user, but not submitted or
saved to TM) will be automatically set to "Abandoned" by the system.

All other settings are related to abandonment delivery. This feature allows you to mark submissions in other form statuses as abandoned when they
reach a certain age, and deliver these abandoned submissions to a separate delivery channel. The organization can then review these submissions and
decide if any of them should be followed up to help the user complete their application.

To enable abandoned transaction delivery, select a delivery channel from the "Abandoned Delivery Channel" dropdown. This will enable the other fields
in this section.

If you would like only submissions that exceed a certain transaction score (a numerical value calculated by the form, generally based on how much of
the form was filled in) to be delivered, you can enter the minimum score into the "Minimum Transaction Score" field.

You can customize the timeout for opened forms for which a background save was performed by setting the "No User Activity in Form Max Time" field.
The maximum age for saved and submitted (but incomplete, e.g. due to missing attachments) transactions can be controlled via the "Saved
Transactions Max Time" and "Submitted Transactions Max Time" fields.

When you are satisfied with the settings, save your changes.

Page Tracking Settings

To provide support for external analytics and page tracking (e.g. Google DoubleClick), TM allows you to specify custom script that will be appended to all
space pages relating to the form flow.
If you would like to turn on and customize page tracking for a form, edit the form and switch to the "Page Tracking" tab.

Payment Form

Home Dashboard » Forms » Form

Dashboard | Detais | Fiow Config | Emai Verification | FormVersions | Abandonment | Page Tracking | Spaces | Group Access | FormPromotion | Deployment Scheduie

Configure 3rd party page tracking f analytics script across form transaction pages.
Use Form Page Tracking W @
Page Script nclude Position®  Inside <HEAD j @

Tracking Script Template | Google Analytics :J 7]

#* Page Tracking Content Vel
Mote the $submission and $£
Please replace UR=NEKHK=X'

esplate Paramsters.
ataMap parameters will be added only to pages after the form submission.
th yeu Gocgle Analytics sceount ID.

;. Form
ServletRequest
.

$form: com.
$request: j
$requestParams:
$requestCockies

=
srequestlURL:
ssubmission . a.fc.core.entity.Submission
$formbataMap String, String>

Form Page Tracking Script

T LYPE="Lext/]avass
a gag 11 [1:

setAccount ', ‘UA-XKOK-X"]1);
_@ag.pushi[’'_trackPageview']);

{funecion{) {

ga.type = '
tocol ? "hetps:
t')[0]; a.paren

ga.sze = '_google-analytics com/ga.ja’;

. )i

Save Close
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Configuring page tracking for a form

The "Use Form Page Tracking" checkbox controls whether page tracking is enabled for this form.

To enable page tracking, tick this checkbox and customize the page tracking settings (TM provides several script templates including Google
DoubleClick).

Save your changes.

Promotion

The form version promotion functionality allows the organization to progress their forms from development to production, with the ability to add notes and
set up different users with different permissions (e.g. developers may be allowed to send a version to test, but not promote it any further than that).
Promotion applies to a particular form version. If a form has multiple versions, they are promoted independently of each other.

Promoting and Demoting a Form Version

To promote a form version along its life cycle, go to "Forms > Forms", edit the form and switch to the "Promotion" tab. You will see a list of promotion
entries for various form versions.

If there is not yet a promotion record for a form version, click the "New" button. Otherwise, click the "Edit" icon ( @) next to the record. You will be
directed to the "Edit Form Version Promotion Log" page (the example shows a form version being promoted to "Ready For Production").

Edit Form Version Promotion

Home > Forms » Form > Form Version Promotion

Form Name Change of Address
Form Version * 1 =
© Production

Mot Ready For Preduction

N Ready For Production
Promotion Status ™ est Passed

 Test Failed
C Ready for Test
c Development

Promotion Motes

Save Close

Promoting a form version

Choose the form version you want to promote from the "Form Version" dropdown. You can also add promotion notes.

To promote the form version, choose one of the available radio buttons in "Promotion Status". You can promote only a single step at a time, which helps
set up a permission system with several interacting roles such as developer, tester and project manager.

Save the promotion log and verify that it shows in the list of promotion log entries for the form.

After a form version has been promoted, notification emails will be automatically sent out to all organization and global administrators who have the
permissions to promote the form to the next level. For example, if a form is promoted to "Test Passed", all administrators who can promote this form to
"Ready For Production” will be sent an email. Requirements for receiving promotion emails are being a member of the "Receive Promotion Alerts" group
(see Security (Manager v5.0)#_sec_predefinedgroups) as well as having an email address set up in the administrator details.

Please note that you can also set a dedicated form manager for each form. This administrator will receive a notification whenever the promotion status
changes (see _sec_editform on how to set the form manager).

You can also demote a form version by setting it back to a lower level. After saving, the promotion level will be updated, and only the next level up is
available as the next promotion step.

Viewing the Promotion Log

To view the promotion log entries across all forms, go to "Forms > Form Version Promotions". You will get a list of promotion log entries.
Form Version Promotions

Home = Form Version Promotions

— Status =] startate [07Apr 20110000 3] EnaDate [ 4] ShowHistory [ Cear
Form Mame Org. Form Code Form Version Promotion Status  Promoted By Promoted At Action
Change of Address EXEC0  COB-EXaco 1 Ready For Production  Ipammer 02 Apr2miz 161658 [ E]
Change of Address eXace  CO8-EX3co 1 Test Passed Ipammer 02 Apr 2012 16:15:31 B
Change of Address EXACD  COB-EXACO 1 Ready for Test Ipammer 02 Apr 2012 16:15:25 :
SFM Widgets. Test - PDF, fgg sfm-widgets-testd 10 Development Ipammer 27 Mar 2012 10:17:21 r_/’ : i
SFM Widgets. Test - HTW... fgg sfm-widgets-test2 1.0 Development Ipammer 27 Mar 2012 10:16:48 E : i
Example PDF Form ex3-2-0 pdf-ex-3-2-0 1 Development Ipammer 15 Mar 2012 10:42:26 r_/- _ i
Test Groovy Data Form nt-gov  tgdi-ntgov 1 Development Ipammer 16 Feb 2012 16:38:21 I—h = 4
Field Worker Form nt-gov  fwi-ntgov 1 Development Ipammer 15Feb 2012 143401 [ E] | ]
Payment Details - HTML... nt-gov  payment-detaiss 1 Development Ipammer 14 Feb 2012 18:43:20 [7) g
Test Static POF Form nt-gov  tspdf-ntgpv 1 Development Ipammer 14Feb 2012155031 (7 E]

b 1-100f29 Export Data

Viewing the promotion log

This page shows the latest log entry for each form version by default; if you are interested in seeing previous promotions as well, tick the "Show History"
checkbox.

You can also filter by promotion status and a substring of the form name, and export the search results to Excel by clicking the "Export Data" link below
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the table.

To promote or demote a form version, you can click the edit icon ( I=L)l) to open the "Edit Promotion Log" page as described in the previous section. Note
that historic entries that have been superseded by a more recent promotion log entry for the same form version cannot be edited.

Form Space Access

For your users to be able to access a form, it must be hosted on one or more user spaces (see Spaces (Manager v5.0) for the various types of spaces
supported in Transaction Manager).
For each form, you can choose which of the available spaces it will be hosted on. To do so, edit the form and switch to the "Spaces" tab.

Payment Form
Home Dashboard » Forms » Form

Dashboard | Details | Flow Config Email Verification Form Versions Abandonment Page Tracking Spaces
Select the set of Spaces that will display this form.
Available Spaces Assigned Spaces
TransactField App ,:_I Finance Comporation ,:_I
Web Plug-in Gov Assist
Maguire
Spaces <

Changing the spaces a form is hosted on

Note: Only spaces available to the organization owning the form will be shown. For information on how to view or modify the spaces for an organization,
please refer to Organization Configuration (Manager v5.0)#_sec_organizationspaceaccess.

Add your form to the desired spaces to the form by selecting them and clicking ">"; similarly, remove your form from a space by selecting it and clicking
nen

When you are done, click "Save".

Form Group Access

By default, new forms can be accessed by any space user. To restrict access rights to a certain set of users, forms can be assigned to a number of form
work groups. If a form is assigned to at least one form work group, only space users associated with one of the same form work groups can access the
form.

You can create a suitable set of form work groups (see Security (Manager v5.0)#_sec_addgroup). In addition, if LDAP authentication is used, the user's
LDAP groups can be loaded and used as the set of that user's form groups (the matching between LDAP groups and form groups is done by name).
Please refer to Security (Manager v5.0)#_sec_securitymanagers for more details.

To view or modify a form's group associations, go to "Forms > Forms", edit the form and switch to the "Group Access" tab.

Simple Form
Home Dashboard » Forms » Form

Dashboard I Details I Flow Config I Form Versions Portal Access I Group Access I Form Promotion Deployment Schedule

Forms with no associated groups have no access control restrictions
Forms assigned to Groups are only accessible to users belonging to those Groups.

Available Groups Assigned Groups

AVO Officers d Review Group d
Avokallsers
Ben Org
BensGroup
Field Worker Group
frankGroup >
Review Group 2
Groups  Test Import Group <

W
u

”
"

Save Close

Changing a form's group associations

The "Assigned Groups" field shows all form work groups that the form is currently associated with. To make the form accessible to all users of the
hosting user space, ensure that no form work groups are selected.

You can assign the form to or remove it from existing form work groups by using the ">" and "<" buttons. You can also use the ">>" button to assign the
form to all form work groups, or the "<<" button to remove it from all form work groups.

Once you have completed form work group assignment, save your changes by clicking "Save".

Removing a Form
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Deleting a form is a dangerous operation as it affects many other related entities. If possible, forms should be made inactive rather than be deleted,
especially if there have been submissions for the form.

To make a form inactive, go to "Forms > Forms" and edit the form. Untick the "Active" checkbox and save the form.

If you wish to delete a form, be aware that this will delete all form versions and submissions as well as related entities for the form.

? Unknown Attachment
To delete a form, go to "Forms > Forms", find the form you want to remove and click the "Delete" icon ( ). You
will be asked to confirm this action before the form and all related entities are irrevocably deleted.

Rendering a Form

You can render a form quickly using Transaction Manager. The form will appear according to its configuration (organization and form properties,
attachments etc.) but no prefill based on the user will occur.

You normally render a form to quickly view its appearance. If you want to test its behavior, it may be better to use the "Test" function (described in the
next section), which gives you a form fill-in experience identical to that of a user space user.

To render a form, go to "Forms > Forms" and click the "Render" icon ( 0) next to the form. The form will be loaded in a new window and can be filled in
normally.

Testing a Form

Testing a form is similar to rendering it, however the form request will be treated as if a Transaction Manager user had requested a new form, i.e. you
will be directed to the landing page, where you may get additional options depending on the user space (such as logging on). The landing page will take
you to the form, which you can then fill in, submit and make payments or attach supporting documentation as needed.

You would test a form via the Transaction Manager management console if you wanted to validate its behavior. You can also test forms by finding and
opening them on the user space; however, this may show you only active forms in production mode (depending on how the space is implemented).
Therefore, if you need to test forms that are in test mode, you should use the method described below.

To test a form, edit the form, ensure you are on the "Dashboard" tab and click the "Landing Page" link ( %}) next to the space you want to test on. The
landing page for the form will be loaded in a new window.

Testing a Form Using Friendly URLSs

When testing a form as described in the previous section, the URL to the landing page will look something like: http://www.host.com/tmportal/landing.
htm?formCode=If-exp

Transaction Manager also provides "friendly” URLs as an alternative way to access the same page. These URLs look like: http://www.host.com/tmportal
/exp/local-form/

which uses the client code ("exp") and the form name ("local-form") to form the URL. When creating the friendly URL, Transaction Manager will convert
the client code and form name to lower case and replace spaces with dashes ("-"), and then remove duplicate dashes. In addition, ampersands ("&") are
converted to "and", and all other non-alphanumeric characters are stripped out.

To test a form via the friendly URL, edit the form, ensure you are on the "Dashboard" tab and click the "Friendly URL" link ( '_,') next to the space you
want to test on.

Testing Form Receipting

Receipts for a form often need to be tested separately, especially if a separate template file is used to render receipts. The PDF receipt test harness can
be used to test receipting.

To test form receipts using the prefill test harness, edit the form, ensure you are on the "Dashboard" tab and click the "PDF Receipt Test" link in the
"Spaces" section. This will direct you to the "PDF Receipt Test Harness" page with the form name and an example seed file already loaded.

PDF Receipt Test Harness

Home = Forms > POF Receipt Test Harness

Receipt Form Name Change of Address

:47 AM</SubmitDateString>
rm¥ZFreceipt-test-hazness.htm</Referer>

XML Receipt Data®

Receipt Number |

Testing form receipting

You can enter additional data into the seed file shown in the "XML Receipt Data" field.

You can also enter a receipt number into the "Receipt Number" field, which will also be populated into the receipt.

Once you have entered all the data, click "Test Receipt". The receipt will be rendered in a new window. No record of the receipt requests made via the
PDF receipt test harness will be kept in the request log.
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Exporting a Form

To export a form and all its versions, go to "Forms > Forms" and click the "Export Archive" link ( {i) next to the form. For more information on exporting
and importing forms, please see Multi-Environment Support (Manager v5.0)#_sec_migratingform.
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Form Version Configuration (Manager v5.0)

Each form can have multiple versions. A form version contains the set of versioned information for a form. To allow flexible switching between versions,
almost all data related to a form is versioned. This allows controlled releases of new versions at any time you choose as well as the ability to roll back a
release if needed.

Form versions may contain the actual form template and receipt files, the form data configuration, property and metadata values, attachments and other
information.

Search

Viewing the List of Form Versions

To view the list of all form versions that have been set up for a particular form, go to "Forms > Forms", edit the form and switch to the "Form Versions"
tab.

Test Payment Form

Home Dashboard » Forms » Form

Dashboard | Details | Flow Config | Email Verification [ Form Versions | Page Tracking | PortalAccess | Group Access | Form Promotion | Deployment Schedule

Form Version Current\Version Form Type Form Template(s) Receipt Template Last Modified Action
20 o Composer SmartForm HTML Deskiop, Tablet form-receiptxdp 14 Feb 2013 by lpammer B i r = (4
1.0 Make Current Composer SmartForm HTML Deskiop, Tablet form-receiptxdp 11 Jan 2013 by lpammer E‘I z _.: H ™l

New Close

The list of form versions
You will see a list of all form versions along with the information when the version was last modified, and by which user. You can create a new version,

=» sy

edit ( £ ) an existing version, delete ( ﬁ) versions that are not currently in use, edit the form data configuration ( , see _sec_formdataconfigsetup

-
for more on form data configurations), download the form template file ( H), download the receipt template file if configured ( <= or export the form

version ( i ).

Please note that the current form version is distinguished in the "Current Version" column and cannot be deleted. You can immediately promote another
form version to be the current one by clicking the "Make Current" link in the "Current Version" column. In addition, _sec_changecurrentformversion
describes how to schedule version changes for a future date and time.

Creating a Form Version

To add a new form version, click "New" to call up the "Edit Form Version" page.
Payment Form

Home Dashboard » Forms » Form » PDF Receipt Test Harness » Form Version

Form Version I |

Version Number* 2.0 @
Form Type* Composer SmartForm j 2]

Render Form Template  Auto Match j 9
Notes

Form Template

Upload Form or FAR File Browse_ | Development__My Organization_My Project_Payment Form_html-receipt far @

Receipt Template
Upload Receipt File Browse_ | Nofile selected. L7

Upload Signature File Browse_ | Nofile selected

Receipt XML Mapping Browse_ | No file selected. @
Use Delivery Receipt [~ @

Receipt Process Timeout 20 sec :I @

Form XML Data

Form XML Data Fie ~ Browse_ | No file selected 7]

Creating a form version
The "Version Number" field should be set to a unique version number that is only used internally. You would usually start with version number "1" and
then increase it sequentially as new versions are uploaded.
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Enter notes about the version into the "Notes" field (optional). These notes are not exposed to space users.

Select the appropriate form type from the "Form Type" dropdown. Refer to Form Configuration (Manager v5.0)#_sec_formtypes for details about the
various form types.

Upload the PDF, XDP, FAR or ZIP file using the "Browse" button next to the "Upload Form File" section or specify the URL to the form in the LiveCycle
repository in the "Form Template" section.

If you would like Transaction Manager to use a different file when rendering the receipt, upload a file or enter the URL to the LiveCycle repository in the
"Receipt Template" section.

If your form is asking the user to sign the receipt, you can specify a file that will be used when generating the receipt for the user to sign. If not specified,
the receipt template (if set) or the form template file will be used in the signature step.

The checkbox "Use Delivery Receipt" should be enabled only if the form has been specifically designed to make use of delivery receipts. If ticked, TM
will create two different kinds of receipt for each submission instead of only one: One receipt to be presented to the user after submission (which has the
node representing "Display Mode" set to "Receipt" as usual) and another receipt that will be stored in the TM database and used for delivery and
administrators viewing receipts in TM (with the node representing "ReceiptMode" set to "Delivery"). This can allow your form to present different
information in a receipt meant for the end user vs. the receipt that is delivered on to the backend, for example enabling office-use only sections in the
latter.

The "Receipt Process Timeout" setting is used to control the maximum time allocated to render a receipt for this form when using PhantomJS. This can
be useful for complex forms for which the receipt can take a long time to render.

Finally, you can upload a new form data configuration file using the "Upload Form XML Data File" field. Note: While Transaction Manager supports forms
that do not use form data configurations, many features such as prefill, managed attachments and payment will not be available.

Save the form version once you are done.

When a new form version is created, it inherits existing data. If the new version is the only existing version for the current form, the new version inherits
all organization property and metadata values. Otherwise, the new version will inherit attachments, properties and metadata values from the existing
form version with the highest version number.All inherited values can be adjusted in Transaction Manager.

Changing the Current Form Version

You can change the current form version at any time, whether to roll out a new release or roll back to an older version. The current form version is used
whenever a user requests the form.

To change the current form version, go to "Forms > Forms", edit the form and switch to the "Version Deployment Schedule" tab.

You will see the current schedule for the form, showing all deployments that are scheduled for the future. If there are any entries in the schedules,
please ensure that your changes will not conflict with the schedule.

To schedule a form version change, click "Schedule Version Deployment". You will see the "Schedule Deployment of a Form Version" page.

Schedule Deployment of a Form Version

Home = Forms = Form > Schedule Deployment of a Form Version

Form Template * Test Payment Form Template

Form Version * 2>

Deploy Immediately [~
Deployment Time* [07 Sep 2012 00:00:00 5|

VRN Close

Scheduling a form version change

On this page, choose the new form version to be deployed from the "Form Version" dropdown.

If you would like to change to the new version immediately, tick "Deploy Immediately”. Otherwise, enter the desired changeover date and time into the
"Deployment Time" field.Note: Do not schedule multiple deployments on the same form for the exact same time (down to the minute). This is not
supported.

Save your changes.

If you chose to make the change immediately, the form will be configured to use the new form version straight away. No schedule record needs to be
created.

If you chose a future deployment date, a schedule record is created. The change will be made by a scheduled job (named "Template Version
Deployment"). Please ensure this job is configured correctly and not paused; otherwise scheduled form version changes will not be processed.

Editing a Form Version

=
To edit an existing form version, go to "Forms > Forms", edit the form and switch to the "Form Versions" tab. Click the "Edit" icon ( =-') next to the
version you want to edit.

Note: If you want to edit the current form version, simply go to "Forms > Forms" and click the "Current Form Version" icon (.ﬂ) next to the form.
The basic form version settings are described in _sec_createformversion. All the other tabs are described in the sections below.

Composer Form Information

If the form version is of form type "Composer SmartForm", the "Form Archive Info" tab is shown. It contains information about the Composer
environment used to create the form as well as Composer metadata describing the form.
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Avoka Transact Showcase Form - Version 4.0

Home Dashboard » Forms » Form » Form Version

FormVersion | Propertes | AttachmentRules | Services | FormCategories | FormTags | Form Archive Info | Composer Form Descriptor

Author  medgar@avoka.com
Organization Showcase
Form Name  Showcase Form
FormKey Sample Fomms 42/Showcase/Showcase/Showcase Fom/htmlreceipt
Form Description  Master version. Do not edit without informing Sacha Trube
Form Generation Date 22 Jun 2015- 12.44 PM
Form Archive MDS b6db8921c643a23b52929318041f6d3

Build Server URL  hitps://composer test avoka com/composer

Data Version 420

Build Version 42C11

Build Number 42319
Build Environment  staging

HTML Desktop Template
HTHL Receipt Template
HTML Tablet Template
POF Form Template

PDF Receipt Template

U B s B

Supports Save Chalienge

Composer form archive information for a form version
The information shown helps you find the original form in Composer as well as find out when the form was generated and by whom.

Composer Form Descriptor

If the form version is of form type "Composer SmartForm" and the FAR file includes the Composer form descriptor, the "Composer Form Descriptor” tab
is enabled. It shows the full Composer form descriptor XML.

Avoka Transact Showcase Form - Version 4.0
Home Dashboard » Forms » Form » Form Version

FormVersion | Properties | AttachmentRules | Services | FormCategories | FormTags | Formarchiveinfo | Composer Form Descriptor

Form Archive - Composer Form Descriptor XML,

<?xml vers
Z ¥ <formdescr

="1.0" encoding="UIF-2" standalcone="yes"7>
or descriptiocn="Master wversion. Do not edit without informing Sacha Trube"
"Styling-Maguire—Default, Navigation-LeftHierarchy" template="Template-Maguire">
ransaction.type"” wvalue="Application"/>

ude . share®™ walua true™/>

-hotline"™ wvalu 840 318%6"/>

-chat.url" walue="http://www.avoka.com/contact-us"”
lp.branch url® value=*http://www.avoka.com/contact—u:

<field name="_ avoka toolkit® type="Data-HutakndBolea™>
<field name="_ spriona® cype="D Optionas-Folder™>
13 <field name=* generaticn® type="Data-GeneraticnOpticns®s
13 <setproperty nams="policy include. debug.info® wvalue=s"tcrue®/>
1 </field>
</field>
- <field name="_ responsiveRulesets” type="Data-Responsive-Folder™s
T <field name=™ Ci nt" type="Data-Responsive-Ruleset">
<setprope ree-Column-Content™/>
3w <field name= able-Responsive-Cperator™s
<getproperty name="size" value="850"/>
<field name="1t250" type="Variable-Responsive-Rule™/>
</field>

</field>
</ field>
6™ <field name="_modals" type="Data-Modal-Foldezr">
- <field name="_Dialogs" type="Data-Dialog-Foldezr™>
2 <field name="_ confirmSaveDialog"” styles="style.dialog.save.confirm, style . maguire.dialogs"™
25 type="Dialog">
3 _outerArea™ styles="style. dialog.cuterarea" type="Block-Standard™>
<field name="_contentArea™ styles="style.dialeg.contentarea” type="Block-Standard™>r
<field name="_concent” type="Bleock-Standard">
<field name="_confirmSaveContent” type="Block-Dialog-ConfirmSave">
<field name="ConfirmSave"
atyles="style section_ levell save confirm style dislog.section levell®
& types"Section-Standard-Levell™>
b <field names" puterirea” scylesm"${section outer. stylenams}"
type="Block-SectionOuter™>

The Composer form descriptor for a form version

Configuring PDF Options

Transaction Manager allows you to control how your forms will be displayed in Adobe Reader or Acrobat by specifying a set of so-called PDF open
parameters (for a list of these parameters, refer to http://www.adobe.com/devnet/acrobat/pdfs/pdf_open_parameters.pdf).

Note that these parameters apply only to forms rendered in Adobe Reader or Acrobat (including the respective browser plugins).

To view or change the PDF options for a form version, edit the form version and switch to the "PDF Options" tab.
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Edit Form Version - Wet Signature Form 1.0
Home = Forms = Form = Farm Version

Form Version I PDF Options I Properties | Aftachments | Form Tags Semvices Version Promaotion

Reader Version Required @
Reader Extend Form ¥ @
Enable Local Save ¥ @
Allow Multiple Submissions [~ @
Form Supports Offine Submission [~ @
Validate Submission on Server [~ @

PDF Form Open Parameters

Page View  FitH =le
Zoom Percentage 100 x| @
Page @
ToolBar  Show x| @
MNavigation Pane Hide j g9
Scroll Bar =le
Status Bar  Hide x|
Message Bar  Hide j

Page Mode j

Save Close

PDF options for a form version

In addition to the PDF open parameters, you can also edit several other settings on this page:

If your form requires a minimum version of Adobe Reader, you can enter this minimum version into the "Reader Version Required" field (e.g. "9.0.0" to
specify a minimum version of Adobe Reader 9.0.0. The user space can then attempt to detect the user's Reader version and ask users to upgrade if
needed (this is the behavior of the Example Self Service Space).

If you are uploading a non-reader-extended form file that will have to be reader-extended whenever the form is rendered, tick the "Reader Extend Form"
checkbox. You will need to reader extend forms if they submit as PDF (as opposed to XML or XDP) or if the user should be able to save them to their
own hard disk and later continue to fill in and submit the form.

The "Enable Local Save" checkbox can be ticked to allow the user to save the form offline (i.e. to their own computer) for later completion. Note that
Transaction Manager cannot control whether or not the user saves the form offline (saving offline is done in Adobe Reader); instead, the flag is passed
into the form, which can then use it in its internal logic. In addition, if a form is submitted after having been saved offline and the "Enable Local Save" flag
is not ticked, Transaction Manager will reject the submission.

The "Allow Multiple Submissions" checkbox can be ticked to allow the user to submit a form multiple times, typically after saving a form offline for reuse.
If ticked, Transaction Manager will accept submissions, even if the same requested form was already submitted previously. Otherwise, Transaction
Manager will reject duplicate submissions.

If you would like the form data to be validated by LiveCycle when the user submits the form, tick the "Validate Submission on Server" checkbox. This
validation is done in addition to the validation rules applied by your form. Complex forms may cause validation errors on the server even though the
submitted data is valid from the form's perspective; if this is the case, try unticking this checkbox.

If your form has been designed to render the offline submission response, tick the "Form Supports Offline Submission". Refer to Offline Submission
(Manager v5.0) for more information on offline submission.

Change the settings as desired and save.

Setting Up Form Version Attachments

Attachments can be set up to instruct Transaction Manager to ask the user to attach supporting documentation after submitting the form. To view or
modify attachments for a form version, edit the form version and switch to the "Attachments" tab.
For detailed information on how to set up attachments, see Managing Form Attachments (Manager v5.0)#_sec_addattachmenttoversion.

Adding Form Version Properties

Properties can be used to pre-populate your forms or modify their behavior (see Organization Configuration (Manager v5.0)#_sec_propertytypes for
more on properties and property types). Each form version maintains its own set of organization and form properties independently.
If you wish to view or modify property values for a form version, edit the form version and switch to the "Properties” tab.
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Edit Form Version - Test Attachment Form 1

Home > Forms = Form > Form Version

Form Version | PDF Options | Properties | Attachments | Form Tags I Services Version Promotion
Name Value Scope Type  Action
AutoSubmit true Form Bookan [ &
BPAY Biller Code 1234 Client  Number [7] &
BPAY Reference Number 123456789012 Client  Number [7] 7
Form Description This is a form that can be used to test attachment functionality. Form  String [2 E
Logo avokalogo.jog Client Image (7] &
Offline Status Message  This form is unavailable. Form String Ef‘, ﬁ
Submit type PDF Form  String @ &

Sync Org Properties Close

The list of properties for a form version

You can either create a new property value by clicking "New" or change a property by clicking the "Edit" icon ( }») next to it. You can also synchronize
organization level properties with the properties currently set up for the organization by clicking "Sync Org Properties”.
If you are creating or editing a property, you will see the "Edit Version Property" page.

Edit Version Property

Home Dashboard » Forms » Form » FormVersion » Version Property

Mame Submission Message
Property Type | Submission Message - (Form Scope) j

Data Type* | String j

Thank you for your submission.

Value

Save [ELES

Creating / Editing a form version property

If you are creating a new property, you can choose the appropriate property type from the "Property Type" dropdown. If no suitable property type exists
in the system, you can either create one first, or leave the "Property Type" dropdown blank and fill in appropriate values for the "Name", "Data Type" and
"Scope" fields.

Enter the new value for the property (depending on the property type, values may have to follow a specific format; see Organization Configuration
(Manager v5.0)#_sec_propertytypes), using the "Browse" button to upload a file for properties of type "Image" or "Long Text".

If the property type is "List", you can enter a label for the form property.

To sort list properties, you can also assign them a sequence number.

Save the property and verify that it now appears in the list of version properties on the "Properties” tab.

Adding a Form Description

Form descriptions can be used to present your users with additional information about a particular form to help them determine whether the form meets
their needs.

To add a description to a form version, edit the form version and add a property of type "Form Description”.

In the Example Self Service Space included in Transaction Manager, this description will be displayed on the form's landing page.

Setting Up Form Version Metadata

Metadata can be used to run queries on the set of forms defined in Transaction Manager using a Web Service API (see Organization Configuration
(Manager v5.0)#_sec_metadataconfiguration on more details about metadata, including how to create metadata tags). Each form version maintains its
own set of organization and form metadata independently.

If you wish to view or modify metadata values for a form version, edit the form version and switch to the "Form Tags" tab.
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Payment Form - Version 1.0

Home Dashboard » Forms » Form » Form Version

Form Version | Properties I Attachment Rules I Services | Form Categories Form Tags | Form Archive Info

Tag Name Scheme Scope Required Flag Value Action
Test Export Tag 1 Client o @
Test Export Tag 2 Form J @
Test Export Tag 4 Clignt o A

m Sync Org Tags Validate Tags Close

The list of metadata values for a form version

p
You can create or edit ( ';-.) a metadata value, delete existing values ( ﬁ) and validate the set of metadata values. You can also synchronize
organization metadata values with the current values stored for the organization by clicking "Sync Org Tags".
To add a metadata value, click "New" to bring up the "Edit Form Tag" page (the screenshot below shows the page with all values filled in).

Edit Form Tag

Home Dashboard » Forms » Form » FormVersion » Form Tag

Form Payment Form
TagName  Test List Tag j @
Name Test List Tag
Data Type = List j
Scope  Fom j
Required Flag [~

Value = Chinese (zh) j

Save Close

Adding a metadata value to a form version

Choose a metadata tag to assign a value to from the "Tag Name" dropdown. If no suitable metadata tag exists in the system, you can either create one
first, or leave the "Metadata Tag" dropdown blank and fill in appropriate values for the "Name", "Data Type" and "Scope" fields.

Set "Value" to the metadata value for this particular form version and save. You will see that the metadata value has been added to the "Form Tags" tab.
You can also click "Validate Tags" to validate the metadata values for the form version. Any errors (such as missing values for required metadata tags)
will be reported so you can correct them.

Configuring Form Categories

Forms can be assigned one or more form categories (e.g. "Business") to enable space users to search forms by category. This can be helpful especially
if a large set of forms is being hosted.
Form categories are defined on the organization level (see Organization Configuration (Manager v5.0)#_ sec_setupformcategories). Once you have
created a set of form categories, you can assign them to form versions.
To assign form categories to a form version, edit the form version and switch to the "Form Categories" tab.

Medical Screening Assessment Form - Version 1.0

Home Dashboard » Forms » Form » Form Version

Form Version | Properties | Attachments ] Services ] Form Categories Form Tags | PDF Oplions
Select the set of categories applicable fo this form version, The set of categories is defined on the erganization level
Available Categories Assigned Categories
Business ;l Heath ;l
Development
Finance
Categories <
>
e o

Assigning form categories to a form version

All available form categories set up on the organization level will be shown. Use the ">" and "<" buttons to assign and unassign individual form
categories.

To assign or remove all form categories, use the ">>" and "<<" buttons.

Save your changes. If your space supports form categories and you have defined a set of categories for forms hosted on the space, a category selector

will automatically be included on the form search page.
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Transaction Manager uses configurable services to perform key processes such as form rendering (see Services (Manager v5.0) for more on services).
Some services relevant to form processing can be configured on a form version level. This allows you to override some behavior for individual form
versions, while other form versions simply use the default services configured in Transaction Manager.

To view or edit a form version's service configuration, edit it and switch to the "Services" tab.

Please note that selecting the blank entry from one of the dropdowns means that Transaction Manager will use the default service for this form version.
It is generally preferable to leave the dropdowns blank where possible, and customize only those services for which a different behavior is desired.

By default, all forms will be rendered using the default form rendering service (in the standard Transaction Manager build, this uses Adobe LiveCycle
Output on the Adobe LiveCycle server that does the rendering). If you want to use a different form rendering service for a form version, choose the
service from the "Form Render Service" (rendering forms for fill-in) or "Receipt Render Service" dropdown.

Similarly, if you would like to use a specific service to retrieve the XML prefill data, choose a service from the "Form Prefill Service" dropdown.

If you would like to generate receipts electronically signed by the organization for this form, you can either rely on the default service set up in
Transaction Manager (if any) or specify a custom service in the "eSignature Render Service" dropdown.

If you would like to use a specific service to monitor, modify and possibly even reject certain submissions for this form version, select a service from the
"Submission Preprocessor Service" dropdown.

If you would like to use a service to validate submission XML data at submission time (not when the user saves or abandons), select a service from the
"Submission Data Validator" dropdown. Submission data validator services can be developed to detect issues in the submitted data, such as users
attempting to manipulate the XML data. If errors are detected, the submission is stored but not treated as a successful submission (it will be delivered
using a specialized delivery channel if configured for the form, see Form Configuration (Manager v5.0)#_sec_formdetails).

If you would like to use a service that can execute custom logic when the submission is completed by the user, select a service from the "Submission
Completed Processor" dropdown. Transaction Manager provides a default service out of the box, which will execute a customizable Groovy script. For
example, it could be used to assign new tasks to the user or forward the submission on for review.

Collaboration Job Information

If the form version is configured to use a service of type "Job Controller", an additional tab showing information about the collaboration job will be
displayed.
To view information about the collaboration job template, edit the version and switch to the "Job Info" tab.

Job Example 2 - Version 2.0

Home Dashboard » Forms » Form » Form Version

Form Version | Properties | Attachment Rules. | Services Job Info Form Categories I Form Tags Form Archive Info Composer Form Descriptor

Job Name: 2 S5tep Review Job Edit

Job Steps:
Default Next ) Displayable Form Route
Step Name Type Step Available Routes (Route: Step Name) =
Start Start Ingial Review Default Initial Review Default
. . Approve: Applcation Delvery, Declina: Applicant Update, Exceads Threshold: Additional Review, . .

Initial Review Terminate: Tarminated inkial Approve, Decline, Terminate
Additional Review Approve: Apphcation Defvery, Decline: Applicant Update, Terminate: Terminated Additional Approve, Decline, Terminate
Applicant Update Update: #2PREVIOUS_STEP, Terminate: Terminated Apphcant Update, Terminate
Application Approved

- Default Approved Complete Default
Delvery Complete T P “
Approved .
Compists Endpaoint

Terminated Initial Endpaint

Terminated

Additionsl R

Terminated

Applicant IR

Job Form Data Maps:

Form Data Map Name Supported by Form

firstName v
lasthame )
routeName o
loanAmount v
Form Data Extracis
Close

Job information for a form version
The panel displays the name of the job controller service, the set of job steps it defines and the set of job form data mappings.
This information can also be viewed when editing a service definition of type "Job Controller".

Deleting a Form Version

Deleting a form version is a dangerous operation as it affects many other related entities, including submissions for the form version.

If you wish to keep submission data, you can simply promote a different form version or, if the form is to be retired, deactivate the form as described in Fo
rm Configuration (Manager v5.0)#_sec_removeform.

To delete a form version, go to "Forms > Forms", edit the form and switch to the "Form Versions" tab. Find the form version you want to remove and

click the "Delete" icon ( #.7) next to it. You will be asked to confirm this action before the form version and all related entities are irrevocably deleted.
Note that you cannot delete the currently deployed form version.


https://servicedesk.temenos.com/kb/pages/viewpage.action?pageId=76189392#FormConfiguration(Managerv5.0)-_sec_formdetails
https://servicedesk.temenos.com/kb/pages/viewpage.action?pageId=76189392#FormConfiguration(Managerv5.0)-_sec_removeform
https://servicedesk.temenos.com/kb/pages/viewpage.action?pageId=76189392#FormConfiguration(Managerv5.0)-_sec_removeform

Exporting a Form Version

To export a specific form version, go to "Forms > Forms", edit the form and switch to the "Form Versions" tab. Click the "Export Archive" link ( § ) next
to the version you want to export. For more information on exporting and importing form versions, please see Multi-Environment Support (Manager v5.0)
#_sec_exportsingleformversion.

Form Data Configuration Setup

Transaction Manager form data configurations define the XML data structure being passed into and out of a form. If a form data configuration is set up
for a form version, a variety of features such as prefill, managed attachments and payments becomes available.

A form data configuration can contain three kinds of mappings from prefill data into this data structure: Property prefill mappings, where the source of
prefill data are the form version properties set up in Transaction Manager; XML prefill mappings, where an external XML file containing prefill data is
obtained at render time; and parameter prefill mappings, where prefill data is passed through as HTTP request parameters, session attributes or cookies.
For improved submission handling, form data configurations can include submission data extract mappings, which specify values that should be parsed
out of the submitted XML and stored separately.

To use some features built into Transaction Manager such as attachments and receipting you also need to set up configuration mappings for your form
data configuration (see _sec_setuppropertyprefillmappings).

Viewing the Form Data Configuration for a Form Version

Each form version is set up with its own form data configuration (or possibly none at all for simple forms). To edit a form data configuration, go to "Forms

> Forms", edit the form and switch to the "Form Versions" tab. Click on the "Form Data Configuration" icon ( m) next to the form version.
You can also access the form data configuration of the current form version by going to "Forms > Forms" and clicking the "Current Form Data Config"

icon ( M) next to the form.
If a form version does not have a form data configuration set up, these icons will not be present. You can upload the form data configuration file by
editing the form version and uploading the XML file using the "Upload Form XML Data File" field (see _sec_createformversion).

Configuration Mappings

When editing a form data configuration, the "Configuration Mapping" tab allows you to configure important sections in your form.
SmartForm Demonstration - Version 1.1 - Form Data Config

Home Dashboard » Forms » Form » Form Data Config

Configuration Mapping ] Form XML Data ] Property Prefil Mapping [ Request Param Prefill Mapping I Input XML Prefill Mapping Form Data Extract Mapging

Configuration Mappings enable you to override the default form XML configuration paths for the system to write to and read Form XML data from

Default Form Data Mappings
Use Default Mappings ¥ &

Attachments XPath
Payment Details XPath
Form Signatures XPath

Abandonment Reason XPath

2 @ @ @ ©

Receipt XPath
Contact Form Data Mappings
Contact Phone XPath

Contact Email XPath
Contact Postcode XPath

Contact Gender XPath

€ © @ © @

Contact Age XPath

Additional Form Data Mappings
Save Challenge XPath
Transaction Ref Number XPath

Transaction Value XPath

2 @ @ @

Oid Wet Signatures Required XPath

Save LGS

Configuration mappings for a form data configuration

The sections in your form you can identify on this page are needed to support certain features TM provides. For example, if you want TM to request
payment for your form, your form must contain a section of a particular structure (normally named PaymentDetails).

By default, the most important sections (related to form attachments, payments and signatures) have pre-defined mappings ("Use Default Mappings" is
ticked and the default XPath pointing to the section appear as a placeholder in the respective fields).

You can also define additional mappings to sections for which no default mapping exists:

"Contact Phone XPath" should contain the XPath to an element containing the user's contact phone number.

"Contact Email XPath" should contain the XPath to an element containing the user's contact email address. This value is necessary for post-submission
email verification and anonymous online save.

"Contact Postcode XPath" should contain the XPath to an element containing the user's (or the designated contact's) postcode.

"Contact Gender XPath" should contain the XPath to an element containing the user's (or the designated contact's) gender.

"Contact Age XPath" should contain the XPath to an element containing the user's (or the designated contact's) age.

"Save Challenge XPath" should contain the XPath to an element containing the answer to the challenge question users will need to answer to return to
an anonymously saved form. The element in question must not be blank when the form is saved; please refer to the Transact Integration Guide, chapter
"Form Saving and Retrieval" for detailed information on anonymous online save.

"Transaction Ref Number XPath" should contain the XPath to an element containing a transaction reference number that will be stored against the

72


https://servicedesk.temenos.com/kb/pages/viewpage.action?pageId=76189584#Multi-EnvironmentSupport(Managerv5.0)-_sec_exportsingleformversion
https://servicedesk.temenos.com/kb/pages/viewpage.action?pageId=76189584#Multi-EnvironmentSupport(Managerv5.0)-_sec_exportsingleformversion

73

submission. The transaction reference number can be used to identify multiple TM submissions that are part of a larger transaction (while the TM receipt
number always identifies an individual submission).

"Transaction Value XPath" should contain the the XPath to an element containing a number describing the value of this transaction as defined by the
form developer. If set, this value is stored against the submission and can be used for reporting or in Groovy scripts.

"Signatures Required XPath" is a setting related to signatures that is being maintained for compatibility reasons. For new forms that require signatures,
please use the mapping defined in "Signature XPath" instead.

Modifying the XML Seed File

To upload a new XML seed file or edit the seed file contents, edit the form data configuration you want to modify and switch to the "Form XML Data" tab.
Edit Form Data Config - Change of Address 1

Home > Forms » Form Data Config

Form Data Definition I Form XML Data | System Config Mapping | Property Prefil Mapping Regquest Param Prefil Mapping Input XML Prefil Mapping Submission Data Extracts

<AvekaSmartForm>
<Common>
<PaymentDetailar
<Payment>
<SubTotal/>
<GST/>
<ServiceFeea/>
<Total/>
</Payment>
<BPAYBillerCodae/>
<BPAYReferencellumber/ >
<BSBNumber/>
<EFTAccountNumber/ >
<ClientReferencelumber/>
<PaymentTyperCredit/Debit Card</PaymentType>
<AccountNumber/ >
<ItemList>

Form XML Data

<Item>
<Description/>
<Quantity/>

<UnitValue/> -
« | »

Form XML File Name FC_Payment Seed xml

Form XML Data File | Browse_ | @
e -

The seed XML for a form data configuration
You can upload a new seed file by clicking the "Browse" button and selecting the new file (which must be an XML file) and saving. The XML file will be
loaded, and its contents will be displayed in the "Form XML Data" field.

To change the seed XML, you can either upload another file or edit the "Form XML Data" field directly. To avoid syntax errors, the XML will be validated
when you save.

Setting Up Data Extract Mappings

Data extract mappings can be used to read data items from arbitrary locations in the submitted XML, which are then stored separately in the Transaction
Manager database. Each form data configuration can have its own set of data extract mappings.

Please note: For Composer SmartForms, data extract mappings can be easily defined in Transact Composer. When these forms are published to
Transaction Manager, the data extract mappings will be loaded along with the form.

To set up data extract mappings, edit the form data configuration and switch to the "Submission Data Extract Mappings" tab.

Job Example 2 - Version 2.0 - Form Data Config

Home Dashboard » Forms » Form » Form Data Config

Configuration Mapping | FormXMLData | Property Prefil Mapping | Request Param Prefil Mapping | Wput XL Prefil Mapping | Form Data Extract Mapping

Form Data Extract Mapping are used define form XML vakies 1o be extracted when form XML data & submitted.
This submission data extract information is summarized in the Form Submission Data view.

Extract Field Name Form XPath Extract Repeats Sequence Action
First Name JavokaSmartFormMinimalFormData/FirstName 1 @A f‘
Last Name 1A orm/ IFarmDatall 2 A0 *
Loan Amount JAvokaSmartFormMWinimalFarmData/loa nt I @A f’ g&
Route Mame IAvekaSmantFormMinimalFormData/SelectRoute 4+ A0 4}

MNew Close

Viewing the list of data extract mappings

You can use this page to set up new data extract mappings or edit ( 'd) and delete ( E) existing mappings. You can reorder mappings by using the

"Move Up" ( ) action.
To create a new mapping, click "New". You will see the "Edit Submission Data Extract Mapping" page as shown below.



Edit Submission Data Extract Mapping

Home Dashboard » Form Transactions » Transaction Details » Form » Form Data Config ¢ Submission Data Extract Mapping

*

email a@

Name

XPath™ | [fInstructions/Applicant/EmailAddress @
Encrypt Extracted Data (from Organization) [# g;
Extract Repeating Data [~ &
Sequence® 3 @
Job Step Data Sharing
Publigh to Shared Data [~ @
Subscribe to Shared Data [~ @

Save Close

Creating a data extract mapping
Enter the name you want to give to this data item into the "Name" field. This is the name under which the extracted data will be stored.

Enter the XPath to the location in the submitted XML into the "XPath" field.
If the XPath points to a repeating element and you want a data extract value to be created for each instance, tick the "Extract Repeating Data" checkbox.

Values extracted from the submission can be encrypted for additional security. To encrypt values for this data extract mapping only, tick the "Extract
Encrypted Data" checkbox. Note that encryption can also be enabled on the organization level, in which case it cannot be turned off for an individual
data extracy mapping (see the screenshot above for an example). You can change this setting by editing the organization (see chapter "Operations"
section "Data Retention and Storage Configuration (per Organization)").

The "Sequence" field is used for ordering the extract values. You can adjust the values as needed. Note that the sequence number must be unique
within the form data configuration.

The "Job Step Data Sharing" section allows you to specify whether values for this data extract mapping will be shared between submissions associated
with the same job. If "Publish to Shared Data" is ticked, the value will be shared with all submissions who themselves have a data extract mapping with
the same name and "Subscribe to Shared Data" ticked.

Save your changes to create the mapping. Whenever a form using this form data configuration is submitted, Transaction Manager looks up the value at
the specified XPath and writes it to a data extract element with the specified name (see Operations (Manager v5.0)#_sec_submissiondataextractvalues o
n how to view extracted data for a submission).

Setting Up Property Prefill Mappings

One of the benefits of setting up a form data configuration in Transaction Manager is the ability to map properties into arbitrary form XML data elements,
causing Transaction Manager to populate the corresponding property values when a form is rendered. Using properties and property prefill mappings,
you can customize and adapt your form without having to upload a new version of the form file.

To set up property prefill mappings for an existing form data configuration, edit the form data configuration you want to modify and switch to the
"Property Prefill Mapping" tab. You will see all existing property prefill mappings for the form data configuration.

Home Owners Insurance Quote PDF - Version 1.0 - Form Data Config
Home Dashboard » Forms » Form » Form Data Config

Configuration Mapping | Form XML Data ] Property Prefill Mapping | Request Param Prefil Mapping | input XML Prefil Mapping | Form Data Extract Mapping

Property Prefill Mappings enable forms to be dynamically prefiled with data from the User Profiie, Form Properties or Organization Properties.

Property Name Scope Form XPath

Email User Mnsiructions/applicantEmailtddress
Family Name User  MnstructonsiApplicant/ApplcantiastMame
Given Name User Mnstructions/Applicant/&pplcantFirstName

Prefill with Organization Property Values [~ @

Update User Profile on Submission | @

Edit Save Close

Viewing the list of property prefill mappings

In addition to using properties maintained in the form version (scopes "Form" and “Client"), you can additionally also instruct TM to fall back to properties
defined for the organization by ticking the "Prefill with Organization Property Values" checkbox. This is not the default behavior in order to preserve data
encapsulation in form versions.

If you are planning on mapping user profile properties into the form, you can also choose to populate data entered by the user back into the user profile
at submission time by checking the "Update User Profile on Submission" checkbox and saving. If you do this, all property prefill mappings of scope
"User" will be applied in reverse at submission time, i.e. data from the form will be written to the user profile.

To modify property prefill mappings, click "Edit". You will see the "Form Prefill Property Mapping" page.
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Form Prefill Property Mapping: Test Payment Form 3

Property Hame Scope Form Data XPath Target: Form Data XML
Additional Services Form \~| | » Common
Address User » FormData
Attachments Single Submit Method Form §

AutoSubmit Form

BPAY Biller Code Client HComman/PaymentDetails/BPAY BillerCode -

BPAY Reference Number Client HCommon/PaymentDetails/BPAY ReferenceNumber

Credi Card Accepied Client

Display Receipt Number Form

Eligibdity Form

Email User

Family Name User HComman/UserProfie/individualFamilyName

Form Description Form

Given Name User HCommon/UserProfiefindividualGivenName

HTHL Confirmation Page Form (|
Property Scope L4 Il Current XPath

| Save Close

Editing property prefill mappings for a form data configuration

The page is divided into two areas: The table on the left shows the set of available properties, which comprises all available property types as well as all
version property values set up for the form version that the form data configuration belongs to. For each entry, the XPath it is currently mapped to is
shown next to it. You can filter the properties by their scope ("Client", "Form" or "User") using the "Scope" dropdown.

The tree in the "Target: Form Data XML" section represents the form data XML document and contains all its elements. Nodes with children can be
expanded or collapsed.

To define a property prefill mapping, find the form data element you want to map a property to, then simply drag and drop the element into the "Form
Data XPath" column next to the property. The full XPath will be populated into the cell.

Form Prefill Property Mapping: Test Payment Form 3

Property Name Scope Form Data XPath Target: Form Data XML
Number Form * ! | w Common -
Offline Status Message Form » PaymentDetais
Omniture Context Form v ClientProfile
Payment Certificate File Client v Business
Payment Credit Card Amex Accepted Client ABN
Payment Credit Card MasterCard Accepted Client ACN
Payment Credg Card Visa accepted Client BusinessName :
Payment Merchant Password Form _ URL
Payment Merchant User Form » ContactDetails
Payment Type Form PrivacyStatement
Portal C55 URL Form » FormPresentation
Postcode User » Fees
Privacy statement Form k‘ » CertificateDelivery
Requiremenis Form @ A PaymentFormCode
Property Scope v Hl Current XPath » UserProfie [+

| Save Close

Adding a new property prefill mapping
When you are done assigning property prefill mappings, save your changes.

Setting up XML Prefill Mappings

When forms are rendered, they are pre-populated with various data: Prefill data based on properties is mapped into the form data document as
discussed previously. In addition, Transaction Manager allows you to pass data to the form at render time using an XML prefill document. The data
elements are copied to the form's seed XML data using previously defined mappings (similar to property prefill mappings).

This method of pre-population allows the organization to maintain the data used for pre-population outside of Transaction Manager. It can replace or
complement property prefill.

Note: For security reasons, XML prefill is disabled by default. It can be enabled by setting the space property "Allow XML Request Param Form Prefill" to
"true" (see Spaces (Manager v5.0)#_configurespaceproperties for more on space properties).

Each form data configuration can have a set of XML prefill mappings defined. To view a list of all XML prefill mappings set up for a form data
configuration, edit it and switch to the "Input XML Prefill Mappings" tab.
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Edit Form Data Config - Test Prefill Form 1

Home > Forms » Form Data Config

Form Data Definition I Form XML Data ] System Config Mapping l Property Prefill Mapping I Request Param Prefill Mapping Input XML Prefill Mapping I

Input XML Prefill Mappings are used to prefill XML data into the form XML data model when the form is rendered.
This feature is typically used with Form Prefill services

Input XML XPath Form Data XPath

liclient-account/first-name  //Common/UserProfile/individualGivenName

liclent-account/surname  Common/UserProfile/individualFamityName

Edit Input XML Edit XML Mapping Close

Viewing the list of XML prefill mappings for a form data configuration

If XML prefill has not yet been set up for the form data configuration, click "New Input XML" to upload an XML file showing the structure of the prefill data
(this is generally a blank example of the prefill data). The screenshot below shows the page that allows you to upload and later edit the prefill XML
structure.

Edit XML Input Version

Home > Forms > Form Data Config > XML Input Version

Wersion Name * Test Attachment Form Schema 1

Test Prefill XML

Upload Test Prefil File Browse |

Save Close

Uploading a sample XML prefill file

Simply use the "Upload Test Prefill File" button to upload the sample XML prefill file, and then save.

Once the prefill XML file has been defined, click "Edit XML Mapping" to access the "Form Prefill Data XML Mapping" page, where you can define how
the prefill data shall be mapped into the form data configuration file.

Form Prefill Data XML Mapping: Test Prefill Form Schema 1

Source: Prefill Data XML Prefill Data XPath Form Data XPath Target: Form Data XML

¥ client-account ficlient-account/frsi-name HCommenAlserProfilefindividualGivenName v Common =
first-name liclient-account'sumame HiCommon/UserProfiefindividualFamilyName w UserProfile
surname » Business

» ContactDetails
¥ Individual
Salutation
GivenName
WiddleName
FamilyName
JobTitle
» ClentProfile
» SystemProfile
» PaymentDetails

» Attachments

» Receipt

K

| Save Ciose |

The XML prefill mapping tool

The mapping tool consists of three sections: the XML prefill document structure on the left, the form data configuration XML structure on the right and
the mappings in the center. To create a new mapping, drag an element from the left into the middle, and drag the schema seed element you want to
map it to next to it. Transaction Manager will automatically fill in the full XPath of the elements you drop onto the mapping area.

To delete a mapping, simply delete both its "Prefill Data XPath" and "Form Data XPath" entries.

When you are done, click the "Save" button.

Once XML prefill is set up for a form version, you can use XML prefill when rendering your forms. To enable XML prefill, edit the form and tick the
"Require Form Prefill" checkbox, then save. If this checkbox is ticked, Transaction Manager will attempt to acquire XML prefill data at render time, using
the "Form Prefill"* service for the form version (see Services (Manager v5.0)#_sec_formprefillservice).

Setting up Request Parameter Prefill

76


https://servicedesk.temenos.com/kb/pages/viewpage.action?pageId=76189718#Services(Managerv5.0)-_sec_formprefillservice

77

In addition to property and XML prefill, you can also choose to prefill your form with data obtained from the HTTP request when the form is rendered.
Prefill data can be passed in via request parameters, session attributes or cookies.

To view and modify the set of request parameter prefill mappings, edit the form data configuration and switch to the "Request Param Prefill Mapping" tab.
Edit Form Data Config - Test Attachment Form 1

Home > Forms > Form Data Config

Form Data Defintton | Form XIL Data | System Config Mapping | Property Prefil Mapping | Request Param Prefill Mapping | _hput XUL Prefil Mapping |

Reguest Param Prefill Mappings are used to map Web Plug-in JSON ‘prefilData’ parameters into the form XML data model when the form ie rendered.
This feature is currently only supported in the SmartForm Web Plug-in.

Parameter Name Form XPath Action

userFirstName [iCommon/UserProfie/ndividualGivenName @ ﬁ

userLastName IiCommen/UserProfile/individualFamiyName 7]

m Css

Viewing the list of request parameter prefill mappings for a form data configuration

You can edit and delete existing mappings, or create a new mapping by clicking "New" (the screenshot below shows the "Edit Prefill Data Parameter
XPath Map" page).

Edit Prefill Data Parameter XPath Map

Home = Forms > Ferm Data Cenfig = Prefill Data Parameter XPath Map

Parameter Name * [userEmail @

Form XPath* |//Common/ UserProfile/Contact Details/Email @

Save Close

Creating a request parameter prefill mapping

Enter the request parameter name into the "Parameter Name" field. This name is used at render time to look up matching request parameters, session
attributes and cookie values.

Enter the XPath in the form data configuration into the "Form XPath" field.

When a form is rendered in the Web Plugin module, the HTTP and JSON request parameters, HTTP session attributes and cookies will be searched for
entries with matching names, and their values will be mapped into the form data configuration according to the mappings.



Importing Forms from Transact Composer (Manager v5.0)

Transaction Manager is designed to host forms created in Avoka Transact Composer. In addition, you can easily publish forms from Composer to
Transaction Manager. This section describes how to publish forms created in Composer.

Search

Concepts

Transact Composer is a web application that allows for rapid design of sophisticated HTML and PDF SmartForms, and is part of Avoka Transact.
Composer can publish form packages to Transaction Manager, either directly or using ZIP file exports.

Publishing a Form Using Composer

Please note: Before you can publish forms to Transaction Manager, your instance of Composer must have the deployment property "External URL" set
to the URL of Composer as visible to Transaction Manager. If this is not possible, you will need to publish forms by exporting a ZIP file and importing it
into Transaction Manager.

In Composer, open the form you want to publish and click the "Publish..." button. You will see the "Publish Form" dialog.

Publish Form

' This wizard will guide you through the process of publishing a Form.
o

Select how you want to publish this form:

Publish Method sa:l Publish to Transaction Manager v | Configure...

URL https://tm.dev.avoka.com/manager

Include Seed File [ Include Composer generated seed file v

Select the form types you want to publish:

Form Types
YR [¥] HTML l Select All
] POF | Clear Selection

Cancel | Finish |

Publishing a form in Transact Composer

You can either publish the form directly to a Transaction Manager instance, or export it as a zip file and import it to Transaction Manager at your
convenience.

To modify the URL of the Transaction Manager instance that will be published to, click "Configure..." and edit the entry associated with publishing to
Transaction Manager (alternatively, you can add a new entry with a different URL). Adjust the URL and save your changes.

Once you are satisfied with your publishing target, select the form types you want to include and click "Finish".

If you are publishing directly to Transaction Manager, please read on. If you are publishing to a ZIP file, save the file and import it to Transaction
Manager by accessing the "Composer Import Summary" page as described in _sec_viewcomposerimportlog.

Importing a Form in Transaction Manager

If you are publishing to a Transaction Manager instance, you will be asked to log in to Transaction Manager and then shown the "Import Composer
Package" page.

Import Composer Package
Home Dashboard » Composer Package Imports » Composer Package Upload » Import Composer Package

Please review the forms found in the Composer package and the possible import actions you can take below.
- Tick and configure all import actions you would like to take, then click "import™ to proceed

Organization = Maguire j 2] New Form Space = Maguire j 2]
Action Composer Name Form Template(s) Form Name Options
12 ;j Basic Form - HTML HTML Desktop, Tablet  Basic Form - HTML New Form
2 _4‘; Basic Form-PDF  PDF Basic Form - PDF New Form

Importing a Composer form package to Transaction Manager
You will be offered to import all forms included in the package published by Composer. Please note that all form types will be listed separately, and a
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Transaction Manager form will be created for each.

Make sure to select the Transaction Manager organization you want to import the forms to from the "Organization" dropdown. All forms will be imported
to this organization. If no organizations exist on your Transaction Manager instance, you need to create one before you can import Composer forms.

In addition, select a space from the "New Form Space" dropdown. All new forms created during the import will be associated with this space (if
necessary, this can be manually adjusted later for individual forms). Note: Only spaces available to the selected organization will be shown. For
information on how to view or modify the spaces for an organization, please refer to Organization Configuration (Manager v5.0)
#_sec_organizationspaceaccess.

You can choose to import some or all of the forms by ticking the checkboxes next to the entries. For each Composer form in the package, two actions
may be available:

® Create a new form

This action is always available. A new Transaction Manager form with the name specified in the "Form Name" field will be created.
® Update an existing form

If a Transaction Manager form derived from the same Composer form was found, you can create a new version of the existing form or update
the current version (use with caution). This is the default action if a matching form is found.

Make your selection and then click "Import". The forms will be imported, and you will be shown a summary of the outcome. Please review the result to
check that all forms were imported successfully.
Composer Import Summary

Home > Forms > Form Data Config » Prefil Data Parameter XPath Map = Composer Package Loader > import Compeoser Package » Composer Import Summary
Composer package import completed

Form Name Composer Name Result Action
[:@ Payment Details - HTML [with PDF receipt] Payment Detais - HTML [with PDF receipt] New Form - Created form "Payment Details - HTML [with PDF receipt]"

[ Payment Details - PDF [with POF receipt]  Payment Details - PDF [with POF receipt]  New Form - Created form "Payment Details - PDF [with POF receipt]

The page summarizing Composer import results

Viewing the Composer Import Log

Every package that is imported from Composer is recorded in Transaction Manager. This allows you to monitor past imports, manually import Composer
package ZIP files and complete previously abandoned imports.

To view the Composer import log in Transaction Manager, go to "Forms > Composer Package Imports". You will see the list of previous Composer
package imports and their status.

Composer Package Imports

Home > Compeser Package Imperts

Import Status vl Start Date IDZ Apr 2012 00:00 D End Date : Clear

Import Composer Package

ID Composer Package Org. Time Created User Import Status Action
17 d1d8%dbd-2129-43cd-957a-6555cedbe7a3 ctest 03 Apr 2012 11:45:46 Ipammer Completed ! E !
16 extract fgg 03 Apr2012 10:05:58 Ipammer Completed 4 ﬁ !
15 extract foo 03 Apr201210:04:14 Ipammer Completed - i\ i
14 extract fgg 03 Apr201210:03:26 Ipammer Completed A m !
Export Data

The list of Composer package imports
You can filter the list by organization, import status (“Ready" or "Completed") and import date.

You can view details for an import item (), delete import records ( E) and download the ZIP file for an import item ( '!-).

You can also import ZIP files created by Composer by clicking the "Import Composer Package" button. You will be asked to upload the ZIP file as shown
below.

Composer Package Upload

Home > Composer Package Imports > Composer Package Upload

Composer Package File ™ |D:‘:data’\downloads'\sFC_&SSaadaB-B74B-4a23-af38h5e08dcba::1.ﬁp Browse_.

Uploading a Composer package file to Transaction Manager
Follow the instructions in the previous section to import the package.
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Delivery Configuration (Manager v5.0)

Once a form is submitted and ready for further processing, the organization needs to be notified so they can take appropriate action. Transaction
Manager allows you to set up automatic email, web service or LiveCycle orchestration delivery on a per-form basis, with separate settings for test and
production mode. A delivery channel is such a configuration defining the delivery process, and is a reusable entity associated with an organization.

Search

Delivery Types

Each form can be set up with two delivery channels: production and test delivery. The production delivery channel is used when the form is in production
mode (i.e. its "Test Mode" flag is turned off), otherwise the test delivery channel is used.

Submission delivery is initiated when the user completes all aspects of the form on Transaction Manager and other tasks (such as attachment virus
scanning and receipt generation) have also been completed. For example, this means that forms that have been submitted, but for which required
attachments are still outstanding, will not be delivered automatically until the user has completed everything.In addition, submission delivery can occur
after a submission has been abandoned, but it contains enough information that the organization may want to follow up with the user.

For more details on how to tell whether a submission is ready for delivery or has already been delivered, see Operations (Manager v5.0)
#_tracksubmissions.

Delivery Methods

Transaction Manager currently supports four different delivery methods.

Email Delivery

Email delivery sends out an email to a set of email addresses. The email can contain the submission data as well as a link to the attachments uploaded
by the user. Delivery is marked as completed as soon as the email has been sent.

Secure Email Delivery

Secure email delivery is similar to the standard email delivery in that it sends out an email to notify the organization of a submission. However, the email
itself does not contain any submission data; instead, it contains a link to a secure page on Transaction Manager which provides the submission data for
download.

In addition, delivery completes only after an administrator user has accessed this page and confirmed that the submission has been received.

If delivery has not been acknowledged within a certain time period (by default 24 hours), reminders are sent out to the recipients defined in the delivery
channel every day. If the delivery channel's "Email Addresses" field is blank, the reminder is sent to all global and organization administrators in the
"Receive Delivery Escalation Alerts" group.

If delivery remains unacknowledged (by default 72 hours after the form was submitted), escalation emails are sent out to all global and matching
organization administrators in the "Receive Delivery Escalations" group.

Web Service Delivery

Web service delivery notifies the organization by making a web service call, using a pre-defined API (see the Transaction Manager Web Service API
document).

Organizations can choose to either implement these web services themselves or install the Transact Integration Agent (please refer to the TIA
documentation for more information).

Delivery is marked as complete once the web service client confirms that it has received the submission.

If delivery has not been completed (by default 72 hours after the form was submitted), escalation emails are sent out to all global and organization
administrators in the "Receive Delivery Escalation Alerts" group.

REST Delivery

TM provides a REST endpoint that can be used to retrieve submission data. For more information on REST delivery, please see the Groovy services
guide included in the TM management console ("System > Transact Services Guide", section "REST Services").

Process Delivery

Process delivery invokes a service definition in TM to perform delivery. TM contains multiple service implementations, including a service that calls an
orchestration on an Adobe LiveCycle server and passes in the submission data as well as the attachments, as well a customizable Groovy delivery
service. Delivery is marked as completed if the service indicates that delivery was successful.

If delivery has not been completed (by default 72 hours after the form was submitted), escalation emails are sent out to all global and organization
administrators in the "Receive Delivery Escalation Alerts" group.

The sample LiveCycle delivery orchestration included in Transaction Manager writes the files out to C:\formcenter\processdelivery\<submitKey>\, where
submitKey is the submission's submit key.

Browsing Delivery Channels

To browse the list of available delivery channels for an organization, go to "Forms > Organizations", edit the organization and switch to the "Delivery
Channels" tab.
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Department of Health

Home Dashboard » Organizations. » Organization

Organization | Delivery Channels | Payment Gateway | Properties | PortalAccess | Form Categories | FormTags | Applications | Report Schedules | Storage Settings

Hame Default Method Delivery Process Action

Customer Email Delivery Process Delivery Process Groovy Customer Email Defvery Process  [7)
Trash Can Delvery Delivery Process Trash Can Delvery Process. ]
Web Service Web Service A8

New Close

Browsing the list of delivery channels

This page allows you to create, edit ( E)l) or delete ( E) delivery channels — see the sections below for details.

Creating a Delivery Channel

Delivery channels can be re-used for several forms. This makes it easier to later e.g. change the email addresses in one place without having to update
each form individually.

To create delivery details, go to "Forms > Organizations", edit the organization, switch to the "Delivery Channels" tab and click "New". You will see a
blank form (the screenshot below shows the form with some details filled in).

New Delivery Channel
Home Dashboard » Organizations » Organization » Delivery Channels

Delivery Channels I

Name*®  Default delivery channel
Delivery Method ™ =@
Description

Default Delivery Channel ¥ &

Save Close

Creating a delivery channel

Give the delivery channel a name (unique for all delivery channels available to the chosen organization) and, optionally, a description.

If this delivery channel shall be the default channel for the organization, tick the "Default Delivery Channel" checkbox. Submissions not explicitly
associated with a delivery channel will be delivered using the default delivery channel.

Now you need to choose how you want the submissions to be delivered: by email (standard or secure delivery), via a web service, via a REST call or to
a LiveCycle orchestration. Choose the appropriate value from the "Delivery Method" dropdown.

For more information on the Transact Integration Agent and web service delivery, see the separately delivered TIA Administration Guide.

Creating an Email Delivery Channel

Choose "Email" from the "Delivery Method" dropdown.

The "Email Addresses" and "Cc Addresses" fields are the email addresses submissions will be delivered to. You can fill in multiple email addresses by
separating them with commas.

You can customize the email subject and message (the default values are stored as service parameters of the default "Submission Delivery Controller"
service).

Note that you can also reference data extract values stored for the submission in the email subject or message. Data extract values generally represent
data entered by the user filling in the form, and can be used in delivery emails to display data about the user and/or their choices.To add a data extract

value to the email message or subject, use the Velocity variable "${submissionExtractData.extractname}", replacing “extractname" with the submission

data extract name and omitting the quote characters. However, if you are unsure whether a given extract value is present, you should add a conditional
around its usage.

For example, the following would safely add a reference to the contact phone number provided by the user (assumed to be stored in a data extract value
with the name "UserContactNumber"):

Please refer to the Velocity Template Language documentation for more information on Velocity notation (http://velocity.apache.org/engine/devel/vtl-
reference-guide.html) and to Operations (Manager v5.0)#_sec_submissiondataextractvalues for more about submission data extract values.

To control what data you wish to include in the delivery email as attachments, you can use the "Deliver PDF" and "Deliver XML" flags:
* |f you want the PDF receipt to be included in delivery, tick the "Deliver PDF Receipt" checkbox.
® |f you want the XML-based form data to be included in delivery, tick the "Deliver XML" checkbox.
® If you would like to include an Excel file containing submission extract data values (see Operations (Manager v5.0)
#_sec_submissiondataextractvalues), tick the "Deliver Excel Receipt" checkbox.

The above attachments will be assigned file names by TM, by default using the submission ID. If you would like to change the name template, edit the
"Attachment Filename Template" field.

You can include attachments uploaded by the submitting user by checking "Add User File Attachments".
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If your email server has size limitations, you can specify the maximum total size of attachments with the "Max Attachments Size" dropdown. If the total
attachment size exceeds the limit, TM will not attach any files but instead provide links in the email.

For an example of a fully filled in email delivery channel, see below.
Edit Delivery Channel

Home Dashboard » Organizations » Organization » Delivery Channels

Delivery Channels | \

Name*  Default delivery channel

Delivery Method* | Email j@
Description
Default Delivery Channel ¥ &
Email Message
To:* | delivery@mycompany.com 7]
Ce o
Subject® | $fenvironmentName} - Form: ${submission. form, formMame} Submission ID: $4submission.id} @
v <html>
¥ <head>
<title> Transaction Manager Submission Delivery </title>
<meta http-equiv="Content-Type" content="text/html; charset=UTF-3"/>
</head>
<body style="background-fscecec; ">
<center style="padding:lem;">
ar <table style="width:&40px; border-collaspse:collapse; font-family:Arial,Helvetica,sans-serif;"»
57 <tr>
<th style="coler:white; background:$005536; text-align:left; padding:lem; ">Transaction Manager
Submission Delivery</th>
<ftr>
<cr>
<td style="color:black; background:white; text-align:left; padding:lem;">
<p> Submission ID: $submission.id <br/>
Message * $if ($submission.paymentStatus) Payment: $submission.paymentStatus

$if ($submission.paymentType) ($submission.paymentType) #end <bz/> fend
BEttachments: $if ($submission.attachments)$submission.attachments.size()fend </p>
<p> This message has been zutomatically generated to advise the attached

submissicn has been successfully completed on Transaction Manager.</p>
<p¥» Data and attachments for this submission can be viewed by following <a
href="$5{portal.contextPathladmin/submission/submissicon-view. htm?tabPanellndex=2a
entityld=fsubmission.id">this link</a> </p>

<p*» For support please email S$supportEmail </p>
</td>

</tr>

<trr<td style="color:$d9fffd; background:§556c90; text-align:left; padding:lem;"></td></tr>

</table>

</center>
</body>
</html>

Email File Attachments

Add Receipt PDF
Add Form XML
Add Data Extract XLS

V@
V@
V@

Add User File Attachments
Wax Attachments Size

10MB jz@

FDF, XML, XLS filenames | ${submission.id} =]

Save Close

Setting up an email delivery channel

Creating a Secure Email Delivery Channel

Choose "Email Secure" from the "Delivery Method" dropdown.

The "Email Addresses" and "Cc Addresses" fields are the email addresses submissions will be delivered to. You can fill in multiple email addresses by
separating them with commas.

To control what you wish to include in the delivery, you can use the "Deliver PDF", "Deliver XML" and "Deliver Submitted PDF" flags:

® If you want the PDF receipt to be included in delivery, tick the "Deliver PDF Receipt" checkbox.
* |f you want the XML-based form data to be included in delivery, tick the "Deliver XML" checkbox.
® [f you want the submitted PDF in editable form to be included in delivery, tick the "Deliver Submitted PDF" checkbox.



For an example of a fully filled in set of secure email delivery details, see below.

Edit Delivery Channel

Home Dashboard » Organizations » Organization » Delivery Channels

Delivery Channels |

Name™ | Default delivery channel
Delivery Method ™ | Email Secure =] &
Description
Default Delivery Channel [ &
Email Addresses ™ | delivery@mycompany com
CC Addresses
Deliver POF Receipt [V @
Deiver Form XML ¥ @
Defiver Submited POF [~ &

Setting up a secure email delivery channel

Creating a Web Service Delivery Channel

Choose "Web Service" from the "Delivery Method" dropdown.
Tick "PDF Receipt Embed Files" to cause the submitted XML and submission attachments to be embedded into the receipt during delivery.

If you want the submitted PDF in editable form to be included in delivery, tick the "Deliver Submitted PDF" checkbox.

The "Client Key" displays the client key for the organization to which the delivery channel belongs. The client key is used during delivery and can be
helpful when setting up delivery on the Transact Integration Agent.

For a fully configured web service delivery channel, see below.

Web Service Delivery

Home Dashbeard » Organizations » Organization » Delivery Channels

Delivery Channels | Forms |

Name* Default delivery channel
Delivery Method* \Web Service j @
Description
Default Delivery Channel W @
PDF Receipt Embed Files [~ @
Deliver Submitted POF [~ i@
Client Key d92790f9833bc2aaleb84f287db3842

Save Close

Setting up a web service delivery channel

Creating a Delivery Process Delivery Channel

Choose "Delivery Process" from the "Delivery Method" dropdown. Choose the delivery process you want to use. Delivery processes are set up as
service definitions (see Services (Manager v5.0) for more information on service definitions and service connections).

The "Delivery Process Name" field specifies which orchestration will be invoked (for LiveCycle delivery processes).

If you want the submitted PDF in editable form to be included in delivery, tick the "Deliver Submitted PDF" checkbox.

Once a submission is complete, the delivery process service passes the submission delivery service, including the submitted form XML, the receipt in
PDF format, all attachments as well as an XML file containing metadata about the attachments.

For a fully configured Groovy process delivery channel, see below.

Edit Delivery Channel

Home Dashboard » Organizatiens » Organization » Delivery Channels

Delivery Channels I

Name ™ | Default delivery channel
Delivery Method® | Delivery Process ;l @
Description
Default Delivery Channel ¥ &

Delvery Process™®  Groovy Customer Email Delivery Process ;I

Delivery Process Name

Deliver Submited POF [~ &

Save Close

Setting up a process delivery channel

Creating a REST Delivery Channel
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Choose "REST Service" from the "Delivery Method" dropdown.

Tick "PDF Receipt Embed Files" to cause the submitted XML and submission attachments to be embedded into the receipt during delivery.

The "REST Retry Delivery Period" determines after how long a submission is reset to delivery status "Ready" after having been in status "In Progress".
The "REST Service URL" displays the REST URL for this delivery channel once the delivery channel has been saved.

Default delivery channel Delivery

Home Dashboard » Organizations » Organization » Delvery Channels

Delivery Channels I Forms |

Name*  Defaul delivery channel

Defivery Method* | REST Service j L

Description
Defauk Defivery Channel W @
FOF Receipt Embed Files [~ &
REST Retry Delivery Period | 1 hour j 7]

REST Service URL hitps-itm test avoka comimanager/securerestidelivery/v idoha/defaut-deivery-channel
3 o

Setting up a REST delivery channel

Setting the Delivery Channel for a Form

To change the delivery channel used by a form, go to "Forms > Forms" and edit the form. The "Details" tab has two dropdown fields that control delivery
channels: "Production Delivery" and "Test Delivery". Both offer all delivery channels set up for the form's organization. The production delivery details will
be used if the form is submitted while in production mode ("Test Mode" checkbox unticked); otherwise the test delivery details apply.

If no delivery channel is set, submissions will be delivered via the default delivery channel for the organization, if one is defined.

To change the delivery channel used by the form, simply choose the appropriate entry from the dropdown lists and save.

Home Owners Insurance Review

Home Dashboard » Forms » Form

Dashboard | Details I Flow Config | Email Verification Form Versions I Abandonment l

Form Display Mame* | Home Owners Insurance Review @
Form Code* | insurance-feview @
Ref Form ID @
Form Manager j @
Transaction Value 2]
Active ¥ @
TestMode [T @
Form Version Selector ~|@
Submission Expiry Date : 7]
Submission Expiry Days @
Tracking Code

Use Receipt No. for Tracking Code [~ @

Tracking Number Service j =]

Receipt Number

Receipt Number Service j @
Receipt Number Pattern*  ${formCode}-${nexd Sequence) @
Next Sequence Number* | 1 2]

Delivery Channels

Production Delivery j a@

Test Mede Delivery | Customer Email Delivery Process @
Validation Failure Delivery | Trash Can Delivery 2]

T ion Form Data R ion (max age)
Finished Transaction Form Data =~ Use defaults (7 days) j 7]

Saved Transaction Form Data | Use defaults (180 days) j L2 ]

Delete Form Data Extracts [~ @

Save Validate Form Close

Changing the delivery channel for a form

All submissions made for this form after you have saved it will use the new delivery channels.

To set a delivery channel for abandoned forms, change to the "Abandonment" tab and select a delivery channel from the "Abandoned Delivery Channel"
dropdown, then save.
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Viewing Forms Associated with a Delivery Channel

When modifying or deleting a delivery channel, it can be helpful to know which forms are using it to avoid unwanted side effects. To see the list of forms
using a given delivery channel, edit it and switch to the "Forms" tab.

Review And Approval Delivery

Home Dashboard » Organizafions » Organization » Delivery Channels

Delivery Channels. | Forms

Form Name
Signature Receipt

SmariForm Demonstration

Close

The list of forms using a delivery channel
Note that this list includes only forms explicitly associated with the delivery channel. If a delivery channel is marked as the default for the current
organization, it will be used for all forms not explicitly set to use other delivery channels.

Deleting a Delivery Channel

Delivery channels can be deleted; however, this will leave forms that had been using them without a delivery channel. To avoid delays in delivery, you
can check the organization's forms and reassign delivery channels first, where necessary.

Once all forms have been reconfigured, go to "Forms > Organizations", edit the organization and switch to the "Delivery Channels" tab. Find the delivery
channel that you want to remove and click the "Delete" icon. Because this action cannot be undone, you will be asked for confirmation.

Monitoring Submission Delivery

Transaction Manager automatically delivers submissions according to the delivery channel currently configured for the form (and the organization default
delivery channel if the form is not assiocated with a delivery channel) and will automatically retry delivery if failures occur (depending on the delivery
method used).

In addition, you can monitor submission delivery on a dedicated page and change the status for a set of submissions (e.g. to retry delivery after a
prolonged outage). To access this page, go to "Operations > Transaction Delivery".

Transaction Delivery

Heme Dashboard + Transaction Delivery

Delivery Status =~ Completed :] Form Delivery j Form j Start Date j Clear

Dedvery Message Wax Records 100 j End Date :|
Make All Delivery Ready Clear All Delivery Checkpoints Make All Dalivery Completed Make A eliverable
Delivery Delivery ) Hext )
(] Receipt Number  Form Org. siztis Tane Delivery Message Checkpoints  Attempts Attempt Action
- PR Credit Card . Delivered via process : Trash Can Delivery L2 & ™
[ FTX-CCA- 5 » P 5
61110 FTX-CCA-247 Appicaiion maguire Completed 1BIN0ZE s
e D-form- . ~ Delivered via process : Trash Can Delivery L2 47
60503 sttachment2-4 In-Form Attachment maguire Completed 13 Jul 1526 —
i . . i b .
60352 receipl-test-2 Receipt Test maguire Completed 13 Jul 1526 E:;::;:ﬁ via procsss - Trash Can Delvery L e
X . . X . -
60350 receipt-test-1 Receipt Test maguire Completed 13 Jul 15:26 Lo e e T e ey > %
= Process
» " . " -
BO251 FTN-CCA-D4E [‘.re._t Card maguirs Comp 13 Jul 1526 Delivered via process : Trash Can Delivery E
Application = Procass
z . 2 . " -
50249 FTN-CCA-245 Ele._l: Card maguire Completed 13 Jul 15:26 Delivered via process | Tragh Can Delivery OO )
Agpplication Process
Export Diata

Monitoring submission delivery

You will see the list of submissions with a certain delivery status. You can apply additional filters such as the organization associated with the
submission, the delivery channel, the form, a substring of the delivery message and the delivery date and time.

You can view details for each submission, which also allows you to change the delivery status for an individual submission (see Operations (Manager v5.
0)#_sec_submissionstatusvalues). To apply a bulk delivery status change to all submissions in the current search result, you can use the "Make All
Delivery Ready" (reset delivery status to "Ready" so delivery will be retried), "Clear All Delivery Checkpoints" (relevant only if the delivery service
supports delivery checkpoints), "Make All Delivery Completed" (set delivery status to "Completed" without retrying delivery) and "Make All Undeliverable"
(set delivery status to "Undeliverable", meaning that delivery will not be reattempted) button.
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Managing Form Attachments (Manager v5.0)

(Forms are very often not stand-alone documents but include other aspects such as supporting documentation. This chapter details how to set up
supporting documentation (“attachments") in Transaction Manager.

Search

Concepts

Attachments are separate entities (files or physical documents) that have to be submitted alongside the form. Forms may have multiple attachments,
some of which may be required to complete the submission, while others may be optional.

Attachments can be submitted in one of two ways: Either the user attaches them to their Transaction Manager submission by uploading files (electronic
submission), or the user submits them in any other way, e.g. by mail or fax (manual submission). You can choose to allow one or both methods when
defining an attachment.

Please note that Transaction Manager considers a submission complete only if all required attachments with electronic submission have been attached
by the user. Transaction Manager cannot check attachments that the user submits manually (by definition, such attachments are submitted
independently of Transaction Manager).

Attachments are defined for each form version. When a form is submitted, Transaction Manager checks whether attachments have been set up for it and
if so, displays an attachment page (the screenshot below shows an example).

&> MAGUIRE

FINANCIAL

Submission Attachments

Please review and complete the attachment requirements before continuing

Required Attachments

You need to attach these files in order to complete your submission

Proof of Identity
File type(s): .bmp, *_jpg. *.png Maximum file size: 512 KB

1 will deliver this document manually

Optional Attachments

These attachments are optional but you may wish to add them to your submission

Site Plan
File type(s). *.pdf Maximum file size: 2 MB

Add File

Total size: 0 KB (max total 50.0 MB)

Total number of attachments: 0 (max number 3)

Return to Form Cancel Submission

TM attachments page for a submission

As you can see, attachments are split into required and optional attachments. The user can decide how they want to submit attachments if they were set
up to allow both electronic and manual submission. A user can also upload files on the same page and gets a list of all files uploaded so far. Multiple
files can be attached for a single attachment.

Certain types of forms can also contain embedded attachments, which the user uploads using the PDF viewer. Transaction Manager can store these
attachments when the form is submitted, and they are also visible to administrators and are included in delivery.

The attachments submitted electronically by the user can be viewed and downloaded via Transaction Manager directly.

Attachment Types
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Every attachment managed by Transaction Manager can be associated with a document type, e.g. "Detailed Specification". This allows you to define
attachment categories you can then code against if needed.

Browsing Document Types

To view all document types currently defined in Transaction Manager, go to "Forms > Document Types". You can filter the list by organization or using a
substring of the document type's name, code or description, and export the search results to Excel by clicking the "Export Data" link below the table.

Document Types
Home > Document Types

|~.:;-.- Clear

New

Document Hame Org. Code MimeiFile Types Max Size Description Action
Decument document *doc, *.docx, * pdf, =ppt 0.5MB A document [2 E
Passport Photo nt-gov  ppp * jpa,*.bmp, *.gif SMB A
Passport Photo ntgovc ppp2 * jpa,* bmp,* gif 5MB A&
Proof of identity nt-gov  poi 3MB z‘ E
Proof of Identity ntgove poi2 IMB A
Site plan ntgovc sp2 5MB A&
Site plan nt-gov sp SMB E’ E
Test test 0.5MB A
Test Document Type 1 tdt *ixt, *.pdf, *.doc 1MB @A
Test Document Type 3 tdt3 *txt, * pdf, *.doc IMB E E
b 1100fM1 Export Data

Browsing the list of document types

You can add, edit ( E)l) and delete ( E) document types from this page.

Adding a Document Type

You can define new document types as needed. Go to "Forms > Document Types" and click "New". You will be directed to the "Edit Document Type"
page where you can fill in the details for the new document type.

Edit Document Type

Heme = Document Types = Document Type

Name* IPruof of Identity
Organisation I E|
Code™ 'pnl
File Types [*bmp. “jpg. “png
Maximum size* | 3 MB vl
Description
Save Close

Creating a document type

Enter the name and, optionally, a description of the document type. This description is used only to characterize document types internally and will never
be displayed to space users.

If the document type is specific to a particular organization, select it from the "Organization" dropdown. If you do not set an organization, the document
type will be globally available.

Enter a unique document type code into the "Code" field. This can be any string.

If you want to restrict the document type to certain file types, you can enter the supported file extensions into "File Types" field. Please enter a string
such as "*.jpg, *.gif, *.png" (i.e. extensions in the format *.<extension> separated by commas).

Choose the maximum size for attachments of this document from the "Maximum Size" dropdown.

After you save the document type, it can be assigned to your attachments. Note that while these attachments will default to the document type's allowed
file types and maximum size, each attachment can be modified to use different values.

Deleting Document Types

If you want to permanently remove a document type, you can delete it as long as it is not currently in use. This means that you need to review your
attachments to make sure no attachments of that document type exist.
Once you have removed or reconfigured all attachments of the affected document type, go to "Forms > Document Types", find the document type to be

? Unknown Attachment
removed and click the "Delete" icon ( ). You will be asked to confirm your decision before the document type is
deleted.

Configuring a Form to Support Attachments
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Transaction Manager populates the form with the list of specified attachments and later reads the list of required attachments from the form when it is
submitted. While this gives the form the opportunity to manipulate the list of attachments, it also means that the form must contain a certain data
structure that holds the specified attachments.

To enable Transaction Manager to read and write the form's attachment section, you may need to add a configuration mapping to the form data
configuration. Please refer to Form Version Configuration (Manager v5.0)#_sec_configurationmappings on how to do this; the mapping you need is from
"Attachment" to the XPath of the attachment section in your form.

Adding an Attachment to a Form Version

To add an attachment to a form version, edit the form version and switch to the "Attachments" tab. Click the "New" button. You will see the "Edit Version
Attachment" page.

Edit Version Attachment

Home Dashboard » Forms » Form » Form Version » Version Attachment

Name ™ Proof of Identity

Please upload a proof of identity document (passport, driver's licence or state

identity card).
Description i

Document Type = Proof of Identity j @
Document Code  poi @
Aftachment Required [V &
Maximum Number = 2 j 9
File Types  “bmp, *jpg. “png 9
Maximum Size™ 2 MB j o
Maximum Pixel Resolution j 22

Submit Method  Blectronic j-j

Save Close

Creating an attachment for a form version

Fill in the attachment name as you want it to appear to the space user. Add a description to help the user determine what to attach and if more than one
copy is required for manual submission.

Choose the most appropriate document type from the "Document Type" dropdown. This will initialize the document code, file types and maximum size
with the values stored in the document type. You can also create an attachment that is not based on a document type, and fill in the "Document Code",
"File Types" and "Maximum Size" fields yourself.

Please note that the user space will be able to enforce that only files matching the allowed file types and maximum size can be uploaded. The Example
Self Service Space rejects files that do not match these criteria.

The "Attachment Required" checkbox controls whether the user will have to provide this attachment for the submission to complete. If left unticked, the
attachment is treated as optional.

The "Maximum Number" dropdown lets you control the maximum number of files that the user can attach for this attachment. This restriction applies in
addition to global restrictions to the number of overall attachments.

The "Maximum Pixel Resolution" is used on the TransactField App only, to restrict image files to a maximum resolution.

Finally, the "Submit Method" determines how users can submit their attachments. The choices are electronic (attach directly via the Transaction
Manager attachments page), manual (any other way) or both. Please note that if you choose manual submission only, the organization will be
responsible for monitoring and managing attachments. Please also indicate to the user what manual submission means for them — either in the form or
the attachment description.

When you save the data, the new attachment will be created.

Size Limits

As you have seen, the size of each individual attachment can be limited. While this is useful, it applies only to a single file uploaded by a user. It can be
helpful to restrict the total number and size of all attachments combined. Transaction Manager allows you to do this for each form version. This will affect
all attachments made for a submission, including embedded attachments.

To limit the total attachment size, edit the form version and switch to the "Attachments" tab.

Edit Form Version - Electoral Enrolment 1

Home > Forms > Form > Form Version

Form Version | PDF Options | Properties I Attachments | Form Tags Services Version Promotion |

Name File Types Document Code Max Size Required Submit Method Action
Additional documentation sp SNMB ?| f
Passport Photo *jpg,*.bmp,*.gif ppp 2NMB 2 T

Maximum Total Size [15MB x| &

Maximum Number |6 | @&
Save Close

Viewing the list of attachments and setting size limits

Select the desired total attachment size from the "Maximum Total Size" dropdown.

If you would like to limit the number of attachments that are submitted, choose the maximum number from the "Maximum Number" dropdown.
Save your changes.
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Deleting Attachments

If you want to delete an attachment so Transaction Manager no longer asks for it to be submitted, edit the form version and switch to the "Attachments"

tab. Find the attachment you want to delete and click the "Delete" icon ( E).
After you confirm your decision, the attachment will be removed. Previous submissions with attachments remain unaffected by this; Transaction
Manager will simply no longer request the attachment in the future.

Virus Scanning

To avoid users uploading files infected with viruses, Transaction Manager includes support for virus scanning. If a virus scanning service is configured,
Transaction Manager will maintain a virus status for each uploaded file.

If a virus scanning service is configured, delivery will be initiated only once all attachments have been scanned and are virus-free. Files that are found to
contain a virus will be deleted to avoid contamination. The Example Self Service Space will scan files as they are uploaded and will give immediate
feedback to the user in case a virus was found.

Transaction Manager includes support for two virus scan engines: Symantec Scan Engine 5.2 and ClamAV.

Setting Up the Symantec Virus Scanning Service

Transaction Manager includes a virus scanning service that can connect to the Symantec Scan Engine 5.2 (http://www.symantec.com/business/scan-
engine). Make sure you have set up Symantec Scan Engine before you activate the service.

If Symantec Scan Engine is running on a different server or a port other than the default (1344), you will need to edit the service connection. Go to
"System > Service Connections" and edit the service connection named "Symantec Virus Scan". Adjust the "Endpoint Value" field as needed and save.

Edit Service Connection

Home = Service Connections > Service Connection

Name |Symartec Vius Scan
Endpoint Jlocalhost:1344
Transport I -

Server Type I vl

FormServer [

Username I

Password |

Use Auth. Mgr. [

Save Close

The service connection for the Symantec virus scan service
Activate the Symantec virus scan service by following the instructions in _sec_activatevirusscanservice. The relevant service definition is named "Virus
Scan".

Setting Up the ClamAYV Virus Scanning Service

Transaction Manager also contains a virus scanning service that can connect to ClamAV (http://www.clamav.net/). Make sure that ClamAV is set up
before you activate the Transaction Manager service.

If ClamAV is running on a different server or a port other than the default (3310), you will need to edit the service connection. Go to "System > Service
Connections" and edit the service connection named "ClamAYV Virus Scan". Adjust the "Endpoint Value" field as needed and save.

Edit Service Connection

Home > Service Connections > Service Connection

Name |QamAV Virus Scan
Endpoint |\ocalhost'33'l 0
Transport I -

Server Type I vl

Form Server -

Username I

Password |

Use Auth. Mgr. [

Save Close

The service connection for the ClamAV virus scan service
Activate the ClamAV virus scan service by following the instructions in _sec_activatevirusscanservice. The relevant service definition is named "ClamAV
Virus Scan".

Activating a Virus Scanning Service

To activate a virus scanning service, go to "System > Service Definitions", find the appropriate service of type "Virus Scan" and edit it. Tick the "Service
Type Default" checkbox and make sure the "Service Connection" dropdown is set correctly. Save the service definition.

To deactivate the virus scanning service, simply edit it again, untick the "Service Type Default" checkbox and save.

Once you have turned on the virus scanning service, attachments will be scanned automatically. Transaction Manager can handle temporary outages of
the virus scan engine and will simply re-attempt to have unscanned attachments scanned periodically.
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Embedded Attachments

Embedded attachments are files that are uploaded to the PDF form directly, using the PDF viewer (as opposed to attachments defined in and uploaded
via Transaction Manager).

These attachments can be used only with reader-extended dynamic PDF forms that submit as PDF (as opposed to XML or XDP). When the form is
submitted, Transaction Manager will extract the attached files and add them to the submission.

Administrators alongside other attachments can view these embedded attachments and will be virus scanned and included in delivery. However,
embedded attachments are not managed by Transaction Manager, and hence are not individually constrained in their maximum size or file type. Note
that the form can be designed to enforce constraints on these attachments, and they are also subject to the total attachment size configured for the form.

Managing Submitted Attachments

This section describes how attachments that are submitted via Transaction Manager (including embedded attachments) can be viewed and managed.

Viewing Attachments for a Submission

To view all attachments for a submission, go to "Operations > Form Transactions". Find the submission you are interested in, click the "View Details"

icon () and switch to the "Attachments" tab.
Transaction Details

Home Dashboard » Form Transactions » Transaction Details

Transacton Detats | Transacton Status | Request | wetory | Attachments | Processngstsus | Evens

Required Attachments

Attachment Name Required Max No. Max Size File Types Submit Method Doc Type
Attachment Limé to Oine 4 1

Aftachment Small SWE 4 48 MB

Essential-dre there AL 50 MB

Lim&t To One Max Resolution 500 ¢ 1

Submitted Attachments

Attachment File User Virus  Delivery .
o e Type  File Name Size Submitted  Time —— s Elatun Deleted File Data Hash [SHA-256) Action
B35 Attachment Upioad aft TO0c21Z85TEiAcEabZ9)51482/e62137jpg 4KB Electronicaly 12 Ciean  Completed o’ §1121c0ab51032e8d007 0197 54b08bCad852 cabb29 1 c1 acio 16377 2008 JeeT T
Limi ta Gne May
03
G366 LmtTo One Upicad ofl_1d67904705ec4935985065308407 2044 pg 4 KB Electroncaly 12 ean  Completed ¢ 4293307690091 402309550459 1 cAMS4T 404 Tec2ad? 1 SbeatcOdTb2053 3005
Max May
Resolution 1038
500
G367 Aftachment  Upload afl_fEb11490b47d44300454e02bcd3b38c8 pg 1,055 Eleclronicaly 12 Clea Completed i 2577b1S036ea8M 134 341400989856154 5! 6 26511
Small SMB L] May
10:39
BIE8 EssenfislAre Upibad af_0Sb1ad037a274770sedBdasld1adScidjpg 2,228 Eleclromcaly 12 Clean  Completed e 0450ce4b2dBB0 142501151 02143307 A4 7511 445034007 2cBc 1 b4 FIO0Sa04
there RCD's KB May

10:38

Files Total Size: 3261 KB

In-Form Attachments Used [T i@

The attachments for a submitted form

The "Attachment Type" column contains the type of attachment. This can be one of the following values: "Upload" for a managed attachment uploaded
by the user; "Embedded" for an embedded attachment; "Signed Receipt" for a scanned-in signed form receipt uploaded for a form requiring wet
signatures; and "Submitted Form" form for PDF forms submitted as PDF, where the submitted form is stored as a separate attachment.

The "Attachment Name" column contains the name of the corresponding attachment set up in the form. For embedded attachment, this column is blank.
The "Doc Type" column contains the name of the document type of the corresponding version attachment. For embedded attachments, this column is
blank.

The "Required" column shows whether the attachment was mandatory or optional.

The "Submitted" column shows how the user chose to submit the attachment and will be set to either "Electronically” or "Manually".

The "File Name" and "File Size (KB)" columns contain the file name and size in KB of the file that was uploaded. This column is blank if the attachment
was submitted manually.

The "Virus Status" column contains the virus scan status for the uploaded file. This column is blank if the attachment was submitted manually or no virus
scan service has been configured. Otherwise, it may also contain the values "Clean" (scanned successfully; no virus found), "Virus" (scanned
successfully; virus found) and "Error" (error during virus scan; repeat scan pending).

The "Delivery Status" column contains the delivery status for the attachment. The column will change to "Completed" once the attachment has been
delivered successfully.

m
Click the "Download File" icon ( U) to save the file to disk. This will download the file using your browser's normal download routines.

Please note that Transaction Manager provides an automated purge mechanism for submissions, attachments and many other entities (see Operations
(Manager v5.0)#_sec_dataretention).
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Online Payment (Manager v5.0)

A submission often requires payment to be processed further. Transaction Manager includes a payment module to manage online credit card payments.
This chapter explains how to set up organizations and forms to use the payment module.

Search

Concepts

Forms in Transaction Manager can request payment once they have been completed. The total payment consists of one or more payment line items.
Payment can either be requested via credit card, BPAY or using external payment services such as PayPal.

If BPAY is requested, the form should display the biller code and reference number to the user. Transaction Manager cannot process BPAY payments,
so it does not provide a separate payment step for submissions using BPAY.

If you would like to process payment directly via Transaction Manager, there are two different payment modes you can choose from: 2-party services,
where the payment is processed via a payment page in the Transaction Manager user space, with Transaction Manager calling the payment provider
directly; or hosted (3-party) services, where the user is redirected to the payment provider's website, makes payment there, and is then redirected back
to Transaction Manager.

Transaction Manager integrates with a number of 2-party payment providers as well as several hosted payment services (including PayPal). The 2-party
payment services will ask for payment via credit/debit card, whereas hosted payment services can be very flexible (since the payment provider's website
is used). For example, with the PayPal payment service, the user can choose to use their PayPal account, or simply enter credit card details instead.

If a submitted form indicates that payment should be performed via the 2-party model, Transaction Manager reads out the payment amount from the
payment section in the form and requests credit card payment from the user by displaying a payment page.

Once the user makes payment via credit card, the payment details are forwarded to the payment gateway set up for the organization. A payment
gateway processes online credit card payments and forwards them to the organization's bank account. Transaction Manager comes with adapters for
several payment gateways. Generally, an account must be set up with the payment gateway for each organization that wishes to use it.

If, on the other hand, a submitted form indicates that payment should be performed using a hosted payment gateway, the user is directed to a page in
Transaction Manager that contains information about the payment as well as a link to the payment provider's website. The user can click this link, make
their payment and then get redirected back to Transaction Manager to continue the submission process.

Once payment is complete, the submission can progress and eventually be delivered. For security reasons, a user's credit card details are not stored in
Transaction Manager. Instead, records on successful and failed payment attempts are kept, which can be used to reconcile payments made in
Transaction Manager with payments actually received by the organization.

For payment reconciliation, payment gateways commonly report on credit card payments for a batch. A batch consists of payments made during 24
hours, but does not normally coincide with a calendar day. Instead, a batch changes when the organization's bank stops processing payments for the
day, e.g. at 5:30 pm. Payments made after this time (the batch cutoff time) are processed during the next calendar day. For accurate reconciliation
reporting, it is important to know the batch cutoff time that is appropriate for the organization's bank.

Payment Gateways

To process a payment (whether using credit card details entered by the user in the 2-party model, or redirecting to an external website in the hosted
model), Transaction Manager needs to call a payment gateway that either confirms or rejects the payment. Payment gateways are set up as service
definitions in Transaction Manager (see Services (Manager v5.0)). By default, Transaction Manager provides a number of payment services as
described below.

Payment gateway configuration can be on one of two levels: The global level of the payment service definition (usually containing parameters such as
the payment gateway URL) and the organization level (containing information about the organization's account with the payment gateway such as user
name).

Two-Party Payment Gateways

This section lists the two-party payment gateways supported by Transaction Manager, and how to configure them.

Demo Card Payment

This payment service can be used for testing and demonstration purposes. It is not linked to a gateway; instead, it accepts all credit card payments
without actually processing them.

Global Configuration

No special configuration is needed for this service.

Organization Configuration
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To configure an organization to use the Demo Card Payment service, go to "Forms > Organizations", edit the organization and switch to the "Payment
Gateway" tab.

Choose "Demo Card Payment" from the "Payment Gateway Service" dropdown. No other values are required.

Save your changes.

Edit Organisation - Example Company

Home > Organisations = Organisation

Organisation | Form Delivery Detais | Payment Gateway | Properties | ReportSchedules | FormTags | Portal Access
Payment Gateway Service | Demo Card Payment v @ Supported Credit Cards:
Merchant ID I a American Express -
Payment Access Code | 9 Diners Club r
Merchant User I [} MasterCard v
Merchant Password I @ Visa 2

Batch Cutoff Time 12 vIll}{l vI am x| @

An example configuration for the Demo Card Payment service

NAB Card Payment

This payment service connects to the NAB payment gateway (https://transact.nab.com.au). To use it, the organization needs to set up an account with
NAB and enter its merchant details into Transaction Manager.

Global Configuration

The NAB card payment service has two global configuration parameters: The URL to the payment gateway server and the transaction timeout value.
To configure these parameters, go to "System > Service Definitions", find the NAB card payment service and edit it. Switch to the "Service Parameters
tab.

To change the URL to the payment gateway server, edit the "paymentUrl" parameter and enter one of the payment URLs below (unless provided with
different URLs by NAB):

Test | https://transact.nab.com.au/test/xmlapi/payment

Live | https://transact.nab.com.au/live/xmlapi/payment

To change the transaction timeout value, edit the "timeout" parameter and enter the desired timeout value in minutes.

Organization Configuration

To configure an organization to use the NAB card payment service, ensure the organization has obtained a merchant account with NAB first.
Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway" tab (see below).

Choose "NAB Card Payment" from the "Payment Gateway Service" dropdown.

Enter the organization's merchant ID into the "Merchant ID" field.

Enter the merchant password into the "Merchant Password" field.

Enter a batch cutoff time consistent with the organization's bank into the "Batch Cutoff Time" field.

Save your changes.

Edit Organisation - Example Company

Home > Organisations > Organisation

Organisation | Form Delivery Details | Payment Gateway | Properties | Report Schedules I Form Tags | Portal Access

Payment Gateway Service | NAB Card Payment ~| @ Supported Credit Cards:

Merchant ID* |AECDD1 2] American Express -
Merchant Password* Iunoou a9 Diners Club -
Batch Cutoff Time IS_L”E, pm v | & MasterCard 12

Visa I

Close

An example configuration for the NAB Card Payment service

TNS Card Payment and CommWeb Card Payment

These payment services both connect to the TNS payment gateway (http://www.tnsi.com/). To use it, the organization needs to set up an account with
TNS and enter its merchant details into Transaction Manager.

Global Configuration

The TNS and CommWeb card payment services have two global configuration parameters relevant to making payments: The URL to the payment
gateway server and the transaction timeout value.

To configure these parameters, go to "System > Service Definitions", find the payment service and edit it. Switch to the "Service Parameters" tab.
Set the "paymentUrl" to https://migs.mastercard.com.au/vpcdps unless instructed otherwise by the gateway provider.

To change the transaction timeout value, edit the "timeout" parameter and enter the desired timeout value in minutes.

Organization Configuration
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To configure an organization to use the TNS or Commweb card payment service, ensure the organization has obtained a merchant account on the TNS
or Commweb payment gateway first. In addition, a payment query user needs to be set up on the web administration console associated with the
payment gateway. This user needs to have the permission to query past payments (permission "Enable advanced Merchant Administration features").
Please contact your payment gateway provider for assistance if required.

Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway" tab (see below).

Choose "TNS Card Payment" or "CommWeb Card Payment" from the "Payment Gateway Service" dropdown.

Enter the organization's Merchant Profile ID into the "Merchant Profile ID" field. Note that each organization is normally provided with two profiles, one
for testing and one for production use.

Enter the merchant access code into the "Merchant Access Code" field.

Enter the user name of the payment query user into the "Payment Query Username" field.

Enter the password of the payment query user into the "Payment Query Password" field.

For later reconciliation of payments received via Transaction Manager, enter the batch cutoff time (specific to the bank used by the organization) into the
"Payment Batch Cutoff Time" field.

Tick the checkboxes for the credit cards that are enabled for your merchant account and save your changes.

Edit Organisation - Example Company

Home > Organisations = Organisation

Organisation | Form Delvery Details | Payment Gateway | Properties | Report Schedules | FormTags | Portal Access

Payment Gateway Service | TNS Card Payment v | & Supported Credit Cards:

Merchant Profile ID* |TESTCUENTABCD‘I @ American Express -
Merchant Access Code * IBCDSEBEB a9 Diners Club |l
Payment Query Username |quer)-user o MasterCard 2
Payment Query Password quuu o9 Visa 2

Batch Cutoff Time 5 =||30 =||pm | &

An example configuration for the TNS Payment Gateway service

Westpac Card Payment

This payment service connects to the Westpac payment gateway (https://www.payway.com.au). To use it, the organization needs to set up an account
with Westpac and enter its merchant details into Transaction Manager.

Global Configuration

No special configuration is needed for this service.

Organization Configuration

To configure an organization to use the Westpac card payment service, ensure the organization has obtained a merchant account with Westpac first.
The organization will also receive a certificate file from Westpac, which must be stored to a directory accessible to Transaction Manager.

Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway" tab (see below).

Choose "Westpac Card Payment" from the "Payment Gateway Service" dropdown.

Enter the organization's merchant ID into the "Merchant ID" field. Please note each organization is usually provided with two IDs, one for testing and one
for production use.

Enter the merchant username into the "Merchant Username" field.

Enter the merchant password into the "Merchant Password" field.

Set the "Batch Cutoff Time" field to 6:00 pm unless advised otherwise by Westpac.

Tick the checkboxes for the credit cards that are enabled for your merchant account.

Edit Organisation - Example Company

Home > Organisations > Organisation

Organisation | Form Delivery Details I Payment Gateway | Properties Report Schedules I Form Tags | Portal Access

Payment Gateway Service IW 9 Supported Credit Cards:
Merchant ID* |TEST @ American Express -
Merchant Username * IOW?MS @ Diners Club r
Merchant Password™ |nunn @ MasterCard I
Batch Cutoff Time [6 = =m @ Visa v

Save [JEeLED

An example configuration for the Westpac Card Payment service

Save your changes and switch to the "Properties” tab.

Create a new organization property of type "Payment Certificate File" and set it to the full path to the certificate file obtained from Westpac for the
organization (e.g. C:\paywayCert\ccapi.q0).

Bizgate Card Payment

This payment service connects to the Bizgate payment gateway (http://www.bizgate.sa.gov.au/). To use it, the organization needs to set up an account
with Bizgate and enter its merchant details into Transaction Manager.

Global Configuration
The Bizgate card payment service allows you to configure the URL to the payment gateway server.

To configure the URL, go to "System > Service Definitions", find the Bizgate card payment service and edit it. Switch to the "Service Parameters" tab.
Edit the "bizgateUrl" parameter and enter one of the payment URLs provided by Bizgate.
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Organization Configuration

To configure an organization to use the Bizgate card payment service, ensure the organization has obtained a merchant account with Bizgate first.

Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway" tab (see below).

Choose "Bizgate Card Payment" from the "Payment Gateway Service" dropdown.

Enter the merchant username into the "Merchant Username" field.

Enter the merchant password into the "Merchant Password" field.

For later reconciliation of payments received via Transaction Manager, enter the batch cutoff time (specific to the bank used by the organization) into the
"Payment Batch Cutoff Time" field.

Tick the checkboxes for the credit cards that are enabled for your merchant account and save your changes.

Edit Organisation - Example Company

Home > Organisations > Organisation

Organisation | Form Delivery Details | Payment Gateway | Properties | Report Schedules | Form Tags | Portal Access

Payment Gateway Service W 7]} Supported Credit Cards:
Merchant Username * |12345 9 American Express r
Merchant Password * |-"un- 2] Diners Club -
Batch Cutoff Time [5 =130 =][em =] @ MasterCard ~
Visa v

An example configuration for the Bizgate Card Payment service

SecurePay Card Payment

This payment service connects to the SecurePay payment gateway (http://www.securepay.com.au). To use it, the organization needs to set up an
account with SecurePay and enter its merchant details into Transaction Manager.

Global Configuration

The SecurePay card payment service has two global configuration parameters: The URL to the payment gateway server and the transaction timeout

value.
To configure these parameters, go to "System > Service Definitions", find the SecurePay card payment service and edit it. Switch to the "Service

Parameters" tab.
To change the URL to the payment gateway server, edit the "paymentUrl" parameter and enter one of the payment URLs below (unless provided with

different URLs by SecurePay):

Test | http://test.securepay.com.au/xmlapi/payment

Live | https://api.securepay.com.au/xmlapi/payment

To change the transaction timeout value, edit the "timeout" parameter and enter the desired timeout value in minutes.

Organization Configuration

To configure an organization to use the SecurePay card payment service, ensure the organization has obtained a merchant account with SecurePay first.
Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway" tab (see below).

Choose "SecurePay Card Payment" from the "Payment Gateway Service" dropdown.

Enter the organization's merchant ID into the "Merchant ID" field.

Enter the merchant password into the "Merchant Password" field.

Enter a batch cutoff time consistent with the organization's bank into the "Batch Cutoff Time" field.

Tick the checkboxes for the credit cards that are enabled for your merchant account and save your changes.

Edit Organisation - Example Company

Home > Organisations > Organisation

rganisation orm Delivery Detai Payment Gatewa roperties eport Schedules orm Tags o ccess
0 ti Fi Delivi Details ¥ Y P rii Report Schedul Fi Te Portal A

Payment Gateway Service Im 7] Supported Credit Cards:
Merchant ID* |ABC1234 9 American Express r
Merchant Password* I--uoo" ] Diners Club |l
Batch Cutoff Time [5 =30 =][em x| @ MasterCard ¥
Visa =2

An example configuration for the SecurePay Card Payment service

BPoint Payment Gateway

This payment service connects to the BPoint payment gateway (https://www.bpoint.com.au/bpoint/).
To use it, the organization needs a BPoint merchant account.

Global Configuration
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The BPoint card payment service has two global configuration parameters: The URL to the payment gateway server and an expiry date value for use
during testing.

To configure these parameters, go to "System > Service Definitions", find the BPoint card payment service and edit it. Switch to the "Service
Parameters" tab.

To change the URL to the payment gateway server, edit the "paymentUrl" parameter and enter one of the payment URLs below (unless provided with
different URLs by BPoint):

Test | https://evolve-uat.premier.com.au/evolve/service.asmx?WSDL

Live = https://www.bpoint.com.au/evolve/service.asmx?WSDL

The second parameter (named "testExpiryDate") MUST NOT be set when the payment service is in production mode. An empty string value is
acceptable.

While the payment service is in test mode, BPoint uses the credit card expiry date to control the returned result. For a test payment to be successful, the
expiry date must be "9900" or "9908" (using a format of MMYY). As this does not correspond to a valid date and TM does not allow users to enter such
expiry dates, it would be impossible to make successful BPoint test payments. Therefore, the BPoint payment service provides a way to set a hard-
coded expiry date that, if set, will be passed to BPoint in place of the expiry date entered by the user.

In short, set the test expiry date to a blank string while in production mode, or set it to "9908" or "9900" for successful payments in test mode, or another
value to produce payment errors in test mode (the two digits for the year will be returned as the response code).

Organization Configuration

To configure an organization to use the BPoint card payment service, ensure the organization has obtained a BPoint merchant account first.
Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway" tab (see below).

Choose "BPoint Card Payment" from the "Payment Gateway Service" dropdown.

Enter the organization's merchant ID into the "Merchant Number" field.

Enter the merchant username and password into the "Username" and "Password" fields.

Enter the batch cutoff time provided by BPoint into the "Batch Cutoff Time" field.

Tick the checkboxes for the credit cards that are enabled for your merchant account and save your changes.

Administrative Services

Home Dashboard » Organsations » Organisation

Organisation | Form Delivery Details | Payment Gateway | Fropert Form C ies | FormTags | PortalAccess | ReportScheduks | Storage Settings
Payment Gateway Service  BPoint Card Payment | '@ edat Supported Credit Cards:
Merchant Number®  1234123412341234 o American Express [
Usemame "  myuser = Diners Cub [V
Password” ssssssssss o MasterCard [V
Batch Cutoff Tme 5 x| 30 =] pm x| @ vea [V

An example configuration for the BPoint card payment service

Hosted Payment Gateways

This section lists the hosted (three-party) payment gateways supported by Transaction Manager, and how to configure them.

PayPal Hosted Payment Gateway

This payment service uses the PayPal Express Checkout service to process payments. Users are offered to pay using their PayPal account, or using a
credit card.

Global Configuration

The PayPal Hosted Payment service has three relevant parameters: The URL of the payment website, the name of the PayPal environment that will be
used, and the currency.

To configure these parameters, go to "System > Service Definitions", find the PayPal hosted payment service and edit it. Switch to the "Service
Parameters" tab.

To change the URL to the payment website, edit the "paymentUrl" parameter and enter one of the payment URLs below (unless provided with different
URLSs by PayPal):

Test | https://www.sandbox.paypal.com/cgi-bin/webscr?cmd=express-checkout&token=

Live | https://www.paypal.com/cgi-bin/webscr?cmd=express-checkout&token=

Also ensure the "environment" parameter is set correctly: It should be "sandbox" while using the sandbox test environment, and "live" while in production
mode.
To change the currency, edit the "currency" parameter and enter the desired currency code.

Organization Configuration

To configure an organization to use the PayPal hosted payment service, ensure the organization has obtained a merchant account with PayPal first.
Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway" tab (see below).

Choose "PayPal Hosted Payment" from the "Payment Gateway Service" dropdown.

Enter the email address associated with the organization's merchant account into the "PayPal User Email" field.

Enter the PayPal signature (an alphanumeric string) into the "PayPal Signature" field.
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Enter the organization's PayPal API username into the "PayPal APl Username" field.
Enter the organization's PayPal API password into the "PayPal API Password" field.

Edit Organisation - Example Company

Home > Organisations > Organisation

Organisation | Form Delivery Details I Payment Gateway | Properties

Report Schedules Form Tags Portal Access

Payment Gateway Service | PayPal Hosted Payment vI 7

PayPal User Email*

Jtuser_1224567890_biz@clent.com @

PayPal Signature *

FDngAF?OOkySMh NBBTSINOGn58CZx3R &

PayPal APl Username *

[luserj 234567890 _biz_api1.client.com o

PayPal APl Password*

-

[sssssssace @

An example configuration for the PayPal Hosted Payment service

Westpac QuickWeb Hosted Payment

This payment service connects to the QuickWeb payment gateway (https://www.quickweb.com.au). To use it, the organization needs to set up an
account with QuickWeb and enter its merchant details into Transaction Manager.

The QuickWeb payment gateway is a hosted payment gateway where the user's credit card information is actually captured by the Westpac QuickWeb
gateway. The Transaction Manager Space redirects the user to the QuickWeb website where the payment details are captured and processed. The
results of the transaction are passed back to Transaction Manager through an asynchronous server to server HTTP post handled by the Space. After
payment, the user is redirected back to the confirmation page.

Submission payment is marked as completed when the asynchronous call back is received. If the callback is not received the submission will be marked

as "Payment Verification Pending" and will not be delivered until the server to server callback is received.

Prerequisites

To enable this service the following actions need to be performed:

QuickWeb needs to build a payment portal for the client and set the gateway up to support a token request.

QuickWeb/merchant need to provided Community Code, Business Code, Username and Password.

Make sure the TM SSL Certificate is not Self-Signed as this is not supported by QuickWeb.

The TM server's IP address needs to be white-listed by QuickWeb.

Make sure the self-service space is available externally otherwise QuickWeb will not be able to send the payment result callback.
The QuickWeb portal needs to be setup to allow a callback to a URL of the following format: https://<domainname>/<portalcontext>

Iservlet/hostedpayment/callback.

Global Configuration

The Westpac hosted payment service has global configuration parameters as described in the following table:

Parameter
currency

paymentURL

paymentRequestUrlPara
metersTemplate

tokenURL
requestTokenUrlParame
tersTemplate

currency

customParameterMap

callbackParametersMap
ping

passbackParametersMa
pping
keepReconciliationFileF
orDays

paymentTransactionLife
spanMinutes

reconciliationConfigurati
on
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Description

The currency of the transaction

The URL that the user will be redirected to. The following is an example for the test system:-
https://quickweb.support.qvalent.com/OnlinePaymentServlet

Velocity template to control the parameters passed to QuickWeb when the user is redirected to the payment gateway.
Please see section "QuickWeb Outgoing URL Configuration" below.

The URL that is used to obtain a token for the transaction. The following is an example for the test system:-
https://quickweb.support.qvalent.com/Community TokenRequestServiet

Velocity template to control the parameters passed to QuickWeb when the system requests a token from the payment
gateway. Please see section "QuickWeb Outgoing URL Configuration" below.

The payment currency (default AUD)

JSON Map of XPath references of values to pull out of the form xml for use with the customParameterTemplate string.
The following is an example mapping.

{
"cpParaml": "//AvokaSmartForm/SFMData/SystemProfile/TrackingCode"

}

Provides a mapping to the values in the QuickWeb callback used to process the result of the transactions (Default
QuickWeb3)

Provides a mapping to the values in the QuickWeb user return browser redirection used to process the result of the
transactions (Default QuickWeb3)

The number of days that the reconciliation files will be kept in the database.

The session time for a payment transaction in the provides payment gateway

JSON structure used to identify the columns within the reconciliation file. This should have an empty value unless
reconciliation is being utilised.


https://www.quickweb.com.au
https://quickweb.support.qvalent.com/OnlinePaymentServlet
https://quickweb.support.qvalent.com/CommunityTokenRequestServlet

To configure these parameters, go to "System > Service Definitions", find the Westpac hosted payment service and edit it. Switch to the "Service
Parameters" tab.

Organization Configuration

To configure an organization to use the Westpac hosted payment service, ensure the organization has obtained a merchant account with Westpac first.
Westpac will also provide a number of parameters that need to be entered in the organization configuration section.

Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway" tab (see below).

Choose "Westpac Hosted Payment" from the "Payment Gateway Service" dropdown.

Enter the organization's QuickWeb community code into the "QuickWeb Community Code" field.

Enter the QuickWeb supplied business code into the "QuickWeb Supplier Business Code" field.

Enter the QuickWeb username into the "QuickWeb Username" field.

Enter the QuickWeb password into the "QuickWeb Password" field.

Edit Organisation - Example Company

Home = Organisations = Organisation

Organisation | Form Delivery Details | Payment Gateway I Properties | Report Schedules Form Tags Portal Access

Payment Gateway Service Westpac Hosted Payment vl 9

QuickWeb Community Code * ICUABC o

QuickWeb Supplier Business Code * |CL\ABC )

QuickWeb Username * ICUAEC =

QuickWeb Password * [eesssee a
Save Close

An example configuration for the Westpac Hosted Payment service

SSL Certificates

HTTPS is required on all communications with Westpac this requires Westpac's QuickWeb SSL certificates to be trusted by the application server and
also for Westpac to trust the Transaction Manager certificates.

QuickWeb Outgoing URL Configuration

There are two URL's used to initiate a payment transaction with QuickWeb (tokenURL and paymentURL) and they differ between older versions of
QuickWeb and QuickWeb3. To support this the URL strings that are used are configurable using Velocity Templates in the payment service definition
settings paymentRequestUrlParametersTemplate and requestTokenUrlParametersTemplate. The following table contains a description of the values
available for use in these templates. The default configuration is for QuickWeb 3.

Name Description

paymentLog The Transact Manager PaymentLog entity. This can provide access to a variety of information from the form transaction. Please see
the APl documentation for more information about this object.

amPayment The payment amount as defined by form transaction.
returnURL The system return URL used when the user is returned from the QuickWeb payment gateway.

serviceReturn | The servlet that QuickWeb will use to post the results of the payment transaction.

URL

cancelURL The system cancel URL used when the user is returned from the QuickWeb payment gateway after they have cancelled the payment
operation.

errorURL The system error URL used when the user is returned from the QuickWeb payment gateway after there has been a system error.

userName The QuickWeb User Name from the Organisation Payment Configuration.

password The QuickWeb Password from the Organisation Payment Configuration

communityCo | The QuickWeb Community Code from the Organisation Payment Configuration
de

supplierBusin | The QuickWeb Supplier Business Code from the Organisation Payment Configuration
essCode

currencyCode* ' The currency code from the payment gateway service definition.

serviceReturn = The QuickWeb service return email address from the payment gateway service definition.
Email*

These parameters can be overridden using on the form, client or space properties.
In addition to the above any parameters defined in the customParameterMap payment gateway service definition parameter map are also available to
these Velocity templates.

WorldPay Hosted Payment
This payment service uses the WorldPay payment gateway ( http://www.worldpay.com/) to process payments. Users are redirected to the WorldPay
website and can pay using their credit card.
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Global Configuration

The WorldPay Hosted Payment service has two relevant parameters: The URL of the payment website and the currency.

To configure these parameters, go to "System > Service Definitions", find the WorldPay hosted payment service and edit it. Switch to the "Service
Parameters" tab.

To change the URL to the payment website, edit the "paymentUrl" parameter and enter one of the payment URLs below (unless provided with different
URLs by PayPal):

Test | https://secure-test.worldpay.com/jsp/merchant/xml/paymentService.jsp

Live | https://secure.worldpay.com/jsp/merchant/xml/paymentService.jsp

To change the currency, edit the "currency" parameter and enter the desired currency code.
Do not modify the "configUiMapping" service parameter.

Prerequisites
To enable this service the following actions need to be performed:

®* The TM server's IP address needs to be white-listed by the service provider
® The service provider/merchant needs to provide a Merchant Code, MAC Secret Key, Username and Xml Password

Organization Configuration

To configure an organization to use the WorldPay hosted payment service, ensure the organization has obtained a merchant account with WorldPay first.
Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway" tab (see below).
Choose "WorldPay Hosted XML Payment" from the "Payment Gateway Service" dropdown.
Enter the organization's WorldPay merchant code into the "WorldPay Merchant Code".
Enter the MAC secret configured via the WorldPay merchant interface into the "MAC Secret" field.
Enter the organization's WorldPay username and XML password into the "Merchant Username" and "Merchant XML Password" fields.
Tick the credit cards you would like to support (you must enable at least one credit card).
Save your changes.
Department of Health

Home Dashboard » Organisations » Organisation

Organisation ] Form Delivery Details Payment Gateway I Properties I Form Tags I Portal Access I Report Schedules I Storage Settings

Payment Gateway Service | WorldPay Hosted XML Payment LJ & Edit Supported Credit Cards:
WorldPay Merchant Code®  MERCID o American Express |V
MAC Secret* | MySecret < Diners Cub  [¥
WorldPay Username*  MERCID El MasterCard [V
WorldPay XML Password™ sesssssssss o Visa v

Save Close

An example configuration for the WorldPay Hosted Payment service

BPoint Hosted Payment

This payment service connects to the BPoint payment gateway (https://www.bpoint.com.au). To use it, the organization needs to set up an account with
BPoint and enter its merchant details into Transaction Manager.

The BPoint payment gateway is a hosted payment gateway where the user's credit card information is actually captured by the Commonwealth Bank
BPoint gateway. The Transaction Manager space redirects the user to the BPoint website where the payment details are captured and processed. After
payment, the user is redirected back to the Transaction Manager space. Transaction Manager verifies payment via a HTTP POST to BPoint, after which
the user is redirected to either (dependent upon payment status) the confirmation page, or back to the initial hosted payment page.

When the payment process is first initiated, the payment is marked as "Pending". The submission payment is marked as completed upon a successful
result from the verification POST. If the verification call is not completed for some reason, a scheduled job will attempt to reconcile the payment via
BPoint's SOAP API. If the SearchTransactions SOAP call indicates the payment has been completed, the submission payment status is accordingly
updated.

Prerequisites
To enable this service the following actions need to be performed:

BPoint need to create/nominate a Merchant account to be used

BPoint need to provide a Merchant Number, APl Username and password
BPoint need to build a hosted payment page and link this to a biller code
BPoint need to provide the URL to the hosted payment page

BPoint need to provide the biller code

Global Configuration

The BPoint hosted payment service has three global configuration parameters as described in the following table:

authURL The URL for the authentication HTTP Post, which returns a token sent to BPoint as part of the initial redirect away
from TM:
Examples:
Prod: https://www.bpoint.com.au/payconnect/auth.aspx
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Test: https://bpoint-uat.premier.com.au/payconnect/auth.aspx

verifyURL The URL for the verification HTTP Post, which accepts a token and several other parameters received in the post-
payment redirect back to TM:
Examples:
Prod: https://www.bpoint.com.au/payconnect/verify.aspx

Test: https://bpoint-uat.premier.com.au/payconnect/verify.aspx

soapURL The URL for the SOAP endpoint, used to reconcile payments that could not be verified by the verification POST.
Examples:
Prod: https://www.bpoint.com.au/evolve/service.asmx?WSDL

Test: https://evolve-uat.premier.com.au/evolve/service.asmx?WSDL

customParameterMap JSON Map of XPath references of values to pull out of the form xml and populates CRN2 and CRN3 in the BPoint
request.
{
"in_crn2":"/AvokaSmartForm/Common/UserProfile/Individual/GivenName",
"in_crn3":"/AvokaSmartForm/Common/UserProfile/Individual/FamilyName"

}

paymentTransactionLifespan | The session time for a payment transaction in the provides payment gateway
Minutes

To configure these parameters, go to "System > Service Definitions", find the BPoint hosted payment service and edit it. Switch to the "Service
Parameters" tab.

Organization Configuration

To configure an organization to use the BPoint hosted payment service, ensure the organization has obtained a merchant account with BPoint first.
BPoint will also provide a number of parameters that need to be entered in the organization configuration section.
Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway" tab (see below).
Choose "BPoint Hosted Payment" from the "Payment Gateway Service" dropdown.
Enter the organization's BPoint merchant number into the "BPoint Merchant Number" field.
Enter the BPoint supplied username into the "BPoint Username" field.
Enter the BPoint supplied password into the "BPoint Password" field.
Enter the BPoint supplied biller code into the "Biller Code" field.
Enter the BPoint provided payment URL into the "Payment URL" field and click "Save" to store the configuration attributes.
FinanceCorp

Home Dashboard » Organizations » Organizaton

Organization | Delivery Channais Payment Gateway Propertes Portal Access Form Categories Form Tags [ Applications Repart Schedules Storage Setfings
Payment Gateway Service  BPoint Hosted Payment v @ Egit
BPoint Merchant Number® 5353108481203460 o
BPont Usemame™  apiuser @
BPoint Password®  sesses @
Biller Code™ 1002140 L]
Payment URL™  hitps:Vbpoint-uat premier. com aw/payments/smartforms o

An example credentials configuration for the BPoint Hosted Payment service

Form Configuration

The BPoint payment gateway allows the form to override the biller code that is used with the payment transaction. To override the biller code for a form,
the form developer is required to set up a data extract mapping in TM called "billercode" and populate this with the required biller code. If a form does
not provide a "billercode” or the data extract content is blank, the default organization biller code will be used.

Bizgate Hosted Payment

This payment service uses the Bizgate payment gateway to process payments. Users are redirected to the Bizgate website and can pay using their
credit card.

The Bizgate payment gateway is a hosted payment gateway where the user's credit card information is captured by the Bizgate Remote Payment
system and forwarded to the relevant bank. The Transaction Manager space redirects the user to the Bizgate website where the payment details are
captured and processed.

The results of the payment transaction is passed back via a synchronous web page redirect to the Transaction Manager space's hosted-payment servlet
and processed accordingly. If the transaction was successful the space redirects the user to the confirmation page. Otherwise the user is redirected
back to the space payment page with a description of the last unsuccessful payment transaction.

Data transmission security and SSL certificates
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Bizgate payment gateway service recommends applying a digital signature to the Request XML which is sent via a secure HTTP POST. A digital
signature is a standard security measure for confirming the validity and integrity of data sent over the Internet.

To create a payment the remote payment service consumes requests with a digitally signed XML parameter [xml]. Any response from this service back
to Transaction Manager will be also digitally signed using the same method. SSL certificates and keys which are used to encrypt/decrypt the XML
requests and responses are read from a "JKS" key-store stored to a directory accessible to Transaction Manager.

Prerequisites
To enable this service the following actions need to be performed:

® Bizgate needs to create/nominate a Merchant account to be used
® Bizgate needs to provide a Merchant ID and password
* Avalid "JKS" key-store with certificates for XML signature needs to be created and it contains:
® avalid private key to sign XML payment requests
® avalid public key to verify XML payment responses provided by the service provider (Bizgate)
® The service provider needs to receive a public key to verify signed XML payment requests from TM.

Global Configuration

The Bizgate Hosted Payment service has a couple of relevant parameters. To configure these parameters, go to "System > Service Definitions", find the
Bizgate hosted payment service and edit it. Switch to the "Service Parameters" tab.
Do not modify the "configUiMapping" service parameter.

keystoreFilePath The path to the "JKS" key-store stored to a directory accessible to Transaction Manager.

keystorePassword Password to the provided "JKS" key-store. The same password will be used to read the private key stored under the
"requestXmliSignKeyAlias" alias.

paymentRequestTemplate = Template used to generatethe SOAP request.
Do not modify unless the payment gateway service provider requests.

paymentTransactionLifesp = The transaction Lifespan in minutes for which a user session in the payment gateway is valid.
anMinutes

paymentURL The Bizgate URL to request a redirect for payment

requestXmliSignKeyAlias Alias to the private key used to sign the XML request. The same "keystorePassword" password will be used to access
the key from the key-store.
Note that only one key pair is used across all organizations.

responseXmiSignKeyAlias = Alias to the Bizgate public key to decrypt the XML response. The public key should be imported into the key-store as
"trustcacert" and does not require a password.

transactionStatusURL The Bizgate URL Transaction Manager uses to request a transaction status for a payment

Organization Configuration

To configure an organization to use the Bizgate hosted payment service, ensure the organization has obtained a merchant account with Bizgate first.
The service provider will also provide a number of parameters that need to be entered in the organization configuration section.

Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway". Choose "Bizgate Hosted Payment" from the "Payment
Gateway Service" dropdown.

Enter the merchant username into the "Merchant ID" field.

Enter the merchant password into the "Merchant Password" field and save the changes.

SecurePay DirectPost Payment

This payment service uses the DirectPost Payment gateway (https://api.securepay.com.au/live/directpost/authorise) to process payments.

The SecurePay payment gateway is a hosted payment gateway where the user's credit card information is processed by the DirectPost Payment
gateway. In this type of gateway the page that captures the card details is a customizable HTML form configured in the payment gateways global
configuration property "htmlForm". The page submits the details directly to the payment gateway service configured in the "paymentURL" property.
Transaction manager does not store or log any of these card details.

The result of the payment transaction is passed back via a synchronous web page redirection to the Transaction Manager space. This gateway also
utilizes a server to server callback for added reliability. The results of the transaction is passed to the hosted-payment servlet and processed
accordingly. In the case of a successful transaction the space redirects to the confirmation page. Otherwise, the user is redirected back to the space
payment page with a description of the last unsuccessful payment transaction.

Prerequisites
To enable this service the following actions need to be performed:

® SecurePay need to provide Merchant ID and Password
® Make sure the self-service space is available externally otherwise SecurePay will not be able to send the payment result callback.

Global Configuration

The SecurePay Hosted Payment service has a couple of relevant parameters. To configure these parameters, go to "System > Service Definitions", find
the SecurePay DirecPost payment service and edit it. Switch to the "Service Parameters" tab.
Do not modify the "configUiMapping" service parameter.

htmIForm The html form content.
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keepReconciliationFiles = Number of days to keep reconciliation files.
ForDays

paymentTransactionLife = The transaction Lifespan in minutes for which a user session in the payment gateway is valid.
spanMinutes

paymentURL The URL to use when processing a payment

reconciliationConfigurati = Allows the overriding of the names of the columns and timestamp formats in the reconciliation file. (JSON). This should
on have an empty value unless reconciliation is being utilised.

Organization Configuration

To configure an organization to use the SecurePay DirectPost payment service, ensure the organization has obtained a merchant account with
SecurePay first. The service provider will also provide a number of parameters that need to be entered in the organization configuration section.

Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway". Choose "SecurePay DirectPost Payment" from the
"Payment Gateway Service" dropdown.

Enter the merchant username into the "Merchant ID" field.

Enter the merchant password into the "Merchant Password" field.

For later reconciliation of payments received via Transaction Manager, enter the batch cutoff time (specific to the bank used by the organization) into the
"Payment Batch Cutoff Time" field.

Tick the checkboxes for the credit cards that are enabled for your merchant account and save your changes.

NAB DirectPost Payment

This payment service uses the NAB DirectPost Payment gateway to process payments.

The NAB DirectPost payment gateway is a hosted payment gateway where the user's credit card information is processed by the DirectPost Payment
gateway. In this type of gateway the page that captures the card details is a customizable HTML form configured in the payment gateways global
configuration property "htmlForm". The page submits the details directly to the payment gateway service configured in the "paymentURL" property.
Transaction manager does not store or log any of these card details.

The result of the payment transaction is passed back via a synchronous web page redirection to the Transaction Manager space. This gateway also
utilizes a server to server callback for added reliability. The results of the transaction is passed to the hosted-payment servlet and processed
accordingly. In the case of a successful transaction the space redirects to the confirmation page. Otherwise, the user is redirected back to the space
payment page with a description of the last unsuccessful payment transaction.

Prerequisites
To enable this service the following actions need to be performed:
* NAB need to provide Merchant ID and Password
® Make sure the self-service space is available externally otherwise NAB will not be able to send the payment result callback.
Global Configuration
The NAB DirectPost Payment service has a couple of relevant parameters. To configure these parameters, go to "System > Service Definitions", find the

NAB DirecPost Payment service and edit it. Switch to the "Service Parameters" tab.
Do not modify the "configUiMapping" service parameter.

htmIForm The html form content.

keepReconciliationFiles = Number of days to keep reconciliation files.
ForDays

paymentTransactionLife = The transaction Lifespan in minutes for which a user session in the payment gateway is valid.
spanMinutes

paymentURL The URL to use when processing a payment

reconciliationConfigurati = Allows the overriding of the names of the columns and timestamp formats in the reconciliation file. (JSON). This should
on have an empty value unless reconciliation is being utilised.

Organization Configuration

To configure an organization to use the NAB DirectPost Payment service, ensure the organization has obtained a merchant account with NAB first. The
service provider will also provide a number of parameters that need to be entered in the organization configuration section.

Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway". Choose "NAB DirectPost Payment" from the "Payment
Gateway Service" dropdown.

Enter the merchant username into the "Merchant ID" field.

Enter the merchant password into the "Merchant Password" field.

For later reconciliation of payments received via Transaction Manager, enter the batch cutoff time (specific to the bank used by the organization) into the
"Payment Batch Cutoff Time" field.

Tick the checkboxes for the credit cards that are enabled for your merchant account and save your changes.

TNS Hosted Payment

This payment service uses the TNS Hosted Payment gateway to process payments. Users are redirected to the TNS website and can pay using their
credit card.
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Prerequisites
To enable this service the following actions need to be performed:

® TNS need to provide a Merchant Profile ID, Access Code, Username and Password
® Make sure the self-service space is available externally otherwise TNS will not be able to send the payment result callback.

Global Configuration

The TNS Hosted Payment service has a few relevant parameters. To configure these parameters, go to "System > Service Definitions", find the TNS
hosted payment service and edit it. Switch to the "Service Parameters" tab.

To change the URL to the payment website, edit the "paymentUrl" parameter and enter one of the payment URLs below (unless provided with different
URLs by TNS):

apiURL https://secure.ap.tnspayments.com/api/nvp/version/17

paymentURL  https://secure.ap.tnspayments.com/page/pay

To change the transaction Lifespan for which a user session in the payment gateway is valid, edit the "paymentTransactionLifespanMinutes" parameter
and enter the desired period in minutes.

To change the currency, edit the "currency" parameter and enter the desired currency code.

Do not modify the "configUiMapping" service parameter.

Organization Configuration

To configure an organization to use the TNS hosted payment service, ensure the organization has obtained a merchant account and all related details
with TNS first. The service provider will also provide a number of parameters that need to be entered in the organization configuration section.

Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway". Choose "TNS Hosted Payment" from the "Payment Gateway
Service" dropdown.

Enter the organization's TNS Merchant ID into the "TNS Merchant ID" field.

Enter the provided TNS Merchant Name into the "TNS Merchant Name" field.

Enter the provided TNS Password into the "TNS Password" field and save your changes.

SmartPay Hosted Payment

This payment service uses a service offered by Optus through the RBA bank to process payments. Users are redirected to the SmartPay website and
can pay using their credit card.

Prerequisites
To enable this service the following actions need to be performed:

SmartPay needs to build a portal and provide a URL to the portal
Encryption of the payment requests has been agreed with the service provider
The encryption secret key and any required encryption URLs have been provided by the service provider
SmartPay has obtained the following URLSs for each space and organization
® Approved: [space context path]/serviet/hostedpayment/response/[Organization code]
® Cancelled: [space context path]/servlet/hostedpayment/cancel/[Organization code]
® Problem: [space context path]/servlet/hostedpayment/error/[Organization code]
® SmartPay configured up the source URL that will be passed in the "Referrer Request Header" which will be [space context path]/hosted-
payment.htm
® Make sure the self-service space is available externally otherwise SmartPay will not be able to send the payment result callback.

[Space context path] — The portal's context path configured in "Forms > Form Spaces", column "URL".
[Organization code] — The organization's code configured in "Forms > Organizations"”, client code column / field.

Global Configuration

The SmartPay Hosted Payment service has a set of relevant parameters. To configure these parameters, go to "System > Service Definitions", find the
SmartPay Hosted payment service and edit it. Switch to the "Service Parameters"” tab.
Do not modify the "configUiMapping" service parameter.

paymentURL The URL to use when processing a payment.

reconciliationConfig | Allows the overriding of the names of the columns and timestamp formats in the reconciliation file. (JSON). This should be
uration blank if reconciliation is not supported.

Organization Configuration

To configure an organization to use the SmartPay Hosted Payment service, ensure the organization has obtained a merchant account and all related
details with SmartPay payment service provider first. The service provider will also provide a number of parameters that need to be entered in the
organization configuration section.

Go to "Forms > Organizations", edit the organization and switch to the "Payment Gateway". Choose "SmartPay Hosted Payment" from the "Payment
Gateway Service" dropdown.

Enter the organization's Agency ID into the "Agency ID" field.

Enter the Encryption Configuration into the "Encryption Configuration" field. The encryption configuration is a CSV formatted string containing the
following values in the same order as described in the table:

Encryption Algorithm needs to be one of the following:
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AES/CBC/PKCS5Padding (128)
AES/ECB/PKCS5Padding (128)
DES/CBC/PKCS5Padding (56)
DES/ECB/PKCS5Padding (56)
DESede/CBC/PKCS5Padding (168)
DESede/ECB/PKCS5Padding (168)

Encryption key Provided by the service provider when creating an account
Encryption password Negotiated with the service provider when creating an account
Encryption padding interval Negotiated with the service provider when creating an account

Encryption padding char count = Negotiated with the service provider when creating an account

For later reconciliation of payments received via Transaction Manager, enter the batch cutoff time (specific to the bank used by the organization) into the
"Payment Batch Cutoff Time" field.
Tick the checkboxes for the credit cards that are enabled for your merchant account and save your changes.

PaymentSmartPayHosted

Home Daghboard » Organizations » Organization

Organization | Delivery Channels | Payment Gateway Properties Portal Access Form Categories Form Tags I Applications Report Schedules Storage Settings
Payment Gateway Service = SmartPay Hosted Payment v @ @ Supported Credit Cards:
Agency D* | 140 o American Express
Encryption Configuration™ | AES/CBC/PKCSSPadding ASgH@3vTSTriei0Z, 10,5 @ Diners Club |+
Bateh Cutoff Time 12 - [V am v | @ MasterCard |+ b
WVisa |«
Save Close

An example credentials configuration for the SmartPay Hosted Payment service

Browsing the List of Payment Services

To view the list of payment services and change the default service, go to "System > Service Definitions", choose "Payment Gateway" from the "Service
Type" dropdown and click "Search” (the screenshot below shows an example).

Service Definitions

Home Dashboard » Service Definitions

search Service Type | Payment Gateway x| connection x| W Active Ony Clear

MNew New Groovy Semvice Copy Service Impaort Export

Service Name Type Connection Default Type Active Action
Bizgate Card Payment Payment Gateway Make Default v A8
Comm\Veb Card Payment Payment Gateway Make Default v =_’ E ]
Demo Card Payment Payment Gateway Make Default ¢ A&
MAB Card Payment Payment Gateway Make Def; v @Aad
PayPal Hosted Payment Payment Gateway Make Default " 2 D !
SecurePay Card Payment Payment Gateway Make Default L @ f] i
TNS Card Payment Payment Gateway o v A&
Westpac Card Payment Payment Gateway lake Default i A4
Westpac Hosted Payment Payment Gateway Make Defaut @A
WorldPay Hosted XML Payment Payment Gateway Make Default v 2 a i

Searching for payment services

TM includes a set of service templates which can be used to create the payment services you need. See Services (Manager v5.0)
# sec_createservicefromtemplate for information on how to create a service based on a template.

You can change the default payment service by clicking the "Make Default" link in the "Default Type" column. Generally, it is best to configure the
payment service explicitly for each organization. If you wish to use a "real" payment service as the default, be aware that each organization that wants to

use payments needs to be set up with its account details (or configured to use a different service); otherwise payments will not be accepted by the
gateway.

Configuring an Organization for Payment
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For an organization to be able to use online payment, they first need to set up an account with one of the payment gateways supported by Transaction
Manager. Once this is done, the payment configuration can be done.

To view an organization's payment details, go to "Forms > Organizations" and edit the organization. Switch to the "Payment Gateway" tab. The
screenshot below shows an example configuration using the NAB payment gateway.

Edit Organisation - Department of Health

Home > Organisations > Organisation

Organisation | Form Delivery Details | Payment Gateway | Properties I Report Schedules Form Tags

Payment Gateway Service W 2] Supported Credit Cards:
Merchant ID |ABC 7] American Express r
Payment Access Code | o Diners Club r
Batch Cutoff Time |5_L"ﬂ pm | & MasterCard v
Merchant User [ @ visa W
Merchant Password |n"l L=

Configuring the payment service for an organization

Generally, the fields have the following meaning:

The "Payment Gateway Service" determines which payment service will be used to process credit card transactions for this organization.

The "Merchant ID" normally identifies the organization to the payment gateway. It is often assigned by the payment gateway provider and corresponds to
a bank account that the payments will be credited to. For this reason, it is vitally important to ensure that the correct merchant ID is used.

The "Payment Access Code" is an additional identifier that might be assigned by the payment gateway provider. It is used in conjunction with the
merchant ID.

The "Payment Batch Cutoff Time" field should be populated with the batch cutoff time (specific to the bank used by the organization). This is currently
used by the payment reconciliation report provided along with Transaction Manager (see Reports (Manager v5.0)#_sec_paymentreconciliationreport),
but is generally not required for the payment process itself.

The "Merchant User" can be used to further distinguish payments using the same merchant ID. A payment gateway provider might issue two user
names for a single merchant ID, where one is to be used during testing (where transactions can be tested without money being actually transferred) and
one to be used in production.

The "Merchant Password" is generally used when the payment gateway requires a password to be provided.

There are also four checkboxes in the "Supported Credit Card" area that can be ticked to indicate which credit cards will be accepted by the payment
gateway. This is often specific to the merchant ID. On the Example Self Service Space, this value is used only to give an indication to the user as to
what credit cards are accepted, but the credit card number a user enters is not validated against these settings.

The descriptions above are intended to give a general impression what the fields do. Please refer to the section describing the payment gateway that will
be used for specific configuration instructions.

Configuring a Form for Payment

Transaction Manager reads the payment information from the form when it is being submitted. This means that the form needs to pass through the
payment data in the correct format. Transact Composer contains widgets to help capture payment information.

Given a form that follows these guidelines, there is only one thing you need to do to enable payment for the form: You need to set up a configuration
mapping for the form data configuration.

To do this, go to "Forms > Form Data Configurations”, edit the form data configuration that your form is using and switch to the "Config Mappings" tab.
You can either enable default mappings for your form by ticking "Use Default Mappings", or add a custom configuration mapping from "PaymentDetails"
to the appropriate element in your schema seed file (the one containing the payment information subtree).

If you wish to have Transaction Manager update the form's receipt section, also add a mapping for "Receipt".

Once these mappings have been added, the form is set up for payments. Please also make sure the organization's payment details have been
configured, as described in the previous section.

Note: If the form indicates that payment shall be made using a payment service, TM will use the payment service configured for the organization (even if
the payment type in the form does not match the payment service, e.g. form specifies "Hosted" as the payment type, but the payment service is a 2 party
credit card payment service).

The Payment Log

All credit card payments and payment attempts made via Transaction Manager are logged to the payment log. Note that Transaction Manager does not
store the user's credit card details. However, the payment log can be helpful when monitoring and tracking down problems that occurred during payment.

Browsing the Payment Log

To view the payment log, go to "Operations > Payment Transactions". You will see the "Payment Transactions" page. You can filter this page by
payment ID, the receipt number, the payment service, the transaction number assigned by the payment gateway and the date and time of payment.
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Payment Transactions

Home Dashboard » Payment Transactions

Payment D Receipt Number Trans Number Start Date 14 Jul 2014 0000 || & Clear
Amount From Amount To Service End Date j
I Receipt Service A nt Order Time Trans Status M g Action
S62 pf-t41-14 PayPal $112.00 19 May 2015 11:32:41 Cancelled - IJ
601 drivewaypermitv4-1 NAB 572.00 31 May 2015 23:37:36 475358 Completed MNormal @ 13
B03 drivewaypermitvé-1 NAB $72.00 01 Jun 2015 10:43.:58 477472 Completed MNormal 4 IJ
604 drivewaypermitv7-1 NAB $72.00 01 Jun 2015 10:56:54 477643 Completed MNormal o 3
621 pf-h418-15 Bizgate $100.00 02 Jun 2015 11:37.02 4919 Completed Payment approved 4, ([
505 pf-t418-7 BPaint 5118.00 13 Feb 2015 11:07:33 Error Q8
532 BCC-CA10010-9 NAB S7E64.00 27 Apr 2015 14:40:31 321889 Completed Normal L 3
624 pf-i418-20 HAB  $1,000.00 02 Jun 2015 16:39:43 490952 Completed MNormal QB
626 pf-i418-22 Bizgate $666.00 02 Jun 2015 16:46:49 6090 Completed Payment Approved 4, (5
628 pi-t418-24 Bizgate §555.00 02 Jun 2015 16:49:31 4428 Completed Payment Approved 4, [
¢ 110 0f 110 Export Data

Browsing the payment log

You can view a payment log entry ( % 1), the details for the corresponding submission (l-lj) and re-query the payment gateway about the status of the
payment ( “%2), if the payment gateway supports this.

Viewing a Payment Log Entry

To view a payment log entry, click the "View Details" icon ( b ') next to it. You will be directed to the "View Payment Transaction" page (an example for
a payment via the Westpac payment gateway is shown below).
Please note that field semantics may vary between payment gateways, and not all fields may be populated.

Payment Transaction Details

Home = Payment Transactions > Payment Transaction Details

Payment Status Completed
Payment Service Code Bizgate

Form Name Test Payment Form
Submission ID 81z

Receipt Number tpf-ntgov-812-31
User IP Address 127001

Digital Order

Do Timestamp 05 Mar 2012 14:54:13
Payment Amount (Cents) 300

Do Merch Txn Ref 11312030514

Do Merchant TESTACOTECCBAD1
Do Version 1

Digital Receipt

Dr Timestamp 05 Mar 2012 14:54:14
Dr Acq Response Code

Payment Amount (Cents) 300

Dr Batch Mo 20120305

Dr Merch Txn Ref 812

Dr Message Payment Approved
Dr Receipt No BZ-0014580664
Dr Tax Amount

Dr Transaction No 7481

Dr Txn Response Code [11]

Dr Txn Response Msg Transaction approved
Ant-fraud response code

Anti-fraud response

Viewing a payment log entry

Important fields include:

Payment Status: Indicates whether the payment was successful or not

Payment Service Code: The payment service that was used to make this payment.

User IP Address: The IP address of the user making the payment.

Do Amount: The payable amount (usually in cents) passed in by Transaction Manager

Do Merchant: The Merchant ID that was passed in

Dr Timestamp: The date and time of the response from the payment gateway

Dr Batch No: The batch in which the payment was processed, as obtained by the payment gateway
Dr Message, Dr Txn Response Code, Dr Txn Response Msg, Dr Acq Response Code: Fields containing information about the response type (Success
/Error) and diagnostic information

Dr Transaction No: Transaction identifier assigned by the payment gateway
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Signatures (Manager v5.0)

Like paper forms, SmartForms often need to request the user's signature to confirm their submission. Transaction Manager can provide multiple ways to
enable user signatures.

This chapter lists the various signature methods that Transaction Manager supports, and tells you how to check on the signature status for individual
submissions.

Page Contents Search

Concepts

Configuring Wet Signatures

Configuring Digital Signatures

Configuring eSignatures

Monitoring Signature Status for a Submission

Concepts

In Transaction Manager, there are three supported signature modes: Wet signatures, where the user prints and signs the signatures conventionally;
digital signatures, where the user signs the form with a digital certificate; and eSignatures, where the form receipt is signed by a certificate associated
with the organization, and then presented to the user to confirm or cancel their submission.

Forms can control the signature method by defining an XML block for signatures; for more information, please refer to the Transact Integration Guide,
chapter "Signatures". Alternatively, wet signatures and eSignatures can be turned on for a form using Transaction Manager.

Configuring Wet Signatures

To enable wet signatures for a form, edit it, select "Wet Signature" from the "Signature Type" dropdown and save.

When the Example Self Service Space encounters a form submission for which wet signatures are enabled, they will ask the user to first download the
receipt, then either print, sign and upload the receipt straight away, or send in the signed receipt manually (e.g. via mail or fax).

In addition, the user is prevented from completing wet signatures before they have made credit card payment for the submission (if applicable). This
ensures that the receipt has been finalized before it is printed and signed.

Configuring Digital Signatures

Digital signatures provided by a user need to be verified against a set of trusted certificates. At this point, Transaction Manager contains support for
customer-specific digital signature verification services. If you would like to add support for digital signatures, please contact Avoka support to discuss
development of a verification service that meets your needs.

Configuring eSignatures

Each organization that wants to use eSignatures needs to be set up with a certificate in Adobe LiveCycle. This certificate will be used to electronically
sign receipts presented to the users.

After you have imported the certificate into Adobe LiveCycle, make a note of the certificate alias and edit the organization in Transaction Manager. Enter
the certificate alias into the "Credential Alias" field and save.

To enable eSignatures for a form, edit it, select "eSignature” from the "Signature Type" dropdown and save. Note that this change will also disable
anonymous fill-in for this form, as only registered users can perform eSignatures.

The Example Self Service Space allows new users to choose whether they wish to receive electronically signed receipts or not. Note that this setting
cannot be changed after the user has been created.

When the Example Self Service Space encounters a form submission for which eSignatures are enabled, and if the user submitting the form has chosen
to enable eSignatures, it will generate the electronically receipt and present it to the user. The user can choose to continue, or cancel the submission at
this point.

Monitoring Signature Status for a Submission

For each submission, you can check whether signatures were requested and what the signature status is. To do so, go to "Operations > Form

Transactions", view the submission details () and switch to the "Transaction Status" tab.
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Transaction Details

Home > Form Transactions > Transaction Details

ission Detais | Transaction Status | At ayment | DataExtract | Processing Status
Form Status Completed
Form Completed Time 21 Nov 2011 1:23:11 PM
Authentication Status
Attachments Status Completed
Signature Type Wet
Signature Status Completed - Upload Scanned Copy
Signature Completed Time 21 Nov 2011 1:23:11 PM
Payment Status Im
Receipt Status Completed
Receipt Render Duration (ms) 1856
Receipt Render Time 21 Nov 2011 1:23:07 PM
Receipt Render Attempts
Delivery Status IWH
Delivery Time 21 Nov 2011 1:26:14 PM
Delivery Message Submission delivered via delivery orchestration: Deliver To Directory Process
Delivery Method Delivery Process
Delivery Process ID 602
Processing Status
Processing Status Modified Time
Data Deleted false
Deletion Time
Close

The signature status of a submission
The "Signature Type" field indicates what type of signatures were requested. The "Signature Status" field indicates whether signatures have been
completed, and the "Signature Completed Time" field indicates when signatures have been completed.
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Tasks (Manager v5.0)

In addition to giving users the ability to fill in forms they are interested in, Transaction Manager also allows you to create tasks based on a specific form
and assign a task to specific users and groups. The task can have prefill data associated with it, and completes when one of the assignees completes
the task form.

Search

Concepts

A task in Transaction Manager consists of a form that needs to be filled in by a user. The task may contain prefill data for customization (e.g. including
reference numbers) and a task subject and task message that is used to identify the task to the user. When a task is created, TM creates a submission
object that is marked as a task and contains all task data. As the user opens and completes the task, the submission is updated as normal.

There are currently two types of tasks: Form tasks are basic standalone tasks, whereas review tasks are associated a previous submission and are
often prefilled with the submitted data for review purposes.

Tasks can be assigned to either a single user or a group of users. The task status indicates whether the task is assigned, completed or has expired
(which is controlled via an optional expiry date). When a task expires, it can invoke a specified service to notify an external system about the task expiry.
This service is configured as a service definition of type "Task Expiry Process".

Tasks can be created via the Transaction Manager management console or a web service interface. Please see the Transaction Manager Web Service
API document for details about the web service interface.

Browsing the List of Tasks

To view the list of tasks that have been defined, go to "Operations > Assigned Tasks". You can filter the list by keyword (either task ID or a substring of
the task subject or message), status and task creation date, and export the search results to Excel by clicking the "Export Data" link below the table.

Assigned Tasks

Home Dashboard » Assigned Tasks

Type =] satus [=| startDate 26 Dec201300:00 [ End Date
New
Tracking Tazk . . Expiry .
0 Form Code Type  Sublect Status User Group Created Scheduled Completed Expiry oo @ Action
= " B ]
773 BIZPWN pl-tcs Form  TestAddress Task 1 Lﬁi‘i;ﬂi: Ipammer i;:ff “a
Review Home Owners A @
- v 17 M -
€96 BIWCEF T Review  Insurance Cuote by JobDelvery o ipar  Quole e 17 Mar 2014
review Completed Reviewers 2014
medgar@av
) Review Home Owners M@
B85 WYNSRZ nes::e::‘ 2= Review Insurance Cluote by Jclz}t':“D;I;;ry medgar g:::wers ;;::” 17 Mar 2014
medgar@av... "
- A A
B84 YWOEYF calc-test Form Test description ln:s.:;r:t;“ kkrcmargva ;;:i” gg-ﬂ.r l'_' =
- NEUrance- ~ _— N Job Delivery Quote 14 Mar 14 Mar = 21 Mar AR
680 quote-82 msurance-guote  Form Client Quote Task Mot Required medgar Reviewers 2014 2014 A7 Mar 2014 2014
test task with address only  Task Form 13 Mar 14 Mar PR
5 2 MAG- y J
SBE TSCS28 MAG-HLA Form o Assigned rmandryk 2014 2014
505 PEXOAM mergage- fom test task with address only  Task Form vk 13 Mar MR
wEe e appication 3 Assigned o 2014
e = Task Form 13 Mar MA@
s81 WNTEZ ied 7 ; o
591 WNTE2X pi-Ht Form est Task Assigned Ipammes e
- Task Form 13 Mar A @
5 cD -4 3 -
590 QHZQCD pi-ite: Form est Task & Assigned Ipammer 20148
— Task Form 13 Mar A @
£, ihed g =
589 HPXREQ pi-fte Form est Task 5 Assigned lpammer 2018
» 110 of 69 Export Data

Viewing the list of tasks

This page allows you to create tasks as well as edit ( @) existing tasks. You can also view the full submission details via the "View Transaction Details"
(=) action. These operations will be described in the sections below.

Creating a Task

To create a new task via the Transaction Manager management console, go to "Operations > Assigned Tasks" and click the "New" button. You will be
directed to the "Edit Assigned Task" page (an example is shown below). To find out how to add a task via the web service interface provided by
Transaction Manager, please refer to the Transaction Manager Web Service APl document.
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Edit Assigned Task

Home Dashboard » Assigned Tasks » Assigned Task

Task Type* | Review j
Task Subject™  Review application no. 440

Plesse review the attached application.

Task Message

Previous Submission ID | 440
Scheduled Date

Expiry Date | 01 Jun 2015 00:00

e

Task Address
Location Latitude

Location Longitude
Allow Claiming [V

User Login Name 9

Mairtainer Tester Group 1 4 Quote Reviewers =l
Miro RT Group >

Miro RT Group 2

mandrykgroup

Rod - Collab Final Reviewers N
Rod - Collab Initial Reviewers—J -
RodGroup oy

Fodorous2 -l ]

Task Deletable by User [

Group

Send Email to Assignees [

FormName | Home Owners Insurance Review :I

Form Data j

Creating a task

Choose the task type. Form tasks are basic tasks that can be created using either form XML or prefill XML data, whereas review tasks are based on a
previous submission and do not accept prefill XML data (instead, they generally use the submission data).

Fill in a task subject and message that describes the task. This is shown to assignees on the user space, so it should contain any information that users
will need to identify the task (e.g. reference numbers).

For review tasks, enter the submission ID that the task is based on.

If the assignee should be informed that the task should be done on a specific date, fill in the "Scheduled Date" field.

You can enter an expiry date if you want the task to expire at a specific date and time (for more on the mechanics of task expiry, see _sec_taskexpiry).
You can enter the physical address of a location or latitude and longitude information if relevant. This information will be displayed to the assignee (the
default spaces include Google Map support). The latitude value needs to be in a range of -90 to 90 and the longitude value between -180 and 180.
You can assign the task to a specific user and/or a user group, in which case any member of the group will be able to view and complete the task. To
assign the task to a specific user, enter the user's login name into the "User Login Name" field. To assign the task to a group, choose the group name
from the "Group" dropdown. Note that users joining a group will be able to view and work on all tasks existing for the group.

Tick "Allow Claiming" to put the task into a special "claiming mode", where users have to claim the task before being able to work on it. In addition to
being claimed, such tasks can be reassigned to other users by the claiming user or other space users with special privileges.

If you would like assignees to be able to delete the task, tick the "Task Deletable by User" checkbox. Note that assignees will not be able to delete
completed tasks in order to preserve the audit trail.

You can choose to send email to the assignees to notify them of the new task, you can tick "Send Email to Assignees" checkbox. In this case, you can
also fill in the "Email Subject" and "Email Message" in as appropriate (otherwise default values will be used). Note that this email will be sent out only
once to the current assignees; if users later join the group the task is assigned to, they will not receive a notification email.

Choose the form that will need to be filled in to complete the task from the "Form Name" dropdown. The form can have payment and attachments
associated with it as usual. For review tasks, you can leave the dropdown blank, in which case the form on which the original submission was based will
be used.

If you would like to prefill the form that will be presented to the assignees, you have two options: If your task is of type "Form" and XML prefill is set up
for your form, you can choose to use standard XML prefill (see chapter Form Version Configuration (Manager v5.0)#_sec_setupxmlprefillmappings) by
choosing "Prefill XML" from the "Pre-population Data" dropdown and uploading the prefill XML file using the "Upload Prefill XML" field. Alternatively, you
can also pass in a populated seed file (structurally matching the form seed XML data). To do so, choose "Form XML" from the "Pre-population Data"
dropdown and upload the seed file using the "Upload Form XML" field.For tasks of type "Review", the XML data of the previous submission is
automatically used if nothing else is specified.

Save the task. At this point a task submission will be created in form status "Assigned”, and users will be able to fill in the form and complete the task
using the user space associated with the form.

Editing a Task

To edit a task, go to "Operations > Assigned Tasks" and click the "Edit Task" icon ( E)l) next to the task. You will be directed to the "Edit Assigned Task"
page.
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Edit Assigned Task

Home Dashboard » Form Transactions » Assigned Task

Form Status  Assigned
Task Key a7127cfc8600a64e 70520893637d6fb2
Task Type = Review j
Task Subject Review application no. 29062

Please review the attached application.

Task Message

@

Previous Submission ID 29062

Scheduled Date

8

Expiry Date = 01 Jun 2015 00:00
Task Address
Location Latitude
Location Longitude
Allow Claiming [#
User Login Name @
Group(s) Quote Reviewers
Task Deletable by User [~
FormName Home Owners Insurance Review
Expiry Process Status j

Expiry Attempts 0

Save Close

Editing an existing task

This page allows you to edit most of the task data; however, some fields such as task type cannot be edited after task creation.

You can also manually change the "Expiry Process Status" field. Note that this should not be necessary during normal operations - the expiry process
service is invoked by Transaction Manager, and the status is updated accordingly.

In addition, the task key generated by Transaction Manager is shown.

Task Expiry

If a task is not completed before the expiry date, a Transaction Manager background job (see Scheduled Jobs (Manager v5.0)
#_sec_transactionprocessingjob) will change the task submission's form status to "Expired”. At this point, the default user space will not allow assignees
to complete the task. Expired task submissions cannot be progressed further.
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Collaboration Jobs (Manager v5.0)

In addition to standalone transactions and tasks, Transaction Manager supports more complex workflows potentially involving multiple participants, steps
and forms by providing collaboration jobs and the tools to manage them.

Search

Concepts

A collaboration job is a collection of submissions that are completed as part of a workflow. Collaboration jobs consist of a series of steps, which
themselves can consist of a set of actions. Collaboration jobs are processed by a job controller service. When a submission is created and the form has
been set up with a job controller service, the service is called and can create a collaboration job if appropriate.

Collaboration jobs may involve review steps and multiple users or groups of users. Additional submissions may be created as part of the job.
Transaction Manager allows you to track and manage jobs and create custom services involved in job control.

For additional documentation on how to use jobs and create your own job controllers, see Avoka Transact Collaboration Jobs

Browsing the List of Collaboration Jobs

To view the list of collaboration jobs, go to "Operations > Collaboration Jobs".
You can filter the list of collaboration jobs by a substring of the job name, reference number, job key, status, job controller service and creation date.

Collaboration Jobs

Home Dashboard ¢+ Collaboration Jobs

Status =] Job Controkers (=] |StartDate | 01 Apr2014 0000 T3] EndDate ) Clear
0 Job Number Job Name Org. Created Job Status  Current Step Current Action  Action Type Action Status  Action
&4 colab-from-scratch-102 2 Step Aeview Doc Test - MR magure 08 Apr 11:55 InProgress  indial Review Handie Submission Task Wak Pending L, & B
83 colab-from-scratch—101 2 Step Review Doc Test — MR magure 0B Apr 11:50 InProgress  Start Handie Submission  Form Start Error LGB B
82 colab-from-scratch—95 2 Step Review Doc Test— MR maguire 07 AprQ:59 I Progress Addtional Review  Handle Submission Task Wai Pending i, B
&1 colab-from-scralch--93 2 Step Review Doc Tes! — MR maguire 07 Apr0822 InProgress Addlional Review — Handle Submission Task Wal Pending Y

65 colab-from-scratch—37 2 Step Review Doc Test — MR maguie 04 Apr 1016 Completed  Approved Complete Process Message Frocess Message Completed
64 colob-from-scratch—84 2 Siep Review Doc Test — MR maguire 03 Apr17-00 Canceled ndial Review Handie Submission  Task Wat Cancelied
€3 colab-from-scratch--32 2 Step Review Doc Test - MR maguire 03 Apr 17.00 Canceled initial Review Handke Submisson  Task Wal Cancelied
62 colab-from-scratch—72 2 Step Review Doc Test — MR maguie 03 Apr 1540 Complted  Approved Complete Frocess Message Frocess Message Completed
&1 colab-from-scratch—6% 2 Step Review Doc Test — MR magure 03 Apr 10°:43 Completed  Approved Complete Process Message Process Message Completed
55 colab-from-scratch-66 2 Step Review Doc Teat-- MR magure 02 Apr 11:08 Compieted  Approved Complete Process Message  Process Message Completed

b 1-10of16 Export Data
Browsing the list of collaboration jobs

You can view job details ( ), pause ("—li), process ("-'.[-*") or permanently cancel a job that is in progress ( "-'!5). You can also delete ( E) cancelled
jobs (especially useful in the when developing a job definition).
You cannot manually create collaboration jobs because they are always based on a submission whose form is associated with a job controller service.

Viewing Collaboration Job Details

To view the details of a collaboration job, go to "Operations > Collaboration Jobs" and click the "View" icon ( ) next to the job you are interested in.
The screenshot below shows the job details for a completed job.
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Review and Approval - 1 Step User Review Job
Home Dashboard » Colaboration Jobs » Job Details

Job Details | Steps | Actions | Events | Submissions |

Job Number  NXPXWY
Job Name Review and Approval - 1 5tep User Review
Job Key e93262d0cedb857c6fc538231e5df13a
Processs Immediate  false

Organization Maguire

Job Controller Review and Approval - 1 Step User Review - v1
Status | Completed j
Creation Tme 24 MNov 2015 12:13:35PM
Last Processed Time 24 MNov 2015 12:20:55 PM
Finished Tme 24 Mov 2015 12:22:00 PM

Duration 8 minutes, 24 seconds

3 -

Collaboration job details

The "Job Details" tab contains basic information about the collaboration job: A name, a unique job key and job number, the job controller service
managing the job, the status, and various dates from the job's life cycle.

Viewing Collaboration Job Steps

Collaboration jobs consist of individual steps. The definition of which steps are possible and how they are linked resides in the job controller service. To
view the list of steps for a collaboration job, view details for the job and switch to the "Steps" tab.

2 Step Review Doc Test -- MR Job

Home Dashboard » Collaboration Jobs » Job Detais

Job Detais Steps | Actions | Events | Submissions |

Step Name Status Next Step Created Finished Duration Scheduled Finish Action
Start Completed Initial Review 04 Apr1410:16 04 Apr 1410216 ]
Initial Review Completed Additional Review 04 Apr 14 10:16 04 Apr 14 10220 3 min, 59 sec 05 Apr 14 10116 [}
Additional Review  Completed Approved Complete 04 Apr 14 10:20 04 Apr 14 10:20 29 sec @
Approved Compiete  Completed 04 Apr 14 10:20 04 Apr 14 10:20 ]

The list of steps for a collaboration job

You can view step details by clicking the "Edit" icon ( ﬁ—)l).
Additional Products Step

Home Dashboard » Collaboration Jobs » Job Details » Collaboration Job Step

Step Details | Actions

Name Additional Products

Status  Completed
Dynamic Pre Conditions  true
Share Extract Data  true
Share FormData  false
AllForms Editable  true
Redirect Next Task  true
Hext Step Name  Application Delivery
Creation Time 13 Jan 2016 3:05:02 PM
Finished Time 13 Jan 2016 3:08:33PM

Duration 3 minutes, 31 seconds

Close

Collaboration job step details
Each step has a name, status, creation and finished time and may have a scheduled completion time. Switch to the "Actions" tab to see all the actions
for this step.
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Additional Products Step

Home Dashboard » Collaboration Jobs » Job Details » Collaboration Job Step

Step Details | Actions

Sequence Action Name

1 Credit Cards Application Task Assign
2 Ingurance Application Task Assign
3 Appliction Confirmation  Task Assign
4 Review Wait Task Wait

Action Type Status

Completed

Completed

Completed

Completed

Route Result Attempts

Created
1 13 Jan 16 15:05
1 13 Jan 16 15:06
1 13 Jan 16 15:05
4 13 Jan 16 15:05

Finished

13 Jan 16 15:06

13 Jan 16 15:07

13 Jan 16 15:08

13 Jan 16 15:.08

Duration Action
1min, &sec  [F) @ @
57 sec @B E

3mn, 30sec [F @ T

3min, 29 sec [

The list of actions for a collaboration job step

You can edit (

Viewing Collaboration Job Actions

) job actions and view the details for the submission associated with the action ( ﬂ,), if one exists. Please see the following section for
more on job actions.

Each collaboration job step may break down into multiple actions. To view the list of actions for all steps in a collaboration job, view details for the job
and switch to the "Actions" tab.

Customer Onboarding Job
Home Dashboard » Colaboration Jobs » Job Detais

| sobDetmis | steps | Actions | Events | submissions |

Step Name Action Name el Status Assignee
Type
Customer Customer Form Completed bwarner@avoka.com
Onboarding Submission Start
Additional Credit Cards Task Completed bwarner@avoka.com
Products Application Assign
Additional Insurance Task Completed bwarner@avoka.com
Products Application Assign
Additional Rewview Wait Task Wait Complated
Products
Application Application Defvery  Completed
Delivery Defvery
Application Application Defvery  Completed
Delivery Debvery Wait Wiait

The list of actions for a collaboration job

You can edit each action ( @) and view the details of the submission associated with the action ( ﬂ,), if one exists.

Submitter

bwarner@avoka.com

bwarneri@avoka.com

bwarneri@avoka.com

Route
Result

Index Item

Attempts Created Finished

1 03Jun15 03 Jun 1S
05:09 08:09

1 03Jun15 03 Jun 1S
09:09 08:12

1 03Jun15 03 Jun 1S
09:09 08:12

3 03Jun15 03 Jun 15
05:09 08:12

4 03Jun15 03 Jun 15
09:12 0818

1 03Jun15 03 Jun 15
09:18 0820

2 min,

sec

2 min,

sec

2 min,

sec

3 min,

sec

3 min,

sec

3

#“

40

42

44

@@

@@

@a

2

2

2

The screenshot below shows the details for a collaboration job action. Each action has a name, type, unique key, creation and finished time and may be
associated with a submission ("Form Transaction" field).
The "Action Processing" section shows information about what service is responsible for handling the action, and what the processing result was.

Credit Cards Application Action

Home Dashboard » Collaboration Jobs » Job Details » Collaboration Job Action

Action Details Events.

Name

Type

Job Action Key
Sequence
Redirect Next Task
Creation Time
Finished Time
Duration

Form Transaction

Action Processing

Action Service

Status.
Action Attempts

Action Executed Time

Credit Cards Application

Job Task Assign

95a44f027f3d 1f847745ee6 736060452

1

true

13 Jan 2016 3:05:02PM
13 Jan 2016 3:06:10 PM

1minute, 8 seconds

onboard-credit-test-&

Job Task Assign Action - v1
Completed
1

13 Jan 2015 3:05:02FM

Details for a collaboration job action
Switch to the "Events" tab to see all events associated with this action.
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Create Task Action
Home Dashboard » Collaboration Job Action

Action Detalls | Events | Emors |

ID Type Message Created Username Action

279 info  ‘Job Task Assign Action’ action service executed with resull status “Assigned” 04 Apr 14 10:20 LS

Events associated with a collaboration job action
Switch to the "Errors" tab to view errors associated with the action. Generally, errors are of greater severity than events.

Create Task Action
Home Dashboard » Collaboration Jobs » Job Detais » Collaboration Jobr Action

Action Details | Events I Errors ]

D Error Time Name Message Action

9244 10 Apr2014 10:28:50 MegalsrgumeniException Must have an assigned Task User or Task Group

The list of errors for a collaboration job action

Viewing Collaboration Job Events

In addition to general-purpose TM system events, events can also be logged against a specific collaboration job. These job events can be viewed by
viewing job details and switching to the "Events" tab.

2 Step Review Doc Test -- MR Job
Home Dashboard » Collaboration Jobs » Job Detais

Job Detais ] Steps. I Actions I Events | Submissions |

D Type Message Created Username Action
276 Info  ‘Job Form Start Action’ action service executed with result status ‘Compieted 04 Apr 1410018 @,
277 Info  ‘Job Task Assign Action’ action service executed with result status "Assigned” 04 Apr 1410116 o,
278 Info  ‘Job Task Walt Action’ action service executed with result status "Completed” 04 Apr 14 10:20 &,
279 info  ‘Job Task Assign Action’ action service executed with resull status "Assigned’ 04 Apr 14 10:20 @
280 info  ‘Job Task Wai Action’ action service executed with result status "Completed” 04 Apr 14 10:20 -,
281 Info  ‘Job Process Message Action’ action service executed with result status ‘Completed” 04 Apr 14 10:20 LN

282 Emor  No default route wes found in step ‘Approved Complete’, Avalable step routes: | 04 Apr 14 10:20 @,

The list of events associated with a collaboration job

You can view details for each event by clicking the "View Details" action ( """-\).

View Job Event
Home Dashboard » Colaboration Jobs » Job Details » Job Event

D 27
Type Info

'Job Form Start Action' action serviece executed with result status 'Completed’

Message

Created Fri Apr 04 10:16:05 EST 2014

Username

Details for a collaboration job event

Viewing Submissions for a Collaboration Job
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The set of submissions associated with a collaboration job can be accessed by viewing job details and switching to the "Submissions" tab.
Onboarding - Test Case 300ct15 Job

Home Dashboard » Collaboration Jobs » Job Details

Job Detailz. | Steps | Actions | Events. | Submissions |
Tracking . Time —— . Form Delivery Time .
0 Code Form Job Action Submitted Status Status Delivered  ACtion
10836 T2KYBW Customer Onboarding Customer 13 Jan 15:05 voka.com voka.com C Not Ready a
Submission
10837 BWS4XH Product Onboarding - Credit Cards 13 Jan 15:06 [@avoka.com (@avoka.com Compl Ready 13 Jan 15:40 Q ﬁ
Credit Cards Application
10838 B2G672W Customer Onboarding - Appliction 13 Jan 15:08 @avoka.com @avoka.com Compl Ready 13 Jan 15:40 Q m
Confirmation Confirmation
10839 SM4CDY Product Onboarding - Insurance 13 Jan 15:07 @ .COMm (@ .com  Compl Ready 13 Jan 15:40 Q m
Insurance Application

The list of submissions for a collaboration job
For each submission, you can see the tracking code, which form was used, what job action is associated the submission and some other submission

status values. You can view details for each submission ( '’=%.). See Operations (Manager v5.0) for more on submissions.
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Offline Submission (Manager v5.0)

In addition to direct submission and saving forms online to Transaction Manager, PDF forms can also be saved to the user's computer (=offline save)
and later be re-opened in Adobe Reader or Acrobat and submitted. Because the submission is done using Adobe Reader or Acrobat rather than a web
browser running a PDF viewer plugin, the submission process has to be somewhat different.

Page Contents Search

Concepts

Enabling Offline Submission

Offline Submission Scenarios

Offline Submission Form Customization

Concepts

Offline submission happens when the user submits a PDF form that had been saved locally, using Adobe Reader or Acrobat. In this case, Transaction
Manager cannot send back a HTML page as usual, because Adobe Reader cannot interpret a HTML page. Instead, Transaction Manager detects that
an offline submission was made and then populates and sends back a PDF (the offline submission form), which contains feedback for the user as well
as a link back to Transaction Manager. When clicking on this link, a browser window will be opened, which will take the user to the appropriate page in
Transaction Manager (e.g. the payment page).

The offline submission form is dynamically populated according to the submission status (completed, attachments or payments outstanding, or failure
due to errors) and can also be customized to some extent. While the offline submission form needs to support a certain data structure, you can elect to
create your own offline submission form with a customized look and feel.

In addition, forms can be designed to support rendering the offline submission response themselves instead of using a separate form. This provides the
user with a more streamlined experience.

Please note that for a form and the data filled in so far to be saved offline by your users, it needs to be reader-extended, and the form needs to be
configured to support offline submission.

Enabling Offline Submission

Any PDF form can be configured to allow offline submission (HTML forms can only be saved online). To check a form's configuration, edit the form's
current version and switch to the "PDF Options" tab. To enable offline submission for the form, tick the "Enable Local Save" checkbox and save.

Test PDF Form - Version 1.0

Home Dashboard » Forms » Form » Form Version

Form Version | Properties | Attachments | Services Form Tags PDF Options L

Reader Version Required e
Reader Extend Form | @
Enable Local Save F%g
Allow Multiple Submissions [~ i@
Form Supports Offiine Submission [~ @

Validate Submission on Server [~ @

PDF Form Open Parameters

Page View ~| @
Zoom Percentage ;I @
Page @
Tool Bar e
Navigation Pane e
Scroll Bar =e
Status Bar LI
Message Bar LI
Page Mode ﬂ

Save Close

Enabling offline submission for a form version

If offline submission is not enabled for a form and a user attempts to submit the form after having saved it locally, Transaction Manager will refuse to
accept the submission. However, if a form does not support offline submission, it should be designed such that it will not allow the user to save their form
locally in the first place to avoid issues at submission time.

Choosing Offline Submission Mode
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In addition, you can decide whether you want the form itself to handle the offline submission response (note that it must be designed to do that) or
instead use the offline submission form configured for the space.

To do so, edit the form version you want to configure, switch to the "PDF Options" tab and tick "Form Supports Offline Submission" to indicate that your
form can handle the offline submission response, or leave it unticked to use the default offline submission form instead.

Offline Submission Scenarios

When the user submits a form offline, there are multiple scenarios to consider:

® The submission is complete, and the form is configured to skip the confirmation page
The receipt is rendered back directly to Adobe Reader or Acrobat.
® The submission is complete, and the form is configured to show the confirmation page
The user can be informed of their receipt number and will be redirected to the confirmation page.
® Attachments are needed
The user needs to be made aware that attachments are outstanding. They will be redirected to the attachments page.
® Payment is needed
The user needs to be made aware that payment needs to be made. They will be redirected to the payment page.
® Signatures are required
The user needs to be made aware that the form needs to be signed.
® The form has expired
The user attempted to submit a form after it has expired (applies only if an expiry date has been set up for the form). The submission is rejected
and the user is informed that the form cannot be submitted.
® An error occurred during submission
The user needs to be made aware that their form could not be submitted. They will be redirected to an error page.

The offline submission response will be populated with different text depending on what the scenario is. If you customize the text displayed to the user

(as described in the next section), please make sure you clearly indicate to the user whether or not their submission is complete. The link back to
Transaction Manager will be automatically generated and inserted into the response.

Authentication

If the form is configured to require users to be logged in, Transaction Manager ensures that the space user is authenticated before finalizing their offline

submission.

If a user accesses a link to Transaction Manager in the offline submission form and they are not authenticated, they will be directed to the login page for

the user space. Only after they have logged in will the submission go ahead. This applies even if the form has been completed and no other user work is
outstanding - the user still needs to authenticate before Transaction Manager will process the form.

The Example Self Service Space also displays submissions for which authentication is required on the space user's To Do list. The user can then
acknowledge submissions directly on the To Do list.

Offline Submission Form Customization

To cater for forms that are not designed to handle the offline submission response, Transaction Manager includes an offline submission form as part of
the Example Self Service Space. This offline submission form is not branded and can be customized somewhat. Alternatively, you can also develop your
own offline submission form using the same data configuration file and use it instead.

This section describes the various properties that can be configured for an offline submission form.

The screenshot below shows a screenshot of the default offline submission form for a submission requiring attachments.

SmartForm Factory

Please complete attachments

Your form has been submitted.
To complete your submission, please click the button below to go to the attachments page.

Continue

Alternatively, click on the fellowing URL link to go to the submission confirmation page.

http://192.168.2.32:9080/govassist/secure/form-attachments.htm?submitKey=b755a1ff1108aa8e18c3a760176e99%be

Please note Adobe Acrobat may not open a new browser window when you click on the button.
If this occurs please copy the URL link above into a web browser to view the page.

The offline submission form

The following properties can be configured:

Header: In the screenshot, this is the top section titled "Transaction Manager". You can customize the title text as well as the font and background color.
Body text: In the screenshot, this is the text between the title and the button. You can customize the body text for each submission scenario.

Button: In the screenshot, this is the button labeled "Continue". You can specify a label for each of the submission scenarios.

Note that the section below the button is automatically populated and cannot be customized. If the submission is complete or has errors, the receipt
number will be shown in the title.

To customize an offline submission form, go to "Forms > Form Spaces" and edit the user space (each space has its own offline submission form).
Switch to the "PDF Offline Submission Form" tab. The screenshot below shows the configuration of the default offline submission form.
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Edit Portal

Home > Portal

Fortal | Status | Securty | Properties | Pages | Resources | POF Offiine Submission Form

Template Fie Name
Upload Template File
Schema Fie Name
Upload Schema File
Header Text™
Header Font Color™

Header Background Color*

Body Text Completed *

Button Text C ®

offlineSubmitForm. paf

Choose File | No fie chosen

offlineSubmitSeed xml

Choose File | No fie chosen

|Furmcemer

[2s5.255.255

[0,102,153

Thank you, your form has been submitted to FormCenter.
Please note this document is not a receipt. To view a receipt
please chick the button below to go to the confirmation page. .

Go To

Confirmation Page

our form has been submitied to FormCenter

Body Text Attachment:

To kete your please click the button below to go

Button Text Attachments

Body Text Payment*

Button Text Payment ™

Body Text Signature

Button Text Signature

Body Text ESignature

Button Text ESignature

Body Text Authenticate

Button Text Authenticate

Body Text Saved

Button Text Saved

Body Text Expiry

Button Text Expiry

Body Text Error™

Button Text Error*

to the attachments page. P

Go To Attachments Page

*rour form has been submitied fo FormCenter.
To complete your submission, please click the button below to go
to the payment page 4

IGD To Payment Page

"our form has been submitted to FormCenter.\nTo complete your
submission, please click the button below to print and sign your
form.

“

Go To FormCenter

¥ our form has been submitted to FormCenter \nTo complete your
please ciick the bution below to sign your form.

el

Sign Your Form

" our form has been submitted to FormCenter. \nTo complete your
submission, please click the bution below to authenticate.

e

Authenticate

Your form has been saved to FormCenter
Please click the bution below to go fo the confirmation page and
review your submission. p

[Go To Formcenter

This form is expired.
Please ciick the button below to go to view the details.

|Gu To FormCenter

.An error has occurred during form submission.
Please click the button below to view the error details.

Go To FormCenter

Synchronize Offline Forms

e -

Customizing an offline submission form

You can upload a new version of the offline submission form and its data configuration file by using the "Browse" buttons. Note that the data
configuration file needs to match the one used by the default offline submission form.

Adjust the values as needed (the colors need to be specified as RGB values) and save.

You can click "Synchronize Offline Forms" to trigger an attempt to write out the form to the LiveCycle repositories.
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Spaces (Manager v5.0)

Transaction Manager supports multiple user spaces, all of which expose their own set of forms. User spaces can be dynamically deployed, register
themselves at startup and can be used to host forms after that.

Search

Concepts

A space is a Transaction Manager module contained in its own WAR file. One of these spaces is the Transaction Manager management console itself,
another the BIRT report module; in addition, multiple user spaces may be installed.

A user space is a Transaction Manager module that is used to expose forms to your users and handle form requests, submissions and related activities.
While Transaction Manager comes with an Example Self Service Space, user spaces are often customized and branded. Each form is associated with
one or more user spaces, which can be used to render the form. If a form is associated with multiple spaces, the form (as well as saved and completed
submissions of that form) will generally be visible on all these spaces.

User spaces define a security model, which encapsulates strategies around handling user registration and login. Transaction Manager supports
authentication against a local database and/or LDAP by default as well as space user self-registration, potentially combined with an approval step for
new user accounts.

User spaces have a status indicating whether the user space is currently available. If the user space has been set to be unavailable (e.g. due to
maintenance), requests made by space users are automatically redirected to a specific information page.

User spaces have a space context path (e.g. http://www.server.com/tmportal) and a set of space pages, which specify the HTML pages that provide
specific functionality (e.g. landing page, payment page etc.). This allows Transaction Manager to call the user space without knowing about its
implementation, and potentially allows you to customize space pages without having to rebuild the space EAR. User spaces also have customizable spac
e resources (e.g. images) and space properties.

In addition, user spaces provide an offline submission form. This PDF form is sent back to users when they submit a form after saving it offline (see Offlin
e Submission (Manager v5.0)). Transaction Manager has a default offline submission form you can use, but you can also create a branded version to
use instead.

Browsing the List of Spaces

To view the list of spaces, go to "System > Modules" for system spaces such as the management console or to "Forms > Form Spaces" for form hosting
spaces. You can filter the list using a substring of the space name, and export the search results to Excel by clicking the "Export Data" link below the
table.

Spaces

Home Dashboard » Spaces

Import Archive Import WAR
. Content - . - -
Name URL Description Editable  VETSIon  Last Modified Module WAR File Action
ANZ https:/tm test1 aveka comianz! ANZ v 04 Sep 2013 by awang A&
Avoka Forms Avoka Internal Forms. Porial v 13 Sep 2013 by awang @A
Avoka 550 ADFS Avoka S50 v 16 Jun 2015 by Ib A8
Awoka S50 Portal - avoka-sf-portal- o) "=' i
ADFS eSS J DS Serau IRl E ek BvOKaSE0 War
X s/t Avoka. L 7 &7 14
Bark of Mebourne hitps:itm test1 m. ka.com Bank of Melbourne Home & 4 28 Aug 2013 by awakimin E =t
[oankofmelbourne/ Contents
tps:iftm.test] avoka. e 7 £
E.ﬂnf cf. South hitps:itm. test]. avoka .C,DIT Bank of Seuth Australa Home & J 28 Aug 2013 by awakimin e i
Australia fbankofgouthaustrakal Contents
. " . 41 17 Nov 2014 by avoka-sf-portak A0
4 i
Bendigo Bendigo Self Service Portal v PRE.RE A T
BT Portal BT Online Forms Portal v 03 Sep 2013 by awang A8
CAAPortal hitps./tm.test1.avoka.com/CAAPorial CAAPgrial Seif Service Porial 06 Sep 2013 by giackson [—_7 E
Classic Finance hitps:/tm.test1 avoka.com/finance- Classic Finance demonstration r_/’ [ |
v ki H
Corporation classic/ Self Service Portal SR S fanrek
b 110 0f35 Export Data

Browsing the list of spaces

=3
This page allows you to add new spaces or edit ( L ) and delete ( ﬁ) existing spaces as well as import and export space configurations.
The "WAR File Name" column shows the file name of the deployed space WAR file. Form space WAR files can be downloaded by clicking the link on
the WAR file name.
You can also import an entire space WAR file by using the "Import WAR" facility. Please refer to _sec_hotdeployspace for more details.
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Please note adding new spaces should not be necessary as user spaces generally create an entry in this table when they first start up. Also, the
management console space cannot be deleted or renamed.
To assist you in auditing configuration changes, the last modified date and the user modifying the space are displayed in the "Last Modified" column.

Editing a Space

=
To edit a space, go to "System > Modules" or "Forms > Form Spaces" and click the "Edit Space" icon ( 4 ) next to the space. You will see the "Edit
Space" page.
Maguire

Home Dashboard » Form Spaces b Module

Space | Properties | Pages | Resources | Forms | Organizations | Status | POF Offine Submission Form

Hame Maguire

Context Path* | https://tm.test1.avoka.com/maguire/ 2]
Description  Avoka Transact Wark Space

Security Manager  Short timeout Local Security Manager j @

Content Editable [V &
Default Forms Portal [~ @

Save Close

Editing a space
The "Content Editable" checkbox determines whether administrators will be able to adjust space content at runtime. If the space is editable, you will be
able to edit all fields and space content. If not, some fields will be read-only, and space content cannot be changed.

Be careful when editing the context path: When the Transaction Manager server starts up, an entry will be created for each space that has been
deployed unless an entry with the same space name or context path already exists.

If needed, you can change the space context path to allow for Apache mappings etc. This should be the URL under which the space is accessible to
users. Please note that the space context path is used during form submission - if the URL does not match the space context path (including port), the
submission will not be accepted.

You can also edit the space description.

You can choose the security manager associated with the space from the "Security Manager" dropdown. If not set, the security manager currently
marked as the default will be used. Please refer to Security (Manager v5.0)#_sec_securitymanagers for detailed information about security managers.

Tick the "Forms Default" flag if the space should be used as the default for rendering forms. This setting is mainly relevant when testing forms via the
management console.

Save the space.

You can also configure the space's page paths, resources, properties, offline submission form, status and associated organizations as described in the
sections below.

Configuring Pages for a Space

To configure a space's pages, edit the space, ensure the space is editable and switch to the "Space Pages" tab. You will see the list of pages defined for
the space. Depending on the space, different pages may be mapped.
You can filter the list to show only pages containing a certain string. Enter the string into the "Page data" field and click "Search".

Maguire

Home Dashboard » Spaces » Module

Space [ Properties ] Pages ] Resources | Forms | Organizations ] Status | PDF Offiine Submission Form

Viewing the list of space pages

Page View URL Params
sizs D33 Last
Name Path Description Content  Merged Action
Modified
Date
Account 2 Factor Authentication secure/accounttwo-factor- Account 2 Factor Authentication 322 10 Apr 2015 21Jui2015by A -0 ) (] 0
authentication-setup him setup page Ipammer
Account Change Password secure/accountichange- Account Change Password 1.53 22 Apr 2014 10 Jun 2015 e 7]
pasgword.htm page. by lpammer
Account Custom 1 secure/account/custom-1.him Account Custom 1 page. 0.40 16 War 2015 10 Jun 2015 E) 0
by lpammer
Account Custom 2 secure/account/custom-2_hitm Account Custom 2 page. 0.43 16 Mar 2015 16 Mar 2015 el ~]
by system
Account Custom 3 rel; nt m-3.him Account Custom 3 page. 0.43 16 Mar 2015 Mun2015by [F @
cthomas

You can see if the page was edited in the "Last Modified" column. If the page has been modified, the last modified date and user are shown. If the
content is different to the base content (the page as defined in the space WAR file), the entry is highlighted in red, and additional actions (to view the

differences between the current and base content and L'él to restore the base content) are shown.

_—
To promote an edited page to be the new baseline, use the "Mark Content Merged" ( L\’J) icon.
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Click on the URL or the "View Page" icon (0) to view the page. If the page needs certain URL parameters to display correctly, for example a form
code, enter the parameter(s) into the "Page View URL Params" field first.

=
You can edit individual pages using the "Edit Space Page" icon ( 'ﬂ). You can also restore the base content of all space pages by clicking "Restore
Base Content".

Editing Space Pages

To edit a space page, click the "Edit Space Page" icon next to it. You will be directed to the "Edit Space Page" page.

Maguire - Account Find Form
Home Dashboard » Spaces » Module » Porial Page

Portal Page | Page History |

Page Content
4 fia/aearchTable ja" type="text/javaseript®></ascript>

"spanl? topSpace divider">
hl>Forms</hl>
_ <p*Select from the list of available forms below.</p>

w search-form">
s="gearchField smallDivider">

ass="searchButton smallDivider™>

$form. fields.go

span>
§if ($form.fields.categoryFilter.optionlist.size() > 1)
2w <span class="searc 1d smallDividezr">

: fields.categoryFilter

v

#if (S5filtexClients)
T <div id dvanced-search” style="displa
class="field-label"><label fo:

e; "
m_access">$form fields_ clientSelect.label</lab

n
=
W

elass="rou"><hr><  dive

#%# See template in: /rescurces/includes/account/tile.htm

¥ <div id="tableHoldezr" class="zow">
tileldst
< divr

.Page View URL Params

w Restore View Close

Modifying a space page

This page allows you to modify the HTML pages used by the space, for example to adjust styling at run time. Please be careful when doing this to avoid
introducing issues with the page's styling or functionality.

Once you are done editing the page, save your changes.

You can then click "Preview" to inspect the new version. If the page needs certain URL parameters to display correctly, for example a form code, enter
the parameter(s) into the "Page View URL Params" field first.
If you would like to restore the base content of the space page, click "Restore".

To see the edit history of the page, switch to the "Page History" tab.

Maguire - Account 2 Factor Authentication
Home Daghboard » Spaces » Module » Portal Page

Portal Page | Page History |

Version Value Created At Created By Action

1 <!— account-getai htm—> <div class="row" id="twoFactorAuthenticationSignup™> <!— Heading -... 21 Jul 2015 14:32:03 PM  Ipammer =2

Viewing the history for a portal page

Configuring Space Resources

Space resources are files other than HTML pages, such as CSS, images and localization-related files. You can view the list of space resources by
editing the space, ensuring the space is editable and switching to the "Space Resources" tab.

You can filter the list to show only resources whose content includes a certain string. Enter the string into the "Page data" field and click "Search". You
can also filter by resource type.
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Maguire
Home Dashboard » Spaces » Module

Space | Properties | Pages | Resources | Forms | Organizations | Status | PDF Offline Submission Form

Resource Path Size KB Base Content Date Merged Last Modified Action
Iresources/AcrobatSniffer.pdf 12.42 10 Sep 2013 13 Aug 2013 by system [ @ 0
Iresources/css/bootstrap-responsive-revised.css 14.93 27 Feb 2014 13 Aug 2013 by system @ E o
iresources/css/bootstrap. min.css 107.32 27 Feb 2014 13 Aug 2013 by system [ (7 @
Irespurces/cssichidportal css 0.07 22 Apr 2014 21Ju201Sbylpammer AL [ D D O
Iresources/css/govassist-childportal.css 6.45 14 Mar 2014 10 Mar 2014 by system [ (7] @

Viewing the list of space resources
Click on the "View Content" icon (0) next to the resource to load it in your browser.

You can create new resources by clicking "New" and edit each resource by clicking the "Edit Space Resource" icon ( [2|).
You can see if the resource was edited in the "Last Modified" column. If the resource has been modified, the last modified date and user are shown. If
the content is different to the base content (the resource as defined in the space WAR file), the entry is highlighted in red, and additional actions (to view

the differences between the current and base content and Qfl to restore the base content) are shown.

To promote an edited resource to be the new baseline, use the "Mark Content Merged" ( E) icon.
You can also revert all resources to their original version by clicking "Restore Base Content".

Editing Space Resources

To create a space resource, click "New"; or click the "Edit Space Resource" icon ( [2) to edit a resource. You will be directed to the "Edit Space
Resource" page.

Maguire - [resources/css/childportal.css

Home Dashboard » Spaces » Module » Portal Resource

Portal Resource I Resource History |
Path*
/resources/css/childportal css
Content
* Placeholder for customized CS5 styles. *

File Upload

Browse_ INofile selected
E Restore Close

Editing a space resource

The "Path" field contains path where the resource should be hosted (relative to the space context path).
You can edit textual resources directly, or upload the resource content using the file upload field.

Save the resource when you are done.

If you would like to restore the base content of the space resource, click "Restore".

To view the revision history of a space resource, change to the "Resource History" tab.

Maguire -;‘resources!includesfaccount!ajax-border-template.html
Home Dashboard » Portals / Modules » Portal » Porial Resource

Portal Resource | Resource History

Version Value Created At Created By Action
1 <l—* Cl*headerMeny’ *—> #parse(SsubHeaderPath) #parse{SoptionalHeaderPath) <= Cik’'page... 07 Apr 2014 10:54:49 AM  |pammer QaB
2 <I—* Clk’*headerMeny’ *—> #parse(SsubHeaderPath) <—* Clk’‘pageContent’ *—= #parse(Spath) 07 Apr 2014 10:54:55 AM  |pammer ;_'

The history of a space resource
You can remove old revisions, restore the resource to the previous revision ('4¢) and compare the content of a revision to the current resource content (

Q).

Configuring Space Properties
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Space properties are arbitrary name-value pairs that you can use to customize your space. To view the list of space properties, edit the space and
switch to the "Space Properties" tab.

Edit Portal - Gov Assist

Home > Portals » Portal

Portal | Status | Securty | Properties | Pages | Resources | POF Offine Submssion Fom | 0
Name Type Value Description Action
Account Locked Message Sfring “our account has been locked Message displayed at login to users whose accounts are locked z ﬂ
due to a number of fai...
Aliow Form Cancel Boolean  ftrue Allows users to cancel a submission at the payment stage @ &
Allow Form Retry Boolean true Allows users to go back to the form if payment has not baen completed yet 'z ﬁ
CDN Server URL String Optional CON Server URL for caching static content A &
eSignature Cancel Alert Siring By clicking OK you will cancel Submission eSignature page Cancel popup message @ &l
your submission
eSignature Confirm Alert String By clicking OK you, on behalf of  Submission eSignature page Confirmation popup message 'z ﬁ
yourself or any ent...
eSignature Enabled Boolean frue Submiszion eSignature enabled @ &
eSignature Enrolement Alert String By selecting {0} you agree to the Create Account page eSignature enroiment popup message A x'-|
terms of the eSign...
Google AP! Key String  <AP|KEY> Google AP| Services Access Key A8
Page and Resource Caching Enabled Boolean false Velocity Page Template and Resource Caching enabled. This should be set to true in A &
production, or false in dev Changes to this value wil require a server restart before
the take effect.
Server Busy Redrect URL String Optional external resource URL to redirect users to if the server is too busy to handie the =
form request.
Ul Mapping String  <\— Submission fiter_mappings: - The Ul Mapping for the submission page A &8
type attribute ...
3 -

Viewing the list of space properties

You can add, edit ( ) and delete ( ) space properties.

Editing Space Properties

To edit a space property, edit the space, switch to the "Space Properties" tab and click the "Edit" icon ( ‘2]) next to the space property. You will be
directed to the "Edit Space Property" page.

Edit Portal Property - Account Locked Message (Gov Assist)

Home = Portals = Portal = Portal Property

Name * Account Locked Message

Your account has been locked due to & number of failed login attempts. Please contact an administrator to have
your account reactivated.

Creating a space property
Modify the value and save your changes.

Standard Space Properties

Transaction Manager defines a set of standard space properties that can be set for every space. Most of these properties have a default value if the
property is not present to avoid having to explicitly define these properties for all spaces.
The current list of standard user space properties is:

Property Default Description

Account Locked Depends = Message displayed to a user whose account was locked due to too many failed login attempts.
Message onspace May not apply to all spaces depending on security configuration.

Allow Form Cancel true Controls whether users are able to cancel their submission on the payment page.

Allow Form Retry true Controls whether users are able to return to the form after submitting it, and potentially resubmit using

different data.

123



Allow XML Redirect false Controls whether to check submission data for a custom HTTP redirect URL. If this setting is enabled
Target and a custom redirect URL is found, the user is sent there after submission.
Allow XML Request false Allows XML request parameters [ xmIData | schemaSeed ] to be used in form prefill. schemaSeed ] to be
Param Form Prefill used in Form Prefill.
Anonymous 15 min The grace period in minutes during which anonymous users can access their submission.
Submission Access
Timeout
CDN Server URL - If set, instructs the space to load static resources such as CSS and images from a Content Distribution
Network.
Email Form Receipt Subject of the submission receipt email sent to space users
Subject
Email Form Receipt Body text of the submission receipt email sent to space users
Message
Email Lost Password Lost password reset email message
Message
Email Lost Password Lost password reset email subject
Subject
Email Saved Form Subject of the email sent to space users regarding a saved submission
Subject
Email Saved Form Body text of the email sent to space users regarding a saved submission
Message
eSignature Enabled false Controls whether the space will display information about eSignatures to the user.
eSignature Confirm - Text displayed to the user when they are accepting a digitally signed form receipt
Alert
eSignature Cancel - Text displayed to the user when they are rejecting a digitally signed form receipt
Alert
eSignature - Text displayed to the user when creating a user space account on a space where the property
Enrolement Alert "eSignature Enabled" is set to true
Form Terms And - The form Terms and Conditions statement the user must accept before accessing the form.
Conditions
Google API Key - Google API Services Access Key
Server Busy Redirect - If set, this URL will be used to redirect space users to if they attempt to render a form, but the system
URL cannot handle the request due to high load.
By default, the "Server Busy" space page will be used.
Use Email for Login false Use the email address as the user login name for Local TM user accounts.

Note: If you are using a custom user space, some of these properties may not be implemented.

Configuring the Offline Submission Form for a Space

To configure a space's offline submission form, edit the space and switch to the "Offline Submission Form" tab (see Offline Submission (Manager v5.0)
#_sec_offlinesubmissionformcustomization).

Editing the Space Status

Transaction Manager allows you to restrict access to each user space for maintenance purposes. This is achieved by maintaining a space status as well
as some status messages. If a space is put into offline mode, users cannot access any content on that user space - instead, they will be redirected to a
space-specific page that displays the status messages to the user. Once the space is put back into normal mode, all content can be accessed as before.
Please note that the management console and Business report space do not support separate statuses.

To edit the space status, edit the space and switch to the "Status" tab. You will see the current status and the status messages (the screenshot below
shows a space that is currently offline).

Edit Portal - Gov Assist

Home > Portals > Portal

Portal | Status | Security | Properties | Pages | Resources PDF Offline Submission Form Organizations

Offline: 'I

IAppllcahwn Not Available

Status *

Offiine Status Title

The application currently operates in a restricted mode and the functionality you

r ted is not available. PI t in later.
Offline Status Message equested is not available. Please try again late

Save Close

Editing the space status

Select the new status from the "Status" dropdown. Possible values are "Normal" and "Offline".

Modify the offline status title and message as necessary. These messages are relevant only when the space is in offline status. In this case, requests
made for any content belonging to that space are redirected to the "Offline" space page (see _sec_configurepagesforspace for more on space pages).
This page will use the offline status title as its page heading and the offline status message as the page body, so make sure to enter content that gives
the space users the information they need (you can enter HTML content including links).

When you are done editing the status value and messages, save your changes.

In addition, requests for forms can be handled more intelligently by using a message specific to the form. To set up a customized message for a form,
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edit the form and add a property of type "Offline Status Message". This message overrides the offline status message when space users attempt to
access a page specific to the form (e.g. the landing page).

Associating Organizations with a Space

For an organization to be able to host forms on a specific user space, it needs to be associated with that space. This can be done for each organization
(see Organization Configuration (Manager v5.0)#_sec_organizationspaceaccess), but you can also change the organizations associated with a space.
To view the list of organizations associated with a space, edit the space and switch to the "Organizations" tab. You will see the list of available and
assigned organizations.

Edit Portal - Gov Assist

Home > Portals > Portal

Portal | Status | Security | Properties | Pages | Resources PDF Offline Submission Form Organizations |
Select organizations that shall be able to host forms on this portal.
Available Organizations Assigned Organizations
DataWright ;I Administrative Services d
Example Company Ben Org
Finance Cop Department of Health
MTHojgaard Franc Org
frank Test
> Lena Test Client (3.2.2)
Lena Test Client (3.3)
Organizations < Test Hampal
53 Test Import Client
Test Org
<<
Close

Assigning organizations to the space
You can use the ">" and "<" buttons to assign and unassign organizations. Click "Save" when you are done.

Hot Deploying a Space

"Hot deploying" a space means updating the underlying WAR file on the Transaction Manager application server without shutting down the server and
restarting it. Transaction Manager now supports hot deployment of spaces by importing a WAR file via the management console.
To hot deploy a space, go to "Forms > Form Spaces" and click "Import WAR". The "Import Portal WAR" page will be displayed.

Import Portal WAR

Home = Portals = Import Portal WAR

Browse._.

Portal WAR File *

Hot deploying a space WAR file

Browse to the updated space WAR file on your hard disk and click "Import". If overwriting an existing WAR file, ensure the file name matches —
otherwise conflicts may occur.

It is recommended to use this functionality on development servers only and carefully restrict access to the feature (using the "Import Space"
permission) because accidental or malicious deployment of WAR files can be potentially very harmful. Also, when upgrading to a new Transaction
Manager version, do not use this feature to update the WAR files, but instead follow the upgrade instructions provided.If you do use this feature, ensure
that the space you have deployed starts up normally and is fully accessible afterwards.

D:\sfm-install\war\avoka-sf-portal-govassist war

Deleting a Space

Before deleting a space, check if there are still forms associated with it. If so, these forms will not render after the space is deleted. You can fix this by
associating them with a different space.

=i |
To delete a space entry, go to "System > Modules" or "Forms > Form Spaces" and click the "Remove Space" icon ( #-') next to the space. You will be
asked for confirmation before the space is deleted. Please note that if the space WAR file is still deployed on the application server, the space will re-
create its entry when the server restarts.

Associating Forms with a Space

To associate a form with a particular space, go to "Forms > Forms" and edit the form. Change to the the "Space Access" tab, assign the desired set of
spaces and save. From that point on, the form will be visible on the set of assigned spaces. By default, other user spaces will refuse to display the form.
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Payment Form
Home Dashboard » Forms » Form

Dashboard | Detais | Flow Config | Email Verificati Form Versions. | | PageTracking | spaces
Select the set of Spaces that will display this form.
Available Spaces Assigned Spaces
TransactField App ;I Finance Comoration ;I
Web Plug4in Gov Assist
Maguire
>
Spaces <
>
<<
= [
Close

Changing the space(s) a form is hosted on
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Advanced Form Lookup (Manager v5.0)

Users can search for forms on the Example Self Service Space by using conventional search fields and filtering. If there is a large number of forms or if
external resources should be referenced as well, however, more sophisticated form finding methods may be needed.

Search

Concepts

Transaction Manager provides a way for users to search for forms or external resources by answering a series of questions about their needs. Each
answer is used to filter the set of forms and resources.

A set of questions that are used to filter forms is called a finder category. It contains a form data file describing the forms and resources that shall be
exposed as well as a user interface definition file. This separation is useful when a form data file is exposed multiple times via different user interface
definitions.

The Transact Finder module is an example of how a finder category might be rendered, providing a user interface to progress through the set of
questions and display matching forms. In addition, users can also search the entire set of forms and resources by keyword.

Setting Up Finder Categories

To view the list of finder categories in Transaction Manager, go to "Forms > Finder Categories". You can filter the list of categories by a substring of the
category name.

Finder Category Search

Home Dashboard » Finder Category Search

Category Name Org. Category Code Data Rows Time Data Loaded Action

Grants grants 320 23 Apr201410:45:40 (7 g £ [=

Viewing the list of finder categories -
You can use this page to create new finder categories or edit (@) and delete (E) existing categories. You can also view the form data file (‘il) and

the user interface definition file ( = ) for each category.
To add a finder category, click "New". You will be directed to the "Edit Finder Category" page.

Edit Finder Category

Home Dashboard » Finder Category Search » Finder Category

Finder Category I

Category Name* Grants o

Category Code™ grants o

Organization j

Category Excel Data Browse_ | Finder-Grants-Data xis w

Description

Save Close

Creating a finder category

Enter a unique category name and a short unique category code.

Upload the form data file using the "Category Excel Data" field. The form data file is a Microsoft Excel file containing a line (or multiple lines) for a form or
external resource. External resources define a URL, and forms are identified by the form code. All entries also have a description and an arbitrary set of
attributes, which are used for filtering.

Save the finder category and switch to the "Finders Ul Descriptor” tab.

Upload the user interface definition file using the "Upload XML File" field. The user interface definition file is an XML file defining the series of questions
to be asked of the user, and what attribute in the form data file the questions correspond to.If you have already uploaded the user interface definition,
you can also edit the XML data in the "Finders XML Descriptor" field directly.

When you are satisfied with the user interface definition, save your changes.

Accessing the Finder

Please note: The Transact Finder module contains an example page that will display the finder category with code "grants", if one exists. Generally,
agencies would provide their own finder page using a Transaction Manager finder category. For more information around this, please refer to the Finder
Examples module ("avoka-sf-finder-examples.war"), which is created by the Transaction Manager installer.
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To be able to access the Finder module, it must be deployed on your Transaction Manager instance. The relevant deployment module is named "avoka-

sf-finder.war".

To access Finder, create a finder category with code "grants" and then access <TM server root>/finder e.g. http://transactionmanager.com/finder
The screenshot below shows the Finder after the user has answered two questions. Note also the global search field and the quick navigation bar at the
top that allows the user to jump to one of the previous questions.

Question

What type of business do you operate?

IOiIs or fuels

=

N/ Avoka
S SmartForm Finder

[ Search

Energy Grants Credits Scheme
(ECGS) - Alternative Fuels

EGCS provides grants to businesses that use
particular fuels for specified acthities.

Ethanol Production Grants (EPG)

Eligible Australian ethanol producers can apply
for funding under the EPG program that
supports the use of biofuels in fransport.

Product Stewardship for Oil (P50)
Program

The PSO Frogram provides benefits to eligible
recyclers of used oil and businesses who use
selected used oil.

Second Generation (Gen 2) Biofuels
Research and Development Program

Gen2 is a competitive grants program which
supports the research, development and
demonstration of new biofuel technologies and
feedstocks.

The Finder
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Scalability and Server Nodes (Manager v5.0)

Search

Concepts

To allow a scalable architecture, Transaction Manager allows you to define server nodes. Each server node corresponds to a Java Virtual Machine
involved in this Transaction Manager deployment. Server nodes may host Transaction Manager spaces and/or Adobe LiveCycle. There may be multiple
nodes hosting the same space, and multiple LiveCycle nodes. A server node hosting Adobe LiveCycle is called a form server node.

For further details about the different deployment architectures that are supported, please refer to the TM Installation Guide, section "Server Nodes and
Service Connections".
Note that all Transaction Manager nodes share the same database.

Configuring the Set of Server Nodes

To view the list of server nodes configured in Transaction Manager, go to "System > Server Nodes". You will see the currently configured servers (the
screenshot below shows an example). The "Status” column is dynamically calculated based on recent health data. If the status in "Unavailable" for a
server node, try reloading the page to see if the status persists, and if so, this could indicate an issue with the server node.

You should have a server node entry for each Java Virtual Machine hosting a Transaction Manager module or LiveCycle. Transaction Manager creates
a default node at installation time representing a LiveCycle node, and a default node representing the Transaction Manager server. Ensure you correct
the configuration (including IP address and credentials) for these nodes.

Server Nodes
Home Dashboard » Server Nodes

Search Clear
New Synchronize Repositories
Server Name Server URL Group Admin Server Form Server Porial Server Mode Status  Action
USR-MEDGARZ - LC Form Server hitp-/USR-MEDGARZ2:8080 USR-MEDGARZ v Active Avaiable [7) r" i
USR-MEDGARZ - TM Server hitp://USR-MEDGAR2:9080 USR-MEDGAR2 0 v Avaisble [ [ 4

Export Data

The list of server nodes

You can filter the list of servers by a substring of the server name. This page also allows you to add, edit ( E)l) and delete ( E) server nodes, as well

as check the health status of a specific node ( ' ).
In addition, you can click "Synchronize Repositories” to synchronize the set of forms

Adding a Server Node

To add a server node entry to Transaction Manager, go to "System > Server Nodes" and click "New". You will see the "Edit Server Node" page.
Edit Server Node

Home Dashboard » Server Nodes » Server Mode

Server Node Details
Server Name* UUSR-MEDGAR2 - LC Form Server &
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Server Node URL ™
Server Host Mame or IP Address ™

Server Group™*

Transact Management Server

Management Server

Transact Portal Server
Portal Server

Max Form Worker Queue

Max Form Worker Threads
LiveCycle PDF Form Server

LC Form Server

Form Server Mode

Max LC Process Load

LC Service Connection

Save Test Connection

http://USR-MEDGAR2:8080
USR-MEDGAR2

USR-MEDGAR2

Oe

Oe

¥a
Active |w| @
6 |&

FormServer Connection | v | &

Close




Creating a new form server node

Enter a name for the server node into the "Server Name" field. This name is purely descriptive.

Enter the URL to the server into the "Server Node URL" field. The URL should use the domain name if there is one.

Enter the server's IP address into the "Server IP Address" field.

Enter the name of the server group the server node belongs to into the "Server Group" field. Generally, server nodes that can communicate via the
network should be in the same server group; if your deployment consists of multiple sets of servers that cannot communicate via the network, each set
of servers needs to be a separate server group. The group names themselves can be chosen arbitrarily.

Depending on what modules are deployed on the JVM that the server represents, tick one or more of the "Management Server" (management console),
"Portal Server" (User Space) and "LC Form Server" checkboxes.

For portal servers, you can set the maximum length of the form worker queue and number of form worker threads.

The "Form Server Mode" dropdown can be used to indicate what status the LiveCycle form server node is in. "Active" signifies that the server is running
and ready to take on tasks. "Standby" signifies that the server is running but not currently taking on Transaction Manager tasks. "Inactive" signifies that
the server may not be running, and Transaction Manager will not query the server.

The "Max LC Process Load" field is relevant only to form server nodes and determines how many requests will be given to the server to process at a
given time. A reasonable value for the maximum request load would be 10.

The "Service Connection" dropdown is typically used only for form servers. It points to an existing service connection, which basically contains
connection details including authentication credentials and is used when requests are sent to the server node. Please refer to Services (Manager v5.0)
#_sec_manageserviceconnections for more information on service connections and how to set them up.

Save your changes to create the new server.

If the server status is "Active" or "Standby", health data will be collected about the server.

Deactivating a Server

To temporarily deactivate a server, go to "System > Server Nodes", find the server and edit it. Set the status to "Inactive" and save.
The server will then no longer be selected when rendering forms or receipts. To ensure uninterrupted operations, do not deactivate all servers providing
portal or LiveCycle services at the same time.

Removing a Server

To permanently remove a server, go to "System > Server Nodes", find the server and click the "Delete" icon ( E). Please note that some associated
data, such as health records, will be permanently removed along with the server.

Monitoring Space Server Performance

Transaction Manager offers a set of graphs showing real-time performance measurements for the set of space servers. To view the graphs, go to
"Operations > TM Server Performance".

TM Server Performance
Home Dashboard » TM Server Performance

Server Group  tmdest] jPona Server | tmiest!-TM Server j [V Form Rendering Metrics |~ Request Served / Queued [~ ReguestTurned Away R ServerCPU [T Server Memory

Form Rendering Metrics

Server CPU Usage
. W CFU

The space server performance graphs
You can select the server group and the space server and choose from a set of five graphs by ticking the checkboxes at the top.
The page will automatically update to show real-time metrics for the graphs you selected.

Monitoring Form Server Performance

Transaction Manager offers a set of graphs showing real-time performance measurements for the set of active form servers. To view the graphs, go to
"Operations > LiveCycle Performance".
You will see three graphs that are constantly updating.
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LiveCycle Server Performance
Home = LiveCycle Server Performance

Server Groups  Local Group %] Form Server | LiveCycle Form Server 1 %]

Process Load History

Ml Process Count: 0

30vsec

15sec

10 mins 9 min B mins 7 mins. 8 mins S5 mins. 4 mins. 3 mins. 2 mins.

Error Count History

2isec
Ml Error Count : 0

15/see
1Disec
Sisec

10 mins 9 min B mins. 7 mins. 8 mins 5 mins. 4 mins. 3 mins. 2 mins

Server CPU Usage
0%
Bl CPU- 1%

Mm%
=%
I%

10 mins 5 min & mins 7 mins 8 mins 5 mins 4 mins 1 mins 2 mins

The form server performance graphs

You can filter the data by server group and form server.

The "Process Load History" chart shows the number of concurrent processes on the form server.

The "Server CPU Usage" chart shows CPU load for the form server over time.

The "Error Count History" chart shows the number of form server invocations that resulted in an error being thrown.
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Multi-Environment Support (Manager v5.0)

Search

When forms are developed and hosted, there will often be several environments set up: Development and test server(s) as well as the production
environment. As the form matures, it migrates from one environment to the other.

Transaction Manager was built with these processes in mind and allows you to easily migrate forms, form versions, organizations, metadata tag
definitions, services, security managers and role configurations from one environment to the other. Each of these can be exported separately

Migration Order

If you want to migrate a set of entities (e.g. an organization and all its forms, or all roles, spaces and service definitions), you need to know in which
order to import your export archives.
The following list shows the import order you should follow in general:

. Services (service definitions and service connections)
. Spaces

. Security managers

Roles

. Metadata tags

. Organizations

. Application packages

Forms

ONOUTAWN

So if you want to migrate a space as well as an organization and its forms, you can export them in any order, but you need to import the space first, then
the organization and finally the form.

Please note that services in particular contain large amounts of information that may be server-specific (such as endpoint URLS). When migrating
services, you need to ensure the services are configured correctly for the target system by reviewing the services that have been imported. This is also
true for other entities to a lesser extent (e.g. spaces need to have their context path adjusted).

Migrating an Organization

If needed, you can migrate an entire organization with its configuration including property types, metadata tags and document types across to another
environment. After reimporting, the organization will be set up as it was on the original system (though the entity IDs may have changed). Please note
that not all entities are included in the export/import process; for example, organization administrators are not exported along with the organization for
security reasons. In addition, forms and associated data are not included in an organization export (they can be migrated separately).

Use this mechanism to migrate an organization to a system that doesn't have the organization yet or where organization-related properties are not up to
date. It is also a good way to back up organization data without introducing dependencies on database IDs.

Exporting an Organization

? Unknown Attachment
To export an organization, go to "Forms > Organizations" and click the "Edit" icon ( ) next to the organization.
Click the "Export Organization" button on the "Organization” tab to download a ZIP file containing data describing the organization.

Importing an Organization

To import the organization on the target environment, go to "Forms > Organizations" and click the "Import" button. You will see the "Upload Organization
Archive" page.

Upload Organisation Archive

Home > Organisations > Upload Organisation Archive

Organisation Archive File * |C‘"AvnkaTestCases"-ﬁxpnrt"\diemarch\ve'Tasl_\mpurt_Chenl 7ip Browse

Target Organisation Name @
Target Client Code 2]

Proceed To Import Cancel

Importing an organization
Select the previously exported file using the "Browse" button.

If you want to create a new organization to import the data to, enter the desired organization name and client code into the "Target Organization Name"
and "Target Client Code" fields. This can be useful when you want to rename or duplicate an organization during import.
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Click "Proceed to Import". The file will be read and the "Import Organization" page will be displayed.
Import Organization

Home Dashboard » Organizations » Upload Organization Archive » Import Organization

—‘ Import Information

The existing organization with code 'tic’ will be updated.

Import Action

Export Environment  tm test1.avoka.com fim.dev.avoka.com]
Export Date 20141003

TM Version Version 4.1.0 (build number 38553)
Database Version 1357

Client Code tic

Organization Name  Test Import Client

_{ Options

Import Client Definition 2
Import Client Key |l
Import Service Definitions 2
Preserve Existing Services W
Import Application Packages [V
Import Payment Configuration |7
Import Portals I
Import Delivery Details I
Import Document Types 12
Import Property Types I3
Import Metadata Tags I~
Import Organization Properties [
Import Organization Metadata [V
Import Categories Ird
Import Report Schedules v

Confirming an organization to be imported

This page displays some information about the source system as well as the action that will be taken when you continue. Check the "Import Action" field
specifically for any indication of import conflicts that may need to be resolved first.

You can choose what data shall be imported by changing the settings in the "Options" section. By default, the client key (a UUID uniquely identifying the
organization) is not imported but will instead be regenerated if a new organization is created.

Click "Import" to import the organization data, and wait for the data to be integrated into the system. Please review the import message and record that
are displayed to ensure all data was imported successfully. If any issues are found, a detail message will be added to the import record, so you can
manually resolve the issue after importing.

Migrating an Application Package

While you can migrate forms and service definitions by themselves (which is discussed later in this chapter), it can be easier to create an application
package containing a number of forms and organization specific services, and migrate the entire application package in one go. You still need to ensure
the organization exists on the target system first (e.g. by importing it as described above), but apart from that, application packages can save you doing
a lot of individual imports.

To learn more about how to create application packages, please see Organization Configuration (Manager v5.0)#_sec_setupapplicationpackages.

Exporting an Application Package

To export an application package, edit the organization and switch to the "Applications” tab. You have two options on what will be included in the export
archive:

® export all services and forms with all form versions ( {i)
This is the most comprehensive option. Use this when you need to migrate the entire set of form versions. However, if the forms contained in
the application package have many versions, the export archive can become very large.

® export all services and the current version of each form ( ‘!-)
This is a good option if you simply need the current version of each form.

Importing an Application Package

To import the application package on the target environment, go to "Forms > Organizations", edit the organization and switch to the "Applications" tab.
Click the "Import" button. You will see the "Upload Application Package Archive" page as shown below.
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Upload Application Package Archive

Home Dashboard » Organizations » Organization » Upload Application Package Archive

Application Package Archive File*  Browse... | application-package-archive My_Application_3-2015-10-15.zip &

Proceed To Import Cancel

Uploading an application package archive
Select the previously exported file using the "Browse" button.

Click "Proceed to Import". The file will be read and the "Import Application Package" page will be displayed.

Import Application Package

Home Dashboard » Organizations » Organization » Upload Application Package Archive » Import Application Package

—| Import Information

Application package ‘Application Package 1" for crganization with code "1t418° will be

Import Action upsated.

Export Envirenment Engineering Test 1 (AWS EC2 Linux - Orade 12c)
Export Date 2015-01-12

TH Version Version 4.3.0 (build number 44838)

Database Version 1528

Client Code lt418

Application Package Name  Application Package 1

—| Options

Import Service Definttions

Preserve Existing Services

q 0=

Import Forms

Importing an application package

This page displays some information about the source system as well as the action that will be taken when you continue. Check the "Import Action" field
specifically for any indication of import conflicts that may need to be resolved first.

You can choose what data shall be imported by changing the settings in the "Options" section. Mainly you can decide whether to import services and/or
forms contained in the application package.

Additionally you can choose to import new services but leave any existing services alone by ticking "Preserve Existing Services" in addition to "Import
Service Definitions".

Click "Import" to import the application package, and wait for the data to be integrated into the system. Please review the import message and record
that are displayed to ensure all data was imported successfully. If any issues are found, a detail message will be added to the import record, so you can
manually resolve the issue after importing.

Migrating a Form

If you are progressing a form to production, you will want to export the form and its configuration to the production server, but not necessarily transfer
across all the organization data if the organization is already set up and up to date on the target system.

Transaction Manager allows you to export a single form or even a single form version and reimport it on a different Transaction Manager system. The
process is very similar to exporting and reimporting an organization.

Exporting a Form and All Versions

You can export a form and all its form versions at once. This is best done if the form does not yet exist on the target system (and the entire version
history is needed). If you need to migrate only a single form version, please refer to the following section.

Go to "Forms > Forms", and click the "Export Archive" icon ( i ) next to the form to download a ZIP file containing data describing the form and all its
versions.

Exporting a Single Form Version

You can export a single form version if you would like to create or update just this version on the target system.

To export a form version, edit the form and switch to the "Form Versions" tab. Click the "Export Archive" icon ( § ) next to the form version to download
a ZIP file containing data describing the form and the chosen version.

Importing a Form (One or Multiple Versions)
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To import the form version archive on the target environment, go to "Forms > Forms" and click the "Import Form Version" button. The file will be read
and the "Upload Form Version Archive" page will be displayed.

Upload Form Version Archive

Home Dashboard » Forms » Upload Form Version Archive

Archive Name  form-version-archive-Job_Example_1-2.0-2015-06-26 zip
Add to Organization =~ maguire j @

& Update an Existing Form
€ Create a Form

Existing Form = Job Example 1 j 7]

Proceed To Import Cancel

Uploading a form version archive

Select the previously exported file using the "Browse" button and click "Upload".

TM will scan the archive and load the target organization and form (which may not exist on the system you are importing to).

If you want to import the form to a specific organization, choose its client code from the "Add to Organization" field.

Now select whether you want to update an existing form or create a form.If you want to update a form, select it from the "Existing Form" dropdown. Note
that if you are not updating the same form, be very careful as form versions are resolved by version number during import, and existing form versions will
be overwritten if their version number matches the version number of a version in the import archive.If you want to create a form, enter a unique form
code into the "New Form Code" field.

Click "Proceed To Import". The "Import Form Version" page will be displayed.

Import Form Version

Home Dashboard » Forms » Upload Form Version Archive » Import Form Version

—‘ Form Info

Import Action  The existing form with form code: job-example-1° will be updated.

Form Name Job Example 1

Form Code job-example-1

Client Code maguire

Export Server  Test

Export Date 2015-06-26

T Version Version 4.2.0 (build number 42474)

TM DB Version 1464

—i Import Options

Form Definition 'm|
Delivery Channels 2
Form Groups I3
Update Current Version re
Form Deployment Schedule WV @
Attachments I
Properties I
Form Tags I~2
Form Categories I~2
Form Data Config v

Importing a form

This page displays some information about the source system as well as the action that will be taken when you continue. Check the "Import Action" field
specifically for any indication of import conflicts that may need to be resolved first.

You can choose what data shall be imported by changing the settings in the "Options" section.

Click "Import" to import the form data, and wait for the data to be integrated into the system. Please review the import message and record that are
displayed to ensure all data was imported successfully. If any issues are found, a detail message will be added to the import record, so you can
manually resolve the issue after importing.

Migrating Services

Transaction Manager allows you to export and import the set of service definitions and service connections. This allows you to configure and test your
services on one server and then export them to your other environments.
Note: Only service connections that are referenced by service connections will be exported.

Exporting Services
To export the set of service definitions and the service connections they use, go to "System > Service Definitions" and click the "Export" button.
You can also export individual services, or filter the list of services by an application package and then click "Export" to export all services in the package.

A ZIP file containing information about the chosen service definitions, their parameters and service connections will be created and offered to you for
download.

Importing Services
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To import the set of services on the target environment, go to "System > Service Definitions" and click the “Import" button. You will see the "Upload
Service Archive" page as shown below.

Upload Service Archive

Home > Service Definitions > Upload Service Archive

Service Archive File* IC MAvoka TestCases\export\service-archive-export zip Browse_.

Proceed To Import Cancel

Importing the set of services
Select the previously exported file using the "Browse" button and click "Proceed To Import". The file will be read and the "Import Services" page will be
displayed.

Import Services

Home Dashboard » Service Definitions » Upload Service Archive » Import Services

—-! Import Information

Services contained in the import file will be imported

Import Action

Export Environment tm.dev.avoka.com

Export Date 2013-04-22

TM Version Version 3.5.1 (build number 28203)
Database Version 1027

Organization

—‘ Options

Preserve Existing Services V&

Preserve Existing Service Connections [ 7]}

Preserve Service Type Defaults ¥V a

Import services confirmation page
This page displays some information about the source system as well as the action that will be taken when you continue. Check the "Import Action" field
specifically for any indication of import conflicts that may need to be resolved first.

You can select several options to preserve data on the target system: Tick "Preserve Existing Services" to leave all service definitions on the target
system intact. Tick "Preserve Existing Service Connections" to leave all service connections on the target system intact. Finally, tick "Preserve Service
Type Defaults" to ignore the service type default flag for imported services; otherwise, imported services may be marked as the default for their type and
existing services demoted.

Click "Import" to import the service data, and wait for the data to be integrated into the system. Please review the import message and record that are

displayed to ensure all data was imported successfully. If any issues are found, a detail message will be added to the import record, so you can
manually resolve the issue after importing.

Migrating Groups

You can use groups to define a set of users with certain privileges (mainly form access). TM allows you to export the full set of groups or a single group
for migration to other servers.

Note that the set of users associated with the group and the set of forms using the group is not part of the export. Only basic group settings (name,
description) and user access control settings will be exported.

Exporting Groups

To export the full set of groups, go to "Security > Groups" and click the "Export" button. To export a single role, click the "Export Archive" icon ( ! /).In
either case, a ZIP file containing the group data will be created and offered to you for download.

Importing Groups

To import the group(s) on the target system, go to "Security > Groups" and click "Import". You will see the "Upload Group Archive" page.
Upload Group Archive

Home Dashboard » Groups » Upload Group Archive

Group Archive File*  Browse_ | groups-archive-Job_Applicants zip

Proceed To Import Cancel

Importing a group
Select the previously exported file using the "Browse" button and click "Proceed To Import". The file will be read and the "Import Group" page will be
displayed.
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Import Group

Home Dashboard » Groups ¢ Upload Group Archive » Import Group

The existing group will be updated

Import Action

Export Environment Test

Export Date 2014-10-29

TM Version Version 4.1 PRE-RELEASE (build number SNAPSHOT (buik at 2014/10/27 14:19 by Ip:
Database Version 1366

Group Job Reviewers

Import group confirmation page
This page displays some information about the source system as well as the action that will be taken when you continue. Check the "Import Action" field
specifically for any indication of import conflicts that may need to be resolved first.

Click "Import" to import the group, and wait for the data to be integrated into the system. Please review the import message and record that are
displayed to ensure all data was imported successfully. If any issues are found, a detail message will be added to the import record, so you can
manually resolve the issue after importing.

Migrating Roles

To save yourself the work of setting up the same set of roles on several servers, Transaction Manager allows you to export and import the set of roles,
or individual roles. Please note that while the set of permissions is included in the export, role membership and other user-related data is not.

Exporting Roles

To export the full set of roles, go to "Security > Roles" and click the "Export Roles" button. To export a single role, click the "Export Archive" icon ( i ).In
either case, a ZIP file containing the role and permission data will be created and offered to you for download.

Note: To avoid lockout issues on the target system, the "Administrator" role will not be including when exporting the set of roles. The role can still be
exported individually, however.

Importing Roles

To import the role(s) on the target environment, go to "Security > Roles" and click the "Import" button. You will see the "Upload Role Archive" page.
Upload Role Archive

Home > Roles > Upload Role Archive

Role Archive File ® [C: \Avoka TestCases\export \roles-archive-Test_Import_Role zip Browse_

Proceed To Import Cancel

Importing the set of roles
Select the previously exported file using the "Browse" button and click "Proceed To Import". The file will be read and the "Import Role" page will be
displayed.

Import Role

Home Dashboard » Roles » Upload Role Archive » Import Role

Roles contained in the import file will be imported

Import Action

Export Environment tm test1.avoka com [tm dev avoka.com]
Export Date 2014-02-26

TM Version Version 4.0.0-alphab (build number 34256)
Database Version 1262

Role Report Generate

Import roles confirmation page
This page displays some information about the source system as well as the action that will be taken when you continue. Check the "Import Action" field
specifically for any indication of import conflicts that may need to be resolved first.

Click "Import" to import the role and permission data, and wait for the data to be integrated into the system. Please review the import message and
record that are displayed to ensure all data was imported successfully. If any issues are found, a detail message will be added to the import record, so
you can manually resolve the issue after importing.

Please note that importing roles and permission will not remove existing roles that are not contained in the import archive. Roles contained in the import

archive will be reconfigured with exactly the permissions contained in the import archive. This means that roles may become more restrictive or more
permissive depending on the contents of the import archive.

137



Migrating Security Managers

Transaction Manager allows you to export the set of security managers (or a single security manager) and import them to a different TM instance. This
saves you configuration work and ensures the security managers are configured in the same way on multiple systems.

Exporting Security Managers

Go to "Security > Security Managers". To export the full set of security managers, click the "Export" button. To export a single security manager, click the

"Export Archive" icon ( i /) next to the security manager.In either case, a ZIP file containing the configuration data will be created and offered for
download.

Importing Security Managers

To import a security manager export archive on the target system, go to "Security > Security Managers" and click the "Import" button. You will see the
"Upload Security Manager Archive" page.

Upload Security Manager Archive

Home Dashboard » Security Managers » Upload Security Manager Archive

Security Manager Archive File * IC:"\AvukaTESICE;E!‘Mort‘\sacurity-manager—an:hive~My7LDAP75&curitLManager zip  Browse_ |
Proceed To Import Cancel

Uploading a security manager archive
Select the previously exported file using the "Browse" button and click "Proceed To Import". The file will be read and the "Import Security Managers"
page will be displayed.

Import Security Managers

Home Dashboard » Security Managers » Upload Security Manager Archive » Import Security Managers

—‘ Import Information

Security Managers contained in the import file will be imported

Import Action

Export Envirenment  tm.dev.avoka.com
Export Date 2013-05-21
T Version Version 3.5.1 (uild number 28537)

Databage Version 1028

—‘ Options

Preserve Existing Security Managers v @

Preserve Default Security Manager ¥ @
Update Portals e

Importing a security manager
If you tick "Preserve Existing Security Managers", all security managers existing on the target system will not be modified, even if security managers with
matching names exist in the export archive. New security managers will still be imported.

If you tick "Preserve Default Security Manager", the system default security manager will not be modified during import. None of the imported security
managers will be promoted to the system default security manager.

If you tick "Update Portals", the import will also attempt to resolve all spaces that were associated with a security manager on the source system and
ensure they are set to use the same security manager on the target system (note: space matching is done by name). Otherwise, spaces on the target
system will use the same security manager as before.

Click "Import" to import the security managers in the archive with the settings you have selected.After the import process has completed, please review

the import record that are displayed to ensure all data was imported successfully. If any issues are found, a detail message will be added to the import
record, so you can manually resolve the issue after importing.

Migrating Metadata Tag Definitions

To save yourself the work of setting up the same set of metadata tag definitions on several servers, Transaction Manager also allows you to export and
import the set of global metadata tag definitions and associated metadata tag list values.Please note that metadata tags created for a specific
organization will not be exported (instead, these metadata tags are included when the organization itself is exported). In addition, concrete metadata
values will not be part of the export.

Exporting Metadata Tags

Go to "Forms > Metadata Tag Definitions" and click the "Export Global Tags" button to download a ZIP file containing data describing the set of global
metadata tags.
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Importing Metadata Tags

To import the metadata tag definitions on the target environment, go to "Forms > Metadata Tag Definitions" and click the "Import" button. You will see
the "Upload Metadata Tag Archive" page.

Upload Metadata Tag Archive

Home > Metadata Tag Definitions > Upload Metadata Tag Archive

MMetadata Tag Archive File* |C.‘"-Avoka TestCases\export\metadatatag-archive-global zip Browse_

Proceed To Import Cancel

Importing the set of metadata tags
Select the previously exported file using the "Browse" button and click "Proceed To Import". The file will be read and the "Import Metadata Tags" page
will be displayed.

Import Metadata Tags

Home Dashboard » Metadata Tag Definitions » Upload Metadata Tag Archive » Import Metadata Tags

—-! Import Information

Global metadata tags will be imported

Import Action

Export Environment tm test1.avoka.com ftm.dev.avoka.com]
Export Date 2014-10-03
TM Version Version 4.1.0 build number 38553)

Database Version 1357

_{ Options

Keep Existing Metadata Tags [ @

Import metadata confirmation page

This page displays some information about the source system as well as the action that will be taken when you continue. Check the "Import Action" field
specifically for any indication of import conflicts that may need to be resolved first.

By default, all existing global metadata tags are kept. You can untick the "Keep Existing Metadata Tags" checkbox to cause any existing global metadata
tags that are not contained in the import archive to be deleted (effectively restoring the set of tags in the import file).

Click "Import" to import the metadata tags, and wait for the data to be integrated into the system. Please review the import message and record that are
displayed to ensure all data was imported successfully. If any issues are found, a detail message will be added to the import record, so you can
manually resolve the issue after importing.

The Import Log

To facilitate tracking and auditing, Transaction Manager keeps a log of all import operations that have been performed, and records the outcome of each
import as well as any warning messages.

Viewing the Import Log

To browser the import log, go to "System > Import Log". You will see the list of import operations.
You canfilter the list by import type (e.g. "Organization"), import status and the import completion date, and export the search results to Excel by clicking
the "Export Data" link below the table.
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Import Actions

Home = Import Actions

import Type [ =] status | =] Start Date Tenaome [ |9 Clear
I Org. Type Archive Name Status Import Time  Import User Action
156 exaco FormVersion  form-version-archive-Composer HTML_Form-al(1).zip Completed sg;sp_r‘éﬂﬂ lpammer @
RS SR a:ﬂiul_Sa:::EK;:éj!:?Jr:n:lzb o ersansene: ELIEE 1:;::1;012 fr::ﬁpmm B
153 DOMA-320 Organisation g;apzs;x::jnéﬁjm:\ﬁ::x?;mh;:mammn-chent-.arcni-ue- Compisted ;::;:;mz ftr;::ltp Examples  [7)
124 Organisation  clent-archive-Depariment_of_Heath_and_Aging zip Ready  1o1m020'? ammer B9
130 nt-gov FormVersion  form-version-archive-Composer_HTML_Form-all zip Completed 1;;:’;”12 lpammer @
127 DIXON Formersion  form-version-archive-Contact_Us-all.zip Completed 22:;:;012 lpammer @
126 DXOM  Organisation clentarchive-Docon_Advisary zip compietes 122202017 ppamaer @
120 MetadataTags metadata-tag-archive-global.zip Completed ?:::a;émz lpammer m
19 Portal portak-archive-import_Test.zip Completed ?:::'_‘uimz lpammer @
18 Roles roles-archive-Test_import_Role.zip Completed ?z:ﬁ'_;m: Jpammer @
b 1-100f98 =

Browsing the import log

You can click the "Edit" ( E) icon to view an individual import entry.

Import Action
Home > Import Actions > Import Action

Import Action I Detail Messages

D 156

Client Example Company
Import Type* FormVersion
Status* Completed

Creation Time* 03 Apr 2012 12:38:43
Import Time 03 Apr 2012 12:38:46
Import User*  Ipammer

Form Definition, Delivery Details, Form Groups, Attachments,
Metadsta, Properties, Form Data Configuration, Keep Existing
Import Options ~ Vessiens, Deployment Flan

Form with form code ‘comp-form-7" and version 1" was imported with
warnings. Flease review the detsil messages and make adjustments

Import Message __ o

Viewing details for an import entry
The "Import Action" tab shows general information about the import and whether it has been completed. To view a list of warning messages generated
during the import, switch to the "Detail Messages" tab.

Import Action

Home > Import Actions » Import Action

Import Action I Detail Messages

ID  Detail Message

11 The template code ‘reg-newsletter-templ is already in use. A new template code of ‘reg-newsletter-temp2’ was generated Q%

Viewing detail messages for an import entry
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Operations (Manager v5.0)

This chapter explains how to keep track of what is happening on Transaction Manager: what submissions have been made, what their status is, whether
there were any problems, what changes have been made to the Transaction Manager configuration and by whom and how you can post and view
important notifications. This knowledge will help you resolve issues raised by organizations or users.

Search

Tracking Submissions

An integral part to understanding what is happening on Transaction Manager is knowing what forms users are submitting. This information can be found
on the submission log, with additional data available via the request log. Many questions asked by users can be answered by investigating these logs.

The Submission Life Cycle

A submission object is created in TM as soon as the user opens a form (or even earlier for task submissions that are assigned to users to complete). As
the user performs actions (e.g. online save, submission, payments), the submission is updated by TM. Even after the user has completed their work,
there may be additional steps in the submission process, such as virus scanning and delivery.

Therefore, the submission life cycle can consist of many stages. This section lays out all the tasks that could potentially be part of the submission
process.

User-related actions:

® Render form
Transaction Manager status: Entries are created in the request log and submission log. The submission form status is "Opened".
Next actions: save, save offline, submit
® Save form to Transaction Manager
Transaction Manager status: The submission form status is "Saved".
Next actions: save to Transaction Manager, save offline, submit
® Save form offline
Transaction Manager status: The submission record in TM is not updated.
Next actions: submit
® Mark form as abandoned, effectively canceling the submission
Transaction Manager status: The submission form status is "Abandoned".
Next actions: abandonment delivery if configured
® Submit form
Transaction Manager status: The submission form status is "Submitted" if further user tasks need to be done, otherwise "Completed".
Next actions: authenticate, verify email address, add attachments, make payment, sign
® Authenticate / acknowledge submission
Note: This action is needed only when a form that requires authentication is submitted while the user is not logged on (this is commonly the
case after a form has been saved offline).
Transaction Manager status: The submission form status is "Submitted”, the authentication status is "Completed" once the user has
acknowledged the submission.
Next actions: add attachments, make payment, sign
® Reject submission
Transaction Manager status: The submission form status is "Submitted”, the authentication status is "Cancelled" once the user has rejected the
submission.
Next actions: None - as the user has rejected the submission, it cannot progress further.
® Verify email address
Note: This action happens in parallel with other actions such as adding attachments and payment. At submission time, an email is sent to the
user asking them to click on a link to verify their email address if submission email verification is enabled. Once they do, this step will complete.
Refer to Form Configuration (Manager v5.0)#_sec_submissionemailverification for more on submission email verification.
Transaction Manager status: The submission form status is "Submitted”, the email verification status is "Completed" once the user has verified
their email address.
Next actions: add attachments, make payment, sign
® Complete attachments
Transaction Manager status: The submission form status is "Submitted" or "Completed”, the attachment status is "Completed".
Next actions: make payment, sign
® Make payment
Transaction Manager status: The submission form status is "Submitted” or "Completed", the payment status is "Completed".
Next actions: sign
® Accept electronically signed submission
Transaction Manager status: The submission form status is "Submitted" or "Completed”, the signature status is "Completed" and the signature
type is "ESignature".
If all the previous steps have been completed, the submission is now complete from the user's perspective.
® Reject electronically signed submission
Transaction Manager status: The submission form status is "Submitted”, the signature status is "Cancelled" and the signature type is
"ESignature".
Next actions: None - as the user has rejected the submission, it cannot progress further. If this is configured, the submitted data may be
delivered as part of abandonment delivery.
® Sign the form
Transaction Manager Status: The submission form status is "Submitted" or "Completed", the signature status is "Completed" and the signature
type is "Wet".
If all the previous steps have been completed, the submission is now complete from the user's perspective.

Please note that some of these actions may not occur or happen in a different order (e.g. attachments and payment can generally completed in either

order).
Tasks performed by Transaction Manager:
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® Receipt Render
This is done for a form that has been submitted, either when the user requests a receipt or otherwise as part of a routine job. If a form requires
eSignatures, the receipt that is generated will contain the electronic signature of the organization hosting the form.

® Virus scan
This is done for submissions with attachments, if a virus scanning service is configured. If applicable, submissions are not considered complete
until virus scanning has been done.

® Delivery
This is the final step and happens only once the user has completed the submission and all other Transaction Manager tasks have also been
completed successfully.

Please note that during certain stages, the submission can go into an error state. An example for an error to be corrected by the user is a payment error,
which is often caused by invalid credit card details. An example for an error occurring during Transaction Manager processing is a delivery error, which
might be caused by invalid delivery email addresses.

Transaction Manager will indicate the status, including errors, in the submission log.

Browsing and Filtering Submissions

To view the list of all submissions, go to "Operations > Form Transactions".
Form Transactions

Home Dashboard » Form Transactions

Form Status j Start Date j Clear

Attachments j Baymenis j Email Verification :J Delvery j End Date :
Tracking
1] Cod Form Org. Time Space User | Contact Email  Payment Tesi Transaction Status Action
15 Jul De Ready, Method Mot "
§1144 LBEMBZ BCC-CC11046 Bee g Gov Assist O
15:22 Configured
- -
B1124  SMODWX TField custom files MiroTestOrg 15 Jul Transactfiekd mibotka Form Saved =
12:14 App
Delivery Resdy. Method Not y =
51120 XEBJCR TField custom files MiroTestOrg :ff;' Gov Assist o “”l[j’f Hetfiod Mot 2
= e - 15 Jul . . . & & T
E1110 WRBSWE Credit Card Application maguire 1011 Maguire ieff nhnson@avoks com Delivery Completed # S
mrmrm e = - 14 Jul . X, 1T
61037 WFNOYW ELIS Inspector's Order WESPOW 1722 Maguire gerook Delivery Ready -
P - . o . 14 Jul _ . i, T
61036 G40QH4E ELIS Inspector's Order WESPOW 1718 Maguire jclagnan Delivery Ready
ad 3 . = A 14 Jul 1T
61034 VZEPXT ELIS Inspector's Order WESPOW 1710 Maguire jclagnan Delivery Ready
o iene TFiekd - MFW-602 - 08 Jul TransactFieid R , T
60593 HIZEPS et DAS s e jclagnan Form Saved
o - 08 Jul TransactFieid i, T
5051 TaLACA T - MFW-E02 - Fo d
60592 L4C. Fieid FW-602 - Chiid DAS 1526 App jciagnan m Saved
B0ST1 77CSLS Attachment Form te1 ;‘7‘ b Magure Delivery Completed
41 ¥ M-200f2,633 Export Data

The submission log

You canfilter this list by organization, the submission ID or key, a substring of the form name, receipt / tracking number, the login name or email address
of the user who made the submission, submission date, as well as form, attachment, payment, email verification and delivery status.

The key column is "Transaction Status" which shows a message indicating the current status (see the previous section for details about the submission
life cycle). Depending on the status, various actions will be available, which are described in greater detail below.

Submission-Related Actions

For each submission, Transaction Manager allows you to view additional information or take action as appropriate. These actions are displayed in the
"Action” column (see screenshot above). Depending on the submission's current status, different actions will be available.
The available actions are:

® View Details (  *)
Availability: Always
Opens the "View Form Transaction" page (see _sec_submissiondetails) for the selected submission

® Open Saved Form ('3;})
Availability: Saved forms
Opens the saved form, which can be completed by the administrator on behalf of the user (e.g. as part of a support request). As this is a
sensitive operation, this action is only available to administrators whose roles include the permission "Submission Save Edit".

® View Receipt ( <=)
Availability: Submitted forms, unless submission data is unavailable
Opens the form receipt.

® Form Attachments (%)
Availability: Submitted forms for which attachments are outstanding
Opens the "Form Attachments" page on the user space. You can send the URL to anonymous users who have lost access to their submission
(e.g. by closing the browser window).

® Credit Card Payment Page ( =)
Availability: Submitted forms for which credit card payment is outstanding
Opens the payment page on the user space where credit card payment can be made. This can be used when a space user contacts support to
assist them with their credit card payment. The support administrator can then access the credit card payment page and enter the user's details.

® Retry Delivery ( “i“)
Availability: Completed forms where delivery has not been completed and submission data is available
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Attempts to deliver the submission to the current delivery details set up in the form. This can be used to retry delivery, e.g. after changing
delivery details. For submissions with email delivery, this action can also be used after delivery has been completed.

® Retry Delivery from Scratch ( ‘L)
Availability: Completed forms where delivery has not been completed and submission data is available
Attempts to deliver the submission to the current delivery details set up in the form after deleting all existing delivery checkpoints for the
submission. If no delivery checkpoints exist, this is equivalent to the retry delivery option above.

® View Email Delivery Confirmation (L)
Availability: Submissions with secure email delivery waiting for acknowledgment, where submission data is available
Opens the "Email Delivery" page that allows authorized administrators to acknowledge delivery of a submission. This only applies if the delivery
method is "Email Secure" (see Delivery Configuration (Manager v5.0)#_sec_secureemaildelivery).
Note that this works only if the submission data has not been deleted.

These actions can be very valuable for finding out what happened to a submission and make the submission log the best starting point when
investigating submission-related issues.

Submission Details

Each submission is described in more detail on its own page, including the various statuses, the submitter's browser and PDF viewer version,
attachments, payment, previous submission stages, data extracted from the submission, errors and events associated with the submission, the current
processing status at the organization, and optionally auditing information.

To view this page, go to "Operations > Form Transactions", find the submission and click the "View Details" ( ) action. You will be directed to the
"View Form Transaction" page for that submission.

Transaction Details

Home Dashboard » Form Transactions » Transaction Details

Transaction Details ] Transaction Status ] Request | History | Form XML Data Attachments [ Payment | Processing Status ] Events

Transaction Defails

Submission D

345
Tracking Code DNFPXE
Receipt Number cpfdcd-9
Submission Key BOfalBec2b141695bfd 10dadBecc5589

Form Details

Form Name
Version
Organization
Portal
Form Test Mode
Form Status
Submitied Time
User Information

Created By

Completed By

User Profile

Time Taken te Submit
User Operating System

User Browser

Card Payment Form

1.0

Lena Test Client (4.0
Maguire

true

Completed

28 Feb 2014 12.55:42 PM

Ipammer
|pammer
My Profile
17 seconds
Windows 7

Firefox 27

Viewing submission details

Basic Submission Details

The "Transaction Details" tab shown above lists basic submission data. This section describes some fields of interest.

Submit Key: An alternate key uniquely identifying the submission. This key, as opposed to the submission ID, is not generated by the database and will
therefore persist through database migrations.

Tracking Code: The tracking code is a short random alphanumeric code that is generated when the form is opened. By default, it is displayed to the user
as a reference number for the submission. See Form Configuration (Manager v5.0)#_sec_trackingcode for more on tracking codes.

Receipt Number: Another unique identifier for the submission, the receipt number is generated at save/submission time and can be displayed on the
receipt. The receipt number can be generated according to your specifications; please refer to Form Configuration (Manager v5.0)#_sec_trackingcode fo
r more information. You can also configure your form to use the receipt number in place of the tracking code.

Form Test Mode: Indicates whether the submission was made when the form was in test mode or not. This can be used in reporting as well as in
determining which set of delivery details will be used (test or production).

Task Key: The task key of the task associated with this submission, if applicable (see Tasks (Manager v5.0) for more on tasks).

Form XML Hash: A hash value calculated from the submitted XML data. This is used during web service delivery to verify that submission data has been
transferred correctly. The hash is kept even if the XML data for a submission has been deleted.

User Information section: This section displays important information about the user(s) involved in the submission. The information displayed depends
on submission status and history.
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Contact Email Address: The user's email address. This is automatically extracted from the submitted XML data if the configuration mapping "Contact
Email Address" is set for the form data configuration (see Form Version Configuration (Manager v5.0)#_sec_configurationmappings).

Offline Submission (PDF forms only): This field indicates whether a submission was made via the browser (online) or via a form that was saved to the
user's computer (offline).

Submission Status Values

The "Transaction Status" tab contains all status variables relevant to the submission. See _sec_submissionlifecycle for an outline of the basic
submission life cycle.

Transaction Details
Home Dashboard » Transachion Details

jon Details | T jon Status | Request | History | FormXMLData | FormDataExtract | Processing Status | Events | Ermors |

User Transaction Flow Steps

Form Opened Time 15 Jul 2015 10:11:09 AM
Form Submitted Time 15 Jul 2015 10:11:31 AM
Last User Activity Time 15 .Jul 2015 11:41:10 AM
Form Completed Time 15 Jul 2015 10:11:31 AM

Form Status | Completed j
PDF Receipt Generation
Receipt Status | Completed j
Receipt Render Duration (ms) 2553
Receipt Render Time 15 Jul 2015 10:26:58 AM

Receipt Render Attempts 2
Transaction Data Delivery

Delivery Channel Trash Can Delivery
Defvery Status | Completed j
Defivery Time 15 Jul 2015 10-26:59 AM
Delvery Message Delivered via process - Trash Can Delvery Process

Delivery Method  Delivery Process
Transaction Data Purging
Scheduled Transaction Data Purge 22 Jul 2015 10:26:59 AM

Time to Purge Transaction Data 17 hours, 50 m'ru.te!l

Scheduled Transaction Record Purge 11 Jan 2016 10:11:31 AM

E Retry Delivery Close

Viewing the submission status

In addition, this tab lists some additional information about delivery, whether or not the submission data has been deleted and the current processing
status (see _sec_submissionprocessingstatus).

If the submission has not yet been completed (form status is "Assigned”, "Saved" or "Submitted"), administrators can set the status to "Abandoned". This
can be used to manually expire a submission and prevent the user from accessing it again.

Transaction Manager allows you to manually mark an outstanding payment to be completed. This should be done only if payment for a submission has
been made outside of Transaction Manager. To mark payment as completed, select "Completed” from the "Payment Status" dropdown and click "Save".
An entry will be added to the event and audit logs.

Similarly, you can mark submission attachments as "Completed" if required. If the form status is "Submitted" and attachments are outstanding, you can
change the value of the "Attachments Status" dropdown to "Completed" and save.

You can also change the status of submission email verification (if applicable). Submission email verification means that an email is sent to the user's
email address (as entered into the form) and the user must click on a link in this email to complete the submission (see also _sec_submissionemailverific
ation).You can manually set submission email verification to completed or reset it to required status to restart the email verification process.

If the receipt needs to be regenerated (e.g. due to errors in the receipting process), you can manually change the receipt status from "Completed" to
"Ready" and save. If the submission data is still available, this will cause TM to regenerate the receipt. Once this is done, you can then choose to
redeliver the submission if necessary (see below).

Transaction Manager also allows you to change the delivery status of a submission. This should be done only for three purposes: Marking a submission
as undeliverable, marking delivery as completed, and marking delivery as ready so a submission is delivered a second time. Note also that marking a
submission as undeliverable affects only submission delivery, and should not be used in other scenarios.

Note that you cannot progress submissions which are not yet ready for delivery, and that you cannot modify the delivery status of submissions for which
no submission data is available (e.g. because it has already been purged).

To change a submission's delivery status, choose the new status from the "Delivery Status" dropdown and save. The status will be updated, and the

delivery message will indicate that the status was manually modified. In addition, an entry will be added to the audit log (entity name "Submission").
For more options on submission delivery monitoring and bulk status changes, please refer to Delivery Configuration (Manager v5.0)#_monitordelivery.

Attachments

The "Attachments" tab shows the set of attachments associated with the form and allows you to view individual attachments. Please refer to Managing
Form Attachments (Manager v5.0)#_sec_viewattachmentsforsubmission for an in-depth description.
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Transaction Details

Mome Dashboard » Form Transactions » Transaction Details

Trm Dun] mM|M]mw|amnmm.|mmm[Em|
Required Attachments
Attachment Name Required Max No. Max Size File Types Submil Method Doc Type
Aftachment Limé fp Ong + 1
machment Small SNE o 4.8 MB
Essential-fre there RCD's 50 MB
Limt To One Max Resolution 500 4 1
Submitted Attachments
Attachment = File - - User Virus  Delivery = -
[} T File Name " Submitted T - Deleted File Data Hash [ SHA-266] Action
Name: Ll Size "™ Description Status  Status ! sh{ J "
6365 Attachment  Upioad af_T00C21Z8578f4cSab29361483/e62137 jpg  4WB Electronicaly 12 Clean  Completed g 6121c0ab51032e6d067d19754b08bca0552 cobb2B1 1 actb 163772005 e THT
Limt to One: May
1W0:38
6365 LimtToOne Upioad afi 1067304 705ec433550505500407Ze44 pg 4 KB Elkctronicaly 12 Clean  Completed ¢ Lt TeciadZ!
Wax May
Resoltion 1038
500
B3E7 Aflachmeni Upload afi_fEb11400b47d44300454e02bed3b380e pg 1,055 Elecironicaly 12 Clean  Completed ] 57 1134, hEAT
Small SMB KB May
10:38
6368 Essentislire Upoad af O5b1ad037al74770sedBdasdd1adScidjpg 2228 Electronicaly 12 Clean  Completed 4  04cSOcedb2dBB0142501151021df3307MTdEM 445034007 2cBoe | bAHO0Sa04
there ACD's ] May
10:39
Files Total Size: 2261 KB
In-Form Aftachments Used [T @

Viewing the attachments for a submission

Payment
The "Payment" tab displays information about the payment associated with the submission. This includes the payment status, payment type (e.g. credit
card) and some payment-type specific fields.

Transaction Details

Home D » Form Trar i + Transaction Details

T Details | Tr ion Status ] Reguest | History I Form XML Data Payment | Processing Status | Events |

Payment Details
Payment Status  Completed

Payment Type Credi/Debi Card

Payment Total  132.0
Card Transaction Details
Payment Transaction 10

Payment Service Code  Bizgate
Digital Order Time  Tue Feb 25 15:51:32 EST 2004
Digital Response Receipt Number  BZ-0021485226

Digital Response Txn Message Transaction approved

Submission payment status

Form Sessions

The "Form Sessions" tab shows the set of form requests made as part of this submission. One request is made when the submission is started, and
additional requests may occur as the submission is saved and reopened.

Each request can be inspected by clicking the "View" link ( '“‘?). See section _sec_viewrequestlog on the information available for each request.

Transaction Details

Home D b FormTr. i b Tr tion Details
T ion Details | Ti ion Status Form Sessions | History | Form XML Data Form Data Extract Processing Status Life Cycle Audit
Time Version Space Session Duration User Device User's 05/Browser IP Address Referer Action
10 May 09:31:08 2.0 Maguire 4 minutes, 25 seconds Desktop Windows 10/ Firefox 46 114.141.100.202 https:/ftm.test1.avoka. comimanager/admin/form/form-search.htm?_wid=31 ':.!..\

The form sessions for a submission

Form XML Data

The "Form XML Data" tab displays the XML data submitted by the user. Under very specific circumstances (the form has been completed by the user,
form data has not yet been purged, and an error is preventing receipt generation or delivery), the XML data can be edited by administrators with the
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appropriate permissions. This can be useful if the user has entered characters that cause issues with back end processing, which the administrator can
then remove to allow delivery to proceed.

Because viewing and editing the form data is a very sensitive operation, permissions are used to control access to the tab ("Submission Xml Data View'

for read-only access, "Submission Xml Data Edit" to be able to modify the XML).In addition, whenever an administrator views or changes the data, TM
logs the operation to the audit log. When an administrator changes the data and saves the changes, the resulting XML is verified and stored as a new
submission history entry (see following section on the submission history), preserving the data previously submitted by the user.

Transaction Details

Home Dashboard » Form Transactions » Transaction Details

Payment | Form XML Data | FormData Extract | Processing Status | History | Defivery Checkpaints | Events | Errors |

Form XML Data

Save Data

<Te =:Vr~a=>£a1:a< Te =—Urc=>

—&I

ame>lpammer</IserHame>

TyP

rvlet/FormDynamicDataServliet</FormDataServiceURL>
LogKey>

Frame</HostContext>

erSubmitted</SubmissionType>

//tm_dev_avoka.com/finance/secure/form nem?formCode=tgf2-1redbc/Referar>

s

umbe.
Submis

>
zenshiph

</attacrhmenta>

r>2</RevisionNumber>
sionld>3715fcdb4dadb4ldcadlb3dsT7405e70c08</0:

neSubmissionld>

_ce[‘a:ap:—t"’
se</ ) 1Cex LJ.___Q.EJ
r_‘ute>ialn< P

ule>

Viewing the submitted XML

Submission History

The "History" tab shows the list of all versions of a submission. A version is created when a submission assigned (task submission only), when the user
opens a form, every time a submission is saved to Transaction Manager and, finally, when it is submitted. For each version, the submission XML is

stored and can be accessed by clicking on the "View XML" icon (. For each version but the current one, you can also click the "View XML Diff" icon (

to see how that version is different to the current XML.
For auditing purposes, the IP address and user agent related information is also logged for each submission history entry.

Transaction Details
Home Dashboard » Form Transactions » Transaction Detais

The version history of a submission

Transaction Detalls | Tr Status | Reguest | History | FormxuLData | Attachments | Processing Status | Events |
Form ; _ Time to User's 05/
Status Version Time  Portal Submit User B = IP Address Form XML Hash | SHA256)
Form 10 12 Mar  Maguire - Windows 7/ 114.141.100.97 c5573897b7ed109aB4cB8d4b46511 feTBBE6aTd1cT1936C974119670ebb9BIET 3 0
Opened 16:41 Firefox 27
Form 10 12 Mar Maguire 7 seconds Windows 7/  114.141.100.97 f850b8aT8822273d32363813M aceasalaTIacabi348a4cd46C331960T04acET 3 Q)
Saved 16:41 Firefox 27
Form 10 12Mar Magure 6seconds lpammer Windows7/ 11414110097 B0416451aeaB516646160b09939ccS5072779002b123ee9c7b33221ed0648120 [2) @)
Saved 16:42 Firefox 27
Form 10 12Mar Maguire § seconds Windows 7/ 114.141.100.97 Sded8d767b3163626c55a473265a110915020015a969153167d7 09063 122008 ':'-] @
Saved 16:43 Firefox 27
Farm 1.0 12Mar  Maguire 10 pammer Windows 7/ 114.141.100.97 300614812b713cb6917720403241260b8T 76802003127 555622455320283401 1'-]
Submitted 16:44 seconds Firefox 27

Submission Events and Errors

In addition, you can see any errors or events that were logged against the submission by navigating to the "Events" and "Errors" tabs. In the example
shown below, there are events showing when payments, attachments and signatures were completed. The submission event log also records delivery

events.
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Transaction Details
Home Dashboard » Form Transactions » Transaction Detais

Transaction Detais | Tr status | Request | History | FormXMLDsts | Atiachments | Processing Staws | Events
ID  Event Time Event Type Message Action
5518 12 Mar 2014 16:47:53 Info Defvered via process : Deliver To Directory Process

5517 12 Mar 2014 16:44:08 Info Aftachments completed by ipammer for submission (receipt no. cpf-Bc4-22). User's remote [P address was 114.141.100.97, and
browser user-agent was: Mozilla/5.0 (Windows NT 6.1; WOWSE4,; rv-27.0) Gecko/20100101 Firefox/27.0

Viewing submission-related events
These tabs can be very helpful when debugging submission errors. However, we also recommend searching the error log around the time of the defect.

Submission Properties

Submissions can have a set of arbitrary properties (key-value pairs). For example, these properties may be generated and referenced by Groovy
services to store additional status values for the submission.

To view the list of submission properties, view submission details and switch to the "Properties" tab. Note that the tab is present only if submission
properties exist and your user has permission to view submission data.

Transaction Details

Home Dashboard » Form Transactions » Transaction Details

Transaction Details ] Transaction Status | Request ] History I Form XML Data Attachments ] Processing Status Dekvery Checkpoints | Events I Properties

Hame Value
docusignStatus  declined

envelopeld 179222a1-aT02-4eaa-b124-0953fd44a519

The set of properties for a submission

Delivery Checkpoints

Complex delivery services may include multiple steps that need to be completed. If a delivery failure occurs, it may be important to know which step
failed (both for debugging purposes and in order to be able to retry delivery in such a way that previously completed steps are repeated only as
necessary).

Transaction Manager allows delivery services to record arbitrary checkpoints as they proceed through delivery for a submission, and query existing
checkpoints to ensure the correct behavior is executed in case of a retry after a previous delivery failure.Because delivery services can execute custom
logic (e.g. a Groovy script), TM does not have any knowledge of delivery checkpoint semantics but merely provides an easily accessible API to record
and query existing checkpoints. In addition, administrators can manually delete delivery checkpoints if necessary.

To view the list of delivery checkpoints for a submission, view submission details and switch to the "Delivery Checkpoints" tab. Note that most delivery
services will not record checkpoint information; for a custom Groovy service, you have to determine which checkpoints make sense for a customized
delivery service and then enhance the Groovy script to log checkpoints and potentially execute smart retry behavior by querying which checkpoints are
already present.

Transaction Details

Home Dashboard » Form Transactions » Transaction Detais

Submission Detais | Transaction Status | Aftachments | Payment | DataExtract | Processing Status [ History | Delivery Checkpoints | Events [ Errors |

Checkpoint Name Status Description Time Delivery Service Action
Process Status Update Registered Update submission processing status 17 Apr 2013 09:06:20 Groovy Customer Email Delivery Process &7
Process Status Update Completed 17 Apr 2013 09:08:20 Groovy Customer Email Delivery Process z
Email Customer Registered Send thank you email to customer AT Apr 2013 09:08:20 Groovy Customer Email Delivery Process E
Email Customer Error Unknown SMTP host: test-idap 1T Apr 2013 09:08:20 Groovy Customer Email Delivery Process :

The list of submission delivery checkpoints for a submission
Please refer to the Transact Integration Guide, section "Delivery Checkpoints" for an example Groovy script.

Processing Status

In addition to the Transaction Manager status values described earlier, there is also a status variable called "Processing Status". This value is used to
indicate whether the organization has started processing the submission and what the current status is. It can be updated by the organization using a
web service call. Refer to the separately provided TIA Administration Guide for more information.

In the Example Self Service Space, users can elect to be notified when the processing status for one of their submission changes.

The "Processing Status" tab shows the history of all changes made to the processing status, along with the time that the change was made and the user
who made the change.
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Transaction Details
Home Dashboard » Form Transactions ¢ Transaction Details

Transaction Details | Transaction Status | Request | History | Form)LDsta | Processing Status

Processzing Statuz  Created At Created By
Pending 2B Mar 2014 13:13  Ipammer
Approved 28 Mar 2014 13:15  Ipammer
Completed 26 Mar 2014 13:16  Ipammer

o3 o

Processing status entries for a submission

You can also manually update the processing status by clicking "New". On the "Edit Submission Processing Status" page, enter the new processing
status. If the submission is associated with a Transaction Manager space user, you can tick "Send Email Notification" to make sure the user is notified of
the status change.

Edit Submission Processing Status

Home = Form Transactions > Transaction Details = Submission Processing Status

Processing Status* |Approved
Send Email Notification [~

Save Cancel

Updating the processing status

Data Extract Values

Transaction Manager can be instructed to extract items of interest from the submitted XML and store them separately (see Form Version Configuration
(Manager v5.0)#_setupdataextractmappings on how to set up data extract mappings).

To view extracted data, edit the submission and switch to the "Data Extract" tab. As shown below, all items extracted from the submission will be shown,
with the concrete value for the current submission listed in the "Value" column.

Transaction Details

Home: D » FormTi ns » Transaction Detals

Transaction Detads | Transaction Status | Request | History | FormXMLData | Form DataExtract | Processing Status | Events |

Hame Value Form XPath

First Name John IAvokaSmartForm/GettingStarted/AboufvowFirstname

Last Name Doe Tovok o tiing YoulSumams

Phone Number 30388776855 IAvokaSmartForm/GettingStarted/Aboulyouw/contact/Phonenumber
Email Address john doe@test com [AvokaSmartForm/Getfi You/cont iladdress

R

Delete Close

Viewing data extracted from the submission XML
You can delete all values if necessary, or reload the values from the submission XML using the configured data extract mappings by clicking "Reload".

Life Cycle Audit

Submissions can process through a number of different steps. While TM offers ways to track all possible steps and events, it can be hard to get the full
picture of what happened in which order. To help with this, TM provides a full life cycle audit for each submission.

To access the life cycle audit, view the submission and switch to the "Life Cycle Audit" tab.

Transaction Details
Home Dashboard » Transaction Details

Transaction Details | Transaction Status Form Sessions | History | Form XML Data Form Data Extract Processing Status Life Cycle Audit L

Event Time Audit Event Action
9:31:08 AWM/ 10 May 2016 Form Session - Form Request, User Agent. Windows 10/ Firefox 46, Remote Address: 114.141.100.202 '»-fi__
9:31:08 AM /10 May 2018 Submission History - Form Opened, User Agent: Windows 10 / Firefox 46, Remote Address: 114.141.100.202
59:31.08 AM /10 May 2018 Transaction - Form Opened

5:35:33 AM /10 May 2018 Transaction - Form Submitted

9:35:34 AM /10 May 2016 Submission History - Form Submitted, User Agent: Windows 10/ Firefox 46, Remote Address: 114.141.100.202
9:35:34 AWM /10 May 2016 Transaction - Form Completed

5:35:34 AM /10 May 2018 Transaction - Last User Activity

5:40:26 AM /10 May 2018 Receipt Request - PDF Receipt Render for Delivery 'J__

5:40:29 AM /10 May 2018 Transaction - PDF Receipt Completed

Viewing a submission's life cycle
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Form Submission Data

The form submission data page lists the submission data extract values for a set of submission in tabular form. It can be used to quickly review the
extracted data for multiple submissions.
To view form submission data, go to "Operations > Form Submission Data". Select a form and form version and possibly a date range, and click "View".

Form Submission Data
Home Dashbosrd » Fors Sebmssion Dats

Fom  Customer Oriboasding :J\ntrsnn 20 =] fomStatus | Completsd jacmeew W Start Oate =] vt Dt = m Chaar
0 ing i Time itted Form Statss Device First Name Last Name Phone Number Emad Product Credit Cards Product Insurance  Action

20708 ZBGNZE onboard-customerf 22 0ct 141331 Complated Desiiop Karl Jones 293599099 bwnmeriiavals com true trug J

W75 WRGWZZ caboard-ceMtomes-5 220ct 141323 Complled  Desklop Sem Jones 0299999999 Lwamer(iaveks com frue true a

20659 CVTI3E enboard-customer—4 27 0ct 14 1334 Compieted Deskiop Tom Jones 029999999 o amerfavoks com  true true “_ a

20655 BAMWVE onboard-customer-3 220ct 141315 Compieted  Deskiop BN Wamer 0099999955  bwomerfavokacom true true T o

0688 LTSTR onboard-customer-2 220t 141308  Competed  Deskiop Ben Warner 10295050000 bwomeriiavoka com true true ha

20635 RIGKEH eaboard-customes-] 22021 141307 Cospliled Desldep Ban Warnaf 255550090 bwansrlaviks com true trug 4

Viewing submission data extract values for a form

Each entry corresponds to a submission for which data extract mappings were defined at submission time, and data was extracted. You can navigate to

. @ . o
the submission details (%), or view the receipt ( =).
You can also export the entire set of entries as an Excel file by clicking the "Export Data" link below the table.

Saved Submissions

Transaction Manager provides a specialized page showing saved submissions only. To access it, go to "Operations > Saved Transactions".
Saved Transactions

Home Dashboard » Saved Transactions

Transaction Score Space j Start Date G End Date D

D 2:;:‘““ Opened  Saved ‘?J".‘:': User | Contact Email Comnle:: Tra;arc:ion Form Space mﬁs ! Action
60592 TILACA :g :i' E::Jz:' iclagnan TField - MFW-E02 - Child 1:;”"”“’ g;“"”"“ TiChrome T

60363 BETIXK S P TFied - F¥£02 - lr::samField :;-;ehu:g] 81/ et o

L il — e

soe7a avxkep ol T2 v TR Covasmat  WPews7icwum @R
59652 BLIBYQ gg:jﬁ" v jphn doe@test.com EE:;%'ZFFS:“E'U"Q " Maguire é":::g:i f-” @70
59653 2H22L8 P v john doe@test.com pustomer OnboAING - yaguie @n
595498 NPTPWL g1l m.JUI v penny Bnefavoka.com Credit Card Application  Maguire Widows 10/Frefox @ T

11:40 11:41 38

58437 HR3265 33::“ 3?:#“ v Test page change Maguire g:::::::‘l b @ -
58096 WIDBWH fgél;n ?g:}usn J Test POF Form Maguire grldnws T I Firefox @h
58990 6GETMV fg";:" ‘1?2;‘:" v e ehakease tant S et e gsf;rgnnel?momle QN
4 » M-4001435 BportDsta

The list of saved submissions
You can filter the list by organization, form code, submission OID, tracking and receipt number, minimum transaction score, space and saved time.
For each saved submission, you can view submission details by clicking the link in the "ID" or "Tracking Code" columns. If the submission supports it,

you can open it by clicking the "Open Saved Form" action ('3). This can be useful if users ask for help in completing their submissions.As long as

-y
submission data is available, you can also view the receipt for the currently filled in data by clicking the "View Receipt" action ( =).

Abandoned Submissions

Transaction Manager provides a list of abandoned submissions, which includes submissions abandoned by users (explicitly by clicking a button to
abandon the submission, or implicitly by closing the browser or never returning to a saved form) and submissions marked as abandoned by
administrators. You can access the list of abandoned submissions via "Operations > Abandoned Transactions".

149



Abandoned Transactions

Home Dashboard » Abandoned Transactions

Transaction Score Start Date Clear
Space j Abandonment Type j End Date
D E':;:i“g Form Org. ;:;x" ‘:‘J':;': User/ContactEmail pm: T m; ;u" ;“;n Action
61126 VADTOW Aok Showcass Form maguire 15 Jul 12:42 mbotka User © R
Maguire - 4.

61003 B45SYF Attach Rule Teat maguire 14 Jul 10228 o User
G0506 X26TTR Test Child Form - ¥ G maguire 0% Jul 16:28 yoitaavoka.com User "4 '“‘_
60505 KNT4AW Test Parent Form - YG maguire 09 Jul 16:28 yoitag@avoka.com User "1
60343 GSBLHPJ Payment Form t418 08 Jul 12221 < System
50656 ZK2AMS Credi Card Application maguire 02 Jul 15:13 < effiohnson@avoks com User Out of Time
SBERS XNACSW4 Credi Card Application maguire 02 Jul 15:10 L ffphnscni@avoka com User
59694 WsBEQD Credit Card Application maguire 02 Jul 15:09 o it phnsoni@avoka com User
59692 XFEKPT Credit Card Application maguire 02 Jul 15:06 < ff.ioh ¥ User Changed Mind
SE4TOD WEMITV BCC-CA21T BCC 22 Jun 16:23 < User

» 110 of 402 Export Data

The list of abandoned submissions

You canfilter the list by organization, form code, submission OID, tracking and receipt number, abandonment type ("User" denoting explicit user
abandonment, "System" implicit user abandonment and "Administrator" submissions abandoned by an administrator), minimum transaction score, space
and last user activity time.

If submission data is present, you can revert the submission into "Saved" status (e.g. if the original submitter would like to complete the submission now)

} -y
by using the "Make Abandoned Transaction Saved" action ( r-f-ﬁ) or view the receipt by using the "View Receipt" action ( <=).

Request Log

The request log contains information about user requests for forms and receipts; i.e. whenever a user opens a form, a request log entry is created and
associated with the submission log entry. Like the submission log, the request log contains information that can be very helpful in reporting and
debugging.

Browsing the Request Log

To view the request log, go to "Operations > Form Requests". You will see the list of requests for forms or receipts as pictured below.
Form Requests

Home Dashboard » Form Requests

Form Name Render Made Form _=| Portal Server = Start Date Clear
Version Receipt Mode ;I Form Server ;J End Date
- - Render Form Size Prepare Render Load Total -
1D Form Name 0Org. Time Version Mode Portal Server r—— (KB) (ms) (ms} (ms) (ms) Action
1262 CakendarFutirePast—. DAS 0t AP 10 Form mtest2 - TH %16 138 123 3 64 SEE
10:54 Server
1261 CalendarFuture.Past-_ DAS 01 AP 10 Form tm-test2 - TH 3375 137 8 2 s SR E
10:53 Server
01 Apr tm-test2 - TM . A @ E
1260 Calendar Future-Past - Das 10:45 10 Form Server 3375 162 m 2 Z75
1259 Test Form— HTML frankOrg 01 Mar 10 Form tm-test2 - TH 5817 170 11 3 18 & B E]
15:24 Server
1258 Test Form - HTML frankorg 31 Mar 1.0 Form tm-fest2 - TH 5817 201 9 3 23 S RE
1521 Server
New Feature - Create 31 Mar tm-test2 - TM A, @ E
c ; E
== @ DAS 1300 s Ao Server =Xt i = ! 1 .
=~ RuleAvalancheTest- 28 Mar tm-test2 - TM ' -4 5
252 DAS  q1ap o Form Server -
_ § 27 Mar tm-test2 - TM a4 @ E
1249 Formbridge - Submit-.. DAS e 1.0 Form e — -
27 War tm-tesi2 - TM - i, @ E
1246 Bugs - HTML DAS 14:58 1.0 Form S 4576 210 108 3 kg
447 Acme Post Example - 27 Mar tm-test2 - TM Q@ E
128 DAS  yoq7 L EOTR Server =
» 1-10 of 582 Export Data

Viewing the request log

You can filter the request log by organization, the form name, the form version, the "Render Mode" ("Form" to display only requests made for forms,
"Receipt" to display only requests made for receipts), the "Receipt Mode" for receipt requests ("Web" indicating that the receipt was requested by a user
via a web browser, "Email" indicating that the receipt was generated when a space user asked for an email copy, "Delivery" indicating that the receipt
was generated during submission delivery), the server node serving the request and the request date and time.

You can also export the search results to Excel by clicking the "Export Data" link below the table.

The request list shows the basic data (organization, form, form version, request time, render mode) as well as some performance-related measurements
(note that the latter are logged only if the form was rendered successfully).

The "Size (KB)" column shows the size of the form produced by the render process.

The "Prepare (ms)" column contains the time it took to prepare the render request (including creating the request log entry). The "Render (ms)" column
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contains the time it took to render the form on the server. The "Load (ms)" contains the time that was needed to stream the rendered form to the user's
browser. The "Total (ms)" column contains the total time from when the request was made to when the form was displayed in the browser.

You can view detailed information on each request (see the following section) by clicking the "View" icon ( ). You can view the submission associated
with the request by clicking the "View Submission Details" icon ( d ), and the form that was requested by clicking the "View Form Details (IEI) icon.

Viewing a Request

If you want to view detailed information about a form request (e.g. IP address or referer), go to "Operations > Form Requests", locate the request and
click the "View Details" icon (). You will see the "View Form Request" page.

Request Details
Home Dashboard » Form Reguests ¢ Reguest Details

1]

Request Key

Request Tmestamp
Datetime Created
Datetime Compieted
Render Mode

Portal

Organization

Form Name

Form Type

Form Test Mode
Template Version

Form Render Size (bytes)
Form Streamed Size (bytes)
Render Time (ms)
Browser Load Time (ms)
Total Time (ms)

Request Cancelied
Portal Server

P Address

Referer

User Agent Header

1262

Tcf Jacf T58bb 14c6a37aZe 1ad4c348e2
01 Por 2014 10:54:13

01 Apr 2014 10:54:13

01 Apr 2014 10:54:13

Form

Gov Assist

Administrative Services
Calendar Future-Past - HTML
Composer SmartForm

false

1.0

47124

6731

false

tmiest2 - TM Server

114.141.100.57

Hitps://tm test2 avoka com./manager/admin form/fom-eadit him Aab Panelindex=08sntityld=102

Mozila/5.0 (Windows NT 6.1; WOWE4) AppleWebKit/537.36 (KHTML. lke Gecko) Chrome/33.0.1750.154 Safan/537 36

Browser

Chrome 33
Operating System Windows 7
Request URL  hitps://tm test2 avoka com./govassist./senviet,/Smart Form html
Request Method GET

Request Content Length -1

Request Query formCode=calendarfuture-past
Request Cookie  JSESSIONID=kGtUce80m SWshyb LtpB2MER; __utma=264857115,1017556760.1393540654.1353308526.1396217784.3; __utmc=264897119; _utmz=264857115.13935
Submission Count [

Submission D 321

Close

Viewing detailed request information

The "View Form Request" page shows a number of fields containing request log relevant data. Some of the important fields are described in this section.
Request Key: An alternate key uniquely identifying the request. This key, as opposed to the request ID, is not generated by the database and will
therefore persist through database migrations.

Form Type: The form type of the form being requested. See Form Configuration (Manager v5.0)#_sec_formtypes on the form types available.

Form Test Mode: Indicates whether the request was made when the form was in test mode or not. This can be used for reporting or debugging purposes.
Task: The task on which the request was based (if applicable).

Remote User / External User ID: The identifier of the user requesting the form (if the request was not anonymous). The fields displayed are "Remote
User" and "Profile Name" if the user space is using Transaction Manager user accounts, and "External User ID" and "External Profile ID" if the user
space is using a custom login mechanism (see Spaces (Manager v5.0)#_sec_standardspaceproperties for the space property controlling this behavior).
IP Address, Referer, Browser, User Agent Header: These fields contain data related to the user and their environment, which can be helpful for
debugging.

Referer: This field contains the referer HTML header. If the user accessed a form via the space landing page, this field will contain the referer that was
set when the user requested the landing page.

Request Query: This field shows the exact request made by the user's browser (basically the URL request parameters).

Request Cookie: This field shows the contents of the cookie header.

Submission Count: The number of submissions resulting from a form request. Transaction Manager by default will accept only a single submission and
reject subsequent ones (see Deployment Properties (Manager v5.0)#_sec_duplicateformsubmissions).

Submission Expiry Date: The date after which a submission for this request will be rejected.

Form Rendering Metrics
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You can get an overview on how fast forms are rendering by accessing "Operations > Form Rendering Metrics".

Form Rendering Metrics

Home Dashboard » Form Rendering Metrics

Form LI Version Start Date j Clear

Max Records 1,000 =] End Date :
Render Metric Average Median 95th Percentile Min Max Number
Form Prepare Time 100 ms 81 ms 245 ms & ms 2,017 ms 725
Form Render Time 1,074 ms | 199 ms 5392ms | 3Ims  21,139ms 738
Browser Load Time B4 ms Ims 383ms | Oms 2,240 ms 9
Total Render Time 1,367 ms | 382 ms 7568ms | 41ms 34694 ms 802

Viewing form rendering metrics

The table shows various metrics (including mean, median and range) of the total render time and its components for all form requests matching the
search criteria.

The total render time refers to the total time from when the request was made to when the form was displayed in the browser and includes three
subtasks shown as separate rows: The "Form Prepare Time" refers to the time it took to prepare the render request (including creating the request log
entry). The "Form Render Time" refers to the time it took to render the form on the server. The "Browser Load Time" contains the time that was needed
to stream the rendered form to the user's browser.

To change the set of form requests on which the metrics are based, enter different values into the search fields and click "Search". You can filter by form
and form version as well as render date. The "Max Records" field allows you to a limit on the number of requests to calculate the metrics from.

Note: If you choose a large number of records to use for calculation (the "Max Records" field), the metrics calculation may take longer.

Transaction Log
Transaction Manager keeps a record of the transactions occurring in your system for licensing purposes. You can review this information by accessing
"Reports > Transaction Log" and "Reports > Org Transaction Log" (the same data broken down by organization).

Transaction Log

Home Dashboard » Transaction Log

Transaction Type j Start Date j End Date: : Clear
1] Date Type Total Transactions LC Output LC Forms LC DSignatures LC Reader Extensions LC Proc Mgmt ield Add Look Action
7786 16Jun 2015 Standard 7 3 0 0 0 0 0 0
7799 16Jun 2015 Job 0 0 0 0 0 0 0 0
7785 15Jun 2015 Standard 20 18 L] o o o 1 L]
7798 15Jun 2015 Job 0 L] ] 0 o 0 0 L]
7784 14Jun 2015 Standard 1 0 0 0 0 o 0 0
7797 14 Jun 2015 Job 0 L] 0 0 0 0 0 L]
7783 13Jun 2015 Standard 1 0 0 0 0 0 0 0
7796 13Jun 2015 Job 0 0 0 0 0 ] 0 0
T782 12Jun 2015 Standard B 3 L] o 0 0 1 L]
7795 12Jun2015 Job 0 0 0 0 0 0 0 0
4 » T1-800f1,000 . Search resulls have been limited to 1,000 records. Expart Data

The transaction log

Transaction data is calculated and aggregated per day. Transactions mostly correspond to form submissions. Additional information such as usage of
Adobe LiveCycle modules or the TransactField App is also recorded. For further details on transaction licensing in Transaction Manager, please contact
your account manager.

Transaction Manager also provides four BIRT reports containing transaction information. Please see Reports (Manager v5.0)
#_sec_transactionsbydayreport onwards.

Event Log

The event log contains various messages logged by Transaction Manager, mostly of informative character. Examples for event log entries are messages
recording when Transaction Manager is itself started or shut down or when a submission is delivered to the organization.

To view the event log, go to "System > Event Log". You can filter the list of events by ID, type ("Info", "Warning", "Error" or "Security"), using a substring
of the message, the submission which the event relates to (where applicable) and the date and time the event was logged. The "Message Filter"
dropdown lets you control how the message substring is used in the search. You can include or exclude submission related events by using the
"Transactions Filter" dropdown.
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You can export the search results to Excel by clicking the "Export Data" link below the table.
Event Log

Home Dashboard » EventLog

Event ID Messzage Message Fitter | Like j Start Date | 05 Jan 2016 00:00 D Clear
Submigsion IO Event Type j Transactions Fitter j End Date D
1D Time Type Message Action
1430687 12 Jan 2016 12:23:45 Error Hybrid Cloud Submission Data Storage - w1 error, failing over to Database Submission Data Storage. @, a

143086 12 Jan 2016 12:23:45 Error System Alerts cannot be emailed because the system alert group "Receive System Alerts’ has no mem... @,

143065 12 Jan 2016 12:20:27 Info Delivered via process : Trash Can Delivery Process - v1 @ a,
143084 12 Jan 2018 12:20:27 Info Delivered via process : Trash Can Delivery Process - w1 b :". a
143083 12 Jan 2016 12:20:27 Info Delivered via process : Trash Can Delivery Process - v1 @, a
143062 12 Jan 2016 12:20:27 Info Delivered via process : Trash Can Delivery Process - v1 @ a,
143081 12 Jan 2018 12:20:26 Info Delivered via process : Trash Can Delivery Process - w1 4 a
143060 12 Jan 2016 1220:26 Info Delivered via process : Trash Can Delivery Process - v1 a, 2
143059 12 Jan 2016 12:20:26 Info Delivered via process : Trash Can Delivery Process - v1 @ a,
143058 12 Jan 2016 12:20:26 Info  Delivered via process : Trash Can Delivery Process - w1 b :". a
143057 12 Jan 2016 1220:26 Info Delivered via process : Trash Can Delivery Process - v1 Q@ 2
143056 12 Jan 2016 12:15:27 Info Delivered via process : Trash Can Delivery Process - v1 Q'
143055 12 Jan 2018 12:15:27  Info  Delivered via process : Trash Can Delivery Process - w1 4 a
143054 12 Jan 2016 121527 Info Delivered via process : Trash Can Delivery Process - v1 a, 2
143053 12 Jan 2016 12:15:27 Info Delivered via process : Trash Can Delivery Process - v1 @, a,

b 1-150f 20,841 Export Data

The event log

From this page, you can also view the details for each event using the "View Details" icon (). This takes you to the "View Event Log" page. Even
though this page does not contain any additional fields beyond what is shown in the event log table, it can be useful to see the full text content for long
messages.

Event Details

Home = Event Log » Event Details

[v] 6176

EventTime Mon Mar 05 14:49:20 EST 2012
Event Type |nfo

Submission 310

Payment by for i (receipt no. tpl-ntgov-810-29). User's remote IP address was 127.0.0.1, and browser gent was: zilla/5.0 (Wi NT 8.1;
WOWe4, rnv:10.0.2) Gecko/20100101 Firefox/10.0.2

Close

Details for an event log entry

Error Log

The error log is similar to the event log. However, messages logged to the error log are generally of a higher severity and may contain additional
information such as a stack trace and the request URL. Examples for error log entries are problems resulting from lost database connections, but also
faulty form data configurations or delivery errors due to misconfiguration.

To view the error log, go to "System > Error Log". You can filter the list by organization, using the error ID, the error name, a substring of the message,
the submission ID (where applicable) and the date and time the error was logged. The "Message Filter" dropdown lets you control how the message
substring is used in the search.

You can export the search results to Excel by clicking the "Export Data" link below the table.
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Error Log

Home Dashboard » Error Log

Error ID Message Message Fiter  Like j Start Date | 15 Jun 2015 00:00 : Clear

Submission ID Name Space = EndDate =
1] Time Name Message Space | Module TM Server Action

23 Jun 2015 . Transaction fm-test! - TM -1
49108 10-15:40 SocketException Broken pipe Manager o
49107 22 Jun 2015 chediad=arics o java.util.co B xceplion: xception: Audit Log Service tm-test! - TM o

12:00:01 Error:. Server

22 Jun 2015 Groovy Scheduled Service . o . - " tm-test! - TM :\
49106 12:00:01 Error ApplicationException: Audit Log Service Error: Error writing audit log data i

21 Jun 2015 java.util.co L.E: xceplion: L fion: Audit Log Service tm-test! - TM o,
pies 12:00:01 SoagEME S e Lob Error:... Server

21 Jun 2015 Groovy Scheduled Service § . . . X . tm-test! - TM Q
49088 12:00:01 Error ApplicationException: Audit Log Service Error: Error writing audit log data Server

20 Jun 2015 . java.util.concurrent ExecutionException; ApplicationException: Audit Log Service tm-test! - TM :«'__
49087 45 n0:01 = Error... Server

20 Jun 2015 Groovy Scheduled Service . - . fm-test! - TM &
49086 o 00 T ApplicationException: Audit Log Service Error: Error writing audit log data o

19 Jun 2015 . - Transaction tm-test] - TM \:(\
49077 o) ioag SocketException Connection reset Manager —

19 Jun 2015 - Phantom Rasterizer Emor ; exitCode=null himiFi fusrisfm. j fm-test! - TM @ 3
45076 20-57:51 Phantom Rasterizer Error Ideiveryl... i
49078 19.Ju|:| 2015 ScheduledServiceJob jﬂ'\fﬂ.l..llﬂ.u. it.E> xception: xception: Audit Log Service tm-test! - TM -

12:00:01 Error.. Server

4 b 121-1300f1,000 ' Search resulls have been imited to 1,000 records. Export Data

The error log

You can also view detailed information for each entry by clicking the "View Details" icon ( “J'r). This takes you to the "View Error Log" page for the entry.
In addition to the basic data displayed in the error log, you can also see the full stack trace, name, context, user message, solution and the submission
ID where applicable. If a user session existed for the error, the user's IP address, user name and user agent string are displayed.

Some errors associated with failed submissions may also contain the XML data that was being submitted. If this is the case, an additional icon ( will
be displayed. Click on this icon to view the XML data.Note: This icon is displayed only if you have the "Submission XML Data View" permission.

View Error Log
Hame = Effor Log > Effor Leg

Error D 10435

Time Fri Jan 06 13:46:56 EST 2012

Name RepostoryPublshUtis

Message RepostoryPublshlitis: Template\Version ID=10470

User Message  Could not publish Form Template Version. Template is not defined.
Context

TemplateVersion ID=10470
Error Stack Trace

ApplicationException: RepositeryPublishUtils: Could net publish Form Template Version. Tesplate is neot defined.
at com.avoka.fc.core.service ErrorLogService.logEirror(ErrorlogService.java:73)
at com.avoka.fc.lces.publish.FastRepositorySynchronizeService.synchronizeTemplatesForClient (FastRepositorySynchronizefervice. java;138)
at com.avoka.fo.lees.publish.FastRepositorySynchronizeService.synchronizeTemplates (FastRepositorySynchronizeService.java:50)
at com.avoka.fe. lees. publish ReposicorySynchronizeServiece. synchronizeTemplaces (RepositorySynchronizeServiece. java:70)
at com.avoka.fe. core job.SynchronizeTemplatesJob.executeJob(SynchronizeTemplateaJob.java:2E)
at com.avoka.fc.cozre.job.Baselob.execute (BaseJcb. java:138)
at org.guarts.core.JobRunShell.run|JobRunShell.java:I16)
at org.quartz._simpl SimpleThreadPooliWorkerThread. run|SimpleThreadPool._ java:-54%)

_Oose |

Details for an error log entry
The information you find here should go a long way towards diagnosing problems, and the error log should be monitored regularly to ensure smooth
operations.

System Information
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Transaction Manager provides information about runtime load and parameters. Go to "System > System Info" to access the system information.
System Information

Home Dashboard » System Information

Runtime Info

Current Process ID 2608

Free Memory 1,205 MB
Total Memory 2,041 MB
Max Memory 2,041 MB

Number CPU i Cores 2
CPU Speed 2.35GHz

Server Uptime 1,035 hours

Build Properties

Name Value

database.product sqlserver

formtypes Composer SmartForm,Dynamic PDF Form, Static PDF Form Other Document
formcenter.version 40BETA 2

groovy.client.data.isolation true

groovy.enabled true

installation.dir d:/avokaltransact/manager
livecycle.version 10.0.2

revision.number 35145

System Properties

Name Value

RUN_UNDER_ECLIPSE false

awt.tookit sun.awt.windows.WToolkit

catalina.home d:\avokaltransactimanager\server\standalone\tmp

cayenne servercontexts_sync_strategy false
com.sun.jndi.ldap.connect.pool.protocol  plain ssl

com.sun.jndi.ldap.connect.pool timeout 300000

file.encoding Cp1252

file.encoding.pkg sun.io

file. separator \

java.awt.graphicsenv sun.awt.Win32GraphicsEnvironment
p 1-100f98

Viewing system information

The page consists of three sections: some runtime statistics at the top, properties that were used to build your version of Transaction Manager in the
center and the Java system properties in the table below.

Database Version History

When Transaction Manager is started, it checks the database to see what version the database schema is at and runs update statements as necessary.

All these automatic updates are logged to the database version history, which can be viewed via the management console.

To view the database version history, go to "System > Database Version History". You will see the "Database Version Updates" page listing the updates

applied to the database since the system was set up. Each version has a unique version number and a textual descriptor identifying the release.
Database Version Updates

Home = Database Version Updates

|_».-_—‘-_'| SiuﬂDuleI :l End Date D Clear

Version Release Time Rows Updated Update Performed Action
761 320 02 Apr 2012 23:19:12 0 drop table daily_summary_report =y
7680 320 02 Apr 2012 23:19:12 0 delete from portal_property where name = "HTML Form Page' L !
759 320 02 Apr 2012 23:19:12 1 delete from deployment_property where name = 'Portal Cache Enabled -

758 320 02Apr201223:19:12 447 create index ix_submission_receipt_no on submission (receipt_number)
757 320 02 Apr201223:19:11 0 alter table transaction_audit_log modify column lc_procman_count integer not null 4,
756 3.20 02 Apr2012 23:19:11 0 update transaction_audit_log set Ic_procman_count = 0 =,
755 3.20 02 Apr2012 23:.19:11 0 alter table fransaction_audit_log add Ic_procman_count integer null
754 320 02 Apr 2012 23:19:11 4 alter table report drop column report_permission_oid
753 320 02 Apr2012 23:19:11 1 update role set role_name = ‘Administrator’ where role_name = ‘administrator' L
752 320 02Apr201223:19:11 5075 create index x_request_metric_request_time on request_log_metric (request_timestamp) =,

b 110 0f 696 Export Data

Browsing the list of database updates
You can filter the list by version number, a substring of the release identifier and the date the update was applied, and export the search results to Excel

155



by clicking the "Export Data" link below the table.

You can also click the "View" icon ( R ) to see the full statement that was executed and how many rows were modified.
This log can be useful in determining which version your database is up to; other than that, it is not relevant for day-to-day operations.

TransactField App Synchronization Log

To aid in debugging TransactField App issues, Transaction Manager stores a log of operations invoked by the TransactField App. You can access the
TransactField App synchronization log via "System > T.Field Sync Log".

T.Field Sync Log

Home Dashboard » T.Field Sync Log

User Message Start Date
Space | Device nto End Date
= App Device = = =
V] Time User Space Version Info Summary Device Forms Duration Action
y Task Downloads: 5, Missing Template Assigned Tasks: 5, Group - E]
19276 ::_J;]I_ff‘ = rmandryk [[Eneacisd 423 Nexug 5.. Dewnloads: 3 Form Downloads: 71, Draft Tasks: 0, Saved: 27, Submited: 3 min
50 App e S —— R 2
x : 35, 17 0, 17
N Asgsigned Tasks: 5, Group 4, (&)
19275 :g,g‘,ig‘ 5 rmandryk lr:"“w'e” 423 win32/i..  Form Downloads: 3 Tasks: 0, Saved: 27, Submited: 14 sec
: e 0, Delivered: 17
Assigned Tasks: 0, Group 4, 33
19274 :g_‘ul'élgf‘ 5 Lranswﬁelu WinBaiw... Tasks: 0, Saved: 0, Submited: -
i o 0, Delivered: 0
Assigned Tasks: 0, Group 4, [
19273 :3_‘1';'_'22'5 ssharpless@avoka.com :”"“"FB"’ 422 iPad2S..  Form Downloads: 71 Tasks: 0, Saved: 0, Submisg: | ™™ 18
. P 0, Deitvered: 0 s=c
Assigned Tasks: 0, Group |
19272 :3‘1':%3' 5 ssharpiess@avoka.com I’“"““F'e"’ 421 win32i..  Form Downloads: 71 Tasks: 0, Saved: 0, Submited: 42 sec
: ad 0, Delivered: 0
. Assigned Tasks: 0, Group |
19271 :;i;'gg‘ 5 mbotka 1’:"““’;‘"’ 421 GTB50..  Draft Delstes: 2 Tasks: 0, Saved: 1, Submited: 10 sec
e P 0, Deiivered: 0
" Assigned Tasks: 0, Group @, [
19270 12 382" miotia osacield 421 GOS0, Alfems in syne, Tasks: 0, Saved: 3, Submied:  12sec
18 P 0, Delivered: 0
. Assigned Tasks: 0, Group @, &=
19289 1202 ootk l:"“‘f"" 421 GTB50..  Alfems in sync. Tasks: 0, Saved: 3, Submited: 11 sec
Sl P 0, Delivered: 0
§ Assigned Tasks: 0, Group Q@
jopeg 152015 VLR g GT-B50..  Draft Upioads: 1, Draft Downloads: 1 Tasks: 0, Saved: 3, Submied: 12 sec
12:15:06 App U, S
0, Delivered: 0
§ Assigned Tasks: 0, Group Q@
19267 12992015 ootk 1’:"”‘:’"*” 421 GT-950.. Draft Upioads: 1, Draft Downloads: 1 Tasks: 0, Saved: 3, Submied: 13 sec
o > 0, Delivered: 0
#  1-10 of 1,000 Search results have been limited to 1,000 records. Export Data

The TransactField App synchronization log
You will see the list of operations invoked by devices running the TransactField App. You can filter the list (among other things) by space, user and date.
In addition, TransactField App users can elect to upload their device log to the TM server; these log files can be viewed via the TransactField App device
log, which is described in the following section.

TransactField App Device Log

TransactField App users can upload the log file maintained by the TransactField App to the TM server. This can be very helpful in debugging issues
occurring on the device running the TransactField App.
To view the list of uploaded TransactField App device logs, go to "System > T.Field Device Log".

T.Field Device Log

Home Dashboard » TField Device Log

User Message Start Date 3 Clear
Space j Device Info End Date M
D Time User Space IP Address User's OS / Browser Action
10308 15 Jul 2015 18:53:46 rmandryk TransactField App 122.150.70.7 Android 5 / Chrome Mobile 43 4 J:\‘
10308 15 Jul 2015 16:22:53 rmandryk TransactField App 114.141.100.202 Windows 8.1/ Chrome 32 Q, F

10307 15Jul 2015 14:19:34 ssharpless@avoka.com TransactField App 114.141.100.97 iOS (iPad) 8 / Apple WebKit Unknown ];\‘

10306 15 Jul 2015 14:15:14 ssharpless@avoka.com TransactField App 114.141.10097 Windows 7/ Chrome 32 Q, E
10305 15 Jul 2015 12:42:44 mbotka TransactField App 203.206.1723  Android 4 / Chrome Mobile 30 B E
10304 15 Jul 2015 12:16:45 mbotka TransactField App 203.206.172.3 Android 4 / Chrome Mobie 30 @ E
10303 15Jul 2015 12:16:24 mbotka TransactField App 203.206.172.3  Android 4 / Chrome Mobile 30 @ E
10302 15Jul 2015 12:15:18 mbotka TransactField App 203.206.172.3 Android 4 / Chrome Mobie 30 Q }2‘
10301 15 Jul 2015 12:12:37 mbotka TransactField App 203.206.1723  Android 4 / Chrome Mobile 30 @ E
10300 15 Jul 2015 12:07:07 mbotka TransaciField App 203.206.172.3 Android 4 / Chrome Mobie 30 w4 ]rz}

b 1-100f1,000 : Search results have been limited to 1,000 records Export Data

The TransactField App device log
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You can view () individual log entries to see the full TransactField App device log. You can also view the corresponding synchronization log entry (

ELh

).

Preventative Measures

To avoid problems altogether or at least detect them as soon as possible, you can take preventative measures. This section outlines some things you
can do to keep Transaction Manager running smoothly.

Monitor the System Logs

A good way to detect issues is to keep an eye on the logs provided by Transaction Manager. Inspect the error log and the event log regularly to be
alerted to irregularities and problems of all sorts. Make sure you look into issues that you do not fully understand, using additional logs such as the
submission and request log to track users' activities, the audit log to track changes made by administrators or the log files maintained by the application
server.

If you have multiple administrators set up in Transaction Manager, the audit log should also be monitored to make sure no unintended or harmful
changes have been made.

Check Scheduled Job Status

All jobs are started on a specific schedule and should not require maintenance. However, you should make sure all jobs are running normally from time
to time by checking the "Scheduled Jobs" page (for active jobs, the status should be "Normal”, the "Next Run" time should be in the future, and the "Last
Run" time should be in the past, with the interval between them equal to "Repeat Interval).

Run Status Reports

If you have status reports set up for Transaction Manager, you should view them from time to time to check for aberrations or unexpected trends (e.g. a
decline in submission levels may indicate some sort of problem). Better yet, set up a report schedule to get the reports emailed to you automatically (see
Reports (Manager v5.0) for more).

Test Changes

Whenever any administrator makes changes, whether modifying organization properties or uploading a new form, these changes should be tested
carefully, especially if they will affect forms that are in production.
This helps detect any errors or misconfiguration early on and lowers the risk of your users encountering unwanted behavior.

Data Retention

To maintain the system over time, data storage and retention needs to be considered. Storing a large amount of data in the Transaction Manager
database can cause various operations to slow down, as well as the database itself to grow larger. Transaction Manager provides data purging
capabilities as well as flexible data storage to allow you to keep your system functioning well.

Generally, you need to weigh the need for keeping the amount of data manageable against the need to preserve data, especially submission-related
data that your space users have access to (such as receipts).

Transaction Manager already archives submission and request log metadata to a set of lightweight reporting tables, which can be used for reporting and
auditing purposes after the original records have been purged. In addition, you can customize data retention and storage as described in the sections
below.

Note that you can set the data retention and storage settings globally and override important settings for individual organizations as needed.

Please refer to Data Retention Management (Manager v5.0) for an article explaining the available settings.

Data Retention Configuration (Global)

To configure data retention and purging, go to "System > Data Retention Management".
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Data Retention Management

Home D » Data Retenti
Retention Settngs | Data Status |
Data Type Number Records Oldest Record Records Max Age Policy Max Age
Form Transactions - Opened 112 11 Jan 2016 1 days 30 days
Form Transactions - Saved 65 16 MNov 2015 57 days 180 days
Form Transactions - Finished 6,506 22 0ct 215 81 days 30 days
Form Transactions - Total 5,802 20 0ct 2015 83 days T30 days
Form Reguests 11,389 02 Sep 2015 131 days 365 days
Form Transaction History 1,573 12 0ct 2015 91 days 1,825 days
Email Queue 2 16 Dec 2015 26 days 30 days
Error Log 3,415 26 Oct 2015 78 days 180 days
Event Log 141,118 26 Oct 2015 78 days 180 days
Groovy Service Log 12 12 Jan 2016 0 days 30 days
TField Device Log 179 14 Dec 2015 29 days 30 days
TField Sync Log 189 14 Dec 2015 29 days 30 days
T.Field Sync Call 7,359 14 Dec 2015 29 days 30 days
Composer Import Log [ 17 Dec 2015 25 days 30 days
Import Log 90 14 Dec 2015 29 days 30 days
Scheduled Job History 161,963 13 Dec 2015 30 days 30 days
Security Audit Log 22,286 25 0ct 2015 78 days 3565 days
Server Health 87,772 13 Dec 2015 30 days 30 days
User Login History 3,465 26 0ct 2015 T& days 180 days

Managing data retention

You will see the currently configured retention settings. To modify the retention settings for a specific entity, choose a new value and click "Save".

After saving, you can click "Apply Policy" to apply the retention policies and purge records exceeding the maximum age. The records will be purged, and
Transaction Manager will display the number of records that were purged.

Some data retention settings can be overridden on the organization and form level. If you would like to restrict the available options on the organization
levels such that they cannot be set to longer retention times than the system settings, tick the "Enforce Global Threshold" checkbox.

If you would like an overview of the data in the system, switch to one of the other tabs.

Information about submission data (excluding submissions associated with collaboration jobs) is provided on the "Transactions" tab.

Data Retention Management

Home Ot d » Data Retenti g
Retention Settings. | Transactions | Collaboration Jobs System Logs
Form Status Delivery Status Didest Max Age Records Percentage
Abandoned Completed 13 Nov 2015 179 days T 0%
Abandoned Not Required 08 Apr 2016 32 days 1 0%
Abandoned Undeliverable 22 0ct2015 201 days 9,056 83 %
Aszsigned Not Ready 20 Oct 2015 203 days 9 0%
Aszsigned 25 0%
Completed Completed 11 Mov 2015 181 days 768 7%
Completed Error 16 Mov 2015 176 days " 0%
Completed Not Ready 26 Oct 2015 198 days 28 0%
Completed Not Required 24 Mov 2015 169 days 26 0%
Completed Ready 13 Moy 2015 179 days 155 2%
Completed Undeliverable 13 Jan 2016 113 days T 0%
Expired Not Required 3 0%
Opened Not Ready 10 May 2016 0 days 109 1%
Saved Not Ready 20 Apr2016 20 days = 1%
Submitted Not Ready 04 Mov 2015 188 days 15 0%
04 Dec 2015 159 days 6 0%
=

Viewing submission data retention status

Information about collaboration jobs is provided on the "Collaboration Jobs" tab.
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Data Retention Management

s Panbbaeed & Dt Ralelion Mansgasanl

Ralestion Setngs | Transaciong | Caolabaration Jobs I_ Syalan Logs

Job Type Job Slatus Didest klax Age Records Percemtage
Formmi Burdk: h Progress 300ci 2015 194 days 13 195%
Furm Burdis Competad 15 Jan 2018 108 daya 20 &% %
Form Durndke Cancefed OO Aor MG 32 days L] L
Reviw B Aporoval I Propress 20 0ol 2015 204 days 13 19%
Raviaw & Apsroval Competad 24 Kov 3015 180 daya ] B
Reviw B Aparoval Emror 0 Fab 201&  5H days 2 3%

Viewing collaboration job data retention status

Information about other entities is provided on the "System Logs" tab.

Data Retention Management

Home Dashboard » Data Retention Management

Retention Seftings | Transactions | C fon Jobs | SystemlLogs |
Data Type Oldest MaxAge Policy Max Age Records
Transacton History  120ct2015 2t days  1625days 4895
Email Queue 14ADr2016 26 days 30 days a5
Error Log 13 Nov 2015 180 days 180days 4784
Event Log 13 Nov 2015 179 days 180 days 370,800
Groovy Service Log 11 Apr2018 30 days 30 days 108
TField Device Log 02 May 2016 8 days 30 days 25
TFelSynclog  02May2016  Gdays Ndays 253
TFelSyncCal  02May2016 8 days Ndays 13481
Composer importLog 04 May 2016 7days 7days 19
mport Log 05May2015 S days 7days 7
Scheduled Job History 11 Apr2016 30 days Ndays 118,430
Security Audt Log 260012015 198 days 35days 74,984
User Login History 13 Now 2015 180 days 180days  7.274

Viewing system log data retention status

For each entity that can be purged automatically, you can review the number of these entities currently stored in the system and the age of the oldest
record in days and as a date.

Data Storage Configuration (Global)

In addition to data retention, you can also configure submission data storage. This means that you can choose how and where submission-related data
(submission data, attachments and submission history data for saved forms) will be stored and retrieved by Transaction Manager.

By default, submission-related data is stored in the Transaction Manager database. However, data storage can be configured and changed at runtime.
The functionality is encapsulated in a set of service definitions of type "Submission Data Storage". The storage service that is marked as the default for
this service type will be used when storing submission data.

To view the list of storage services, go to "System > Service Definitions" and filter by service type "Submission Data Storage" (see below). By default,
Transaction Manager includes a database storage service (submission-related data is held in the database), an Amazon S3 storage service (submission
related data is held in S3), an Amazon KMS storage service (submission data is held in the TM database, encrypted with a key held in your Amazon
KMS) and a file system storage service (submission related data is stored on the file system).

Service Definitions

Home Dashboard » Service Defintions

Type  Submission Data Storage j Org App Pack j [T GroovyOnty W Active 01
Mew | Copy | Import | Export
Service Name Version BT Org. Type Connection Default  , jive Last Modified Action
Version Type
(R S ST T S (0 1 I puigsssonData Amazon KMS Maks Defautt ¥ 13 Nov 2015 by system A3 3
Storage Storage
Amazon $3 Submission Data Storage 1 v ::l;;n;s:mn Data Amazon 53 Make Default v‘ 02 Sep 2015 by system @ E i
Database Submission Data Storage 1 v ::'Dbr;";:'”" Data MekeDefaut ¢ 02Sep20Sbysystem (2 0 LD
File System Submission Data Storage 1 v :t';:';”g"'f:'”" pas MskeDefaut ¥  025ep2015bysystem (2 &0 L
Hybrid Cloud Submission Data c r Submission Data Transact Integration r J 16 D_ec 2015 by [Eag=alE"
Storage Storage Gateway adminavoka

Export Data
The list of storage services

To view detailed settings for a storage service, click the "Edit" icon ( @) next to it. Switch to the "Service Parameter” tab.
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Edit Service Definition

Home = Service Definitions » Service Definition

Service Definition I Service Parameters

Name Type Value Description Bind Parameter Action

attachmentsEncoding List Compressed/Encrypted File attachments storage encoding v (£l
receiptPdfEncoding List Compressed/Encrypted PDF receipt storage encoding ) |=4 ﬁ
submissionHistoryXmiEncoding List  Compressed/Encrypted Submission History XML storage encoding v @ &
submissionXmiEncoding List Compressed/Encrypted Submission XML storage encoding s @A 8

Cloge

Storage service parameters

For each storage service, you can define how the various submission data items (submission data, receipt data, attachments and submission history
data from saved forms) will be stored.

You can opt to store the data compressed or uncompressed. In addition, you can choose to have the data encrypted. By default, the data will be both
compressed and encrypted to increase security and save on storage space.

Data Retention and Storage Configuration (per Organization)

You can override important form-related settings for each organization individually. To do so, go to "Forms > Organizations" and edit the organization.
Switch to the "Data Management" tab to view or change the current configuration (see below for an example).

Maguire
Home Dashboard » Organizations » Organization

Organization | Delivery Channels Spaces | Payment Gateway | Properties Form Categories Form Tags Applications Report Schedules Data Management | Security

Transaction Data Retention Policies (max age)

Saved Transactions (days) @
Finished Transaction Pll Data (days) (2]

Delete Form Data Extracts [~ &

Transaction Form Data Storage Settings
Submission Data Storage Service j @ New
Data Encryption Key Rollover | Weekly j a8

Encrypt Data Extracts O @

Adjusting the data retention and storage settings for an organization
The data retention policies you can configure are the age after which saved submissions are automatically abandoned and the maximum age of data for
finished (delivered or undeliverable) submissiondata. If you would like the global settings to apply for this organization, leave the field blank.

If you would like submission data extract values to be deleted as soon as the submission XML is deleted, tick "Delete Form Data Extracts". If not set,
submission data extract values will be retained until the entire submission record is deleted. This setting is available only in relaxed data retention policy
mode (see the knowledge base article Data Retention Management (Manager v5.0) for details on data retention).

The "Transaction Form Data Storage Settings" section allows you to customize how submission data is stored for this organization.

You can choose a specific submission data storage service (see Services (Manager v5.0)#_sec_submissiondatastorageservice) for this organization by
selecting one from the "Submission Data Storage Service" dropdown. If left blank, the system default service will be used.

You can set a rollover interval for the security key for the organization by adjusting the value of the "Data Encryption Key Rollover" dropdown. The
security key is used by TM to encrypt submission-related data. All encrypted data is associated with its security key, so data encrypted before a security

key change will still be accessible.If you choose a value other than "Never", a new security key will be automatically generated by a background job
when required.

Finally, you can choose to encrypt the all submission data extract values for this organization by ticking the "Encrypt Data Extracts" checkbox. If ticked,
all values will be encrypted across the board; otherwise each data extract mapping can be configured to encrypt the value or not (see Form Version
Configuration (Manager v5.0)#_setupdataextractmappings).

Note that changes to this setting are not applied retroactively to existing submission data extract values.

Data Retention and Storage Configuration (per Form)

You can override important form-related settings for each form individually. To do so, go to "Forms > Forms" and edit the form. Switch to the "Details"
tab to view or change the current configuration in the "Transaction Form Data Retention (max age)" section.
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Transaction Data Retention Policies (max age)

Saved Transaclions (days) o
Finished Transaction Pil Data (days) @

Delete Form Data Extracts [~ &
Validate Form | Close

Adjusting the data retention settings for a form

The data retention policies you can configure are time after which saved submissions will be automatcally abandoned and the maximum age of data for

finished (completed and delivered or abandoned) submission data. If you would like the global/organization settings to apply for this form, leave the field
blank.

If you would like submission data extract values to be deleted as soon as the submission XML is deleted, tick "Delete Form Data Extracts". If not set,
submission data extract values will be retained until the entire submission record is deleted. This setting is available only in relaxed data retention policy
mode (see the knowledge base article Data Retention Management (Manager v5.0) for details on data retention).

Notification Messages

To keep your users informed about current announcements and maintenance notices, Transaction Manager offers functionality to post notification
messages to the management console or a user space.

Browsing the List of Notifications

To manage notifications, go to "System > Notification Messages". You will see the list of notification messages that have been set up in Transaction
Manager.

Notifications

Home > Notifications

== Portal =] Start Date [03Apr 20100000 [ End Date = Cear

New

Message Start Time End Time Portal Action
The system is going down for maintenance on Sep... 24 Aug 2011 00:00:00 01 Sep 2011 10:00:00 Gov Assist |=/1 ﬁ

Electoral enralment forms. will be available 24 Aug 2010 00:00:00 01 Sep 2010 10:00:00 Gov Assist [7] [g]

Viewing the list of notification messages
You can filter the list using a substring of the message, by space and date.

Using this page, you can create new messages and edit ( ) or delete ( E) existing messages.
Adding a Notification Message
To add a notification message for a space, go to "System > Notification Messages" and click "New". You will be directed to the "Edit Notification" page.

Edit Notification

Home > Notifications = Notification

Portal™ Gov Assist VI

The system is going down for maintenance on September 1 from 7:30 - 9am.
We apologize for any inconvenience.

Message *

Start Date ™

24 Aug 2012 00:00:00 =
End Date* |01 Sep 2012 10:00-00 =

Save Close

Creating a notification message

Choose the space on which the message should be displayed.

Enter a detailed message to be displayed to space users.

Enter a start and end date and time between which the notification should be displayed on the space.

Save the notification. After it has been saved, the notification will be displayed on the space during the specified time period.

Deleting a Notification Message

To delete a notification, go to "System > Notification Messages" and click the "Delete" icon ( E) next to the notification. You will be asked to confirm
this action before the notification message is removed.

Charts

For a quick overview of submissions and form requests, you can use the charts built into Transaction Manager.
Transaction Manager provides a transaction trend showing submission statistics.
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In addition, there are several individual charts built into Transaction Manager: The Form A/B Testing chart, the Submission Trend chart, the Form
Submissions chart, the Referer Submissions chart, the Browser Submissions chart, the OS Submissions chart and the Reader Versions chart.

Note: Most charts are based on an additional set of database tables holding a subset of submission and request data. These tables are regularly
updated, and are more lightweight than the submission/request tables themselves. The data contained in the tables can be purged automatically and
independently from the submission and request tables (see _sec_dataretention).

The Transaction Trend Chart

The Transaction Trend chart consists of several charts showing transaction trends in regards to conversion rate (what percentage of submissions were
completed by users), number of transactions and median time taken by users to complete a submission. A pie chart shows the distribution of device
types (desktop, tablet, phone).
To access the Transaction Trend chart, go to "Analytics > Transaction Trend". You can filter the charts by organization, form, space, device type and
date.

Transaction Trend

Home Dashboard » Transaction Trend

i) Shows Compieted and Abandoned fransactions for the time period. Transactions which are Tn Progress’ or are test mode transaclions are exciuded. Note these charls have a 1 day delay o alow opened
ons o be to

Form ;J Space j Device Type j Start Date | 21 Jun 2015 :

Conversion Rate

33%
= Conversion Rate

(‘.n'ﬂplr—.-.—.n ransactions
JunZt Jun23d  JunZ5 Jun27  Jun28  Juli Jul3 Jul § Jul? Jul'g Jultt Jul1d W15 M7 Jul19
Jun2Z Jun2d4 Jun26 Jun2d Jun30 Jul2 dul 4 Julé Jul @ Jul10 Jul 12 Jul 14 Jul 16 Jul 18 Jul 20

1 min
Median Completion Time

Completed Transactions

/\/\ A A A

JunZi Jun23  Jun2S  Jun2T  Jun28  Juli Jul3 Jul & Jul? Jul® Jull Jul13  JuliE Jul1T Juli®
Jum22 Jun2d4 Jun26 Jun28 Jun 30 Jul 2 Jul4 Julg Jul g Jul10 Jul 12 Jul14 Jul 16 Jul18 Jul 20

Median Completion Time (mins)

60 ’
Customer Devices
40
20
B P - W ———- —Y

JunZ Jun23 Jun25 Jun2T  Jun28  Juld Jui3 Jul & Jul? Jul & Jull Jul43  Jul1E JuldT Juii®
Jun22 Jun24 Jun26 Jun28  Jun 3D Jul2 Jul4 Julg Julg Julte Jul 1z Jul14 Jul 16 Jul 18 Jul 20

The Transaction Trend chart

The Form A/B Testing Chart

The Form A/B Testing chart can be used to compare submission statistics for two form versions side by side.
To access the Form A/B Testing chart, go to "Analytics > Form A/B Testing". Select the form and the two versions you want to compare to show data for
both versions for the past month. You can also filter the data by space and device type (desktop, tablet or phone).
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Form A/B Testing

Home Dashboard » Form A/S Testing

i) Provides A/B (spiit) testing information of different form varsions over the same time period. Please select the Fiorm and then the A and B versions to assess.

Form | Credt Card Application j Space j ATestVersion 10 j 8.TestVersion | 2.0 j Device Type

Transaction Trend: A-Test v. 1.0

o - L o
Jun 22 Jun 24 Jun 26 Jun 2B Jun 30 Jul2 Juls Julg JulB Jul 10 Jul12 Jul 14 Jul 18 Jul 18 Jul20 Jul 22
Jun 23 Jun 25 Jun 27 Jun 29 dul1 Jul 3 Juls Jul 7 Julg Jul 11 Jul 13 Jul1s Jul 17 Jul 19 Jul21
Il Opened |l Saved M Submited

Total Transactions Opened: 16 Saved: 4 (25%) Submitted: 4 (25 %)

Transaction Trend: B-Test v. 2.0

0
Jun 22 Jun 24 Jun 26 Jun2d  Jun 30 Jul 2 Jul4 Jul§ Jul Jul10 Jui12 Jul 14 Jul 16 Jul 18 Julzo Julzz
Jun 23 Jun 25 Jun 27 Jun 28 Jul1 Jul3 Juls Jul 7 Jul® Jul 11 Jul 13 Jul 15 Jul 17 Jul 19 Jul21
[l Opened [l Saved [l Submitted

Total Transactions Opened: 19 Saved: 1 (5 %) Submitted: 8 (42 %)

The Form A/B Testing chart

The Form Submissions Chart

The Form Submissions chart shows a pie chart of the number of all submissions per form during a certain date range. The chart can be filtered by
organization.

To access the Form Submission chart, go to "Analytics > Form Submissions". If you want to modify the date range used, enter new dates into the "Start
Date" and "End Date" fields and click "Refresh".

You can export the search results to Excel by clicking the "Export Data" icon below the chart.

Form Submissions

Home = Form Submissions

Start Date [04 Apr 2011 | [75] End Date [04 Aor 2012 | [T3)

M Test Attachment Form
Test Payment Form
Test Form Wizard
Test Form
Test No Schema
M Test Delete Form
Payment Details - PDF [with PDF receipt]
Simple Form
Australian Taxation Office
Cancer Screening Assessment
. Composer HTML Form
M Field Warker Form

Top 15 submissions by Form - g

The Form Submissions chart

The Submission Trend Chart

The Submission Trend Chart shows the number of form requests and submissions for all forms during a date range. The data is grouped by month, and
can be filtered by organization or form.
To access the Submission Trend chart, go to "Analytics > Submission Trend". If you want to modify the form or date range used, select a form from the
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"Form Name" field, enter new dates into the "Start Date" and "End Date" fields and click "Refresh".
You can export the search results to Excel by clicking the "Export Data" icon below the chart.

Submission Trend
Home > Submission Trend

Form Name | ;l Start Date |EH Aor 2011 D End Date IN Apr 2012 D
90
30
To
60

50

HNumber

40
| Requests

3 W submissions

20
10 L L
0 —PQ\\L -19\ ‘5’.\\ 19,;\ *E’\\ "9!) ‘P"v .-p!'_ 'ﬁ'&
S A
¢ o . X
Month

=
The Submission Trend chart

The Referer Submissions Chart

The Referer Submissions chart shows the referer URLs (URLs from which the space users navigated to the form or landing page) as a pie chart. It also
lists the referring URLs along with a percentage.

To access the Referer Submissions chart, go to "Analytics > Referer Submissions”. To filter by form, choose a value from the "Organization" dropdown
and select a value from the "Form Name" dropdown. If you want to modify the date range used, enter new values into the "Start Date" and "End Date"
fields and click "Refresh".

Referer Submissions

Home = Referer Submissions

Form Name | | start Date [04 Apr 2011 ) End Date [04 Aor 2012 T

B http://usr-lIpammer2:9080/govassist/|landing.htm?formCode=tpf-ntgov
http://usr-Ipammer2:9080/govassist/landing.htm?*formCode=taf-ntgov
http://usr-lpammer:3080/govassist/landing .htm*form Code=tfw-ntgov
http://usr-lpammer: 9080/ govassist/landing htm form Code=insp-exacoco
http://localhost: 9080/ govassist/landing.htm?formCode=taf-ntgov

B http://localhost: 9080/ govassist/landing. htm *formCode=tgdt-ntgov
http://localhost: 9080/ govassist/landing. htm?formCode=payment-detailss
http://localhost: 9080/sfmanager/admin/form/form-search.htm
http://usr-lpammer2:9080/finance/landing. htm?formCode=taf-ntgov
http://usr-lpammer:9080/govassist/landing .htm?formCode=taf-ntgov

M hitp://localhost: 9080/ govassist/landing. htm ?formCode=tpf-ntgov

M http://localhost: 9080/govassist/landing. htm?formCode=coa-exaco
http://usr-lpammer2:2080/govassist/wet-signature. htm

B hitp://usr-lpammer2: 2080/ govassist/wet-signature.htm?submitkiey=bf682cad 376c5f ...

W http://usr-lpammer: 9080/ govassist/landing htm orm Code=sim-quick

Top 15 submission by Referer - ﬁ]

The Referer Submissions chart

The Browser Submissions Chart

The Browser Submissions chart shows a breakdown of the most common browser versions used to submit forms. The data can be filtered by
organization, form and date.

To access the Browser Submissions chart, go to "Analytics > Browser Submissions". To filter by form, choose a value from the "Organization" dropdown
and select a value from the "Form Name" dropdown. If you want to modify the date range used, enter new values into the "Start Date" and "End Date"
fields and click "Refresh".

You can export the search results to Excel by clicking the "Export Data" icon below the chart.
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Browser Submissions
Home > Browser Submissions

Form Name [ =] Start Date [0£ Aor 2011 | [777] End Date [04 Apr 2012 [0

M Firefox - 10
Firefox - 8.0
Firefox - 3.6.17
W Firefox - 8
AcroForms - Unknown
M Firefox - 3.6.18
Safari - 523.15
AdobeAlR - 3
Firefox - 11
Firefox - 3.6.20

Top 15 submission by Browser. Please note browsers may include Adobe Reader and Acrobat making offline submissions - @

Browser Submissions chart

The Operating System Submissions Chart

The OS Submissions chart shows a breakdown of the most common operating systems used to submit forms. The data can be filtered by organization,
form and date.
To access the Operating System Submissions chart, go to "Analytics > OS Submissions". To filter by form, choose a value from the "Organization”
dropdown and select a value from the "Form Name" dropdown. If you want to modify the date range used, enter new values into the "Start Date" and
"End Date" fields and click "Refresh".
You can export the search results to Excel by clicking the "Export Data" icon below the chart.

Operating System Submissions

Home = Operating System Submissions

Form Name | =] startDate [04 Apr 2011 [77) End Date [04 Apr 2012 [T

W windows - 7
Windows - XP
Unknown - Unknown

I windows - Unknown

Top 15 submission by Operating System - @

The Operating System Submissions chart

The Reader Versions Chart

The Reader Versions chart shows a breakdown of the most common Adobe Reader versions used to submit forms. The data can be filtered by
organization, form and date.

To access the Reader Versions chart, go to "Analytics > Reader Versions". To filter by organization, select a value from the "Organization" dropdown. If
you want to modify the date range used, enter new values into the "Start Date" and "End Date" fields and click "Refresh".
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Reader Versions

Home = Reader Versions

Form Name * | Start Date |04 Apr 2011 | 77.] End Date |04 Apr 2012
| = | = | i

B Reader 10.1.1
Reader 8.2.0
Reader 8.3.0

[l Reader 9.4.1

Top 15 submissions by Reader Version. Please note Reader submissions may also include submission made by Adobe Acrobat - @

The Reader Versions chart

The Forms Activity Chart

The Forms Activity chart is based on live submission data to show recent activity in TM. It shows the number of render requests and submissions for the
last month (or day depending on the interval selected.

To access the Forms Activity chart, go to "Operations > Forms Activity". You can filter the data by organization, form, space and device type (desktop,
tablet or phone).

Forms Activity

Home Dashboard » Forms Activity

i) Show real-time activity of number of forms rendered and submitted by users.

Form j Space j Device Type ;I interval | Day j

Forms Activity
200

150

100

0 ;ﬁ’i\,—.—.—aﬁ-—m

Jun  Jun Jun Jun Jun Jun Jun Jun Jun  Jul  Jul Jul Jul Jul Jul Jul Jul Jul Jul Jul Jul Jul Jul Jul Jul o Jul Jul Jul o Jul o Jul
2 N M B XN NN BB N 2 3 4 3 6 7 & 9 10 M 12 13 14 15 16 17 18 19 20 21
M Renders [l Submissions

The Forms Activity chart

The Error Log Trend Chart

The Error Log Trend chart shows the number of error log entries logged in TM for the last month. It provides a quick way of checking on the health of the
TM instance.
To access the Error Log Trend chart, go to "System > Error Log Trend". You can filter the data by space and a substring of the error message.
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Error Log Trend

Home Dashboard » Error Log Trend

i) Shows daily Error Log totals over the last 30 days

Message Space / Module j Clear

Error Log Trend
40

/\_/\_.__/\ . <

- — ¥
dun Jun  Jun Jun Jun  Jun  Jun  Jun  Jun  Jul  Jul Jul Jul Jul Jul Jul Jul Jul Jul o Jul Jul  Jul Jul Jul Jul  Jul Jul Jul Jul - Jul
2 23 4 25 2% 21 2B 29 30 1 2 3 4 5 6 7 L] g 10 1 12 13 14 15 16 17 18 19 20 21

0

B Number of Errors

The Error Log Trend chart

System Licensing

The TM licensing model includes automated reports sent to an Avoka server, containing daily summaries on the number of submissions, broken down
further by organization and some other metrics (e.g. how many transactions involving T.Field were completed).

The licensing data that is collected and reported on can be viewed in the transaction log (see _sec_transactionlog).

The licensing reports that are sent to a secure Avoka server need to be configured with some information about the TM system such as environment
name and type. To view the current settings, go to "System > System Licensing". These settings are also displayed if they have not been filled in
previously.

System Licensing

Home Dashboard » System Licensing

Licensee Name* Avoka Technologies o
Environment Type®  Non-Production j L}

TH Instance ID 73341699296b832d951332c95(f673e2 2

Auto License Reporting [V =]

The status of the licensing reporting job is "Normar.
The job last ran at 6:00 AM, 22 July 2015 and is scheduled to run at 5:00 AM, 23 July 2015.

Save Run Licensing Job Close

System licensing settings

To configure licensing details for your server, enter the licensee name (your company name + the server identification, e.g. "My Company UAT") and
choose the server type (production or non production). Save the changes.

By default licensing reporting data is automatically transmitted securely to the Avoka reporting server. If this mechanism is not suitable for your TM
server, please contact Avoka to obtain a key for manual license reporting for your server (you can untick "Auto License Reporting" and click the link to
request a license key via email).Once you receive your manual license reporting key, go to "System > System Licensing" again, untick "Auto License
Reporting" and enter your key into the "Manual License Reporting Key" field. Also enter the directory on the TM server where licensing reports shall be
stored into the "License Report Directory" field. TM must be able to write to this directory.Save your changes to switch to manual licensing reporting. TM
will store the licensing reports to the configured folder, and you will need to provide these report files to Avoka when requested.
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Outgoing Email (Manager v5.0)

Transaction Manager uses email for a variety of notifications to both administrators and space users. This chapter talks about configuring SMTP server
information and how emails can be tracked and sent using the management console.

Page Contents Search

® Concepts
® Configuring SMTP Server Information
® The Email Queue

Concepts

Transaction Manager requires an SMTP server to send its emails. Please note that Transaction Manager does not currently process incoming emails.
Emails are either sent directly as part of some processes (e.g. delivery, form promotion, scheduled reports) or alternatively can be scheduled on an email
queue. The email queue provides a mechanism to send arbitrary emails, keeping track of emails and their current status and sending them with a
configurable number of retries.

Configuring SMTP Server Information

For Transaction Manager to be able to send email, it needs to be configured with connection parameters to an SMTP server.
To view or modify the SMTP server information, go to "System > Email Settings" (see below for what you should be seeing).

Email Seftings

Home > Reader Versions > Email Settings

SMTP Server Host*  [mysmtpserver
SMTP Server Port [5
SMTP User [

SMTP Password |

Qoeeee

Sender Email Address * |Ema|\@m}‘domam com

Send Test Email Address
Test Email Address | =]

Send Test Close

The SMTP configuration for Transaction Manager
Edit the fields to set up the connection to the SMTP server, then save.
You can send a test email by entering a valid email address into the "Test Email Address" field and clicking "Send Test".

/

The Email Queue

The email queue enables administrators or Transaction Manager services to create emails, which will be automatically sent, retried if necessary and
logged. This helps track whether emails actually get sent and allows you to resolve errors such as invalid recipients.

To view the email queue, go to "System > Email Queue". You will see the list of emails in the queue (including those that have been sent already).
You can filter the list of emails by status ("Ready", "Completed", "Error", "Max Retries Exceeded" or "Purged"), a substring of the category, the
submission ID associated with the email, the space and the creation date.You can also export the search results to Excel by clicking the "Export Data"
link below the table.
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Email Queue

Home > Email Queus

Email Status | =] category | Start Date [03 Apr 20110000  [T] - Clear
Submission D Portal | ] endpate | |

New

D Status Created Portal Category Current Subject Action
111 Max Retries Exceeded 03 Apr 2012 13:02:57 Admin Console User Account SmartForm Manager Account Approved: msue2 B
10 Completed 11 Jan 2012 03:31:24 Admin Console Delivery Escalation ESCALATION: 7 form submission(s) not delivered m
1098 Completed 06 Jan 2012 01:30:00 Admin Console Delivery Escalation ESCALATION: 7 form submission(s) not delivered B
108 Max Refries Exceeded 05 Jan 2012 01:30:00 Admin Console Delivery Escalation ESCALATION: 7 form submission(s) not delivered B
107 Completed 16 Dec 2011 01:30:00 Admin Console Delivery Escalation ESCALATION: 6 form submission(s) not delivered E
106 Completed 12 Dec 2011 11:08:37 Admin Console Form Promotion Form Promotion Notification - Form: TCF-14 on Test E
108 Completed 12 Dec 2011 08:28:14 Admin Console Delivery Escalation ESCALATION: & form submission(s) not delivered E

104 Max Refries Exceeded 02 Dec 2011 01:30:00 Admin Console Delivery Escalation ESCALATION: 6 form submission(s) not delivered [

103 Completed 21 Jun 2011 12:00:46 Admin Console Delivery Escalation ESCALATION: 43 form submission(s) not delivered  [7]
102 Completed 21 Jun 2011 12:00:46 Admin Console Delivery Escalation ESCALATION: 43 form submission(s) not delivered @
b 110020 Export Data

Viewing the email queue

This page allows you to create new emails and edit (El) existing emails. These operations are described in the sections below.

Adding an Email to the Queue
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To add a new email, click "New". This will take you to the "New Email Queue Item" page.
New Email Queue Item

Home > New Email Queue tem

Portal™ IAdmm Console 'I

Available Users Included Users

& test2@emaildomnain.com ;]
testa@emaildomain.com
formcenter@test.avoka.com
test@emaildomain.com

To* formcenter2@test. avoka.com

HEE

- Ipammer@avoka.com
msue@mydomain.com
~ msue@mydomain.com
cc |admin@emaildomain.com
BCC |
RepyTo |
From* lidoe@emaildomain.com

Subject”  [Please process outstanding delivery tems

Body*
There are several delivery items waiting to be acknowledged.
Please make sure to process these items ASAP.
If you have any guestions, please contact us for assistance.
Best regards,
Jane Doe
Submission Monitoring

Plain Body

Send Cancel

Adding an email to the email queue

Select a space to whose users you wish to send email. This will populate the "Available Users" list with all users associated with the space.

Select one or more of the email addresses from "Available Users" and use ">" to add them as recipients. To add all users, use ">>". The "<" and "<<"
buttons can be used to remove a selection of or all users from the recipients list.

You can also enter additional email addresses into the "CC" and "BCC" fields.

Edit the "From" field if you would like to use a custom sender address. By default, this field is populated with the value of the "Email Default Sender"
deployment property (which can be edited using "System > Email Settings"; see also section "Configuring SMTP Server Information").

The "Reply To" field can be used to set a reply address that is different to the "From" address. It will be used when a user replies to an email sent out via
the email queue.

Enter the email subject into the "Subject" field.

Enter the email message into the "Body" (for HTML email content) and/or the "Plain Body" (for plain text content) fields.

When you are done, save the email. It will be automatically sent by the Email Queue job. If there is an error, there will be a maximum of two automatic
retries. Refer to the following section for getting information on the email progress and how to retry sending the email.

Editing an Email

2 Unknown Attachment
Once an email has been added to the queue, it can be edited using the "Edit" icon ( ) next to the email. The
screenshot below shows the "Edit Email Queue Item" page.
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Edit Email Queue ltem

Home > Email Queue > Email Queue ftem

Email Details | Email Template | Events | Errors ‘

Category Delivery Escalation
Priority ™ 1
Created™ 11.Jan 2012 3:31:24 AM

Email Status Completed > I

Delivery Attempts 2
Max Attempts. 3

Portal * Admin Console

From smartforms @innovation.gov .au

To Ilpammer@avoka.comfomcemer@lest.avoka.com;

cc |

BCC |

Reply To |

Subject ESCALATION: 7 form submission(s) not delivered
<htmi=<head=<style type=texticss*>body {font-family:Arial;}</style=</head= ﬂ

Bod <body><h3>ESCALATION: 7 form submission(s) not delivered</h3>

ody <p=7 form submission(s) have not been delivered to NT Government.</p> ll

<p>Submissions details can be viewed at: <br/><a href="http://usr-

Plain Body

Attachments 0

Close

Editing a queued email

The "Email Details" tab allows you to edit some of the fields such as the recipients and email body. This allows you to resolve email delivery issues.In
addition, if an email was resent unsuccessfully so often that it has exceeded the maximum number of retries, you can reset its status by changing the
"Email Status" field to "Ready".

Once you are done editing the email, save your changes.

The "Email Template" tab contains various template values from which the actual email fields are calculated (if applicable). The actual values are
calculated when the email is being sent.

The "Events" and "Errors" tabs show events and errors that occurred when attempting to send the email. This can be useful for debugging email failures.
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Reports (Manager v5.0)

Transaction Manager includes extensive reporting capabilities. You can set up your own reports that generate submission statistics, trends and help
organizations monitor user activities. Transaction Manager uses the BIRT framework to run reports.
These reports can be viewed on screen or scheduled to be automatically emailed to one or more recipients.

Search

Concepts

A reportin Transaction Manager consists of a BIRT report file as well as report parameters that are passed into the report at runtime. There are two
types of reports: System reports are global reports that are not organization specific, whereas organization assignable reports are reports that display
data for a particular organization.

Each report allows you to view the report on screen (i.e. as HTML) as well as to define multiple report schedules. Report schedules are used to
automatically generate and email the current report for a particular date range. Reports can be sent out in PDF, CSV or XLS (Microsoft Excel) format.

Configuring Reports

This section describes how to set up and run reports in Transaction Manager. For a new report, you need a BIRT report file to base the report on. You
can create and upload your own reports without having to rebuild Transaction Manager, albeit with some restrictions as described below.

Browsing the List of Reports

To view the list of reports set up in Transaction Manager, go to "Reports > Report Configurations".

Report Configurations
Home = Report Configurations

| ¥ Active Only Clear

New Synchronize Reports

Name Group Description Org. Assignable Active Action

Client Operational Summary Provides an overview of transactions for a specific organization o v @ E ['>
Operational Summary Provides an overview of transactions for all organizations v @ a P’
Payments Daily Provides a summary of the payments made for a batch v v B z L}’
Temp report 1 v @A &2 P
Temp report 2 b el J
Transacticn Report by Day Provides transaction statistics for SFM, broken down by day v B z |?>
Transaction Report by Month Provides transaction statistics for SFM, broken down by month v 51 x=‘ P’

=

Browsing the list of reports
You can filter this list a substring of the report name. In addition, you can choose to show inactive reports by unticking the "Active Only" checkbox.You
can also export the search results to Excel by clicking the "Export Data" link below the table.

This page allows you to create new reports and edit ( ) or delete ( E) existing ones, as well as rendering reports on-screen ( |:"L").
You can also click "Synchronize Reports" to recreate the report directory where Transaction Manager stores all reports so BIRT can access them. Doing
this will delete the contents of the report directory and create a folder for each report containing the report design as uploaded by the administrator.

Adding a Report

To add a report, go to "Reports > Report Configurations" and click the "New" button. You will be directed to the "Edit Report Configuration" page.
Edit Report Configuration

Home = Report Configurations > Report Configuration

Report Definition | ‘

Name * |C!ient Operational Summary

Description I

Organisation Assignable [V

Report File

Upload Report File |C,‘uf\vokaTesiCases‘mpnrts‘cliernﬂperalmnalﬁummaryﬁl\ rptdesic  Browse_ I
Report Group |

Active 2

Save Close

Creating a report
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Give the report a unique name and (optionally) a description.

The "Organization Assignable" checkbox determines whether your report should be schedulable for specific organizations or whether it is a system
report.

Upload a BIRT report design file (*.rptdesign) using the "Browse" button next to "Upload Report File". The file will be stored in the database as well as
the reports directory on the file system so it is accessible to BIRT (the reports directory is configured via the deployment property "Config Directory"; see
also Deployment Properties (Manager v5.0)#_sec_directories)

You can enter the category to which the report belongs (e.g. "Global Submission Statistics") into the "Report Group" field. Specifying a report group is
currently purely descriptive, i.e. Transaction Manager is not using this information, but merely stores it.

The "Active" checkbox can be used to mark a report as active or obsolete. To run or schedule the report, make sure the checkbox is ticked.

Save the report and verify that it is shown in the list of reports. Before you can use it, you may need to add one or more report parameters.

Setting Up Report Parameters

Report parameters are passed into the BIRT report when it is being rendered on-screen (there are also invisible parameters that are passed into a report
when it is generated and emailed by the report scheduling component — these are discussed in _sec_reportscheduleexecution).

At present, there is only one parameter that Transaction Manager supports here, which is "client_oid". If the report you are setting up is organization
assignable, add a report parameter named "client_oid" to the Transaction Manager report. At render time, the organization's ID is automatically retrieved
and passed into the report (see _sec_renderorganizationreport on how to render an organization assignable report).

Please note: For this to work, your BIRT report needs to define a parameter named "“client_oid" and use that parameter in its queries to retrieve
organization-specific data.

To add the parameter, go to "Reports > Report Configurations" and click the "Edit" icon ( E,l) next to the report. On the "Edit Report Configuration”
page, switch to the "Report Parameters" tab and click the "New" button. You will be directed to the "Edit Report Parameter" page.
Edit Report Parameter

Home = Report Configurations = Repert Configuration = Report Parameter

Report™® Client Operational Summary

Name * |:|ient_n|d

Type |

Sequence I
Hidden Flag [~

Save Close

Adding areport parameter
Enter the parameter name (in this case "client_oid", as explained above) into the "Name" field. The other fields can remain blank.
Save the report parameter. Now the report is fully configured and can be rendered on-screen.

Configuring Users to View Reports

The BIRT reporting engine is set up as a space in Transaction Manager. For a user to be able to view reports, they must be associated with the
"Business Reports" space (see Security (Manager v5.0)#_sec_changespacesforuseraccount on how to do this). In addition, when viewing reports on-
screen, the user needs to log on with their credentials.

Rendering a System Report

To render a system report on-screen, go to "Reports > Report Configurations" and click the "View" icon ( [") next to the report. This will render the
report in the current window (see below for an example). If the report has parameters, you will be prompted to populate them with values before the
report is rendered.

Avoka Transact Business Reports

S A T
Showing page 1 of 1 4l 4 ¥ ¥ Gotopage: a
Operational Summary Avoka Transact
Organisation{s): maguire
Start date: 01/03/2014 24:00
End date: 01/04/2014 24:00
Name Code Rendered Completed Abandoned Completion Rate Last Submission Median Time to Payments Amount Paid
Submit
Maguire maguire T T 0 100% 26 Mar 2014 55 sec 0 $0.00
Calc Test- HTML calc-test 1 1 0 100% 05 Mar 2014 0 $0.00
Collab Maguire - collab-maguire 2 2 0 100% 04 Mar 2014 568 sec 0 $0.00
HTML
Maguire Morigage maguire- 1 1 0 100% 10 Mar 2014 0 $0.00
Application - mortgage-app
Mortgage MAG-HLA 3 3 0 100% 206 Mar 2014 47 sec 0 $0.00
Application
Total 7 7 0 100% 26 Mar 2014 95 sec 0 $0.00

Rendering a report
The BIRT report viewer packaged with Transaction Manager renders the report as HTML. The viewer allows you to re-run the report, export the data and
print the report.

Rendering an Organization Assignable Report

Organization assignable reports typically have a hidden parameter "client_oid" as described in _sec_setupreportparameters. To ensure that the correct
organization ID is passed into the report when it is rendered, go to "Reports > Report Configurations" and select the desired organization from the

"Organization" dropdown, Then click the "View" icon ( ) next to the report.
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Removing a Report

You can delete reports and report parameters if needed. Be aware that deleting a report will also remove all schedules associated with it.

To delete a report, go to "Reports > Report Configurations" and click the "Delete" icon ( E) next to the report. After you confirm your decision, the

report and all its schedules will be irrevocably deleted.
If you do not want to physically delete the report, you can also make it inactive. To do this, go to "Reports > Report Configurations" and click the "Edit"

icon ( El) next to the report. On the "Edit Report" page, untick the "Active" checkbox and save. This marks the report as obsolete; you can later
reactivate it by simply re-ticking the checkbox.

Scheduling Reports

This section describes how you can set up schedules to automatically run reports and send them out via email.

Browsing System Report Schedules

To view the system report schedules set up in Transaction Manager, go to "Reports > System Report Schedules".
System Report Schedules

Home Dashboard » System Report Schedules

Schedule Type j ¥ Active Only Clear

New
I0  Name Report Name Format Active Schedule Type Schedule Time MNextRunTime  Action
202 Awvoka Transaction Licensing Report Transaction Report by Month  XLS J Month 06:00:00 01 Aug 2015 06:00 \Z E_-' B"
182 Transaction Report by Month 182 Transaction Report by Month XLS J Maonth 06:00:00 01 Aug 2015 06:00 f? 7_' D

Export Data

Viewing the list of system report schedules

You can filter this list using a substring of the report name and by schedule type (day, week or month). If you tick the "Active Only" checkbox, only report
schedules that have the "Active" flag set will be displayed.You can also export the search results to Excel by clicking the "Export Data" link below the
table.

This page allows you to create new system report schedules and trigger (L), edit ( E)l) and delete ( E) existing report schedules as well as render

the report on-screen ( 7).

Adding a System Report Schedule

To add a report schedule, go to "Reports > System Report Schedules" and click the "New" button. You will be directed to the "Edit System Report
Schedule" page.

Edit System Report Schedule

Home Dashboard » System Report Schedules » System Report Schedule

Report Schedule |

Report*  Operational Summary j
Mame* Global Operational Summary
Output Format Type* PDF j

Zip Report Output File [~ @
Output Format Order

Delivery Email*  jdoe@emaildomain.com

Schedule Type* j
Schedule Time* 12 j 00 j am j
active [
Next Run Date
Scheduled Time of Next Run

Report Period Start

Report Period End

e

Creating a system report schedule

Configuring a Report Schedule

Select the report you want to schedule from the "Report" dropdown. If you are creating a system report schedule, the dropdown will contain only system
reports; if you are scheduling an organization assignable report, you will be offered only organization assignable reports.

Enter a globally unique report name.

The "Output Format Type" can be PDF, CSV or XLS. If you want your reports to be easily readable by humans, choose PDF; if you want to process
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them automatically, CSV is the better choice. Choose XLS to obtain the report in Microsoft Excel format.

The checkbox "Zip Report Output File" allows you to automatically compress the report file and attach the resulting ZIP file to the report email rather than
the uncompressed original. This setting helps when report files are getting very large, especially with CSV and XLS reports.

The "Output Format Order" is relevant only if you have chosen CSV as the output format. It allows you to specify the order in which the columns
extracted from the report are written to the CSV file. For some more details on this, see _sec_reportscheduleexecution.

Enter the email addresses you want the report sent to into the "Delivery Email" field, using commas to separate them.

The "Active" checkbox at the bottom of the form indicates that the report schedule is ready for use; untick this only if you want to deactivate the schedule
to stop reports from being emailed out automatically.

All other fields contain scheduling information. You have a choice of three basic schedule intervals: daily, weekly and monthly. See below on how to
configure these schedule types. Please also refer to _sec_reportscheduleexecution to understand how the configured report periods are passed into the
report.

Setting Up a Daily Schedule

Daily schedules, as their name implies, are run once a day. If the report is configured to generate results for a certain date range, Transaction Manager
will run it for a 24-hour period. This means that every day, the recipient(s) will get a report containing one day's worth of data.
The screenshot below shows an example configuration for a daily report schedule.

Edit System Report Schedule

Home > System Report Schedules » System Report Schedule

Report Schedule | Run History |

Report® Operational Summary - I
Output Format Type* FPDF = |
Zip Report Output File [~ @

Output Format Order

Delivery Email®  jdoe@emaildomain.com

Schedule Type™
Schedule Time *

Report Period StartEnd Time *

Active
Next Run Date
Scheduled Time of Next Run

Report Period Start

Report Period End

Day _~|
7 =] o0=]||am[=]
122 =] 00 =] am =]

W~

250ct 2012 07:00:00

24 Oct 2012 00:00:00

25 Oct 2012 00:00:00

Save Close

A daily report schedule

Set the "Schedule Type" to "Day". Set the "Schedule Time" to the time that you want the report to run (format HH:MM:SS).

Set "Report Period Start/End Time" to a time of day (format HH:MM:SS). If you use "12:00:00", each report will contain data from 12pm of one day to
12pm on the following day.

Setting Up a Weekly Schedule
Weekly schedules are run once a week. If the report is configured to generate results for a certain date range, Transaction Manager will run it for a 7-day

period. This means that every week, the recipient(s) will get a report containing one week's worth of data.
The screenshot below shows an example configuration for a weekly report schedule.
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Edit System Report Schedule

Home = System Report Schedules > System Report Schedule

Report Schedule | Run History |

Report™®

Output Format Type ®

Zip Report Output File

Output Format Order

Delivery Email™

Schedule Type™

Schedule Time*

Schedule Day of Week™

Report Period Start/End Day of Week™*

Report Period Start/End Time *

Active
Next Run Date

Scheduled Time of Next Run
Report Period Start

Report Period End

Save Close

Operational Summary

POF = |
re

jdoe@emaildomain.com
Week _~ |

§ x| oo =] am =]
=

=

00 LI am L]

Monday
Monday

2 |
W

29 Oct 2012 08:00:00
22 Qct 2012 00:00:00

29 Oct 2012 00:00:00

A weekly report schedule

Set the "Schedule Type" to "Week". Set the "Schedule Time" to the time that you want the report to run (format HH:MM:SS).

Select the day of week you want the report to run on from the "Schedule Day of Week" dropdown.

Set "Report Period Start/End Day of Week" to the day of week you want the report to use for its reporting period. For example, if you use "Sunday",
Transaction Manager will instruct the report to retrieve data from a Sunday to the Sunday the week after.

Set "Report Period Start/End Time" to a time of day (format HH:MM:SS). If you use "12:00:00", each report will contain data from 12pm of one day to
12pm seven days later.

Setting Up a Monthly Schedule

Monthly schedules are run once a month. If the report is configured to generate results for a certain date range, Transaction Manager will run it for a 1-
month period (the number of days varies, as it must).
The screenshot below shows an example configuration for a monthly report schedule.

Edit System Report Schedule

Home = System Report Schedules » System Report Schedule

Report Schedule | Run History ‘

Report™® Ll

Operational Summary

Output Format Type *

Zip Report Output File
Qutput Format Order

Delivery Email®
Schedule Type*
Schedule Time *
Schedule Day of Month ®
Report Period Start/End Day of Month ®
Report Peried Start/End Time *
Active
Next Run Date

Scheduled Time of Next Run
Report Period Start

Report Period End

POF |
rNne

jdoe@emaildomain.com
Month = |

8 = 30 =] am =
1

1

2] 0] v
v

01 Nov 2012 08:30:00
01 Oct 2012 00:00:00

01 Nov 2012 00:00:00

A monthly report schedule
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Set the "Schedule Type" to "Month". Set the "Schedule Time" to the time that you want the report to run (format HH:MM:SS).

Set "Schedule Day of Month" to the day of month you want the report to be run on. You can use values 1-31, with each value standing for the nth day of
a calendar month. To avoid problems when using values > 28, you can also use zero and negative values: For example, 0 will cause the report to run on
the last day of the month, however many days that month contains. Likewise, -1 will cause the report to run on the second-last day, and so on.

Set "Report Period Start/End Day of Month" to the day of month you want to use as the boundary between reports. As with "Schedule Day of Month",
use a value from 1 to 31 or zero and negative values.

Set "Report Period Start/End Time" to a time of day (format HH:MM:SS). If you use "12:00:00", each report will contain data from 12pm of one day to
12pm on the same day but one month later.

Browsing an Organization's Report Schedules

To view the report schedules set up for an organization, go to "Forms > Organizations", edit the organization and switch to the "Report Schedules" tab.
Edit Organisation - Department of Health

Home > Organisations > Organisation

Organisation | Form Delivery Detais | Payment Gateway | Properties | Report Schedules | FormTags |

ID  Report Name Group Format Active Schedule Type Schedule Time MNext Run Time Action

101 Daily Reconciliation POF Day 08:00:00 29Mar201108:00 [ ] P

-

The list of report schedules for an organization

This page allows you to create new report schedules and trigger (L), edit ( E)l) and delete ( E) existing report schedules as well as render the report

onscreen ( 7).

Adding an Organization Report Schedule

To add a report schedule to an organization, go to "Forms > Organizations", edit the organization and switch to the "Report Schedules" tab. Click the
"New" button to get to the "Edit Report Schedule" page.

Edit Report Schedule

Home Dashboard » Organizations » Organization » Report Schedule

Report Schedule | |

Report* Client Operational Summary j
Name* Maguire Operational Summary
Output Format Type*  XLS j

Zip Report Output File ¥ &
Qutput Format Order

Delivery Email*  jdoe@emaildomain.com

Schedule Type ™ j
Schedule Time* 12 :I 00 j am :I
Active M
Hext Run Date

Scheduled Time of Next Run
Report Period Start

Report Period End

Save Close

Creating areport schedule for an organization
Now configure the report schedule as described in _configurereportschedule onward.

Report Schedule Execution

When a BIRT report is executed according to a Transaction Manager schedule, the report has to have some way of knowing what date range it should
be generating data for. Similarly, an organization assignable report needs to know what organization it is being run against.

The way this is accomplished is by using parameters and naming conventions. Transaction Manager will examine the BIRT report and its input
parameters. It will look for and populate report parameters with the following names:

® “client_oid"This parameter will be populated with the organization ID (a number).
® "start_date"This parameter will be populated with the start date and time of the reporting period.
® "end_date"This parameter will be populated with the end date and time of the reporting period.

The end date is always the closest possible date and time before the time that the report is run. For example, if a weekly report is configured to return
data from Sunday 12pm to the next Sunday 12pm, you will get the most recent results possible by running the report Sunday afternoon.

The other thing to be aware of is the way report output is generated if the CSV output format type is used. In this case, the BIRT report will be processed
by Transaction Manager, the table named "data_table" (if it exists) will be parsed and its contents returned in the CSV file. All other tables will be
ignored. This allows you to either re-use the table displayed when viewing the report on-screen, or designate another table for CSV export.

For CSV reports, you can also instruct Transaction Manager to only return a sorted subset of the columns defined in the report's dataset by entering the
column names you wish to have extracted into the "Output Format Order".
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Triggering a Report Schedule

If you need to execute a report schedule that is not yet due to run, you can trigger it manually. This will generate the report email as per the settings for
the report schedule and send it out to the configured recipients.
To trigger a scheduled report, find the report (system reports: "Reports > System Report Schedules”, organization assignable reports: "Forms >

Organizations") and click the "Trigger the report schedule" icon ([ -1) next to the report. A new window will open to process your request. It can be safely
closed once it has finished loading (the window will remain blank).

Removing a Report Schedule

If you want to remove a report schedule, you have two choices: You can either irrevocably delete the report schedule, or you can deactivate it with the
option of reactivating it later.
To delete a report schedule, go to "Reports > System Report Schedules" (system reports) or "Forms > Organizations", edit the organization and switch

to the "Report Schedules" tab (organization assignable reports). Click the "Delete" icon ( #-!) next to the report schedule. You will be asked to confirm
this action before the report schedule is deleted.

To deactivate a report schedule, click the "Edit" icon ( E‘) next to it. On the "Edit Scheduled Report" page, untick the "Active" checkbox and save. As
long as the schedule is inactive, it will not be executed, and no emails will be sent out (though you can still manually trigger the schedule).

Reports Included in Transaction Manager

Transaction Manager comes with a set of sample reports that allow you to monitor form submissions. These reports will be loaded into a newly installed
system by default.
To use these reports, set up report schedules as described in the previous sections.

The "Operational Summary" Report

Operational Transaction Summary —

Organisation|(s): All
Start date: 17/10/2014 24:00
End date: 17/11/2014 24:00

System Admin User Completion Last Median Time
Form Name D Total Completed Abandoned Abandoned Abandoned Rate  Completed to Submit Payments Amount Paid|
A Secret Hidden Organisation 20 10 0 10 0 0 0% 0 $0.00
Insurance Application 224 7 0 7 0 0 0% 0 $0.00
USA Bank - Consumer Loan 174 3 0 a 0 0 0% 0 $0.00
Appli
FinanceCorp 1 1 1] 0 0 100% 200ct 14 =1 min 0 $0.00
Home Owners Insurance Quote 1 1 0 0 0 100% 200ct 14 <1 min 0 $0.00
Lena Test Client (4.0) 10 2 1 o 0 1 50% 27 Oct 14 5 min 0 $0.00
Test Attachment Form 53 2 1 0 0 i 50% 27 0d 14 5 min 0 $0.00
Waguire 7 4 3 1 0 0 75% 240ct 14 <1 min 3 §119.85
Credit Card Application 225 1 0 1 0 0 0% 0 $0.00
SmanForm PDF Test 228 3 3 0 0 0 100% 240c 14 <1 min 3 $119.85
Training 24 kT4 10 24 3 0 27% 12 Nov 14 2 min 0 $0.00
Avoka TransactWeb Workshop 240 16 5 il 0 o 3% 11 Nov 14 1 min 0 $0.00
For
CT Application 230 1 1 0 0 0 100% 03 Nov 14 <1 min 0 $0.00
CT Changing receipt type on Pu 233 1 0 1 0 0 0% 0 $0.00
CT Form Sharing 229 1 1 o 0 0 100% 03 Nov 14 4 min 0 $0.00
CT Form Sharing 24 4 1 3 0 0 25% 12 Nov 14 3 min 0 $0.00
CT Form Sharing - LC OutputRe 235 9 2 4 3 0 22% 03 Nov 14 4 min 0 $0.00
Populating DOL with an initial 238 5 0 5 0 0 0% 0 $0.00
Total 54 15 35 3 1 28% 12 Nov 14 <1 min 3 $119.85

The "Operational Summary" report

This report gives a fairly detailed overview of all organizations that have been set up on the system and submissions for their forms over a certain period.
The metrics include the number of completed and abandoned forms, completion rate and the date and time of the most recent completed submission.
Note that submissions that are in progress (saved, submitted with user tasks outstanding) are not included in the report.

This system report accepts three parameters: Start and end date, and the organization to report on (or "All Clients" to show everything).

The "Client Operational Summary" Report
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Operational Transaction Summary J—

Organisation: maguire
Start date: 17/09/2014 24:00
End date: 17/10/2014 24:00

System Admin User Completion Last Median Time

Form Name D Total Completed Abandoned Abandoned Abandoned Rate  Completed to Submit Payments Amount Paid
Account Opening 2 a3 3 0 k| 0 ] 0% 0 $0.00
Account Opening 3 34 5 0 5 0 0 0% 0 $0.00
Custom Block Test 35 2 0 2 0 0 0% 0 $0.00
Customer Onboarding 15 492 30 452 (1] o 6% 16 Oct 14 <1 min 0 $0.00
Customer Onboarding - Triage 9 7 7 i} 1] 0 100% 22 Sep 14 <1 min 0 $0.00
Customer Onboarding - Triage - 13 1 1 i] 0 0 100% 22 Sep 14 <1 min 0 $0.00
Ezidebit Form 14 1 0 1 0 0 0% 0 $0.00
Product Onboarding - Credit Ca il 1 0 1 0 0 0% 0 $0.00
Product Onboarding - Credit Ca 16 14 12 2 0 0 86% 26 Sep 14 <1 min 0 $0.00
Product Onboarding - Insurance 10 1 0 1 0 0 0% 0 $0.00
Product Onboarding - Insurance 17 13 8 5 1] 0 B2% 25 Sep 14 <1 min 0 $0.00
Product Onboarding - Refiremen 18 ] g o (1] o 100% 25 Sep 14 <1 min 0 $0.00
QUS - Paramedical Examination 54 2 2 1] 0 0 100% 16 Oct 14 1 min 0 $0.00
Total 550 68 482 0 0 12%  160c14 <1 min 0 $0.00

The "Client Operational Summary" report
This report is similar to the operational summary report, but it is designed to be used as an organization assignable report. Users cannot choose the
organization at render time, which makes it safe for use by organization administrators.

The "Payment Reconciliation” Report

Daily Payment Report Avoka Transact

Organisation: Northern Territory Government
Batch: 20130125

Submission ID Receipt Number Payment ID Payment Time Payment Receipt Amount
15 tpf-ntgov-3 3 25 Jan 2013 12:16 140312301 $120.00
Total $120.00

The "Payment Reconciliation" report

This report provides a list of credit card payments made for an organization in a 24-hour period ("batch”). It can be used by the organization to reconcile
payments against the reports they receive from the payment gateway provider.

Please refer to Online Payment (Manager v5.0) for more information about credit card payment in Transaction Manager and the concept of a batch.
This organization assignable report can be scheduled and emailed out as PDF, XLS or CSV (for automated reconciliation and processing).

The "Transactions By Day" Report

Transaction Report

Avoka Transact

Start date: 24/07/2013 24:00
End date: 31/07/2013 24:00

Date Transactions Renders Saves Email LC Forms LC Reader LC Output LC Digital LC Proc FieldWorker Address  Static
Verifications Extensions Signatures  Mgmt Lookups PDF

Jul 24, 2013 1" 33 9 0 1 1 10 0 0 [ 0 1

Jul 25, 2013 9 90 1 0 0 0 8 0 0 1 0 0

Jul 26, 2013 8 20 3 0 3 3 8 0 0 4 0 0

Jul 27, 2013 0 0 0 0 0 0 0 0 0 0 0 0

Jul 28, 2013 0 0 0 0 0 0 0 0 0 0 0 0

Jul 29, 2013 23 63 = 0 ) 3 23 1 1 6 0 0

Jul 30, 2013 20 63 8 0 2 2 20 0 0 14 3 0

Total 71 269 24 0 9 9 70 1 1 N 3 1

The "Transactions By Day" report

This system report is used to collect transaction metrics for licensing purposes. It will show transaction data for each day in a specified date range.
You can view this report to see how many billable transactions have been processed in your system. Alternatively, refer to Operations (Manager v5.0)
#_sec_transactionlog to see how you can review transaction log data via the Transaction Manager management console.

The "Transactions By Month" Report

Transaction Report

Avoka Transact
Start date: 08/2012
End date: 07/2013

Date Number of Transactions Renders Saves Email  LC Forms LC Reader LC Qutput LC Digital LC Proc FieldWorker Address  Static
Verifications Extensions Signatures  Mgmt Lookups PDF
04/2013 21 190 336 39 1 65 63 189 1 1 69 1
05/2013 3 219 498 56 5 42 42 219 0 0 109 0
06/2013 30 15 87 5 0 1 1 14 0 0 4 5 0
07/2013 N 292 982 10 0 96 96 290 1 1 58 6 2
Total 13 716 1903 210 6 204 202 712 2 2 240 1 3

The "Transactions By Month" report

This system report is used to collect transaction metrics for licensing purposes. It will show transaction data for the last twelve months, grouped by
month (note that the report in the screenshot was taken from a server with less than a year of available licensing data).

You can view this report to see how many billable transactions have been processed in your system. Alternatively, refer to Operations (Manager v5.0)
#_sec_transactionlog to see how you can review transaction log data via the Transaction Manager management console.

The "Organization Transactions By Day" Report
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Transaction Report Avoka Transact

Organisation: fincorp
Start date: 24/07/2013 24:00
End date: 31/07/2013 24:00

Transactions Renders Saves Email  LC Forms LC Reader LC Qutput LC Digital LC Proc FieldWorker Address  Static

Verifications Extensions Signatures  Mgmt Lookups PDF
Jul 24, 2013 9 33 £l 0 0 0 8 0 0 6 0 1
Jul 25, 2013 4 90 1 0 0 0 4 0 0 1 0 0
Jul 26, 2013 8 20 3 0 3 3 8 0 0 4 0 0
Jul 27, 2013 0 0 0 0 0 0 0 0 0 0 0 0
Jul 28, 2013 0 0 0 0 0 0 0 0 0 0 0 0
Jul 29, 2013 14 63 3 0 0 0 14 0 0 6 0 0
Jul 30, 2013 15 63 5 0 0 0 15 0 0 14 0 0
Total 50 269 21 0 3 3 49 0 0 3 0 1

The "Organization Transactions By Day" report

This organization report is used to collect transaction metrics for licensing purposes. It will show transaction data for each data in a specified date range.
You can view this report to see how many billable transactions have been processed for a specific organization. Alternatively, refer to Operations
(Manager v5.0)#_sec_transactionlog to see how you can review transaction log data via the Transaction Manager management console.

The "Organization Transactions By Month" Report

Transaction Report o —

Organisation: fincorp
Start date: 08/2012
End date: 07/2013

Date Number Transactions Renders Saves Email LC Forms LC Reader LC Output LC Digital LC Proc FieldWorker Address

of Days Verifications Extensions Signatures  Mgmt Lookups
0442013 21 89 336 28 1 1 1 88 0 0 43 1
05/2013 n 126 498 22 5 2 2 126 0 0 66 0
06/2013 30 T 87 2 0 0 0 6 0 0 3 0 0
0712013 N 170 982 104 0 L 5 168 0 0 55 0 2
Total 13 392 1903 156 6 8 8 388 0 0 167 0 3

The "Organization Transactions By Month" report

This organization report is used to collect transaction metrics for licensing purposes. It will show transaction data for the last twelve months, grouped by
month (note that the report in the screenshot was taken for an organization with just three months of available licensing data).

You can view this report to see how many billable transactions have been processed for a specific organization. Alternatively, refer to Operations
(Manager v5.0)#_sec_transactionlog to see how you can review transaction log data via the Transaction Manager management console.

Configuring BIRT Logging

BIRT can be configured to log information to the file system. This information can be useful for debugging purposes, but the log file needs to be
monitored and purged if necessary.

Transaction Manager provides configuration options to tune the BIRT log level (or turn logging off completely) and to configure where the log files are
written.

To configure the log level, edit the space named "Business Reports" and modify the space property "BIRT Log Level". Acceptable values are "OFF",
"SEVERE", "WARNING", "INFO", "CONFIG", "FINE", "FINER" and "FINEST".

To configure the log directory, modify the space property "BIRT Log Directory".
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Services (Manager v5.0)

This chapter explains what Transaction Manager services are, what functions the standard services perform, and how to manage services.

Search

Concepts

A service in Transaction Manager is a software module providing specific functionality on demand. Services have a service type describing the
functionality (e.g. virus scanning) they implement. There can be multiple services per service type, one of which will be set up as the default service for
that type. Services can be specific to an organization, which can make sense for services that can be associated with specific organizations or forms and
should not be visible to other organizations.

Services are uniquely identified by their name and version number. Services with the same name are considered to be different versions of the same
service.

Services may require a service connection, which is basically a set of connection parameters to a certain endpoint (e.g. the LiveCycle server). Services
can also have a set of arbitrary service parameters controlling their behavior.

Because of the big part custom services often play, TM supports setting up unit tests for custom services. These can be used to validate service
functionality after making changes.

Service Types Defined in Transaction Manager

Transaction Manager uses several services for various tasks such as rendering forms or virus scanning files. This section lists and describes these
service types.

The Data Retention Management Service
This service is periodically called by the Data Retention job. It is responsible for purging a variety of entities within Transaction Manager (such as

submission data and error logs). While this service comes with a set of default settings, configuring a suitable data retention policy is very important.
Please refer to Operations (Manager v5.0)#_sec_dataretention for more information about data retention.

The Delivery Process Service

This service is called when a submission with a delivery method of "LC Process" is being delivered. It is responsible for passing the submission data
across to the LiveCycle orchestration that is being invoked.

The Dynamic Data Service

This service can be called by forms to obtain data dynamically while they are being filled in (e.g. data lookup or validation using external services). By
default, a Groovy Dynamic Data service is provided, which will perform the lookup using a Groovy script configured as a service parameter. This means
that the lookup behavior can be changed by modifying this service parameter, without requiring a restart or rebuild of Transaction Manager.

The Email Queue Service

This service is responsible for processing emails stored in the email queue, including retries (see Outgoing Email (Manager v5.0)#_sec_emailqueue).

The Find Delivery Process ID Service

This service can update the delivery process ID assigned by Adobe LiveCycle for submissions delivered to an Adobe LiveCycle process. This
information can be used for debugging purposes.

Please note that when the service connects to Adobe LiveCycle to retrieve the process ID, it uses the service connection defined for the Delivery
Process service that delivered the submission originally. Therefore, it is not necessary to define a service connection for the Find Delivery Process 1D
service itself.

The Form Meta Data Service

This service is called by the user space to render the metadata related to the form as HTML.

The Form PDF Pre-Render Service

This service is called when a new Composer SmartForm with an XDP form template is created. It uses an Adobe LiveCycle orchestration to pre-render a
PDF from the XDP template. This PDF is used for form rendering, which speeds up rendering and reduces the load on LiveCycle's processes.

The Form Prefill Service
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This service is called at form render time. It is responsible for retrieving prefill XML data for the form. The exact service used can be defined at a form
version level, and a global default service can be defined.

The Form Saved Processor Service

This service is called when a form is saved to Transaction Manager, and the form version in question has been associated with a Form Saved Processor
service.
The default service provided by TM allows you to specify custom logic in a Groovy script.

The Form Security Filter Service

This service is called when a new submission is started, or a saved submission is resumed. It can be used to implement custom security checks in
addition to the checks performed by TM. TM includes a Groovy service template as a starting point.

Once you have a service, you can associate it with specific form versions as described in Form Version Configuration (Manager v5.0)
#_sec_configureservicesforversion.

The Form Server Load Balancer Service

This service is called by various operations involving LiveCycle (e.g. rendering forms and receipts), and is used to ensure capacity to perform the
operation is available. It also performs load balancing if more than one LiveCycle server is available.

The Form Version Selector Service

This service is used when a form is rendered and is responsible for choosing the appropriate form version to render. The default service named "Current
Version Selector" will simply return the current form version unless a specific version was requested.

If you would like to customize the way versions are selected (e.g. for A/B testing), you can create your own form version selector service and implement
custom logic in a Groovy script.

The form version selector service can be configured on the form level (see Form Configuration (Manager v5.0)#_sec_formdetails). If not specified for the
form, the form version selector service that is marked as the system default will be used.

The Groovy Service

This service can be used to provide Groovy code that can be reused by other Groovy services in the system. TM itself does not directly call services of
this type.

The Job Action Service

This service provides a "Job Action" service related to collaboration jobs.

The Job Action Wait Service

This service provides a "Job Action Wait" service related to collaboration jobs.

The Job Controller Service

The Job Controller service is responsible for creating new collaboration jobs for a submission and then processing the collaboration job. It needs to be
associated with the form version.

The Job Delivery Service

This service provides a "Job Delivery" service related to collaboration jobs.

The Job Delivery Wait Service

This service provides a "Job Delivery Wait" service related to collaboration jobs.

The Job Form Start Service

This service provides a "Job Form Start" service related to collaboration jobs.

The Job Process Message Service

This service provides a "Job Process Message" service related to collaboration jobs.

The Job Receipt Wait Service

This service provides a "Job Receipt Wait" service related to collaboration jobs.
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The Job Task Assign Service

This service provides a "Job Task Assign" service related to collaboration jobs.

The Job Task Wait Service

This service provides a "Job Task Wait" service related to collaboration jobs.

The Payment Gateway Service

This service is used to process payments. It is used to connect to a payment gateway and make a transaction. Please refer to Online Payment (Manager
v5.0) for more on payments in Transaction Manager.

The Payment Reminder Service

This service is periodically called by the Payment Reminder job. It sends out reminder emails about submissions with outstanding payments older than a
certain age (configured as the "reminderAgeHours" service parameter). Emails will be sent to administrators belonging to the "Receive Outstanding
Payment Alerts" group.

The Receipt Number Service

This service is used by Transaction Manager to calculate receipt numbers for new submissions. It can be configured on the form level (see Form
Configuration (Manager v5.0)#_sec_trackingcode), with the default Receipt Number service serving as a fallback.

The Render Composer HTML Form Service

This service is responsible for rendering Composer SmartForms.

The Render eSignature Receipt Service

This service is used to render an electronically signed receipt to the user.

The Render Form Service

This service is called when a form is opened for fill-in. The service will use an orchestration in LiveCycle ES to render the form.

The Render Offline Submission Form Service

This service is called when a form is submitted after being saved offline. The service will use an orchestration in LiveCycle ES to render the form.

The Render Receipt Service

This service is called when a form receipt is opened. The service will use an orchestration in LiveCycle ES to render the receipt. Typically, receipts are
rendered statically, with all interactive form features (such as buttons and text fields) disabled.

The Repository Publish Service

This service is used by Transaction Manager to publish a single form to the LiveCycle repositories.

The Repository Synchronize Service

This service is used to bring the LiveCycle repositories up to date after the set of form versions has changed.

The Scheduled Service

This service can be configured to execute custom logic, which is defined in a service parameter containing a Groovy script. The Scheduled Service job
can be configured to call this service on a custom schedule.

The Submission Completed Processor Service

This service will be called only if it is configured as the "Submission Completed Processor" service for a form version (see Form Version Configuration
(Manager v5.0)#_sec_configureservicesforversion). It is called when a submission is completed by the user and can perform further checks or actions at
this point (e.g. assign a new review task based on the submission data).

Transaction Manager provides a service that allows you to specify the desired behavior as a Groovy script, and another that allows the specification of
simple actions as XML.

The Submission Data Extraction Service

This service is called on form submission. It passes the submitted form to LiveCycle and retrieves the submission XML data.
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The Submission Data Storage Service

This service is responsible for storing and retrieving submission, receipt and attachment data.

The Submission Data Validator Service

This service is responsible for validating submission data when a submission is submitted (not saved or abandoned) by the user. This can be used to
prevent users from making fraudulent submissions.

If the service returns an error, the submission is accepted but the errors are recorded and the submission is delivered using a specialized delivery
channel for submissions with data validation errors.

You can create your own submission data validator service by using the Groovy service template provided.

The Submission Delivery Controller Service

This service is responsible for a number of features around submission delivery (such as delivery itself, marking submissions as undeliverable, sending
reminders etc).

The Submission Email Verification Service

This service is responsible for sending email verification requests to users who have submitted a form. It is also called by the Submission Email
Verification Reminder job to send reminders for users who have yet to complete outstanding email verification requests.

The Submission Preprocessor Service

This service is called when a form is submitted, but before the submission is stored to the database. It has the opportunity to check and/or modify
submission content and metadata, and can reject a submission entirely.
This service can be configured per form version, and a global default service can be used as a fallback.

The Submission Receipt Service

This service is called periodically by the Transaction Processor service. It is responsible for creating and storing receipts for new submission, and re-
attempting to render receipts for submissions where previous attempts failed.

The Task Expiry Process Service

This service is called when a task expires (which happens when the expiry date is reached without the task having been completed). The service is
responsible for invoking an external process to notify it of the task having expired.

The Tracking Number Service

This service is used by Transaction Manager to calculate tracking codes for new submissions. It can be configured on the form level (see Form
Configuration (Manager v5.0)#_sec_trackingcode), with the default tracking number service serving as a fallback.

The Transaction History Creation Service

This service is called by the Transaction Processor service and extracts relevant metrics from form requests and submission records for reporting
purposes.

The Transaction History Publish Service

This service can be called by a scheduled job to publish transaction history data to a customer system.

The Transaction Processor Service

The Transaction Processor service is called by the Transaction Processing job and performs submission processing in the following order:
Abandonment, receipting, delivery, task expiry, transaction history creation and data retention.

Two Factor Authentication Service

This service is responsible for validating the second factor in two-factor authentication. Please refer to the Transact Integration Guide for more on two-
factor authentication in TM.

The Virus Scan Service

This service is used to scan attachments stored in Transaction Manager for viruses. If this service is not configured, no virus scanning will be done.

Managing Service Connections
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Many services need to connect to a server to function properly. These connection details are set up using a service connection. Service connections are
managed separately to the services themselves, which allows you to reuse and change service connections easily.

Please note that some service definitions (notably those related to rendering forms and receipts) do not use their own service connection. Instead
individual requests are assigned an available form server node, which handles the request and defines its own service connection. Refer to Scalability
and Server Nodes (Manager v5.0) for more information on server nodes.

Browsing the List of Service Connections

To see all service connections set up in Transaction Manager, go to "System > Service Connections" (see below).

The list can be filtered using a substring of the service connection name and the endpoint value, and export the search results to Excel by clicking the
"Export Data" link below the table.

Service Connections

Home > Service Connections

|~::-, Clear

New
Name Endpoint Transport Form Server Action
Amazon 53 @&
ClamAV Virus Scan localhost:3310 &
FormServer Connection jnp:/fiocalhost:1099 EJB v A
LiveCycle ES npilfc2-es25:1009 EJB A
Symantec Virus Scan  localhost: 1344 (Eal~a]

Export Data

Browsing the list of service connections
=3 —_—

This page allows you to create new service connections, edit existing connections ( ) and delete service connections ( #-).

Editing a Service Connection

=2
To edit a service connection, go to "System > Service Connections" and click the "Edit" icon ( & ) next to the connection. You will be directed to the
"Edit Service Connection" page.

FormServer Connection
Home Dashboard » Service C A » Service Connection

Name* FormServer Connection
Endpoint  jnp:/Aocalhost:1099
Username  administrator

Password ssesssss
Server Type = JBoss j

Transport  EJB j
Form Server | @

LC Use Auth. Mgr. [~

Editing a service connection

Change the fields as required (depending on the service using the connection, not all fields will be used) and save the connection.

One important field is the "Form Server" checkbox. This should be ticked if the service connection is being set up for use with a form server node, which
is used to host LiveCycle (see Scalability and Server Nodes (Manager v5.0)). If ticked, all communication with the remote server will take place using the
"Form Server" Transaction Manager module (which must be deployed on the server). In addition, the "Endpoint” field must then contain the URL of the
endpoint relative to the "FormServer" module (which is typically on the same server, so is referenced by using "localhost" or a local IP address). For

service connections where the "Form Server" checkbox is not ticked, the "Endpoint” field must still contain the URL as accessible to Transaction
Manager itself.

Deleting a Service Connection

While you can delete service connections, make sure to update all services using the service connection before you do so. Otherwise a service may be
left without a service connection, which will most likely cause it to fail.

=i |
To delete a service connection, go to "System > Service Connections” and click the "Delete" icon ( #-') next to the service connection. You will be asked
to confirm this action before the connection is irrevocably deleted.

Managing Service Definitions

This section describes how to view and manage the service definitions set up in Transaction Manager.

Browsing the List of Service Definitions
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To view the list of all service definitions, go to "System > Service Definitions".
Service Definitions

Home Dashboard » Service Definttions

Type = Dynamic Data j Org App Pack j O Groovy Only VW Active Only Clear
New Copy Import Export
Service Name Version Cipeat Org. Type Connection Default . tive Last Modified Action
Version Type
ABR Entity Lookup 1 v g:::m": Make Defaut ¥ 13 Nov 2015 by bwarner BKE
Address Logkup 1 v g:r:m'c Make Defaut ¥ 16 Oct2015 by Ipammer G
Address Lookup Google Detail 1 v Ly Make Defaut B A ek 4
Data jclagnan@avoka.com
Address Lookup Google . r Dynamic T 02 Nov 2015 by [EalEN ]
Search Data I jclagnan@avoka.com
Address Lookup Mastersoft 1 I g:::m'c Make Defautt ¥ 14 Oct2015 by kkuba@avoka.com @
Au 0tix Verify Document 1 I g:::m'c Make Defautt ¥ 23 Oct2015 by mbotka@avoka.com @
dan dds test 1 v Dynamic Transact Integration Make Defaut ¢ 14 Oct 2015 by diu@avoka.com BRE
Data Gateway
Experian Verication 1 v HSBC g:r:m'c MakeDefau v 23 0ct2015 by mbotka@avoka.com |2 i L4
InstantiD 1 v g:?:m'c Make Defaullt v 17 Hov 2015 by diu@avoka.com ek 4
InstantiD QA 1 I g:?:m'c Make Defautt ¥ 18 Nov 2015 by diu@avoka.com RaEe

Export Data

Browsing the list of service definitions

You can filter the list using the organization, a substring of the service name, the service type (e.g. "Render Form"), an application package (see Organiz
ation Configuration (Manager v5.0)#_sec_setupapplicationpackages), whether the service is Groovy based and whether the service is marked as active.
When filtering by organization, you will be shown all services available to that organization, which includes global services. Organization administrators
can see but not modify global service definitions.

To assist you in auditing configuration changes, the last modified date and the user modifying the service are displayed in the "Last Modified" column.
This information is also available for individual service parameters.

=% =i |
This page allows you to create new service definitions from a template, copy, edit ( 4 ) and delete existing service definitions ( #-') as well as setting a
service definition as the default for its service type ("Make Default"). You can also export and import the set of service definitions.

If a service supports unit testing, you can run the unit tests for it ( [.b).

Editing a Service Definition

=
To edit an existing service definition, click the "Edit" icon ( # ) next to it.
You will be directed to the "Edit Service Definition" page.

Groovy Form Version Selector - v1
Home Dashboard » Service Definitions » Service Definition

Service Definition I Groovy Script I Parameters Edit | Parameters. Unit Test Test Parameters Groovy Service Log I Service Usage

Service Name *  Groowy Form Version Selector @
Version Number® | 1 =]
Current Version [
Description A service that uses a Groovy script to select the form version to render.
Service Type™  Form Version Selector j 2]
Organization Maguire @
Service Type Defaut [~ &
Service Connection j @
Server Node j a9
Active W @

Save Close

Editing a service definition
The service name combined with the version number needs to be globally unique, even if the service belongs to a specific organization.

If you are a global administrator, you can choose to assign the service definition to a specific organization. If you do so, the service definition is invisible
to organization administrators of other organizations and be associated only with the same organization or its forms. System related service types such
as "Email Queue" should be global, while other services such as "Dynamic Data" or "Delivery Process" might be candidates for organization-specific
services. If you change the organization a service is assigned to, please be aware that all entities belonging to other organizations (e.g. form versions)
that are currently associated with this service will be disassociated and may have to be assigned new services. In most cases, it is better to create a new
service for a particular organization rather than change a global service to be organization-specific.
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The service type determines what this service is used for. Tick the "Service Type Default" checkbox to make this service the system default one for its
type. This setting may not be relevant for some service types; for example, services of type "Dynamic Data" are always resolved by name and the
"Service Type Default" setting is not used.

The class name of the service's Java class (or possibly the Spring bean name) is displayed in the "Classname / Bean Name" field. The class must be
one of the classes pre-defined in Transaction Manager (while new service classes can be added in theory, this is beyond the scope of this document).

If the service requires a connection to a server, select the appropriate service connection from the "Connection" dropdown.

If the service needs to connect to a specific server node defined in TM (e.g. delivery service only present on a dedicated server), select the server node
from the "Server Node" dropdown.

If you wish to deactivate a service, uncheck the "Active" checkbox. This will prevent the service from being displayed in various contexts, including on
the form version edit page. You can later reactivate the service if it needs to be reinstated.

Click the "Save" button to save your changes. From now on, the service will use the new configuration when called.

Editing the Groovy Script

The "Groovy Script" tab is displayed for services based on a Groovy script. It allows you to edit the Groovy script directly.
Groovy Submission Completed Processor

Home Dashboard » Service Defintions » Service Definition

Service Definition | Groovy Script | Service Parameters | Service Usage

import com.avoka.component.xml.XmlDoc
import com. -component . marketo.MarketoClient
import com. .fo.core.service .EventlogService

ot the form XML D

def mlDoc = mew ¥mlDoc|submissionXML) ;

= xmlDoc.getText('//Name/Email ")

[=]

Name™] = mmlDoc.getText('//Hame
" xmlDoc. gecText | '/ /Name

= zmlDoc.getText (" //Name/Loc

= mmlDoc.getText (" //Name/Location/US_St

st

Value def url = serviceParameters ["HMarketo
def accessFey = serviceParamec ™
def secretley = serviceParams

rs["

def marketoClient = new MarkectoClient{url, accessEey, secretEey)

ent. getCookieValue (submission. requestCookie)

synclead{email, attrs, trackingCockie)

reate to Lead Bsc

def leadRecord = marketoClie

Nt ervice = n
eventLogServiee logInfalw + leadBecord.id, submission)

Groovy Services Guide Avoka TM Javadoc AP
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The Groovy script for a service

Managing Service Parameters

Services can define service parameters, which can be used to change how the service behaves. For example, the submission data storage service
allows you to specify whether submission XML shall be encrypted and compressed before storage.

To view the list of service parameters, go to "System > Service Definitions" and edit the service definition, then switch to the "Service Parameters" tab.
You will see the list of all service parameters and their current values.

GI’OOVV Submission Completed Processor
Home Dashboard » Service Definition

Service Definition | Groovy Script | Service Parameters | Service Usage
Name Type Value Description Bind Parameter Last Modified Action
createTaskFlag Boolean ftrue 28 Mar 2014 by lpammer =4 ,'=|
groovyScript Groovy Script /™ Provides a Groovy script form submission complete...  The Groovy scripl to execute 'l 17 Mar 2014 by lpammer  [7) ,'='|
MNew Close

Viewing the list of service parameters
Note that the time the parameter was last modified and the user who made the change are shown in the "Last Modified" column.

You can also edit the parameters to change their value. However, as services are vital to Transaction Manager, please make sure to make changes only
if you know how the service and its parameters work.

=

If you want to edit a service parameter, click the "Edit" icon ( £ ) next to it. You will be directed to the "Edit Service Parameter" page (see below), where
you can enter a new value for the parameter. Depending on the parameter type, you may be offered a specialized editor.

Please do not change the value of the "Bind Parameter" checkbox. If unticked, the parameter will not be automatically passed to the service upon
instantiation; such parameters are used to augment customizable services (such as Spring Bean and Groovy services).

If a parameter is absolutely required for the service to work and cannot be left blank, tick the "Required" flag. Note that the service may not execute if
required parameters are not set.
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Tick the "Clear Value on Export" checkbox if you would like the parameter value to be excluded when exporting the service. This can be useful for
values that need to be reconfigured on every environment, or sensitive values like passwords.

If the parameter is used only for service unit testing, tick the "Unit Test" checkbox.

Once you are done editing, save the parameter.
Random Receipt Number - v1 - Parameter characterValues

Home Dashboard » Service Definitions » Service Definition » Service Parameter

Service Parameter | Parameter History |

Name characterValues

Description  The list of character values to generate the random receipt number from.
Bind Parameter [ @
Required [~ @
Clear Value on Export [ @
Unit Test [~ i@

1 BCDFCHJELMNDQRSTVWHYZIZ345678%5

Value

Save Close

Editing a service parameter

To view a history of the changes made to a service parameter, you can switch to the "Parameter History" tab. You can see exactly when and by whom
changes were made, and view, compare with and restore older values.

Home Insurance Quote Review Service - ParameterjobDeﬂ nition
Home Dashboard » Service Defintions » Service Defintion » Service Parameter

Service Parameter | Parameter History I

Version Value Created At Created By Action
1 { “jobDetails™: { “name”: “Application Review", }, “steps™ [ { "name™ "A... 14 Mar 2014 11118 AW medgar O a5
2 { “lobDetails™ { "name”™. "Home Insurance Quote Review", “version™ "4.0 ALPHA 18" ... 14 Mar 2014 11:21 AW medgar QB ‘='|
3 { "jobDetailz™ { "name™ "Home Insurance Quote Review", “version™ "4.0 ALPHA 19.. 14 Mar 2014 11:28 AM  medgar O35
4 { “jobDetails™: { “name™: “Home Insurance Quote Review", “version™ “4.0 ALPHA 19" . 14 Mar 2014 16:44 PM  medgar QO =RE

5 { “ebDetails™ { “name”: "Home Insurance Cuote Review", “version™ "4.0 ALPHA 20" ... 17 Mar 2014 13:04 PM  medgar

ol

Change history for a service parameter

Changing Service Parameter Values
If you just need to change parameter values, you can use the parameter editor page. Edit the service definition and switch to the "Parameters Edit" tab.

Groovy Form Version Selector - v1

Home Dashboard b Service Definttions b Service Definition

Service Definition | Groovy Script | Parameters Edit | Parameters | UnitTest | TestParameters | Groowy Service Log | Service Usage

Execution Timeout sooo0 &
Groovy Logging Enabled ¥ @
Groovy Script  Edit Parameter. &
Groovy Type Checked [ @
lanore Form Version Request Parameter [ @

Changing the values of service parameters

Enter values for any parameters you want to change and click "Save".

Service Usage

The "Service Usage" tab is shown for service types that can be explicitly associated with entities such as form versions, organizations and delivery
channels. It helps you determine where the service is used, so you can avoid unwanted side effects when modifying / deleting the service.
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Hybrid Cloud Submission Data Storage - v1

Home Dashboard » Service Definitions » Service Definition

Service Definition | Parameters Edit | Parameters | Service Usage |

Overview of the entities using this service. Pleaze note that not all services have direct entity associations which can be listed, for example "Groovy Service”
This service is marked as the default for type 'Submission Data Storage'. Depending on the service type, it may be used by numerous entities in the system.
Associated Entities

593 submission(s) for data storage

Close

Service usage for a service of type "Submission Data Storage"

Creating a Service Definition from a Template

To create a new service, go to "System > Service Definition" and click "New". You will be able to create a new service based on a template on the "New
Service" page.

Mew Service
Home Deshbosd ¢ Servics Definlicna ¥ New Servce

Cregle & new Servics bassd an a Servics Temphls,

Earviee Type | Recept Humber j @

Service Tamplale™  Groowy Receipt Mumber jt&

Service Hame™ | Sy Diget Fecsspt Mumber @
“Werabn Number® | 1 )
Organcaton | Maguine j

e

Creating a service definition
First, choose the service type from the "Service Type" dropdown. Each service type may have multiple templates; please choose the most suitable from
the "Service Template" dropdown.

Give the new service a name (if this is a totally new service, give it a globally unique name; if a new version of an existing service, you can use the same
name as the existing service with a new version number).

If you are a global administrator, you can associate the service definition with a specific organization. If you do so, the service can be associated only
with forms and other entities belonging to that organization; if you do not select an organization, the service will be globally available.

Click "Save" to create the service. You will then be taken to the "Service Edit" page, where you can configure the service as needed (see _sec_editservic
edefinition).

Copying a Service Definition

You can create a copy of an existing service definition that inherits its base configuration and all service parameters from the original service rather than
a service template.

To copy a service definition, go to "System > Service Definitions" and click "Copy". You will be redirected to the "Copy Service Definition" page (see
below).

Copy Service Definition
Hoema Dashboard & Sarvice Defnidiona » Copy Sarvice Definticn

Service Type™  Recmipt Mumber j
Exating Service Hame ™ | Saguenice Fattem Recspt Mumber - vl j

New Kama ™ Sequenoe Patten Aeceipt Number

Veeralon Mumber® 2

Oinganizalian j

Save Cance

Creating a copy of a service definition
Choose the service type for which you want to create a new service definition.

Now select the service you would like to create a copy of from the "Existing Service Name" dropdown.

If you are just creating a new version of the service, leave the name as is and check the version number (TM will suggest a suitable version number for
you). Otherwise, enter a unique combination of service name and version number.

If you would like to restrict the new service to a specific organization, select the organization from the "Organization" dropdown and save. This option is
not available to organization administrators; for them, the new service definition will always be associated with their organization.

Transaction Manager creates a new service, which is identical to the original apart from the name. If you would like to make any changes to the new
service, edit it and change service parameters as described in the preceding sections.
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Deleting a Service Definition

When deleting a service definition, make sure it is not used anywhere (e.g. form versions) to avoid errors. It is not recommended to delete a service that
is the default for a service type.

=i
To delete a service definition, go to "System > Service Definitions" and click the "Delete" icon ( #-)) next to it. You will be asked to confirm this action
before the service definition is irrevocably deleted.

Importing / Exporting Service Definitions

You can export service definitions, their parameters and associated service connections, to be imported to a different Transaction Manager instance or
for backup purposes.
To learn about how to export and import services, please refer to Multi-Environment Support (Manager v5.0)#_sec_migrateservices.

Groovy Based Services

Service definitions that can be swapped out and configured at runtime add a lot of flexibility to your system; however, often the requirements for the
functionality that a service provides vary widely and can change over time. Transaction Manager addresses this issue by providing services that are
based on a Groovy script (Groovy is a programming language related to Java). The Groovy script encapsulates the basic functionality that the service
provides (depending on service type; for example, custom delivery logic for a submission delivery service), and can be freely adjusted at runtime.
Groovy services make it possible to integrate with a wide variety of third party systems, or even just to provide customizations or adjustments that fall
outside the scope of service parameters provided by Transaction Manager. Do note that Groovy services could be used to run malicious code on
Transaction Manager, and while Transaction Manager contains safeguards to mitigate this issue, it is important that you regulate access to Groovy
based services carefully.

For more on specific Groovy services such as submission delivery, dynamic data retrieval and form prefill, please refer to the Transact Integration Guide.

For unit test support, please refer to the Transact Services Guide included in the TM management console ("System > Transact Services Guide").

The Groovy Services Guide

To help you develop your own Groovy scripts, TM comes with its own service development guide that contains some Groovy basics, tips and tricks as
well as documentation about the Groovy extension points provided in Transaction Manager.
The Groovy services guide can be accessed via "System > Transact Services Guide".

The guide also explains how to set up unit testing for a service.

The Groovy Script Console

Groovy scripts must be constructed and tested carefully to avoid runtime errors. To make script development easier, the Transaction Manager
management console provides a Groovy script console, which allows you to enter and evaluate your scripts.
To access the Groovy script console, go to "System > Groovy Script Console".

Groovy Script Console

Home Dashboard » Groovy Script Console

Groovy Script l Service Parameters |

Groovy Script

return submission.getld|

Seript Type Checked [~ @ Execution Timeout (sec) | 60 o

Execute Script Clear Qutput Clear Script Save Script Copy Senvice j 7

Groovy Services Guide Awvoka TM Javadoc AP|

Execution Output

The Groovy script console
Enter the script in the "Groovy Script" area and click "Execute Script" to evaluate the script and see the results. Tick "Script Type Checked" to enabled
Groovy type checking (see http://docs.codehaus.org/display/GROOVY/Type+checking+extensions for more on type checking in Groovy).
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Note that output printed to System.out (e.g. via "printin®) will be shown in the "Script output" window. However, output printed to System.err will not be
shown. To see the value your script returns, you'll need to print it to System.out as well.

You can also initialize the script from an existing service definition by selecting the service from the "Service" dropdown and clicking "Copy Service". If
the service has other service parameters, these will also be loaded for testing purposes.

You can save the current script against your user account preferences by clicking "Save Script" or clear the stored script by clicking "Clear Script".

Finally, you can create service parameters that will be used when testing your script on the "Service Parameters" tab.

The Groovy Service Log

The Groovy service log contains records logging the execution of Groovy services when they complete successfully or in specific error cases.
Groovy service logging can be globally disabled by setting the deployment property "Groovy Logging Enabled" to “false". In addition, Groovy service
logging can be enabled or disabled for each service by setting the parameter "groovyLoggingEnabled" to "true" or "false".

To view the Groovy service log, go to "System > Groovy Service Log". You can filter the list by organization, service type, service (by name), status
("Completed"/"Error"), minimum duration and date.

Groovy Service Log

Home Dashboard » Groovy Service Log

Service Type :] Service Name j Start Date | 15 Jul 2015 00:00 j m Clear

Call Status :J Min Duration (ms) End Date 3
Service Name Service Type Form Time Duration Memory Change CPU Threads Status Action
DocuSign Delivery Process Delivery Process  DocuSign Testd - HTML 22 Jul 142644 913 ms 36.2 MB 33 % 50 Completed [
DocuSign Delivery Process Delivery Process  DocuSign Testd - HTML 22 Jul 14:26:43 1,285 ms 439 MB 18 % 89 Completed (5
DocuSign Delivery Process Delivery Process  DocuSign Testd - HTML 22 Jul 13:26:30 B23 ms 7.7 MB 10 % 90 Completed (5
DocuSign Delivery Process Delivery Process DocuSign Testd - HTML 22 Jul 13:26:28 1,468 ms 8.2 MB B% B9 Completed ([
DocuSign Delivery Process Delivery Process  DocuSign Testd - HTML 22 Jul 12:26:15 844 ms 7.1 MB 13% 20 Completed (5
DocuSign Delivery Process Delivery Process  DocuSign Testd - HTHL 22 Jul 12:26:13 1,530 ms 8.2 MB 6% 89 Completed [
Groovy Scheduled Service Scheduled Service 22 Jul 12:00:00 28 ms 36 MB 83 % 90 Completed
DocuSign Delivery Process Delivery Process DocuSign Testd - HTML 22 Jul 11:25:58 828 ms 7.6 MB 22% 20 Completed ([
DocuSign Delivery Process Delivery Process  DocuSign Testd - HTML 22 Jul 11:25:58 1,264 ms 18.9 MB 12% 89 Completed ([
DocuSign Delivery Process Delivery Process  DocuSign Testd - HTML 22 Jul 10:25:45 826 ms 7.2 MB 10 % 50 Completed [[H

b 1-10 of 383 Export Data

The Groovy service log
For each entry, information identifying the service, date and time of the invocation, the result status and server performance information are shown.
Additional actions such as links to the submission and error log may also be included.
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Scheduled Jobs (Manager v5.0)

This chapter explains what scheduled jobs are, what functions the standard jobs perform in Transaction Manager, and how to manage jobs.

Search

Concepts

A scheduled job in Transaction Manager is functionality that has to run regularly to perform routine operations, such as triggering delivery, generate
receipts and temp file cleanup. Often a scheduled job will call the default service of a certain service type to do the actual work, which increases flexibility
by allowing you to swap out and reconfigure services. Unlike collaboration jobs (see Collaboration Jobs (Manager v5.0)), scheduled jobs are not
necessarily related to one or more submissions. Instead of coming with a fixed set of hard-coded schedules, Transaction Manager allows you to manage
existing scheduled jobs, modify their schedules, and control and monitor their execution.

Jobs have a schedule, which means they are automatically started by Transaction Manager at regular intervals. You can also pause and resume a
scheduled job, as well as trigger it manually if needed.

Transaction Manager provides two scheduling mechanisms: simple jobs and cron jobs. Simple jobs are characterized by a repeat interval and the
number of times a scheduled job should run. This is sufficient for regular scheduled jobs but allows no control exactly when a scheduled job runs. Cron
jobs allow finer grained control via a cron expression, which specifies both the run interval and the time the scheduled job should run. This is particularly
useful for maintenance jobs that need to run outside of peak times.

Transaction Manager uses the Quartz Job Scheduling Framework to manage scheduled jobs.

Managing Scheduled Jobs

To view the list of scheduled jobs set up in Transaction Manager, go to "System > Scheduled Jobs". As you can see, scheduled jobs have a name, a
status, and various fields describing their schedule.

Scheduled Jobs

Home Dashboard » Scheduled Jobs

Refresh Pause All Jobs Restart Scheduler New Scheduled Service Job New Job Copy Job

Job Scheduler running on server node tm-test1.

Job Name Status Type Schedule TZ NextRun Last Run First Run Action
Audit Job Paused Cron 0012**? +10 12:00 PM15Jul15 12:00 PM 14 Jul 15 02:14PM23Jun15 [ ‘= |}
Collaboration Job Controller Normal Simple 15 secs 03:26 PM 22 Jul15 03:26 PM 22 Jul 15 04:16 PM 25 Mar 14 [ '_' “ >
Data Keystore Rollover Normal Cron 0004 **? +10 0400 PM22Jul15 03:00 PM 22 Jul15 0546 PM10Apr13 [ &7 i >
Data Retention Normal Cron 001%*? +10 01:00 AM 23 Jul15 01:00 AM 22 Jul15 12:09PM 11 Jun 14 [P &7 i >
Delvery Escalation Normal Cron 03012** +10 01:30 AM 23 Jul15 01:30 AM 22 Jul15 05:46 PM 10 Apr 13 |'./] ‘_' “ [ g
Delivery Reminder Normal Cron 01512** +10 01:15AM 23 Jul15 01:15AM 22 Jul15 05:46 PM 10 Apr 13 |'.‘J ‘__' “ [)
Email Queue Normal Simple 1 min 0327 PM 22 Jul15 03:26 PM 22 Jul 15 05:46 PM 10 Apr 13 m x| ii [
HTTP Invoker Normal Cron 001**? +10 01:00 AM 23 Jul15 01:00 AM22Jul15 05:46PM10Aprc13 [ 01 B B
Payment Reminder Normal  Simple 1 hour 03:46 PM 22 Jul15 02:46PM22Jul15 05:48PM10Apc13 [P 0 BT B
Purge Unverified User Accounts Normal Simple 1 hour 03:46 PM 22 Jul15 02:46 PM 22 Jul15 05:46PM10Apr13 [ 20 B B
p 1-100f19 Export Data

Managing scheduled jobs

You can see that Cron jobs are associated with a timezone (the "TZ" column contains the timezone offset), which generally corresponds to the timezone
used on the TM server. Whenever TM is restarted, it will adjust the timezones for all Cron jobs if the system time has changed. If you are seeing
unexpected timezone values, check the system time settings of the server that Quartz is running on and restart TM if needed.

If there are issues when running scheduled jobs, one option is to pause or trigger individual jobs for debugging purposes. It is also possible to restart the
entire job scheduler by clicking "Restart Scheduler". This will reset the scheduler without the need to restart the TM server.

Note that if you are running multiple TM server nodes, the job scheduler will be running only on a single node. The "Scheduled Jobs" page displays the
node above the main table. Please ensure you are logged on to the management console on that node when making changes to scheduled jobs.

Adding or Editing a Scheduled Job

To add a scheduled job, click the "New Job" button on the "Scheduled Jobs" page (if the new job will be calling a service definition of type "Scheduled

Service", you can click "New Scheduled Service Job"). If you want to edit an existing scheduled job, click the "Edit" icon ( ) next to it. You will be
directed to the "Edit Scheduled Job" page.
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Edit Scheduled Job
Home Dashboard » Scheduled Jobs » Scheduled Job

Name Data Retention
Classname com.avoka fc.core job.DataRetentionJob
Description | Purges various logs. form and attachment data of completed submissions
Context Param

StartDate* | 11Jun 2014

E1E

End Date
Trigger Type* | Cron j
Time Zone  Australia/Sydney

Cron Expression* | 001°*7

Cron Expression Tutorial

Save Close

Editing a scheduled job

Enter the unique name of the scheduled job into the "Name" field. Enter the class name of the scheduled job's Java class into the "Classname" field. The
class must be one of the classes pre-defined in Transaction Manager (while new job classes can be added in theory, this is beyond the scope of this
document).

Optionally, you can enter a description that explains what your scheduled job does.

If the scheduled job can be parameterized, enter the parameter into the "Context Param" field.

Finally, you need to schedule your job. Select the appropriate job type ("Simple" or "Cron") from the "Trigger Type" dropdown. The sections below
describe the how to schedule simple and cron jobs.

Once you are done editing the scheduled job, save your changes.

Scheduling a Simple Job

To schedule a simple job, select "Simple" from the "Trigger Type" dropdown. This will cause additional scheduling fields to be displayed.
Edit Scheduled Job

Home = Scheduled Jobs > Scheduled Job

Name* Receipt Render

Classname * |cnm,avoka,fc,core,jcb ReceiptRenderJob

Description |Creates receipts for submissions

Context Param |

StartDate*  [11May 2011 R
End Date [ =

Trigger Type* | Simple ~
Repeat Run continuously v
Repeat Interval | 1 minute -

Save Close

A schedule for a simple job

The "Repeat" dropdown lets you choose how often the scheduled job should be run (values range from once to continuously). The "Repeat Interval”
defines the time interval between two invocations of the job (values range from 1 minute to 24 hours).

The "Start Date" and "End Date" define the date range in which the scheduled job is to run. Leave the end date blank unless you want the scheduled job
to expire.

You can have four different types of schedules depending on the settings you choose:

1. Once-off jobsCharacterized by: "Repeat" = "Run Once" Result: Job will run only once on the start date you enter (it will be run at midnight). Use
this for non-routine tasks or if you want a job that is triggered manually whenever it needs to be run.

2. Jobs with a fixed number of repetitionsCharacterized by: "Repeat" = "Repeat <n>"Result: Job will run n times starting at midnight on the start
date you set. Use this for tasks that need to be run a fixed number of times.

3. Jobs that run for a fixed number of daysCharacterized by: "Repeat” = "Run continuously"”, "End Date" is setResult: Job will run from midnight on
the start date you set, repeating after the specified interval. It will not be run after midnight on the end date. Use this for tasks that need to be
run for several days.

4. Continuous jobsCharacterized by: "Repeat" = "Run continuously”, "End Date" is blank Result: Job will run every n minutes, starting at midnight
on the start date you specified. Use this for repeating tasks.

Most of your jobs will likely perform background tasks with no set expiry date and will therefore be set up as continuous jobs. All simple jobs shipped with
Transaction Manager also follow this pattern.

Scheduling a Cron Job
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To schedule a cron job, choose "Cron" from the "Trigger Type" dropdown. This will cause additional scheduling fields to be displayed.
Edit Scheduled Job

Home Dashboard » Scheduled Jobs » Scheduled Job

Name Data Retention
Classname com avoka fc.core job DataRetentionJob
Description | Purges various logs. form and attachment data of completed submissions
Context Param

Start Date* | 11 Jun 2014

L1 L1

End Date
Trigger Type* | Cron j
Time Zone Australia/Sydney

Cron Expression* | 001°*7

Cron Expression Tutorial

Save Close

A schedule for a cron job

The schedule is controlled via a cron expression. To learn more about cron expressions, refer to e.g. http://en.wikipedia.org/wiki/ CRON_expression or
click on the "Cron Expression Tutorial" link at the bottom of the page. The expression in the screenshot above will cause the job to run every day at 1am,
and much more sophisticated schedules are possible.

Copying a Scheduled Job

If you would like to add a scheduled job that is based on an existing job, you can simply create a copy of the existing job. This is especially useful to
create additional instances of the "Scheduled Service" job, which can be used to execute arbitrary Groovy script on a schedule.
To copy a job, go to "System > Scheduled Jobs" and click the "Copy Job" button. You will be directed to the "Copy Scheduled Job" page.

Copy Scheduled Job
Home Dashboard » Scheduled Jobs » Copy Scheduled Job

Scheduled Job*  Scheduled Service =@
New Job Name* Monitor Submission Status @
Save Cancel
Copying a job

Choose the scheduled job you want to copy from the "Scheduled Job" dropdown.

Enter the name for the new scheduled job into the "New Job Name" field. Ensure that no other scheduled job with this name already exists.

Click "Save". A new scheduled job with the specified name will be created, and all other settings including the schedule will be based on the job you
copied.

Finally, edit the new scheduled job and make any configuration changes you want (for example, for a scheduled service job, change the schedule and
associated service definition as shown below). Save your changes.

Edit Scheduled Job

Home Dashboard » Scheduled Jobs » Scheduled Job

Name  Scheduled Service
Classname com.avoka fc.core job.ScheduledServiceJob

Description

Service Defintion* | Create Updated Transaction Log j Edit

Start Date* 02 Sep 2014

End Date

L1

Trigger Type™  Cron j

Time Zone

Cron Expression® 000/2*°7

Save Close

Adjusting the configuration of a copied job

Pausing and Resuming a Scheduled Job

If you want to temporarily suspend a scheduled job until you are ready to start it again, you can pause it. To do this, go to "System > Scheduled Jobs"
and click the "Pause" icon ( 'i) for the scheduled job in question.

Transaction Manager will then simply not run the scheduled job until you resume it by clicking the "Resume" icon ( b).
If you need to pause or resume all scheduled jobs, you can use the "Pause All Jobs" and "Resume All Jobs" buttons at the top of the page.

Triggering and Interrupting a Scheduled Job
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If the time for a scheduled job's next invocation has not yet come but you want it to run anyway, you can manually trigger the job (note: this option is not
available for scheduled jobs that are currently paused). This does not affect scheduling at all; subsequent runs will take place as originally scheduled.

To manually trigger a scheduled job, go to "System > Scheduled Jobs" and click the "Trigger" icon ( rjk')) next to the job. The job will be run straight away.
If you ever find you need to terminate a running scheduled job (this may be because of bugs in the job or data that the job cannot handle), you can use

the "Interrupt" icon ( . Clicking it will stop the current instance of the scheduled job, if one exists.

Deleting a Scheduled Job

If a scheduled job is no longer needed, you can either disable it by setting an end date (after which it will no longer be run) or delete it entirely.

To delete a scheduled job, go to "System > Scheduled Jobs" and click the "Delete" icon ( E) for the job you want to remove. You will be asked to
confirm this action.

Pre-Defined Scheduled Jobs

Transaction Manager comes with a number of scheduled jobs set up and ready to go. They perform useful functions and should not be paused or
removed without a reason. Read on to find out more about these scheduled jobs.

The Collaboration Job Controller Job

The Collaboration Job Controller job is responsible for processing current collaboration jobs by calling the Job Controller service associated with the job.
Please see Collaboration Jobs (Manager v5.0) for more details.

The Data Keystore Rollover Job

The Data Keystore Rollover job is responsible for creating new keystores for organization if automatic rollover is configured. Please see Operations
(Manager v5.0)#_sec_dataretentionorganizationlevel for more information.

The Data Retention Job

The Data Retention job calls the default Data Retention Management service, which is responsible for purging Transaction Manager data such as
submissions and error logs. Please see Operations (Manager v5.0)#_sec_dataretention and Services (Manager v5.0)#_sec_dataretentionservice for
more information.

Note that other jobs will not run while the data retention job is running, to avoid contention.

The Delivery Escalation Job

The Delivery Escalation job sends out escalation emails for submissions delivered via secure email delivery (see Delivery Configuration (Manager v5.0)
#_sec_secureemaildelivery).

The Delivery Reminder Job

The Delivery Reminder job sends out reminder emails for submissions delivered via secure email delivery (see Delivery Configuration (Manager v5.0)
#_sec_secureemaildelivery).

The Email Queue Job

The Email Queue job sends out emails placed into the email queue (see Outgoing Email (Manager v5.0)#_sec_emailqueue).

The HTTP Invoker Job

The HTTP Invoker can invoke a HTTP URL. The URL is configured as the context parameter of the job.

The Payment Reminder Job

The Payment Reminder job loads the default payment reminder service and calls it. The service will then send out a reminder email regarding
incomplete payments (see Security (Manager v5.0)#_sec_predefinedgroups for the group to which emails will be sent by default).

The Run Reports Job

The Run Reports job goes through all report schedules set up in Transaction Manager. If it finds one that is due to be sent out, it will run the report,
extract the result data and send out the report email.

The Scheduled Service Job

The Scheduled Service can be used to invoke a service of type "Scheduled Service". These services can be customized using a Groovy script, and
therefore are suitable if you need to create custom logic and run it on a schedule.
The service that the job will invoke can be selected when editing the job.

The Security Policy Manager Job
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The Security Policy Manager job is responsible for applying security policies such as user role and group expiry. It also removes user accounts that were
registered by users, but for which email verification was not completed (and hence the accounts were never activated or used).

The Submission Email Verification Reminder Job

The Submission Email Verification Reminder job calls the default Submission Email Verification service, which sends out reminders for submissions
where the user must verify their email address. For more on submission email verification, please refer to Form Configuration (Manager v5.0)
#_sec_submissionemailverification.

The System Monitoring Job

The System Monitoring job monitors other important system jobs (currently the Transaction Processing and Email Queue jobs) and sends out emails to
the "Receive System Alerts" group if these jobs do not exist or have not been running as they should.

The Template Version Deployment Job

The Template Version Deployment job is responsible for applying scheduled form version changes (see Form Version Configuration (Manager v5.0)
#_sec_changecurrentformversion)

The Transaction Processing Job

The Transaction Processing job calls the default Transaction Processor service, which performs submission processing in the following order:
Abandonment, receipting, delivery, task expiry and transaction history creation.

The Virus Scan Job

If a virus scan service is defined, the Virus Scan job loads a list of all attachments that need to be virus scanned and then call the default virus scan
service for each attachment, setting the attachment's virus scan status appropriately.

Scheduled Job History

Every time a scheduled job runs, TM logs a history event recording which job ran, the result (success/error) and some performance metrics.

To view the scheduled job history, go to "System > Scheduled Job History". You can filter the result list by a substring of the job name, the run duration,
the status ("Completed"/"Error") and the run date.

You can also export the search results to Excel by clicking the "Export Data" link at the bottom of the table.

Scheduled Job History
Home Dashboard » Scheduled Job History
Min Duration (ms} Status j StartDate |013an201500:00 [ 4] End Date = Clear
Job Name Time Server Node Duration Memory Change CPU Threads Status Action
Collaboration Job Controller 11 Jan 16:25:30  ip-192-168-140-45.us-west-2. compute.internal 220 ms 938 MB 7% 178 Completed
Payment Reminder 11 Jan 16:25:30  ip-192-168-140-45.us-west-2. compute.internal 11 ms 05 MB 0% 178 Completed
Virus Scan 11 Jan 16:25:26  ip-192-168-140-45_ us-west-2. compute.internal 13ms 15MB 0% 178 Completed
Transaction Processing 11 Jan 16:25:26  ip-192-168-140-45.us-west-2. compute.internal 796 ms. 257 MB 8% 178 Completed
Template Version Deployment 11 Jan 16:25:26  ip-192-168-140-45_us-west-2 compute.internal Sms 0.0 MB 0% 178 Completed
System Monitering 11 Jan 16:25:26  ip-192-168-140-45.us-west-2. compute.internal 39 ms 27NMB 14% 178 Completed
Server Health Monitor 11 Jan 16:25:26  ip-192-168-140-45_ us-west-2. compute.internal 35 ms 24NMB 0% 178 Completed
Run Reports. 11 Jan 16:25:26  ip-192-168-140-45.us-west-2. compute.internal 3Ims 0.0 MB 100 % 178 Completed
Email Queue 11 Jan 16:25:26  ip-192-168-140-45_ us-west-2. compute.internal ams 0.0 MB 0% 178 Completed
Collaboration Job Controller 11 Jan 16:24:30  ip-192-168-140-45_ us-west-2 compute.internal 451 ms 79MB 5% 178 Completed
Server Health Monitor 11 Jan 16:24:26  ip-192-168-140-45. us-west-2. compute.internal 32 ms 14 MB 16 % 178 Completed
Email Queue 11 Jan 16:24:26  ip-192-168-140-45_us-west-2 compute.internal 10 ms 0.0 MB 50 % 178 Completed
Collaboration Job Controller 11 Jan 16:23:30  ip-192-168-140-45.us-west-2. compute.internal 237 ms 88 MB 4% 178 Completed
Server Health Monitor 11 Jan 16:23:26  ip-192-168-140-45_ us-west-2 compute.internal 33ms 0.8 MB 0% 178 Completed
Email Queue 11 Jan 16:23:26  ip-192-168-140-45.us-west-2. compute.internal 10 ms 08 MB 0% 178 Completed
» 1-1501 56,785 Expert Data

The scheduled job history

If an error occurred during job execution, you will be able to view the error log by clicking the "Error Log" icon (').
Because TM runs many scheduled jobs as part of normal operations, the scheduled job history can contain a large number of entries. TM purges the

scheduled job history as part of its data retention policies. Please refer to Operations (Manager v5.0)#_sec_dataretention for more information on data
retention.
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Deployment Properties (Manager v5.0)

Much of the functionality implemented in Transaction Manager can be customized without the need to rebuild the application. Among other things, this
was accomplished by adding deployment properties that control certain behavior.
Deployment properties can be set at runtime the Transaction Manager management console. This section tells you what deployment properties there

are and which ones you should modify after installing Transaction Manager.

Page Contents

Search

Current Deployment Properties

Important Deployment Properties
Browsing Deployment Properties
Modifying a Deployment Property

Current Deployment Properties

The following are the deployment properties set up in Transaction Manager:

Property Name

Alternative Redirect User
Agents

Attachments Max
Embedded Size

Attachments Max Total
Size

Cache Timeout

Config Directory

Date Format Long

Date Time Format Long
Debug Mode

Duplicate Submission
Rejection Delay

Email Default Sender

Email Duplicate Payment
Message

Email Duplicate Payment
Subject

Email Fraud Payment
Message

Email Fraud Payment
Subject

Email Lost Password
Message

Email Lost Password
Subject

Email Promotion Message
Email Promotion Sender
Email Promotion Subject
Email Report Message
Email Report Sender
Email Report Subject

Email Submission Status
Message

Email Submission Status
Subject
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Description

Describes a set of user agents requiring alternative HTTP redirect mechanisms

The maximum size of a single embedded (PDF) attachment

The global maximum combined size of all attachments for a single submission.

Deployment property cache timeout in seconds
Transaction Manager configuration root directory.
Long date format.

Long date time format.

Is system in Debug mode?

Time in milliseconds after which a duplicate submission is rejected

Default sender email address for emails sent by Transaction Manager

Body text template for emails notifying administrators of a duplicate payment

Subject template for emails notifying administrators of a duplicate payment

Body text template for emails notifying administrators of a possibly fraudulent payment

Subject template for emails notifying administrators of a possibly fraudulent payment

Lost password email message

Lost password email subject

Form promotion notification body

The email address for the promotion notification messages
Form promotion notification subject

Report delivery email message

Report delivery sender email address

Report delivery email subject

Submission processing status update email messageNote: Can be overwritten on the organization and form level by

using organization and form version properties.

Submission processing status update email subjectNote: Can be overwritten on the organization and form level by

using organization and form version properties.



Email Task Notification
Message

Email Task Notification
Subject

Email Task Sender

Email Welcome User
Message

Email Welcome User
Subject

Enable REST/Web
Service Delivery

Enable Script Submissions

Enable Web Service
Delivery

Groovy Logging Enabled
Groovy Script Timeout
HTTPS Port

LC Form Servers Deployed

LC Form Servers Load
Balanced

LiveCycle Repository
Domain

Online Save Enabled

Report Internal URL

Report Reschedule Delay

Server Real Time Health
Monitoring

SMTP Host
SMTP Password
SMTP Port
SMTP User

Supported Delivery
Methods

Task notification body

Task notification subject

The email address shown as the sender for task notification messages

User welcome email body

User welcome email subject

Enable REST and web service delivery for submissions

Enable test submission scripts by switching off submission request log checks

Enable/disable web service delivery. This can be used to temporarily suspend web service delivery, e.g. during high
load or web service maintenance.

Enable logging of Groovy service calls

GroovyScript execution timeout in milliseconds

Port on which HTTPS operates

If this instance of TM does not use any Adobe LiveCycle servers, set this property to "false"

Enable this setting to use load balancing when assigning tasks to Adobe LiveCycle nodes

Relative location of LiveCycle repository domain for form version publishing

Option to globally disable Online Saving of forms. If set to true, the individual form's setting will be used.
Location where reports are run internally by the application (i.e. http://localhost:9080/webreport)

Amount of time in minutes to wait before rescheduling a running report.

Enable / disable real-time server health monitoring

SMTP email server Hostname (mail.smtp.host)

SMTP email server authentication Password (mail.smtp.password)
SMTP email server Port (mail.smtp.port)

SMTP email server authentication User (mail.smtp.user)

Supported delivery methods

Each deployment property is initialized to a default value but can be changed freely. Be aware that changes may impact various functionality in
Transaction Manager, so make sure you take care.

Important Deployment Properties

The following deployment properties should be modified after setting up the Transaction Manager management console:

Directories

Transaction Manager uses directories to store various objects such as attachments and report files. By default, these files are stored in a subfolder of
the folder where the TM server is installed. You can adjust this by setting the "Config Directory" property to any directory you want. If you do, ensure that
the TM service has read/write access to the directory.

Edit the property "LiveCycle Repository Domain" and enter the path (relative to the LiveCycle repository) where Transaction Manager shall publish its
forms. If multiple Transaction Manager instances are sharing the same LiveCycle repository, make sure to enter a unique path (e.g. " /tm-test-thirdparty
[TransactionManagerRepository/").

SMTP Properties

If you want Transaction Manager to be able to send emails (e.g. for delivery purposes), you have to configure the SMTP settings. This is best done by
accessing "System > Email Settings".

Duplicate Form Submissions

Transaction Manager offers some options to control duplicate submissions, which are multiple submission attempts of a requested form. This can

happen either because the user attempts to submit the same form multiple times (by double-clicking the submit button or saving the form offline and then
opening multiple copies of it) or commonly in system testing, where scripts are used to automate a number of submissions.
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By default, Transaction Manager blocks duplicate submissions when they are more than a certain time interval (controlled by the "Duplicate Submission
Rejection Delay" deployment property) apart. If duplicate submissions occur within a certain short period, Transaction Manager assumes that they
originate due to accidental double-clicking of the submit button and ignores the duplicates.

If you would like to enable duplicate submissions (e.qg. for load testing), change the "Enable Script Submissions" deployment property to “true”.

If you would like to customize the message displayed to space users when a duplicate submission is rejected, use the in-built form property named
"Submission Duplicate Message".

Browsing Deployment Properties

To view the list of all deployment properties and their current values, go to "System > Deployment Properties”.
Deployment Properties

Home = Deployment Properties

| earch Search Clear
Name Type Value Description Action
Attachments Max Embedded Size Number 1048576 The maximum size of embedded(PDF) attachments @
Cache Timeout Number 80 Deployment property cache timeout in seconds 'Z]
Config Directory String d\data\formcenteriocal FormCenter configuration root directory. '2
Date Format Leng String dd MMM yyyy Long date format. 4}
Date Time Format Long String dd MMM yyyy h:mm:ss a Long date time format. '2
Debug Mode Boolean false Is in system in Debug mode? 4|
Duplicate Submission Rejection Delay  Number 30000 Time in milliseconds after which a duplicate su... '2']
Email Default Sender Email testd301@avoka.com @
Email Lest Password Message Long Text  <himi=<head=<style type="text/css"=body {foni-family... Lost password email message 'Z]
Email Lost Password Subject String FormCenter Lost Password - S{environmentName} Lost password email subject @

b 1-100f49 Export Data

Browsing the list of deployment properties
You can filter the list using a substring of the deployment property's name and/or value, and export the search results to Excel by clicking the "Export
Data" link below the table.

You cannot add or remove deployment properties, but you can edit them using the "Edit" icon (E)l).

Modifying a Deployment Property

To edit a deployment property's value, go to "System > Deployment Properties" and click the "Edit" icon next to it. You will be directed to the "Edit
Deployment Property" page.

Edit Deployment Property

Home > Deployment Preperties > Deployment Property

Name* Online Save Enabled
Type* Boolean

Description Option to globally disable Online Saving of forms. I set to true, the individual form's setting will be used

Value True =

Save Close

Changing a deployment property's value
Enter a new value and save the deployment property. Your changes will take effect almost immediately (by default, deployment properties are cached
with a refresh time of 30 seconds)
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Appendices (Manager v5.0)

Appendix 1 — Submission Status Values

The table below shows some important combinations of submission status values (form status, attachment status, payment status, receipt status and
delivery status) as well as the aggregate "Transaction Status" string displayed on the TM submission search page.

Note that there are more statuses and combinations that are not shown below. Generally the transaction status will indicate the relevant status applicable to
the submission and its value (e.g. required, ready, completed, error).

Form Attachments  Payment Receipt Delivery Tranaction

Saved - - Form Saved

Submitted ' Required - - - Form Submitted, Attachments Outstanding

Submitted - Required | - - Form Submitted, Payment Required

Submitted = Required Required | - - Form Submitted, Attachments Outstanding and Payment Required
Completed Ready Receipt Render Pending

Completed Completed ' Ready Delivery Ready, orDelivery Ready, Method Not Configured
Completed Completed Completed ' Delivery Completed
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Transact Web Service Guide (Manager v5.0)

Introduction

This document provides a guide to the Avoka Transact integration SOAP Web Services. These web services include:

® Forms Server SOAP Web Service
® Portal SOAP Web Service
® Task and User SOAP Web Service

Using the integration web services you can develop sophisticated form based solutions which include user prefill data, receipt number generation, business
process integration and submission processing status updates for customers.

W Avoka Transact
“J% Transaction Manager

Get Pre-Fill Initlate Business

Cata

m

Enterprise Data

Transaction Manager Web Service Interactions
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Forms Server SOAP Web Service (Manager v5.0)

Overview

The Form Server web service enables you to retrieve completed form submissions from a remote Transaction Manager server and provide processing status
updates.

Submission Delivery

Submission delivery is completed through using a series of web service calls to the Transaction Manager server. These fine grained web service calls enable
reliable delivery of submission and attachment data over Wide Area Networks.
The web service invocation sequence is illustrated in the diagram below:

Client App TM Server

GetSubmissionKeysForDelivery

return list of submission keys for all
client's transactions 'Ready” for delivery

loop /[for each submit key]
GetSubmission

return submission info and data including
XML, PDF and list of file attachment keys

loop /[for each attachment key]
GetAttachment

retumn attachment info and file dataj

calc. attachment file data hash
(SHA-256 hex encoded)

SetAttachmentDeliveryCompleted

ted

calc. submission XML data hash
(SHA-256 hex encoded)

SetDeliveryCompleted

server confirms all submission data delivered
and sets delivery status as "Completed

Client App TM Server

Submission delivery sequence
The pseudo code representation for the submission delivery process is provided below:

get list of submission keys for delivery (GetSubni ssionKeysForDelivery)
for each submission key in subm ssion key |ist
get submi ssion data (Get Subni ssion)
for each attachnent key is subnission attachment keys
get attachnment data (GetAttachnent)
confirmdelivery of attachment data (SetAttachnentDeliveryConpl ete)
confirmdelivery of subm ssion data (SetSubni ssionDeliveryConpl ete)

When confirming the delivery of the submission XML data or the file attachment data the client needs to provide the Transaction Manager server with a data
hash of the received data. The data hash must be a Hex encoded SHA-256 hash of the data. Please see the example code provided later.

Once this delivery has been confirmed the Transaction Manager server can mark the delivery as being completed and the data on the server can be purged.

If the web service client fails during this delivery process before calling SetSubmissionDeliveryComplete it can try delivery again at a future point in time. The
server will still make the Submission available to the client to retrieve.

Once the web service delivery client has stored the submission in a persistent data store or queue it should call the server SetSubmissionDeliveryComplete

method as soon as possible. The internal delivery system or processing workflow should not delay this step so that the Transaction Manager server can
make this submission data available for purging.
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Data Hash Utils

Example data hash configuration Java code is provided below:

import java.io.File;
inport java.io.FilelnputStream
import java.io.|CException;
i mport java.io.UnsupportedEncodi ngExcepti on;
inport java.security.MessageDi gest;
/**
* Provides Forns APl data hashing utility methods.
*
* See SHA-2 definition: <a href="http://en.w ki pedi a. org/w ki / SHA-2">http://en. w ki pedi a. or g/ wi ki / SHA-
*/
public class DataHashUtils {
/** Hexi deci mal characters for encoding. */
private static final char[] HEXADEClMAL = { '0O', "1', '2', "3", "4, '5','6", "7, '8, '9", 'a
‘¢, td, e, fT )
private static final String HEXADECI MAL_STRI NG = "0123456789abcdef";
/**
* Return a Hex encoded SHA-256 hash of the given form XML data or attachment file data.
* @aram bytes the byte array to hash
* @eturn SHA-256 hash, encoded as a 64 character Hex string
*/
public static String toSHA256Hash(byte[] bytes) {
if (bytes == null) {
throw new Il egal Argurment Exception("Null bytes paraneter");

}

try {
MessageDi gest nd = MessageDi gest. getl nstance(" SHA- 256") ;
nd. updat e( byt es) ;
byte[] binaryData = nd.digest();
/1 Hex encode data SHA-256 di gest
char[] buffer = new char[64];
for (int i =0; i <32; i++) {
int low= (int) (binaryData[i] & OxOf);
int high = (int) ((binaryData[i] & Oxf0) >> 4);
buffer[i * 2] = HEXADECI MAL[ hi gh];
buffer[i * 2 + 1] = HEXADECI MAL[ | ow] ;
}
return new String(buffer);
} catch (Exception e) {
t hrow new Runti neException(e);

}

/**

* Return a Hex encoded SHA-256 hash of the given string value. Please note the string
* value will be encode as a byte array using the UTF-8 charset before hashing.

*

* @aram pl ai ntext string value to hash

* @eturn SHA-256 hash, encoded as a 64 character Hex string

*/

public static String toSHA256Hash(String plaintext) {
if (plaintext == null) {
throw new Il egal Argunent Exception("Null plaintext paranmeter");

}

try {
return t oSHA256Hash( pl ai nt ext . get Byt es(" UTF-8"));

} catch (UnsupportedEncodi ngException uee) {
t hrow new Runti neException(uee);
}
}

/**
* Decodes the hex encoded SHA-256 string returned by {@ink #toSHA256Hash(String)} into a byte arr
* @ar am encodedHash the hash string consisting of 64 hex characters
* @eturn a byte array of length 32, representing the encoded hash in binary form
*/
public static byte[] decodeSHA256Hash(String encodedHash) {
char[] buffer = encodedHash.toCharArray();
byte[] result = new byte[32];
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for (int i =0; i <32; i++) {
char lowChar = buffer[i*2 + 1];
char highChar = buffer[i*2];
int | ow = HEXADECI MAL_STRI NG i ndexCf (1 owChar) ;
int high = HEXADECI MAL_STRI NG i ndexCF (hi ghChar) ;
result[i] = (byte) ((high << 4) | low;

}

return result;

}

| **

* Provide a test harness to generate hash values for a given file.
*

* @aram args the program argunents
*/

public static void main(String[] args) {

if (args.length !'=2) {
Systemout. println("Usage: java -jar DataHashUils.jar -filename <filename>\n");
System out. println("where:");
Systemout.printIn(" -filenane the name of the file to generate the SHA-256 hash for"
return;

}

if (largs[0].equal s("-filenane")) {
Systemout. println("Usage: java -jar DataHashUils.jar -filenanme <fil ename>\n");
Systemout. println("where:");
Systemout.printin("-filename the name of the file to generate the SHA-256 hash for"
return;

}

String filename = args[1];

File file = new File(fil enane);

if ('file.isFile() || !'file.canRead()) {
Systemout. println("Cannot read the specified file: " + filename + "\n");
Systemout. println("Usage: java -jar DataHashUils.jar -filename <filename>\n");
System out. println("where:");
Systemout.printin("-filename the name of the file to generate the SHA-256 hash for"
return;

}
long length = file.length();

/Il Create the byte array to hold the data

byte[] bytes = new byte[(int)length];
FilelnputStreamfis = null;

try {
fis = new FilelnputStrean(fil enamne);
/! Read in the bytes
int offset = 0;
int nunRead = 0;
while (offset < bytes.length
&& (nunRead = fis.read(bytes, offset, bytes.length-offset)) >= 0) {
of fset += nunRead;
}
/'l Ensure all the bytes have been read in
if (offset < bytes.length) {
t hrow new | CException("Could not conpletely read file " + file.getName());
}
Systemout. println("Hex encoded SHA-256 data hash\n");
Systemout.printin(" File name: " + file.getCanonical Path());
Systemout.println(" Data hash: " + toSHA256Hash(bytes));
} catch (1 OException ioe) {
i oe.printStackTrace();
} finally {
if (fis!=null) {
try {
fis.close();
} catch (I CException e) {
}
}
}

Submission Processing Status Updates
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The Form Server web service also enables you to provide submission processing status updates which can be presented to end users and operations staff.
This feature is great for providing immediate feedback to customers about the status of their form submission, which in turn reduces calls to your help desk
for information.

History

View the history of forms you have submitted and their processing status

» BHBAPS - Home Owners Insurance Quote

Tracking Code: BHBAPS Job Number: BHBAPS

Completed: 23 Apr 2014 4:25 PM

Organization: FinanceCorp

Processing Updated: 23 Apr 2014 4:25 PM

Processing Status: Thank you Malcolm Edgar your Home Owners Insurance Quote is being processed.

Submission processing status update in Self Service Portal

Application Programmer Interface

The Web Services Description Language (WDSL) for the Forms Server web service is available on the server URL:

http://<server name>/manager/fcservices/FormsServerWebService?wsdl
The Forms Server web service provides of the following operations:

GetSubmissionKeysForDelivery
GetSubmission

GetAttachment
SetAttachmentDeliveryComplete
SetSubmissionDeliveryComplete
UpdateProcessingStatus
UpdateProcessingStatusAndEmail

GetSubmissionKeysForDelivery
This operation returns the list of submission key identifiers for submissions with a delivery status of 'Ready' for the given client key.

Input Parameters

® clientKey: the organization client key identifier. This must be a valid client key known to Transaction Manager.

Output Result

® alist of strings containing the submit keys of all submissions ready for delivery to the client organization.

Faults

® Exception: if the organization could not be resolved via clientKey or an unexpected error occurs invoking this method.

GetSubmission
This operation returns the submission object for the given client key and submit key.

To confirm the delivery of the form XML data a Hex encoded SHA-256 hash of the fileDataBytes
element needs to be created for the SetSubmissionDeliveryComplete call.

Input Parameters

® clientkey: the organization client key identifier

® submissionKey: the submission submit key identifier. The submission identified by this key must exist and be associated with the organization
identified by clientKey, and be ready for web service delivery.

Output Result
® Submission (Complex Type)
A Submission type provides the following elements:.

® formCode - a reference to the form that was used for this submission.
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formName - the name of the form used for this submission

formDataBytes - the XML Data for this submission, this is a base64 encoded text value of the original file bytes data
formTemplateVersion - the form template version number

pdfReceiptBytes - a flattened PDF copy of the receipt o receiptNumber - the form receipt submission number o submissionlid - the
submission id

submissionKey - the submission surrogate key;

submissionTime - the time the submission was lodged

® attachmentKeys - a list of the attachment keys that are associated with the submission, which can be used to retrieve the attachments via
GetAttachment

Faults

® Exception: if one of the input parameters violates a constraint (e.g. invalid submissionKey) or an unexpected error occurs invoking this method.

GetAttachment

This operation returns the attachment object for the given client key and attachment key.
To confirm the delivery of the attachment a Hex encoded SHA-256 hash of the fileBytes element needs to be created for the
SetAttachmentDeliveryComplete call.

Input Parameters
® clientkey: the organization client key identifier

® attachmentKey: the submission attachment key identifier. The attachment identified by this key must exist and be associated with the organization
identified by clientKey.

Output Result
® Attachment (Complex Type)
The Attachment type provides the following elements:

attachmentKey - the attachment key identifier

attachmentName - the configured attachment name

documentCode - the configured document code

documentTypeName - the configured attachment type

description - the user entered description

fileName - the name of the file attached by the user

fileBytes - the attachment file data uploaded by the user, this is a base64 encoded text value of the original file bytes data
submittedManuallyFlag - specifies whether the user elected to provide the attachment manually

requiredFlag - specifies whether providing the attachment is required

Faults

® Exception: if one of the input parameters violates a constraint (e.g. invalid attachmentKey) or an unexpected error occurs invoking this method.

SetAttachmentDeliveryComplete

This operation sets the delivery status for an attachment to '‘Complete’.

Input Parameters
® clientkey: the organization client key identifier
® attachmentKey: the attachment key identifier. The attachment identified by this key must exist and be associated with the organization identified by

clientKey. There must also be a file associated with the attachment.
® dataHash: the Hex encoded SHA-256 hash value of the attachment (fileBytes) data

Output Result
None

Faults

® Exception: if one of the input parameters violates a constraint (e.g. invalid attachmentKey) or an unexpected error occurs invoking this method.

SetSubmissionDeliveryComplete

This operation sets the delivery status for a submission to '‘Complete’. Before invoking this method, please invoke SetAttachmentDeliveryComplete for each
submission attachment.

Input Parameters
® clientkey: the organization client key identifier
® submissionKey: the submit key identifier. The submission identified by this key must exist and be associated with the organization identified by

clientkey.
® dataHash: the Hex encoded SHA-256 hash value of the submission (formDataBytes) data

Output Result

None
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Faults

® Exception: if one of the input parameters violates a constraint (e.g. invalid submissionKey) or an unexpected error occurs invoking this method.

UpdateProcessingStatus

This method set the submission processing status to the given status value.

Input Parameters

® clientkey: the organization client key identifier

® submissionKey: the form submission key identifier. The submission identified by this key must exist and be associated with the organization
identified by clientKey.

® processingStatus: the current processing status of the form submission by the organization. The maximum length of the processing status is 100
characters, longer values will be truncated.

Output Result

® None: update processing status. If the submission was performed by an authenticated user, and that user has elected to receive notification emails
then an notification email will be sent

Faults

® Exception: if an error occurs invoking this method.

UpdateProcessingStatusAndEmail

This method set the submission processing status to the given status value and send out a customized email to the submission user (if known).

Input Parameters

® clientKey: the organization client key identifier

® submissionKey: the form submission key identifier. The submission identified by this key must exist and be associated with the organization
identified by clientKey.

® processingStatus: the current processing status of the form submission by the organization. The maximum length of the processing status is 100
characters, longer values will be truncated.

® emailSubject: the email subject value of the notification email

® emailBody: the email notification message body. Email message template variable you can use include:

${formDataExtract}
${user.fullName}
${user.givenName}
${user.familyName}
${user.email}
${user.loginName}
${submission.receiptNumber}

® None: update processing status. If the submission was performed by an authenticated user, and that user has elected to receive notification emails
then an notification email will be sent.

Faults

® Exception: if an error occurs invoking this method.
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Portal SOAP Web Service (Manager v5.0)

Overview

This web service enables organizations to integrate Avoka Transact capabilities into their existing Portals and web sites.
Using these web services you can to create the following types of portal pages or views: form landing page

form submission confirmation page form list view / search

form ToDo item list view /search form submission history view / search

Web Service Security

The Portal Web Service now supports invoker authentication and authorization security access control. Web service can be optionally protected using
HTTPS BASIC authentication, against Transaction Manager user accounts. When access control is enforced these user accounts must have the role
permission "Web Service Invoke" assigned to them.
Web service security can be enabled and disabled using the Transaction Manager portal property "Authenticated Web Services".

Transaction Manager

Home Dashboard » Porlaks / Modules » Poral

Fortal | Properties |

lame Type Value Description Action
Admin Environment CSS Style Siring  color; #000000;background-color: #ffffff; border: 1p... The envirenment label style of the Transaction Manager @ k
Admin Environment Name String tm test1 avoka.com [tm dev. avoka.com] The environment name of the Transaction Manager instance | va]
[ Authenticaled Web Services  List  Groovy and Task ] Specify which types of Web Services required authenticaled and authorized access conirel [3) £

m Ll

Web Service Security Transation Manager Configuration Option

Application Programmer Interface

The Web Services Description Language (WDSL) for the Portal web service is available on the server URL: https://<server name>/manager/secure/services
[PortalWebService?wsdl
The Application Programmer Interface (API) to the Portal web service consists of the following operations:

GetFormDefinition
GetFormDefinitionList
GetFormSubmission
GetFormSubmissionList
GetFormTodoList
DeleteFormTodo

This operation returns the FormDefinition matching the specified Portal Name and Form Code.

Input Parameters

® portalName: the name of the Portal (required)
® formCode: the globally unique form code identifier (required)

Output Result

FormDefinition (Complex Type)
The FormDefinition type contains the following elements:

formCode - the globally unique form code identifer

formName - the organization unique form name

formVersion - the currently active form version number

formURL - the URL to access the form with

orgName - the owning organization name

testMode - specifies whether the form is in test mode

categoryNames - the list of form version category names used to classify the form

formProperties - the list of form version properties The FormProperties type contains the following elements o name - the form version property
name

® value - the form version property value

Faults

® ObjectNotFoundException: if the form specified by the Portal Name or Form Code could not be found.

This operation returns a list of FormDefinition items matching the search criteria. The result set will be ordered by form name.

Input Parameters
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portalName: the name of the Portal (required)

groupNames: the form group name associated with the forms (optional), will filter the result set if specified

keyword: the free text search keyword (optional), will filter the result set if specified

formCategories: the list of form category search values (optional), will filter the result set if specified

fetchLimit: the result set fetch limit, default value is 1,000 items if not specified. If specified it must be in range of 1-10,00 (optional)

Output Result

FormDefinition (Complex Type) list
The FormDefinition type contains the following elements:

formCode - the globally unique form code identifer

formName - the organization unique form name

formVersion - the currently active form version number

formURL - the URL to access the form with

orgName - the owning organization name

testMode - specifies whether the form is in test mode

categoryNames - the list of form version category names used to classify the form

formProperties - the list of form version properties The FormProperties type contains the following elements o name - the form version property
name

® value - the form version property value

Faults

ObjectNotFoundException: if the specified portal could not be found.

GetFormSubmission

This operation return the FormSubmission matching the specified Portal Name and Submit Key.

Input Parameters

® portalName: the name of the Portal (required)
® submitKey: the globally unique form submit key identifier (required). This is a 32 character Hex encoded UUID value.

Output Result

FormSubmission (Complex Type)
The FormSubmission type contains the following elements:

submissionld - the globally unique form submission id (submission record primary key)
submitKey - the globally unique submit key, which provides an alternative key using a UUID value
userName - the form submitter user login name

submissionTime - the time the form was submitted

® completionTime - the time the all the required user steps have been completed, e.g. attachments, payments etc. This value will often be the same
as the submissionTime.

receiptNumber - the submission receipt / reference number.

receiptURL - the URL to access the PDF receipt document

processingStatus - the latest submission processing status value to be displayed on the submitter

processingStatusTime - the creation time of the latest submission processing status

submissionMessage - the submission message displayed to the user on the submission confirmation page, generally used to provide additional
instructions

paymentAmount - the total payment amount associated with the form transaction o numberAttachments - the number of attachments uploaded with
form submission o orgName - the name of the organization which owns the form

formName - the name of the submitted form

formCode - the globally unique code of the submitted form

xmiDataExtracts - the list of form submission data XML extracts The XmIDataExtracts type contains the following elements

name - the submission data extract name

value - the submission data extract value

xpath - the submission data extract XPath expression

Faults

® ObjectNotFoundException: if the form submission specified by the Portal Name and Submit Key could not be found.

GetFormSubmissionList

This operation returns a list completed of FormSubmission items matching the search criteria. The result set will be ordered by submission completed time
descending.

Input Parameters

portalName: the name of the Portal (required)

userName: the form submitter user login name (required)

groupNames: the submission group names (optional), will filter the result set if specified

keyword: the search keyword (optional), will filter the result set if specified

fetchLimit: the result set fetch limit, default value is 1,000 items if not specified. If specified it must be in range of 1-10,00 (optional)
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FormSubmission (Complex Type) list
The FormSubmission type contains the following elements:

Faults

submissionld - the globally unique form submission id (submission record primary key)

submitKey - the globally unique submit key, which provides an alternative key using a UUID value

userName - the form submitter user login name

submissionTime - the time the form was submitted

completionTime - the time the all the required user steps have been completed, e.g. attachments, payments etc. This value will often be the same
as the submissionTime.

receiptNumber - the submission receipt / reference number.

receiptURL - the URL to access the PDF receipt document

processingStatus - the latest submission processing status value to be displayed on the submitter

processingStatusTime - the creation time of the latest submission processing status

submissionMessage - the submission message displayed to the user on the submission confirmation page, generally used to provide additional
instructions

paymentAmount - the total payment amount associated with the form transaction o numberAttachments - the number of attachments uploaded with
form submission o orgName - the name of the organization which owns the form

formName - the name of the submitted form

formCode - the globally unique code of the submitted form

xmlIDataExtracts - the list of form submission data XML extracts The XmIDataExtracts type contains the following elements

name - the submission data extract name

value - the submission data extract value

xpath - the submission data extract XPath expression

ObjectNotFoundException: if the form submission specified by the Portal Name and Submit Key could not be found.

GetFormToDolList

This operation returns a list of FormToDo items matching the search criteria. The result set will be ordered by item submission time and task creation time
descending.

Input Parameters

portalName: the name of the Portal (required)

userName: the form submitter user login name (required)

groupNames: the submission group names (optional), will filter the result set if specified

keyword: the search keyword (optional), will filter the result set if specified

filterType: the form Todo filter type [ Completed | Submitted | Saved | Expired | Assigned ], will filter the result set if specified (optional)
fetchLimit: the result set fetch limit, default value is 1,000 items if not specified. If specified it must be in range of 1-10,00 (optional)

Output Result

FormTodo (Complex Type) list
The FormTodo type contains the following elements:

® todoKey - the globally unique identifier, either the Assigned or Completed Task Key or the Submission Key

todoType - the ToDo item type: [ 'Assigned Task' | 'Completed Task' | 'Expired Task' | 'Saved Form' | 'Payment Required' | 'Attachments Required’ |
'Wet Signature Required' | 'Authentication Required' ]

actionURL - the URL to the open the task, saved form, portal action page URL or the completed task submission PDF receipt

actionTitle - the user Todo action item short title description

actionMessage - the user Todo action item long description message

receiptNumber - the submission receipt / reference number

formName - the name of the submitted form

formCode - the globally unique code of the submitted form o orgName - the name of the organization which owns the form o userName - the form
submitter user login name

submissionTime - the time the form was submitted

taskGroupName - the assigned Task form group name.

taskCreationDate - the date time the assigned Task was created

taskScheduledDate - the date time the assigned Task is scheduled to be performed

taskExpiryDate - the date time the assigned Task will expire

canDelete - the flag specifying whether the assigned task can be delete by the user

xmiDataExtracts - the list of form submission data XML extracts The XmIDataExtracts type contains the following elements

name - the submission data extract name

value - the submission data extract value

xpath - the submission data extract XPath expression

ObjectNotFoundException: if the form submission specified by the Portal Name and Submit Key could not be found.

DeleteFormTodo

This operation deletes the FormToDo item for matching the ToDo Key.

Input Parameters
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Output Result

® Boolean: Return true if the operation could be completed (e.g. Task deletable or Submission saved) or false otherwise

Faults

® ObjectNotFoundException: if the item specified by the ToDo Key could not be found.
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Task and User SOAP Web Service v2 (Manager v5.0)

Overview

The Task and User web service enables you to create form tasks, form groups and user accounts in Transaction Manager. By using the Task and User web
service, external applications can assign forms to staff to complete and create multi-step workflows.

In Transaction Manager a task consists of a task description, a reference to a form, optional XML prefill data and some other attributes. Transaction Manager
will present the task to the assigned user(s) in the Self Service Portal or Mobile FieldWorker, and will optionally notify users of assigned tasks.

You can manually create tasks and edit tasks in Transaction Manager via the "Operations > Assigned Tasks" screen. This facility is particularly useful when
developing web service integration with external systems.

Home Forms Tasks (1) History Account

Task List

Complete your outstanding forms and tasks.

Filter: Group ltems:

l kearch l Go ~ 0O

» BZBZXP - Review Home Owners Insurance Quote medga voka.com.

Assigned Task
Tracking Code: 8Z8ZXP Job Number: BHBAPS
Assigned To Quote Reviewers Created: 23 Apr 2014 4:25 PM

Please review the Home Owners Insurance Quote by Malcolm Edgar

Screenshot: Assigned Tasks screen in Transaction Manager
In Transaction Manager tasks can be assigned to individual users and/or to a group. When tasks are assigned to a group, all the users belonging to that
group will be able to view that task.

Tasks can also include geo-location latitude and longitude coordinates to support map displays in the Self Service Portal and Mobile FieldWorker
applications.

B  https://demo.avoka.com/govassist/secure/account/task-map.htm?taskKey=0f8af7e227 ec88bc130a0ec000c9b19b

Home Safety Review

| [bscmll)ll Home safety review for Malcolm Edagar (aged 73) at 32 Therry Street, Avalon NSW. Contact telephone number is: 02 9382 9128.
| Please call Mr Edgar 24 hours before the home visit. Previous visit on the 23rd June 2010 identified mobility issues after a knee
replacement, please assess what outside work he is currently doing and the condition ofthe home.

Assigned To: medgar Created: 10Jul 2012 10:50 PM Scheduled: 24 Jul 2012 1230 PM  Complete By: 31 Jul 2012 5:00 PM

| Map | Satelite |
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Screenshot: Task Location Display

Web Service Security

The Task and User Web Service supports invoker authentication and authorization security access control. Web service can be optionally protected using
HTTPS BASIC authentication, against Transaction Manager user accounts. When access control is enforced these user accounts must have the role
permission "Web Service Invoke" assigned to them.

Web service security can be enabled and disabled using the Transaction Manager portal property "Authenticated Web Services".

Transaction Manager
Fome Cashboard » Porial ! Boduies ¢ Porid

[ Porta ] Proparties |

M Type  Value Dee8Criphiom Action
dmin Envirosment ©55 Shie Siring  color: S000004- bactbground-calor: BT border: Tp.  Tha snvinonment istesl sfyie of the Transaction Manager B
sgmn [nvrgoment Heme firing  tmiestt ol com [im dev avoka com| Tha envirenment name o the Transachion Masaper natence & =
[: Ayfechcaied Web Services.  Lmt Groowy and Task ] Specty which types of Vet Services neguned suthentcated and sethorized scoems contred [ )

Web Service Security Transation Manager Configuration Option

Application Programmer Interface

The Web Services Description Language (WDSL) for the Task and User web service v2 is available on the server URL:
https://<server name>/manager/secure/services/TaskUserWebServiceV2?wsd|

The Task and User web service v2 provides of the following operations.

CreateLocalUser
CreateFormGroup
CreateFormTask
CreateFormReviewTask
ExpireTask
AddUserToGroup
RemoveUserFromGroup
ReassignTask
ReassignAllUserTasks

CreateLocalUser

This operation creates a "Local" type Transaction Manager user with the given parameters. Note that LDAP users will be looked up and created in TM
automatically by the other operations, so this operation is not needed for LDAP users.

Please ensure the user password conforms to the configured Security Manager password policies. If the password does not meet the password
requirements this operation will return a TaskUserWebServiceException fault.

Input Parameters

userName: the user name (required)

password: the user password (required, must conform to configured Security Manager password policies)
email: the user email address (required)

givenName: the first name (optional)

familyName: the last name (required)

portalName: the associated portal (required)

changePwdAfterLogin: whether the user must change the password after login (required)

Output Result

None

Faults

InvalidParameterException: if one of the parameters violated a constraint
PortalNotFoundException: if the portal was not found

PortalSecurityException: if the portal does not support local users
UserAlreadyExistsException: if a user with the specified login name already exists
TaskUserWebServiceException: if other errors occur

CreateFormGroup

This operation creates a form group with the given name.

Input Parameters

® groupName: the form group name (required)
® groupDescription: the form group description (optional)
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Output Result

Faults

boolean value: true if a group was created, or false if it already exists.

InvalidParameterException: if one of the parameters violated a constraint
TaskUserWebServiceException: if the group cannot be created (e.g. a non-form group with the same name exists)

CreateFormTask

This operation creates a new form task.

Input Parameters

subject: the task subject (required)

message: the task message (optional)

formCode: the form code (required)

userName: the assigned user name (optional; must be specified if groupName is not)

groupName: the assigned form group name (optional; must be specified if userName is not)
portalName: the user portal name (optional; must be specified if userName denotes an LDAP user)
formDataXml: the form XML data or schema seed (optional; must not be specified if formPrefillXml is)
formPrefillXml: the form prefill XML data to map into the form XML (conditional; required when formDataXml specified)
latitude: the task location latitude (optional; must be between -180 and 180 if specified)

longitude: the task location longitude (optional; must be between -90 and 90 if specified)
scheduledTime: the scheduled task time (optional)

expiryTime: the task expiry time (optional; must be in the future if specified)

userDeletableFlag: whether the user can delete the task

sendEmailFlag: whether to notify the assignee(s) of the task via email

emailSubject: the notification email subject line

emailMessage: the notification email message body. Email message template variable you can use include:
${format} : Apache Click Format object use for formatting values

${formDataMap} : form data extracts map

${submission} : task submission object

${task} : task submission object (as above)

${environmentName} : server evironment name

${supportEmail} : support email address, defined as a deployment property

Output Result

A string containing the new task key identifier.

Faults

ExpiryDateException: if the expiry date is not in the future

FormInactiveException: if the form exists but is inactive

FormNotFoundException: if the form cannot be found

FormPortalNotSetException: if the form exists but is not exposed on any portals

GroupNotFoundException: if the group was not found

InvalidParameterException: if one of the parameters violated a constraint

PortalNotFoundException: if the portal was not found during LDAP user lookup

PortalSecurityException: if the portal does not support LDAP users and the user does not exist as a local user
UserNotFoundException: if the user was not found (including LDAP lookup if applicable)
TaskUserWebServiceException: if other errors occur

CreateFormReviewTask

This operation creates a new form review task based on the form data and attachments of a previous form submission. The CreateFormReviewTask
operation can be used create form review business processes, where the first party submits a form, then a delivery process assigns a form review task to
second party (reviewer). The reviewer is then able to check the submitted data, ensure it is correct, make any amendments, check any attachments, and
then submit the reviewed form. This reviewed and submitted form would then be delivered to a process to complete the business operation.

With form review tasks any file attachments from the previous submission will be presented to the reviewer upon the submission of the review form. The

reviewer can the view the file attachments, delete them or add new attachments.
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Submission Attachments

Please review and complete the attachment requirements before continuing

Required Attachments

You need to attach these files in order to complete your submission

Driver's Licence
Maximum file size: 512

KB

Untitied gif Drivers License Scan Delete

Add Anocther File (Optional)

Optional Attachments

These attachments are optional but you may wish to add them to your submission

Medicare Card
Maximum file size: 1 MB

1 will deliver this document manually. Change

Total size: 4 KB (maxtotal 10.0 MB)

Total number of attachments: 1 (max number 5)

m Return to Form Cancel Submission

Screen:

Review Attachments From Previous Submission

Form designers often introduce phase variables in the form XML data model to change the forms behavior based on the phase it is in. For example in the
review phase, the form may display additional Office Use Only sections where the reviewer can provide additional information.
In comparison to the CreateFormTask operation the CreateFormReviewTask:

maintains a relationship to the previous form transaction (submission record)

you don't have to specify the formDataXml, it will use the data from the previous submission by default. Note some SystemProfile elements are
reset at form render time, these include DisplayMode, ReceiptNumber and SubmissionNumber.

file attachments are copied from the previous form submission on demand to the new form transaction record, so the reviewer can review or modify
them in a separate transaction

you can optionally specify an alternative form template for the reviewer to use, this could include additional sections for the reviewer to complete

Input Parameters

submitKey: the submission to base the task on (required)

subject: the task subject (required)

message: the task message (optional)

formCode: the form code of the task form (optional; if not specified, the submission's form will be used)
userName: the assigned user name (optional; must be specified if groupName is not)

groupName: the assigned form group name (optional; must be specified if userName is not)
portalName: the user portal name (optional; must be specified if userName denotes an LDAP user)
formDataXml: the form XML data or schema seed (optional; if not set, the XML data associated with the submission will be used)
latitude: the task location latitude (optional; must be between -180 and 180 if specified)

longitude: the task location longitude (optional; must be between -90 and 90 if specified)
scheduledTime: the scheduled task time (optional)

expiryTime: the task expiry time (optional; must be in the future if specified)

userDeletableFlag: whether the user can delete the task

sendEmailFlag: whether to notify the assignee(s) of the task via email

emailSubject: the notification email subject line

emailMessage: the notification email message body. Email message template variable you can use include:
${format} : Apache Click Format object use for formatting values

${formDataMap} : form data extracts map

${submission} : task submission object

${task} : task submission object (as above)

${environmentName} : server evironment name

${supportEmail} : support email address, defined as a deployment property

Output Result

A string containing the new task key identifier.

Faults
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FormlInactiveException: if the form exists but is inactive

FormNotFoundException: if the form cannot be found

FormPortalNotSetException: if the form exists but is not exposed on any portals

GroupNotFoundException: if the group was not found

InvalidParameterException: if one of the parameters violated a constraint

PortalNotFoundException: if the portal was not found during LDAP user lookup

PortalSecurityException: if the portal does not support LDAP users and the user does not exist as a local user
SubmissionNotFoundException: if the submission was not found

UserNotFoundException: if the user was not found (including LDAP lookup if applicable)
TaskUserWebServiceException: if other errors occur

ExpireTask

This operation immediately expires a task.

Input Parameters

® taskKey: the task key (required)

® boolean value: true if the task was expired, false if it could not be expired (because it is either already expired or has been completed).

Faults

® |nvalidParameterException: if one of the parameters violated a constraint
® TaskNotFoundException: if the task was not found

AddUserToGroup

This operation adds a user to a form group.

Input Parameters

® userName: The login name of the user (required)
® groupName: The name of the form group (required)
® portalName: the user portal name (optional; must be specified if userName denotes an LDAP user)

Output Result

® boolean value: true if the user was added to the group; false if they already were a member.

Faults

GroupNotFoundException: if the group was not found

InvalidParameterException: if one of the parameters violated a constraint

PortalNotFoundException: if the portal was not found during LDAP user lookup

PortalSecurityException: if the portal does not support LDAP users and the user does not exist as a local user
UserNotFoundException: if the user was not found in LDAP and does not exist as a local user
TaskUserWebServiceException: if other errors occur

RemoveUserFromGroup
This operation removes a user from a form group.

Note: This works only for Transaction Manager defined group membership; if the user is an LDAP user, group membership may also be imported from the
LDAP directory when the user logs in.

Input Parameters

® userName: the login name of the user (required)
® groupName: the name of the form group (required)

Output Result

® boolean value: true if the user was removed from the group; false if they were not a member.

Faults

GroupNotFoundException: if the group was not found
InvalidParameterException: if one of the parameters violated a constraint
UserNotFoundException: if the user does not exist in Transaction Manager
TaskUserWebServiceException: if other errors occur

ReassignTask

This operation reassigns a specific task.

Input Parameters

® taskKey: the task key (required)
® userName: the login name of the user to assign the task to (optional; needs to be specified if groupName is not)
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® groupName: the name of the forms group to assign the task to (optional; if not specified, the group assignment will be preserved, i.e. NOT nullified)
® portalName: the user portal name (optional; must be specified if userName denotes an LDAP user)

Output Result

® bhoolean value: true if the task was reassigned, false if the task was completed or expired.

Faults

GroupNotFoundException: if the group was not found

InvalidParameterException: if one of the parameters violated a constraint

TaskNotFoundException: if the task was not found

PortalNotFoundException: if the portal was not found during LDAP user lookup

PortalSecurityException: if the portal does not support LDAP users and the user does not exist as a local user
UserNotFoundException: if the user was not found (including LDAP lookup if applicable)
TaskUserWebServiceException: if other errors occur

ReassignAllUserTasks

This operation reassigns all tasks assigned to a specific user.

Input Parameters

® existingUserName: the login name of the existing user (required)

®* newUserName: the login name of the user to assign the tasks to (optional; needs to be specified if groupName is not)

®* newGroupName: the name of the forms group to assign the tasks to (optional; if not specified, the current group assignment will be preserved, i.e.
NOT nullified)

® portalName: the user portal name (optional; must be specified if userName denotes an LDAP user)

Output Result

® boolean value: true if any tasks were reassigned; false if no eligible tasks were found (completed or expired tasks are ignored).

Faults

GroupNotFoundException: if the group was not found

InvalidParameterException: if one of the parameters violated a constraint

PortalNotFoundException: if the portal was not found during LDAP user lookup

PortalSecurityException: if the portal does not support LDAP users and the user does not exist as a local user
UserNotFoundException: if the user was not found (including LDAP lookup if applicable)
TaskUserWebServiceException: if other errors occur
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Task and User SOAP Web Service (Manager v5.0)

Overview

The Task and User web service enables you to create form tasks, form groups and user accounts in Transaction Manager. By using the Task and User web
service, external applications can assign forms to staff to complete and create multi-step workflows. This web service has been replaced by the newer
Version 2 service, which provides additional operations and access to the richer Task API.

This Task and User Web Service is provided for backward compatibility.

Application Programmer Interface

The Web Services Description Language (WDSL) for the Task and User web service is available on the server URL:
http://<server name>/manager/fcservices/TaskUserWebService?wsdl

The Task and User web service provides of the following operations:

FindOrCreateUserAccount
CreateTaskGroup
AssignUserTask
AssignGroupTask
ExpireTask

FindOrCreateUserAccount

This operation attempts to find a user by login name. If unsuccessful, it creates a user for the specified portal.

Input Parameters
® JoginName: the login name identifying the user (required)
® email: the user's email address (required)
® givenName: the user's given name(s)
L[]
L]

familyName: the user's family name (required)
portalName: the name of the portal which the user should be associated with (required)

Output Result

A string containing the user key (a UUID) of the existing or newly created user.

Faults

® PortalNotFoundException: if the portal with the name specified in portalName cannot be found
® UserlnactiveException: if the user exists but is inactive
® TaskUserWebServiceException: if loginName is blank or an unexpected error occurs invoking this method

CreateTaskGroup

This operation will create a user group with a given name. If such a group already exists, no action is taken.

Input Parameters

® groupName: the name of the new group (required)
® portalName: the name of the portal to which the group belongs (currently unused)

Output Result

® boolean value: true if a group was created, or false if it already exists.

Faults

® TaskUserWebServiceException: if groupName is blank or an unexpected error occurs invoking this method

AssignUserTask

This operation will create and assign a task to a single user.

Input Parameters

userKey: he user key of the assignee (required)

portalName: the name of the portal which the task will be associated with (required)

formCode: the form code of the form on which the task is based (required)

formDataXml: the xml seed data to pass directly into the form (mutually exclusive with formPrefillXml)
formPrefillXml: the xml prefill data to map into the form's schema seed (mutually exclusive with formDataXml)
taskMessage: the task message to identify and explain the task to the user (required)

datetimeExpiry: the date and time the task will expire, if it has not been completed

userDeletableFlag: whether the assignee will be able to delete the task (required)
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® sendEmailFlag: whether an email should be sent to the assignee to notify them of the task (required)
® emailSubject: the subject of the email to the user
®* emailMessage: the notification email message body. Email message template variable you can use include:

${format} : Apache Click Format object use for formatting values
${formDataMap} : form data extracts map

${submission} : task submission object

${task} : task submission object (as above)

${environmentName} : server evironment name

${supportEmail} : support email address, defined as a deployment property

Output Result

a string containing the task key (a UUID) of the new task.

Faults

ExpiryDateException: if the datetimeExpiry parameter contains a date in the past

FormNotFoundException: if the form specified by formCode does not exist

FormlInactiveException: if the form specified by formCode is inactive

FormPortalNotSetException: if the form specified by formCode is not associated with a portal

PortalNotFoundException: if the portal specified by portalName does not exist

PortalMismatchException: if the form specified by formCode is not associated with the portal specified by portalName
UserNotFoundException: if the user specified by userKey does not exist

UserlnactiveException: if the user specified by userKey is inactive

TaskUserWebServiceException: if required input parameters are not set, both formDataXml and formPrefillXml are set or an unexpected error
occurs invoking this method.

AssignGroupTask

This operation will create and assign a task to an existing group of users.

Input Parameters

groupName: the name of the group of assignees (required)

portalName: the name of the portal which the task will be associated with (required)

formCode: the form code of the form on which the task is based (required)

formDataXml: the xml seed data to pass directly into the form (mutually exclusive with formPrefillXml)
formPrefillXml: the xml prefill data to map into the form's schema seed (mutually exclusive with formDataXml)
taskMessage: the task message to identify and explain the task to the users (required)
datetimeExpiry: the date and time the task will expire, if not completed before then

userDeletableFlag: whether the assignees will be able to delete the task (required)

sendEmailFlag: whether an email should be sent to the assignees to notify them of the task (required)
emailSubject: the subject of the email to the users

emailMessage: the message body of the email to the users

Output Result

Faults

a string containing the task key (a UUID) of the new task

ExpiryDateException: if the datetimeExpiry parameter contains a date in the past

FormNotFoundException: if the form specified by formCode does not exist

ForminactiveException: if the form specified by formCode is inactive

FormPortalNotSetException: if the form specified by formCode is not associated with a portal

GroupNotFoundException: if the group specified by groupName does not exist

PortalNotFoundException: if the portal specified by portalName does not exist

PortalMismatchException: if the form specified by formCode is not associated with the portal specified by portalName
TaskUserWebServiceException: if required input parameters are not set, both formDataXml and formPrefillXml are set or an unexpected error
occurs invoking this method.

ExpireTask

This operation will expire an existing task. Please note that the task must have a state of "Assigned".

Input Parameters

None

Faults
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taskKey: the valid task key (required)

TaskNotFoundException: if no task with this task key was found
TaskAlreadyCompletedException: if a task exists but has already been completed
TaskAlreadyExpiredException: if the task has already been expired
TaskUserWebServiceException: if an unexpected error occurs invoking this method
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Data Extract Example - Repeats (Manager v5.0)

Below is an example of repeating data extracts for the Avoka Transact Show Case form.

&> MAGUIRE

FINAMCIA

Reference Code ERWEITE

Introdeciion H H
" Repeating Sections
-“ A Showcass Formm
il e welt © ane regusneg
Frands Inpart
Halp . .
Repeating Sections
tiide Show LU
Thas SabeZ B eMPrsirales B
Fot uriee repeatng bock Descriphon
[ropdowss The folowing Bems were
corhguned
| repess 1) Humber of iterations - | D o e —
Maximum, manrmum and ]
Brariaeiit Hiilis & SLarirg
Prafill
v
n
Rich Data Collecion z o o e :
et
1) Cadoulations - The Add m Comment?
Finail T I
Tiz:u_u;u FIUM(} funciion in

comunction with some
Coraiiondl Kaad, Useg Some a Delete lem

Fedden fields
D save For Laier
4] An index flald - The ndex
& share Form of th MErB0ON 5 ASPLIYED 85 pyps 3
a floating field in each section
Fopching DesLnplon

Example form XML data structure:

<HepeatingSections>
<ExammlelfepeatingSect>
<blkItems>
<blkItems>
<Description*Desacription Z2</Description>
<Datecfievent>Z0l5-0Z-04«< /Datecievent>
<Emountr>lZ</EAmount>
<PaidinFull *true</PaidinFull>
<Claimthisitem>*true</Claimthisitem*
<EddaComment>falae</EddaComent>
<Comment/ >
<AmountPaidx>l1Z</EAmountPaid>
<EmountClaimed>]lZ<//EBmountClaimed>
“</blkItems>
<blkItems>
<Description¥Description Z</Descriptiocn>
<Datecfevent>2015-02-183</Datecfevent>
<Emountr>Z4</EAmount>
<PaidinFull *>true</PaidinFull>
<Claimthisitem*true</Claimthisitem>
<EddaComment>falae</EiddaComent >
<Comment/ >
<EmountPaid>Z4</ AmountPaid>
<EmountClaimed>Z4</EBmountClaimeds>
“</blkItems>
</blkItema>
<Totals>
<Totalampuntpaid»3e</Total amountpaid»
<TotalZmountClaimed 1>3&6</TotalifmountClaimed 1>
</Totalax
</ExamolefepeatingSects
</ Bepeatingiectionsr
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Form Data Configuration for repeating data extracts, please note the Extract Repeating Data option is selected. Please also note that you need to specify
the parent XPath, so TM can determine what elements are related. For example, don’t do //Description otherwise TM may not be able to associate grouped
data.

Avoka Transact Showcase Form - Version 3.0 - Form Data Config
Home Dashboard » Forms » Form » Submission Data Extract Mapping » Form Data Config

Configuration Mapping | Form XML Data | Property Prefill Mapping | Regquest Param Prefil Mapping | Input XML Prefill Mapping Form Data Extract Mapping |_

Form Data Extract Mapping are used define form XML values to be extracted when form XML data is submitted.
This submission data extract information is summarized in the Form Submission Data view.

Extract Field N\ame Form XPath Extract Repeats Sequence Action
Delivery Email IfvokasmartForm/DeliveryEmail 1 @ E
Description JIExampleRepeatingSect/blktems/blktems/Description 7 2 @ E 4}
Date Jiis leRepeatingSect/blkit ems/Datenfevent J 3 @ @
Amount IE RepeatingSect/blkit ems/Amount J 4+ A @

Example transaction data result:

Transaction Details

Home Dashboard » Form Transactions » Transaction Details

Transaction Detailz. | Transaction Status Request | History | Form XML Data Form Data Extract Processing Status | Events | Errors. |

Name Value Form XPath

Delivery Email medgari@avoka.com /AvokaSmartForm/DeliveryEmail

Description_1 Description 2 E Repeating /Description
Date_1 2015-02-04 E Repeating Dateofevent
Amount_1 12 E Repeating mount
Description_2 Description 2 E Repeating /Description
Date_2 2015-02-18 E Repeating Dateofevent
Amount_2 24 E R i mount
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Security Manager (Manager v5.0)
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Active Directory Federated Services (ADFS) (Manager v5.0)

Avoka Transact supports 2 different authentication and authorisation integration with Active Directory Federated Services 2.0, these are Federation
Services (SSO) & WS-Trust.

ADFS allow a Cloud Hosted Transact server to authenticate and authorise users for an organisation Active Directory.

The table below explains the main features and differences between the 2 Transact Security Managers that to Federation Services (SSO) & WSTrust.

Type

Federation
Services (SSO)

WS-Trust

Desc SSO

A user connects to a Transact Web secure page. Yes
The security Manager redirects the Users Browser to the ADFS Server:
® |f the user is running Internet Explorer and the user is logged onto the domain the Users browsers can pass the Windows Authentication to
the ADFS server this is the (SSO).
® With other browsers the ADFS server will prompt for the users credentials.
After validating the user via Windows Authentication:
* ADFS encrypts a SAML token using the Public Key to to get the user profile information such as first name, last name, email, groups etc.
This will update or create the user record.
® automatically redirects the users browser back to the Web Spaces home page. Passing the encrypted SAML Token

Transact Web

® Decrypts the SAML Token using to get the user profile information such as first name, last name, email, groups etc. This will update or
create the user record.

The Federation Services (SSO) Sequence Diagram (Manager v5.0) shows the connection between the Users Browser, Transact Web server and
the ADFS server.

Note: Each Transact Web Space in each environment requires its own Public / Private Key as well as its own Security Manager.

The user logs into TranactWeb or TransactField with their AD credential (Username and password). No
The Transaction Manager - Security Manager then calls the ADFS - WS-Trust Endpoint.
The ADFS service checks if the user credentials. If valid, the user details are passed back in the web service response to the Security Manager.

The SAML token is decrypted using the security managers Private key to get the user profile information such as first name, last name, email,
groups etc. This will update or create the user record.

WS-Trust Sequence Diagrams (Manager v5.0) page shows how TransactField and TransactWeb connect to WS-Trust using the sequence
diagram.

Note:

® WS-Trust requires a different Public and Private key for each environment.
® The WS-Trust Security Manager can be shared between multiple TransactWeb and TransactField Spaces.

Installation

Space
Support

Web Only

T-Field and
Web

Installation involves configuring either TM Security Manager created from the following templates: Microsoft ADFS Security Manager (Federation Services
SSO) or Microsoft WS-Trust Security Manager

The installation process for WS-Trust and Federation Services SSO have a lot of common installation and configuration steps. The table below summarises

the process:

Step Desc Who Federation
SSO
Creating Private / Public This step involved using the keytool to generate and store the steps in a command prompt / terminal Avoka Common
Keys and Trusting SSL IT

Certificates (Manager v5. | Note:

0)

Creating the _SP.xml

(Manager v5.0)

or

Keys are usually created with the Java that is supplied with Transact.

Java that comes with later versions of Transact 4.1.6 + can produce RSA256 key pairs. This means SHA-256 can Client IT
be used instead of SHA1

The key stores can be uploaded to a Transact Manager however its not possible to download them from

Transaction Manager

The storage of Private Keys is something that is covered under Avoka's security practise. For Hosted System this

is an Avoka IT function

The _SP.XML file is provided to the client's (ADFS specialist) for the purpose of creating a Relying Party Trust. Avoka Common
IT

This process involves the temporary use of a spring-security-saml2-sample war file. This is deployed to the server that

and Apache settings must be updated to allow the context to go through. or

The IT administrator then connects to the we page to copy field contents to a newly created _SP.XML file. Finally some of ' Client IT
the URL's in the _SP.XML file needs to be.

Create the ADFS Relying | The _sp.xml file created in the above steps is sent to the client. Client *Common
Party Trust (Manager v5. IT
0) The process for adding a new Relying Party Trust is detailed here. It involves the following Admin
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® Wizard is run to setup the Relying Party Trust from the sp_file supplied. ADFS
® Claim Rules are setup Admin
® Algorithm are checked and Endpoints are updated.

® WS Trust requires a new identifier to be setup.*

WSTrust

Common

Common

*Common



Microsoft ADFS Security
Manager Configuration
(Manager v5.0)

Microsoft WS-Trust
Security Manager
(Manager v5.0)
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® All new installations should use the SHA-256 algorithm. Old installs may have used SHA-1.

This is the Security Manager for the ADFS Federated SSO. It has a 1 to 1 association with a Relying Party Trust.
Federated SSO uses browser redirecting from Transact Web Space to ADFS as well as from ADFS back to the web
space's context. This Security Manager can only be associated with a single Relying Party Trust and a single Web Space

This is the Security Manager for the WS-Trust.

Avoka Yes
Installer

Client
IT
Admin

Avoka No
Installer

Client
IT
Admin

No



Create the ADFS Relying Party Trust (Manager v5.0)

Open AD FS Manager on the Windows Server.

Add Relying Party Trust by Importing the _sp.xml File

- ADFS. [=T=lm
Q@ Fle Adon View Window Hep [lelx
Y
A0S Actions
=] :w‘n; N o Encbled__ Identier Relying Party Trusts =
Claims Provider Trusts - = — Add WE‘Y‘"‘}PIWTNR -
= Rebying Prty Trusts view ,
Astrbute Stores New Window from Here:
@ Reren
B e
Larry's Laptop -
. Vetadat
&
The Add Relying Party Trust Wizard comes up
Select Start
1 Add Relying Party Trust Wizard =1
Welcome
=i Welcome to the Add Relying Party Trust Wizard
@ Welcome
This wizard will help you add a new relying party trust to the AD FS corfiguration database. Relying parties
@ Select Data Source consume claims in securty tokens that are issued by this Federation Service to make authentication and
@ Choose lsuance authorization decisions.

Authenzztion Rules The relying party tnust that this wizard crates defines how this Federation Service recogrizes th relying
© Readyto Add Tust party and issues clzims to 1. You can define ssuance transiom nes forissuing claims to the reiying party
aher you complete the wizard
@ Frish

<Previos | [ St | [ Caned | [ Hep

Select "Import data about the relying party from a file".
Browse and select the testlmaguireavoka_sp.xml file created above.

Press Next A warning dialog will appear press OK.
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Select Data Source
Steps
Select an option that this wizard wil use to obtain data about this relying party:
@ Welcome
) Import data about the relying party published online or on a local network.
Select Data So
- = Seuree Use this option to impor the necessary data and certficates from a relying party orgarization that
@ Choose lssuance publishes s federation metadata oniine or on a local network.
Authonzation Rules
Federation metadata address fhest name or URLY:
@ Ready to Add Trust |
@ Finish
Bxample: fs.contoso.com or hitps://ww contose com/app
@® Import data about the relying party from a file
Use this option to import the necessary data and certficates from a relying party organization that has.
exported it federation metadata to a file. Ensure that ths file is from a trusted source. This wizard wil
ot valdate the source of the file
Federation metadata fil location
| [ Browse.
O Enter data about the relying party manually
Use this option to manually input the necessany data about this relying party organization.
[<Pevious || nex> |[ Canesl | [ Hel |
@ ~ 4 [EDesktop » v ¢ [ search Desktop o]

Orgenize = Newfolder

¢ Favorites il Libraries
B Desktop System Folder

|i¢ Downloads

5 Dicent places \ Network
System Folder

[ Libraries
[ Documents
o Music
&= Pictures

B videos

Larry Bunton B || Computer
System Folder System Folder

testimagiureavoka_sp ‘

XML Document
5.16 KB

8 Computer

iy Local Disk ()
<a DATA (D)
8 C on USR-LBUNT
% D on USR-LBUNT
9 Eon USR-LBUNT
52 Gon USR-LEUNT -

File name: | testmagiureavoka_sp

[Metadiata files ("xmi) v

A

G Add Relying Party Trust Wizard

Select Data Source

Steps. Select an option that this wizard wil use to obtain data about this refying party:
© Welcome

O import data about the relying party published online or on a local netwark
@ Select Data Source

a relying party that

Use this option to import th ry data an
@ Choose lssuance publishes ts federation metadata oniine or on a local netwok.
Authorization Rules
© Readyto Add Trust

@ Finish

Federation metadata address (host name or URLY

Example: fs.contoso com or hitps://www.contoso.com/app

@) Import data about the refying party from a file

Use this option to import th ry data and cer a relying party organization that has
exported metadata to a fie. Ensure that is from a trusted source. This wizard will
not validate the source of the file.

Federation metadata file location
C\Users'lburton\Desktop test Imagiureavoka_sp xml ] [ Browse...

Some of the cortent inthe federation metadata was skipped because i is not supported by AD FS. Reviewthe propefties of
the trust carefully before you save the trust to the AD FS corfiguration database.

Type in the the Display Name and Notes. Note the diagram differs from the recommended values. These can be updated later.
Display Name: {environment}.{web space context}

e.g. testl.maguireavoka
Notes: https://{server domain name}/{web space context}/secure/account/home.htm

e.g. https://tm.testl.avoka.com/maguireavoka/secure/account/home.htm
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Specify Display Name

Steps
@ Welcome

Type the display name and any optional notes for this relying party.

Display name:

@ Select Data Source
[test1 Maguire Avoka

@ Specify Display Name

@ Chooss Issuance Notes:
Authorization Rules

ttps:/Am test 1 avoka.com/maguire/admin/home htm|
© Readyto Add Trust

@ Finish

Select Permit all users to access this relying party. Then click Next.

Choose Issuance Authorization Rules

Steps. I = R et pemtee] e it F ot oty
@ Welcome Choose one of the following options for the initial behavior of this reying party's ssuance authorization
nies.
@ Select Data Source
@ Specky Display Name ®) Permit all users to access this relying party
Th s wil be configured to pemnt al users to this relying party. The
@ mﬁ;ﬂaﬁm relying party service or application may stlldeny the user access.
@ Readyto Add Trust O Deny all users aooess to this relying paty
© Fiish Th ization ndes wil be configured to deny all o his relying party. You must
Iater add issuance authorization nes 1o enable any users to acosss ths relying party.

You can change the issuance athorization rules for ths relying party trust by selecting the relying party
trust and clicking Edt Clam Rules in the Actions pane.

Click Next

Ready to Add Trust

Steps: The relying party trust has been configured. Review the following saftings. and then ciick Next to add the:
@ Welcome relying party tnust ta the AD FS configuration database.
® Select Data Source
@ Speciy Display Name Encryption | Signature | Accepted Ciaims | | Endpoints [ Notes | Advanced <
@ Choose lssuance ‘Speciy the encryption ceriicate for this relying party trust

Authonzation Rules
@ Readyto Add Trust T
@ Frish Issuer CN=Nr Tester, OU=md, O=avoka, L=sydney, S=nsw, C=au

Subject CN=Mr Tester, OU=md. O=avoka. L=sydney. S=nsw. C=au

Effective date:  11/03/2014 4:29:53 PM
Expiration date: 8/03/2024 4:29:53 PM

[ ver ]

select the Open the Edit Claim Dialog check box and click Close
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Finish

Steps The relying party trust was successfully added to the AD FS configuration database.
Wel
@ Welcome You can modfy this relying party trust by using the Propetties dialog bax in the AD FS Management snap-n
® Select Data Source
@ Speciy Display Name

@ Choose Issuance
Authorization Rules

@ Readyto Add Trust
@ Finish

[¥] Open the Edit Claim Rules dialog for this relying party trust when the wizard closes

Claim Rules

Right Click on the Relying Party Trust, select Edit Claim Rules...
You will get a Dialog Edit Claim Rules for <Environment>.<webspace>.

Select Add Rule.

Relying Party Trusts

Display Mame Enabled |dertifier
Lamy’s Laptop Yes Avolca lamy dev
test1 Maguire Awval _ i giureavoka
Update from Federation Metadata...
Edit Claim Rules...
Dizable
Properties
Delete
Help

Issuance Transfom Rules | ssuance ion Rules | Delegation ion Rules |
The following transform ules specify the claims that will be sert to the relying party.
Order ~ Rule Name Issued Claims
Add ﬂlre Edit Rule. Remove Rule
ok | [ cencsl || oo [ Hep |

Setup the Claim Rule, Attribute Store and Mappings as follows.

Note: The second screen capture shows the 3 additional fields that don't fit on the first screen
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Edit Rule - NamelD

“You an corfigure this rule to send the values of LDAP attributes as claims. Select an attibute store from
which to extract LDAP attributes. Specify how the attributes will map ta the outgoing claim types that will be
issued from the rule

Claim rUle name:

Edit Rule - Nameld

You can corfigure s nule to send the values of LDAP attnbutes as claims. Select an attnbute store from
which to exract LDAP attrbutes. Specify how the attrbutes will map ta the outgoing claim types that will be:
issued from the rule.

Cim nie niame

NamelD

==

Rule template: Send LDAP Attributes as Claims

Rule template: Send LDAP Attributes as Claims

Select Ok then OK

Update Algorithm

Atrbute store: Atrbute glore
Active Directory v] [ctive Directoy v]
Mapping of LDAP attibuies Lo ovtgoing claim types ks Mapping of LDAP atirbutes to oLtgaing ciaim types.
LDAP Atrbute (Select ar type fo ) LDAP Altibute (Select T
add mors) Ouigoing Claim Type (Select or type to add more} add mm;‘ e (Select ortype to Outgoing Claim Type (Select ortype to add more)
SAM-Account-Name | Name 1D v E-Mai-Addresses v | E-Mai Address v
Given-Name v [Given Name o= o Momber G OL ) [ S
UserPincipal Name ¥ JUPN hd User-PrincipakName v |upn vl
Sumame ¥ | Sumame hd SAM-Account-Name: | Windows account name v
> |[EMai-Addresses v [E:Mai Address V] = " "
View Rule Language ok | [ Conesl ][ Hep
View Rule Language: oK | [ Cancel | [ Hep

From the main screen select the relying trust. Right click and select Properties.

Next Click on the Advanced tab.

Select Secure hash algorithm as SHA-256

Note: Older systems used SHA-1 algorithm, all new 4.1.6+ clients should use SHA-256

| Moritoring | identifiers | Encoption | Signature | Accepted Claims |
| Organization | Endpoirts | Proxy Endpoints | Notes ‘ Advanced

test1.avokasso Properties

Specify the secure hash algorithm to use for this relying party trust.

Secure hash algorthm: | SHA 256 v

[ ok || cace |[ sopy

| Federated SSO Update Endpoints

From the main screen select the relying trust. Right click and select Properties.

It is possible to reuse a Relying Party Trust for 1 Federated SSO with a portal and WS-Trust. In which can you can perform both this

The following instructions are different for the WS-Trust and Federated SSO

Select the Endpoint tabs

Make the POST SAML Assertion Consumer Endpoint the Default

Double click to get the Edit Endpoint

Update the URL: https://{server environment name}/{}web space name}/secure/account/home.htm

eg. https://tm.testl.avoka.com/maguireavoka/secure/account/home.htm
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test1 Maguire Avoka Properties =] dertiier

[ Morkoring | idertfies | Encyption | Sirature | l’:::‘s'i
Acoepted Clams_ | Organizaton | Endpoints | Notes | Advanced | =

‘Speciy the endpoints to use for SAML and WS-FederationPassive
protocols.

URL ndex  Bndng  Defaut |
SAML Assertion Consumer Endpoints

hitps:/Am test1.avoka.com/m... 1 POST Yes
SAML Logout Endpoints

hitps:/Am test1.avoka.com/m... n/a POST No
hitps:/Amlestlavoka.com/m... n/a  Rediect  No

Endpoint type:

[ SAML Assertion Consumer |

Bindng
[Post v

Indiex:

URL:

| itps://im test1.avoka com/magureaveka/secure /account/home Fim |
Example: hitps://sts contoso.com/adfs/ls

Response URL:

Example: hps://sts.contoso.com/logout

Adding WS-Trust Identifier

From the main screen select the relying trust. Right click and select Properties.
Select the Identifiers tabs

Update the Relying party identifier: https://{server environment name}/
https://tm.testl.avoka.com/

Click Add, then Apply

Organization | Encpoints | Proxy Endpoints | Netes | Advanced | || [ Organization | Endpoints | Proxy Endpoints | Notes | Advenced |
dentfiers | Encyption | Signature | Accepted Claims

Moritoring | Idertfiers | Encoyption | Signature | Accepted Claims |
Specify the display name and identfiers for this relying party trust Specify the display name and identifiers for this relying party trust

Display name: Display name:

[iest1.avokasso | [iest1.avokasso |

Relying party identifier:

Relying party identifier:
[nétps:/tm test1 svoka com/ | [ A | I

Example: hitps:/As contoso.com/adfs/servicesArust Example: hitps./As.contoso com/adfs/services Arust

Relying party identifiers: Relying party identifiers:

test1.avokasso Remove

06 | [ Comeel | [ esv | ok [ [ camca | [ memy |
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Creating Private / Public Keys and Trusting SSL Certificates
(Manager v5.0)

Overview

Public and private key need are generated and stored in a Java Keystore. The keystore that holds the private and public key will be uploaded to the
Transaction Manager - Security Manager. It is recommended that the generation of the private / public key pairs be done on a secure server.

ADFS using Federation SSO, and WS-Trust and will only communicate works over HTTPS / SSL. In addition the Transact Server must trust the SSL
certificate of the ADFS Server and visa versa. It is better to use certificates generated by a Trusted Certificate Authority than a self signed certificate, Even so
Transact may have to trust the ADFS servers SSL certificate.

Note: The processes of trusting the ADFS certificate writes to the Java cacerts file. The process may need to be repeated if t

Prerequisites

Java

This is installed with Transact the default locations are here
C:\avokaltransact\manager\jdk1.7.0_80 (Windows)

/data/avoka/transact/manager/jdk1.7.0_80 (Linux)

Generate the Private / Public Key Pair into a Keystore (.jks)
The following uses keytool located here"C:\avoka\transact\imanager\jdk1.7.0_80\jre\bin\keytool.exe"
It creates:

® A keystore named samlKeystore.jks

® The private and public Key with RSA-2048 key size which is valid for 10 years.

® devmaguire is the matching keystore alias for the public / private key. This alias can be any name, | have used the following naming convention
<environment><clientname>

® The alias password is also set to mysecret. This should be replace with a more secure password.

® The keystore password is set to the same as the alias password

Keytool

#> keytool -genkeypair -alias devnaguire -keypass nysecret -keyal g RSA -keysize 2048 -validity 3650 -keystore
sanl Keystore.jks

Enter keystore password:

Re-enter new password:

What is your first and | ast name?

[ Unknown] : nmaguire

What is the nane of your organizational unit?

[ Unknown] : avoka-it

What is the name of your organization?

[ Unknown] : avoka technol ogi es

What is the name of your City or Locality?

[ Unknown] : nmanly

What is the nane of your State or Province?

[ Unknown] : nsw

What is the two-letter country code for this unit?

[ Unknown] : au

I's CN=maguire, OU=avoka-it, O=avoka technol ogies, L=manly, ST=nsw, C=au correct?
[no]: yes

#>

Trusting the SSL certificates

<Yo can you please complete this>
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Creating the _SP.xml (Manager v5.0)

Extract a spring-security-saml2-sample.war file

Using 7Zip extract the contents of the base spring-security-saml2-master into the C:\avoka_adfs\spring-security-saml2-sample\

note C:\avoka_adfs is a temporary directory used for editing and updating files.

We will be updating the files highlighted in this directory.

J testlenv
5] berkley.cer

| spring-security-saml2-sample .
[5] CN=ttacd.samplecrganization.com.cer

. META-IMNF
Qf' Federationfetadata.xml
. WEB-IMNF
=] geotrust.cer
J classes —_
M idp.xml
| org _
, || samlKeystorejks
| securi
t}.‘ ) Qf’ securityContesxt.xml
1) securityContext.zip - -
b 1) securityContext.zip
S i
. | £ sslextractor-0.9.jar
| security

Connect to the ADFS server to get FederationMetadata.xml

TG 1T I
{ LjLJ13

£y

[==1

00 PM
/1272013 2:00 PM
3/02/2014 10:48 ...
9/12/2013 2:00 PM
29/12/2013 8:00 PM
11/03/2014 4:43 PM
4/04/2074 11:38 AM
20/12/72013 &

L

[==]

q
'

u—y

[pn)

2:00 PM

29/12/2013 2:00 PM

The following is required if you are connecting to a new ADFS server. This step has already been completed for Manly-2013

https://<yourservername>/FederationMetadata/2007-06/FederationMetadata.xml
save to file

C:\avoka\cert\{environment}\spring-security-saml2-sample\WEB-INF\classes\security\FederationMetadata.xml

Edit securityContext update your keystore alias and password.

C:\avoka\cert\{environment}\spring-security-saml2-sample\WEB-INF\classes\security\securityContext.xml

For the above credentials.

Ehammﬂhnmﬁxmlm]

Create a spring-security-saml2-sample.war file
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6l
62 «<!'-- Central storage of cryptographic keys ——>
63 <bean id="keyManager" class="grg.springfiramewerk.security.gsaml.key. KSKeyManager">
64 <constructor-arg value="glasspath:security/samlReystore.Jks"/>
65 <constructor-arg type="Jaya.lang.String" value="secret"/>
66 ] <constructor-arg>
a7 E <map>
68 <entry key="testl" wvalue="secret"/>
g - </map>
70 - </constructor-arg>
71 <constructor-arg type="Jaya.lang.String" value="testl"/>
72 - </bean>
74 «!-— Entry point to initialize authentication, default wvalues taken from properties file -->
7] = <bean id="samlEntryPoint" class="grg.springframework.security.saml.SAMLEntryFoint">
76 % <property name="defanltProfileOptions":>
77 = <bean class="grg.springframework.security.saml.webhsso.Web550Frofilelptions">
78 <property name="includeScoping" wvalue="false"/>
79 - </bean>
80 - </property>
81 - </bean>
g2
83 <!-- IDP Discovery Service -->
g4 [H <bean id="samlIDPDiscovery" class="grg.springframework.security.zaml.SAMLDiscovery">
85 <property name="idpSelectionPath" values="/WEB-INF/security/idpSelection.jsp"/>
86 L </bean>
ga <!—— Filter automatically generates default 5P petadata ——
89 = <bean id="metadataGeneratorFilter" class="grg.springframework.security.gaml.metadata. MetadataGeneratorFilter">
o E <constructor-argk»
a1 = <bean class="grg.shringframework.security.saml - m@&@g@&@ MetadataGenerator">
sz <property name="entityId" wvalue="testl.
33 <property name="signMetadata" 1a,,e=“false”/>
94 - </bean>
as - </constructor-arg>
96 F </bean>

Security Certificat:
Security Certificat
XML File

Security Certificat
XML File

JES File

XML File
Compressed (zipp

Executable Jar File



Using 7Zip the contents of the C:\avoka\cert\{environment}\spring-security-saml2-sample\ directory into spring-security-saml2-sample.war

Deploy spring-security-saml2-sample.war file to The TM Server
1. Update Apahce proxy setting for the war file context spring-security-saml2-sample.
2. https://<servername>/spring-security-saml2-sample/

® check the server.log for errors
® You will get to a IDP selection page.

[ Spring Security SAML Exte % |

€« > C A & https;//devapply.caa.co.uk/spring-security-saml2-sample,
i Apps ¢ Bookmarks [T] Getting Started ﬂSuggested Sites ['] Web Slice Gallery ("] Im

IDP selection

http//1dp ssocirele com
* http://dev-avoka-adfs clondapp.net/adfs/services/trust

Login

Metadata nformation

Select IDP:

® click on the "Metadata information" Link

€« C A [ https://devapply.caa.co.uk/spring-sec saml2-sample/saml/web/metadat:
i Apps 9k Bookmarks [T Getting Started ﬂ Suggested Sites [ Web Slice Gallery (] Imported From Firef.. [5 ¢
Metadata

Generate pew service provider metadata
Initialize Single S1gn-On

Default hosted service provider:
testl.maguireavoka

Default service provider is available withont selection of afias.

Service providers:
http://dev-avoka-adfs clondapp net/adfs/services/trust
testl maguireavoka

Identity providers
hitp://sdp.ssocircle.com

-ad 5

Metadata providers

org.opensaml. saml? metadata. provider FilesvstemMetadataProvider@6£6d2a0a
5] 2 dat: vids tadataProvider@59d95

Refersh metadata |

® Under the "Default hosted service provider" click on the
® {environment}.{portal} link eg testl.maguireavoka

Follow the instructions to store the metadata in file {environment}{portal}_sp.xml e.g. testlmaguireavoka_sp.xml

This metadata includes the exported public keys as well as other settings used by ADFS. It is used by the next section to which details creating the Relying
Party Trust in ADFS.

Remove the spring-security-saml2-sample.war
Delete the file from standalone\deployments

Remove Apache settings for the spring-security-saml2-sample
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http://localhost:9080/spring-security-saml2-sample/
http://localhost:9080/spring-security-saml2-sample/

Federation Services (SSO) Sequence Diagram (Manager v5.
0)

Transact Web Federation Service SSO (ADFS 2.0) Authentication Sequence

l All Transportation over HTTF'SW

B Select Secure Page Entry URL

No Session Found, Store Entry URLIT

Post redirect to ADF S server

L J

Post to ADFS Federated Logi

l 550 - Browser Automtically negotiates Windows Doma

‘ Or the user enters their credentiz

Valid User SAML Token is Encrypted with

Post Redirect with SAML Toke

Post with SAML Token To Jsecure/accounthome.htm

-
-+

N
[ SAML Token is decryted with Private Key, Create/Update SSO User and profile, and create User Session.

Redirect page to Entry URL
e Select Secure Page Entry URL

Transact Web User Browser
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Microsoft ADFS Security Manager Configuration (Manager
v5.0)

Create a new Security Manager

Select Security Managers from the Security Menu

Click New

Security Managers

Home Dashboard » Security Managers

[« Active Only Clear

Nﬁ\r Import Export

Name Description Active Default Last Modified Action

2FA test Security Manager Provides a local database user account security manager J 21 Jul 2015 by adminavoka E’I E i

Lecal Security Manager Provides a local database user account security manager J J 22 Jun 2015 by system EI ‘!
Export Data

Enter New Security Manager Name

New Security Manager

Home Dashboard ¢ Security Managers ¢ Mew Security Manager

Security Manager Template® | Microsoft ADFS Security Manager w &

Mew Security Manager Name®  ADFS 550 Test1 maguireavoka L7 ]
Save Cancel

Security Manager Tab

i) A ADFS S50 Test! maguireavoka security manager has been successfully created.

Security Manager Spaces Authentication Providers 550 Auth Fitter 550 Certificates | Parameters

Name* | ADFS 550 Test1 maguireavoka @

Provides s Microseft Active Dirsctory Federation Services
Description | {ADFS) S50 user sccount security msnager

Defautt Security Manager [ ] /@
Disable User Profie Ediing ] @

Active [F] @
Last Modified 27 Jul 2015 - 15:58 by lbunton@avoka.com

User Authentication
Delegated Authentication [¥] &

2 Factor Authentication v|i@
Max Login Attempts | 5 v|@
Lockout Duration | 15 minutes | v | &'

Session Timeout | 30 minutes | v | @

Save [eLEE

Spaces Tab

There should only be 1 Web Space selected for the 1 ADFS Security Manager.
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ADFS SSO Test1 maguireavoka Security Manager

Home Dashboard » Security Managers » Security Manager

Security Manager I Spaces I Authentication Providers | S50 Auth Fitter I SS0 Certificates Parameters.
Available Assigned
Business Reports Maguire
TransactField App
Transaction Manager
Web Plug-in
Spaces & Modules <
Save Close

SSO Certificates Tab

Use the keystore, password, alias and alias password used in the Create the Private / Public Key step
® Keystore File: Upload the samlKeystore.jks
® Sso Keystore Password
® Private Key Alias

® Private Key Password

ADFS SSO Test1 maguireavoka Security Manager

Home Dashboard » Security Managers b Security Manager

Security Manager | Spaces | ion Providers | S50 Auth Fitter | 550 Certificates Parameters
Validation Certificate
Validation Cert Filename =
Valigation Cert File | Browse_ | Nofie selected a

Java Keystore

Keystore Filename: @
Keystore File | Browse_ | Nofie selected =
Ss0 Keystore Password a
Private Key
Private Key Alias g
Private Key Password @

Save Clear Cert Clear Private Key Close

SSO Auth Filter Tab

Login URL: https://[SERVER_ADDRESS]/adfs/Is/IdpInitiatedSignon.aspx?logintoRP=[RELYING_PARTY_IDENTIFIER]
https://adfs.maguire.com/adfs/Is/IdpInitiatedSignon.aspx?logintoRP=test1.avokasso

Logout Chain URL: ./index.htm

This will redirect the user to the
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https://adfs.maguire.com/adfs/ls/IdpInitiatedSignon.aspx?logintoRP=test1.avokasso

ADFS SSO Test1 maguireavoka Security Manager

HoreDastoear » Sscurty Managers » Secrty Uanager

Secuty onager | Spaces | | 550 Autn e 550 erfaes | Poroneir

erabe ssorar (99

cries AedizecEaception

et550 Aun Tken eret

R e

At OK Respanse Seret

Reirecion s pedstislommneriel requese

o ir St sty sesiseee T soturing 1) ¢
: :

e

Logi URL reps./SERVER,ADDRESS) s/ dpintodSanen 3oc7ogmoR RELYING. PARTY IDENTIFIER]

@

LogoutCran URL @

G
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Microsoft WS-Trust Security Manager (Manager v5.0)

Create a new Security Manager

Select Security Managers from the Security Menu

Click New

Security Managers

Home Dashboard » Security Managers

Active Only [EEESTN  Clear

th Import Export

Name Description Active Default Last Modified Action

2FA test Security Manager Provides a local databaze user account security manager J 21 Jul 2015 by adminavoka EI E '!

Lecal Security Manager Provides a local database user account security manager o o 22 Jun 2015 by system EI ‘é
Export Data

Enter New Security Manager Name

New Security Manager

Home Dashboard ¢ Security Managers ¢ MNew Security Manager

Security Manager Template®  Microsoft WS-Trust Secunty Manager | v 7]

Mew Security Manager Name™ | WS-Trust Securty Managerl 7]
Save Cancel

Security Manager Tab

WS-Trust Security Manager

Home Dashboard » Security Managers » Securty Manager

i AWS-Trust Security Manager has been successfull created

Security Manager | Spaces | Authenticaton Providers | SSO Auth Fiter | SSO Certficates | Parameters

Name* WS-Trust Security Manager @

Provides = Microsoft WS-Trust ADFS delegated authentication
Description  Security manager

Default Security Manager [ ] @
Disable User Profile Editing [¥] @

Active @
Last Modified 27 Jul 2015 - 16:23 by lbunton@avoka.com

User Authentication
Delegated Authentication [¥] @
2 Factor Authentication -8
Max Login Attempts 5 v|@
Lockout Duration 15 minutes | v | @'

Session Timeout | I minutes | v | @

CED

Spaces Tab

WS-Trust can be assigned to as many TransactWeb and TransactField spaces.
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WS-Trust Security Manager

Home Dashboard » Security Managers » Security Manager

Security Manager I Spaces I Authentication Providers S50 Auth Fiter S50 Certificates Parameters

Available Assigned
Business Reports Maguire
Transaction Manager TransactField App
Web Plugdin

~

Spaces & Modules

W
v

“
-

Save Close

SSO Certificates Tab

Use the keystore, password, alias and alias password used in the Create the Private / Public Key step
® Keystore File: Upload the samlKeystore.jks
® Sso Keystore Password
® Private Key Alias

® Private Key Password

ADFS SSO Test1 maguireavoka Security Manager

Home Dashbosrd » Security Managers b Security Manager

Securty Wansger | Spaces | Authentication Froviders | 550 AuthFiter | 50 Certificates | _Paramsters

Validation Certificate

‘Validation Cert Filename @

Validation Cert File | Browse_ | Nofie selected @

Java Keystore

Keystors Filename a
Keystore File Browse_ | Nofile selected. 7]
Sso Keystore Password @
Private Key
Private Key Alias. a
Private Key Passwaord a

ClearCert || Clear Private Key | Close

SSO Auth Filter Tab

Login URL: https://[SERVER_ADDRESS]/adfs/Is/IdpInitiatedSignon.aspx?logintoRP=[RELYING_PARTY_IDENTIFIER]
https://adfs.maguire.com/adfs/Is/IdpInitiatedSignon.aspx?logintoRP=test1.avokasso

Logout Chain URL: ./index.htm

This will redirect the user to the
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https://adfs.maguire.com/adfs/ls/IdpInitiatedSignon.aspx?logintoRP=test1.avokasso

ADFS SSO Test1 maguireavoka Security Manager
cuty anagrs » Securey aneger

ey vager | Spees | AuberitonProvtrs | 330 At ier | 550 Gt | puaneers

ersbessofar (919

Get550 a0 Token sret |

At O Respanse vt | -

IntodSanen 3 2egrioRP FELYING PARTY JDENTIFER)

LogoutCran URL °

Parameters Tab

WS-Addressing Endpoint Reference:
[TM SERVER_ADDRESS]
e.g. https://tm.testl.avoka.com/

WS-Trust Endpoint URI:
https://[SERVER_ADDRESS]/adfs/services/trust/13/UsernameMixed

e.g. https://adfs.maguire.com/adfs/services/trust/13/UsernameMixed

WS-Trust Security Manager

Home O » Security M gers b Security M

Security Manager | Spaces | Authentication Providers S50 Auth Fitter 550 Certificates Parameters

Name Type Value Description

SAML Group Attribute Name String hitp:ischemas xmizoap.org/claime/Group Opticnal SAML group attribute name, use if groups are to be imported by ADFS.

SAML XML Node Name String EncryptedAssertion SAML XML node name

W3-Addressing Endpeint Reference String [TM SERVER_ADDRESS] WS-Addressing Endpoint Reference element identifying the Web service endpoint at which the reguested s
W3-Trust Endpeint URI String https:/[SERVER_ADDRESS)adfs/services/trust/3/User...  WS-Trust server endpoint URI

WS-Trust Request Template String <=s:Envelope xmins:s="http:/"www.w3.0rg/2003/05/z0ap-... WS-Trust SOAP Request Velocity template

New Close
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WS-Trust Sequence Diagrams (Manager v5.0)

Below it the WS-Trust Flow for TransactField App and TransactWeb.

Note Both use the Same Security Manager which is the Transaction Manager component that communicates with the ADFS WS-Trust Endpoint to
authenticate the user.

Avoka TransactField App - WS-Trust (ADFS 2.0) Authentication Sequence

TransactField App Transaction Ma r (Cloud ADFS Proxy (Client

Usemame/Password sent to TM via REST request

I
I

F— a
All traffic uses HTTPS !
I

]

]

I

Reqguest SAML Token with Usemame/Password _

[
Validates the user

Return SAML token

Inspect SAML token for authentication success/failure and User detailsj

|
_ Return extracted User profile and/or Authentication response |
= 1

TransactField App Transaction Manager (Cloud) ADFS Proxy (Client)

Avoka TransactWeb Portal - WS-Trust (ADFS 2.0) Authentication Sequence

TransactWeb Browser Transaction Ma r (Cloud ADFS Proxy (Client)

i
User clicks on a Secure Page URL_A !

FAIL. User does not have a sessionj

User redirected to Login page

User enters their username and passwortlj

|
| Usemame/Password sent to TM

All traffic uses HTTPS

Request SAML Token with Usemame/Password _

[
Validates the user

Return SAML token

I
|
[
e

Inspect SAML token for authentication success/failure and User detailsj

T
_Success: User redirect to secure URL_A. |

On Fail goto "FAIL. User does not have a session” ab-ouej
|

I
|
|
1
I
|
|
|
I
I
|
On Success create session !
I
|
|
|
I
I
|
|
I
I
|

TransactWeb Browser Transaction Ma r (Cloud ADFS Proxy (Client)
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2 Factor Authentication (Manager v5.0)

Transaction Manager has supported 2 factor authentication since 4.X

This document details how to setup this for the Transaction Manager module.

Access Control Options (Manager v5.0) contains details on how to setup the service.

Work in Progress.

243



Form A/B Testing (Manager v5.0)

Introduction to Transact A/B Testing

Avoka Transact supports dynamic form version selection. The key use of this new capability is to enable A/B testing of applications for transaction conversion
rate optimization. Business teams can now incrementally change application forms, making individual changes and test the results quickly. By testing
multiple versions in parallel, you can isolate the changes you have made from other variables that would be introduced if comparing different versions
running at different times. By rapidly iterating and testing new changes, organizations can quickly and dramatically improve transaction conversion rates.

A/B Testing analytics in Transact supports time-series analysis of multiple form versions, with filtering by device type.

Form version selection is provided using a randomized distribution for A/B Testing, however it is possible to devise a customized version using a scriptable
Form Version Selection service. This capability also supports dynamic form version selection for market segment targeting. For instance, if you have a
different type of product for a specific geography you can use form version selection to choose the correct product. If you want to provide an alternative
product for an existing customer, you can also use form version selection for this purpose.

How to set up A/B Testing.

The following example shows 2 form versions of the form "AB Testing Demo". It is possible to have more than this include them in the A/B testing. In the
screen below, under normally conditions only the current version v1.0 of the form would be offered to the user. The steps below show how you can include
multiple versions to be shown to users at random.

AB Testing Demo

Home Dashbeard » Forms » Form

i/ Composer package import completed.

Dashboard I Details I Flow Config Email Verific ation I Form Versions Abandonment I Page Tracking I Spaces I Group Access Form Promation I Deployment Schedule

Form Details Form Versions
Form Display Name : AB Testing Demo Version Current Version Last Modified
Form Code :  ab-testing-demo y . -
20 Make Current 12 Mov 2015 Properties Aftachments Services Data Config @D iy
Organization : Maguire
Delivery Channel: Defautt - Web Service 1.0 v 12 Nov 2015 Properties  Attachments  Services Data Config @D i)
Created : 12 Nov 2015 - 21:23 by jclagnani@avoka.com
Last Modified © 12 Mow 2015 - 21:24 by jclagnan@avoka.com New Form Versicn  Export Current Form Version
Form URLs Latest Transactions View Al Transactions
Spaces Friendly Landing Form Direct QR Code o} Receipt Number Time Transaction Status Receipt
Maguire @ @ @ @ E]
1s: 0 q 0 ission Rate: 0%  Avg. Submit Time :

PDF Receipt Test

Close

The Details Tab has the option to use a Form Version Selector. The dropdown menu has the form selectors that are available for use. The standard TM form
selector will provide a randomized distribution for the A/B testing. It is possible to customize form selectors based on client requirements.

AB Testing Demo

Home Dashboard » Forms » Form

Dashboard I Details I Flow Config I Email Verification Form Versions | Abandonment | Page Tracking I Spaces Group Access I Form Promotion Deployment
Form Display Name*  AB Testing Demo @
Form Cede™  ab-testing-demo 2]
Ref Form ID @
Form Manager v @
Transaction Value a9
Active [« &

Test Mode a@

Form Version Selector ) A/B Testing Form Version Selecter - v1 ¥ a

Submission Expiry Date D @

Submission Expiry Days @

It is possible to modify the service by using the edit facility that navigates to the service definition for the Form Version Selector.
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AB Testing Demo

Home Dashboard » Forms » Form

Dashboard | Details | Flow Config | Emai Verfication | Form Versions | A | Page Tracking | Spaces | Group Access | Form Promofion | Deploy
Form Display Mame* | AB Testing Demo g
Form Code " | ab-testing-demo @
Ref Form 1D a9
Form Manager v @
Transaction Value 2]
Active [+ @

TestMode [ | @

Form Version Selector  A/B Testing Form Version Selector-v1 ¥ Edit
Submission Expiry Date D =]
Submission Expiry Days 2]

Tracking Code

Within the service Definition for the selector it is possible to specify Form Versions you want included in the AB testing. This is especially useful when
multiple versions exist but only some of them are relevant to the test.

A/B Testing Form Version Selector - v1

Home Dashboard » Forms » Form » Service Definition

Service Definition I Parameters Edit | Parameters I Service Usage

Ignore Ferm Version Request Parameter || &

Included Form Versions

3 o

Once the Selector has been set up and parameters have been defined, the form versions are ready for A/B testing. It will mean that any one of the eligible
versions will be rendered to the user requesting the form.

Unk : 'pdf pagebreak’ - -
& Unknown macro: ‘pdf_pagebrea Analyzing the A/B testing results.

Transact provides out of the box analytics for the A/B testing. It allows comparison between any two form versions at one time. The versions to compare are
selected via a dropdown list that includes all eligible versions. Statistics are gathered on Form Open, Save and submitted, further refinement by device type
is also available. In the screen grab below results are being compared for form versions 1.0 vs 2.0 on desktop devices.
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Form A/B Testing

Home Dashboard » Form AB Testing
i) Provides A/B (spiit) testing information of different form versions over the same time period. Please select the Form and then the A and B versions to assess

Form  AB Testing Demo ¥ Space Maguire ¥ A-TestVersion 1.0 ¥ B-TestVersion 2.0 ¥ Device Type v w

Transaction Trend: A-Testv. 1.0

Oct  Oct Oct Oct Oct Oct Oct Oct Oct Oct Oct Oct Oct Oct Oct Oct Oct Oct Oct Oct MNov MNov HMov Mov HMHov MNov MNov HNov HMNov Hov Nov HNov
7

12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 1 2 3 4 5 6 7 8 9 10 11 12
—8— Opened Saved —@— Submitted

Total Transactions Opened: 0 Saved: 4 Submitted: 2

Transaction Trend: B-Test v. 2.0
6.0

45

3.0

©gt Oct  Oct ©Qet Oct  Oct Cot OCct Oct ©Oet Cct ©Oet OCot Oct Oct Oet Oct ©et Gt Oct MNov MNev Mov Mov HMov MNew Mov HNov Mov HMov  MNov  HNow
7

12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 1 2 3 4 5 & 7 8 9 10 11 12
—&— Opened Saved —#— Submitted

Total Transactions Opened: 0 Saved: 5 Submitted: 3

Transact Database Queries

The underlying Transact database queries used for the Form A/B Testing include:
® Opened - number of transaction "Opened" events. This query runs of the submission_history table.

® Saved - number of transaction "Saved" events excluding background saves. This query runs off the submission_history table.
® Submitted - number of transaction "Submitted" and "Completed" events. This query runs off the submission_history table.

246



Work Space Help Desk (Manager v5.0)

This is permission driven. Two permissions that drive this functionality are: "Help Desk View" and "Help Desk Authenticated Edit".

Having the Help Desk View Permission will create a new tab on the portal called Help Desk.

This tab shows all the forms submitted, saved or abandoned on the portal. The Help Desk agent can open any of these forms
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Managing Form Spaces (Manager v5.0)

® Introduction
® Space Types
® Exclusions to this article
® TransactField systems which have more than just the default TransactField App Space.
® Form Spaces / Portal with Custom Java Code
® Creating a Form Space WAR File
® Importing Form Space War file into Transaction Manager
® Setup Form Space in the Transaction Manager Console
® Setup Apache Mappings
® WAR File Components
® WAR (Web Application Archive)
® Work Space WAR files contains
* WEB-INF
® WEB-INF/classes
® Transact Architecture Space Architecture
® Editing Portal Content - Skinning
® Updating and Deploying HTML Content
® Merging Active HTML Content

Introduction

This topic discusses how to create and manage Form Spaces in Transaction Manager. In Avoka Transact a "Form Space" is a public web module which is
used to support Form Transaction Applications

In previous versions of Avoka Transact "Form Spaces" were called Portals, however to avoid confusion with customer's web sites and older Portal
technologies, we now use the term "Form Spaces".

In Java Enterprise Edition (JEE) terms a "Form Space" is a Java Web Application which is deployed using a Web Application Archive (WAR) file. Unlike
traditional JEE applications in Avoka Transact "Form Spaces" WAR files are used to initialize the Transact database with configuration settings and HTML
content. In Avoka Transact the Java application code is provided by the Transact Application server modules and the HTML content is rendered from the
Transact database. This model is used to make application upgrades easier. "Form Space" WAR files contain content and default configurations, and don't
contain code.

Space Types

In Avoka Transact there are 3 type of of "Form Spaces" available.

Form Space Type TM Installer Default Context Description
TransactField App Default Server Install field-worker This is the Form Space that all TransactField App devices communicate with.
Web Plug-in Default Server Install web-plugin The web plug-in is used to host forms that are embedded in a client website page.
Maguire Maguire Examples Selected = maguire This_is an example responsive portal that is loaded with example forms and
services.

It should only be deployed to DEV and TEST environments.

TransactField systems which have more than just the default TransactField App Space.

This has been done to cater for:

® clients with different business structures requiring separate security managers.
® clients who operate in multiple geographic regions requiring multiple Languages or styling.

® shared environments used by Client Services / Pre Sales

Avoka Hosted Services has instructions for creating additional TransactField App Spaces

Form Spaces / Portal with Custom Java Code

Portals created prior to TM 4.2 included java classes. These may have been customised by client services. The Form Spaces created by the Avoka Transact
4.2 onwards do not contain the portal library code. The java source files are kept in a separate portal library.

® Avoka Escalations have Linux BASH scripts or Windows batch files that can identify portals that may have been modified in this way.
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® Avoka Hosted Services can run these on the Linux hosted clients.
® Engineering has Eclipse projects for form spaces that contain the java source code for TM 4.2.5+. These are ONLY for upgrading older clients that
require java source customisations.

Creating a Form Space WAR File

The following instructions use the Avoka Transaction Manager Installer Avoka-TM-Setup.jar.

1. Double Click the Avoka-TM-Setup.jar file
Select Create a Transact Work Space

|: Avoka Transaction Manager Setup — O e

Welcome to Avoka Transaction Manager 4.3.0 Setup Wizard

On Microsoft Windows please 'Run as administrator' to enable service installation.

Please specify the Avoka Transaction Manager setup task you want to perform.

Setup Task () Install & new Transaction Manager server
O Upgrade a Transaction Manager 3.5+ server
() Configure a Transaction Manager database

() [Create a Transact Work Space

‘ € cancel || 4 Back

B> Next | | @ 1t |

2. Enter the details for the Transact Work Space
[ Avoka Transaction Manager Setup - O x

Transact Work Space

Configure Transact Work Space settings.

Space Mame Creative Wave Finance
Context Path owf
Description CWF Cusmmerh"n’ork Space

‘ |°Cancel||qﬁad<||bNextH@Z-

@ Note

Space Name:

® IMPORTANT - Do NOT use the ampersand '&' character in the space name.
® This is the name that Transaction Manager uses as the primary key when a space is imported.
® |t should be unique to a customer's environment

Context Path:

® IMPORTANT - Do NOT use the ampersand '&' character in the context path.

® This is a component of the URL as follows https://{Server Domain Name}/{context path}. It's the base path to access the Web
Application Archive WAR file.

® This should be unique per environment.

® For the configuration below the URL could be https://creativewave.transactcentral.com/cwf
® Transaction Manager modules and web context path like the Transaction Manager Administration module is manager.
The URL is https://creativewave.transactcentral.com/manager

Description:

® This is an optional description of the work (form) space
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3. Enter the Security Configuration.

L{,_ Avoka Transaction Manager Setup — O o

Security Configuration

Choose whether to support only HTTPS traffic.
Note when installing a Dev server without S5L unchecdk secure cookies so you can login,
Production servers MUST use secure cookies.

Use secure cookies (HTTPS)
Groovy Services
Groovy Organization data isolation

‘ [OCanoell[daachbNext”QInsta\l]

(D Note

When building a new form space you should accept the default.

The only time you should uncheck use secure cookies (HTTPS) is if you are building a test form space to run on your own PC.
Do not provide test form spaces to a client.

4. Transact Manager Setup

|.f,— Avoka Transaction Manager Setup — O b4

Installation Directory ‘

Installation directory |C:\avoka—m—cusmmdo\'arkspace-cwﬂI Select Folder ]

This is the directory where the custom work space will be stored.

| [ v [ ][ > vre] [ @ 7=

{D Note

By default on a Windows PC it will install to a directory c:lavoka-tm-custom-work-space
If you are intending to make a number of form spaces its good practice to make the install directory unique.

In the screenshot above | have appended the context c:lavoka-tm-custom-work-space-cwf

5. Perform installation



[ Avoka Transaction Manager Setup - m} X

| Perform Installation

‘ [@5how Details | Click Install to continue

[© cancel || Wgack| b1 || @ mstal |

This creates the formspace war file in the specified directory in 4.

Look at the readme.html file

« © 4 [l ThisPC > 0S(C) » aveke-tm-custom-work-space-cwi v @ | seorch avoka-tm-custom-v
O Name Date modified Type Size
deploy 24 8PM  File folder

/€] readmehtm 24/11/20155:18PM HTML File 2KB

B Avoka Transact Portal Re X+

- o X
SO | e f/reacime i % | &
Introduction

This page describes how to customize a Avoka Transact Work Space.
Project Components

The generated Portal project includes the following components.

[avoka-tm-custom-portall
1
+-[deploy] : directory containing pre-built Work Space WAR file, ready for deployment onto application server
1

+- readme.html : Readme help file

Customizing Content

If you want to change CSS or HTML content of your Portal you can do this online through the Management Console application. Simply copy the pre-build
Portal WAR file in the deploy folder into the Transaction Manager /avoka/transact /manager/server/standalons/deployments folder. If the server is running
the Portal will automatically register itself and you can edit its content online in the Management Console.

&

The WAR file avoka-sf-portal-{fcontext}.war in located the deploy subdirectory.

= v P » ThisPC » Q5(C) » avoka-tm-custorn-work-space-owf »  deploy

] Mame Date modified Type Size

[85] avoka-sf-portal-cwf.war 24/11/2015 318 PM WAR File 1,046 KB

Importing Form Space War file into Transaction Manager

There are 2 ways to install the WAR file into transaction Manager.

1. Copy the pre-build Work Space WAR file in the depl oy folder into the Transaction Manager / avoka/ t r ansact

/ manager/ server/ st andal one/ depl oynent s folder

G) Note

This requires access to the transaction manager directory for the server that you are installing to.

Once deployed you can go to the Form > Form Space menu to see the Spaces search page as per step 2.c. below.
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2. Import the WAR file using the Transaction Manager Console. This requires you to have TM Administrator with Global Access.

a. Select the Menu Forms > Forms Spaces
This brings up the Spaces search page as per below
Click Import WAR

Avoka Transaction

AOKA

Test Environment

7 Home ' Operations < Anaytics g, Reports e Security ststem

Spaces
Home Dashboard » Spaces

search Clear

Import Archive Import WAR

Name URL Description Content Editable Version Last Modified Module WAR File Action

Maguire http:/localhost:9080/maguire/ Avoka Transact Work Space v 430 23 Nov 2015 by system avoka-sf-portal-maguire war FZ'I b

TransactField App hitp:/localhost: 9080/ feld-worker/  Avoka TransactField App Space v 4.3.0 23 Nov 2015 by system avoka-st-field-worker. war le g’:

Web Plug-in hitp-#localhost 9080/ web-plugin/  Avoka Transact Web Plugin Space v 430 23 Nov 2015 by system avoka-si-portal-web-plugin war E"I b
Export

b. Choose the WAR file and click Import
Home Dashboard » Spaces » Import Portal WAR
o
Portal WAR File Choose file | avoka-sf-portal-cwi war
Cancel
c. You will be returned to the Spaces search page. You may have to click search after 5-10 seconds for the work space to appear.
Spaces
Home Dashboard » Spaces
i WAR file deployed, please wait a little while it is initializing.
search Clear
Import Archive Import WAR

Name URL Description Content Editable Version Last Modified Module WAR File

Creative Wave Finance CWF Customer Work Space v 430 25 Nov 2015 by system  avoka-si-portal-cwi

Maguire http:/localhost:9080/maguire/ Avoka Transact Work Space v 4.3.0 23 Nov 2015 by system  avoka-sf-portal-mac

TransaciField App http://localhost: 9080/ ield-worker/ Avoka TransactField App Space L4 430 23 Nov 2015 by system  avoka-si-field-worke

Web Plug-in http:/localhost 9080/web-plugin/  Avoka Transact Web Plugin Space v 430 23 Nov 2015 by system avoka-si-porial-web

@ Note

If you don't see the new work space in the list it could mean that there is a problem with your user account configuration.

TM versions prior to 4.3.0 allow an organisation to be assigned for users with Global Access.



User | Organizations | Spaces | Roles | Role Expiry | Groups | Group Expiry | UserProfiles | Login History

Available Organizations Assigned Organizations

Maguire
Transact Server Monitoring

Organizations =<
=3

e

Enable Global Access ¢ @

This is an issue as you can only see the spaces that belong to the assigned organisations. When a new space is created it
doesn't have an organisation assigned and hence it may be hidden from you.

Setup Form Space in the Transaction Manager Console

1. Click on the Form Space

Spaces

Home Dashboard » Spaces

search

Import Archive Import WAR

Name URL Description Content Editable Version Last Modified Module WAR
Creative Wave FE;}M http./localhost. 9080/cwif CWF Customer Work Space v 430 25 Nov 2015 by system  avoka-si-port
Maguire st90BO/maguire/  Avoka Transact Work Space v 430 23 Nov 2015 by system avoka-s-pori
TransactField App hitp-/localhost: 9080/ feld-worker/ Avoka TransactField App Space v 430 23 Nov 2015 by system  avoka-sf-fielg
Web Plug-in http:/localhost:9080/web-plugin/  Avoka Transact Web Plugin Space v 430 23 Nov 2015 by system avoka-si-port

2. Change the context path from localhost

From:

253



Creative Wave Finance
Home Dashboard » Spaces » Module

Space | Properties | Pages Resources Forms Organizations Status ‘

Name Creative Wave Finance
Context Path™ http://localhost: 9080/cwf/ 7]
Description CWF Customer Work Space
Security Manager v
Content Editable v @
Default Forms Portal @

Save Close

To:

Creative Wave Finance
Home Dashboard » Spaces » Module

Space | Properties | Pages Resources Forms Organizations Status |

Name Creative Wave Finance

Description  CWF Customer Work Space

Security Manager = CWF SSO Security Manager A
Content Editable [« &
Default Forms Portal o

Save Close

Setup Apache Mappings

@ Apache Server Backgroud
Apache Server sits between Transaction Manager and the Network. It is used to:

® TM offloads the SSL Termination onto Apache. SSL certificates are loaded into Apache.
® Serves cached static content

® Reverse Proxy restring access to the Application Manager running Transaction Manager. Only certain context paths are
exposed to the network. This is configured in the mod-proxy.conf

After installing a new form space we need to update the Apache Configuration to expose that to the network. If you need help please see Avoka Hosted
Services team.

In the code block below we have setup the Creative Wave Financial Space, by first cloning the TM Example Maguire Portal settings.

extract from /Apache2/bin/mod-proxy.conf

# TM Exanpl e Maguire Portal
ProxyPassMatch ~/ maguire(.*)$ ajp://|ocal host: 9009/ magui r e$l
ProxyPassReverse /maguire ajp://|ocal host: 9009/ maguire

# TM Creative Wave Fi nanci al Space
ProxyPassMatch ~/cwf (.*)$ ajp://1ocal host: 9009/ cwf $1
ProxyPassReverse /cwf ajp://1 ocal host: 9009/ cwf

WAR File Components
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Transaction Manager is hosted on a J2EE application server runtime. Each form space is built into its own WAR file which was deployed as per the
instructions above. The screenshot below show a listing for the war files in the deployments directory. This included modules and example application that
come with TM. The form spaces start with "avoka-sf-portal-" + <portal context> + ".war". We can see avoka-sf-portal-cwf.war file has been deployed.

avoka » transact * manager » server : standalone @ deployments

A [ MName Date modified Type N ¢
‘B avoka-tm-rmaestro.war 41172015 409 PM WAR File
W] avoka-tm-consolewar 23/11/2015 3:42 PM WAR File
H] avoka-sf-web-plugin-examples.war 23/11/20153 3:42 PM WAR. File
‘W] avoka-sf-portal-web-pluginawar 23/11/2015 3:42 PM WAR. File
H] avoka-sf-portal-maguire.war 23/11/2015 3:42 PM WAR. File
W] avoka-sf-portal-owf.war 25/11/2015 9:03 AM WAR. File
W] avoka-sfrm-webreport.awar 23/11/2015 3:34 PM WAR. File
H] avoka-sfm-servergroup-agent.war 23/11/2015 3:34 PM
W] avoka-sfrn-server-agentwar 23/11/2015 3:34 PM
W] avoka-sf-finder-examples.war 23/11/2015 3:42 PM WAR. File
W] avoka-sf-field-worker.war 23/11/2015 3:34 PM WAR File

WAR (Web Application Archive)

The WAR file is a type of JAR file defined by the J2EE application server specifications. WAR and JAR files can be opened in tools such as 7Zip. The
contents of the war file can be seen below.

Ciavo kesp P portal

File Edit View Favorites Tools Help

T

Add Extract Test Copy Move Delete Info

7 [ cravok k-space-cwfdep portal-cwfawar\

Name Size Packed Size  Modified cr
:WEEV\NF: 97110 25092 2015-11-2417:18
secure 66023 19964 2015-11-2417:18
resources 1604255 980541 2015-11-2417:18
META-INF i 143 2015-11-2417:18
dlick 1077 460 2015-11-2417:18

[£] wet-signaturehtm Iy 2863 o1 2015-11-2315:29

[£] terms-and-conditions.htm 1319 430 2015-11-2315:29

(2] submission-saved.htm 4986 1378 2015-11-2315:29

2] submission-failed.htm 3745 862 2015-11-2315:29

(2] submission-errors.hitm 2569 750 2015-11-2315:29

(8] submission-email-verification.htm 1089 306 2015-11-23 15:29

(2] submission-cancelled. htm 1205 470 2015-11-23 15:29

|2] session-expired.htm 992 398 2015-11-2315:29

[£] server-busy.htm 1029 423 200511231529

[£] save-challenge.htm 1829 552 2015-11-2315:29

[ redirectjsp 983 463 2015-11-231529

[£] off-linehtm 489 27 2015-11-2315:29

[£] not-authorized. htm 593 292 2015-11-2315:29

[£] togout. htm 0 2 2015-11-231529

(2] togin.htm 3092 960 2015-11-2315:29

(2] landing.htm 4931 1278 2015-11-2315:29

(8] job-tasks.htm 4463 1027 2015-11-2315:29

|8] job-challenge.htm 1684 578 2015-11-2315:29

(2] index.htm 2342 1123 2015-11-2315:29

|2]incompatible-adobe-reader.htm 2058 663 2015-11-2315:29

[£] hosted-payment htm 2395 693 2015-11-2315:29

[£] hosted-card-paymenthtm w7 198 2015-11-2315:29

Work Space WAR files contains
Page Templates (.htm files) which are held in the

® root directory (Unsecured can be accessed anonymously)
® secure directory (required an authentication user session) These contain the pages users seen in the form space after a user logs in such as the
Tasks or To Do page.

Resources (See image below) this include items used to style the form space.

css: Cascading Style Sheets
images:

includes: html snippets

js: JavaScript files
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;] Chavoka-tm-custormn-work-space- cwfdeployhavoka-sf-portal-owfowarresources’,

Mame
includes
irmages
Css

AcrobatSniffer.pdf

WEB-INF

This directory contains the list of xml files and the classes subdirectory. When creating the WAR file (ref Creating a Form Space WAR File) the installer does
string substitutions on the context path, and space name into the portal files.

Chavoka-tm-custom-work-space-cwf\deploy\avoka-sf-portal-cwfowar WEB-INFYy
File Edit View Favorites Tools Help

N T

Add  Extract Test Copy Move Delete Info

? ‘ Chavoka-tm-custom-work-space-cwf\deploy\avoka-sf-portal-owfowar WEB-INFY

Mame

classes

c@s
=i

D velocity. properties

=] spring.xml

web.xml

@

=] spring-custom.xml

2| jboss-deployment-structure.xml

=1

c@s
=i

click.axml

The important files are the:

web.xml: The web application deployment descriptor file describes how the web application should be deployed to the application server. It is required for
every Web Application

jboss-web.xml: The installer substitutes the context path here. Note the context path cwf we specified in the installer has been written into the context-root
element.

Jboss-web.xml

<?xml version="1.0" encoding="UTF-8"2>
— «jboss-web>

zcontext-root=cwl</context-root=

—_ {! -
<replication-config=>
L\) <replication- trigger=SET_AND_MNOMN_P
<replication-granularity >SESSIOMN </Te
=/replication-config=
-
</jboss-web:=

(D Important

Always use the TM Installer to create your Form Space WAR file.
Creating a copy of an existing Form Space WAR file can result in problems with deployment, if all the required substitutions are not made.
If the copying has resulted in 2 WAR files with the same context, the J2EE application server will only deploy 1 WAR file.

Each WAR file must have a unique context path per TM environment (DEV, UAT, PROD).
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WEB-INF/classes

This directory contains the compile java packages and classes.

[B2 Cavoka-tm-custom-work-space-cwhideploy\avoka-sf-portal-cwf.warWEB-INP\classes',
File Edit View Favorites Tools Help

[ = v W = % i

8 Add Extract Test Copy Move Delete Info

¥ | Chavoka-tm-custom-work-space-cwfideployhavoka-sf- portal- cwfwar\WEB-INP\classesh,
MName
com
smartform-webplugin.min.js
| db-configl.xml

| | click-page_en.properties

| | click-page.properties

db-config.xml: This is the important file in this directory. The db-config.xml has had the context path space name substitutions applied. It is used to create all
the new form space properties when the WAR file is deployed. The Roles for the Form Space are also defined here.

Creative Wave Finance
Home Dashboard » Spaces » Module

Space | Properties | Pages | Resources | Forms | Organizations | Status ‘
Name% Type Value Description
Account Locked Message String “Your account has been locked due fo a number of fail... Message displayed at login to users whose accounts are locked
Allow Form Cancel Boolean true Allows users to cancel a submission at the payment stage
Allow Form Retry Boolean frue Allows users to go back to the form if payment has not been completed yet
Allow XML Redirect Target Boolean false Allows XML form data to specify redirect target
Allow XML Request Param Form Prefill Boolean false Allows XML request parameters [ xmiData | schemaSeed ] to be used in Form Prefill
Anonymous Submission Access Timeout Number 15 The grace period in minutes during which anonymous users can access their submission. Note: Access is granted only if the user's IP address has not changed.
CDN Server URL string Optional CON Server URL for caching static contant
Email 2FA Message String #if (SaccountReset) <p> Anew Au... Email message for 2FA user account enrolment.
Email 2FA Subject String  Setup 2-Step Verification Email subject for 2FA user account enrolment.
Email Form Receipt Message HTML =p=Thank you for submitting ${form formName} at ${p. Email message for form confirmation / receipt email
Email Form Receipt Subject String  ${form.formName} Confirmation Email subject for form confirmation / receipt email
Email Lost Password Message HTML <p=We received a request to reset the password asso. Lost password reset email message
Email Lost Password Subject String  Password Assistance - ${portal.name} Lost password reset email subject

Transact Architecture Space Architecture

The following diagram explains the relation ship between the WAR File and the the Space.

® |tis necessary to upload a war file
® The war files content becomes the base content in the database.
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® The active content in the space is either edited in the admin console or imported in an archive zip file.

/"1 WARFile "\ /A T™MSpace "\

Web App Config* Active Content
— Properties
Roles Permissions Pages
Base Content Resouces
Prgge;trsas Base Content
Hesngucas Properties
\ / Pages

\ Resouces /
Mote: *JZEE Application

——
— A\

Server Restrictions il |
means that a WAR file is Active HTML | \\
always required to be content is served | \\
deployed 1{ from the database.] \

= B¢
3

The sequence diagram shows developing a new form space and then deploying it to production
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Developing A New Form Space in Dev & Deploying to Prod

&
3

T Dev

TM Prod

create new WAR[:T

User uploads WAR file

MNew Space registered in DB
base content, properties roles
and permissions loaded

User edits HTML content

active HTML content updated in DElﬂ

Space now backed Uﬁ

S, SV, S A

User uploads WAR file

Mew Space registered in DB
base content, properties roles
and permissions loaded

:
|
|
|
|
|
|
|
!
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
i
! Export archive Zip
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
:
|
|
|
|
|
|
|

|
|
|
|
|
|
|
|
|
User uploads archive Zip
|
|
|
|
|
|
|
|

Space html content is updated
same as TM Dev

!

— ¥

1
3

T Deyv

TM Prod

Editing Portal Content - Skinning

The portal skinning has been documented by Client Services

TODO ADD LINK Unknown User (jbasey)

Updating and Deploying HTML Content

The following sequence diagram shows the steps required to update content from Dev to Prod.
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Updating Content from DEV to Prod

Admin TM Dev TM Prod

User updates HTML content

active HTML content updated in DElij

Export archive Zip

Space now backed upﬁ

I SEUR S

User uploads archive Zip

: -
I I
I I
i | | actice content is updated to
l | same as TM Dev
| |

Admin TM Dev TM Prod

Merging Active HTML Content

The following sequence diagram shows the steps required when a new version of TM is installed.

When upgrading a new war file, it is important to review all the pages and resources that were customised. This is required as new versions of Transact may
introduce new functionality and bug fixes which update the pages. By default when a Form Space is upgraded the existing active html content (pages and
resources are kept). The Transaction Manager Console - Spaces Page enables the reviewing of pages and resources with similar principals found in source
control systems.
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Updating A Form Space for a New Version of TM

Admin

create new TM version WAFﬁ

User uploads new TM version WAR file

User merges HT ML content

Export archive Zip

TM Prod

Existing active content kept in DB
new base content, properties roles
and permissions loaded

active HTML content updated in DE%]

Space now backed uﬁ

User uploads new TM version WAR file

|
|
|
|
|
|
|
|
|
User uploads archive Zip

Existing active content ke
base content, properties r
and permissions loaded

M Dev

y

actice content is updated
same as TM Dev

TM Prod

In this example the tile-todo-min.html was update in the 4.3.0 form space as part of a bug fix. Note this is highlight and has more action items.

Iresourcesfincludes/accounttile-submission. htmil

Iresourcesfincludes/accounttile-todo-min. htmil

Iresourcesfincludes/accounttile-todo htmil

res nureesfinclides fonter-nanel htmil

3.09 12 Oct 2015

0.81 06 Mov 2015

734 12 Oct 2015

N2 12 Oet 2015

Click on the View Content Diff to Base Resource and use this to assist in merging content.
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Iresources/includes/accounttile-submis sien. htmil

Iresourcesfincludes/accounttile-todo-min. html

Iresourcesfincludes/accounttile-tedo. html

3.

0.

-
/

09

81

.84

12 Qct 2015

06 Nov 2015

12 Qct 2015

I @) e
12 Oct 2015 by system [P ] €

12 Oct 2015 by system |2| E E
12 Oct 2015 by system @ E .}:

12 Ot 2015 by svstern  FA 3 &

12 Oct 2015 by system E] E a
12 Oct 2015 by system @ E E %l_}l .ﬁa
12 Oct 2015 by system E] E ﬁ) @



Portal Resource Diff - /resot i ile-todo-min.html
Home Dashboard » Form Spaces » Module

View Type: | Site by Side v

Base: / res: nt/tile-todo-min. html
1 .

We may decide:

® That we want to keep our existing changes. In this case we just need to click Mark Content Merged.

fresourcesfincludes/accountfile-submission. html 3.09 12 Oct 2015 12 Oct 2015 by system |=_/‘| ﬁ 0
fresourcesfincludes/ace ountfile-todo-min. html 0.81 06 Mov 2015 12 Oct 2015 by system E/’l E Q
Iresourcesfincludes/accounttile-todo. html 7.84 12 Oct 2015 12 Oct 2015 by system E)l E @
Iresourcesfincludes footer-panel. html 0.26 12 Oct 2015 12 Oct 2015 by system [ 7] &)

® We can replace the content with the the base content. By clicking first on "Restore all Portal Resource with theie Base Content"

Iresources/fincludes/accountitile-todo-min. html 0.81 06 Mov 2015 12 Oct 2015 by system @ ﬁ B Q:K@ 0
Iresources/includes/accountitile-todo.html 7.84 12 Oct 2015 12 Oct 2015 by system [ (7] @)

Restore all Portal Reso
Iresources/includes footer-panel html 0.26 12 Oct 2015 12 Oct 2015 by system @ E 0

® We can manually merge changes by clicking on edit. Note after doing so we need to Mark Content Merged.

fresourcesfincludes/accountftile-submission. htmil 3.09 12 Oct 2015 12 Oct 2015 by system @ E G
fresources/fincludes/accounttile-todo-min. html 0.81 06 Nov 2015 12 Oct 2015 by system %E E
Iresources/includes/accountftile-todo. htmil 7.84 12 Oct 2015 12 Oct 2015 by system I-"
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BIRT Reporting Guide Manual (Manager v5.0)

Introduction

This document is aimed at users wanting to create or modify Avoka Transaction Manager BIRT business reports.
BIRT stands for Business Intelligence and Reporting Tools, and is an open source data visualization and reporting platform.

http://www.eclipse.org/birt/

Transaction Manager includes the BIRT runtime as well as a number of standard reports you can use out of the box. This guide assumes you are already
familiar with BIRT and covers only specifics you need to be aware of when developing TM reports.

Operational Transaction Summary

Thiis rapor includas only ransactions that have been Snalized (complatad o abandoned). Transadions in bast moda are not shown Organizatica|s): A
Stan dabec 12112014 2400
End dabes 121202014 2600

Last  Median Tims
Complated 0 Smbmit

Fill

Administra Sanices B2 3 24 43 5% 11 Ducc 14 <1 min L] 50,00
401 Test - HTML 3070 4 2 2 a 0 50% 08 Dec 14 <1 min a 50.00
7548 Thedd best case - Default b & L] Q L] 1 8% 10 Dac 14 <1 min a S0.00
ASC-2952 Dropdown Test- HTUL 2113 2 2 Q L] ] 100% 02 Dac 14 <1 min a 0,00
ASC-3048 Maguiry - Dedaull Rec kRl & ] 0 L] ] 100% 11 Dec 14 <1 min a 50,00
ASC-3052 Signature Widgetlest un 2 ] 2 L] 0 % a 50,00
ABC-I0E2 Signatune Widgelles! nx 5 1] 5 i} o 0% L] 50,00
ASC-2052 Sigrature Widgellesl bkl 1 1] 1 L] 1] 0% [i] 50,00
ASC-10&0 DOR isswe Maguire - H N4 2 1] 2 L] 1] 0% L] 50,00
ASC-30&0 DO igswe Maguire 47 3116 1 1] 1 L] 1] 0% L] S0.00
ARC-3085 Calendar dabe sebeddi e 2 1] 2 o 1] 0% L] S0.00
ASC-3085 Calendar dabe sebeddi ine 2 ] 2 o '] 0% L] S0.00
ASC-3100 Address widgel TRl 3213 3 3 1] o 1] 1005 1iDec 14 <1 min L] S0.00
ASC-3100 Address widgel T-Feel 3214 1 1 1] o '] 100% TiDec 14 <1 min ] 50,00
Adoress mceipla] - Detaull Re M 1 1 1] L1} ] 100% Q5 Dec 14 <=1 mn 0 000
Address widgat T-Flald 41- HTM 2335 4 12 & a -] 50%% 0 Dac 14 & min ] $0.00
Address widget T-Fialg4151 - am 1% 4 1 L] 1] hiE ] 08 Dac 14 <1 min a 50,00
Assot ManagementForm-HTML 2780 L ] Q L] 1 % 1303 min a 50,00
Atachment - HTML iPhanlom Rec 1874 L1 35 L] L] 1% 1% 10 Dec 14 2 min 1] S0.00:
Atachmentv - Defaull Receipl 51 1 ] 1 a 1] 0% ] 50,00
Avoka Trandsct Showeads Faim I 1757 E | 1 a 1 1 1% 18 Mow 14 =1 [ L] £0.00
Avoka Trandacl Showeass Faimd, 2332 14 ] 1 1 4 Ly 21 How 14 =1 fHf L] £0.00
Avoka Trandact Showease with M 2600 2 /] 2 o '] 0% L] 50.00
Aok Trand-acl Showeass wili M 2333 21 18 1 o 2 B4 05 Dec 14 <1 min L] S0.00
Barosde New Widget - HTLL 212 1 1] L] L] 1 0% 2 min 1] S0.00
Calendar - HTML 30586 4 1 3 L] 1] 25% 02 Dec 14 <1 min ] S0.00
Calendar and Date Tast - Detau 2871 18 15 2 L] 1 3% 01Dec 14 <1 min ] S0.00
Calenidar and Date Tast SP3 -8 3071 25 ] 25 o o 0% L] 50,00
Calendard 053 - HTML Phanlom 3055 18 1 15 o '] % 26 Mo 14 <1 min L] 50,00
Calendarilaguin - Defaull Rece 282 14 2 1 Q 1 14% 18 Mov 14 2 min [ $0.00

263


http://www.eclipse.org/birt/

Developing Reports (Manager v5.0)

This chapter goes into specifics on how to develop a BIRT report that will work with TM.

BIRT Development Environment

TM currently uses BIRT version 4.3.0. We recommend that you use the same version of BIRT to develop your reports. Otherwise it is up to you to ensure
they run without problems on the version of TM that you are using.
Download and install the designer of your choice from http://download.eclipse.org/birt/downloads/

TM Database Setup

To develop and test your reports, you need to have access to a TM database. We highly recommend that you use a database that has realistic TM data. This
can be done by obtaining a database backup from a TM server running the version of TM you are targeting and restoring this backup to a local database you
can access.

Please refer to the TM Installation Guide for the set of supported database versions and instructions on how to set them up.

Note that TM supports three databases: MySQL, SQL Server and Oracle. Always make sure to use the same database (including version) for report
development as what is used by your TM servers because each database requires subtly different syntax and possibly other configuration such as BIRT
report parameter types. If you are developing reports for multiple databases, you need to test them on each database separately and it may be necessary to
maintain different versions of the report design.

Data to Report on

This guide focuses on a very specific subset of the TM database, namely the transaction history entity. The transaction_history table contains historical data
for submissions that have been finalized (either by being completed successfully or being abandoned). The transaction history contains a large amount of
information about each transaction, including form and organization name, payment and attachment information and time taken to complete the transaction.
Please refer to section The Transaction History Table for a detailed list of columns in the transaction_history table.

While using the transaction history as a basis for reports allows you to create reports for a large number of use cases, there are some cases where it is not
sufficient: Reports requiring live submission data (i.e. submissions that have not yet been completed or abandoned), reports requiring submission information
that is not present on the transaction history (e.g. filtering by submission properties or data extracts) and reports requiring data from other tables (e.g. audit
log, request log, form). If you think that the transaction history is not sufficient for your use case, please contact your Avoka representative to discuss how
your report can be implemented.

Installing Database Driver(s)

In order to connect to your TM database during report development, you'll need to ensure that BIRT has access to the appropriate JDBC drivers.

The drivers can be copied from the TM server (or installation artefacts) directory in the /modules subfolder:
MySQLThe current MySQL driver is at /modules/com/mysqgl/main.

SQL ServerThe current SQL Server driver is at /modules/com/microsoft/sglserver/main.

OracleThe current Oracle driver is at /modules/com/oracle/main.

Copy the driver JAR file to the appropriate directory in your BIRT designer (generally [designer root folder]/plugins/org.eclipse.birt.report.data.oda.jdbc_4.3.0.
v201306041519/drivers) and restart BIRT designer. All driver JARs in the directory should automatically be loaded by BIRT designer and will be available
when creating a data source.

Setting up a Data Source

TM currently uses two data sources, one for the transaction history table (which can be situated in its own database schema) and another for all other tables.
This guide focuses on the transaction history table, so for our purposes you just need to set up the report with a single data source.
In your BIRT report, add a JDBC data source named (for example) "TM Transaction History".
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Next, fill in the JDBC connection parameters as follows:

Set the INDI URL to "java:/TransactionHistoryDS". This is very important since when your report is deployed to a TM server, it will be looking up the data

source using the JNDI URL. Only if this lookup fails (e.g. when you are working inside BIRT designer) will BIRT fall back to the hard coded connection
parameters below.

Set the driver class to the appropriate driver for the database you will be using ("oracle.jdbc.OracleDriver" for Oracle, "com.microsoft.sqlserver.jdbc.
SQLServerDriver" for SQL Server and "com.mysql.jdbc.Driver" for MySQL).

Set the database URL to the appropriate URL for accessing your test database, and the username and password to the values needed to successfully
connect to your test database.

Ensure your test database is running and click "Test Connection...". Fix any connection issues that come up.
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You can use this data source in all reports utilizing the transaction history table.

Supported BIRT Parameters

TM supports a certain set of report parameters and will pass them into the report whenever a report schedule is triggered if the report has parameter(s) with
one of the following names:

® client_oidThis parameter will be populated with the organization ID (a number), if the report is being run for a specific organization at the time (this is
the case when running / rendering a client report schedule). In BIRT, this should be modelled as an "Integer" parameter.

® start_dateThis parameter will be populated with the start date and time of the reporting period. This should be modelled as a "Date/Time" parameter
in BIRT
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® end_dateThis parameter will be populated with the end date and time of the reporting period.
® batch_idThis parameter is specific to payment processing and does not apply to the transaction history data set. It represents the number
representing a batch (corresponding to a 24 hour period) of payments. This should be modelled as an "Integer" parameter in BIRT.

At this stage, TM does not support passing arbitrary parameters to a report at runtime. If this is something you need, please contact your Avoka
representative to discuss.

Please note that if a user is rendering the report on-screen (as opposed to an automated report schedule being triggered by a background job), TM will not
pass in any parameters except for client_oid (if available). Therefore you can configure these parameters in BIRT to be required / not hidden to solicit input
from the user viewing the report (or make parameters hidden and use default values if they should not be exposed). You can use additional, arbitrarily named
parameters for onscreen report viewing.

If you would like to see examples of these parameters being used and passed into queries, please see the TM standard reports (specifically "Client
Operational Summary" (client-operational-summary-*.rptdesign) for start_date, end_date and client_oid and "Payments Daily" (payments-daily-all.rptdesign)
for batch_id).

Supported Output Formats

TM uses multiple output formats when rendering reports: For on-screen viewing of reports via the TM management console, the reports are rendered as
HTML. When sending out reports as part of a schedule, the output format can be configured to be PDF, XLS or CSV when creating the report schedule (see
the TM Administration Guide, chapter "Reports" for details).

When choosing PDF or XLS as the output format, the report is rendered by a BIRT emitter and appears similar to the HTML rendition. However, when
choosing CSV as the output format, the TM reporting module generates the CSV file such that it is easier to be processed automatically by backend
applications. Read on for more information on how the CSV report is generated and how to design your report for usage with CSV report schedules.

CSV Reports

The CSV output format that can be used when setting up report schedules in TM is designed to produce pure CSV reports that can be programatically
processed by backend applications.

When creating a CSV report, TM uses data from a single table in the BIRT report and ignores all other elements and formatting. Specifically, TM looks for a
table named "data_table" and extracts the data from the report design.Therefore, you need to name the table containing the data that you want to use for
CSV export "data_table" (see screenshot).

| RN B LF BLEF CREE DRES REEE RRRE SN DS LIRS DS VRIS - SRR * DRIy | DR | RIS DIIRS COICS' DICIS | B . IRr -

Daily Payment Report Avoka Transact

Subemission ID | Receipl Number Paymsent 10 Paryrnenl Tame Payment
Receipt

Bl |[submissice_oid] [submission_recei ] [paymenioid]  [dr_Smestamp]
| Mo results Tound
| Total

BT Taie
5

I ety Bt -Tobke 11 |
L —|

General Genersl

'u_lrjmr dala_table | penent 1o 13

Pogetresk | e [ Bl weoe =
SRR vertcal oment: [ S ST | ) =
Sockenark St Hene El osior: L E
(Comments | Dt

TM allows you to filter the set of columns that will be included in the CSV file by specifying the set of column names in the report schedule configuration. This
also allows you to reorder the columns. All other filtering, as well as sorting, has to be done in the report design.
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If you would like to see an example of a CSV compatible report, look at the TM report named "Payments Daily" (payments-daily-all.rptdesign).

Deploying Reports to TM

For more information on how to deploy reports to TM and set up report schedules, please refer to the TM Administration Guide, chapter "Reports”.

Ongoing Maintenance

TMis a living product that is continually being enhanced. New versions are released regularly, and often contain changes to the database schema that may
affect BIRT reports.

Therefore, for each release, the standard TM BIRT reports are reviewed and modified as needed. While substantial changes to the submission data model
are rare, it is still necessary to review all custom BIRT reports whenever a new version of TM is to be deployed. To do so, review the TM release notes and
upgrade instructions for all versions between the current version and the version you will be deploying. In addition, perform testing of the reports on a server
running the new TM version.

267



Reporting Tables (Manager v5.0)

Transaction History Table

The transaction history table contains extensive data about finalized (completed or abandoned) submissions. It is lightweight as it does not store the
submission XML data or other large CLOB/BLOB fields and does not contain sensitive user-entered information. It allows you to write a number of reports on
transaction metrics and is used by the TM reports "Operational Summary" and "Client Operational Summary".

By default, transact_history records are kept for 5 years, while submission records are kept for 1 year. These data retention settings are configurable with the
Data Retention Management service.

Submission records are published to this table once they progress to a form_status of "Completed" or "Abandoned". This is performed by a background job
which runs every hour.

The transaction_history table can be located in a separate history database, or can be located in the TM transaction database. It uses a separate JDBC
connection pool.

The TM server supports a Groovy Service which can be used to publish data from the transaction_history table to an external data warehouse (DWH). The
transaction_history table provides 2 columns to support this (dwh_publish_status and dwh_publish_time).

Columns

Avoka Transaction Manager provides a transaction history table (transaction_history) which is designed specifically for reporting and analytics. By providing
a separate reporting table, this helps ensure system online transaction processing (OLTP) performance is not effected by online analytics processing (OLAP).

Data in the transaction history table is de-normalized (including related data from the form, client, template_version and portal tables) to make report
development easier for report writers.

Data from the main transaction table (submission) is rolled into the transaction_history table, about 30 minutes after a transaction has been completed by the
user. A transaction is considered to be completed when the form_status = '‘Completed’ or form_status = 'Abandoned'. The copying of transaction records is
performed by the background TransactionProcessor job which runs every 5 minutes.

The transaction history table is very extensive and contains a large number of columns you can report on. Here is a breakdown of the columns and the data
they typically contain. Please note the available indexed columns when creating your queries:

® abandonment_form_status Type: varchar(20) nullindexed: Yes The form status of the submission before it was abandoned. Generally set only if
form_status is "Abandoned". Common values: "Opened", "Saved", "Submitted".

® abandonment_reason Type: varchar(2000) nullA reason entered for why the submission was abandoned. Generally set only if form_status is
"Abandoned", and only if the abandoning user wanted to provide a reason.

® abandonment_timestamp Type: timestamp nullThe date and time the submission was abandoned. Generally set only if form_status is
"Abandoned". Please see the next section for tips on date-based filtering.

® abandonment_type Type: varchar(4) nullA value indicating by which actor the submission was abandoned. "User" means that the submission user
abandoned it, "Administrator” refers to a TM administrator abandoning the submission, and "System" refers to a background job in TM itself
abandoning the submission, usually because it was left uncompleted for too long. Generally set only if form_status is "Abandoned".

® adobe_version Type: varchar(40) nullThe version number of Adobe Acrobat or Reader (contained in the HTTP request header "acrobat-version”)
used by the submission user. A typical values would be "11.0.2" or the like. Generally set only if the form is PDF-based rather than a pure HTML
form.

® attachment_count Type: integer nullThe number of electronic attachments associated with the submission (not counting manual attachments,
where the user does not attach a concrete file and instead promises to submit the attachment through channels outside TM). Can be null or a
numeric value.

® attachments_status Type: varchar(20) nullThe attachment status identifier for the submission. Common values are null (no attachments were ever
required by TM), "Completed" if the attachment step was fully completed, "Required" if attachments required by TM are missing and "Optional” if all
required attachments are present but the user has not confirmed the set of attachments. The latter two statuses are present only if the form_status
is "Abandoned" and are not valid for completed submissions.

® attachments_total_size Type: integer nullThe total size in bytes of all electronic attachments associated with the submission. Can be null or a
numeric value.

® authenticated_flag Type: integer nullindicates whether the submission user was authenticated (whether as a user account in TM or an external
user). If so, the value will be 1; any other value indicates that the user was anonymous.

® authentication_status Type: varchar(20) nullThe authentication status value of the submission. This is relevant only if the form requires
authentication (a setting in TM), in which case the user must authenticate prior to being able to submit. Possible values are null (authentication was
not required), "Completed”, "Cancelled" (the user opted to reject the submission rather than proceed) and "Required". The latter two statuses are
present only if the form_status is "Abandoned" and are not valid for completed submissions.

® client_code Type: varchar(20) not null A short, globally unique string identifying the organization associated with the submission. The code is
assigned by TM administrators. Typical values are "doha" or "fincorp".

® client_name Type: varchar(100) not nullThe name of the organization associated with the submission. Typical values are "Department of Health" or
"FinanceCorp".

® client_oid Type: bigint not nullindexed: Yes The database OID of the organization associated with the submission. This is a numeric value. Note
that even if organizations are deleted and recreated, records in the transaction history table are unaffected.

® contact_age Type: integer nullThe age of the user or their contact as extracted from submitted data. This will be set only if the form data
configuration setting "Contact Age XPath" was defined at the time the submission was created. Possible values are null or an integer.
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contact_gender Type: char(1) nullThe gender of the user or their contact as extracted from submitted data. This will be set only if the form data
configuration setting "Contact Gender XPath" was defined at the time the submission was created. Possible values are null or a single character
representing the gender as contained in submitted data.

contact_postcode Type: vachar(20) nullThe postcode of the user or their contact as extracted from submitted data. This will be set only if the form
data configuration setting "Contact Postcode XPath" was defined at the time the submission was created. Possible values are null or a the postcode
(represented as a string value) as contained in submitted data.

content_length Type: varchar(20) nullThe content length obtained from the HTTP servlet request when the user last saved/submitted the form. The
content length is numeric but represented here as a string value.

duration_client_response Type: integer nullThe time (in milliseconds) it took to stream the rendered form to the browser when the user last
opened the submission. The value may be null or an integer.

duration_render Type: integer nullThe time (in millicseconds) it took to render the form on the server when the user last opened the submission.
The value may be null or an integer.

duration_total Type: integer nullThe total time (in millicseconds) it took to process the form rendering request when the user last opened the
submission. The value may be null or an integer.

dwh_publish_status Type: varchar(50) nullThe status value that records whether this transaction history entry has been published to an external
data warehouse. This column is not used or written to by TM itself, but if a Groovy-based data warehouse publishing service exists on the TM
instance, it may have set a status value.

dwh_publish_time Type: timestamp null The date and time when this transaction history entry was published to an external data warehouse. This
column is not used or written to by TM itself, but if a Groovy-based data warehouse publishing service exists on the TM instance, it may have set a
value.

email_verif_status Type: varchar(20) nullThe submission email verifcation status. Submission email verification can be enabled for individual
forms. If enabled, users must click on a link inside a confirmation email to progress the submission. Possible values are null (email verification was
not required for this submission), "Completed”, "Required" and "Error" (if an error occurred while sending the confirmation email) and "Abandoned"”
(if the user has not completed email verification in time). Submissions with a form_status of "Completed" can have email verification status values of
null, "Completed" or possibly "Abandoned" (depending on form configuration, the submission may be processed even if email verification has not
been completed).

field_worker_flag Type: integer nullindicates whether the submission was last saved or submitted using TransactField App. If so, the value will be
1; any other value indicates that a different portal was used.

form_code Type: varchar(20) not nullA short, globally unique string identifying the form associated with the submission. The code is assigned by
TM administrators. Typical values are "transact-showcase" or "customer-enquiry".

form_name Type: varchar(120) not nullThe name of the form associated with the submission. This is the name that users will see on the portal
when filling in forms. Typical values are "Transact Showcase Form" or "Customer Enquiry Form".

form_oidType: bigint not nullindexed: *Yes The database OID of the form associated with the submission. This is a numeric value. Note that
even if forms are deleted and recreated, records in the transaction history table are unaffected.

form_status Type: varchar(20) nullindexed: Yes The status of the rendered form that this submission is based on. Possible values are "Completed"
(the user submitted the form and completed all necessary post-submission steps) and "Abandoned" (the user or an administrator explicitly
abandoned the submission, or it was abandoned by a TM background job if the user did not complete the form after a configurable amount of time).
This column is very important when you need to distinguish between "successful" and "failed" submissions.

form_version_number Type: varchar(10)Indexed: YesThe version number string identifying the version of the form associated with the
submission. Each form may have multiple versions with their own configuration, and the version number can be assigned by TM administrators.
Typical values are "1.0" or "2.0".

ip_address Type: varchar(50) nullThe IP address of the user when they last saved / submitted the submission. The IP address is obtained from the
HTTP request header "X-Forwarded-For" (if present) or the remote address in the HTTP servlet request. Typical values are "11.12.13.14".
In_status Type: integer null A numeric value used to record various metrics related to TM transaction licensing. This column is not intended for use
in custom reports.

payment_dr_receipt_no Type: varchar(20) nullThe payment receipt identifier received from the payment provider. This column is set only if
payment was completed for the submission and can be used to reconcile records kept by the payment provider with TM submissions. Typical values
vary by payment provider.

payment_dr_timestamp Type: timstamp nullThe date and time when payment was completed for this submission. If payment was not required or
not successfully completed, the value will be null.

payment_service_code Type: varchar(20) nullThe unique identifier of the payment provider service in TM. This column is set only if payment was
completed for the submission and can be used to identify which payment service was used for this submission. Typical values are "PayPal" or
"Westpac".

payment_status Type: varchar(20) nullThe payment status of the submission. Possible values are null (no payment was required), "Completed",
"Required" (user has not completed payment) and "Error" (the user attempted but did not successfully complete payment). The latter two status
values can occur when form_status is "Abandoned" but are not valid for completed submissions.

payment_total Type: decimal(15,5) nullThe total payment amount. If payment was not required for the submission, the value will be null. A typical
value might be 12.58.

payment_type Type: varchar(20) nullThe payment type describes how payment was made. Possible values are null (payment was not required),
"Credit/Debit Card", "Hosted" (payment was made via a 3 party payment provider), "BPAY" and "Manual" (an administrator marked the payment as
completed). Please refer to the Transaction Manager Administration Guide, chapter "Online Payment" for more information on the different payment
types and payment providers supported by TM.

pdf_submit_flag Type: integer nullindicates whether the submission was PDF based. If so, the value will be 1; any other value indicates that the
submission was not PDF based (e.g. HTML form).

percentage_completed Type: integer nullThe percentage to which the form has been completed as an integer value. This value is set only if
specified by the form.

portal_name Type: varchar(60) nullindexed: Yes The name of the TM portal on which the submission was last saved/submitted. Typical values are
"TransactField App" and "Maguire".

receipt_number Type: varchar(100) nullThe receipt number assigned to the submission. Receipt numbers are generated in TM using several
possible approaches (see the Transaction Manager Administration Guide, chapter "Form Configuration”, section "Tracking Code and Receipt
Number"). Note that the tracking code is not currently present in the transaction_history table.

receipt_render_duration Type: integer nullThe time (in millicseconds) it took to render the receipt for this submission on the server. The value may
be null or an integer.

referer Type: varchar(255) nullindexed: Yes The value of the HTTP request header "referer" when the user started the submission.
request_cookie Type: varchar(2000) nullThe value of the HTTP request header "Cookie" when the user last saved/submitted the submission.
request_key Type: varchar(50) nullindexed: Yes A UUID identifying the TM request log entry that was created when the user started the
submission. A typical value would be "00b765d4ebf81232f67069a6115047d5".

request_url Type: varchar(1000) nullThe value of the request URL in the HTTP servlet request when the user started the submission.
revision_number Type: integer nullThe submission revision number, which is used for conflict resolution and is incremented every time the
submission is saved/submitted. Possible values are null or positive integers.



® signature_completed_timestamp Type: timestamp nullThe date and time when the user completed signatures for this submission. This column
will be set only if the submission included a signature step, which the user completed.

® signature_status Type: varchar(40) nullThe signature status for this submission. Wet ink or digital signatures can be set up in TM as a post-
submission step (see the Transaction Manager Administration Guide chapter "Signatures"). Possible values for the status are null (signatures were
not required for this submission), "Completed", "Completed - Upload Scanned Copy" (the user printed and signed the receipt, then uploaded it to
TM), "Completed - Deliver Manually” (the user downloaded the receipt and will send it back outside of TM), "Required" and "Cancelled". The latter
two status values can occur if form_status is "Abandoned" but are not valid for completed submissions.

® signature_type Type: varchar(20) nullThe signature type describes what kind of signatures were requested. Possible values are null (signatures
were not required), "Wet" (wet ink), "Digital" (in-form digital signatures) and "ESignature" (the receipt is signed with the organization's certificate and
presented to the user). Please refer to the Transaction Manager Administration Guide, chapter "Signatures” for more information on the different
signature types.

® submission_expiry_date Type: timestamp nullThe date and time when the submission would expire unless completed by the user. This column is
set only if the form was configured with an expiry time when the submission was started.

® submission_oid Type: bigint null The database OID of the submission. This is a numeric value. Note that even if submissions are deleted, records
in the transaction history table are unaffected.

® submit_key Type: varchar(60) nullA UUID identifying the submission. A typical value would be "00b765d4ebf81232f67069a6115047d5".

® submitted_offline_flag Type: integer nullApplies to PDF submissions only. Indicates whether the submission was saved offline and completed
after having been reopened in a PDF reader. If so, the value will be 1; any other value indicates that the submission was not submitted offline.

® task_flag Type: integer nullindicates whether the submission is based on a task assigned to a user or group, rather than a user opening a form of
their own accord. If so, the value will be 1; any other value indicates that the submission is not based on a task.

® time_email_verif_completed Type: timestamp nullThe date and time when submission email verification was completed. This column is set only if
submission email verification was required.

® time_form_completed Type: timestamp nullThe date and time when all user steps were completed for the submission. Generally this column is set
only if the form_status is "Completed".

® time_request Type: timestamp nullindexed: Yes The date and time when the user started the submission.

® time_submission Type: timestamp nullindexed: Yes The date and time when the user last saved/submitted the submission.

® time_to_submit_sec Type: integer nullThe number of seconds the user actually spent inside the form up to the most recent save/submission. May
not be set if form_status is "Abandoned".

® trans_ref_number Type: varchar(100) nullA transaction reference string as extracted from submitted data. This will be set only if the form data
configuration setting "Transaction Ref Number XPath" was defined at the time the submission was created. Possible values are null or the
transaction reference as contained in submitted data.

® transaction_history_oid Type: bigint not nullindexed: Yes The database OID of the transaction history entry. This is used as the primary key for
this table.

® transaction_score Type: integer nullA numeric score describing the value of the submission on some kind of scale. This value is not assigned by
TM; instead, the form itself can store a transaction value in the submitted XML, and TM will store it. Possible values are null or an integer.

® transaction_value Type: decimal nullA number describing the value (monetary or otherwise as defined by the form developer) of the transaction as
extracted from submitted data. This will be set only if the form data configuration setting "Transaction Value XPath" was defined at the time the
submission was created. Possible values are null or a number describing the transaction value as contained in submitted data.

® user_agent Type: varchar(200) nullThe value of the HTTP request header "User-Agent".

® user_agent_browser_type Type: varchar(100) nullindexed: Yes The name of the browser used by the submission user. This information is
extracted from the user_agent value. Example values are "Mozilla" and "Chrome Mobile".

® user_agent_browser_version Type: varchar(100) nullindexed: Yes The major version identifier of the browser used by the submission user. This
information is extracted from the user_agent value. Example values are "33" and "Unknown".

® user_agent_device_type Type: varchar(20) nullindexed: Yes The device type used by the submission user. This information is extracted from the
user_agent value. Possible values are "Desktop”, "Tablet", "Phone", "Digital Media Rec.", "Game Console" and "Unknown".

® user_agent_os_type Type: varchar(100) nullindexed: Yes The name of the operating system used by the submission user. This information is
extracted from the user_agent value. Example values are "Windows" and "Android".

® user_agent_os_version Type: varchar(100) nullindexed: Yes The version identifier of the operating system used by the submission user. This
information is extracted from the user_agent value. Example values are "10" and "Vista".

Tips and Tricks

Here are some tips to keep in mind when writing reports against the transaction history table.

Filtering by Date

When writing reports, you often need to filter or group by date. There are three key date columns to consider for the transaction_history table:

® time_requestUse this column when you want to filter on the time the submission was initiated. This column applies to all transaction history entries.

® time_submissionUse this column when you want to filter on the time the submission was completed. This column applies to all transaction history
entries.

® abandonment_timestampUse this to filter on when submissions with a form_status of "Abandoned" were abandoned. Depending on system settings
and how the submission was abandoned, abandonment may happen a long time after the user last worked on the submission.

® time_form_completedUse this column to filter on when submissions (generally with a form_status of "Completed") were completed by the user.

Filtering by Organization/Form

If you want to group transaction history data by form and/or organization, you have a few options:
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® client_oid / form_oidThe database ID of the organization or form. This value cannot change until the organization/form is deleted and is, therefore,
useful to find all submissions for a specific organization/form, even if its name has changed.

® client_code / form_codeA short globally unique string identifying the organization / form. This value can be edited; therefore, the same organization
/form may be represented in the transaction_history table under several client/form codes (but they would all have the same client_oid / form_oid).
This column can be used as a display value that is shorter than the organization/form name.

® client_name / form_nameThe name of the organization / form as displayed on TM portals. This value can get fairly long and may need to be
truncated for display (or you can use the organization/form code). This value can be edited; therefore, the same organization/form may be
represented in the transaction_history table under several client/form names (but they would all have the same client_oid / form_oid).



Note that all the columns above are guaranteed to not contain null values.

Other Filters

There are other columns that are commonly used for filtering, such as:

form_statusUse this to distinguish between completed and abandoned submissions [ Completed | Abandoned ].

authenticated_flagWhether or not the user filled in the form anonymously or was logged in to TM or an external authentication provider.
abandonment_typeUse this to distinguish how a submission was abandoned [ System | User | Administrator ].

field_worker_flagWhether the submission was made on a TransactField App portal.

task_flagWhether the submission was based on a task assigned to a user or group of users, as opposed to a user starting a submission of their own
accord.

Transaction Lookup Table

The transaction lookup table (transaction_lookup) provides a fast way to provide a list of organization names, organization codes, form names or form codes
in select lists.

This table is populated when the transaction_history table data is updated. When performing organization or form based filtering of the transaction_history
records, use the client_oid and form_oid values from the transaction_lookup table, as these values are indexed in the transaction_history table.

Columns

The transaction_lookup table column definitions are provided below:
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client_code Type: varchar(20) not null - A short, globally unique string identifying the organization associated with the submission. The code is
assigned by TM administrators. Typical values are "doha" or "fincorp".

client_oid Type: bigint not null - The database OID of the organization associated with the submission. This is a numeric value. Note that even if
organizations are deleted and recreated, records in the transaction history table are unaffected.

form_code Type: varchar(20) not null - A short, globally unique string identifying the form associated with the submission. The code is assigned by
TM administrators. Typical values are "transact-showcase" or "customer-enquiry".

form_name Type: varchar(120) not null - The name of the form associated with the submission. This is the name that users will see on the portal
when filling in forms. Typical values are "Transact Showcase Form" or "Customer Enquiry Form".

form_oid Type: bigint not nullThe database OID of the form associated with the submission. This is a numeric value. Note that even if forms are
deleted and recreated, records in the transaction history table are unaffected.

lookup_oid Type: bigint not nullindexed: Yes The database OID of the transaction lookup entry. This is used as the primary key for this table.



Transact Integration Guide (Manager v5.0)

Introduction

This document covers a range of topics around designing and hosting forms using Avoka Transact, such as form prefill, saving and task assignment. In
contrast to the TM Administration Guide, this document is structured around common administration tasks and explains how to perform them.
The topics are roughly following the order of the form rendering and submission process where applicable.

Who should read this document?

This document is intended for Avoka Transact administrators and form developers who want to configure various advanced features for their forms. Its main
focus is on Transaction Manager, but it also contains some references to Transact Composer.

This document explains these features from a user's perspective and should be read in conjunction with the Transaction Manager Administration Guide,

which is more of a reference guide to the management console. Therefore, the Administration Guide will often discuss individual pages in great detail,
whereas this document focuses on the steps necessary to complete specific tasks.
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Access Control Options (Manager v5.0)

Transaction Manager comes with an extensive security model. Access to the management console is controlled using permission and organization based
filtering, whereas access to forms and content on the user space is controlled using groups, permissions, and user account based filtering.
Much of the security model including the full list of permissions in the management console is discussed in the TM Administration Guide.

Can TM use two-factor authentication?

In addition to default password-based authentication, TM can be configured to use two-factor authentication, where the user is asked to provide an additional
secret when entering their credentials (e.g. a time-based token). This is much more secure and defends against common attacks on user accounts such as
password enumeration. If two-factor authentication is set up, TM will also not increase lockout attempts unless a valid token was presented, which makes it
harder for attackers to lock a user account by repeatedly providing invalid credentials.

Two-factor authentication implementations are set up as service definitions of type "Two Factor Authentication” in TM. Out of the box, TM comes with a
service definition providing two-factor authentication using the Google Authenticator one-time password service ({+}https://en.wikipedia.org/wiki
/Google_Authenticator+).

When two-factor authentication is turned on, users must provide a token generated by the Google Authenticator app in addition to the login name and
password. In order to get the token, users have to install the Google Authenticator app and set up a key generated for them on which the tokens will be
based. TM provides enrollment functionality for new and existing users, generating keys and emailing out instructions. Administrators can also enroll users
and reset their keys if requested. Note that two-factor authentication keys are never exposed to administrators and only sent to the user's email address
when needed.

One important issue with two-factor authentication is the cutover period if TM was previously configured to use single-factor (password) authentication. TM
supports the setup of a grace period, during which existing users without a two-factor authentication key can log in using their password, and are then able to
securely set up multi-factor authentication. Once the grace period ends, users can no longer log in with their password alone; however, administrators can
manually trigger the two-factor authentication setup email for them (or the grace period can be extended if need be).

To configure a two-factor authentication service, go to "System > Service Definitions" and filter by service type "Two Factor Authentication”. If no service of
that type exists, create one from the template named "Google Authenticator”. Now edit the service and switch to the "Parameters" tab.

Google Authenticator

Home Dashboard » Service Definiions » Service Definition

Service Definition ] Service Parameters Service Usage
Hame Type Value Description B Last Modified Action
Parameter
Email 2FA Message String #f (SaccountReset) <p>  Email message for 2FA user account enrolment 1Wapr20isey (A K]
Anew A system
Email 2FA Subject  String Setup 2-Step Verification  Email subject for 2FA user account enrolment 104pr 20150y (A £
systemn
endOfGracePeriod Date  2015-09-01 The grace period alows users to log on without entering a token and then setting up a o 27 Jul 2015 by A8
Google Auth account. Set this to the date when you want the grace period to end. Ipammer
issuer String Awvoka Technologies. Set this parameter to the name of the organization issuing the GoogleAuth key. ‘.r 104pr20150y  [F §
system
[

Service parameters for the Google Authenticator service
Adjust the value of the "issuer" parameter (this will denote the organization issuing the Google Authenticator key and will be visible to the user).
Also, consider how long the grace period should be and set the "endOfGracePeriod" parameter to the date when the grace period should end.

You can also customize the contents of the enrolment/reset email sent out to your users. However, take care not to remove key content that the user will
need to set up successfully.

Once the service has been configured, you can activate it for certain spaces. This is done by configuring a security manager to use a two-factor
authentication service. Go to "Security > Security Managers" and edit the security manager you want to set up with two-factor authentication. Choose the
service you configured above from the "2 Factor Authentication" dropdown and save.

Important note: Once a security manager is configured to use a two-factor authentication service, this takes effect immediately and for all spaces associated
with the security manager (possibly including the management console). To avoid locking yourself or other users out of the system, always test your service
carefully first (possibly using a security manager associated with a single test space) and use a grace period so your users can get set up with two-factor
authentication keys. Also, remember that a security manager that is marked as the system default security manager is used by all spaces who are not
explicitly set to use a specific security manager.

If you would like to disable two-factor authentication, edit the security manager again, blank out the "2 Factor Authentication" dropdown and save. From then
on, users can once again log on just using their login name and password.

If two-factor authentication is enabled, administrators can generate/reset authentication keys for users by editing the user and clicking the "Create 2FA Key"/"
Reset 2FA Key" button at the bottom. This will trigger a key to be generated for the user and the two-factor authentication email to be sent to the user's email
address (exactly as if the user had completed enrolment themselves).
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Organizations (Manager v5.0)

An organization is an entity that owns forms. In Transaction Manager, each organization can be configured in a variety of ways, influencing all forms created
for the organization. In addition, administrators can be assigned to an organization, causing them to be unable to view or modify data belonging to other
organizations.

How do | create an organization?

To create an organization in Transaction Manager, use the menu item "Forms > Organizations". The screenshot below shows the page you should be seeing.
Organisations

Home = Organisations

search [V Active Only Clear

New Copy Import
Organisation Name  Client Code Active Last Modified Action
Administrative Services DAS v 27 Jun 2012 by administrator Iz ﬁ !
Department of Health DOHA v 27 Jun 2012 by administrator [ 7] [ |1
FinanceCorp fincorp v 27 Jun 2012 by administrator  [7) & L1

Export Data

The list of organizations set up in T™M
To create a basic organization, click the "New" button above the table. You will see a form into which you can enter the organization's details. Enter a unique
organization name and short alphanumeric code.

New Organization

Heme Dashboard » Organizations » Organizafion

org I I I | |
Name" | Quick Start Client ]
Chent Code * | quick @
Description
Credential Alias @
Active W @
Close

Creating an organization

Note: You cannot create an organization that has the same name or client code as an existing organization. You can use the "Organizations" page to see
which names and codes are already taken.

Save the organization. You will now be taken to the "Spaces" tab. Assign all spaces that should be available to the organization. This will affect the spaces
that can be used to host forms created for the organization.

Edit Organization

Home Dashboard » Organizations » Organization

i The Organization has been successfully saved. Please assign portals as needed.

Organization Delivery Channels Spaces Payment Gateway Properties. I Form Categories Form Tags Applications Report Schedules Data Management

Specify the Spaces that this. organization's forms can be hosted on.
Select at least one Space that will be avallable to this organization.

Available Spaces Assigned Spaces

ANZ - Maguire =l
Awvoka Forms
Avoka 550 ADFS
Avoka 550 Portal ADFS
Bank of Melboume
Bank of South Austraiia >
Bendigo

Spaces BT Pordl .
CAAPortal
Classic Fnance Comoration
Classic Gov Assist ‘e
CTMaguire
Department of the Interior
EPA Transact Feld App
Finance Comoration

Eﬂ\r Assist ;I ;I

Close

Assigning portals to the organization

Save your changes.

For detailed information about all the options available when configuring an organization, please refer to the Transaction Manager Administration Guide,
chapter "Organization Configuration".
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Configuring Forms (Manager v5.0)

Forms are the central entities in Avoka Transact. This section deals with general topics around form configuration that are not directly related to the user-
facing form fill-in flow, such as how to deploy forms to Transaction Manager.

How do | create and deploy a Composer SmartForm?

You can easily publish Composer forms to Transaction Manager, or alternatively export a ZIP file from Composer in case the two servers cannot
communicate. The ZIP file can be imported to TM, which will automatically host the form on the space of your choice.

This section will show you how to create a very simple form in Composer, publish it to Transaction Manager and render and submit the hosted form. It
assumes you have already created an organization and project in Composer, and an organization in Transaction Manager. This process of creating and
hosting a basic form can be done in a matter of minutes.

Creating a Composer form

To create a basic Composer SmartForm suitable for use in Transaction Manager, log on to Composer and navigate to your project. Click "Create New Form"

and enter a name for your form.
Create a New Form

@ This wizard will guide you through the process of creating a new Avoka Smart Form, Choose a name and description for your form.

Organization My Organization

Project My Project

Form Name & Basic Form

Description  This is a basic form that can be hosted in TI. It is available as HTML and PDF and also includes a PDF receipt.

Next > Cancel

Creating a form in Transact Composer
Click "Next". Choose a suitable template or use the default, then click "Next".

Create a New Form

E Select the initial styling that you want to use for the various elements of your form.

Form Structure: Section Style: | Classic w | Color Theme: | Green v
L J \=men ' v)

Standard Form

Wizard [left]

Wizard i
izard [no menu] Sample for preview

#  Customer Details

# Customer

#  Shipping Details

# Shipping Address

Address 1

The following errors were found in your form, Plesse corrct them before preceeding.
To godirectly to the: errors on your form, please use the butions below or double-dick on the error(s) in the list
To go directly to the errors on your form, Hease doubleclick on the ermors(s) in the list

< Back Next > Cancel
L J L J L J

Configuring the styling for the form
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We will use a standard form with a green color theme. When you change the settings, the sample will change to reflect your choices. Click "Next" when you
are satisfied. Leave the settings on the final screen unchanged and click "Finish" to create the form.

Composer will automatically open the form for you to edit. The form contains a basic logo and a section as well as the standard error section, all of which we
could customize. However, for the purposes of this walkthrough, we will simply add a few fields and a submit button.

To add the fields, expand "Field Types > Common" in the palette area. Drag and drop a widget of type "Text Field" into the blue rectangle in the “Instructions”
section.

Create a New Field

Please supply values for the requested properties in order to create a new field of the given
type.

Field Type Text Field

Caption Text  Given name(s)

Internal Name M Generate Name

Layout Data Keep on Same Row | |

Layout Order (0=normal)

Exclude from Layout Manager | |

Field Size Medium v

Save Cancel

Adding a text field to the form

For our basic form, we will add two text fields for given and family names. The screenshot above shows the creation dialog for the first text field. Fill in a label
(e.g. "Given name(s)" and save. Drag and drop in another text field to the right of the first field, fill in the label (e.g. "Family name") and tick "Keep on same
line", then save.

Finally, drag and drop a "Submit Button" widget to the right of the fields. Accept the default values in the dialog and save.

The screenshot below shows the form we created. You can preview the form in Composer as PDF or HTML, but we will simply go on to publish the form to
Transaction Manager and render it there.

Avoka Transact & 1) & Logost B % Fesdback &
Composer -

Praview: HTML [Deskiop] orm % £ Publish.. 4 SelectTool. v 5 Closs

Palette

-

@ Error Section

1 & [Field]

[l image [Ressurce]

I Int=ger Field

BB rhase Value Text [Rich]
W Section Level 1

L

¥ Section Level 3

Q Smart Radia Button

= Submit Button

¥ Text [Plain]

B Text [Rich)
To go directy 0 e emane on yw fonm, please use e bulons below o double-chok on e ermos) i he st &T t Field

fard in your form, = pracaeding

To go dhemcy fo i rer on e form, pass doubie-cick on s srsras) s Be Gl IS Text Field [Multiline]

anced

S o
+ gl Data Dictionary

Go to First Eror C Sekecied Eror

Prablems — L < %
+ ol Mebile App
+ ol Navigation

+ o Nut its

Data Dictionary

The basic form in Composer
Publishing the form to Transaction Manager

To publish the basic form we just created to Transaction Manager, ensure the form is open in Composer and click the "Publish..." button above the form
area. You may be prompted to save changes to your form before the publish dialog is shown.
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=,
3

Select how you want to publish this form:

is wizard will guide you through the process of publishing a Form.

Publish Method ;1:[ Publish to Transaction Manager A J { Configure... J

URL  https://tm.test.avoka.com/manager/

Include Seed File l Include Composer generated seed file - J

Select the form types you want to publish:

Form Types ¥ HTML Select All
|¥] PDF Clear Selection

Cancel Finish

Publishing the basic form

Assuming the Composer and TM servers can communicate with each other, you can use the publish method "Publish to Transaction Manager". If this has
been set up for your Composer instance already, choose this method and ensure the Transaction Manager URL matches the target environment.
Otherwise please select "Publish as zip file" as the publish method.

Click "Finish".

If you published the file as a ZIP file, navigate to and log in to the TM management console. Go to "Forms > Composer Package Imports" and click "Import
Composer Package".

Composer Package Upload

Home = Composer Package Imperts » Composer Package Upload

Uploading the ZIP file containing the basic form into Transaction Manager
Click "Upload" to get to the "Import Composer Package" page.
If you published directly from Composer to Transaction Manager, you should arrive at the "Import Composer Package" page after you log in to TM.

Composer Package File ™ |D:\data‘\downloads\SFC_52cc7ea5-2155-4dc 8-9cde-e80a53be67d2 zip Browse ‘

Import Composer Package

Home Dashboard » Forms » Import Composer Package

\/ Please review the forms found in the Composer package and the possible import actions you can take below.
iy Tick and configure allimport actions you would like to take, then click "Import™ to proceed

Organization =~ Quick Start Client =le New Form Portal  Maguire =| @

Action Composer Name Form Template(s) Form Name Options
V _5- Basic Form - HTML HTML Desktop, Tablet =~ Basic Form - HTML New Form
F 3 Basic Form- PDF  PDF Basic Form - PDF New Form

Importing the basic form

Please select the target organization in Transaction Manager from the "Organization" dropdown. Transaction Manager will then attempt to find the forms
published by Composer, and will allow you to update the existing forms if they are found. In our case, we are publishing for the first time, and so the only
option is to create new forms.

As you can see, Composer has published our basic form as two forms. This is the same Composer form in two versions, HTML and PDF (both using a PDF
receipt). The checkbox next to each row allows you to select which of the forms you would like to import to Transaction Manager. For this walkthrough, we
will import both forms.

Choose a suitable space from "New Form Space" (we are using the "Gov Assist" example space) and click "Import". The import may take a few seconds to
complete.

Finally, a summary of the actions taken during import will be shown. If any errors should occur, they will be displayed in the summary as well. If you imported
only a single form, the edit page for the form is shown instead.

Composer Import Summary
Home Daszhboard » Forms » Import Composer Package » Composer import Summary

Composer package import completed.
Please review the form(s) you created and assign them to form work groups if you would ike to restrict access to them.

Form Name Composer Name Result Action

[ BasicForm-HTML Basic Form-HTML New Form - Created form ‘Basic Form - HTML. ]

L.a Basic Form-PDF  Basic Form - PDF New Form - Created form ‘Basic Form - PDF. :

The summary displayed after importing a form
Now that we have successfully deployed the basic form to Transaction Manager, we can test it on the space.
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Testing the form

To test the basic form, go to "Forms > Forms" and filter by the organization you have imported the forms to. You should see both the HTML and PDF
versions of the basic form.

Forms

Home Dashboard » Forms

Portal =| FiterBy = Active z| SortBy | Fom Name =] Clear

New Import Form Version Import Composer Package

Basic Form - HTML  basic-form 1.0 Active & Test 29 Apr 2014 by lpammer (7] 1 @ (1

Basic Form- PDF  basic-form2 1.0 Active & Test 29 Apr 2014 by lpammer [ 7 @ |1

Simple Form 'SMQUICK T0 ACINE 8 Test 78 Apr 2014 by pammer 12w &) ||
Export Data

The basic forms in the TM management console

The basic form is now hosted on Transaction Manager and can be filled in and submitted. Note that new forms start out in test mode and hence will not be
offered on the form search page on the space. This is intentional to avoid accidentally exposing forms publicly before they are ready. Forms can be changed
to production mode easily if desired. For our walkthrough, you can start the fill-in process directly via the TM management console.

Edit one of the forms (we will be using the HTML form here on) and click on the @ icon under the "Landing Page" heading in the "Form URLs" section. From
here on, you will interact with the space and the basic form just like one of your end users would. There is a lot of content you can add to the landing page,
but for the moment we just want to test the basic form. Depending on the space you selected during import, this page will look different, but the basic
components should be the same.

& MAGUIRE

FINANCIAL

Basic Form - HTML

This Is a basic form that can be hosted in TM. It is available as HTML and PDF and also includes a PDF receipt

Open New Form

Login and Open Form

;‘{_ Powered By Avoka Transact

The landing page for the basic form

Click "Open New Form" to proceed to the form without logging on as a space user. You will see the basic form with the two text fields and the submit button,
rendered as HTML.

Basic Form

*f GLOBALcorp

TJLOFK

1 Instructions

Given name(s) Family name

The basic form rendered on a TM user portal

Fill in a given and family name, then click "Submit".

Transaction Manager will now process the form submission and display the submission confirmation page, generating a unique receipt number for your
reference and offering the receipt to be downloaded or emailed out to the applicant.
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FINANCIAL

Submission Complete

You have successfully completed your Basic Form - HTML submission

Your Tracking Code is:

TJL9FK

Please record your tracking code. You may quote this number when enquiring about your application.

From Here I!.I Download a PDF copy of your form

OR

€ send yourself an email with a PDF copy to your form

¥ Powered By Avoka T "
7% owerad By Avoka Transact

The submission confirmation page for the basic form

Have a look at the receipt by clicking "Save a PDF copy of your form". Your browser will download a PDF file containing the receipt (this PDF file was
generated automatically by Composer). The given and family names you filled in should be shown, but none of the fields should be editable. The receipt will
generally be black and white only so it can be printed easily if needed.

There is much more you could build into and configure for your forms using Avoka Transact. The focus of this walkthrough was simply to show the basics of
designing a SmartForm from scratch and hosting it on Transaction Manager. The remainder of this document will provide details on many common questions
around form and space customization.

How do | deploy a Designer PDF form?

If you have developed an XDP or PDF form using Adobe Designer, you can easily deploy it to Transaction Manager. This section assumes you already have
a suitable form in XDP or PDF format.
In addition to the form, you will need an administrator account on the TM management console. The organization that will host the form needs to be set up in

Transaction Manager (see "How do | create an organization?" ).

Deploying the form

The easiest and quickest way to set up a new form is to use the "New Form" wizard provided by Transaction Manager.
To start the wizard, choose the menu item "Forms > New Form Wizard". The screenshot below shows example values.

New Form Wizard

Home = New Form Wizard

Use the New Form Wizard to quickly create a new form.
Simply complete the required details, upload your form template and press Finish.

Form | Resources | Portal | PDF Options ‘

Organisation*  Quick Start Client =@
Form Name* Simple Form Q9
Form Code ™ sim-quick @
Form Type* Dynamic PDF Fom ;l 2]

This is a simple test form.

Description

< Back Next > Cancel

Creating a new form

Choose your organization from the "Organization" dropdown, if it is shown (this depends on your assigned permissions).
Enter the full form name as well as a short, unique form code.

Choose "Dynamic PDF Form" from the "Form Type" dropdown.

Optionally enter a description, which can be displayed to space users accessing the form.
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Next, switch to the "Resources" tab.

New Form Wizard
Home = New Form Wizard

Use the New Form Wizard to quickly create a new form.
Simply complete the required details, upload your form template and press Finish.

Form Resources | Portal | PDF Options

Form Template
Upload Form or FAR File |C,\AvukaTeleases\lemplatas\FC_Tem Form pdf Browse_ | @
@

LiveCycle Repository Path

Receipt Template

Upload Receipt File Browse_ |9
@

LiveCycle Repository Path
Form XML Data
Form XML Data File |C-\AvokaTestCases'templates\TCFito3\TC1_seed 2aml Browse.. | @

< Back Cancel

Defining form resources

You will have to upload a file in the "Form Template" and (optionally) "Form XML Data" sections. Upload the XDP or PDF form in the "Form Template"
section, and the XML seed file in the "Form XML Data" section. If the form you have chosen does not have an XML data configuration, leave the "Form XML
Data" section blank.

Note: Many features in Transaction Manager such as attachments, signatures and payment require that you upload a seed file, so that Transaction Manager
can locate and write to or read from special sections in the form data.

Now switch to the "Spaces" tab and assign the space you want to test your form on by selecting the space and using the ">" button.

New Form Wizard

Home Dashboard » Organizations » Organization » New Form Wizard

Use the New Form Wizard to quickly create a new form.
Simply complete the required details, upload your form template and press Finish
Form Resources Spaces | PDF Options |
Available Spaces Assigned Spaces
;l Maguire ;l
>
Space™ <
<<
= =
< Back Next > Cancel

Assigning the portal that will host the form

If the form you uploaded does not need to be reader-extended before it can be filled in, or you do not have a valid Reader Extension certificate, change to the
"PDF Options" tab and untick the "Reader Extend Form" checkbox. If it is left ticked, make sure that your Transaction Manager system has been set up with
the appropriate Reader Extension certificate first. You can find instructions on how to set up a Reader Extension certificate in the Transaction Manager
Installation Guide.

You can also modify how the form is displayed in the PDF viewer by using the dropdown lists.
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New Form Wizard

Home > New Form Wizard

Use the New Form Wizard to quickly create a new form.
Simply complete the required details, upload your form template and press Finish

Form | Resources | Portal | PDF Options

Reader Extend Form ¥ @
Allow Multiple Submissions [~ @
Form Supports Offline Submission [~ Q

Page View ;I 9
Tool Bar ;I @
Navigation Pane :I 7]

Scroll Bar ll ]

< Back Finish Cancel

Configuring PDF options
Save the new form by clicking the "Finish" button. It is now ready for you to test.

Testing the form

After setting up a form, you should test it to make sure it can be displayed, filled in and submitted without problems.
To test the form, click the "Landing Page" link for one of the spaces associated with the form (see screenshot below).

Simple Form
Home Dashboard » Forms » Form

Dashboard | Detas | Fiow Config | Email Verification | FormVersions | Abandonment | Page Tracking | Spsces | GroupAccess | FormPromotion | Deployment Schedule

Form Details Form Versions
Form Display Name :  Simple Form Version Current Version LastModified
R 10 v 03Jun 2013 Properties Attachments Services DataConfip € HH 4

Organization : Quick Start Client
TestMode : “es New Form Version  Export Form Versions
Created : 03 Jun 2013 - 11:51 by lpammer

Last Modified - 28 Jul 2015 - 05:52 by lpammer

Latest Transactions View Al Transactions
Form URLS (1} Receipt Number Time: Transaction Status Receipt
e ety e o) G Loes] e s Submissions: 0 Requests: 0  Submission Rate: 0% Avg. Submit Time :
Finance Corporation () Q 2 9 E
Maguire ) [~ ] @ @ =

PDF Receipt Test

Rendering a new form

If you have already navigated away from that page, go to "Forms > Forms", find your new form in the list and edit it. Note: Transaction Manager will split
search results over several pages, so use the "Next" link at the bottom if you cannot see your form on the first page.

When you access the landing page, a new browser window will be displayed containing the landing page for the form. This page is actually part of the
Transaction Manager user space. From now on until after you submit the form, you will interact with the space just like your users would.

If your user space is configured to allow account self-registration, the landing page will look similar to the one shown in the screenshot below (which is
showing one of the example spaces). While the landing page looks very simple at this point, you can add a wealth of content (description, instructions for the
user, organization logo etc.) using TM.
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Simple Form

Open New Form

Login and Open Form

S Fowersd By Avoka Ti "
7% 'owered By Avoka Transact

The landing page for your new form

On the TM example spaces, you can register a new user space account or log in if you already have one. If you want to test the form anonymously, simply
select the option "Open New Form".

The form should load up inside the same browser window and behave as designed. If there are problems displaying the forms, ensure you have Adobe
Reader 8 or higher installed on your system and that it is configured to display PDF files in your web browser.

Fill in and submit the form. You will be directed to the submission confirmation page as shown below.

£ MAGUIRE

FINANCIAL

Submission Complete

You have successfully completed your Simple Form submission

Your Tracking Code is:

2NDS89

Please record your tracking code. You may quote this number when enquiring about your application.

From Here I!.I Download a PDF copy of your form
OR

€ Send yourself an email with a PDF copy to your form

;{_ Powered By Avoka Transact

The submission confirmation page

Now that you have rendered and submitted the form, you can check on the submission to make sure everything worked correctly.

You can email yourself a copy of the form receipt by entering your email address on the confirmation page and clicking the "Send email" button (or
equivalent). For this to work, Transaction Manager has to have been configured for SMTP email delivery. You should get the email within a few minutes. It
will include the receipt in PDF format.

Checking the submitted form

To see whether Transaction Manager has correctly processed the form submission, a good first step is to render the form receipt. To do this, simply open the
PDF file included in your receipt email or click the "Save a PDF copy of your form" link on the confirmation page.

-
Alternatively, you can switch back to the management console, go to "Operations > Form Transactions" and click the "View Receipt" icon ( = ) next to the
submission entry.

Form Transactions
Home Dashboard » Form Transactions

Form Status =| sStartDate Clear
Aftachments =] Paymenis =] Email Verification =l Defvery =] EndDate
ID  Tracking Code Form Org. Time Portal User/Contact Email Payment Transaction $tatus Action
1084 2ZNDS35 Simple Form quick 28 Apr11:34 Maguire $0.00 Delivery Ready, Method Not Configured ', '-_
Export Data
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Inspecting the submission log
The receipt should render just as the form did; however, all fields will be read-only in the receipt, and dynamic behavior will be disabled (e.g. you should not

be able to submit the form again).
After inspecting the receipt, look at the submission log entry as well (refresh the page if you had navigated to it before). The "Transaction Status" column
should indicate that the submission is ready for delivery but that no delivery method has been configured.
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User Spaces (Manager v5.0)

Transaction Manager offers a variety of options to expose forms to your target audience. You can use the TM self-service space, which provides a complete
solution for end-to-end form fill-in. If you already have a web portal into which you would like to integrate form fill-in, you can easily add calls to the Web
Plugin module to render forms. If you wish to provide your users with sophisticated form lookup as well as offering existing resources, you can use the Finder
module to provide custom form and resource finding.

What kind of user space should | use?

Transaction Manager can expose multiple user spaces with a different set of forms on each one. This means you can combine one or more self-service
spaces with the Finder and/or the Web Plugin modules, potentially for different target audiences and with different branding.

Generally, if you already have your own branded web portal and want to embed forms inside it without styling your own self-service space, you can use the
Web Plugin.

If you want to take advantage of the stand-alone self-service space, you can change the styling and page content to suit your needs. The self-service space
provides the full set of form-related flows, including authentication against the Transaction Manager user base (or external directories) and a personalized
secure area showing the user's submission history, to-do list and available forms.

How can | use LDAP to authenticate users?

In TM, authentication is handled by a security managers. Security managers are configurable entities associated with one or more spaces, and also handle
user enrollment and security-related functionality such as automated lockout and password constraints.

Security managers authenticate either against the TM user database (local authentication) or against an externally maintained user base (delegated
authentication, e.g. LDAP or SSO). Delegating security managers can have multiple authentication providers, which handle the authentication process itself
(non-delegating security managers would have a single authentication provider operating against the TM user base).

Authentication providers are called sequentially until one of them is able to authenticate the user. There are pre-defined authentication provider templates
including authentication against the TM user base and authentication against an LDAP directory. You can configure your security manager to use one or
more authentication providers and define the order in which they are to be called.

TM already provides an LDAP-based security manager named "LDAP Security Manager", which you can configure for your LDAP directory.

Configuring LDAP authentication parameters

Once you have an LDAP-based security manager, you need to configure it such that it can connect to your specific LDAP directory. To do so, edit your
security manager and switch to the "Authentication Providers" tab. Edit the LDAP authentication provider and switch to the "Parameters" tab (see the image
below).

LDAP Authenticator Authentication Provider

Home Dashbeard » Security Managers » Security Manager » Authentication Provider

Authentication Provider | Parameters | LDAPTest |

Hame Type Value Description Action
IdapatiributeDistinguishedName  String distinguishedName LDAP attribute that contains the user's distinguished name =_‘ :
IdapAtiributeEmail String mail LDAP attribute that contains the user's email address =]
IdapAtiributeFirstName String givenName LDAP attribute that contains the user's first name =_' :
ldapAttributeGroups String memberQf LOAP attribute that contains the user's groups A &
Idapatiributel astName String sn LDAP attribute that contains the user's last name =_‘ :
ldapAtiributeMobile String mabile LDAP aftribute that contains the user's mobile number rafi=a)
IdapatiributesProfieMapping String givenName=Given Name; sn=Family Name, mai=Emai; m... LDAP aftributes to User Profile mapping =_‘ :
IdapAftiributelserlame String sAMAccountName LDAP attribute that contains the user login user name =]
IdapSearchBase String OU=Users, OUsMyBusiness, DC=mycorp,DC=local The LDAP search base to use during user authentication =_' :
ldapSearchFitier String (zAMAccountName={0%) The LDAP search filter to use during user authentication 28
IdapSearchSubTree Boolean true LDAP search sub tree flag, or perform single level search if false. =_' :
ldapServerPazsword Password The password for the user defined in ‘ldapServerUser' @A &
IdapServerUrl String Idap:/127.0.0.1;389 The URL of the LDAP server =_' :
ldapServerUser String The user DM that will be used when contacting the LDAP server @A &
IdapUserDnTemplate String {0} The LDAP User Distinguished Name (DM) Template for user authentication =_' :
m Close

The list of LDAP authentication parameters

You will need to adjust the parameters to suit the LDAP directory you are using. Apart from connection parameters, there are also several parameters named
"ldapAttribute*'. These parameters are used to load information about the user from the LDAP directory. Basic attributes are user name, first name, last
name, email address and mobile phone number. The set of groups a user belongs to can also be retrieved by using the "ldapAttributeGroups" attribute.
These groups are used by TM to determine form access, in addition to group membership in TM.
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In addition, you can retrieve custom attributes and store them in the user profile by using the "IdapAttriutesProfileMapping”. The format you need to follow is:
[LDAP attribute name 1]=[user property name 1]; [LDAP attribute name 2]=[user property name 2]
For example country=Nationality; ssn=Social Security Number

When the user is authenticated, these attributes will be retrieved and mapped into the user record maintained in TM. If you map values into the user profile,
these values can be prefilled into forms.

Always make sure to test LDAP authentication after making any changes. TM provides a test harness you can use to test the current configuration (see the
following section).

Testing LDAP authentication
TM allows you to test your LDAP configuration. Edit the LDAP authentication provider you are using and switch to the "LDAP Test" tab.
LDAP Authenticator Authentication Provider

tHome Dashboard » Securty Managers » Securfty Manager » Authentication Provider

LOWAP Usar Authentication Faiied

Authentication Provder | Parameters | LDAP Test

Portal”  Fnance Comoration = | &
Username®  testuger @
Fassword® ssssEsssssss @

Al Atirbutes. [~ @

BadCredentialsException : Bad oedentials

LOMP Resulls

Lookup User Authenticate Liaar Add User To Poral Close

Testing LDAP authentication

Select the space you want to test against and enter the user name of the user.

You can either look up a user, authenticate a user or add a user to the space. Depending on what you want to do, you'll need to fill in different fields.

You need to enter the user's password if testing user authentication.

You can tick "All Attributes" if you want to do a lookup and would like to see all user attributes, not just the ones for which you've defined mappings.

Finally, click the appropriate button to perform the test. The authentication provider will contact the LDAP directory using the currently configured parameters
and perform the desired operations. The results will be displayed in the "LDAP Results" field. If the invocation is not successful, you may have to adjust the
LDAP parameters as described in the previous section and try again.

Using LDAP groups in TM

In TM, form work groups can be defined to control access to forms in a sophisticated manner (for example, you can define a form work group whose users
can see submissions completed by other users in the group). Users must belong to a form work group to gain access to the associated forms. For local
users, this is achieved by assigning the users to the form work group via the TM management console. While this is also possible for externally managed
users (e.g. LDAP), it is impractical because LDAP user accounts for external users are created on the fly, i.e. when they first log in.

To enable you to maintain group associations in the LDAP directory (or re-use existing LDAP groups for form access purposes), TM can load the groups a
user belongs to from the LDAP directory at login time. Whenever the user subsequently attempts to access a form belonging to a form work group, the
groups loaded from the LDAP directory are searched and access is granted if a group with the same name (after processing) is found.

The way TM loads the group associations from the LDAP directory and parses out group names is as follows:

The LDAP authentication provider must have the "ldapAttributeGroups" parameter set to the name of an attribute (e.g. "memberOf"). When the user record is
retrieved from LDAP, all values for this attribute are loaded and each of them is parsed for a group name as follows: Simple strings (e.g. "mygroup" or
"Human Resources") are left as is, and will be compared to group names in TM directly. For distinguished names (DNs), only the first element (usually the
CN) is used; for example, if the group name in LDAP is "CN=mygroup,OU=Distribution Groups,0OU=MyBusiness,DC=mycompany", the resulting group name
after parsing would be "mygroup”.

Can | integrate TM with my existing SSO system?

Transaction Manager forms are often integrated with an existing web site or web application. In many cases, a user logs into the existing web application,
and it is undesirable to force them to log in a second time into Transaction Manager when they need to fill in a form. To avoid signing in twice, a technique
known as Single Sign On can be used. The idea is that once a user has logged in to one application, they are "pre-authenticated" for all applications,
including Transaction Manager.

Transaction Manager allows you to integrate with your SSO system of choice by providing a customizable SSO security manager. You can customize its
authentication logic via Groovy scripts.

Configuring an SSO security manager

TM includes a configurable SSO security manager named "SSO Security Manager". To customize it, go to "System > Security Managers" and edit the SSO
security manager.
You can provide custom Groovy scripts for three extension points:

® Get SSO authentication token ("SSO Auth Filter" tab) This script creates or loads an SSO authentication token from the user request. If the user is
not yet authenticated, it can elect to redirect the user to an external login site.

® Authenticate (authentication provider parameter) The SSO authentication provider performs authentication based on the SSO token. The scripts can
throw various exceptions to communicate to TM that login was unsuccessful.
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® Authentication OK response ("SSO Auth Filter" tab) After authentication has succeeded, another script is called to perform optional processing
steps.

Please refer to the TM Groovy services guide ("System > Groovy Services Guide") for more information on these extension points.

How can | verify email addresses for new users?

An email verification step is often part of the user registration step for secure systems. Transaction Manager supports email verification for self-registered
user accounts. If configured, users will be directed to a separate page after submission, notifying them that they need to click on a link in an email sent to

them.
To enable email verification for a space, you need to reconfigure the security manager used by the space. The user enrollment service also contains a

number of other useful settings around user registration.
Important note: A security manager may be used by multiple spaces. When you make changes to the configuration, make sure you understand which

spaces this will affect to avoid unintentional side effects.
To find out which security manager is associated with your space, go to "System > Modules" or "Forms > Form Spaces" in the TM management console and

edit the space.

Maguire
Home Dashboard » Spaces » Module

Space | Properties | Pages | Resources | Forms I Organizations | Status. | PDF Offiine Submission Form

Name*  Maguire
Context Path™ https:/Am test1.avoka.com/maguire/ 7]
Description Maguire Service Portal
Security Manager = Local Security Manager :I @

Content Editable ¥ @
Default Forms Portal [V @

Save Close

Finding out the security manager for a space
The security manager is displayed in the "Security Manager" dropdown. If nothing is selected, the space is using the system default security manager.

To modify the email verification settings, go to "Security > Security Managers". Find the security manager configured for the space (or if none was selected,
the security manager with a tick in the "Default" column) and edit it. Switch to the "User Enrolment"” tab.
Section "User Email Address Verification” related to email verification (see image below). Note: This section is enabled only if "Enable User Creation" is
ticked.

Edit Security Manager

Heeme Dashbeard + Sscurty Managers b Securly Manager

Security Wanager | Portals I Authentication Providers S50 Awth Fiber | User Enroliment I Passwords

Enabis User Craation [ @
Enable User Self-Registration [ &

reCAPTCHA Account Creation Frotection
Use reCAPTCHA [ @

relAPTCHA Private Key  GLI-BISAARAAG Twidds-By 2TRBE2PagMNBzk Tou
reCAPTCHA Public Key  BLI-BISAARAAGE09IUCHZgul TEHoeveguG 50

User Email Address Verification
Enabie Emai Verification [~ @

Max Days to Veridy | 1 x| &

Ermai Verification Subject  Transaction Manager: Email Address Verfication @

ullHame

Dear §{userdccount
You qua nfirm your amail address hera: <br/><br/>

talMama}. Plaase
EificatienUel]</a> <br/ <k

Ermai Verfication Message

w

Email verification settings in the security manager
Tick "Enable Email Verification" to enable an email verification step at account registration time.

Choose the time in days the user has to complete email verification from the "Max Days to Verify" dropdown. If the user does not complete email verification
within that period, their account may be purged by TM.

Finally, you can configure the verification email that will be sent to the user. You can edit the "Email Verification Subject" and "Email Verification Message"
fields to customize the email.

The Velocity variables you can use in the email subject and body are as follows:

® userAccount Has five properties describing the user: "loginName", the login name of the new user account; "fullName", the full name of the user;
"givenName", the given name of the user; "familyName", the family name of the user; "email", the email address of the user.

® verificationUrl The URL the user will have to access to complete email verification. Make sure this is contained in the email body; otherwise users
won't be able to pass email verification.

® portalName The name of the user space that the user self-registered on.

® portalHref The base URL of the user space that the user self-registered on.
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Values for these variables are automatically provided by TM. An example email body template might be:

"Dear ${userAccount.fullName}, <br/><br/>You have requested a user account on ${portalName}. Please confirm your email address here: <br/><br/><a
href="${verificationUrl}">${verificationUrl}</a> <br/><br/>Thank you."

Once you have configured email verification, test user enroliment by registering a user on the user space(s) you modified.

How do | include a form in my web CMS using the Web Plugin?

After form submission, how do | redirect a user to a different page in my web
CMS?

How do | prefill user details in a form on the Web Plugin?
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Prefill (Manager v5.0)

Prefilling a form, usually with information that can be obtained about the user, is a highly desirable feature for most organizations. It reduces the effort
required by the user at the same time as improving data quality. There are a number of ways that prefill can be implemented.

What prefill options does TM support?

Form prefill is a crucial capability for SmartForms, and there are many possible ways to obtain prefill data (web services, HTTP request parameters and
many others). To give you maximum flexibility, Transaction Manager supports a wide range of prefill options.

This section gives an overview of the prefill capabilities provided in Transaction Manager. The next section talks about how prefill happens and how multiple
ways to obtain prefill data might be combined.

There are 4 different prefill methods supported in TM:

® Seed file This is the simplest form of prefill - it is really just directly modifying the seed XML file. Usually this is used only for simple testing purposes.

® Property prefill This maps a property value defined in TM into a field on the form. TM properties can be maintained by TM administrators
(organization and form version properties) and space users themselves (user profile properties). Examples would be an interest rate table which
needs to be updated on a weekly basis without changing the form design, or information about the user that is being maintained in their TM user
profile.

® Request parameter prefill This approach can be used when the form is invoked from an external web site, passing through some information in the
URL that should be displayed in the form. A Transaction Manager administrator would configure the mapping from the URL parameter to a field in
the form. Apart from request parameters, session attributes and cookie values can also be used to pass prefill data. Example: A URL that contains
the user's client number.

® Service-based prefill This is the most flexible prefill method where a TM service definition is used to obtain prefill XML data, which is then mapped
into the form. Depending on the service implementation, prefill data can be obtained from external services (e.g. web services). By default, TM
provides three implementations: a web service prefill service, a prefill service calling an Adobe LiveCycle process and a Groovy prefill service, which
is based on a Groovy script that can be adjusted at runtime. Example: The client-number passed in the Request Parameter is passed as a
parameter to a web service that has been exposed in the organization's CRM system. This web service returns an XML document that represents
information about the client with that client-number. This data is mapped to fields in the form.

The following sections describe how these prefill methods are applied when the form is rendered, and talk about how to configure each method in greater
detail.

What prefill options are available on the TransactField App?

Forms rendered on the TransactField App can mostly be prefilled like other forms, but there are some restrictions and caveats as follows:

Because TransactField App forms are filled in using a dedicated client application instead of as part of a browser session, request parameter prefill is not
available, since there is no referring page to set these values.

In addition, forms synchronized down to the TransactField App receive a seed file that has most forms of prefill already applied to it (this is necessary
because the TransactField App client, unlike other user spaces, does not have access to Transaction Manager entities such as property values and service
definitions). This means that property values are written to the seed file at synchronization time as opposed to at render time, and service-based prefill is also
done at synchronization time. User property prefill is done by the TransactField App at render time, using the user profile stored in the TransactField App
(which is also synchronized with TM).

How does the prefill and rendering pipeline work?

Before the form is rendered, the various prefill methods are applied in the following order:

. Seed file

. Property prefill (organization, form)
. Request parameter prefill

. Property prefill (user profile)

. Service-based prefill

O wWNE

Note that while the prefill methods can be combined, prefill data obtained in later stages may overwrite prefill data from earlier stages if multiple mappings to
the same form field exist. For each form version, only one prefill service definition can be used for service-based prefill at the same time.
Please read on to learn how to configure individual prefill methods for a form.

How can | configure seed file prefill?

Transaction Manager provides an XML seed file that is used as the basis for the XML payload. Composer will generate a default seed file which contains the
structure of the seed file, with no data.
You may edit and change the seed file used for a particular form in Transaction Manager. To edit the seed file for a form, edit the form in the TM

management console, switch to the "Form Versions" tab and click on the "Form Data Configuration" icon ( = ) for the current version. Switch to the "Form
XML Data" tab, where you can edit the seed file or upload a new seed file.
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Basic Form - HTML - Version 1.0 - Form Data Config

Home Dashboard » Forms » Form » Form Data Config

Configuration Mapping I Form XML Data I Property Prefill Mapping | Request Param Prefill Mapping Input XML Prefil Mapping I Submission Data Extracts

Form XML Data provides the seed XML data used to prefil the form with.

" encoding="UTF-8"7?><Ax

Form XML Data

edFlag>true</EnabledFlag>

Form XML File Name formseed x

Form XML Data Fie Browse | @
=

Changing the XML seed file for a form version

To apply seed file prefill, you can simply fill in values for some elements (as shown in the screenshot above) and save your changes. Render the form to test
the new seed file.

Make sure to use seed file prefill carefully and reset the seed file when you are done to avoid accidental use of test data. Also, be extremely careful when
changing values in the "SystemProfile" section. This section is used by Transaction Manager to store important information about the form, and the form may
fail to render or submit if the system profile is modified. No prefill values should be entered into the system profile unless absolutely necessary.

Note: Seed file prefill uses hard coded data. It is generally only used in form testing.

How can | configure property prefill?

Property prefill is used to prefill property values maintained in Transaction Manager into fields on the form. Properties can be declared on one of three levels:
Organization, where every form belonging to the organization will inherit a snapshot of the organization properties; form, where every form version can define
its own property value; and user, where properties are maintained as part of the user profile and can be edited directly by space users.

Adding TM property types

To view and add to the set of property types set up in Transaction Manager, go to "Forms > Property Types". You will see the set of property types that are
currently set up, along with their scope.
To add a property type, click "New". The screenshot below shows an example.

Edit Property Type

Home = Property Types = Property Type

Name* Occupation

Description
Organisation :I
Scope® User LI

Data Type*  String ;I

Read Only [

Save Close

Creating a user property type

Fill in a unique name for the property.

Choose the appropriate scope from the "Scope" dropdown ("Client" for properties that should be set on an organization level, "Form" for properties where
values are specific to each form version, and "User" for properties exposed in the space user profile).

Choose the appropriate data type and save.

Ensure there is a property type for each property you would like to map into the form for prefill.

Setting organization and form property values
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After you have created your set of property types, you need to define the prefill data values for your form(s) by assigning values to these properties.

To understand how property values are maintained, it is important that you are aware of the form versioning system used in Transaction Manager. As it aims
to preserve a form version independently, most of the data that affects a form version is stored along with the form version entity. This is normally
straightforward, because much of the configuration is done on the form version level anyway. However, there are exceptions, and organization property
values are among these. While properties with a scope of "Client" are set on the organization level, each form version contains a copy of the set of
organization property values, which are initialized with the current property values configured for the organization when the form version is created.

This means that once a form version exists, changes to organization property values do not automatically affect the form version. Therefore, if you would like
to change an organization property value used by a form, you have two options:

1. Modify the property value on the organization level and then synchronize the organization property values stored for your template
version. This approach is appropriate if the change should be applied for new form versions as well. For example, if an organization's website URL
changes, you would want to change the value of the organization property to the new URL, and then apply this change to all form versions that use
the URL. To use this approach, edit your organization and switch to the "Properties” tab. Add a new property value if none exists, or edit the existing
value for the property type in question. Afterwards, edit your form, switch to the "Form Versions" tab and edit the current version. Switch to the
"Properties” tab. You can either click "Sync Org Properties” to reload all organization properties from the organization configuration, or if you want to
modify only one organization property value, simply edit the existing value or create a new value by clicking "New" and selecting the same property
type.

2. Edit the property value stored for the form version, leaving the organization property value unchanged. This approach is appropriate if the
new value needs to be overwritten just for this one form version. For example, if the support phone number is configured as an organization
property and is consistent for all forms but one, you can simply edit the form version and modify the phone number for just this form version. Newly
created forms would still be initialized with the globally defined support phone number. Note: If you find that many forms need to overwrite an
organization level property, you should consider using a property of scope "Form" instead. To use this approach, edit your form, switch to the "Form
Versions" tab and edit the current version. Switch to the "Properties” tab. Edit the existing value for the property type or create a new value by
clicking "New" and selecting the desired property type.

If you create a new form, the organization property values will be copied from the current organization configuration. If you create a new form version for an
existing form, all property values (scopes "Client" and "Form") are copied from the previous form version.

Define property prefill mappings

To map TM properties to fields in your form, edit the form and switch to the "Form Versions" tab. Click on the "Form Data Configuration" icon ( = ) for the
current version and switch to the "Property Prefill Mapping" tab. Click "Edit" to access the mapping page (see screenshot below).

Form Prefill Property Mapping: twsf-ltc34 Schema 1

Property Name Scope Form Data XPath Target: Form Data XML
Additional Services Clent - v Common =
Email User k:} » PaymentDetails
Email Form Receipt Message Chent » ClientProfie
Email Form Receipt Subject Clent v UserProfie
Email Saved Form Message Clent » Business
Email Saved Form Subject Chent v ConiactDetais
Email Sender Address Chent Emai
Family Name User iiCommon/UserProfiendividualFamilyName HomePhoneNumber
Form Description Form Faxhumber
Form Eligibility Form WMobieNumber
Form Expired Message Form » Address
Form Name Form WerkPhoneNumber
Form Requirements Form — ¥ Individual
Form Terms And Conditions Form Salutation
Given Name User fiCommon/UserProfleindividuakGivenName GivenName
HTML Confirmation Page Farm KiddleName
HTML Landing Page Form FamityName
HTWL Saved Page Form JobTile
HTHL Terms And Condiions Page Form » Accounts
Length Test Chant el » SystemProfie
= » Attachments
Property Scope — I Current XPath R ]

Save Close |

Configuring property prefill mappings

All available properties are shown on the left (whether or not a value is assigned to them). To map a property to a form field, expand the nodes representing
the seed file structure on the right to find the location you want to map to, and drag a node into the "Form Data XPath" column next to the property. The
XPath of the node should be filled in automatically when you release the node.

Create mappings for all properties you would like to use for prefill, then save your changes.

When a form is rendered, the current set of property values defined for the form version and the set of user properties (if the user is logged in) are retrieved,
and are prefilled into the seed file according to the mappings.

How can | configure request parameter prefill?

Request parameter prefill is used to map prefill data provided in the HTTP request, session or cookies into fields on the form. In addition, you can pass in a
request parameter named "jsonPrefillData", which should be set to a JSON string containing the map of prefill parameters as name-value pairs.
To set up request parameter prefill mappings for a form version, edit the form and switch to the "Form Versions" tab. Click on the "Form Data Configuration"

icon ( = ) for the current version and switch to the "Request Param Prefill Mapping" tab. You will see the list of request parameter prefill mappings currently
defined for the form version (see screenshot below for an example).
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Edit Form Data Config - Wet Signature Form 1.0

Home > Forms = Form = Form Crata Config

[Form Data Definition I Form XML Data l System Config Mapping l Property Prefill Mapping Request Param Prefill Mapping [ Input XML Prefil Mapping l Submission Data Extracts

Request Param Prefll Mappings are used to map request jsonPrefilData, request URL parameters, cookle values, session valies into the form XML data model when the form ie rendered.
This feature is supported in the Self Service Portal and Web Plug-in.

Parameter Name Form XPath Action
userFamilyh HUserProfieind B

userGivenName HUserProfieindividualGivenName [ 5

o -

The set of request parameter prefill mappings for a form version
To add a request parameter prefill mapping, click "New".

Edit Prefill Data Parameter XPath Map

Home = Forms > Form = Form Data Config = Prefil Data Parameter XPath Map

Parameter Name *  application Type 2]

Form XPath*  //FormData/ApplicationType 7]

Save Close

Setting up a request parameter prefill mapping

Enter the name of the parameter containing the prefill data into the "Parameter Name" field. When the form is rendered, TM will search the set of HTTP
session attributes, cookies, request parameters and the special request parameter "jsonPrefillData" for an entry with this name in this order. If a match is
found, the value of the entity will be used as the prefill data. If multiple matches are found, the later entry takes precedence (e.g. request parameters over
session attributes).

Enter the XPath to the element associated with the target form field into the "Form XPath" field. If prefill data exists, TM will write the value to the XPath
specified. If specifying a potentially ambiguous XPath (e.g. using "//"), make sure it is specific enough to resolve to the correct element. If you enter an XPath
that does not resolve to a node in the current seed file, you will not be able to save the mapping.

Save the request parameter prefill mapping. The change will take effect immediately.

Simple request parameter prefill example

Edit a test form and set up two property prefill mappings from "userGivenName" to a field in your form, e.g. "//UserProfile/Individual/GivenName", and from
"userFamilyName" to another form element. Choose elements that will be displayed when the form opens.

Access your form via the landing page, e.g. https://tmserver.com/govassist/landing.htm?formCode=testform and add a given and family name parameter to
the URL: https://tmserver.com/govassist/landing.htm?formCode=testform&userGivenName=Jane&userFamilyName=Doe

Access the new URL and continue to the form. You should see the given and family name populated according to the mappings you defined.

3 Finance Homeowners Insurance Quote

€ £ Corporation

Menu Applicant Information
Applicant Information

Applicant
Occupants
Residence Applicant First Name Applicant last Name

Jane Doe
Extra Coverage
Discounts Email Address Phone Number
-

Submit Poelicy =l

Social Security Number Date of Birth

Address

Address Line 1

Address Line 2

City State Zipcode

=

A form prefilled using request parameters

Keep in mind that you can also pass data as session attributes and cookie values instead of request parameters.

How can | configure service-based prefill?

Service-based prefill utilizes a service definition set up in Transaction Manager to obtain XML prefill data, which is then mapped into the seed file or even
directly used as the seed file. The service definition encapsulates the logic used to obtain the XML prefill data. Therefore, this is the prefill method of choice
when integration with third party systems is required for prefill and it is not practical to use request parameter prefill.

Note: For security reasons, XML prefill is disabled by default. It can be enabled by setting the space property "Allow XML Request Param Form Prefill" to
"true".

Transaction Manager provides two prefill service definitions out of the box: A service that invokes an Adobe LiveCycle process to obtain prefill data; and a
service that executes custom Groovy code (which itself can call web services or access other sources of prefill data), which can be customized at runtime.
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Additional service definitions with custom implementations can be added; please contact Avoka for more details.
The following sections explain how to configure the prefill service definitions, how to define the mappings from the prefill XML data into the form and how to
configure a form version to use a specific prefill service.

Configuring the client web service prefill service

The client web service prefill service connects to a web service to obtain prefill data. The web service must conform to the Forms Client web service API

specified in the Transaction Manager Web Service Guide. If you need to call a web service that does not conform to this API, you may be able to use the
Groovy prefill service to accomplish this.

To configure the client web service prefill service, log in to the TM management console and go to "System > Service Definitions". Filter the list of service
definitions by service type "Form Prefill" and edit the service named “Client WebService Form Prefill". Switch to the "Service Parameters" tab.

Edit the "webServiceAddress" parameter and enter the URL of the Forms Client web service endpoint that shall be used to obtain prefill data.

Edit Service Parameter - webServiceAddress (Client WebService Form Prefill)
Home Dashboard = Service Definitions = Service Defintion = Service Paramater

Name  webService Address
Description  The URL of the endpoint hosting the Foms Clent web service

heep://afm-prefill-hoac/afia/fesarvices/FormaClientlebService

Walue

Bind Parameter [

Save Close

Configuring the URL of the Forms Client web service endpoint
Save your changes and configure your form(s) to use the client web service prefill service as described in "Configuring the prefill service for a form version".

Configuring the LiveCycle process prefill service

The LiveCycle process prefill service calls an Adobe LiveCycle process to obtain XML prefill data.
The input parameters passed to the process are as follows:

clientCode The organization code of the organization associated with the form.

formCode The form code of the form.

requestLocale The locale specified in the HTTP servlet request.

requestHeaders The HTTP servlet request headers.

requestParams The HTTP servlet request parameters.

sessionAttributes The HTTP session attributes.

seedXml The seed file XML content.

userAgent The value of the "user-agent" header in the HTTP servlet request.

userLogin The login name of the current user as provided by the space's authentication service. May be empty if user is not logged in.
userKey The user key (a UUID) stored for the user, if they are logged in using an TM user account.
userEmail The email address stored for the user, if they are logged in using an TM user account.

The output parameter containing the XML prefill data string is "prefillXml".

The LCA file supplied with TM contains a prefill process that you can use, or you can provide your own process. To configure the process used by the
LiveCycle prefill service, go to "System > Service Definitions" and find the service definition named "LiveCycle Process Form Prefill". Edit the service
definition and switch to the "Service Parameters" tab.

Edit Service Definition - LiveCycle Process Form Prefill

Home > Service Definitions > Service Definition

Service Definition I Service Parameters |

Hame Type Value Description Bind Parameter Action

processName String  FormCenter/Processes/FormPrefil  The name of the LiveCycle form prefill process v 28

Configuring the LiveCycle process prefill service
Edit the "processName" parameter and enter the desired process name. Save your changes.
Ensure the process you are calling is deployed to the LiveCycle instance(s) used by Transaction Manager.

Configuring the Groovy prefill service

The Groovy prefill service allows you to define and change the logic by which prefill data is obtained at runtime, by modifying a Groovy script exposed as a
service parameter. You can define multiple Groovy prefill services with different implementations. This can be very useful when integrating with other
systems.
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This section assumes you want to add a new Groovy prefill service and preserve existing services. If you just want to edit an existing service, skip the step to
create a service definition and just edit the desired service directly.

To configure a new Groovy prefill service based on an existing one, go to "System > Service Definitions" in the management console and click "New Groovy
Service".

Select "Form Prefill" from the "Service Type" dropdown.
Enter a name for the new service into the "Service Name" field and save (the screenshot below shows an example).

New Groovy Service
Home Dashboard » Service Definitions » New Groovy Service

Service Type™  Form Prefill =@

Service Name* My Groowy Form Prefil 9
m Cancel

Creating a new Groovy prefill service based on a template

This will create a new Groovy prefill service based on a template defined in Transaction Manager. You can now customize the new service by editing it and
switching to the "Service Parameters" tab.

Edit Service Definition - My Groovy Form Prefill

Home > Service Parameter > Service Definition

Service Definition Service Parameters Test Service

Name Type Value  Description Bind Parameter Action

groovyScript Groovy Script The Groovy Script content to execute v z f
myCustomParameter String myValue @ &
useModuleClassLoader Boolean false Specify whether to use module classloader J =)] “V=‘

o -

The service parameters for a Groovy prefill service
Customize the "groovyScript" parameter with Groovy code to obtain prefill data (e.g. call a web service). The parameters provided to the script are as follows:

® userAccountld The login name of the current user, as provided by the space's authentication service. Can be empty for anonymous users.

form The form entity for which to obtain prefill data.

formRequestParams The contents of the session attribute "FormRequestParams”. This is a Map<String, Object> which is generally populated by
the landing page and contains the request parameters that were passed to the landing page..

request The HTTP servlet request instance.

schemaSeed The form seed file XML document.

serviceDefinition The Groovy prefill service definition entity.

serviceParameters A Map<String, String> of the service parameters for the Groovy service definition.

The script should return a String containing the XML prefill data.
You can add custom service parameters that your Groovy script can reference. If you do so, make sure to untick the "Bind Parameter" checkbox when you

create the parameter (the "Bind Parameter" checkbox should be set only for service parameters where the service class has a named getter and setter for a
parameter with the same name.

Adding prefill mappings

There are two ways that prefill services can be used: They can either return an XML file with prefill data, which is then populated into the form via explicitly
defined mappings (as described in this section); alternatively, the prefill service can return the modified seed file directly. Transaction Manager will assume
that the returned XML represent the seed file if no XML prefill mappings are defined for the form; otherwise, TM will treat the XML returned by the service as
prefill XML data, and the seed file will be prefilled according to the XML prefill mappings.

Using prefill mappings and returning XML prefill data introduces an additional level of indirection. This gives you greater flexibility, allows you to reuse prefill
services across different forms and allows you to make changes to the mappings at any time.

To define XML prefill mappings for your forms, you need a template XML file for your prefill data (the structure must match, but actual prefill content is not
needed in the sample).

Once you have the sample XML file, edit your form in the TM management console, switch to the "Form Versions" tab and edit the form data configuration for

the current version ( = icon). Switch to the "Input XML Prefill Mapping" tab.
Click on "New Input XML". Upload your sample prefill XML file and save.
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Edit XML Input Version

Home = Forms = Form = Form Data Config = XML Input Version

Version Name ® | Simple Test Form - HTML Schema 2

Test Prefill XML
Upload Test Prefil File |C\Avoka TestCases'templates uml-prefill xml Browse.. I
Save Close

Uploading the XML file containing the prefill data structure
After uploading the prefill XML file, you can add mappings from the prefill data into the form. To do this, click "Edit XML Mapping" on the "Input Prefill XML
Mapping" tab.

Form Prefill Data XML Mapping: Simple Test Form - HTML Schema 2

Source: Prefill Data XML Prefill Data XPath Form Data XPath Target: Form Data XML
¥ client-account ficlient-account/frst-name {Mnstructions/Customerdetais/Givennames v SFMData
first-name iiclient-accountisurname . » SystemProfile
surname k{) v ChentProfile
» Fees
¥ Signatures

SignatureTypeSelected
¥ Instructions
» _ouierdres
v Customerdetails
Givennames

Familyname

Save Close

Creating XML prefill mappings

You will see the structure of the XML prefill file on the left, and the structure of the form's seed file on the right.

The middle area displays existing mappings and allows you to define new ones. Simply drag and drop elements from the "Prefill Data XML" area into a new
row under "Prefill Data XPath", and drag and drop the target element in the seed file to the same row under "Form Data XPath". The screenshot above
shows the "Familyname" element being dragged into place.

Create a mapping for each element from the prefill data that you want to populate into the form. When you are done, save your changes.

Configuring the prefill service for a form version

To configure a form for service-based prefill, edit the form and switch to the "Form Versions" tab. Edit the current version and switch to the "Services" tab.
Select the desired prefill service from the "Form Prefill Data Service" dropdown and save.
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Basic Form - HTML - Version 1.0

Home Dashboard » Forms » Form » Form Version

Form Version | Properties | Aftachments | Services | Form Tags Composer Info ‘

Form Prefil Data Service |

LU EREE el Cliert Web Service Form Prefill

Eror Form Prefil A

Receipt Render Service | Groovy Form Prefill (7]
LiveCycle Process Form Prefill

eSignature Render Service ;l @
Form Submission Preprocessor :I L7
Form Saved Processor ;I @
Submission Completed Processor :l L7 ]
Form Export Service =le
Task Expiry Process ll 9

Configuring service-based prefill for a form version

How can | see what data was passed into the form?

To see the data that was passed into the form, you can inspect the submission in TM. Transaction Manager creates a submission object as soon as the form
is opened, and adds a submission history entry containing the data that was passed into the form.

Once the user submits or saves the form, you can find the submission in the TM submission log ("Operations > Form Transactions"). View submission details
and switch to the "History" tab.

Transaction Details
Home Dashboard » Form Transactions » Transaction Detais

Tr Detais ] 1 Status | Request | History ] Form XML Data | Processing Status |

Form . . Time to User's 08/

Version Time  Portal User IP Address Form XML Hash (SHA256)

DR BCNAGE e
Form 1.0 20 Apr  Maguire - Windows 7/ 114.141.100.87 3cledcl43aed0788096283c245464ee20b5ecdd510bTECd0214f7T4c1 c4afETIT ; @
Opened 13:38 Firefox 28
— - ——— — — —

Form 1.0 20 Apr  Maguire 1 minute, 39 Windows 7/ 114.141.100.97 974cbd3022800131006072d9%eafBe2eciaedT2cdb105c300T4b580041%9e3T1d =
Submitted 13:40 seconds Firefox 28 o

Viewing data passed into a form at render time
Find the entry with a form status of "Form Opened" (there could in theory be multiple such entries if the user saved and reopened the form multiple times).

Use the "View XML" (
seed file.

) link next to the submission history entry to see the XML data passed in. This includes all prefill data that was mapped into the
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Form Display and Layout (Manager v5.0)

Due to the multitude of devices users employ to fill in online forms, there are a multitude of considerations around form display on screens of various sizes
and varying user input and output modalities. Transaction Manager provides responsive spaces and multiple options to control form display and layout.
Composer forms likewise support responsive layout for various device types.

What options do | have around form display inside the page?

For each form, you can choose from three display modes: direct render, embed with div and embed with iFrame.
XXX what are the caveats and recommendations?
To change the display mode for a form, edit the form and switch to the "Flow Config" tab. Choose the desired display mode from the "Form Display Mode"
dropdown (see screenshot below) and save your changes.
Attendee Registration - HTML [with PDF receipt]

Home Dashboard » Forms » Form

Dashboard | Detals | Flow Config | Emsi Verification | FormVersions | PageTracking | Portalaccess | GroupAccess | FormPromotion | Deployment Scheduie

Configure the User Flow options for the form.

Show Landing Page ¥ @

User Authentication =@

Save Online | Authenticated Only x| &
Show Terms & Conditions [~ @

Form Display Mode = Embed with IFrame ;I ]

. . Direct Render
Form Signature Required Embed with D

Show Confirmation Page
Show PDF Receipts [V @

Form Page Close

Choosing the display mode for a form
Make sure the form renders correctly on all target browsers and devices.

Can | show the side panel during form fill-in?

The TM user spaces generally support a side panel displaying additional information about the organization and/or the form (such as logo, link to the web
page or additional information). The screenshot below shows an example sidebar on a space page (the sidebar content can be adjusted at runtime).

GovAssist

SmartForm Demonstration

Showing the benefits of Avoka Transact with Adobe LiveCycle PDF Forms. This example demonstrates:

* Landing Page Content - rich form landing page content

* Online Payments - which supports business rule drive form online payments
+ Local PDF Save - which enables user to save their Reader Extended PDF form locally Q: k’

W Form Eligibility

OretiaiiesDiakion Ut enim ad minim veniam, quis nostrud exercitation ullamco laboris
nisi ut aliquip ex ea commodo consequat Administrative Services

Login and Open Form

Login and then open a new form Requirements

Duis aute rure dolor in reprehenderit in voluptate velit esse cillum
dolore eu fugiat ulla pariatur. Excepteur sint occaecat cupidatat non
proident, sunt in culpa qui officia deserunt mollit anim id est If you would like more

Website:
hitp/iwww.usda.gow/

laborum information please contact
us via:

s Telephone: 1800 123
400

= Web: Administrative
Services

* Email
contact@ervices.gov

tUs | Careers Security & Legal | Report Email Fraud | Siemap Diversity & Accessibilty Powered By Avoka Transact

The sidebar (highlighted in red)

By detault, this panel is not shown while the user is filling in the form to provide the maximum possible amount of screen real estate to the form and avoid
distracting the user. However, you can override this setting for each form and show the side panel throughout the form fill-in process. This is supported only
for HTML forms on responsive spaces. If enabled, the sidebar will behave responsively as on all other space pages and will be hidden on small screens.
To enable the side panel for a form, edit the form's current version and switch to the "Properties” tab. Add a property of property type "Form Show Side
Panel" and set the value to "true" (see screenshot below). Save the property to apply the change.
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Edit Version Property

Home Dashboard » Forms » Form » Form Version » Version Property

Name  Form Show Side Panel

Property Type | Form Show Side Panel - (Fom Scope)
DataType* | Boolean x|
vaue* | tue x|

23 oo

Enabling the side panel for a form version




Dynamic Data Retrieval (Manager v5.0)

While a user is filling in the form, the form may want to retrieve data on the fly to respond to a user's selections (for example address lookups or availability
checks). It is not always feasible to prefill all data the form might need; instead it is better if the form simply could look up the data that is needed. Transaction
Manager exposes endpoints for the form to call, and routes the call on to a configurable service definition that will perform the data lookup. The results
returned by the service are passed back into the form.

Composer includes widgets for making dynamic data calls and populating the results into your form.

This section covers common questions around dynamic data retrieval.

How can my form retrieve data from external sources at runtime?

Your form can dynamically call Transaction Manager to obtain data at runtime. Transaction Manager will route the request to a service definition you provide,
which will handle the request and pass result data back. Your form can then handle the result. HTML forms can call a servlet to obtain dynamic data,
whereas PDF forms make a web service call. The URL of the TM endpoint is automatically populated into the system profile.

Note: Dynamic data retrieval works only if the form is online and has connectivity to the TM server. Dynamic data retrieval is not available for PDF forms that
have been saved offline and will not work on TransactField App forms if connectivity is lost.

If you would like to implement dynamic data retrieval, there are two implementation steps:

® Provide the logic to handle a dynamic data request as a Transaction Manager service definition
® Enhance your form to make a dynamic data call with the appropriate input parameters, and handle the output as well as any errors that might occur.

Configuring a dynamic data service in TM

Dynamic data services in TM are configured as service definitions of type "Dynamic Data". The logic to retrieve data based on the input parameters provided
by the form is encapsulated in a configurable Groovy script. You can maintain multiple dynamic data services in your Transaction Manager system, and each
of them can be reused by multiple forms.

This section assumes you want to add a new Groovy dynamic data service and preserve existing services. If you just want to edit an existing service, skip
the step to create a service definition and just edit the desired service directly.

To configure a new Groovy dynamic data service based on an existing one, go to "System > Service Definitions" in the management console and click "New".
Select "Dynamic Data" from the "Service Type" dropdown.

Select one of the templates from the "Service Template" dropdown (depending on your server, there may be one or more to choose from).

Enter a name for the new service into the "Service Name" field and save (the screenshot below shows an example).

New Service

Home Dashboard » Service Definitions » New Service

Create a new Service based an a Service Template.

Service Type  Dynamic Data
Service Template* Groovy Dynamic Data ;I =
Service Name * | My Groovy Dynamic Data o

Organization ;l

Save Cancel

Creating a dynamic data service based on a template
This will create a new Groovy dynamic data service with all the settings and service parameters based on the template you selected. You can now customize
the new service by editing it and switching to the "Service Parameters" tab.

My Groovy Dynamic Data

Home Dashboard » Service Defintions » Service Definition

Service Definition ] Groovy Script ] Service Parameters Test Service
Hame Ly Value Description - Last Modified Action
ype P Parameter
eventLoggingLevel List Warning The service Event Log logging level. v 28 Jul 2015 by A K
lpammer
executionTimeout Number 60000 The GroovyScript execution timeout in milliseconds. o 28 Jul 2015 by A K
lpammer
groovylLoggingEnabled  Boolean true Log Groovy Service cals to the Groovy Log table. . 28 Jul 2015 by A5
lpammer
grodvySeript Groovy I* Provides form lookup form data The Groovy script to be axecuted. The output will bé converted J 28 Jul 2015 by A ’=|
Script service by calling... io a string and streamed back Ipammer
groovyTypeChecked Boolean false Perform Groovy script static type checking. v 28 Jul 2015 by '=_' ﬁ
Ipammer
responseContentType String text/plain The content type that shall be set on the response to the form. v 28 Jul 2015 by "_/' ll__|
Ipammer
testMode Boolean falge if in test mode, most security checks will be skipped v 28 Jul 2015 by @A &
lpammer
xssFikerRequestParams  Boolean false XS5 fiter request parameters for dangerous characters v 28 Jul 2015 by A K
lpammer

Configuring a dynamic data service

You can change several security settings, chief among them the "testMode" parameter, which can be used during development of the service to turn off most
security checks, so you can call the service outside of a form for testing purposes. You can also set the content type of the response that is sent back to the
form.

For debugging purposes, you can change the "eventLoggingLevel" parameter. Depending on the log level, additional information may be logged to the TM
event log.
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The logic to obtain results based on parameters passed through by the form is encapsulated in a Groovy script stored in the "groovyScript" parameter. Edit
the parameter and provide your own Groovy script (which might call a web service or access some other external data source).
The parameters that TM passes to the Groovy script are as follows:

® request The HTTP servlet request. For PDF forms calling the dynamic data web service, the web service input parameter containing a JSON
representation of the input parameters provided by the form, a mock request object is passed in, containing each parameter in the JSON string as a
request parameter.

® form The form entity.

® serviceDefinition The dynamic data service definition entity.

® serviceParameters A Map<String, String> of the service parameters for the dynamic data service definition.

For this example, we will be using the following script:

import wslite.soap.* import net.sf.json.* import net.sf.json.xml.* def cityName = request.getParameter('cityName') def client = new SOAPClient(‘http://www.
webserviceX.NET/uszip.asmx') def response = client.send(SOAPAction:'http://www.webserviceX.NET/GetInfoByCity") { body { GetinfoByCity
('’xmins":'http://www.webserviceX.NET") { USCity(cityName) } } } def root = new XmlSlurper(false,true).parseText(response.text) def dataset = root.**" .findAll{
it.tname() == "NewDataSet" }[0].children(); def result = [] dataset.each { def str = "{" it.childNodes().each { str = str + "${it.name()}' : '${it.text()}," } str = str[0..
-2] + "}" result += new JSONSerializer().toJSON(str) } printin result return result

This service queries the parameter "cityName" passed in by the form, passes it into a city lookup web service operation, and passes back the response as a
JSON string. Because the script is defined as a service parameter in TM, it can be adjusted at any time without requiring a server restart.

Ensure you test your dynamic data service thoroughly. TM allows you to test your service directly - edit the service, turn on test mode by editing the
"testMode" service parameter and switch to the "Test Service" tab.

Edit Service Definition - My Groovy Dynamic Data

Home = Service Definitions > Service Definition

Service Definition | Service Parameters | Test Service |

Portal* | Gov Assist :J

Regquest Parameters = sfmServiceName=My Groovy Dynamic DatadctyName=Boston

Testing a dynamic data service

You can select the space you would like to test on and enter the service parameters in the format "<parameter name>=<parameter value>&<parameter
name 2>=<parameter value 2>" and so on. You must always pass in the name of the service definition you want to call (as the form will have to), but TM pre-
generates this parameter for you. An example for the parameter string would be "sfmServiceName=My Groovy Dynamic
Data&cityName=Boston&mycustomparameter=value".

Click "Test Service" to start a test. The dynamic data servlet for the selected space will be invoked and passed the specified parameters. If all goes well, you
will see the return value provided by your Groovy script displayed in your browser just as they would be returned to the form.

Adding a dynamic data call to a Composer form

This section shows how to add a dynamic data call to a Composer form, assuming a dynamic data service is already set up in Transaction Manager. To
illustrate the steps, we use a simple, publicly available web service to provide the lookup data, which is exposed by a service definition in TM (see previous
section for details of the example). We will use the Dynamic Data Assistant provided by Composer, which will generate a set of input fields, a button to trigger
the lookup and a table to display the results.

Create a new form in Composer or open one of your existing forms. Find the "Dynamic Data Assistant" palette item and drag it onto a section in your form.
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Add A Dynamic Data

@ This wizard will guide you through the process of creating a dynamic data block.

SFM Service Name s US City Lookup

Test Mode

(I}

v/| Generate Test Data (Fake Result JSON Object)

|2

Lookup Button Label  Lookup

Input Block Title  Search for City

Input Block Fields

Name Label Field Type P Add...
cityName City Name Text Field X
Please Select Result Block Type | Table -

Result Block Title  Results

Result Block Fields

MName Label Field Type op Add...
CITY City Text Field F%4
STATE State Text Field j
ZIP ZIP Code Text Field =

Cancel Finish I
| S

| S

The dynamic data assistant

Enter the name of the dynamic data lookup service defined in Transaction Manager, in our case "US City Lookup".

Enter the name of the input block ("Search for City") and add a single input field, a text field named "cityName". Note: You can assign a label for display
purposes, but the field name must match the input parameter expected by the TM service.

Enter the name of the result block, select "Table" as the result block type and add three result block text fields as shown.

Click "Finish". The assistant will create specialized sections performing the lookup. You can customize the styling and arrangement of the elements as well
as the handling of results returned by TM; however, this is beyond the scope of this example.

Now publish the form to the TM instance where your dynamic data service is set up. Render the form, enter search data and click the lookup button. Your
search results should be displayed in the table as in the example screenshot below.

US City Lookup Form

*Js cLoBALcorp

1 City Lookup -

Search for City

City Name
Seattle

Results
City State Zip Code
Seattle WA S3060
Seattle WA 3101
Seattle WA 98102
Seattle WA, 98103
Seattle Wi 98104
Seattle WA, 98105
Seattle WA, 98106
Seattle WA 93107
Seattle WA a8108

The results of a dynamic data call at runtime

Can my form look up and validate an address while the user is entering it?

Avoka Transact provides the capability to use live address lookup and validation using the Mastersoft Harmony Address Lookup service ({+}http://www.
mastersoftgroup.com/hh-fag/+). You can add predefined address lookup widgets to your Composer forms, which will call a dynamic data service during
address lookup to provide users with a list of address suggestions as they type.

This mechanism allows you to add dynamic address lookup to your forms in minutes, without having to do any integration work beyond having your server
added to the whitelist for Veda service calls (your Avoka account manager will be happy to assist).

Note that transactions including Mastersoft address lookup calls are subject to additional transaction fees. Please contact your Avoka account manager for
details.
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Adding an address lookup widget to a form

Mastersoft address lookup is available in Composer from version 4.1 SP2 onwards.
To add a Mastersoft address lookup block to the form, find the "TM Standard Address Lookup Block" in the palette and drag it onto your form. You will be

asked to specify the block's internal name and confirm the names of the dynamic data services on TM (see screenshot below).
Create a New Field

Please supply values for the requested properties in order to create a new field of the given
type.

Field Type TM Standard Address Lookup Block

Label Please input the address

Internal Name = |v| Generate Name

Address Lookup DDS Name = Address Lookup

Address Block Browse Clear
Value Field For Address Counter Browse Clear

Save Cancel

Configuring a standard address lookup widget

Enter a unique internal name for the block. Do not change the dynamic data service name fields - by default, TM (version 4.1.8 onwards) will contain the
correct service. Once you click "Save", a new address lookup block will be added to your form.

You can configure some additional aspects of the address lookup block (e.g. how many characters the user needs to type before address lookup is initiated)
by editing the properties of the block and switching to the "Data" tab.

Once you are satisfied, publish your form to Transaction Manager. The following section will tell you how to set up address lookup in TM.

The Mastersoft address lookup service in TM

To enable Mastersoft Harmony address lookup, TM exposes a dynamic data service named "Address Lookup". These services are fully set up but need to
be configured with your Mastersoft credentials before you can use them. Please set up an account with Mastersoft and follow their directions.

Once you have set up an account with Mastersoft, configure the service by logging on to the TM management console and accessing "System > Service
Definitions". Filter by service type "Dynamic Data" and edit the service named "Address Lookup". Switch to the "Service Parameters"” tab (see screenshot
below).

Address Lookup

Home Dashboard » Service Definiions » Service Definition

Service Definion | Groovy Script | Service Parameters | TestService
Hame Type Value Description Bind Last Modified Action
Parameter

casaType String uP CLOWTUFTTITLE™) The case type for the returned 28 Jul 2015 by E’ T]

addresses (single line and components). system -

disableService Boolean false Disable service If address lookup is offine 29u20150y [ B
system

eventLoggingLevel List Waming The service Event Log logging level o 29 Jul 2015 by |2 =]
system

executionTimeout Number E0000 The GroovyScript execution timeout in milliseconds., o 29 Jul 2015 by Er’ T]

system -

groevylLoggingEnabled Boolean true Log Groovy Service calls to the Groovy Log table. o 28u20150y [ ()
system

groovyScript Groovy J* Provides Standard Ausiralia address The Groovy script to be executed. The output will be o 29 Jul 2015 by [Z -]
Script lookup formd... converted to a string and streamed back. system

groovyTypeChecked Boolean false: Parform Groovy script static type checking o 28 Jul 2015 by E’ T]

system -

maxRecords Number 10 The maximum number of records that shall be returned. 294ul2015by (A )
system

password Password Password for caling mastersoft address lookup 29 Jul 2015 by 7 &
service system

responseContentType  String text/plain The content type that shall be set on the response to " 29 Jul 2015 by E f]

the form. system B

restServiceURL String hitps:/hosted mastersoftaroup comharmony URL for address lookup REST service 282015y (A [
Jrestiaula... system

testMode Boolean false If in test mode, most security checks will be skipped o 29 Jul 2015 by E n
system

username String Username for caling mastersoft address lookup 29 Jul 2015 by E E
service system

The service parameters of the "Address Lookup" service
Edit the "username" and "password" parameters and enter your credentials. Save your changes.

301



You can also change other parameters, such as the maximum number of search results that will be returned to the form for each call.
Now your service is ready to be used by forms containing Mastersoft address lookup widgets. Please note that TM transactions including Mastersoft address
lookup calls will incur additional fees; please contact your Avoka account manager for details.

How do | stop the Reader security warnings appearing when my PDF form
makes a web service call?

Enter topic text here.
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Form Validation (Manager v5.0)

XXX this is currently not a very meaty topic - worth fleshing out?

How can | verify submitted data on the server before it is delivered?

XXX is this still relevant? these days we'd probably use Groovy
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Form Saving and Retrieval (Manager v5.0)

For you and your users' convenience, your forms can be configured to allow "online" saving, where a form can be saved as a draft to Transaction Manager,
and later be securely retrieved by the original user. PDF forms can also be configured for "offline" saving, where the user saves a copy of the form to their
computer.

This section discusses common use cases around form saving.

How do | enable a form to be saved online?

To enable online saving for a form, edit the form and switch to the "Flow Config" tab.

Simple Form

Home Dashboard » Forms » Form

Dashboard | Detals | Flow Config | Email Verification I Form Versions ] Abandonment | Page Tracking | Spaces [ Group Access

Configure the User Flow options for the form

Show Landing Page ¥ @

User Authentication j o
Save Online o
Show Terms & Conditions | Disabled
Form Display Mode _Authenticated Orly @
Form Signature Required j o9
Submission Confirmation Options
Send Confirmation Email to User  None :J 9

Show Confirmation Page [ @
Show PDF Receipts v @

Custom Page Flow Options

Saved Page URL

Confirmation Page URL

@ @ @

Cancelled Page URL

Form Page Close

Enabling online save for a form

If you want to ensure that users can save only while logged in (using a TM user account), choose "Authenticated Only" from the "Save Online" dropdown.
Transaction Manager will reject attempts to save the form online if the user was not authenticated when rendering the form. If an authenticated user saves a
form online, they will be shown a page confirming that the form was saved, and can reaccess the form by logging on to TM and accessing their To Do list.

If your users are not logged in to TM when filling in the form or you want to allow all users to save the form, choose "Enabled" from the "Save Online"
dropdown. In this case, Transaction Manager will still allow attempts to save the form online if the user is authenticated. This also allows submission sharing
between anonymous and registered users. If an anonymous user saves the form online, they will need to pass a security challenge to return to their form -
more on this in the next section.

Once you have configured the online save setting, save your changes.

Can | allow anonymous users to save my form online?

Transaction Manager provides support for anonymous online saving and, just as importantly, a secure way for anonymous users to return to their saved form
later while denying access to other users.
There are two ways you can secure saved form retrieval for anonymous users:

1. Reference number only When the user saves the form online, a page is displayed to the user containing customizable messaging as well as the
reference number (which is the same as the tracking code or receipt number generated for the form). The user can send themselves an email with
the reference number and a link back to the form. When returning to the form later, the user enters their reference number. If it is correct, the user
can resume filling in the form; otherwise, access is denied.

2. Reference number and form data challenge In addition to the above mechanics, TM can also extract data from the saved form and ask the user
to enter this data (in the form of a question such as "What is your place of birth?") in addition to the reference number before the user can access
the saved form. Both the question text and the XPath in the submitted XML where the answer can be found are configured as form version
properties in Transaction Manager. While this mode adds security, it is also important to consider carefully what question to ask the user. The data
item to be asked about must be set before the form is saved (the form needs to ensure this - if no answer is defined when the form is saved, TM will
treat this as an error case). Additionally, the data item must be both private (unlikely to be known by attackers) and unambiguous (the user must be
able to easily remember the answer when prompted, and also must be able to enter the answer in the correct format). Dates can be problematic
due to the multitude of date formats. Note that if a user forgets the answer to the form data challenge, there is no way for them to get back to the
form. The answer itself is not stored in TM for security reasons (only a hash of the answer is), so it cannot be retrieved by support personnel. In
such a case, the user will need to fill in the form again from scratch.

Generating a secure reference number for anonymously saved forms

When returning to an anonymously saved form, the user is prompted to enter the corresponding reference number. This is the same as the tracking code /
receipt number generated for the form submission, and was displayed to the user after saving the form (if the user used the TM feature to have an email sent
to them, this email generally also contains the reference number).

To make it easier for the user, the reference number should not be overly long. However, in the interests of security, the reference number should not be
guessable (e.g. simply be an incrementing sequence). The reference number must also uniquely identify the submission. To achieve all these objectives, you
will need to look into how tracking codes / receipt numbers are generated for your form.

To view or modify tracking code and receipt number settings, edit the form and ensure you are on the "Form" tab.
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Payment Form

Home Dashboard » Forms » Form

Dashboard | Details | Flow Config I Email Verification Form Versions | Abandonment

Form Display Name* Payment Fom @
Form Code™ pfitd1 @
RefForm D
Form Manager j 9
Transaction Value @
Active [ @
TestMode [T @
Form Version Selector j @
Submission Expiry Date : g
Submission Expiry Days @

Tracking Code
Use Receipt No. for Tracking Code [~ @

Tracking Number Service v|@

Receipt Number

Receipt Number Service |2
Receipt Number Pattern®  $fformCode}-8{next Sequence} @
Next Sequence Number* 15 @

Delivery Channels

Production Defivery ~ Email j @ et
Test Mode Delivery j 2]

Validation Failure Delivery ~ LC Deliver To Directory j 7]

Transaction Form Data Retention (max age)

Finished Transaction FormData  Use defaults (7 days) j 9

Saved Transaction FormData = Use defaults (180 days) j 9@

Delete Form Data Extracts [# i@

Validate Form Close

Changing the tracking code / receipt number settings

The "Tracking Code" section tells you whether the form uses tracking codes or receipt number as the reference number (receipt number is used if "Use
Receipt No. for Tracking Code" is ticked).

When using tracking codes, you can choose a specific service to generate the tracking code ("Tracking Number Service" dropdown) or leave the dropdown
blank to use the system default service.

Note that tracking codes are designed to be easily used as a reference number: They are short, alphanumeric strings that are randomly generated. You can
define the length and set of characters that will be used to generate tracking codes by editing the corresponding service of type "Tracking Number".

When using receipt number ("Use Receipt No. for Tracking Code" is ticked), you need to ensure that the receipt number is appropriate for use as a reference
number. Please review the settings in the "Receipt Number" section.

The "Receipt Number Service" dropdown determines the service that is used to calculate the receipt number (if blank, the default service is used - to find out
which service that is, go to "System > Service Definitions" and search for services of type "Receipt Number"). There are currently two receipt number
services that are shipped with Transaction Manager. These services are described in detail in the TM Administration Guide, chapter "Form Configuration”,
section "Receipt Number Generation".

® Sequence Pattern Receipt Number Service Do not only use the variables "${submissionld}" and "${nextSequence}" as they are sequential and
therefore easily guessable. A good starting point for a pattern is "${submissionld}-${submitKey.substring(0,4)}", which combines the submission OID
(for uniqueness) with part of the submit key (obscurity) while still remaining reasonably short.

® Groovy Receipt Number Service Ensure your script returns suitable values that are not guessable.

Enabling a form data challenge in addition to the reference number

To enable the additional form data challenge, you need to configure the save challenge question to be presented to the user as well as the location of the
challenge answer in the submitted form.

To configure the save challenge question, create a value for the form property "Save Challenge Question". To do so, edit the current form version, switch to
the "Properties” tab and create the property as shown in the example below. Make sure to include any relevant instructions (such as required date format).
Example: "What is your Tax File Number (enter without spaces)?".
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Edit Version Property

Home Dashboard » Forma » Form b Fosm Version » Viersion Propadty

Mame  Save Chalenge Cusstion
Froperty Type  Save Chalenge Quesion =
DetaType Sing ¥
Scopa  Fom x|

¥What is your Tax File Humber {do not include spaces)?

m Closa

The form property for the save challenge question
To configure the XPath in the form data where the challenge answer will be read from, edit the form data configuration and fill in the "Save Challenge XPath"
field. Save your changes. It is vitally important that the form ensures that this value will not be blank whenever the form is saved.

Basic Form - HTML - Version 1.0 - Form Data Config

Home Dashboard » Forms » Form » Form Data Config

Configuration Mapping I Form XML Data | Property Prefil Mapping [ Reguest Param Prefill Mapping Input XML Prefil Mapping Submission Data Extracts

Configuration Mappings enable you to override the default form XML configuration paths for the system to write to and read Form XML data from.

Default Mappings
Use Default Mappings v &

Attachments XPath @
Payment Details XPath g
Receipt XPath @
Signature XPath @
Additional Mappings
Contact Email XPath =]
Save Challenge XPath  //FormData/TaxFleNumber @
Signatures Required XPath o

e o

Configuring the challenge answer XPath

Extracting contact details entered by the user

Often it is important to know a user's email address or mobile phone number. While TM allows registered users to configure email addresses and phone
numbers in their user profile, this does not help if users are submitting your form anonymously. To provide you with a more generic way of capturing user
contact information, TM can be configured to extract a contact email address and/or mobile phone number from submitted form data, which is then stored
against the submission and displayed in the TM management console.

To set up automated extraction of the user's email address and / or mobile phone number for a form, edit the form data configuration for the current form
version and ensure you are on the "Configuration Mapping" tab. Enter the XPath where the email address will be stored into the "Contact Email XPath" field,
and the XPath where the mobile phone number will be stored into the "Contact Phone XPath" field.

Basic Form - HTML - Version 1.0 - Form Data Config

Heme Dashboard » Form » Form Data Config

c ion Mapping | FormXMLData | Property Prefil Mapping | RequestParam Prefil Mapping | Input XML Prefil Mapping | Form Data Extract Mapping

Configuration Mappings enable you to override the default form XML configuration paths for the system to write to and read Form XML data from.

Default Form Data Mappings
Use Default Mappings M @

Attachments XPath
Payment Details XPath
Form Signatures XFPath

Abandonment Reason XPath

@ @ oo e

Recaipt XPath
Additional Form Data Mappings
Contact Phone XPath | //UserProfie/Contact Details/Mobde Number

Contact Email XPath | //UserProfile/Contact Details/Emai
Save Chalenge XPath

Transaction Ref Number XPath

@ e e e o

0l Wet Signatures Required XPath

Close

Configuring the XPath containing the contact email address and mobile phone number

306



Whenever a form is submitted or saved, the content of the specified element is read from the submitted data and stored against the submission. This email
address is used by TM during submission email verification and can also be used by custom services (e.g. Groovy delivery services).

Can saved forms be shared across user spaces, including the TransactField
App?

By default, saved forms are shared across all spaces on which the form is hosted. The TransactField App can synchronize saved forms with the TM server
and is therefore able to display forms saved on other spaces (and vice versa).

Users can open and complete saved forms on any space (assuming the form can be rendered and submitted on all configured spaces).

To see what spaces a form is hosted on, edit the form and switch to the "Spaces" tab.

Payment Form

Home Dashboard » Forms » Form

Dashboard | Details | Flow Config Email Verification Form Versions I Abandonment Page Tracking Spaces
Select the set of Spaces that will display this form.
Available Spaces Assigned Spaces
TransactField App LI Finance Corporation L]
Web Plugin Gov Assist
Maguire
Spaces <

The list of spaces hosting a form
The set of spaces that are listed under "Spaces" can be used to host the form, and potentially share saved forms.

Can | assign a saved form to another person to complete?

Currently, Transaction Manager supports form sharing via form work groups. Form work groups are groups set up in TM that users can be assigned to (or,
for externally managed users such as LDAP user accounts, group associations can be loaded at login time). Form work groups can then be associated with
a number of forms and control access to these forms. All users in a form work group share access to all forms belonging to the group.

To further control group access, a form group can be configured to allow shared access to one or more of the following (see also the image below):

opening new instances of the forms

completing saved or otherwise incomplete submissions for these forms
viewing submissions and receipts for these forms

reassigning tasks based on these forms

Job Reviewers
Home Dashboard » Groups » Group

Group | Forms | Members

Name* | Job Reviewers @
Type* Fom j @
Description | Authorized Job Reviewers.
Group User Access Control
Share with Work Group ¥ @
New Forms [V @
Saved / Assigned Forms [ i@
Completed Forms [V i@
Reassign Task [ @

Save Close

Access control options for a form work group

This means that if you have a form work group where all access is shared, user A can open a form and save it, then user B can open the saved form and
submit it, and both user A and user B will see it in their submission history (assuming both users are in the form work group in question). Group membership
is evaluated dynamically, i.e. you can assign a new user to the group and they will instantly be able to see all relevant forms and submissions - or conversely,
you can remove a user from a group to revoke access to these forms.

To avoid multiple users working on the same saved submission, a warning message is displayed on the space if another user has recently opened a saved
submission but has not submitted it yet.

To summarise, if you want a group of users to be able to pick up each others' saved submissions, create a form work group with at least "Saved / Assigned
Forms" permissions and assign users to it. All users in the group will then be able to see and complete each others' saved forms. Again, you can also assign
users to the group as needed (e.qg. if all current group members are unavailable but a submission must be completed, you can assign another user to the
group temporarily and have them complete the submission).
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Can | display custom messages after a user saves a form?

You can customize various messages displayed to the user after saving the form. This includes an additional message on the "Submission Saved" page as
well as the subject and body template of the email anonymous users can send themselves with a link back to the form. All these messages can be
customized separately for each form version.

Adding a custom message to the "Submission Saved" page

To add a custom message that will be displayed on the "Submission Saved" page, edit the form, switch to the "Form Versions" tab, edit the current version
and switch to the "Properties"” tab. Click "New", set the property type to "Saved Message" and enter your message (including HTML formatting) into the
"Value" field. Save the property value.

In addition, the form has the opportunity to set or modify the saved message. When the form is rendered, the "Saved Message" form version property is
populated into the "SavedMessage" node in the system profile. The form can modify this value as desired, and when the form is saved, TM reads out the
saved message from the form data and stores it in the submission entity to be displayed on the "Submission Saved" page.

If a saved message is set, the "Submission Saved" page will display it in addition to its usual content. See the screenshot below for an example (the custom
message is the text in the "Please Note" section).

j Finance

Test Form

© Form Saved
Your form has been saved online

. Please Note

Please fill in your saved form within 14 days. Saved forms older than 14 days may be deleted

From Here
B Vview your form submission history
- L] L]
= Open your saved Test Form lnsu"‘o rp
(2 Send yourself an email with a link to your saved form INSURANCE SOLUTIONS

E—

urky & Legal | Report Email Fraud |
Diversity & / ssibility | Important N n Trading in Fast Markets | Oniine / s Agreement

The "Submission Saved" page, including a custom message

Customizing the "Submission Saved" email sent to users

On the "Submission Saved" page, users can elect to send themselves an email with a link to the saved form (as well as the reference number if the form was
saved anonymously). You can customize the subject, body and sender email address used in the email for each user space and overwrite these settings on
an organization and/or form version level.

The email subject and message are provided as Apache Velocity templates that can be customized with the following variables:

® form The form entity. You can reference attributes, e.g. "${form.formName}".

® formUrl The URL back to the saved form. This should always be included in the email body, especially for anonymously saved forms.

® submission The submission entity. You can reference attributes, e.g. "${submission.receiptNumber}", which should be included for anonymous
users, since it is used as the reference number needed to return to the form.

® portal The space on which the form was saved.

® environmentName The name of the TM environment, as specified in the space property "Admin Environment Name" associated with the "Admin
Console" space.

If the email message should be usable for both anonymous and authenticated online saves, it should include conditional text such as:

<p> You recently saved a ${form.formName} at ${portal.name}. </p> #if ($submission.user) <p> Please open your form at: </p> #else <p> Your save
reference number is: ${submission.receiptNumber} </p> <p> Please provide this number when you open your form at: </p> #end <p> <a href="${formuUrl}"
>${formUrl}</a>. </p>

This will display the return URL for authenticated users, and the reference number as well as a return URL for anonymous users.

To configure the email sender, subject template and body template for a space, modify the space properties "Email Sender Address", "Email Saved Form
Subject”, "Email Saved Form Message". Note that the email sender address is not specific to the "Submission Saved" email.

To override the email sender, subject template and body template on the organization level, set the organization properties "Email Sender Address", "Email
Saved Form Subject" and "Email Saved Form Message".

To override the email sender, subject template and body template on the form version level, set the form version properties "Email Sender Address", "Email
Saved Form Subject” and "Email Saved Form Message".
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Can | allow users to re-use a PDF form for multiple submissions?

If you enable offline submission for PDF forms, some users may save a form once and then try to re-use it for multiple submissions. By default, Transaction
Manager rejects additional submissions to avoid ambiguity and improve traceability. However, if you would like to allow your users to create multiple
submissions, you can configure this on the form version level.

To enable multiple submissions for a form version, edit the form, switch to the "Form Versions" tab and edit the current version. Switch to the "PDF Options"
tab and tick "Allow Multiple Submissions", then save your change.

Edit Form Version - Wet Signature Form 1.0

Home > Forms » Form » Form Version

Form Version PODF Options I Properties I Attachments | Form Tags | Services ‘Version Prometian

Reader \Version Reguired @
Reader Extend Form ¥ @
Enable Local Save [v @
Allow Mutiple Submissions [, @
Form Supporte Offine Submission [ &

Validate Submission on Server [~ &
PDF Form Open Parameters

Enabling multiple submissions for a form version
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Form Submission (Manager v5.0)

When a form is submitted by the user, the user's work may or may not be done. Complex forms may require additional steps such as attachments, payments
and/or signatures. At the end of this process, however, the user is always presented with a confirmation page that offers a receipt and other important
information.

This chapter discussed submission-related functionality as well as the confirmation page. Subsequent chapters will delve into optional functionality like
attachments, payments and signatures.

Can | customize the content of the submission confirmation page?

There are two ways of customizing the submission confirmation page: You can either add a custom message to the submission confirmation page, or if you
need to make more extensive changes, you can modify the entire HTML page template.

Adding a custom message to the submission confirmation page

To add a custom message that will be displayed on the "Submission Confirmation" page, edit the form, switch to the "Form Versions" tab, edit the current
version and switch to the "Properties” tab. Click "New", set the property type to "Submission Message" and enter your message (including HTML formatting)
into the "Value" field. Save the property value.

In addition, the form has the opportunity to set or modify the submission message. When the form is rendered, the "Submission Message" form version
property is populated into the "SubmissionMessage" node in the system profile. The form can modify this value as desired, and when the form is submitted,
TM reads out the submission message from the form data and stores it in the submission entity to be displayed on the "Submission Confirmation" page.

If a submission message is set, the "Submission Confirmation” page will display it in addition to its usual content. See the screenshot below for an example
(the custom message is the text in the "Please Note" section).

Finance

corporation search Search

Test Form

Thank you

Your form has been submitted for processing.

Submitted: Friday, 9 Movember 2012
Reference Number: tf-ltc34.13

This number can be used to help track your form's progress|

.. Please Note

Your submission will be processed in 4-6 working days. For any enquiries, phone 1300 426 426 and quote your

reference number. . .
INSURANCE SOLUTIONS

From Here
T Save a PDF copy of your form

[~ Send yoursell an email with a POF copy to your form

izt o

B View your form submission history

Agreement

The "Submission Confirmation" page, including a custom submission message

Customizing the HTML template of the "Submission Confirmation" page (form version specific)

If you would like to make layout changes to the submission confirmation page or add new content (such as custom form version property values), you can
adjust the content of the submission confirmation page on a form version level.

To do so, edit the form, switch to the "Form Versions" tab and edit the current form version. Switch to the "Properties” tab. The property you are looking for is
named "HTML Confirmation Page". If it is set already for your form version, edit it; otherwise click "New" and select "HTML Confirmation Page" from the
"Property Type" dropdown.
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Edit Version Property

Home > Forms = Form = Form Version = \Version Property

Name HTML Confimnation Page
Property Type  HTML Confimation Page =l
Data Type  Long Text [~ |

Scope  Fom x|

<diw id="e

|»

$if ($submission)

<prSerrorMsg</pr
</div>
Vale telse

<div ela

2if (gemsailed)
<p style="margin-bottom: 4px; "*¥our form receipt has been emailed to you.</p¥

4px; ">¥Your form haa been submitted for processing. </p>
<prSubmizted: $submissicnDate</p>

gend
< fdiv>

Fend

Upload Fike | Browse_

Customizing the HTML template of the submission confirmation page

When you create the property, TM will automatically load the current submission confirmation page HTML template as the initial value (as shown in the
screenshot above). You can now adjust the layout and content.

To access form version properties, use the notation "${formProperties.PropertyName}", replacing "PropertyName" with the name of the property (omitting
whitespace). For example, if you have added a form version property named "Contact Email Address", you could reference it in the page template using
"${formProperties.ContactEmailAddress}".

Make sure to test your changes after saving the form version property. Other forms will not be affected by these changes.

Customizing the HTML template of the "Submission Confirmation” page (global)

If you would like to customize the HTML template of the "Submission Confirmation" page across the board (i.e. in a non-form-specific manner), you can edit
the submission confirmation page template on the space level. This template applies to all forms that do not define the form version property "HTML
Confirmation Page" when the confirmation page is viewed on that particular space.

To customize the submission confirmation page template for a space, edit the space and ensure it is editable ("Content Editable" checkbox). Switch to the
"Pages" tab and edit the entry named "Submission Confirmation" (see image below for an example).

Submission Confirmation - Finance Corporation
Home Dashboard » Portals / Modules » Portal » Portal Page

Page Content

argeHeading”>$formProperties. FormName</hi>

i class="icon-alert"></i><span class="alert-text"><b>Alert</b></span></span>

s="icon-success"></ir<span class="alert—text"r<b>Thank you</b></span></span>

ipt has besn emailed to you.</p>

<p>Your form has been submitted for processing.</p>

Editing the submission confirmation page for a portal
Adjust the page content and save your changes. The changed submission confirmation page will be used immediately. Ensure to test your changes carefully.

How can | customize the submission confirmation page based on the
submitted data?

The standard submission confirmation page displays important information such as the receipt number to the user. You can customize the submission
confirmation page as we have seen in the preceding sections, but what if you want to add more data specific to the submission (e.g. the type of application
the user made, or additional instructions to the user that are specific to selections in the form)? TM addresses this by providing the set of submission data
extract mappings (data extracted from the submitted XML data at submission time) on the confirmation page. You can display data extract values directly (e.
g. the user's name) or use them to make decisions on what to display (e.g. additional instructions depending on application type).

If you would like to use this mechanism to customize the submission confirmation page, you will need to set up a set of data extract mappings for your form
(s) first. Please refer to the TM Administration Guide, chapter "Form Version Configuration”, section "Form Data Configuration Setup”. Note that changes to
the set of data extract mappings apply to subsequent submissions only.

Once you have set up data extract mappings, you can customize the submission confirmation page to reference data extract values. If the data extract
values are form specific, you will probably want to customize the confirmation page for your form version; on the other hand, if all forms share a set of data
extract values, you may want to customize the global submission confirmation page template. Both options are described in the preceding sections.

Here is an example for Velocity directives that add logic to a message box to display additional messaging if the user will need to make a BPAY payment
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after form submission (the logic regarding the additional messaging is bolded below):

<div class="alert alert-success panelMargin-left"">

<div class="row">

<span class="span8"><i class="icon-success"></i><span class="alert-text"><b>Thank you</b></span></span>

<span class="span8">

#if ($session.emailed)

<p>Your form receipt has been emailed to you.</p>

#else

<p>Your form has been submitted for processing.</p>

#if (${submission.dataExtractMap.PaymentType} == 'BPAY")

<p><b>Note:</b> You need to make a BPAY payment for this submission. <br/>Please make a BPAY payment of AUD ${submission.
dataExtractMap.PaymentTotal} to biller code ${submission.dataExtractMap.BPAYBillerCode}. <br/>Your payment reference number is
${submission.dataExtractMap.BPAYReferenceNumber}.

#end

#end

</span>

</div>

</div>

As you can see, a specific data extract value can be accessed via ${submission.dataExtractMap.<name> where <name> should be replaced with the name
of the data extract element (e.g. "PaymentType"). The example shows both conditional logic based on data extract values ("#if (${submission.
dataExtractMap.PaymentType} == 'BPAY")") as well as simple display of data extract values ("Your payment reference number is ${submission.
dataExtractMap.BPAYReferenceNumber}.").

$¥ Finance
€ £

corporation

BPAY Form

M Thank you
Your form has been submitted for processing.

Note: You need to make a BPAY payment for this submission

Your payment reference number is 1234567890

Reference Number: bf-ltc35-3
Confirmation page with data extracted from the submission
The above is a very basic example. You can add much more logic and elaborate styling to your confirmation page to suit your needs.

Can | send a confirmation email to users who have submitted a form?

If the form is configured to allow users to view their form receipts, the submission confirmation page will automatically allow the user to send themselves a
confirmation email including the receipt. Transaction Manager does not actively send an email, instead allowing the user to customize the email address they
would like it sent to and giving them the opportunity to react to email errors (e.g. user error when entering the email address). Alternatively, users can simply
download the receipt.

The next section explains how you can customize the contents of the "Submission Confirmation" email.

How can | customize the confirmation email sent to the user?

You can customize the email subject and body text of the email for each user space and overwrite these settings on an organization and/or form version level.
Generally, the email subject and message are provided as Apache Velocity templates that can be customized with the following variables:

® form The form entity. You can reference attributes, e.g. "${form.formName}".

® submission The submission entity. You can reference attributes, e.g. "${submission.receiptNumber}".

® submissionExtractData The data extract values for the submission. Reference individual values as attributes, e.g. "${submissionExtractData.
dataExtractKey}" if the extract value name is "dataExtractKey".

® portal The space on which the form was submitted.

® environmentName The name of the TM environment, as specified in the space property "Admin Environment Name" associated with the "Admin
Console" space.

To configure the email sender, subject template and body template for a space, modify the space properties "Email Sender Address", "Email Form Receipt
Subject"”, "Email Form Receipt Message". Note that the email sender address is not specific to the "Submission Confirmation" email.

To override the email sender, subject template and body template on the organization level, set the organization properties "Email Sender Address", "Email
Form Receipt Subject" and "Email Form Receipt Message".

To override the email sender, subject template and body template on the form version level, set the form version properties "Email Sender Address", "Email
Form Receipt Subject” and "Email Form Receipt Message".

Can | send the user status updates after submission?

Often submission in TM is followed by further processing steps at the organization. If this is the case, you can notify users of back-office status updates as
they occur. These processing status updates are displayed in the space and can also be sent to the user via email.

Adding a processing status update

There are two ways of creating processing status updates: directly via the TM management console or via a web service API. For more information about the
web service method, please refer to the "Transact Web Service Guide", chapter "Forms Server Web Service".

To manually create a processing status, log on to the TM management console and access the submission log. View details for the submission you want to
update and switch to the "Processing Status" tab. You will see the list of currently existing processing statuses (see the image below for an example) as well
as the creation date and user. TM itself may also create some processing status values (e.g. during submission email verification).
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Transaction Details

Home Dashboard » Form Transactions » Transaction Detais
Transaction Details l Transaction Status. Aftachments [ Paymant Form XML Data Form Data Extract | Processing Status History l Delvery Chackpoints l Events I Errors |

Processing Status Created At Created By

Thank you. Your submission is being processed. 27 Aug 2013 09:39  medgar

m CIOSE

The list of processing status values for a submission
Click "New" to add a processing status (see image below).

Edit Submission Processing Status

Home Dashboard » Form Transactions » Transaction Details » Submission Processing Status

Processing Status * Verfication pending

Send Email Notification [

Adding a processing status update

Enter the new processing status (e.g. "Approved"). This string will be displayed to the user.

Tick "Send Email Notification" to send an email to the user, telling them that the submission status has been updated.

Save the processing status. The new status will be displayed on the space (if the user has access to the submission list), and an email will be sent to the
user if you chose that option.

Customizing processing status update emails

You can customize the processing status update email that is sent to the user on multiple levels: The global subject and message templates are defined as
deployment properties (named "Email Submission Status Subject" and "Email Submission Status Message", respectively). If you adjust these values, they
apply to processing status updates for all forms by default.
In addition, you can override the email subject and/or message on the organization and form level. This enables you to have a global template for most
forms, but define a tailored email template for specific forms as needed.
To override the email subject / message on the organization level, edit the organization and add an organization property of type "Email Submission Status
Subject" and/or "Email Submission Status Message". The default template value will automatically be populated as the property value for you to modify (see
image below).

Edit Property

Home Dashboard » Organisati » Org tion » Property

Property Type * | Email Submission Status Message ;I

fececec; ">

em; ">
dth:640px; border-collapse:collapse; font-family:Arial,Helvetica,sans-serif;">

h style="color:
orm Status Update

hite; background:#005596; text-align:left; padding:lem;">

tyle="color:black; background:white; text-align:left; padding:lem;">
> S{user fullName} your form submission Ho.

submission.receiptNumber} and Form Name:

form. formName} status has been updated to: &nbsp; ${submission.processingStatus} </p>

Value

tyle="color:§d9fffd; background:$556c90; text-align:left; padding:lem;">

Customizing the processing status email for an organization

Edit the value and save.

Note: Editing organization properties does not immediately flow through into all form versions. In TM, form versions are isolated from changes to
organization properties and other values - all changes to a form version need to be made explicitly. This helps preserve old form versions. To apply the new
organization property value to a form version, edit the form version, switch to the "Properties" tab and click "Sync Org Properties".

To override the email subject / message on the form level, edit the form version and add a form version property of type "Email Submission Status Subject"”
and/or "Email Submission Status Message". The default template value will automatically be populated as the property value for you to modify.

Edit the value and save. All submissions using this form version will use the new template in the future, overriding values defined on the global and
organization level.

Can | update a user's profile based on data they filled into my form?

If you are using TM-managed user accounts in your user spaces, Transaction Manager not only allows your users to manually update their profiles, but also
allows data that the user filled into a form to flow back into the user profile.

Whether this happens or not is the form's decision - TM checks the element "UpdateUserProfile" in the SystemProfile at submission time. If it is set to "true”,
TM will then look up the property prefill mappings with a scope of "User" for the form version. Each mapping that is found is applied in reverse; i.e. TM looks
up the XPath in the submitted XML, and writes its value to the profile property specified in the mapping.

Therefore, this mechanism will update only those profile properties for which property prefill mappings have been set up. This mechanism also ensures that
the form receives the current values for these properties at render time, via property prefill.
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Attachments (Manager v5.0)

Apart from the fields filled in by the user, forms often require supporting documentation, such as proof of identity. These additional documents (here called
attachments) may be provided electronically or physically (via mail, fax or personal drop-off). Transaction Manager supports all these use cases and allows
you to make it easy for the user to directly upload attachments while constraining the attachment size and adding automated virus scanning of attachments
using an external virus scanner.

Attachments can be dynamically requested depending on selections made in the form. Composer allows you to define attachments and the rules when each
attachment will be requested, and in what format. Alternatively, you can maintain the set of attachments in Transaction Manager.

How can | allow the form to decide which attachments will be required?

The form is always in control of the attachments that will be requested when the form is submitted. You can either define the logic around required
attachments inside the form, or define a set of attachments in Transaction Manager, which is then passed to the form, which can modify the set of
attachments as the user makes choices. At submission time, Transaction Manager will read the list of required and optional attachments from the submitted
data, and displays an attachment page to the user.

To use the attachment functionality, your form's seed file needs to contain a special "Attachments" node where attachments will be located at submission
time. By default, Transaction Manager looks for this node using the XPath "//Attachments”, though the search path can be customized.

If you are using Composer forms, the "Attachments" node will be added and its contents managed for you when you add attachments to the form.
Composer provides widgets that help you set up your attachments and rules to add attachments based on user input to the form. Please refer to the
Composer User Guide, section "Transaction Manager Integration” for details.

Once a form that requires attachments is submitted to Transaction Manager, the user will be presented with a page allowing them to upload files or specify
that they will provide the attachment in physical form (e.g. via mail or fax). Whether both these submit methods are available to the user can also be
controlled by the form, and you can control expected file types and maximum size for each attachment as well. Please refer to the next topic for more details.

S 1:
> Finance

corporation

Submission Attachments

(D Instructions
To complete your form you must provide the following documentation and then click on Attachments Completed

Required Attachments
You need 1o attach these files in order to complete your Submission

Proof of ldentity Attachment
File type{s): “.bmp. * jpg. “png Maximum file size: 512 KB

+ Add File will deliver this documant manually

Optional Attachments

These attachments are opltional but you may wish 1o add them to your submission

Site Plan Attachment
File type(s). *.pdfl Maximum file size. 2 MB

+ Add File

Total size: 0KB
Total number of attachments: 0 (max number 3)

mpletes Return to Form Cancel Submission

About s | Terms & Conditions Careers | Securty & Legal | FReport Emal Fraud Skemap ContactUs | Dwersiy & Accessibilty Fowaered By Avoka Transact

The attachment page presented to portal users

How can | prevent users from attaching too many/unsuitable files?

Each individual attachment requested by Transaction Manager can be restricted to a maximum file size and one or several file types (e.g. *.jpg). In addition,
the entire set of attachments for a form submission can be restricted to a maximum size and number of attachments This can be necessary when a PDF
form allows the user to attach files directly to the form, and also because users can in theory upload multiple files for each attachment defined in Transaction
Manager (which allows for flexible handling of attachments where the user may have multiple files to satisfy a requirement for supporting documentation).
To restrict the total number and size of attachments that are possible for a form, edit the form in the TM management console, switch to the "Form Versions"
tab and edit the current version. Switch to the "Attachments" tab.

Test Attachment Form - Version 1.0

Home Dashboard » Forms » Form » Form Version

Form Version | Properties | Attachments | Services | Form Tags Composer Info |

Hame File Types Document Code Max Sizeé Required Submit Method Action
Proof of identity *bmp, *jpg, *png poi 0.5MB ¥ P8
Site Plan * pdf sp 2ZMB Electronic A &

Maximum Total Size | 5MB x| &

Maximum Number | 3 x| @

m Save Close
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Configuring the total number and size of attachments for a form

You can restrict the total size and number of all attachments combined by entering values into the "Maximum Total Size" and "Maximum Number" fields.
Save your changes. Now all future submissions for the form will be constrained to the configured maximum number and size of attachments. Constraints for
individual file attachments still apply.

To control the maximum size and file types for individual attachments, you can specify a maximum size and a set of supported file types. If the attachments
are set up in Transaction Manager, you can navigate to the "Attachments" tab as above and edit an individual attachment (see screenshot below). Edit the
"File Types" field to restrict the file extensions users can upload, the "Maximum Size" field to restrict each attached file to a maximum size and the "Maximum
Pixel Resolution" to restrict uploaded images where applicable. In addition, you can make the attachment mandatory by ticking the "Attachment Required"
checbox, and specify a submit method (electronic via upload or manual via mail, fax etc.) by changing the value of the "Submit Method" field.

Edit Version Attachment

Home Dashboard » Forms » Form » Form Version » Version Attachment

Proof of Identity
Description

Document Type | Proof of Identity j @
Document Code | poi @
Attachment Required [v @
Maximum Number j @
File Types | “bmp, "jpg, “png @
Maximum Size* | 0.5 M8 j @
Maximum Pixel Resolution j @

Submit Method j @

e

Editing the constraints on an individual attachment set up in SFM

If the attachments are set up in Composer, open your form in Composer and edit the attachment rule associated with the attachment. On the "Data" screen,
you can enter a maximum size in bytes, add a set of file extensions to constrain the file type, make the attachment mandatory and determine the submit
method.

Republish your form to TM to apply these changes.

Edit Properties - Field ‘attachmentRule1’ of Type "SFM Attachment Rule’

L';j‘ You can use this dialog to view and edit the properties of the selected field. Note: Property values may come from default values associated with the field type, be
defined in a style associated with the form template or be set explicitly in the form itself.

= &
Data
Attachment Name P Form
Data Binding Passport Phofo o
Rules Attachment Description o Tupe Definition
Styles Document Type 1D O Tupe Definition
Document Code @ Tupe Definition
Mandatory Status Required v 0 om
. 7
Mime Type or File Extensions = iny Add...
irg | Add... | O fm
*.bmp Bulk Edit...
Maximum Size | 1gazs7s | (bytes) O om
SubmitMethod | Ejectronic - © fem
—
Maximum Resolution @ Tupe Definition

Save Cancel |

Editing the constraints on an attachment set up in SFC

How can | guard against users uploading infected files?

Transaction Manager allows you to configure a virus scanning service. If configured, all attachments will be automatically virus scanned and processed only
if no virus could be found.

Currently, Transaction Manager supports two virus scan engines out of the box: ClamAV ({+}http://www.clamav.net/+) and Symantec ({+}http://www.
symantec.com/business/scan-engine+). To use either of these, you would purchase and install your engine of choice, and then configure a service definition
and service connection in Transaction Manager.

Details on how to configure and activate a virus scanning service can be found in the Transaction Manager Administration Guide, chapter "Managing Form
Attachments", section "Virus Scanning".
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Payments (Manager v5.0)

Sometimes forms require that a payment be made after the form has been filled in, e.g. to pay for services requested. Transaction Manager supports a range
of payment options, including credit card payment via a variety of providers, externally hosted payment (e.g. PayPal) and payment processed outside of TM
(e.g. BPAY).

The Transaction Manager payment module does not itself process payments and does not store credit card numbers. The actual payment is processed by
an external payment provider, but TM does monitor the payment provider, allows the user to reattempt payment and ensures payment is made before the
submission can proceed. You can review the payment log and, if required, manually mark payments as completed via the management console.

Please refer to the TM Administration Guide for more on payments and the set of supported payment providers.

How do | add payments to a Composer form?

XXX according to David, we don't have the best solution atm

How can | enable payments for my form?

Transaction Manager can request payment for your forms from the user. The payment method and amount payable are controlled by the form (which can
vary the amount depending on choices made by the user). At submission time, Transaction Manager reads the payment information from a special
"PaymentDetails" node in the form.

By default, Transaction Manager looks for this node using the XPath "//PaymentDetails", though the search path can be customized.

If you are using Composer forms, the "PaymentDetails" node will be added and its contents managed for you.

There are three payment methods supported by Transaction Manager (further information about payment types and the various payment services can be
found in the TM Administration Guide, section "Online Payment"):

® Credit/debit card The user pays via credit/debit card on a payment page provided by the TM user space. No credit card information is stored in TM;
payment is made against a payment gateway, which then transfers the amount to the organization's bank account.

® Hosted The user is directed to an external payment provider (e.g. PayPal). The payment is made via the provider's website, and the user is then
redirected back to TM along with the payment status.

® BPAY BPAY ({+}http://www.bpay.com.au/+) is an Australian system to make payments to registered organizations identified by a BPAY biller code.
For each payment, the user is also given a reference number to quote on their payment. The actual payment is made outside of TM, so TM will not
prompt the user for payment. The payment information should be shown to the user in the form itself (and on the form receipt), and the BPAY
information can also be added to the submission confirmation page displayed in Transaction Manager.

To enable payments in a Composer form, you can add an "TM Payment Total" widget to your form. You can update this field with the amount payable as the
user makes choices. If you need to declare a GST (General Sales Tax) amount, you can use the "TM GST Total" widget which contains the amount of GST
that is included in the total payment.

You can allow the user to choose the payment type by adding a "TM Payment Type Selector" palette item to your form. If you would like to hard code a
specific payment type, you can drop on a widget (e.g. "Data Field") and bind it to "$record.SFMData.PaymentDetails.PaymentType". You can then set its
value to one of "Credit/Debit Card", "Hosted" or "BPAY" to hard code the desired payment method. There are other alternatives, such as pre-populating the
available payment methods into the form.

Important note: If you set a payment total amount in your form, you MUST also specify a valid payment type (one of the values mentioned above), or
Transaction Manager will reject the form submission.

How can | use BPAY with my form?

BPAY ({+}http://www.bpay.com.au+) is a way to make online or telephone payments using two identifiers: the biller code identifying the business receiving
the payment, and a reference number identifying the payment itself.

Because BPAY involves the user making a bank transaction, BPAY payments cannot be monitored by Transaction Manager and there will be no payment
step during submission. The organization hosting the form will need to ensure that the user makes the payment (TM does record the amount the form
requested to make this easier).

To enable BPAY for a form, edit the form and switch to the "Form Versions" tab. Edit the form data configuration for the current version.

BPAY Form - Version 1.0 - Form Data Config

Home Dashboard » Form » Form Data Config

Configuration Mapping | Form XML Data | Property Prefill Mapping ] Request Param Prefill Mapping ] Input XML Prefil Mapping Submission Data Extracts

Configuration Mappings enable you to override the default form XML configuration paths for the system to write 1o and read Form XML data from.

Default Mappings
Use Default Mappings I~ &

Attachments XPath
Payment Details XPath | //PaymentDetails
Receipt XPath =

Signature XPath =]

Additional Mappings
Contact Email XPath
Save Chalenge XPath

Transaction Ref Number XPath

© @ @ €

Signatures Required XPath

Adding a configuration mapping for the payment details node
Add a mapping for the "Payment Details XPath" to the payment element in your form. Save your changes.
Your form needs to ensure that the chosen payment details element contains the following at submission time:
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* PaymentType = "BPAY"
® BPAYBIllerCode = biller code of the business receiving the payment
® BPAYReferenceNumber = reference number for this payment

Here is an example of a valid payment details element that will cause TM to register a BPAY payment for $10 with a biller code of 999999 and a reference
number of 1234567890:

<PaymentDetails> <Payment> <SubTotal/> <GST/> <ServiceFee/> <Total>10.00000000</Total> </Payment> <BPAYBillerCode>999999</BPAYBillerCode>
<BPAYReferenceNumber>1234567890</BPAYReferenceNumber> <BSBNumber/> <EFTAccountNumber/> <ClientReferenceNumber/>
<PaymentType>BPAY</PaymentType> <AccountNumber/> <ltemList/> </PaymentDetails>

TM will make a note of the payment amount and the BPAY details. However, as payment for BPAY is made via bank transfer, TM cannot monitor the
payment. Therefore, payment status is set to "Completed".

It is important to let users know that payment has to be completed outside of TM. This can be done in the form and/or by customizing the submission
confirmation page for the form.

How can | diagnose payment errors?

When using Transaction Manager to process payments (e.g. credit card payments), payment errors may occur, especially during testing. These range from
user errors (e.g. invalid card number) to configuration errors (e.g. organization not correctly configured for payment in TM) to connection errors or errors
returned by the payment provider (e.g. insufficient funds). Where this is feasible, the user will be offered the opportunity to reattempt payment, but in some
cases (e.g. configuration errors) TM prevents the user from further attempts as the error is known to be unrecoverable.

Recoverable errors generally just lead to an error message being displayed on the payment page. Unrecoverable errors mostly lead to an error being logged
to the TM error log, and an error reference number being displayed to the user.

An unrecoverable error may look like the following image.

$¥ Finance
€ £

corporation

Sorry An Error Has Occurred

& Card Payment Page Error
No payment service is configured. Please confact the system administrator,
Error Reference Number: 2035

AboutUs | Terms & Condiions | Careers | Securty &Llegal | ReportEmedFraud | Stemep | ContactUs | Diversiy & Accessibity Powered By Avoka Transact

An unrecoverable payment error

The message in this case indicates that no payment service is configured for the organization in TM. To see further details about the error, log on to the TM
management console and access "System > Error Log". Find the error log entry whose ID matches the reference number displayed on the payment error
page. The error log entry will have additional information that can help debug the problem.

In addition, failed payment attempts will also be logged to the payment log (assuming the organization is configured sufficiently and the payment service can
actually be invoked). In the management console, go to "Operations > Payment Transactions". You can find all payments for a submission by filtering by
receipt number. The "Status" column indicates whether payment was successful.

You can also view the details of individual entries to see any relevant response codes returned by the payment provider.

Payment Transactions

Home Dashboard » Payment Transactions

Payment ID Receipt Number Service Trans Number Start Date | 28 Apr 2013 00:00 j End Date j Search Clear
ID Receipt Humber Service Amount Order Time Trans Humber Status Message Action
62 cpf-icd5-15 NAB 511200 03 Jun 2013 10:38:07 Error Normal 4. (B
61 cpf-ic35-15 MaB S112.00 03 Jun 2013 10:35:08 Error Normal %, (H
42 cpf-ie3s-11 Westpac  3153.00 02 Way 2013 09:31:59 695262031 Completed Payment successful * [H
41 cpf-Rc3s-N Weslpac 315300 02 Way 2013 09:31:12 Error No universal account <4, [
34 twsl-Rc3s-3 Bizgate  $11200 30 Apr 2013 15:52:33 3990 Completed Payment Approved . B
33 tet-ite3s-3 Bizgate S18.00 30 Apr 2013 15:25:29 1968 Completed Payment Approved 4, |
32 tet-Rc3s-1 Bizgate $123.00 30 Apr 2013 15:17:26 6837 Completed Payment Approved ., B
3 cpf-Rc35-T Bizgate 523800 30 Apr2013 14:40:14 2604 Completed Payment Approved A, H
30 thpikc3s-2 PayPal 510000 30 Apr 2013 13:.48:28 Completed Success %, H
29 thpfikc35-1 PayPal 510000 30 Apr 2013 13:46:01 Completed Success %, H

F 1A00f18 Export Data

The list of payment attempts
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Signatures Options (Manager v5.0)

Like paper forms, SmartForms often need to request the user's signature to confirm their submission. Transaction Manager can provide multiple ways to
enable user signatures.
Signature methods are discussed in the Transaction Manager Administration Guide, chapter "Signatures".

How can | ask for wet ink signatures after form submission?

Transaction Manager provides a specialized wet ink signature page as an optional post-submission step. To configure wet ink signatures for a form, you can
change a form setting in the TM management console, or modify your form to set an element in the "Signatures" section. The latter allows the form to decide
whether signatures are required.
To configure the form in Transaction Manager to require wet ink signatures, edit the form and switch to the "Flow Config" panel.

Test Signature Receipt

Home Dashboard » Forms » Form

Dashboard | Details | Flow Config [ Email Verification | Form Versions ] Abandonment | Page Tracking I Spaces | Group Access

Configure the User Flow options for the form
Show Landing Page ¥ @
User Authentication j ]
Save Online  Autherticated Only j @
Show Terms & Condiions [~ @

Form Display Mode | Embed with IFrame | +| @
I—

Form Signature Required =~ Wet Signature j 9

Submission Confirmation Options

Send Confirmation Email to User  None j Q’

Show Confirmation Page [ @
Show PDF Receipts [V i@

Custom Page Flow Options

Saved Page URL @
Confirmation Page URL 2]
Canceled Page URL 7]

Form Page Close

Enabling wet ink signatures for a form

Select "Wet Signature" from the "Form Signature Required" dropdown and save.

Now, whenever a user submits the form, they will be asked to download and sign the receipt, and then either directly attach the scanned receipt or send it in
manually (see screenshot). The user cannot proceed without downloading the receipt.

9 1
o Finance

corporation

Signature Required

@ Instructions

To complete your submission you need to provide a signed copy of your Test Wet Signature Form. Please
1. Click on Download PDF and save document

2. Print the document and sign the required sections

3. Mow Either:

1. Scan your signed document, upload it and click on the Upload... option, or

2. Deliver the signed document manually, click on the Manually... option

Finally click on Continue

s

(Opens a read-only version of the form in your detault POF reader for you to print. )

Insurance
Please choose how you would like to proceed corporation
€ Upload your signed document Browse...
OR

= Manually send in the signed document

Conlinue Retum 1o Fomm Cancel Submission

About Us. | Terms & Condtions | Careers | Securiy &Legal | ReportEmail Fraud | Siemap | ContactUs | Diversity & Accessiity Powered By Avoka Transact

The wet signatures page on the user portal
Please refer to the next section to learn how you can let the form decide whether signatures are required.
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Can the form decide whether signatures will be required?

In addition to configuring signature options in Transaction Manager, the form itself can also decide if signatures will be required, and if so, what signature
method is to be used. This gives you greater flexibility in the form (e.g. signature required only in some cases, user can choose how to sign the form).
The form can communicate the information regarding signature type via a specialized section named "Signatures" in TM. The section has the following
structure:

<Signatures>

<SignatureTypeSelected />

</Signatures>

The form can set three different values for the "SignatureTypeSelected" element to indicate that signatures are required:

® Wet The user must provide a signed copy of the form receipt. The example spaces in TM provide a wet signature page where the user can
download the receipt and choose how they will provide the signed receipt (see previous section for a screenshot).

® ESignature The user is presented with an electronically signed receipt and can choose whether to accept the receipt or cancel the submission. The
example user spaces provide an eSignature page to accomplish this.

® Digital Digital signatures using a certificate can be done in the form. If the "SignatureTypeSelected" is "Digital", Transaction Manager assumes that
signatures have been completed in the form and sets the submission status accordingly. No further request for signatures will be made of the user.

If any other value (including no value) is used by the form, the value will be ignored, and if a signature method has been set up for the form in the TM
management console, it will be used.
If your form has a seed file with default configuration mappings (edit the form, switch to "Form Versions" tab, click "Form Data Configuration" (

?  Unknown Attachment
) next to the current version and check if "Use Default Mappings" is ticked), then the "Signatures" element is looked

up using the XPath "//Signatures". This means that your element can be located anywhere in the seed file and must be named "Signatures”. If this is not the
case, or if you have multiple "Signatures" elements in your seed file, you will need to specify the mapping explicitly.
To set up an explicit mappings to the "Signatures" element, edit the form, switch to "Form Versions" tab and click "Form Data Configuration™ (

? Unknown Attachment

) next to the current version.
Untick "Use Default Mappings" so you can edit the mapping. Note: If your form uses attachments, payment or a receipt section populated by TM, ensure you
enter mappings for the corresponding XPaths as well, since default mappings no longer apply. You can re-enter the default mappings, which are displayed
as a placeholder in the fields.
Enter the desired XPath into the "Signature XPath" field. Ensure the XPath is unambiguous for your form.
Test Wet Signature Form - Version 1.0 - Form Data Config

Home Dashboard » Forms » Form » Form Data Config

Configuration Mapping | Form XML Data [ Property Prefil Mapping | Request Param Prefil Mapping Input XML Prefill Mapping Submission Data Extracts

Configuration Mappings enable you to override the default form XML configuration paths for the system to write to and read Form XML data from

Default Mappings
Use Default Mappings [ @

Aftachments XPath @
Payment Details XPath L7 ]
Receipt XPath 7]
Signature XPath = //Signatures @
Additional Mappings
Contact Email XPath 7]
Save Challenge XPath 7]
Signatures Reguired XPath 7]

Mapping the "Signatures" element

Save the mappings.

In Composer, you can use a wet signature widget to add a signature block, which will allow users to sign the receipt, and you can also set the selected
signature type to a value of your choosing.
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Receipts (Manager v5.0)

Receipts are often an important part of the form submission process, providing the user with an uneditable copy of the data they submitted. Transaction
Manager generates PDF receipts for all form submissions, along with a unique reference number (the receipt number) that identifies the submission. You can
configure whether or not to allow the user to access the receipt, and include it in submission delivery.

How do I include a custom barcode in the PDF receipt?

XXX get more info from Composer team

Can | control how receipt numbers are generated?

Transaction Manager offers you multiple ways to generate receipt numbers for a form. You can specify a parameterized pattern that TM will use to create the
receipt number, invoke a web service you provide, or implement your own receipt number algorithm using a Groovy script. Groovy is a very simple but quite
powerful scripting language that will be familiar to Java or C# programmers.

Receipt number generation is configured on a form level, and uses service definitions defined globally in Transaction Manager (allowing re-use of receipt
number services between forms).

The Transaction Manager Administration Guide discusses receipt number generation in detail and shows you how to configure your form accordingly. Please
refer to chapter "Form Configuration”, section "Receipt Number Generation”.

Can | use a separate PDF template for the receipt?

You can use a separate PDF file as a receipt template for all form types. For Composer SmartForms, a PDF receipt template can be automatically generated
by Composer (depending on the template used by your Composer forms).

Note: Ensure your receipt template uses the same form data structure as the form template. Otherwise the receipt may not render correctly.

To upload a receipt template in the TM management console, edit the form and switch to the "Form Versions" tab. Edit the current version and upload the
desired receipt template using the "Upload receipt file" field. Click "Save" to apply your changes.

Test Signature Receipt - Version 1.0

Home Dashboard » Forms » Form » Form Version

Form Version | Properties | AttachmentRules | Services | FormCategories | FormTags | PDF Options | Form Archive Info

Version Number* ' 1.0 @
Form Type® Composer SmartForm j L

Render Form Template = PDF Form LI @
Notes

Form Template
Upload Form or FAR File Browse_ | Mofile selected. 9

Receipt Template

Upload Receipt File Browse_ | FC_TestForm.pdf 2
Upload Signature File Browse_ | Nofile selected L7}

Receipt XML Mapping Browse . | Nofile selected. @

Use Delivery Receipt [~ @

Receipt Process Timeout j @

Form XML Data

Form XML Data File Browse_ | No file selected 9

Save Edit Form Data Config Close

Specifying a receipt template for an existing form version
When creating a new form using the "New Form" wizard, you can upload a receipt template on the "Resources" tab (if a suitable receipt template is not
already contained in the FAR file for Composer SmartForms).
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New Form Wizard
Home Dashboard » Forms » Form » Form Version » Mew Form Wizard

Use the New Form Wizard to quickly create a new form.
Simply complete the required details, upload your form template and press Finish

Form Resources | Spaces | PDF Options

Form Template

Upload Form or FAR File Browse_ | insurance far @

Receipt Template

Upload Receipt File Browse_. I FC_TestFom pdf @

Form XML Data

Form XML Data File Browse_ | No file selected @
< Back Next > Cancel

Specifying a receipt template on the "New Form" wizard

The PDF receipt won't render, what can | do?

XXX test harness, logs

Can | use HTML receipts?

XXX what is our policy here? how does mixed mode work (is there a system defaultable service that can handle both? or do you have to decide on one and
configure ALL other forms explicitly?)

XXX PhantomJS, how to set up service, Composer side: enable this in the template (is enabled in Maguire template only), totally transparent to form
developer, at publish time Composer includes a .dat file (encrypted HTML) as the receipt template
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Delivery (Manager v5.0)

Once the user submits a form (and also completes all subsequent steps such as payment, attachments and signatures), the submission is delivered to a
backend system. There are multiple ways to deliver submissions built into Transaction Manager, and you can configure delivery on a form level.
Transaction Manager can be configured to automatically purge submission data from the TM database after it has been delivered.

How can | deliver submitted form data to my own database?

There are multiple delivery methods supported by Transaction Manager. These range from simple email delivery to web service delivery as well as custom
delivery via a Groovy script delivery service.

The Transaction Manager Administration Guide, chapter "Delivery Configuration" discusses all available delivery methods as well as how to configure
delivery for a form. This section will explain custom delivery using a Groovy script in further detail. Groovy is a very simple but quite powerful scripting
language that will be familiar to Java or C# programmers. It is used in Transaction Manager to allow administrators to define and modify behavior at runtime.
Custom delivery allows you to adjust the delivery logic by modifying a Groovy script. This allows you to deliver submission data to a wide range of backend
systems and customize exactly what data will be delivered. Because you can provide and modify the delivery logic, this is an extremely flexible delivery
method and can be used to address a multitude of special requirements. If the logic needs to change, the Groovy script can be modified at runtime.

To set up a new Groovy delivery service in Transaction Manager, go to "System > Service Definitions" and filter by service type "Delivery Process". You can
either edit an existing service or create a new Groovy delivery service based on a template. In the latter case, click "New".

New Service

Home Dashboard » Service Definions » Mew Service

Create a new Service based an a Service Template.

Service Type = Delivery Process j @
Service Template*  Groovy Delivery Process :I a9
Service Name * | My Groovy Delivery Service @

Organization j

Save Cancel

Creating a Groovy delivery service based on a template

Choose "Delivery Process" from the "Service Type" dropdown. Choose a suitable service template (e.g. "Groovy Delivert Process"). Enter the name of the
new service into the "Service Name" field and click "Save".

Please refer to the TM Groovy services guide ("System > Transact Services Guide") for details and examples.

Can | deliver submission data to SalesForce CRM?

You can publish to SalesForce CRM as well as a multitude of other systems using the Groovy script based delivery mechanism in Transaction Manager.
The following Groovy script shows how submission data can be delivered to SalesForce. Please refer to the previous section to learn how to set up a Groovy
delivery service.

import groovyx.net.http.*

import groovy.json.JsonSlurper;

import static groovyx.net.http.ContentType.JSON

import static groovyx.net.http.Method.POST

/I Get contact details

def AvokaSmartForm = new XmlIParser().parseText(submissionXml);

def model =[]

model.email = AvokaSmartForm.YourDetails.Name.Email.text()

model.firsthame = AvokaSmartForm.YourDetails.Name.Firstname.text()
model.surname = AvokaSmartForm.YourDetails.Name.Surname.text()
model.organisationName = AvokaSmartForm.YourDetails.Name.OrganisationName.text()
model.country = AvokaSmartForm.YourDetails.Name.Location.Country.text()
model.contactPhoneNo = AvokaSmartForm.YourDetails.Name.ContactPhoneNo.text()
model.description = AvokaSmartForm.Enquiry.QuestionsComments.Questions.text()
model.state = AvokaSmartForm.YourDetails.Name.Location.State.text()

def eventLogService = new com.avoka.fc.core.service.EventLogService()

/I Create Lead in SalesForce

[l initialze a new builder and give a default URL

def http = new HTTPBuilder('https://www.salesforce.com/servlet/")

def postBody = [

oid: 'XXXXX', /I replace with correct value

first_name: model.firstname,

last_name: model.surname,

email: model.email,

phone: model.contactPhoneNo,

company: model.organisationName,

state: model.state,

country: model.country,

lead_source: 'Test Enquiry’,

Campaign_ID: '108A00000001XYZ',

description: model.description,

|

http.post( path : 'serviet. WebToLead?encoding=UTF-8',

body : postBody,

requestContentType: ContentType.URLENC ) { resp ->

eventLogService.loginfoEvent("SalesForce Response: " + resp.statusLine, submission)

}

The script needs to be adjusted to suit your circumstances. The example implementation publishes data extracted from an enquiry form into SalesForce and
logs an information event against the submission when this has happened.
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Can | call a web service to deliver the submitted form data?

You have three options to use a web service for submission delivery:

1. Use web service delivery if you can provide a web service implementing the Forms Server web service. Refer to the Transaction Manager
Web Service Guide for more information on these APIs. The Transact Integration Agent is a Transact component that is installed on a client site and
provides an out-of-the-box implementation along error handling, push or pull delivery, and configurable delivery of submission data on to your
backend.

2. Use Groovy delivery to invoke arbitrary web services. This option requires you to write a Groovy script that calls the web service and handles
delivery. This method allows you to integrate with a web service of your choice, but the implementation needs to be considered carefully (e.g. error
handling) and will require thorough testing. To achieve this, create a new Groovy delivery service as described in the previous section and
customize the Groovy script.

3. Use REST delivery to pull down submissions on demand This option allows you to call a REST endpoint to retrieve submission data. Please
refer to the Transact services guide in the TM management console ("System > Transact Services Guide") for details and examples.

How do | retry delivery if there is an error?

While submission delivery is done automatically by TM according to the delivery channel configured, there is a multitude of delivery errors that may occur (e.
g. network outages, constraint violations in backend systems, errors in Groovy delivery scripts). Once the source of the error has been found and addressed,
submissions that encountered delivery errors need to be redelivered. Depending on submission volume and length of the outage, many submissions may be
affected.
TM offers a range of tools to manage submission delivery retry, ranging from automated retries to manual delivery retry (for individual submissions or in
bulk). Groovy services can make use of delivery checkpoints to record which delivery steps have been successfully completed, and which ones have to be
executed during a retry.
The easiest way to retry delivery for one or more submissions is via the "Transaction Delivery" page ("Operations > Transaction Delivery").

Transaction Delivery

Home Dashboard + Transaction Debrery

Delvery Stalus  Emor ﬂ Form Delivery x| Form ﬂ Start Date :| w Clear

Delvery Message Max Records | 100 :l End Date :

Malke Al Delwery Ready Clear All Delvery Checkpaints Make All Delvery Completed Make All Undelwerable
Receipt Delivery Delivery . Mext
. [

L] Form Name Org. Mk Status Time Delivery Message Checkpoints  Attempts Attampt Action
frankTessFW fncarp testform-9 Error 22 Aug 1B 48 GroovyDelveryProcessService 1af1 L AR
frankTessF fincarp testiorm-2 Error 22 Aug 18:45  GroovyDedveryProcessService 1o0f1 L2 4 ™

1626  frankTestFw fricarp testform.7 Ermo 22 Aug 1845 GroowyDedveryProcessService 1011 N b

1625  frankTessFw fncarp testform & Error 22 Aug 1848 GroowyDeiveryProcessService 1af1 L AT

1624  fromkTestFW fincarp testform-5 Error 22 Aug 18:46  GroovyDedveryProcessSerice 1of1 L ™

1623  frankTestFw fricarp testform.4 Ermo 22 Aug 1846 GroowyDedveryProcesaService 1011 g ) =
WMacquarie WMortgage o Froe Delivery Checkpoints with Enrors: [Create And Send Compieted 0 of L =

159 MACQUAR -27 Ermo 16 A T » > -

88 Apglicatior ACQUARE  applcation-2 Erm 6 Aug 16 Envelspe] 1
Macquarie Wortg . . - ivery Chec mrors: [C A . Y ™

1508 .s. uane Mortgage MACQUARE sppication.26 Error 16 Aug 1625 El!l ery Checkpoints with Errore: [Create And Sand Fomulemcc of Sals L 3
Apphication Envelope]

——— ckpoints v frors: [C And S o -

1588 I: acquarie Mortgage MACOUARE apglication-25 o 16 Aug 1429 ?:Ir.: ry Checkpoints with Enrors: [Creale And Send l;omu:::nl: of = s &
Apglcaton Envelope]

. Wacguone Wortgage: A s s — am 4w aane Delfivery Checkpoints with Emors: [Create And Send Completed 0 of L AEDT

The "Transaction Delivery" page
You can filter by various search criteria, chief among them delivery status. If you search for delivery status "Error", you will see the set of submissions for
which delivery has failed (note that not all records may be shown - you can increase the value of the "Max Records" dropdown). As shown in the screenshot
above, the delivery time and error message are shown. Information about the number of completed delivery checkpoints and the number of automated
retries will be shown where applicable.

You can then either retry delivery for individual submissions ( 1o retry delivery as is and ‘?« to clear out all delivery checkpoints and then retry delivery) or
change the delivery status for all search results via the buttons above the table (e.g. "Make All Delivery Ready" to retry delivery for all submissions shown).
Monitor the results to ensure delivery is completing normally.

How can | deliver form data submitted to a TM cloud instance to an Enterprise
Information System in another datacentre?

Enter topic text here.

How can | transform the form XML data into an enterprise XML data schema?

Enter topic text here.

How can | purge form submission data from TM once it has been delivered
into our system?

TM gives you a wide range of options around data retention. You can specify these settings globally, and override some important submission data retention
settings for specific organizations if needed. Please refer to the TM Administration Guide, chapter "Operations"”, section "Data Retention".

Configure global retention settings
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XXX This is covered in the admin guide and doesn't add anything here
To configure submission data retention globally, log on to the TM management console and go to "System > Data Retention Management".

Data Retention Management

Home Dashboard » Data Retention Management

Retention Settings | Data Status

Transaction Records
Enforce Global Threshold [V @

Open Form Transactions max age | lday _=| @
Form Transactions ma= age lyear =] @

Deivered / Undeliverable Form Data max age = Use Transaction Policy Ll 7]
Saved / Abandoned Form Data max age = 6 months ;l <@

Form Requests max age  1year =] &

Historical Transaction Data

Form Transaction History max age  Syears A@

System Logs
Email Queus max age  Emonths =] @
Error Log maxage lyear =] &
Event Log max age lyear =] @
Import Log max age  6menths =] @
TransactField Client/ Sync Log max age = 28 days ;l o
Security Audt Log max age | Tyear =] '@

Server Health Log max age = 28days =] @

Close

Global data retention settings

The first section, "Transaction Records", concerns submission and request log data. You can specify retention settings separately for saved (including
abandoned) submissions, delivered (including undeliverable) submissions and all form submission (which includes saved and delivered submissions as well).
In addition, you can specify how long request log entries shall be retained.

Most of the above settings can be overridden on the organization level (see the next section). If you would like to enforce the global data retention thresholds
as the maximum values that can be chosen on the organization level, you can tick the "Enforce Global Threshold" checkbox.

Records exceeding the maximum configured age will be deleted from Transaction Manager. Ensure you have suitable delivery settings in place for all forms
to avoid data loss.

In addition to maintaining submissions and form requests with associated data, Transaction Manager also maintains summary tables for statistical purposes.
These tables are much more compact than the submission and request log, and are used by various reports and the dashboard in Transaction Manager. You
can configure the retention policy for these summary tables in the "Historical Transaction Data" section.

Save your changes.

Configure organization specific retention settings

To configure organization specific retention settings, edit the organization and switch to the "Storage Settings" tab.
Quick Start Client

Home Dashboard » Organizations » Organization

Organization I Delivery Channeis I Payment Gateway I Properties l Portal Access I Form Categories I Form Tags I icat l Report ]

Data Retention Policies

Form Transactions max age | 1year ;l @
Deiivered / Undeliverable Form Data max age = Use system defautt = | &

Saved / Abandoned Form Data max age | 30 days ;l a@

Data Storage Settings

Data Storage Encoding = Use system default =@

Data Encryption Key Rollover ~ Monthly [~ | @

Close

Organization-specific data retention settings

The first section, "Data Retention Policies", allows you to adjust the submission data retention settings for saved, delivered and all submissions. The "Use
system default" option means that global data retention settings will be used; alternatively, choose a different value to override the global policies for this
organization.

Save your changes.
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Reporting (Manager v5.0)

Transaction Manager includes extensive reporting capabilities including a dashboard and submission data summary reports built into the management
console, as well as flexible reports based on the BIRT framework that can be viewed on-screen or emailed out on a schedule.
The TM Administration Guide talks about the BIRT reports (chapter "Reports") and charts (chapter "Operations", section "Charts") in detail.

Can | create an summary Excel report based on submitted data?

Transaction Manager includes support for extracting values from the submitted XML at submission time and storing them to the TM database, where they
can be queried and reported on more easily. In addition, TM provides a summary page in the management console where a tabular representation of the
data extracted for a specific form can be viewed and exported to Excel.

To learn how to set up data extract mappings for a form, please refer to the Transaction Manager Administration Guide, chapter "Form Version
Configuration”, section "Setting Up Data Extract Mappings". Once set up, TM will store data extracted from the form at submission time.

To view the extracted data in a tabular summary in the TM management console, go to "Operations > Form Submission Data". Select the form and version
from the respective dropdowns, and optionally filter by submission date.

Form Submission Data

Home > Form Submission Data

Form [Teﬁ Payment Form ZI Version |2 = | Start Date |E3 Apr 2011 00:00 j End Date I'M Jul 2011 1241 : [V Active Only SR Clear
Last Name First Name Reference No Action

Baker Jane 78bf71e9a3aa74540d72c04df6a25edd T |~

Willer Mary Sue 68290410d1e860e51e832194e0713056 T

Smith John §5326Mb0453ecaBlic3882d0cTc0T 4608 u

i
Viewing data extracted from submissions for a form version

To obtain an Excel report based on the search results, click the ‘i| icon at the bottom right of the table.
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Task Creation (Manager v5.0)

TM allows you to assign tasks to users and user groups. These tasks can reference a form that is to be filled in, and optional prefill data, or they could
reference an existing submission that is to be reviewed. Tasks can be created via the management console or a web service interface. For details about the
Task / User web service please refer to the TM Web Service Guide.

Note: This chapter references version 2 of the Task / User web service specifically. Version 1 is still exposed by TM, but this is for backward compatibility
reasons only, and version 2 should be used for new projects.

Can | create a task to review an existing submission?

Transaction Manager allows you to create review tasks, which are based on a previous submission, as well as form tasks.

Using the Transaction Manager Task / User web service API version 2, you can use the CreateFormReviewTask operation to create a review task. The
operation is described in detail in the TM Web Service Guide.

You can also create tasks using the TM management console. To create a review task, go to "Operations > Assigned Tasks" and click "New". Select
"Review" from the "Task Type" dropdown and enter the OID of the existing submission into the "Previous Submission ID" field. If you do not provide form
XML data, the XML associated with the existing submission will be passed into the task form by default. Fill in the other fields as usual.

How can | create a task using the web service API?

XXX

Can | assign tasks when using the Web Plugin?

Enter topic text here.

Can | add file attachments when creating a task?

Enter topic text here.

How can | notify assignees of a new task?

Assignees will see new tasks appear in their To Do list on the user space. In addition, you can have an email sent to the assignee(s) when the task is created.
When using the Task / User web service version 2, the two "Create*Task" operations contain parameters that allow you to control whether an email will be
sent ("sendEmailFlag") as well as the email subject and message ("emailSubject”, "emailMessage". For more details on these operations, please refer to the
Transaction Manager Web Service Guide.

When creating a task using the TM management console ("Operations > Assigned Tasks", click "New"), you can tick the "Send Email to Assignees"
checkbox and enter the email subject and body (the screenshot below shows the relevant part of the task creation page).

Task Deletable by User [

Send Email to Assignees [
Email Subject Please complete a form task on SFM
Dear Jane,
Can you please complete the attached task by December 17

Please access the task via your to do list on:
Emai Message https://sfmhost.com/govassist

Best regards,
John Smith

Form Name ~ Payment Details - HTML j

Task Form Data =l

Close

Email settings for a new task
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Old topics (Manager v5.0)

Enter topic text here.

Portal Integration Options

Transaction Manager offers a variety of options to expose forms to your target audience. You can use the Self Service portal, which provides a complete
solution for end-to-end form fill-in. If you already have a web portal into which you would like to integrate form fill-in, you can easily add calls to the Web
Plugin module to render forms. If you wish to provide your users with sophisticated form lookup as well as offering existing resources, you can use the Finder
module to provide custom form and resource finding.

Using the SmartForm Web Plugin

This chapter provides information about the SmartForm Web Plugin, including ways to integrate the web plugin with your own web environment.
XXX review and rework entire chapter

Introduction

The SmartForm Web Plugin is a JavaScript library that users can incorporate into their own web environment. It provides functionality to link to or embed
specific forms hosted in SmartForm Manager.

The SmartForm Web Plugin is generally used if you already have your own branded web portal and want to embed forms inside it without styling your own
SmartForm Manager Self Service Portal. Note that the Web Plugin supports only unauthenticated (or externally authenticated) transactions and does not
provide a personalized user area.

Integrating with the Web Plugin
The SmartForm Web Plugin is used by referencing the "smartform-webplugin.js" script from the web-plugin portal, then referencing either the "Avoka.
SmartForm.WebPlugin.showEmbeddedForm()", or the Avoka.SmartForm.WebPlugin.showPopupForm() function from the script in your web pages,

depending on what you are trying to achieve. Both functions require at least 3 common parameters; formCode, userAccountld, and redirectTarget. Further
parameters can be supplied to include prefill data for the form, or specify window options for popup forms, as described in the following sections.

Using Popup Forms
Links in a web page to a popup form can be implemented with the following code:

Error rendering macro 'code’: Invalid value specified for parameter 'com.atlassian.confluence.ext.code.render.InvalidValueException'

Using Embedded Forms

Forms can be embedded into a web page using the following code:

Error rendering macro ‘code’: Invalid value specified for parameter '‘com.atlassian.confluence.ext.code.render.InvalidValueException'

Parameters
Both popup and embedded forms require 3 common parameters:

* formCode The unique form code of the target form.

® userAccountld The user's login name on the portal (XXX this is presumably not required - or does it need to be the empty string for anonymous

requests?)

® redirectTarget The URL of your submission confirmation page.
Additionally, data can be prefilled into the form using a "prefillData" parameter. This parameter should contain a list of name/value pairs. In order for these
parameters to be mapped into the form at runtime, you will need to set up request parameter prefill mappings with matching names for the form's data
configuration. Please refer to the SmartForm Manager Administration Guide, section "Setting up Request Parameter Prefill" for information on how to set up

these mappings.
The following example shows data prefilled into a popup form.

Error rendering macro 'code': Invalid value specified for parameter 'com.atlassian.confluence.ext.code.render.InvalidValueException'

Using SmartForm Finder

XXX

Introduction
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XXX this is out of the admin guide - rework?

Users can search for forms on the Turnkey Self Service Portal by using conventional search fields and filtering. If there is a large number of forms or if
external resources should be referenced as well, however, more sophisticated form finding methods may be needed.

SmartForm Manager provides a way for users to search for forms or external resources by answering a series of questions about their needs. Each answer
is used to filter the set of forms and resources.

A set of questions that are used to filter forms is called a finder category. It contains a form data file describing the forms and resources that shall be exposed
as well as a user interface definition file. This separation is useful when a form data file is exposed multiple times via different user interface definitions.

The SmartForm Finder module is an example of how a finder category might be rendered, providing a user interface to progress through the set of questions
and display matching forms. In addition, users can also search the entire set of forms and resources by keyword.

Setting Up Finder Categories

XXX refer to admin guide or duplicate the section?

Accessing SmartForm Finder

XXX refer to admin guide or duplicate the section as done below?

Please note: The Transact Finder module contains an example page that will display the finder category with code "grants", if one exists. Generally, agencies
would provide their own finder page using a Transaction Manager finder category. For more information around this, please refer to the Transact Finder
Examples module (“avoka-sf-finder-examples.war"), which is created by the TM installer.

To be able to access the Transact Finder module, it must be deployed on your Transaction Manager instance. The relevant deployment module is named
"avoka-sf-finder.war".

To access Transact Finder, create a finder category with code "grants" and then access

<TM server root>/finder e.g. http://transactionmanager.com/finder

Figure 121 shows the Transact Finder after the user has answered two questions. Note also the global search field and the quick navigation bar at the top
that allows the user to jump to one of the previous questions.

Old SSO

Enter topic text here.

Anonymous form access_2

Transaction Manager can be used to present forms to anonymous users. You can configure whether authentication is required at the form level. However,
there are several reasons for wanting Transaction Manager to know the identity of the user, such as:

* Prefill (or pre-populate) the form with information you already know about the user, such as their first and last name. Prefilling a form makes it easier
for the user to complete their form.

* Prefill the form with information you can look up about this user in external system, such as their account number or their existing services.

® Restrict or grant access to different forms based on the groups the user belongs to.

Prefill for anonymous users_2

It is possible to achieve prefill of forms without Single Sign On implementation. For example, using the TM Web Plugin, the hosting web application can
embed the form, passing a number of URL parameters to Transaction Manager. Transaction Manager, in turn, can inject these parameters into the form's
XML, or use these URL parameters to look up information in external systems (please see chapter "Prefill" for details and other prefill options). In many
cases, this is actually the simplest way to implement prefill.

Single Sign On implementations_2

There are many different vendors who provide SSO solutions, as well as open source solutions. These solutions tend to be quite different from each other in
terms of the way that they are implemented. There are a variety of techniques in use, including browser plugins, http headers, cookies, Java applets, smart
cards, one time password tokens, integrated windows authentication, and Kerberos. There are also some other techniques to implement single sign-on such
as Openld, used by Google, Yahoo, and MySpace, and many others.

Transaction Manager does not support any particular SSO implementation out of the box. However, Transaction Manager does provide an SSO based
authentication provider whose functionality can be specified at runtime by modifying Groovy scripts. This allows integration with many SSO solutions without
requiring a custom build of TM.

To configure SSO authentication, log in to the TM administration console and go to "Security > Security Managers". Edit the security manager named "SSO
Security Manager" (or create a new security manager based on the "SSO Security Manager" template. You can provide three Groovy scripts to customize
the SSO authentication behavior: the "Get SSO Auth Token Script" and "Auth OK Response Script" scripts on the "SSO Auth Filter" tab and the
authentication provider's Groovy script parameter, which handles authentication itself. Please refer to the TM Groovy services guide ("System > Groovy
Services Guide") for more details about these scripts and example implementations.

SAML 2

A common Single Sign On standard is known as SAML, or Security Assertion Markup Language. SAML is an XML-based open standard data format for
exchanging authentication and authorization data between parties. Importantly, SAML assumes the existence of a security provider, which is not specified by
the standard.

There are many different ways and patterns in which SAML can be implemented, and many different security provider implementations. SAML is really more
suited to loosely coupled federated SSO across multiple domains than it is to SSO across multiple web applications in a single enterprise - however it may be
used in this context.

Transaction Manager has been successfully integrated with SAML-based implementations. The complexity and duration of the integration depend greatly on
the specific implementation.
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Additional ideas (Manager v5.0)

Garry:

add something around best practice for defining print-friendly forms

form validation: For 3.4 specifically, maybe add something here on in-field validation, also touch on specific ways to validate ie per section, per form etc
attachments: Provide something about best practice configuration for attachments within the TransactField App

payment: How can we connect through to other payment providers

delivery: touch on Groovy script delivery Also, maybe touch on different stages of submission here to include why we would use certain endpoints, such as
form submission pre-processor and submission completed processor

reporting: | also would like to use the submission data extract option to view a cut of the data as it comes in

Lena:

describe the Composer publish workaround to keep publishing to a specific form in TM after the FAR form key changes

jobs, form bundles

Keyword index

No index entries found.

329



Data Retention Management (Manager v5.0)

Transaction Manager incorporates a sophisticated data retention management capability which is used to control the growth of database tables, to maintain
high system performance, and also to purge transaction form data which contains Personally Identifiable Information (PIl) entered by end users.

Many entities have a maximum age, after which TM will delete them automatically using scheduled jobs. These maximum ages can be adjusted globally, and
some transaction related settings can be defined on an organization and/or form level.

Data Retention Policy Mode

There are two data retention policy modes in TM: strict and relaxed.

The mode affects how long (as a maximum) transaction related data can be kept in TM. For either mode, you can still configure the exact values for
individual data retention settings.

The following describes the differences between the two modes. Note that the data retention settings mentioned will be discussed in section Transaction
Record Settings below.

Strict Mode Relaxed Mode
Saved Transactions max 180 days, default 30 days max 2 years, default 30 days
Finished Transaction PIl Data = max 30 days, default 7 days max 2 years, default 7 days
Transaction Records max 2 years, default 90 days max 5 years, default 180 days
Finished Job Records max 2 years, default 90 days max 2 years, default 180 days
Submission Data Extracts deleted with Finished Txn PIl Data = optionally deleted with Finished Txn PIl Data
Submission Properties deleted with Finished Txn PIl Data = deleted with Transaction Records

The data retention policy mode is selected in the TM installer (both during a new installation and an upgrade). You can see what data retention mode your
server is using by accessing "System > System Info" in the "Build Properties" section.

Generally, we recommend that you use strict mode whenever possible, as it restricts the maximum transaction data age, avoiding problems caused by long
data retention (database growth, performance decrease, long storage of sensitive personally identifiable information).

Data Retention Settings

Configuration of the data retention policies is performed using the "System > Data Retention Management" page. Access to this page is controlled via the
Transaction Manager "Service Edit" permission.

Changes made to the retention settings will be used the next time data retention jobs run. If you want to start a data purge run immediately, click "Apply
Policy" after saving your changes.

Data Retention Management
Heme Dashboard » Data Retention Management

Retention Settings | Transactions | Collaboration Jobs System Logs Top Table Sizes

Transaction Records (max age)
Enforce System/ Org Thresholds |+ &

Saved Transactions (days)™ 30

o ©

Finished Transaction Pll Data (days)* | 7

©

Finished Transactions (days)™ | 90

©

Finished Cellaberation Jobs (days)™ | 90

System Logs (max age)

©

Transaction Histery =~ 180 days ¥

©

Error Log = 30days ¥

©

EventLog 30days ¥

©

Groovy Service Log | 30days ¥

©

Scheduled Job History | 30days ¥

©

Security Audit Leg 1 year v

©

Security Manager Log = 30days ¥

©

TField App Logs  30days ¥

©

User Login Histery |~ 180 days ¥

m Apply Policy Reset Defaults Close
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Read on for details of the individual settings and their meaning.

Transaction Record Settings

Transactions are a central entity in TM. Each transaction corresponds to a form submitted by a user and is associated with a multitude of other entities such
as submission history entries, submission properties, data extracts and attachments.

Transactions are crucial to data retention for two reasons:

1. Transactions are continually generated and contain a large amount of data.
This can lead to large database sizes and degraded performance if data is not purged regularly.

2. Transactions contain user-entered personally identifiable information.
This can pose a security risk if attackers gain access to data stored in TM. While TM comes with a number of data security measures, it is still
advisable to ensure that personally identifiable information is purged once transactions have finished.

So generally, you want to keep your purge settings strict, so that data is purged regularly, keeping the system performant and secure. TM supports this
approach by ensuring that data is deleted only when the submission is in a finished state (either completed successfully and delivered to the back end, or
abandoned).

To understand the settings that are available, we need to look at the transaction life cycle. There are three different categories a transaction can fall into for
purposes of data retention:

1. Completed Transactions
The submission is not part of a collaboration job and has been successfully completed by the user, and delivered to the backend system (if
configured in TM). No further user interaction is anticipated, and as all the data has been delivered, the countdown to submission deletion starts at
completion time. The maximum age of completed submission records is controlled by the "Finished Transactions" setting.
Note that submission data (including submitted XML and attachment data) makes up the lion's share of a submission's data footprint. To alleviate
this, submission data for finished submissions can be set to be deleted well before the actual submission record is deleted. This is controlled with
the "Finished Transaction PIl Data" setting. When PII data has been deleted, the submission is still visible in the TM submission log (but the XML
data cannot be viewed, and attachments cannot be downloaded any more).

In Progress Finished Transaction Deleted
Saved + Completed & Delivered
Submitted

!

Transaction Records !
Transaction Data « — >

7 days 180 days
Retention Policy: Finished Transaction Pll Data Finished Transactions
Created Deleted

! |

Transaction History | :

5 years

2. Abandoned Transactions
The submission is not part of a collaboration job and has been abandoned (by the user, an administrator or automatically after a period of inactivity).
Data for abandoned submissions may have been delivered if configured in TM. Generally, abandoned submissions will be quite common, especially
caused by users opening a form (perhaps just for a first look) and then closing it without submitting it. While this is normal, the amount of data
generated by abandoned submissions can build up, so it is important to delete these submission records.
The maximum age for abandoned submissions is controlled by the "Finished Transactions" setting, with one exception: Submissions that were
opened by users but never saved or submitted (as mentioned above) are deleted after two days.
Note that submission data (including submitted XML and attachment data) makes up the lion's share of a submission's data footprint. To alleviate
this, submission data for finished submissions can be set to be deleted well before the actual submission record is deleted. This is controlled with
the "Finished Transaction PIl Data" setting. When PII data has been deleted, the submission is still visible in the TM submission log (but the XML
data cannot be viewed, and attachments cannot be downloaded any more).

331



In Progress Finished Transaction Deleted

Saved * Abandoned

Transaction Records !
. ]

Transaction Data « — >
-« — >4 >

30 days 7 days 180 days

Retention Policy: Saved Transactions Finished Transaction Finished Transactions
Pll Data
Created Deleted

Transaction History

5 years

3. Collaboration Jobs
If a submission is part of a collaboration job, it is not purged as part of normal submission purging. Instead, TM uses the "Finished Collaboration
Jobs" policy to purge the collaboration job and all its submissions once the entire job has finished.

In Progress Finished Job Deleted

*+  Completed

* Cancelled

+  Expired
Job Records | |
Transaction Records ' ]

4 —— »
180 days

Retention Policy: Finished Collaboration Jobs

Now let us look at the set of transaction related data retention settings available via "System > Data Retention Management", tab "Retention Settings".

Transaction Records (max age)
Enforce System / Org Thresholds |« g

Saved Transactions (days)™ | 30 7 |

Finished Transaction PIl Data (days)™ 7 7 |
Finizshed Transactions (days)® o0 7 |
Finished Cellaboration Jobs (days)™ | g0 2]

The "Enforce System / Org Thresholds" relate to settings that can be overwritten on the organization and/or form level (more on that below). If ticked, then

the policies defined at a lower level cannot be more lenient than the corresponding setting at a higher level.

For example, if this checkbox is ticked and the global "Finished Transaction PIl Data" policy is set to 14 days, you cannot enter values greater than 14 days
for the "Finished Transaction PIl Data" policy on the organization or form level. If an organization's value of the "Finished Transaction PIl Data" policy is 10
days, you cannot configure any of its forms to have a "Finished Transaction PIl Data" policy value greater than 10 days.

Thresholds are only relevant to the "Saved Transactions" and "Finished Transaction Pll Data" settings.

Note: Even if "Enforce System / Org Thresholds" is ticked, changes to global or organization policies DO NOT affect the values set on lower levels. For
example, if an organization has a "Finished Transaction PIl Data" policy value of 14 days and you change the global "Finished Transaction PII Data" policy
value to 7 days, the organization value will remain the same until the organization settings are edited. This avoids problems around accidental changes to
global policies trickling through the entire system.

The "Saved Transactions" setting allows you to specify the number of days after which a submission that was explicitly saved by a user will be abandoned
(unless of course the user returns and submits the form). Note that the submission is not deleted at this point, but it counts as a finished transaction and the
countdown for Pl data deletion and submission record deletion start ticking at abandonment time.

This setting can be customized on both the organization and form levels.

The "Finished Transaction Pll Data" setting determines how many days personally identifiable submission data (XML data, attachment data, submission
extract data and submission properties) will be kept once a transaction has finished. This data takes up a large amount of space and poses some security
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risk due to containing user entered data, so we recommend a strict value for this policy. The submission record itself will stay around after data deletion (see
the next setting below).
This setting can be customized on both the organization and form levels.

The "Finished Transactions" setting determines how many days submission records and associated entities will be kept once a transaction has finished. If Pl
data has been deleted for a submission, the header records remain until this policy kicks in, allowing your administrators to find the submission in the TM
logs.

The "Finished Collaboration Jobs" setting determines how many days collaboration jobs and all their submissions will be kept once the entire job has finished.

Always save your changes after editing any field. If you would like to start a purge run straight away, save and then click "Apply Policy".

Organization Level Settings

Organizations by default use the global data retention settings; however, you can customize the "Saved Transactions" and "Finished Transaction PIl Data"
on the organization level if desired. These settings will then apply to all submissions associated with forms belonging to the organization.

To edit the organization data retention settings, edit the organization and switch to the "Data Management" tab.

Qrganiz ation I Delivery Channels I Spaces | Payment Gateway | Properties I Form Categories | Form Tags I Applications Installed TPacs Report Schedules

Transaction Data Retention Policies (max age)

Saved Transactions (days) | System: 30 days @

Finished Transaction Pll Data (days)  System: 7 days 7]

Transaction Form Data Storage Settings

Submission Data Storage Service v @ New

Data Encryption Key Rollover | Weekly ¥ @

Encrypt Data Extracts @

3 o

Enter custom values for "Saved Transactions" and "Finished Transaction PIl Data" or leave them blank to use the global setting. If "Enforce System / Org
Thresholds" is turned on, you will not be able to enter values larger than the current global policy value.

When you are done, save your changes. TM will apply the new policies to all submissions for this organization.

Form Level Settings

Forms by default use the organization (if defined) or global data retention settings. However, you can customize the "Saved Transactions" and "Finished
Transaction Pll Data" on the form level. These settings will apply to all submissions for this form.

To edit the form data retention settings, edit the form and switch to the "Details" tab. The relevant setting are at the bottom of the tab.

Transaction Data Retention Policies (max age)

Saved Transactions (days)  System: 30 days 7

Finished Transaction Pll Data (days)  System: 7 days Z
m Validate Form Close

Enter custom values for "Saved Transactions" and "Finished Transaction Pll Data" or leave them blank to use the global setting. If "Enforce System / Org
Thresholds" is turned on, you will not be able to enter values larger than the current organization (if defined) or global policy value.

When you are done, save your changes. TM will apply the new policies to all submissions for this form.

Immediate Data Deletion

Please note for forms where the transaction data should be deleted immediately once it has been delivered, organizations will need to use the REST Delivery
API which provides an option for immediate data deletion once positive delivery confirmation has been acknowledged.

Otherwise, the minimum possible time until data deletion is one day after the submission has been delivered.

System Log Settings

Apart from transaction data, TM stores a number of other entities that may need to be purged (such as various system logs and sent emails). Each of these
settings generally refers to a single entity and do not concern personally identifiable information.

To change these settings, go to "System > Data Retention Management" and ensure you are on the "Retention Settings" tab. We will discuss the settings
available in the "System Logs" section (the others were discussed in the previous section).
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System Logs (max age)
Transaction History =~ 180 days ¥ 7]
Error Leg | 30 days ¥ 7]
EventLog 30days ¥ .7 ]
Groovy Service Log | 30days ¥ .7 ]
Scheduled Job History | 30 days ¥ 9
Security Audit Log | 1 year v @
Security Manager Log  30days ¥ .7 ]
TField &pp Logs | 30days v @
User Login Histery | 180 days ¥ 7]
m Apply Policy Reset Defaults Close

Whenever a submission is finished, a record containing information about the submission (such as final status, form name, time to submit and browser
information) is written to a separate transaction history table. The transaction history table does not contain personally identifiable information, though the
contact email address (if defined) is written to the transaction history table for security auditing purposes. The "Transaction History" setting determines how
long transaction history records are kept, counting from the time the submission was originally started.

The "Error Log" setting determines how long error log entries and data that are not associated with a submission will be kept, counting from the time the error
occurred.

The "Event Log" setting determines how long event log entries that are not associated with a submission will be kept, counting from the time the event was
logged.

The "Groovy Service Log" setting determines how long log entries for Groovy service invocations will be kept, counting from invocation time.

The "Security Audit Log" setting determines how long audit log entries are kept, counting from the time the log was created. The audit log can be crucial to
tracking down changes made by administrators, so on non-test servers, we recommend that you not purge it too soon.

TM creates a log entry every time a scheduled job runs. The "Scheduled Job History" setting determines how long TM will keep these history entries.
The "T.Field App Logs" setting determines how long TM will keep T.Field device logs and T.Field sync logs.

TM logs various events relating to user session (login, logout, session expiry, account lock etc.). The "User Login History" setting determines how long these
logs will be kept.

Always save your changes after editing any field. If you would like to start a purge run straight away, save and then click "Apply Policy".

Data Retention Status

To help decide on data retention settings or see how they are working out, it is useful to see how much data is currently stored on your TM server as well as
other metrics such as the age of the oldest record. TM provides summaries on the data retention management page for your convenience.

To see a breakdown of transactions (excluding submissions associated with collaboration jobs), go to "System > Data Retention Management" and switch to
the "Transactions" tab.

Transactions are grouped by form status and delivery status. Note that only certain combinations of these statuses can be eligible for purging (form status
"Completed" or "Abandoned" and delivery status "Completed", "Undeliverable" or "Not Required").
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Data Retention Management

Home D » Data Retenti
Retention Settings | T i | Collaboration Jobs System Logs
Form 5tatus Delivery Status Oldest Max Age Records Percentage
Abandoned Completed 13 Nov 2015 179 days T 0%
Abandoned Not Required 08 Apr2016 32 days 1 0%
Abandoned Undeliverable 22 0ct2015 201 days 9,056 38 %
Assigned Not Ready 20 0ct20M5 203 days 9 0%
Assigned 25 0%
Completed Completed 11 Nov 2015 181 days 768 7%
Completed Error 16 Nov 2015 176 days " 0%
Completed Mot Ready 26 0ct2015 198 days 28 0%
Completed Not Required 24 Mov 2015 169 days 26 0%
Completed Ready 13 Nov 2015 179 days 155 2%
Completed Undeliverable 13 Jan 2016 118 days T 0%
Expired Not Required 3 0%
Opened Not Ready 10 May 2016 0 days 109 1%
Saved Not Ready 20 Apr2016 20 days 58 1%
Submitted Mot Ready 04 Mov 2015 1388 days 15 0%
04 Dec 2015 159 days 6 0%
3

To see a breakdown of collaboration jobs, go to "System > Data Retention Management" and switch to the "Collaboration Jobs" tab.

Again, not all jobs are eligible for purging: Only collaboration jobs with a status of "Completed"”, "Canceled" and "Expired" are finished and subject to data
retention times.

Data Retention Management

Home Danbboscd » Data Ralelon Nansgasenl

Rale=ton Setngs | Transaciong | Colabarstion Jobs Syalen Logs |

Jiok Type Job Status Oidest Mlax Age Records Percemtage
Form Burdle hPropresa 30 0ci2ME 1594 days 13 18 %
Farm Bundls Completsd 15 Jan JE 108 daya 2 455
Form Durdle Cancaied 00 AQr 2016 32 days L] 6%
Review B Aporoval b Progress 20 Ocl 2015 204 days 13 159 %
Paviaw & Apsitval Comphasd 24 Koy 2015 180 daya L] b
Hevaw & aparoval Emor H Fab 2ME BH days ) 3

To see a breakdown of other system entities, go to "System > Data Retention Management" and switch to the "System Logs" tab.

Data Retention Managemen

Home Dashboard » Data Retention M t

Retention Settings | Transactions | Collaboration Jobs System Logs L
Data Type Dldest Max Age Policy Max Age Records
Transaction History 12 Oct 2015 548 days 730 days 43,322
Error Log 14 Oct 2016 180 days 180 days 6,551
Event Log 14 Oct 2016 180 days 180 days 158,785
Groovy Service Log 13 Mar 2017 30 days 30 days 17670
T.Field Device Log 30 Mar 2017 13 days 30 days 101
T.Field Sync Log 30 Mar 2017 13 days 30 days 120
T.Field Sync Cal 30 Mar 2017 13 days 30 days E.440
Scheduled Job History 13 Mar 2017 30 days 30 days 142,303
Security Audit Log 12 Apr 2015 255 days 355 days 337712
Security Manager Log 14 Mar 2017 25 days 30 days 6,794
User Login History 14 Oct 2016 180 days 180 days 5,474

Total Records 724 273
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TM Table Usage (MySQL only)

If your TM instance uses MySQL, you can see a breakdown of the largest database tables to help you assess how your system uses resources.

Go to "System > Data Retention Management" and switch to the "Top Table Sizes" tab,

Data Retention Management

Home Dashboard » Data Retention W

Retention Settings | Transactions | Collaboration Jobs System Logs Top Table Sizes
Table Name Rows Avg Row (KB) Data (MB) Indexes (MB) Total (MB) DB Percentage
template_version_data 89 1,651.2 144 o 144 40.9 %
import_action_data 8 8,196.0 64 o 64 18.2%
scheduled_job_history 236,671 0z 30 21 51 14.5%
error_log 7173 33 22 2 23 65%
portal_resource 208 863 18 o 18 51%
submission_data 296 33.0 10 o 10 28%
audit_log 15,660 0.6 5 3 ] 26%
submission_history_data 560 83 & o & 1.4%
transaction_history 3,518 13 3 2 4 1.1%
service_parameter_history 1,558 23 4 o 4 1.1 %
client_transaction_audit 9,075 0.4 3 1 4 1.1 %
portal_page 218 120 3 o 3 0.9%
SErvice_parameter 1415 12 2 0 2 0.6 %
portal_resource_history 28 566 2 o 2 06%
report (-] 261.3 2 o 2 06 %
composer_package_data 1 1,568.0 2 o 2 0.6 %
library_resource_data 379 41 2 o 2 0.6 %
submission 431 3.0 0 1 1 0.3 %
request_log 387 1.6 o o 1 0.3%
Total Database Size: 355 MB

Data Retention Schedule

Data retention is performed continuously as part of the Transaction Processor service, which is run at short intervals throughout the day. This helps keep
data from accumulating and spreads out the load of data purging. By default, the Transaction Processor service runs every 5 minutes and will purge up to
500 records for each purgable entity (this number is exposed as a service parameter and can be changed if needed - please consult Avoka Support if
unsure).

Triggering Data Retention

While TM continuously applies data retention policies as described above, you can also trigger a data purge manually. To do so, go to "System > Data
Retention Management", ensure you are on the "Retention Settings" tab and click "Apply Policy" (if you made changes to the policies, click "Save" first, and
then "Apply Policy").
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Data Retention Management

Home D » Data Retenti

ing | Transaction | Collaboration Jobs System Logs

Transaction Records (max age)
Enforce System/ Org Thresholds ol @

Saved Transactions (days)* 30
Finished Transaction Pl Data (days)* 7

Finished Transactions (days)* 180

®@ @ @ e

Finished Collaboration Jobs (days)* | 180

System Logs (max age)
Transaction History = 5 years j 7]

Email Queue | 30 days j 7]

Error Log = 180 days j 2]

Event Log = 180 days j 2]

Groovy Service Log = 30 days j 7]
Import Logs = 7 days j @

Security Audit Log | 1 year j a@

Scheduled Job History | 30 days j a@

T.Field App Logs | 30 days j 7]

User Login History = 180 days j 7]

m Apply Policy Reset Defaults Close

TM will perform a data purge run similar to the pass done by the Transaction Processor service and will return a message as to how many entities were
deleted.
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Analytics Transaction Trend (Manager v5.0)

This topic discusses the Transact Manager Analytics view "Transaction Trend". This view is designed to provide key top line metrics and time series graphs
about how transactions are performing from a business perspective.

Transacti

oMy 2006 [T Endoate |270un 2016 m Clear

Customer Devices

o
M2 My M3t umi  kn2 i3 dmd  AnS  Wms e Gnd Wm0 knl0 kntl Jnf2 Gmid Anie Wnis Jnls Jnf7 lnis W1 un20 dn2 .22 an2 ket hn2s unz 2T

Operating Systems

Background

Form transactions supported in Avoka Transact can be more complex than you may initially think. Transactions will often run over may days, they will often
involve multiple sessions, with saves and resumes, and can be across multiple devices.

Another special feature of transaction is that they can be abandoned in a variety of different ways which are important to understand from a business
perspective. The types of abandonment include:

® Bounces - these are transactions which are opened when they view the form, but then the navigate away or close with window before starting work
on the transaction.

® Form Starts - these are transactions where the user opens the form, performs some action like navigation or form data entry but then closes the
window without performing an explicit user save

® Background Saves - these are transactions where the form has performed an automatic background save when the user navigates to the next
section, but the user then closes with window without performing an explicit save

® User Saves - these are transactions where the user has performed an explicit save operation and then closes the window, however they never
return to resume the transaction again

® User Cancels - these are transactions where the user has decided to explicitly cancel the transaction by clicking on the Cancel button.

®* Administrator Cancels - these are transactions which may be manually abandoned by an administrator, these are very rare

The table below details when these abandonment status are determined and gives an indication of their relative frequency

Abandonment Type Done Automatically Done When Frequency Comments
Form Bounce Yes 24 hours Very High
Form Starts Yes 24 hours High Supported in TM 4.3.4
Background Saves Yes 24 hours High
Use Saves Yes 30 days default Low Period configurable at a Form, Org. or System level
User Cancels No done by user Low
Administrator Cancels No done by staff Very Low

The reason this is important is that we don't know whether an open transaction has been abandoned until 24 hours later. This effectively means we wont
have daily conversion rate and bounce rate information available until 48 hours later.

The Transaction Trend view is based on information in the Transaction History table. This avoids very heavy analytics queries being performed against the
transaction tables which would impact operational transaction processing. Transaction History records are created when a transaction has been finished,
which means it has either been Completed by the user, or it has been Abandoned. Completed transaction history records are created in real-time, when a
transaction is completed an corresponding history records is created at the same time. Abandoned transaction history records however are only created with
a Transaction progresses to an Abandoned state, which could occur 24 hours later or some 30 days later.

The effect of this is you should not be looking at yesterdays daily conversion rate and bounce rate metrics as not all the abandoned records will have been
processed.

Filter Criteria
The filter criteria supported by the Transaction Trend view include:

® Organization - this filter on the top right will restrict the transaction trend analytics data to forms belonging to that organization, and will also filter
down the list of Forms and Spaces available for filtering. Staff which belong to only one Organization will have this filter value automatically set.

® Form - this filter will restrict transaction trend analytics data to that belonging to the Form

® Space - this filter will restriction transaction trend analytics data to that associated with this Form Space

® Device Type - this filter will restrict transaction trend analytics data to that completed by the specified by the Device Type, which includes Desktop,
Phone or Tablet devices.

® Start Date - this filter includes transactions which are completed on or after the Start Date
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® End Date - this filter includes transactions which are completed on or before the End Date

Key Metrics

The Key Metrics pod on the right hand side show some key top line metrics that business owners should be focusing on.

589

Completed Transactions

These metrics include

Completed Transactions - the number of transactions completed by users for the given period and filter criteria

Completion Rate - the ratio of Completed transactions / total transactions (including abandoned transactions) for the given period and filter criteria
Bounce Rate - the ratio of Form Bounce transactions / total transaction for the given period and filter criteria

Median Form Completion Time - the median time time users took to complete the form transaction, this time is cumulative time taken in each form
transaction session

Customer Devices - the percentage distribution of device types used to perform transactions

Operation Systems - the percentage distribution of operating systems used to perform transactions

® Browsers - the percentage distribution of browsers used to perform transactions

Charts

Completed Transactions

This chart provides a timeline display of total transaction completed which were started on the specified day. If a transaction is completed a few days later, it
will still be attributed to the date it was started in the completed transaction counts for that day.

Completed Transactions
G0

45
30
15

0 e & W

Jund4  Jun3  Jun& Jun7T Jund  Jun® Jun10 Jun11l Juni12 Jun13 Jun14 Jun15 Jun1& Jun17 Jun18 Jun19 Jun20 Jun 21

Conversion Rate

This chart provides a timeline display of total transaction completed which were started on the specified day. If a transaction is completed a few days later, it
will still be attributed to the date it was started in the completed transaction counts for that day.

Conversion Rate
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Bounce Rate

This chart provides a timeline display of total form bound transactions started on the specified day. A form bounce is a transaction opened by the user but
which they never start, this is the equivalent of a web analytics page bounce when a user views an page but immediately navigates away or closes the
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window. In Transact a transaction is classified as bounce if they have not performed a save, either explicit user save or a form automatic background save in
24 hours. In real terms the daily bounce rate can be accurately calculated 2 days later. We cant provide the daily bounce rate for transactions started today
or yesterday.

Bounce Rate

Jund4  Jun5 Juné  Jun?7 Jund  Jun® Juni1d Jun11 Jun12 Jun13d Juni14 Juni15 Juni1é Jun1? Jun18 Jun1® Jun20 Jun 21

Median Form Completion Time (mins)

This chat provides a timeline display of the median time it took user to complete a form which was started on the specified day. The time taken to complete a
form transaction is the sum of the transaction form sessions time. So if you spent 2 minutes in the first session and then resumed the transaction the next
day and spent another 13 minutes completing the transaction the total time would be 15 minutes.

Median Form Completion Time (mins}
8

]
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Frequently Asked Questions
Why does the bounce rate increase and the conversion rate change since yesterday ?

The daily conversion rate and bounce rate cannot be accurately determined for the first 48 hours. After 48 hours the bounce rate will be accurate, and the
conversion rate will be fairly accurate but its values may change as other In Progress transactions started on that day are either Completed or Abandoned.

Why isn't the Conversion Rate the inverse of the Bounce Rate?

The Bounce Rate is only one type of abandonment, there are other types including abandoned Form Starts, User Saves, User Cancels and Administrator
Cancels. These all contribute to the overall abandonment rate which is the inverse of the Conversion Rate.

Are Assigned Tasks or Collaboration Jobs included in the Bounce Rate?

Not assigned tasks and Collaboration job transactions are explicitly excluded for automatically abandoned form bounces and form starts.

340



Transact Licensing Reports (Manager v5.0)

Avoka Transact licensing is based on the concept of pay-per-transaction. To support licensing compliance Avoka Transact includes an automated license
audit reporting system. This is covered in the standard Avoka Master Services Agreement (MSA) under the topic "Audit".

By using an automated licensing system Transact relieves customers from the burden audit reporting to ensure licensing compliance. Performing manual
license reporting and auditing doesn't contribute to your bottom line.

Transaction license reporting is performed on a daily basis. These license reports contain meta-data information about the completed and abandoned form
transactions, they contain no end-user form data or personal identifiable information (PII).

This license reporting system also provides summary system health information, to enable proactive operation monitoring of our customers systems and
support capacity planning.

License Keys and TM Installations

Each Transact Manager instance (Prod, Staging, Dev. etc.) is configured with a unique customer licensing key which is used to support license
reporting. With the Avoka Transact Cloud Service licensing configuration is performed by Avoka.

For on premise installations you will need to configure a Transact License Key for each TM instance before performing an installation or upgrade. Please do
this ahead of your planned install or upgrade, so your IT staff will have the keys ready. To obtain License Keys from Avoka please contact: licensing@avoka.
com.

If you have staff running TM instances locally on their computers for development purposes, you can obtain a per-user license key, by providing the named
user's email address to Avoka support. Please note local TM licenses should not be used for any production workflows and are provided for local
development purposes only.

Please see the Avoka Transaction Manager Installation Guide for information on how to install and upgrade Transact Manager and configure license keys.

Transaction Licensing Reports

Transaction license reports are provided on a daily basis to support transaction licensing accrual. Licensing reports include summary meta data on:

Client Organizations - active during the reporting day

Form Definitions - active during the reporting day

Form Transactions - which were completed or abandoned during the reporting day
Collaboration Jobs - created during the reporting day

Services - billable 3rd party service invocations during the reporting day

These reports DO NOT include any user information, user entered information or personally identifiable information (PlI).

System Health Reports

System Health reports provide hourly system health aggregate information to support pro-active operational monitoring and capacity growth planning. Hourly
system health reports include aggregate counts on:

® transaction lifecycle event counts (form renders, saves, submits, deliveries, abandonments, deliveries)

® system error counts and event log counts
® groovy service and scheduled job invocation counts

Data Security
The Transaction Licensing system has a very secure data security architecture and strict access control policies. All data is encrypted at rest using AES-256
encryption with encryption keys managed in the AWS Key Management System (KMS). All data in transit is encrypted using TLS 1.1. Access is to licensing

data controlled via AWS IAM named user accounts, within restricted networks.

Access to licensing reports is on a strictly need to know basis for Avoka licensing compliance staff and Avoka customer account management staff, and is a
literally handful of people.
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Access to system health reports is restricted to Avoka operational support staff and Avoka customer account management staff.

Network Rules

To support Transaction License reporting TM servers deployed on premise must have firewall rules which support access to the following AWS endpoint:

® https://s3-us-west-2.amazonaws.com

All traffic is REST service calls over HTTPS. Network traffic is daily for the transaction licensing reports running after midnight, and hourly for system health

reports running after the hour. These reports are typically very small measuring around a KB for the daily transaction reports and around 90 bytes for system
health reports.
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Transact Licensing Reports Data (Manager v5.0)

The Transact Licensing Reports data files use GZIP compressed tabular CSV format. These report files include:

Instance

The licensed TM instance.

Name Type
tm_license_key char(32) Not Null

billing_client_code = Varchar(20) Not Null

license_name Varchar(50) Not Null
hosting_type Varchar(20) Not Null
env_type Varchar(20) Not Null
env_node_count Integer Not Null

env_version Varchar(20) Not Null
os_type Varchar(10) Not Null
db_type Varchar(10) Not Null

retention_mode Varchar(10) Not Null

manager_url Varchar(100) Not Null
portal_count Integer
time_zone Varchar(20) Not Null

update_timestamp = Timestamp Not Null

Client

The TM client organization entity

Name Type

tm_license_key char(32) Not Null

client_oid Integer Not Null
client_name Varchar(100) Not Null
client_code Varchar(20) Not Null

update_timestamp = Timestamp Not Null

Form

The transaction form metadata.

Name Type

tm_license_key char(32) Not Null

form_oid Integer Not Null
client_oid Integer Not Null
form_name Varchar(120) Not Null
form_code Varchar(20) Not Null

update_timestamp = timestamp not null

Transaction

The finished transaction.

Description
primary key
billing system client code
license name
specifies hosting type: [ Cloud | On Premise ]
TM environment type [ PROD | UAT | TEST | DEV ]
number of server nodes
TM Version Number
Operating System Type: linux, windows
Database Version: mysq|, oracle, sqlserver
Data retention policy mode: strict, relaxed
TM Manager Console URL
number for form spaces
time zone

the date/time the instance was last included in an upload

Description
primary key (compound) & foreign key
primary key (compound)
TM Client Name
TM Client Code

the date/time the client was last included in an upload

Description
primary key (compound) & foreign key
primary key (compound)
foreign key
TM Form Name
TM Form Code

the date/time the form was last included in an upload

Name Type Description
tm_license_key char(32) Not Null primary key (compound) & foreign key
submission_oid Integer Not Null primary key (compound)
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form_oid Integer Not Null foreign key

job_oid Integer foreign key

form_status Varchar(20) Not Null ' TM Form Status: Competed, Abandoned

form_abandonment_type @ Varchar(20) type of abandonment: Bounced, Started, Saved, Submitted, Cancelled

time_started Timestamp

time_finished Timestamp TM time: completed or abandoned

user_agent_device_type | Varchar(20) users device type: Desktop, Tablet, Mobile

user_agent_browser_type | Varchar(20) users browser type: Chrome, Internet Explorer, Edge, Firefox

user_agent_os_type Varchar(20) users operation system type: Windows, iOS, Android

form_session_count Integer number of form sessions

time_to_submit_sec Integer TM Time To Submit Seconds

time_elapsed_sec Integer TM Time in seconds between inital form render and submission

internal_txn_flag Integer specifies whether the form transaction is internal or external

space_name Varchar(60) specified the name of the Form Space (portal)

anon_participant_count Integer number of anonymous participants in transaction

auth_user_count Integer number of authenticated participants in transaction

attachment_count Integer file attachments count

attachment_total_size Integer file attachments total size in bytes

template_type Varchar(20) form template version type: maestro, composer, pdf

far_data_version Varchar(20) form template FAR data version: 4.3.0spl

fw_flag Integer TransactField App transaction

error_count Integer number of error_log records associated with transaction
Job

The transaction job.

Name Type Description
tm_license_key | char(32) Not Null primary key (compound) & foreign key
job_oid Integer Not Null primary key (compound)
client_oid Integer Not Null foreight key (client.client_id)

time_created Timestamp Not Null | TM time job created

Service
The 3rd party licensed service invocation.

This information is used to support billing of 3rd party service licenses.

Name Type Description

tm_license_key char(32) Not Null primary key (compound) & foreign key
submission_service_log_oid | Integer Not Null primary key (compound)
submission_oid Integer Not Null foreign key (transaction.submission_oid)
service_name Varchar(60) Not Null ' TM Service Name
service_url Varchar(200) endpoint URL of the external service called
service_info Varchar(200) additional information recorded with service invocation
time_created Timestamp Not Null = TM time service invoked

System

The system health reports on aggregates for an hour period. Note TM will not upload historical error log data, it will only report the previous hours error count
data.
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This information used for system support to identify trending system issues and ensure systems are correctly provisioned with adequate capacity.

Name
tm_license_key
system_health_datetime_utc
system_health_date
system_health_hour
txn_form_render_count
txn_receipt_render_count
txn_submit_count
txn_save_count
txn_abandon_count
txn_delivery_count
txn_delivery_error_count
job_created_count
groovy_service_count
event_log_count
scheduled_job_count
fw_sync_count
error_total_count
error_critical_count
error_groovy_count
error_collab_job_count
error_email_count
error_form_delivery_count
error_form_dynamic_data_count
error_form_render_count
error_form_submission_count
error_livecycle_count
error_management_count
error_payment_gateway_count
error_receipt_render_count
error_rest_soap_api_count
error_scheduled_job_count
error_security_manager_count
error_fw_sync_count

error_unclassified_count

Upload Log

Type

char(32) Not Null

Timestamp Not Null

Date Not Null

integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null
Integer Not Null

Integer Not Null

Description

primary key (compound) & foreign key

primary key (compound)

primary key (compound)

number of form request_log records

number of receipt request_log records

number of form submissions (excludes saves)

number of user form saves (excludes background saves)
number of abandoned transactions

number of submissions delivered

total number of submissions in delivery error status
number of jobs created

number of groovy service log

number of event log records

number of quartz scheduled jobs run

number of TM field worker sync call log records

total number of error_log records

number of TM critical errors for the period

number of TM system error_log records

number of TM 'Collaboration Job' type error_log records
number of TM 'Email' type error_log records

number of TM 'Form Delivery' type error_log records
number of TM 'Form Dynamic Data' type error_log records
number of TM 'Form Render' type error_log records
number of TM 'Form Submission’ type error_log records
number of TM 'LiveCycle' type error_log records
number of TM 'Management' type error_log records
number of TM 'Payment Gateway' type error_log records
number of TM 'Receipt Render' type error_log records
number of TM 'REST SOAP API' type error_log records
number of TM 'Scheduled Job' type error_log records
number of TM 'Security Manager' type error_log records
number of TM 'T.Field Sync' type error_log records

number of TM 'Unclassified' type error_log records

The data upload verification log file. This information is used to verify the licensing data was correctly uploaded.

Name Type Description

tm_license_key char(32) Not Null primary key (compound) & foreign key

time_created Timestamp Not Null | primary key (compound)

client_count Integer Not Null number of client records uploaded

form_count Integer Not Null number of form records uploaded
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transaction_count Integer Not Null number of transaction records uploaded
job_count Integer Not Null number of transaction records uploaded

submission_service_count | Integer Not Null number of service records uploaded
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Transact Insights Analytics Data (Manager v5.0)

This page has been moved to Transact Insights Analytics Data.
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